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FAQ Database — Solutions to problems and troubleshooting efforts can be found
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Preface

About This Manual
This manual provides hardware installation, software configuration, and operating
instructions for the Jupiter CM 4000 Control Module and associated control panels.

A printed copy of the manual is normally provided with the system, along with the
Routing Products Documentation CD−ROM, part no. 071 8274 xx.

This manual can also be accessed through the Jupiter Configuration Editor “Help”
pull−down menu.

Additional Documentation

CD−ROM 071 8274 xx provides electronic copies of Apex, Jupiter, Saturn, Trinix,
Triton, and Venus manuals and field bulletins, including:

• This manual

• Jupiter VM/SI 3000 System Controller Installation and Operating Manual
(071 8305 xx). Describes JupiterPlus and Jupiter LE applications

• Jupiter Getting Started Guide (04 045707 003). Describes simplified soft-
ware configuration procedures for quick system startup

• Multimedia Courses: 

Setting Up, Configuring, and Operating a Basic Jupiter Control System
(071 8189 00)

Building a Jupiter Tally System from the Ground Up (071 8188 00)

Finding Your Path through Path Finding (071 8187 00)

• JEP 100 Jupiter/Encore Control Panel Installation and Operating Manual
(071 8376 xx)

• Saturn Installation and Operating Manual (04−046654−002)
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• FCS 3306/1/2 Control Panel (1200/2400 baud) Field Engineering Bulletin
(04−883306−001/2). Describes software running in a CP 3000 Control Panel
PROM. This software can be used to talk to remote panels through modems
using MPK protocol at 1200 or 2400 Baud.

• Triton to Jupiter Serial Control Kit Installation Instructions
(04−051254−001)

• Advanced Tally Techniques for Studios with Jupiter Control and DD-35
Series Production Switchers (technical paper)

Current versions of many of these documents are maintained on our web site. See
page ii.

Other publications that can be ordered by contacting Grass Valley Technical Support
include:

• SlimLine Under Monitor Displays User Manual (XU 00650 684 581 900)

• RP 1/2/3 C Under Monitor Displays Manual

• RP 1/2/3 Under Monitor Displays Manual (0 212 173 400)

• CD−ROM 071 8130 xx − documentation for Grass Valley router products
not found on CD−ROM 071 8274 xx.

• EScontrol Routing Switcher Control Protocol Guide (04−04507−006)

• ESswitch Serial Routing Switcher Control Protocol Guide
(04−045707−008)

• ESbus VTR Dialect Protocol Guide (04−045707−007)



xxviiCM 4000 Installation and Operating Manual

Safety Summary

Read and follow the important safety information below, noting especially those
instructions related to risk of fire, electric shock or injury to persons. Additional spe-
cific warnings not listed here may be found throughout the manual.

WARNING
Any instructions in this manual that require opening the
equipment cover or enclosure are for use by qualified service
personnel only. To reduce the risk of electric shock, do not
perform any servicing other than that contained in the operat-
ing instructions unless you are qualified to do so.

Safety Terms and Symbols

Terms in This Manual
Safety−related statements may appear in this manual in the following form:

WARNING
Warning statements identify conditions or practices that may
result in personal injury or loss of life.

CAUTION
Caution statements identify conditions or practices that may
result in damage to equipment or other property, or which may
cause equipment crucial to your business environment to be-
come temporarily non−operational.
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Terms on the Product
The following terms may appear on the product:

DANGER — A personal injury hazard is immediately accessible as you read the
marking.

WARNING — A personal injury hazard exists but is not immediately accessible as
you read the marking.

CAUTION — A hazard to property, product, and other equipment is present.

Symbols on the Product

The following symbols may appear on the product:

Indicates that dangerous high voltage is present within the equipment enclosure that
may be of sufficient magnitude to constitute a risk of electric shock.

Indicates that user, operator or service technician should refer to product manual(s)
for important operating, maintenance, or service instructions.

This is a prompt to note fuse rating when replacing fuse(s). The fuse referenced in
the text must be replaced with one having the ratings indicated.

Identifies a protective grounding terminal which must be connected to earth ground
prior to making any other equipment connections.

Identifies an external protective grounding terminal which may be connected to
earth ground as a supplement to an internal grounding terminal.

Indicates that static sensitive components are present which may be damaged by
electrostatic discharge. Use anti−static procedures, equipment and surfaces during
servicing.
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Warnings
The following warning statements identify conditions or practices that can result in
personal injury or loss of life.

Dangerous voltage or current  present — Disconnect power before removing
protective panels, soldering, or replacing components.

Do not service alone  — Do not internally service this product unless another per-
son capable of rendering first aid and resuscitation is present.

Remove jewelry  — Prior to servicing, remove jewelry such as rings, watches, and
other metallic objects.

Avoid exposed circuitry  — Do not touch exposed connections, components or
circuitry when power is present.

Use proper power cord  — Use only the power cord supplied or specified for this
product.

Ground product  — Connect the grounding conductor of the power cord to earth
ground.

Operate only with covers and enclosure panels in place — Do not operate
this product when covers or enclosure panels are removed.

Use correct fuse  — Use only fuse type and rating specified for this product.

Use only in dry environment  — Do not operate in wet or damp conditions.

Use only in non−explosive environment  — Do not operate this product in an
explosive atmosphere.

High leakage current may be present  — Earth connection of product is essen-
tial before connecting power.

Double pole neutral fusing  — Disconnect mains power prior to servicing.

Use proper lift points  — Do not use door latches to lift or move equipment.

Avoid mechanical hazards  — Allow all rotating devices to come to a stop be-
fore servicing.
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Cautions
The following caution statements identify conditions or practices that can result in
damage to equipment or other property

Use correct power source  — Do not operate this product from a power source
that applies more than the voltage specified for the product.

Provide proper ventilation  — To prevent product overheating, provide equip-
ment ventilation in accordance with installation instructions.

Use anti−static procedures  — Static sensitive components are present which
may be damaged by electrostatic discharge. Use anti−static procedures, equipment
and surfaces during servicing.

Do not operate with suspected equipment failure — If you suspect
product damage or equipment failure, have the equipment inspected by qualified
service personnel.

Ensure mains disconnect  — The power cord of this equipment provides the
means of disconnection. The socket outlet must be installed near the equipment and
must be easily accessible. Verify that all mains power is disconnected before instal-
ling or removing power supplies and/or options.

Route cable properly — Route power cords and other cables so that they ar not
likely to be damaged. Properly support heavy cable bundles to avoid connector dam-
age.

Use correct power supply cords  — Power cords for this equipment, if pro-
vided, meet all North American electrical codes. Operation of this equipment at volt-
ages exceeding 130 VAC requires power supply cords which comply with NEMA
configurations. International power cords, if provided, have the approval of the coun-
try of use.

Troubleshoot only to board level — Circuit boards in this product are densely
populated with surface mount technology (SMT) components and application specif-
ic integrated circuits (ASICS). As a result, circuit board repair at the component level
is very difficult in the field, if not impossible. For warranty compliance, do not trou-
bleshoot systems beyond the board level.
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Regulatory Notices

Certifications and Compliances

Safety Certification

Category Standard Designed/tested for compliance with:

Safety  ANSI/UL 1950−1997 

3rd Ed.

CAN/CSA−C22.2 No.

950−95

EN 60950

Professional Video and Audio Equipment

FCC Emission Notice
Operation is subject to the following two conditions: (1) This device may not cause
harmful interference, and (2) this device must accept any interference received, in-
cluding interference that may cause undesirable operation.

This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful in-
terference to radio communications.

This device has been tested and found to comply with FCC Part 15 Class B limits for
a digital device when tested with a representative laser−based fiber optical system
that complies with ANSI X3T11 Fiber Channel Standard. These limits are designed
to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment.

Operation of this equipment in a residential area is likely to cause harmful interfer-
ence in which case the user will be required to correct the interference at his own
expense. Changes or modifications not expressly approved by Grass Valley can affect
emission compliance and could void the user’s authority to operate this equipment.
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Canadian EMC Notice of Compliance
This digital apparatus does not exceed the Class A limits for radio noise emissions
from digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

Le présent appareil numérique n’emet pas de bruits radioélectriques dépassant les
limites applicables aux appareils numeriques de la classe A préscrites dans le Règle-
ment sur le brouillage radioélectrique édicte par le ministère des Communications du
Canada.

EN 55103 Class A Warning
For products that comply with Class A. In a domestic environment this product may
cause radio interference in which case the user may be required to take adequate
measures.

Canadian Certified Power Cords
Canadian approval includes the products and power cords appropriate for use in the
North America power network. All other power cords supplied are approved for the
country of use.

Canadian Certified AC Adapter
Canadian approval includes the AC adapters appropriate for use in the North Ameri-
ca power network. All other AC adapters supplied are approved for the country of
use.
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Laser Compliance

Laser Safety Requirements
The device used in this product is a Class 1 certified laser product. Operating this
product outside specifications or altering from its original design may result in haz-
ardous radiation exposure, and may be considered an act of modifying or new
manufacturing of a laser product under U.S. regulations contained in 21CFR Chap-
ter1, subchapter J or CENELEC regulations in HD 482 S1. People performing such
an act are required by law to recertify and reidentify this product in accordance with
provisions of 21CFR subchapter J for distribution within the U.S.A., and in accor-
dance with CENELEC HD 482 S1 for distribution within countries using the IEC
825 standard.

Laser Safety
Laser safety in the United States is regulated by the Center for Devices and Radio-
logical Health (CDRH). The laser safety regulations are published in the “Laser
Product Performance Standard,” Code of Federal Regulation (CFR), Title 21, Sub-
chapter J.

The international Electrotechnical Commission (IEC) Standard 825, “Radiation of
Laser Products, Equipment Classification, Requirements and User’s Guide,” governs
laser products outside the United States. Europe and member nations of the European
Free trade Association fall under the jurisdiction of the Comite European de Normal-
ization Electrotechnique (CENELEC).

For the CDRH: The radiant power is detected trough a 7 mm aperture at a distance of
200 mm from the source focused through a lens with a focal length of 100 mm.

For IEC compliance: The radiant power is detected trough a 7 mm aperture at a dis-
tance of 100 mm from the source focused through a lens with a focal length of 100
mm.
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KEMA Certificate

Number:510057.001 

The Quality System of

Thomson Broadcast & Media Solutions
TBMS TBMS
400 Providence Mine Road 17 rue du Petit Albi−BP 8244−

Nevada City, CA 95945 95801 Cergy Pontoise
Cergy, France

TBMS
Weiterstadt, Germany TBMS
Brunnenweg 9 10 Presidential Way, 3rd Floor, Suite 300
D−64331 Weiterstadt, Germany W oburn, MA 08101

TBMS TBMS
15655 SW Greystone Ct. 2300 South Decker Lake Blvd.
Beaverton, OR97006 Salt L ake City, UT 84119

TBMS TBMS − PCB
Nederland B.V. Rennes, France
4800 RP BREDA Rue du Clos Courtel
The Nederlands Cesson−Sevigne, Cedex

France

TBMS/Nextream TBMS/Nextream
Rennes, France Technopole Brest Iroise
Rue du Clos Courtel CS 73808
Cesson−Sevigne, Cedex 29238 Brest Cedex 3
France France

Including its implementation, meets the requirements of the standard: 

ISO 9001:2000
Scope:The design, manufacture and support of video hardware and software products
and related systems. 

This Certificate is valid until: June 14, 2006
September 9, 2003

Renewal Date: June 14, 2003
Issued for the first time:

Affiliate with the N. V. KEMA in the Netherlands
A member of the International Network for Quality System Assessment and Certification “IQNet”

H. Pierre Sallé
President
KEMA−Registered Quality, Inc.

The method of operation for quality certification is defined in the KRQ General Terms and
Conditions for Quality Certification. Integral publication of this certificate and adjoining reports
is allowed.

KEMA−Registered Quality
4377 County Line Road, Suite 202
Chalfont, PA 18914
Ph: (215) 997−4519  Fax: (215) 997−3809

Accredited By:
ANSI−RAB NAP
The Dutch Council for
Accreditation (RvA)

Revision Date:

June 14, 2000
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Figure 1−1. CM 4000/JupiterXPress Installation Overview.
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Section 1 − Introduction

The CM 4000 Jupiter Control System is designed to control Grass Valley Crosspoint Bus* and certain other matrix routers;
video equipment using Sony remote control protocol; and certain other RS−422 devices. The devices to be operated are con-
nected to the CM 4000, which is in turn connected to Jupiter control panels. The CM 4000 is configured using the Jupiter
file server* (Figure 1−1).

Present Jupiter systems may include CM 4000, VM 3000, and/or SI 3000 System Controllers. The VM 3000 and SI 3000
are described in a separate manual.

CM 4000 System Controller

The CM 4000 System Controller provides a hardware platform for the JupiterXPress or AccuSwitch applications. Note that
only one of these applications can be downloaded and executed in a single CM 4000 at one time.

• JupiterXPress provides a limited set of Jupiter switching and machine control functions using the CM 4000 as
the interface between Crosspoint Bus routers and various control devices (as listed in the software package
table, page 1−27). This software cannot be installed on systems containing VM 3000 or SI 3000 processors.

• The AccuSwitch product, when connected to and operated by a suitable automation system, allows determinis-
tic switching of a Crosspoint Bus router, with each switch guaranteed to occur one frame after receipt of the
automation system switch command; and, allows a sustained switching rate of up to 200 physical crosspoint
switches per video frame. AccuSwitch installation and configuration is described in Appendix G.

Note: some Jupiter Control System functions are extra−cost options. See the software package table (page 1−27).

The following overview of system functionality applies generally to a CM 4000 controller running the JupiterXPress applica-
tion. The AccuSwitch application supports a reduced set of functions (as described in the software package table).

An example JupiterXPress system is shown in Figure 1−1.

*Terms marked with an asterisk are defined in Glossary at the back of the manual.
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Control Functions

DISTRIBUTION SWITCHER CONTROL 

Grass Valley matrix routers that can be controlled by the CM 4000 include Apex, Concerto, Trinix, and Venus. The crosspoint
bus* of the switcher is connected to a CM 4000; this in turn is connected to the Jupiter file server. Triton switchers can be
controlled using a serial connection.

Pathfinding Option

Pathfinding provides the user with the means to communicate between routing switchers, including automatic standards con-
version when switching between analog and digital routers.

Note: Jupiter does not support path finding for data routers.

“Remote” (Serial Control) Router Interface Option

The CM 4000 can optionally support several third−party matrix router protocols. Multiple routers with different protocols
can be mixed in one system if desired. For a list of supported remote routers, please refer to page 1−28.

INTEGRATION WITH MASTER CONTROL 

The CM 4000 is specifically designed to provide all configuration and control interface functions required for full integration
with a Saturn Master Control Switcher. Integration with tally/UMD products varies with equipment used (see page 1−30).

MACHINE CONTROL (JUPITERXPRESS ONLY) 

Each Sony−protocol device using the basic RS−422 control scheme requires one dedicated port of a CM 4000.

EXTERNAL CONTROL PROTOCOLS

These protocols can be used by external computers and automation systems to send switch messages into the Jupiter Control
System.  One serial port is used for each device.

For a list of supported protocols, please refer to page 1−28.

Detailed descriptions of these protocols are available. Please contact Grass Valley for more information.
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Control panels

Note 1: only the JEP−100 control panel is available for use with the AccuSwitch application.

Jupiter message−per−keystroke (MPK) control panels are designed to be as simple, flexible, and inexpensive as possible. Sys-
tem software is maintained in a central file server from where it is downloaded to the control processors as required.

Control panels are connected to the controlled device through the CM 4000 System Controller, using either the multi−point
or single−point method.

For information beyond that given in the following summary, please refer to the control panel model number in the Index.

Note 2: Certain control panels are not available for use with JupiterXPress. For additional information, please refer
to page 1−29.

SWITCHER CONTROL PANELS 

The CP 300 one−rack unit series includes the CP 300 24 x 1 Single Bus Control Panel; the CP 310 24 x 8 Eight Bus Control
Panel; the CP 320 full−matrix, 16−category panel with a dedicated protect key; and the CP 330 Control Panel. The CP 330
can be configured as a 48 x 1, 24 x 2, or 48 x 6 panel. The CP 328 is similar to the CP 320 but has eight−character display
windows.

The CP 2002 uses 16 LCD back−lit buttons that allow source mnemonics to be displayed in the button frame. The panel allows
operators to select up to 256 sources by scrolling to additional pages. The colors of the buttons change to indicate the active
source.

The CP 3000 switcher control panel can be configured for single−bus control (allowing selection of a source for one destina-
tion), multi−bus control, or full matrix control (selection of a source for any destination). The CP 3000 panel is used to select
one of 20 source categories (VTR, CAM, etc.) and then, using a 10−key pad, a unit within the category. Crosspoint status*
is provided by the display window. Additional push buttons provide breakaway (control of individual switcher levels such
as left audio, time code, etc), chop,* lock,* protect,* and override* switching. A password can be assigned to the panel if
desired. The CP 3000 can also be operated in connection with an adjacent CP 3010 expansion panel. For example, for multi−
bus control, the desired source can be selected on the CP 3000; the CP 3010 would then display the names of eight destinations,
beneath which are eight corresponding TAKE keys; one of these would be pressed to complete the switch. The page of eight
destinations can be scrolled to display up to 160 possible destinations.

The CP 3020 is a single bus control panel that can select one of 20 inputs. The push buttons illuminate to indicate status and
can be fitted with user−supplied transparent labels. Dedicated chop and lock buttons are included. Up to four CP 3021 Push
button Expansion panels can be added to the CP 3020, allowing button−per−input selection of up to 100 inputs.

The CP 3800 is a universal, eight−character mnemonic, switcher and machine control panel. When operated in the “multiple
destination mode,” the CP 3800 can be used to control from 1 to 80 destinations, with the names of eight of those destinations
(and the status for each) on display simultaneously. In the “single destination mode,” one destination is selected for control,
and the display window shows the status for each level of that destination (video, left audio, right audio, etc.).

The CP 3808 control panel is a 16−category, full−matrix, multiple level breakaway panel capable of locking and protecting
outputs. The CP 3830 is a 12−category, full−matrix, multiple−level breakaway panel, capable of locking, protecting, and
chopping outputs. Dual CP 3830 panels can be configured so that one of the panels is always used for destination selection;
dual output mode is also possible with two panels side by side. Both the CP 3808 and CP 3830 can be operated in connection
with an adjacent CP 3809 Expansion Panel. All three panels feature eight−character display capability and relegendable,
lighted push buttons.
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The CP 3824 control panel is a locally−programmable, full−matrix, multiple level breakaway panel capable of locking and
protecting outputs. The panel features eight−character display capability and relegendable, lighted push buttons. The 24 but-
ton−per−source keys on the left side of the panel are initially assigned to inputs from the file server, but some or all can be
re−assigned to new inputs at any time using only the panel itself. Sources can also be selected by scrolling up or down an LED
display of “Preset” mnemonics or by using the Category/Number keypad.

The CP 3832 is a button−per−source panel configurable for 32 X 1 or  16 X 16 operation. The panel includes buttons for TAKE,
LOCK, and PROTECT. The CP 3864 is a button−per−source panel configurable for 64 X 1 or 32 X 32 operation and includes
buttons for TAKE, LOCK, PROTECT, and CHOP. Both panels can be grouped with additional CP 3832s or a CP 3864 to
provide up to 128 X 128 control. The CP 3810 expansion panel can be associated with a CP 3832, CP 3864, CP 3808, or CP
3830, providing control of up to 80 outputs. The CP 3810 can be operated as a status display only (no control) for one output,
and as a limited−function machine control panel providing Play and Stop commands for VTRs.

MACHINE CONTROL PANELS 

The MC 3000 machine control panel, which is capable of operating any of the machines described above, includes a series
of push buttons for motion control (PLAY, STOP, etc.). A variable speed knob, with a color−coded direction/speed indicator,
is included. When used with a serial control VTR, the panel provides a continuous display of the machine’s time code. Also
available is the MC 3010 machine control panel, which includes a gang−start function and illuminating push buttons.

The following machine assignment systems are available:

• Machine assignment to a control panel can be made to occur automatically, using a “follow−the−switcher”
technique (software linkage).

• Machines can also be permanently assigned to specific control panels if desired.

The CP 3800 and Software Control Panel Suite (described below) are also available for machine control applications.

SOFTWARE CONTROL PANEL SUITE (GUI CONTROL PANEL)

The Software Control Panel Suite (“Graphical User Interface”) consists of seven routing switcher and machine control ap-
plications plus a configuration application. Only one of the applications can be activated at a time.

The software operates on a PC using the Jupiter Network Suite (JNS) software, which provides the interface to the Jupiter
Control system through the Jupiter LAN. The Software Control Panels are designed for mouse or touchscreen operation.§

The panels can be run on the Jupiter file server, on one or more separate PCs on the Jupiter LAN, or on both.

Tally

Note: Tally operation is very limited with the AccuSwitch application. Please refer to page 1−30.

Using the MI 3040 General Purpose / Tally Interface, the Jupiter system can follow a source, such as a camera or VTR, through
as many as five switchers and turn on the tally light next to the source when it is switched to air. Switchers that are on−air
can also be tallied. Multiple sources will be tallied simultaneously during keys, special effects, etc.

§ For touchscreen operation, the PC and monitor must be supplied by Grass Valley.
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Status Displays 

Note: Status displays are very limited with the AccuSwitch application. Please refer to page 1−30.

Under Monitor Displays

The Grass Valley SlimLine UMDs combine status and tally functions in the same chassis and are available in a wide range
of sizes and types. SlimLine UMDs are described on page 2−81.

Certain third−party UMDs are also compatible with Jupiter equipment. See page 1−30.

VGA Status Display

The CM 4000 / JupiterXPress product provides a VGA output for system status display, with basic controls located on the
front panel. The VGA output is designed to give a great deal of flexibility to the user in defining what kind of system informa-
tion will be displayed at a particular location on the VGA screen. The types of information, or “fields,” that can be displayed
are:

Switcher Output Status (any level)
Switcher Input Status (any level)
Machine Status (Play, Stop, Record, etc.)
Machine Delegation Status
Machine Linkage Status (Which control panel it’s currently linked to)
System Time and Date
System Control Board Status (Active, Inactive)
System Control Board Time Source (Time Code Reader, File Server, etc.)
System Control Board Messages (Also displayed by the logger)
Pathfinding (Tie Line) Status

The type and location of these fields are determined by a user−entered DOS ASCII text file.
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File Server (Configuration PC) 

The PC 3000 File Server supplied by Grass Valley is described in detail on page 1−14.

When the system is initialized, program information is downloaded from the file server to the control processor(s). Field up-
grades and modifications can thus be made through this single station.

System Logger

Provides the user with system status display in a window on the Jupiter file server or Jupiter remote PC.

Jupiter Configurator (Table Editor)

Microsoft Windows−style menus are used to configure the various components of the system. For example, these menus are
used to set the individual buses of the CM 4000 to MPK, Sony, or other protocols as needed.
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Specifications

Note: Some functions are extra−cost options. For more information, see the software package table beginning on page 1−27.

ELECTRICAL

CM 4000 CONTROL MODULE 

Front panel controls: 
Activate
Reset
Video output: Up, Down, Next, Select

Front panel indicators: 
Power supply status (+3 V, +/−5 V, +/−12 V)
Active
System status (7−segment LED)

Front panel connectors 
 

1, Probe (diagnostic) (9−pin D female)

Rear panel connectors 
 

1, Video Out (VGA) (15−pin HD female) 
1, SMPTE Time Code In (XLR female)
1, Sync (reference), 1 V P−P to 4 V P−P, looping (BNC)
1, Alarm (SMPTE 269M−1999)
8, Serial Ports (RS−422/ESbus) (9−pin D female)†

1, Redundant (control) (15−pin D female)
1, Grass Valley router Crosspoint (XPT) bus, looping (15−pin D female)
2, Aux (not implemented)
1, LAN (10/100baseT) (RJ−45) 
2, USB (not implemented)

Power requirements: 100 to 240 VAC 50−60 Hz auto ranging, 0.4 A

Environmental: Operational range 0 degrees to 40 degrees C, max. 95% humidity (non−condensing)

† See page 2−12 for restrictions on use of these ports for “remote” (serial) switcher control.
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Figure 1−2. CM 4000.
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VTR, CONTROL PANEL, GENERAL PURPOSE INTERFACE BUSES

Bus controller: CM 4000 System Controller

Protocols supported: Please refer to software package table beginning on page 1−27.

Cable/connectors: 4−conductor twisted pair plus ground / 9−pin D

Transmission speeds: 1200, 2400, 4800, and 9600 bits/sec; 19.2, 38.4, and 115 kbits/sec

No. of tributaries (devices) per bus: 1−32, depending on speed requirements

Max. length per bus: 4003 ft (1220 m)

MATRIX ROUTER CONTROL BUSES

Matrix router bus controller: CM 4000 System Controller

Protocols supported: 

Super crosspoint bus, Grass Valley binary 
Cable/connectors: 10−conductor twisted pair plus ground / 15−pin D
Transmission speed: 1 Mbit/sec (approx)
Routers supported:

Apex
Concerto (with CRS−MC−C2 Controller Module)
GS 400
Mars
SDR 400
Trinix
TVS/TAS 1000 (through CE−1003B)
TVS/TAS 2000
TVS/TAS 2001
TVS/TAS 3000
Venus

Serial control routers include Triton and certain third−party routers. See page 1−28.
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CONTROL PANELS 

CP 300/310/320/328/330 Control Panels

Connectors:
1, MPK (RS−422/ESbus), looping (9−pin D female)

Power requirements: +5VDC +/− 0.25V @ 600 mA. A wall plug−in power supply is supplied with each 300 series
panel that will be used with 110 VAC 60 Hz power. Panels that are to be used in areas where 220VAC 50Hz power
is the norm are not shipped with any power supply. See page 2−38 for more information.

CP 2002 series control panels

Connectors:
1, MPK (RS−485), looping (RJ45)
1, DC in, Molex Mini−Fit, Jr., 2−pin

Power requirements: 9 VDC / 1.5 A. Use only brick−type power supply, order no. 006 022 811 001 (Euro−plug) or
006 022 811 002 (USA plug)

CP 3000 switcher control panel, MC 3000/3010 machine control panel

Connectors: 1, Data A (RS−422/ESbus), looping (9−pin D female)
Power requirements: +5 VDC§

CP 3010 expansion panel

Connections to main panel (CP 3000 or MC 3000): flat wire bus
Power requirements: +5 VDC§

CP 3020,  VC 3020 Push Button Control Panels

Connectors: 
1, Data A (RS−422/ESbus), looping (9−pin D female)
1, Remote (for expansion panel) (37−pin D female)

Power requirements: 117/220 VAC, 0.25/0.125 A

CP 3021 Push Button Expansion Panel

Connectors: 
1, Input (from CP/MC/VC 3020 main panel)  (37−pin D female)
1, Output (to next CP 3021) (37−pin D female)

Power requirements: powered from main panel
Max no. of CP 3021 per main panel: 4

CP 3800 Control Panel

Connectors:
1, MPK (RS−422/ESbus), looping (9−pin D female)

Power requirements: 117/220 VAC, 0.25/0.125 A

§ Furnished by CP 3000/3010 chassis power supply. Power supply requirements: 117/220 VAC, 0.5 /0.25 A.
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CP 3830 Control Panel

Connectors:
1, MPK (RS−422/ESbus), looping (9−pin D female)

Power requirements: power furnished by control panel chassis power supply.***

CP 3808 Control Panel

Connectors:
1, MPK (RS−422/ESbus), looping (9−pin D female)

Power requirements: power furnished by control panel chassis power supply.§

CP 3809 Expansion Panel

Connectors:
1, MPK (RS−422/ESbus), looping (9−pin D female)

Power requirements: power furnished by control panel chassis power supply.§

CP 3824/3832/3864/3810 Control Panel

Connectors:
1, MPK (RS−422/ESbus), looping (9−pin D female)

Power requirements: 110/250 VAC, 0.8/0.4 A; 47−63 Hz.

SLIMLINE UNDER MONITOR DISPLAY COMPONENTS

Standard displays (screw mount):
Connectors: 1,  RJ45 female jack for connection to SlimLine Controller
Power requirements: Single Display, 9 W; Dual Display, 18 W; Universal Display, 30 W. 24 VDC power 

supplied by SlimLine Controller
Operating temperature: minus 10 to plus 50 degrees C

OB van displays (hinged plate mount):
Connectors: 1, 4 m flat cable with RJ45 male plug for connection to SlimLine controller
Power requirements: same as Standard display
Operating temperature: minus 10 to plus 50 degrees C

Controller and Power Supply: 
16,  RJ45 female jack for connection to displays
1, 9−pin D female jack, looping, for RS−422 MPK connection to CM 4000. Alternatively used for software 

download and diagnostics
Supply voltage 88−264 VAC, 47−63 Hz
Fuse: 2A (230V), 4A (115V). Inrush current:  3.6 A. Maximum output power: 240 W
Operating temperature: minus 10 to plus 50 degrees C

§ CP 3808/3809/3830 chassis power supply requirements: 85−264 V, 47−63 Hz. (0.8 A @ 100 V, typical; 0.4 A @
200 V, typical.)
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FILE SERVER

Grass Valley PC 3000 System File Server

PC 3000 Specifications (Minimum)

� Intel Pentium 700 processor with 256 K L2 cache

� 512 Mbytes RAM memory

� 1.2 Gigabyte hard drive

� 4X CD−ROM drive

� 1.44 Mb floppy drive

� Intel or 3Com Ethernet LAN card

� Keyboard / mouse

� 15−inch monitor capable of 1024x768x256

� 2 serial ports and 1 parallel port

� Windows 2000 Professional or XP Professional

A Site License is required to enable features; see Ordering Information (page 1−22).

Jupiter software is installed and tested.

Use of a customer−supplied computer is discouraged (to avoid compatibility problems due to evolving software require-
ments). If circumstances require a customer−supplied computer, please contact Grass Valley Technical Support.

EQUIPMENT DIMENSIONS

CM 4000 SYSTEM CONTROLLER

1.75 in. high x 19 in. wide x approx. 17 in. deep (44 x 483 x 432 mm)

CB 3000 CONTROL BUFFER

1.75 in. high x 19 in. wide x 16.75 in. deep (44 x 483 x 425 mm)

CONTROL PANELS

CP 2002 series panels:  1.75 in. high x 19 in. wide x approx. 8 in. deep (44 x 483 x  201 mm). (Design allows chassis sections
to be separated when depth is critical—contact Grass Valley for more information.)

The CP 3000, CP 3010 expansion, and MC 3000/3010 panels are normally mounted in a chassis which is 3.5 in. high x 19
in. wide by 7.5 in. deep  (89 x 483 x 190 mm). The chassis has space for two panels; a blank insert is provided when required.
(For custom mounting information, see page 1−15.)

CP 3020, VC 3020 Push Button Control Panels: 1.75 in. high x 19 in. wide x 10 in. deep (44 x 483 x 254 mm). CP−3021 and
CP−300 Series: 1.75 in. high x 19 in. wide x 3 in. deep (44 x 483 x 75 mm).
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CP 3800 Control Panel: 3.5 in. high x 19 in. wide x approx. 8 in. deep (89 x 483 x 200 mm).

The CP 3808, CP 3809, and CP 3830 panels are mounted in a chassis which is 3.5 in. high x 19 in. wide by 4 in. deep  (89
x 483 x 100 mm). The chassis has space for two panels; a blank insert is provided when required.

CP 3824 Control Panel: 1.75 in. high x 19 in. wide x approx. 6 in. deep (89 x 483 x  152 mm).

CP 3832 and CP 3810 panels: 1.75 in. high x 19 in. wide by 4 in. deep  44 x 483 x 100 mm). CP−3864: 3.5 in. high x 19 in.
wide by 4 in. deep  89 x 483 x 100 mm).

SLIMLINE UNDER MONITOR STATUS/TALLY DISPLAY COMPONENTS

Displays − Standard (screw mount) type

UMD 9 SD: 1.75 in. high x 9 in. wide§ x 1.15 in. deep (44 x 228 x 29.2 mm),  0.66 lb. (0.30 kg) 
UMD12 SD: 1.75 in. high x 12 in. wide§ x 1.15 in. deep (44 x 302 x 29.2 mm), 0.71 lb. (0.32 kg) 
UMD 14 SD: 1.75 in. high x 14 in. wide§ x 1.15 in. deep (44 x 335 x 29.2 mm), 0.73 lb. (0.33 kg) 
UMD 19 SD: 1.75 in. high x 19 in. wide x 1.15 in. deep (44 x 483 x 29.2 mm), 0.93 lb. (0.42 kg) 
UMD 19 DD: 1.75 in. high x 19 in. wide x 1.15 in. deep (44 x 483 x 29.2 mm), 1.46 lb. (0.66 kg) 
UMD 19 UD: 19 1.75 in. high x 19 in. wide x 1.15 in. deep (44 x 483 x 29.2 mm), 1.5 lb. (0.68 kg)

§Width of front of panel. For custom−mount cut−out dimensions refer to SlimLine manual.

Displays − OB (hinged plate mount) type

UMD 9 SD OB: 1.75 in. high x 8.66 in. wide x 0.87 in. deep (44 x 220 x 22.2 mm), 1.2 lb. (0.54 kg) incl. mounting plate 
UMD 12 SD OB: 1.75 in. high x  12 in. wide x 0.87 in. deep (44 x 302 x 22.2 mm), 1.3 lb. (0.57 kg) incl. mounting plate
UMD 14 SD OB: 1.75 in. high x  14 in. wide x 0.87 in. deep (44 x 335 x 22.2 mm), 1.3 lb. (0.58 kg) incl. mounting plate 
UMD 19 SD OB: 1.75 in. high x  17.4 in. wide x 0.87 in. deep (44 x 442 x 22.2 mm), 1.5 lb. (0.66 kg) incl. mounting plate
UMD 19 DD OB: 1.75 in. high x  17.4 in. wide x 0.87 in. deep (44 x 442 x 22.2 mm), 2.4 lb. (1.08 kg) incl. mounting plate
UMD 19 UD OB: 1.75 in. high x  19 in. wide x 0.87 in. deep (44 x 483 x 22.2 mm), 2.4 lb. (1.11 kg) incl. mounting plate

Controller : 3.5 in. high x 19 in. wide x 0.9 in. deep (88.9 x 483 x 23 mm).

PC 3000 FILE SERVER

Dimensions are typical for a desktop PC. For exact measurements of file server currently supplied with Jupiter systems, please
contact Grass Valley.

CONTROL PANELS FOR CUSTOM MOUNTING

The CP 3000 Router Control Panel, MC 3000 Machine Control Panel, CP 3010 expansion panel, and MC 3010 Single 4 Ma-
chine Control Panel are available without chassis or power supply (See page 1−22 for part numbers). Each individual panel
measures 80 mm high (exactly) x 200 mm wide (exactly) x 65 mm deep (approx.) or approx. 3.2 x 7.9 x 2.5 inches. The panels
are designed to be fastened along the top and bottom front edges (reference: Grass Valley drawing no. 10−040151−001). The
power supply normally supplied is a 5 volt 3 amp Volgen ES−05003, Grass Valley part no. 06−033098−002. The connector
used for connecting the power supply cable to the panel’s PC board is Grass Valley part no. 30−036841−004.
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SYSTEM LIMITATIONS

Maximum Number of Logical Levels 

The system−wide maximum number of logical levels is 96. However, the actual number of levels a CM 4000 can control in
a particular system varies.

The main constraint on the number of levels and outputs a CM 4000 can safely control is the available memory in PMEM,
or backed−up permanent memory. When a CM 4000 starts up, the old status tables are used to generate a completely new set
of status tables. Therefore, no more that half of the total available memory may be used to store switcher status. The CM 4000
has 512 Kb of PMEM available. That means that no more than 262,144 bytes may be used for router status tables.

This formula for router status table PMEM memory usage is based on the worst−case scenario. It assumes that every physical
output on every logical level in the system has its own unique entry in a Switcher Output Table. The formula for each CM
4000 in the system is:

(14 x TL) + (6 x TL x PO) + (10 x PO) + 600 < 262,144

Where: TL  = the total number of logical levels controlled by this CM 4000
PO = the total number of physical outputs on ALL levels controlled by this CM 4000

This total must be less than 262,144. For example, in Figure 2−1 a 25−level switcher can have up to 64 outputs per level.
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Figure 2−1.

(14x25) + (6x25 x {64x25}) + (10 x {64x25}) + 600  =  256,950

It is easy to see that if the logical levels in the Jupiter system consist of small routers with few outputs per logical level, more
of these levels can be controlled by a single CM 4000. However, if the Jupiter system consists of larger routers, fewer of these
levels can be controlled by a single CM 4000, and the system’s router control must be “broken up,” or distributed among multi-
ple CM 4000s.
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Versions of Jupiter prior to 5.1.0 will not handle edit sets which have more than 64 levels. Should you attempt to edit such
a set, the Jupiter Configurator (editor) will detect the error in the Switcher Description table and will not run correctly. Another
symptom is that the Configurator will not exit properly. (If you mistakenly do edit a set with more than 64 levels with a pre
5.1.0 version of Jupiter, terminate the Configurator, delete the invalid set from the YourJupiterDirectory\Config directory,
delete the YourJupiterDirectory\Config\ics_conf file, and re−execute the Configurator.)

CP 38xx Control Panel

If you intend to control more than 64 levels from a CP 38xx panel, a control panel firmware upgrade will need to be ordered
from the factory.

CM 4000 Serial Bus Loading

Recommendations for maximum number of devices per bus and processor board

The following guidelines can be used during system planning or as a part of a troubleshooting process. In the case of an
installed system, a existing configuration set can be analyzed automatically using the “loading.exe” program available at the
Support/FAQ web site.

Base Load Factors

The following are the base load factors for the specified devices and are subject to the multiplier described under “Calculating
Loading” on page 1−18:

— Each CP 3800 Control Panel counts as four devices, with no more than two CP 3800 panels per controller
port.

— Each MC 3000 Machine Control Panel counts as four  devices, with no more than 16 occurrences of MC 3000s
system−wide due to the amount of tape time code being processed.

— Each MC 3010 Machine Control Panel counts as one device: This number remains the same even for an MC
3010/2 Dual 4−Machine Panel.

— Each CP 300 Series Control Panel, CP 3000 Switcher Control Panel, and CP 3020 Push Button Control Panel
counts as one device.

— Each CP 3808 Control Panel, CP 3824 Control Panel, and CP 3830 Control Panel counts as one device.  CP
3809 Expansion Panels count as two devices. For example, a CP 3808 with a CP 3809 Expansion Panel would
count as three devices.

— Each CP 3832 Control Panel, CP 3864 Control Panel, and  CP 3810 Expansion Panel counts as one device.
For example, a CP 3832 with a CP 3810 Expansion Panel would count as two devices.

— Each VC−3020 Video Display Control Panel counts as one device.

— Each Under Monitor Display counts as one−half a device.

— CP 3010 Expansion Panels and CP 3021 Push Button Expansion Panels are not counted.
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— Each CP 2002B/D Control Panel counts as four devices; therefore, a maximum of 16 can be connected to a
CM 4000 (two per serial port).

Fixed Load Factors

The following load factors are fixed and are not subject to the multiplier described below under “Calculating Loading”:

— If a CM 4000’s Crosspoint Bus is in use, it counts as twenty devices on that CM 4000.

— Each instance of a “remote” (non−Crosspoint Bus) switcher protocol counts as eight devices (maximum
one protocol per port).

— Each instance of the ASCII protocol  counts as eight devices (maximum one protocol per port).

— Each instance of ESswitch counts as follows:

� If the switch rate is less than fifty switches per second sustained past five seconds, that instance counts
as eight devices (maximum one protocol per port).  A switch is defined as a take from one input to one
output on one level.

� If the switch rate is more than fifty switches per second sustained past five seconds, that instance
counts as 32 devices (maximum one protocol per port).  A switch is defined as a take from one input to
one output on one level.

— Each instance of serial machine control (Sony machine) counts as eight devices (maximum one protocol per
port).

Note 1: When high switch rates occur, automatic router status on ASCII and ESswitch ports will not be able to
keep up due to baud rate limitations.  Therefore it is suggested that the ASCII protocol use the ZR status commands
instead of ZW, and the ESswitch protocol use READ STOD instead of UDAT STOD.

Note 2: When high sustained switch rates occur and status of identical outputs or levels are being displayed on
router control panels that can display multiple outputs or levels, or on GUI panels, status being displayed may be
delayed.

Calculating Loading

— A maximum of sixteen devices may be assigned to an addressable controller port.

— Only one Sony−protocol device can be connected per port. Only one ASCII protocol device or ESswitch de-
vice can be connected per port.

— In order to calculate loading and quantity of processors required, the following steps should be followed:

1. Sum all base and fixed loading factors in the system.

2. If the system wide sum of all base and fixed loading factors is less than 160, this system is considered a “light-
ly” loaded system and a base multiplier of 1.0 should be used in later calculations.
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3. If the system wide sum of all base and fixed loading factors is greater than or equal to 160 but less than 320,
this system would be considered a “medium” loaded system and a base multiplier of 1.5 should be used in
later calculations.

4. If the system wide sum of all base and fixed loading factors is greater than or equal to 320, this system is
considered a “heavily” loaded system and a base multiplier of 2.0 should be used in later calculations.

5. Using the base multiplier specified above based upon the system wide sum of the base and fixed loading fac-
tors, distribute the devices throughout the system not exceeding the following maximum loading for the CM
4000 processors:

� CM 4000 maximum loading: 200

Note: The base multiplier is based upon the sum of the device counts of all devices system wide, NOT upon the
devices on any single processor board. Therefore, if the sum of the device counts is 400 system wide, you must
use a base multiplier of 2.0 when configuring the system. You can not merely sum the devices connected to each
individual processor using a base multiplier of 1.0 and keep this sum under the specified maximum loading.
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Example

A system is to contain the following:

� 2 channels of Saturn (1 DVP, 2 DAPs per channel).  (Saturn Video and Audio Processors do
not directly contribute to Jupiter loading)

� 1 Saturn MCC 3500 Master Control Console with the Select panel used for delegation pur-
poses. (Saturn MCC 3500 panels do not directly contribute to Jupiter loading unless the Select
panel is used with a backup switcher)

� 1 Saturn DVE (Sony serial machine protocol)

� Venus router control

� 1 Triton remote router control

� 8 MC 3000 Machine Control panels

� 16 serial machines

� 1  ASCII

� 1 ESswitch (high switch rate)

� 30 CP 328 Control Panels

� 16 CP 3800 Control Panels

� 4 CP 3808 Control Panels

Determine the Base Multiplier
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Since the sum of the base and fixed load factors of all devices in the system is greater than or equal to 320, this would be
considered a heavily loaded system.  Therefore, the indicated Base Multiplier (BM) would be 2.

One possible configuration of this system might then be:
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1Fixed Loading Factor
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3Base Multiplier
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Ordering information

JUP−CM 4000 System Controller (software not included) 071 1276 00

JUP−PC 3000 System File Server (desk mount) F7-029500-121

PC workstation with LAN card for storing, editing and
compiling system configurations. Also used for logging
and diagnostics. Site license is required to enable fea-
tures, order SW 2500 or SW 3100.

JUP−SW 3500 JupiterXPress Software F7-029500−158

General Purpose Systems Interfaces

JUP−CB 3000B Control Buffer Module F7-029500-508

Required for very large matrices utilizing over 96 boards
on the crosspoint bus. Provides eight additional cross-
point bus outputs. 1 RU. 110/220 VAC.

Control Cables 

Control System Serial Data Cables for MPK bus and RS-232/RS-422 applications.

JUP−CNTLRTRBTYES-Bus Controller/Tributary Adapter Cable 01-041420-001
JUP−SRLDCBL  1 MPK Serial Cable   1 m 01-048591-001
JUP−SRLDCBL  2 MPK Serial Cable   2 m 01-048591-002
JUP−SRLDCBL  4 MPK Serial Cable   4 m 01-048591-004
JUP−SRLDCBL  8 MPK Serial Cable   8 m 01-048591-008
JUP−SRLDCBL 16 MPK Serial Cable  16 m 01-048591-016
JUP−SRLDCBL 32 MPK Serial Cable  32 m 01-048591-032
JUP−C-PCC2 PC to CE Configuration Cable for CE 300 and SC 400 01-044827-001

Crosspoint bus cable

JUP−CC 2010 Matrix Cable See page 2−4
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SlimLine Under Monitor Status/Tally Displays

UMD−SD/9 Single Display UMD, 9−1/2 inch width 0 924 601 660
UMD−SD/12 Single Display UMD, 12 inch width 0 924 601 661
UMD−SD/14 Single Display UMD, 14 inch width 0 924 601 662
UMD−SD/19 Single Display UMD, 19 inch rack mount 0 924 601 663
UMD−DD/19 Dual Display UMD, 19 inch rack mount 0 924 601 665
UMD−UD/19 Universal Display UMD, 19 inch width 0 924 601 667
UMD−SD/9 OB Single Display OB van UMD, 9−1/2 inch width 0 924 601 680
UMD−SD/12 OB Single Display OB van UMD, 12 inch width 0 924 601 681
UMD−SD/14 OB Single Display OB van UMD, 14 inch width 0 924 601 682
UMD−SD/19 OB Single Display OB van UMD, 19 inch width 0 924 601 683
UMD−DD/19 OB Dual Display OB van UMD, 19 inch width 0 924 601 685
UMD−UD/19 OB Universal Display OB van UMD, 19 inch width 0 924 601 687
UMD−CTRL/16 UMD Controller, supplies 16 UMDs,  19 inch rack mount 0 924 601 690

Additional Hardware Part Numbers

JUP−31-5271 Amphenol Velcro Boot 05-042549-001

JUP−CP 300 24 x 1 Single Bus Control Panel F7-023600-001
JUP−CP 310 24 x 8 Eight Bus Control Panel F7-023600-002
JUP−CP 320 Control Panel F7-023600-003
JUP−CP 330 48 x 1 Single Bus Control Panel F7-023600-004

JUP−CP 2002D 16 soft-labelled LCD button control panel. Requires F7-971310-010
PSU CP EURO or PSU CP USA power supply

JUP−CP 3000 Switcher Control Panel F7-029500-021
JUP−CP 3000 Control Panel w/o Chassis or Power Supply F7-029500-005
JUP−CP 3000/2 Dual Control Panel F7-029500-025
JUP−CP 3000/E Switcher Control/Expansion Panel F7-029500-022
JUP−CP 3000RBK Relegendable Button Kit 44-046025-001
JUP−CP 3010 Expansion Panel without Chassis or Power Supply F7-029500-006
JUP−CP 3000/MC 3010  Switcher / Machine Control Panel F7-029500-048

JUP−CP 3020 Push Button Control Panel F7-029500-016
JUP−CP 3021 Push Button Expansion Panel (includes connecting cable) F7-029500-017

JUP−CP 3800 Control Panel F7-029500-058

JUP−CP 3808 Control Panel (without chassis) F7-029500-066
JUP−CP 3808/1 Single Control Panel (with chassis and blank panel) F7-029500-065
JUP−CP 3808/E Multi Control Panel (with CP 3809 Expansion Panel F7-029500-064

and chassis.) 
JUP−CP 3809 Expansion Panel (without chassis) F7-029500-069
JUP−CP 3809/1 Single Expansion Panel (with chassis and blank panel)   F7-029500-068
JUP−CP 3809/2 Dual Expansion Panel (with chassis) F7-029500-067

JUP−CP 3810 Eight Character Eight Bus Expansion Panel F7-029500-082
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JUP−CP 3824 Eight Character Jupiter Plus X-Y Control Panel F7-029500-095

JUP−CP 3830 Control Panel  (without chassis) F7-029500-063
JUP−CP 3830/1 Single Control Panel (with chassis and blank panel) F7-029500-062
JUP−CP 3830/2 Dual Control Panel (with chassis)  F7-029500-061
JUP−CP 3830/E Multi Control Panel (with CP 3809 and chassis) F7-029500-076

JUP−CP 3832 Eight Character 32 Button Per Source Control Panel F7-029500-080
JUP−CP 3864 Eight Character 64 Button Per Source Control Panel F7-029500-078

JUP−CP/MC 3000 Switcher/Machine Control Panel F7-029500-024

JUP−GJ IC455B Black Box  Interface/converter 05-040935-001

JUP−JEP 100 Jupiter / Encore Control Panel 610 1138 01

Manuals see page xxv
JUP−MC 3000 Machine Control Panel F7-029500-020
JUP−MC 3000 Machine Control Panel without Chassis or Power Supply F7-029500-007
JUP−MC 3000/2 Dual Machine Control Panel F7-029500-026
JUP−MC 3000/E Machine Control with Expansion Panel F7-029500-023

JUP−MC 3010/1 Single 4 Machine Control Panel F7-029500-045
JUP−MC 3010/2 Dual 4 Machine Control Panel F7-029500-046
JUP−MC 3010 Single 4 Machine Control Panel without chassis or F7-029500-044

power supply

JUP−MC 3010/MC 3000  Machine Control Panel F7-029500-047

JUP−MC 3010 Expansion Control Panel (to convert MC 3010/1 to F7-029500-050
MC 3010/2)

JUP−PS 300 110/220 VAC Power Adaptor Kit. Adapts 300 series 44-046442-001
panel for direct connection to power mains.

JUP−PSU CP EURO Plug in Power Supply, Euro 220 V, for CP 2002 F6-022811−001
JUP−PSU CP USA Plug in Power Supply, USA 110 V, for CP 2002 F6-022811−002

Triton to Jupiter Serial Control Kit 44-050456-001

JUP−VC 3020 Video Display Control Panel Same as CP 3020

Control System Software Options

JUP−SW 31DT Datatek Matrix Control option F7−029500−107
JUP−SW 31UT Utah Scientific Control option F7−029500−111
JUP−SW3INXS Nexus Audio Router Driver Contact Grass Valley
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AccuSwitch Frame−Accurate Automation Solution

JUP−CM 4000 System Controller F7−029700−001

Software is not included. Required to run SW 4000
frame−accurate switching software.

JUP−CM 4000RDN Redundant Control Electronics (2 units)  F7−029500−103

Software is not included. Runs SW 4000 frame−accurate
switching software. Includes: Two CM 4000 units and
one BOP 4000 Redundancy Cable Kit

JUP−BOP 4000 CM 4000 Redundancy cable kit and Break Out Panel F7−029500−104

Includes necessary cables for automatic changeover
between two CMs

JUP−SW  4000 Software License  F7−029500−124

For the frame−accurate switching software that runs on
the CM 4000 control electronics. This license is for a
single redundant pair of CM’s only. Additional licenses
per additonal pars must be purchased. Key features are
listed on page 1−27.
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Software Control Panel Suite Packages

JUP−PC−GUI/M GUI PC for Mouse control w/Basic X−Y Panels F7−029599−004

PC workstation with LAN card for operation of  GUI
control panels using a mouse. Includes the basic GUI−
XY routing switcher control panel software.

JUP−PC−GUI/T GUI PC for Touchscreen Control w/Basic X−Y Panels F7−029599−085

PC with LAN card for operation of GUI control panels
using a touchscreen. Includes the basic GUI−XY routing
switcher control panel software.

JUP−GUI−XY Basic X−Y Soft Panels F7−029599−086

Includes two routing switcher control panels for mouse
or touchscreen operation. The Basic X−Y panel imple-
ments Category/Entry type operation using a single key-
pad. The Source/Destination Panel provides separate
keypads for faster operation. Requires PC. Order PC−
GUI/M, PC−GUI/T or see minimum PC requirements on
page 1−14.

JUP−GUI−SPCL Special GUI Soft Panels F7−029599−087

Includes three routing switcher GUI control panels for
mouse or touchscreen operation. Dub panel switches a
single source to multiple destinations. Salvo panel
switches multiple source destination combinations with
a single TAKE. Full Function X−Y panel provides
breakaway capability and user−assignable buttons for
direct access to commonly used sources. Requires PC.
Order PC−GUI/M, PC−GUI/T or see minimum PC re-
quirements on page 1−14.

JUP−GUI−MC Machine Control Soft Panels F7−029599−088

Includes two machine control GUI panels for mouse or
touchscreen operation. The Full Function MC panel pro-
vides basic transport functions plus jog, variable play
and time code display. The Slaved MC panel provides
six machine, six function control plus Gang command.
Requires PC. Order PC GUI/M, PC GUI/T or see mini-
mum PC requirements on page 1−14.
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Software Packages − Key Features

Jupiter software is available in several software (SW) packages. One of these packages is normally activated by the end user
with a unique key code during installation (as described in the Field Engineering Bulletin supplied with the software).

The key features of these packages are summarized in the following table. Please keep the differences between packages in
mind when you refer to the instructions in this manual.

Note: The contents of the packages shown below are subject to change without notice. For the most current list
of all packages and features, please contact Grass Valley.

Figure 1−3. Key features of Jupiter software packages.

Software package Notes

JUP−SW 2500 
Jupiter LE

JUP−SW 3100 
JupiterPlus

JUP−SW 4000 
AccuSwitch  
See Note 1

JUP−SW 3500 
JupiterXPress

Controller type VM/SI 3000 VM/SI 3000 CM 4000 CM 4000 See Note 2

Multiple controllers in network Yes Yes Yes (see Note 3) Yes (see Note 4)

Apex, Concerto, Trinix, Triton, 
Venus control

Yes Yes Yes Yes See also page 1−11
for older Cross-
point Bus routers
supported

Maximum Inputs x Outputs 128 x 128 1024 x 1024 4096 x 4096 (using 
Ultra Crosspoint bus)

4096 x 4096 
(using Ultra
Crosspoint bus)

See Note 5

Maximum Levels 32 96 96 96

Path finding (tie−line management) Yes Yes Yes Yes See Notes 6 and 7

Follow level switching Yes Yes No Yes

3−stage routing No Option No No

Distributed routing (switch forward-
ing)

Yes Yes Yes Yes

Frame accurate control (determinis-
tic switching)

No No Yes (see Note 8) No

File server OS compatibility

Windows 95/98 Not supported Not supported Not supported Not supported

Windows NT Not supported Not supported Not supported Not supported

Windows 2000 Professional Yes Yes Yes Yes

Windows XP Professional Yes Yes Yes Yes

WAN operation of multiple Jupiter
systems

No No Yes No With Jupiter 7.4.1
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Software package Notes

JUP−SW 2500 
JupiterLE

JUP−SW 3100 
JupiterPlus

JUP−SW 4000 
AccuSwitch  
See Note 1

JUP−SW 3500 
JupiterXPress

Automation interface protocols

Jupiter ASCII Yes Yes Yes Yes

Jupiter ESswitch Yes Yes Yes Yes

Jupiter ESbus (Physical) Yes Yes No Yes

Jupiter ESbus (VTR) Yes Yes No No

SMPTE ES tributary
   (EG 29−1993)

No No Yes No

SMPTE ESLAN 
   (EG 30−1995)

No No Yes Yes

“Remote” (serial control) Router 
Interface. See Note 9.

GVG 1020 
NVISION
Sony Control
Vistek
Novotronic
Microvideo
VT−220 (Southbank)

No Yes No No

Alpha Image
Data Tek
GVG Native (outgoing)
Nexus
Pro−bel Eclipse
Utah 96

No Yes Yes Yes

DEC (Southbank)
RKX

Yes Yes No No

EScontrol Yes Yes Yes Yes

Utah 12 No Yes Yes No

Nexus Star
GVG Horizon

No Yes Yes (with Jupiter 7.4.1) Yes (with Jupiter
7.4.1)

Production switcher protocol

DD Series Yes Yes No Yes

GVG 200 Yes Yes No No

Kalypso No No Yes Yes GV Native protocol
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Software package Notes

JUP−SW 2500 
JupiterLE

JUP−SW 3100 
JupiterPlus

JUP−SW 4000 
AccuSwitch  
See Note 1

JUP−SW 3500 
Jupiter XPress

MPK control panels

CP 300 series All All No All

CP 2002 series All All No All

CP 3000 series All All No Yes, except 
CP 3008 and 
CP 3030

CP 3300 series All All No No

CP 3800 series All All No Yes, except 
CP 3810/S, 
CP 3830/P, 
CP 3832/P, and
CP 3864/P

MC 3000 series No All No Yes, except 
MC 3020

3040 LOCK/SLCT
Mess_UMD
WPE

Yes Yes No No

VGA Control Yes Yes No Yes

JEP−100 
Jupiter/Encore control panel

No No Yes Yes
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Software package Notes

JUP−SW 2500 
JupiterLE

JUP−SW 3100 
JupiterPlus

JUP−SW 4000 
AccuSwitch  
See Note 1

JUP−SW 3500 
JupiterXPress

Software Control Panel Suite (GUI) Option Option Option Option

Party line CP interface No Yes No No

Tally/UMD

Jupiter Source Tally/UMD
with SlimLine UMD Series

Yes Yes No Yes See Note 10

Jupiter Source Tally with
RP 1/2/3 UMDs

Yes Yes No Yes

Jupiter Source Tally with
SD 31/32/33

Yes Yes No No

Andromeda tally & 
GPIO management

Option Option No Option

TSL Tally/UMD Yes Yes No Yes

Image Video Tally/UMD Yes Yes Yes (ASCII) Yes (ASCII)

On screen status display No No Yes (Using GV
8964OMD OSD)

No

VTR control protocol

Ampex, ES−Bus No Yes No No

Sony No Yes No Yes

TCS machine control No Yes No No

MI 3040 Machine Control Yes Yes No No

JNS Control System User Apps Yes Yes Yes, except CP I/O, 
Saturn Follow and 
PL Download

Yes, except
Saturn Follow
and PL Down-
load

Notes:
1. For additional AccuSwitch information, see Appendix G.
2. JupiterXPress and AccuSwitch cannot be downloaded and executed in the same CM at the same time.
3. AccuSwitch cannot execute in a VM/SI but can operate in a network that includes a VM/SI.
4. JupiterXPress cannot execute in a VM/SI and cannot be operated in a network that includes a VM/SI.
5. Except for Triton, matrixes larger than 256 x 256 are an extra−cost option for serial control (“Remote”) routers.
6. Pathfinding is supported between CM−controlled routers provided that the CMs are running the same application  (e.g. both  are

running JupiterXPress or both are running AccuSwitch). Pathfinding is not supported between a VM−controlled router and a CM−
controlled router.

7. Data level pathfinding is not supported by any Jupiter system.
8. Only switches on routers directly connected to a CM running AccuSwitch can be guaranteed to be frame accurate.
9. Each “remote” router protocol is available as a separate option.

10. For the SlimLine UMD−UD/19, only the triple display mode is supported (i.e., 3 groups of 8 characters each).
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Section 2 − Hardware Installation

Unpacking and Inspection

Each Jupiter Control System is tested, inspected, and found free of defects prior to shipment. Before unpacking the equipment,
inspect the shipping carton for evidence of freight damage. If the contents have been damaged, notify the carrier and Grass
Valley. Retain all shipping cartons and padding material for inspection by the carrier.

Do not return damaged merchandise to Grass Valley until an appropriate claim has been filed with the carrier and a material
return authorization number has been received from us.

Quick Start tip : If your Jupiter equipment was purchased from Grass Valley as a “turnkey”
system, you may wish to refer to the Jupiter Getting Started Guide, part no. 04-045707-003.
This booklet provides an abbreviated version of the information in this section.

110/230 VAC Selection

Most panels are auto sensing; otherwise, power line adjustments are normally made at the factory, based on the location of
the end−user. However, verifying these settings before applying power is a good practice.

CP 300 Series Control Panels

These panels use an external power supply. See page 2−37.

File Server

Check to see if the PC file server supplied with the system has a voltage selector switch for the power supply on the rear panel,
and if so, that the proper mains voltage is set.

Installation instructions for the file server begin on page 2−36.

Rack Mounting

Grass Valley recommends that each control chassis be near most of the devices which it will control, thus reducing system
cabling. The CM 4000 Control Module should be located near the distribution switcher. See Figure 2−2 for the location of
the chassis fan and ventilation openings.
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Leaving ventilation space between the rack mount units is not necessary. 

System diagrams are shown in the following pages.

Figure 2−2.

WARNING

Do not block ventilation holes.

Rack mount support must be cut shorter if
necessary to avoid blocking airflow.

WARNING

Do not block fan opening
on side of chassis.
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CM 4000 Connection to Distribution Switchers

Although the CM 4000 supports both the JupiterXPress and AccuSwitch applications, only one of these applications can be
downloaded and executed in a single CM 4000 at one time.

• JupiterXPress provides a limited set of Jupiter switching and machine control functions using the CM 4000 as
the interface between Grass Valley Crosspoint Bus routers and the devices on page 1−27. This software cannot
be installed on systems containing VM 3000 or SI 3000 processors.

• The AccuSwitch product, when connected to and operated by a suitable automation system, allows determinis-
tic switching of a Crosspoint Bus router, with each switch guaranteed to occur one frame after receipt of the
automation system switch command; and, allows a sustained switching rate of up to 200 physical crosspoint
switches per frame. AccuSwitch installation and configuration is described in Appendix G.

JupiterXPress application − connection to Crosspoint Bus router

Figure 2−3. Example of CM 4000 / JupiterXPress installation.

CM 4000
Control
Module

CC 2010 Matrix (Crosspoint bus)
cables.

Apex, 
Concerto§,

GS 400, Trinix, 
or Venus router§§

House SMPTE
time code required

for deterministic
switching

Binary protocol

Crosspoint Bus port

For jumper and switch
setting information, re-
fer to the installation
manual supplied with

the router.

House sync
required for

vertical inter-
val switching.

CB 3000 Control Buffer
May be required when more than 50 matrix

boards are installed in switcher.

§ Concerto requires Crosspoint Bus Adapter and

CRS−MC−C2 Controller Board. For more informa-

tion, refer to Grass Valley Field Engineering Bulle-

tin 075−0722−00, “Jupiter Crosspoint Bus Control

of Concerto Flexframe Routing Matrix.”

§§ For a complete list of supported Crosspoint
Bus routers, see page 1−11.

LAN
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CC 2010 Matrix (Crosspoint Bus) Cable

The CC 2010 cable is used to connect the CM 4000 to the switcher Crosspoint Bus. Depending on the size of the switcher,
this bus may require intermediate buffering through the CB 3000 Control Buffer. See Figure 2−3.

The CC 2010 is a 10−conductor (plus ground) cable. The following ready−made cables, with installed 15−pin D male connec-
tors, are available from Grass Valley:

Length Part. No.

1 foot (0.3 m) 01−048592−001

2 feet (0.6 m) 01−048592−002

3 feet (0.9 m) 01−048592−003

10 feet (3 m) 01−048592−010

25 feet (7.6 m) 01−048592−025

50 feet (15.2 m) 01−048592−050

100 feet (30 m) 01−048592−100

Figure 2−4.

All rear−panel Crosspoint Bus connectors are 15−pin D, female. For Concerto and Trinix applications, the crosspoint bus must
be terminated at the point farthest from the control processor using a Crosspoint Bus Terminator, part number
01−053050−001. For other routers, no termination is required.

For specific wiring instructions concerning CC 2010 Crosspoint Bus Cables, please refer to the installation diagrams supplied
with your switcher.

For those who wish to prepare their own cables, pin−outs are shown in Figure 2−5. The cable itself should be Belden 9505
or equivalent. Steps should be taken to shield the connectors, e.g., using EMI housings or ferrite cores. Details concerning
ferrite cores are given in Figure 2−7.
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1 1

8

P1
DB15P
(male)

Shield (drain)

P2
DB15P
(male)

Figure 2−5. CC 2010 wiring. Reference: “Assembly, XPT Bus Cable Shield,” Grass Valley drawing no. 01−048592−TAB.
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CB 3000 Control Buffer

Figure 2−6. CB 3000.

SELECT
A

SELECT
B

CLEAR

A
POWER

B
POWER

REM/ALM
OUTPUT

(CONTROL)
BUSES CROSSPOINT

BUS LOOP

The CB 3000 Control Buffer is required for buffering crosspoint data when the system includes:

• More than 96 Venus crosspoint boards, or

• More than 50 TVS/TAS 3000 or TVS/TAS 2000 matrix boards, or

• If the Crosspoint Bus is sent to more than one equipment rack.

Each of the eight CB 3000 outputs can drive up to 50 (TVS/TAS) or up to 96 (Venus) crosspoint boards. See page 2−3.

For Trinix requirements, please refer to the “Planning” section of the Trinix Planning and Installation Manual.

Apex audio routers do not require a CB 3000—regardless of system expansion—because the crosspoint bus is connected only
to one chassis.

A CB 3000 may also be needed if the system includes more than one router type (e.g., a Trinix and an Apex) and one of the
routers is at or near the bus limit. For more information, contact Grass Valley.

Some systems may be equipped with one or more single−output CB 2000 Control Buffers rather than a CB 3000. Please refer
to the wiring information supplied with your switcher for details.

Each CB 3000 output contains two identical channels, with channel A normally used; this condition is indicated by the eight
green LEDs in the display window. If a fault is detected in channel A, that output will automatically switch to channel B; in
this case the green LEDs would be off and one or more red LEDs would be on. If a changeover occurs, first check to see if
the unit will return to normal operation by pressing the SELECT A button:

— If the unit returns to channel A operation, but a red LED remains on, press CLEAR. If the red LED(s) go off, it
can be assumed that the unit is fully operational.

— If the unit immediately returns to channel B operation, contact Grass Valley Technical Support.

For a description of the front panel window LEDs, see Appendix R.
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VDE EMI/RFI Modifications to Matrix Cables

User−supplied matrix cables for VDE installations require a ferrite core over each end of the cable, adjacent to the connector.

Figure 2−7.  Matrix cable VDE modifications.

Type 43 material
0.375 inch (9.53 mm) or larger inside diameter

0.95 inch (24.13 mm) length (or longer)

Type 43 material sources

Fair−Rite, part no. 2643625102

Fair−Rite Products Corp., P.O. Box J, Commercial
Row, Wallkill, NY 12589, USA; Tel. (914) 895−2055.

Chomerics, part no. 83−10−A637−1000

Chomerics Inc., 77 Dragon Ct., Woburn, MA 01888
USA; Tel. (617) 935−4850.

System protection features

ALARM MODES

The CM 4000 master alarm is asserted when:

• The main CPU (or a main CPU task) is not operating properly, or

• The power supply is not operating properly, or

• The unit is in the process of rebooting.

The master alarm condition is indicated by a “00,” “01,” or “FF” indication on the front panel LED display, and at the rear
panel Alarm BNC connector. Electrically, the Alarm BNC operates according to SMPTE standard 269M−1999. When an
alarm is asserted, the circuit associated with the Alarm connector will present a low impedance to an external current source
circuit provided by the customer. Figure 2−8 shows the CM alarm circuit (left) and an example of a customer−supplied indica-
tor circuit (right).

EXTERNAL CIRCUIT
(EXAMPLE)

NOT TO EXCEED
24 VDC @ 20 mA

REAR−PANEL BNC

Figure 2−8.
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SINGLE CM INSTALLATION

If the master alarm is asserted by the main CPU watchdog timer (and assuming that the power supply is operating properly),
the CM will be rebooted automatically.

REDUNDANT CM INSTALLATION

For additional protection, a redundant (slave) CM 4000 can be installed. The slave CM 4000 monitors the master.

If a master alarm condition is detected in the master unit, control will be switched to the slave automatically. Switch over to
the redundant unit is nearly instantaneous, providing minimal disruption to the control system. The controlling CM is indi-
cated by a green light on the Activate button.

• If the controlling slave CM should later enter an alarm condition and reboot, and the master has not in the mean-
time recovered, control will remain with the slave.

• If the controlling slave CM should later enter an alarm condition and reboot, and the master has recovered by
means of an automatic reboot (e.g., after a power interruption), control will return to the master.

Manual Changeover

To manually change operation from the master to the slave, press the Activate button on the front panel of the slave unit. To
return operation to the master, press the Activate button on the master unit.

Replacement of a Failed Redundant Unit

Protection can be further enhanced by maintaining a third CM as a “replacement” stand−by unit. This CM can be configured
in advance with the same network address as the master. Should the master fail, and the slave assume control, the third CM
would be installed on the network and the failed master removed; the operator could then manually switch control to the new
master. This would restore the system to the original master plus slave backup arrangement and allow repair of the failed unit
with no interruption in service. To prepare a third unit as a replacement in case of failure, please refer to Appendix K.

Installing Redundant CM 4000 Control Modules

In a dual CM system, the redundancy cable between the units is marked “Master” on one end; whichever CM is connected
to this end of the cable is always the master unit.

Wiring for redundant CM 4000s is shown in Figure 2−9. The BOP 4000 Break Out Panel is designed to be mounted in the
back of an equipment rack, behind the redundant CMs.
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Figure 2−9. Redundant CM 4000 installation.

CC−2010 Matrix (Cross-
point bus) cables

House sync required for vertical
interval switching.

Routing
switcher

CM 4000
Redundancy
Cable

Note: the BOP 4000 is supplied with a
redundancy cable kit. See Page 2−10.House time

code

Crosspoint
bus port

BOP 4000 Break
Out Panel

Hub

10/100baseT
Jupiter LAN
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BOP 4000 Break Out Panel kit Cables

CM 4000

1 ea. 
Redundancy
Cable

1.5 feet
(0.46 m)

F

M

M

8 ea. 
serial control
splitter cables

Note: Cables are supplied with connectors installed.

M

M

M

M

2 ea. 
crosspoint
bus cables

Rear of BOP 4000

CM 4000

3 feet
(0.91 m)

M =  male connector

3 feet
(0.91 m)

3 feet
(0.91 m)

3 feet
(0.91 m)

Master

M

M

Figure 2−10. BOP 4000 and cables. Assembly no. F7-029500-104.
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Connection to Serial−Control Routers

Figure 2−11. Connection to serial control routers (example).

Level 0

Serial Switcher

Crosspoint Bus port

Level 3

Serial Switcher
Level 4

Serial Switcher

Level 5

Serial Switcher

Levels 1, 2, 6

Grass Valley
Crosspoint Bus

Switcher

CM 4000 System Controller

House SMPTE
time code required

for deterministic
switching

Serial
Ports

House sync
required for

vertical inter-
val switching.

LAN

The CM 4000 System Controller can be used to control certain non−Crosspoint Bus switchers using serial interface ports
(Figure 2−11). Control of some of these routers is an extra−cost option; such routers are referred to as “remote” routers.§

A single CM 4000 can be used to operate one or more switchers through the Crosspoint Bus, while operating up to four sepa-
rate “serial” switchers through the serial ports.

Please note the restrictions for this application shown in Figure 2−12.

Note: Vertical interval switching of a switcher connected to a CM 4000 serial port depends on the sync system of
the switcher itself. Sync connections to the CM 4000 have no effect on the operation of the serial switcher.

The CM 4000 must be configured using the Network Description table (page 5−27); Serial Protocol table (page 5−30), and
Switcher Description table (page 5−35).

Please refer to the following pages for details concerning each switcher type. The manual supplied with the switcher should
also be checked for port configuration instructions.

§ For more information about Jupiter options, see page 1−27.
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Figure 2−12. Serial−control switcher restrictions.

Only one remote
switcher of a given type
can be connected to a
single CM 4000.

Physical levels cannot be duplicated on a CM 4000
(unless Logical Level Mapping [page 2−29] is used;
or, the “400” offset method [footnote on page 5−42]
is used).

Level 1

Serial−control
Switcher

Level 1

Grass Valley
Crosspoint Bus

Switcher

Serial−control
Switcher

Serial−control
Switcher
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TRITON SYSTEMS

Triton routers are connected using a CM 4000 serial port. Multiple Triton chassis can be connected to a single CM, but only
if all them are connected on the same MIDI bus and connected through the same single serial port. If more than one Triton
MIDI bus is needed, the switchers on that bus must be connected to another CM.

The serial connector on Triton routers is a 9−pin RS−232 signal level port. Since the CM has RS−422 ports, a RS−422 to
RS−232 converter must be used to ensure reliable communications. Please refer to Figure 2−13.

Figure 2−13. Example of connection to Triton distribution switchers.

See Figure 2−14 for
cable details

Triton protocol

† A Triton−to−Jupiter Serial Control Kit
is available from Grass Valley. See
text for details.

RS−422/232
converter†

RS−232  port

MIDI bus loop

Triton Video

Triton L + R  Audio

20 units maximum

Router address “0”

Router address “2”

House sync required
for vertical interval
switching (analog
units). See Triton

manual for details.

CM 4000 System Controller

Serial
Ports

LAN

A Triton−to−Jupiter Serial Control Kit, available from Grass Valley, includes a B&B Electronics 422COR RS−232/RS−422
Converter, a B&B Universal Power Supply, a 25 ft. (7.6 m) VM/CM to Converter Cable, and a 5 ft. (7.6 m) Converter to Triton
Cable. The part number of this kit is 44-050456-001.

Multiple Triton switchers are connected with a MIDI bus loop (as detailed in the Triton manual). In a typical video/audio
switching application, each chassis is set with a unique “Router Address” from 0 to 15 (DIP switches 1−4 on the rear panel).
Note that split switching is possible, but only between chassis; e.g., Audio Left/Right can be split from Video, but Audio Left
cannot be split from Audio Right.

In RGB or YUV applications where all three signals must always switch together, the Router Address should be set to the
same value on each chassis.
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Up to 20 chassis can be connected in one MIDI loop.

Note 1: Some Triton switchers have front−panel controls. to be shown on Jupiter control panels. These controls
will operate normally when the router is connected to a Jupiter system but Jupiter 6.0 and after software is required
in order for Triton status to be indicated on Jupiter panels.

Note 2: All RS−232/422 connections should be complete and all MIDI bus loop connections should be made and
terminated at the originating device before applying power to the Triton router.

In order for a Triton analog video router to switch on Vertical Interval as set in the Switcher Description Table, rear−panel
DIP 7 must be DOWN and a sync reference signal must be connected to Input No. 1. The reference signal must be composite
video, 1 Vpp, 300 mV sync, 75 ohms. For more information, refer to the Triton manual.

Figure 2−14. Cables for connecting CM 4000 to Triton RS−232 port.
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Software Configuration

The CM connected to the Triton router must be configured using the Network Description table (page 5−27) and Serial Proto-
col table (page 5−30).

Triton configuration is similar to that for other routers, beginning with the Switcher Description table (page 5−35). From that
point, switcher inputs, outputs, a CP Level Set, and CP input/Output Sets must be defined.
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SMS 7000 CONNECTIONS

The CM 4000 can be connected to a Grass Valley SMS 7000 Signal Management System and router (see Figure 2−15). The
protocol setting is: 38400 baud, 8 data bits, no parity, 1 stop bit.

The serial cable on the back of the SMS 7000 controller frame may be labeled RS−232, but it can and should function as
RS−422 if configured in software. The CM 4000 is connected to one of the DB25 or DB9 ports on the back of the SMS 7000
controller frame. Refer to the manual supplied with the SMS 7000 for instructions on setting the port up for RS−422 and set-
ting the serial parameters.

Figure 2−15. Connection to SMS 7000 Control System.

See page 2−16 for a description of this cable
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Software Configuration

The CM 4000 connected to the SMS 7000 must be configured using the Network Description table (page 5−27) and Serial
Protocol table (page 5−30).

The router must be defined on the Switcher Description table (page 5−35). From that point, switcher inputs, outputs, a CP
Level Set, and CP input/Output Sets must be defined.
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Figure 2−16. Cable for connecting CM 4000 to SMS 7000 DB9 port.
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Figure 2−17. Cables for connecting CM 4000 to SMS 7000 DB25 port.
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JUPITER CONTROL OF ENCORE

The CM 4000 can send switching commands to a Grass Valley Encore control system (which can in turn send the commands
to a router).

The serial ports on the back of the Encore System Controller Board (SCB) use RJ45 connectors; the port selected for the CM
connection must be configured for RS−422 operation with an internal jumper. For more information about the SCB ports,
refer to the Encore installation and user manuals.

Non−Redundant Installation

See Figure 2−18.

Figure 2−18. Connection to non−redundant Encore Control
System. See following figures for cable variations.
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Cabling

A Cat5 factory cable kit is available in two versions: If the SCB is the old style (071 0884 xx series), order kit 174 8216 xx.
If the SCB is the new style (071 1000 xx series), order kit 174 8217 xx. The factory cable must be used with a customer−sup-
plied adapter, wired as shown in Figure 2−19. Note that  the factory cable is eight inches long. A customer−supplied standard
Cat5 cable (and coupler) can be added if needed. Further instructions are provided with the cable kit.

Figure 2−19. Factory−supplied
Encore/Jupiter serial cable and
customer−supplied items

RJ45 female to 9−pin D male adapter at-
taches directly to CM serial port. Internal
wiring is per Figure 2−21.

8−inch cable supplied with Encore Y Cable
Kit. (Type depends on SCB model; refer to
text for ordering information.)

To SCB RS−422 port

Customer−supplied items

Standard Cat5 cable (max. 250 feet)

Standard Cat5 coupler
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For those who wish to prepare their own cable: if the SCB is the old style (071 0884 xx series), build the cable as shown in
Figure 2−20; if the SCB is the new style (071 1000 xx), build the cable as shown in Figure 2−21. (No adapter is needed when
the cable is custom−built).
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Figure 2−20. Customer−supplied cable
for connecting CM 4000 to old−style
Encore SCB (061 0884 xx series).
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Software Configuration

The CM 4000 connected to the Encore must be configured using the Network Description table (page 5−27) and Serial Proto-
col table (page 5−30).

When Jupiter is controlling Encore, the Serial protocol setting is: GNP (Grass Valley Native Protocol), 9600 baud.

The router must be defined on the Switcher Description table (page 5−35). From that point, switcher inputs, outputs, a CP
Level Set, and CP input/Output Sets must be defined.

Note: If Encore is controlling Jupiter, different software settings are required. See page 2−91.

Redundant Installation

Some Encore systems may be equipped with redundant System Controller Boards (SCBs). In this case, the recommended
arrangement is to install a redundant CM 4000 and connect the CMs to the SCBs with a BOP 4000 Break Out Panel. See Figure
2−22.

Figure 2−22. Connection to redundant
Encore Control System. See following
figures for cable variations.

to routing switcher

Encore Redundant SCBs

Redundant CM 4000 System Controllers

RS−422
ports

Serial Port
Serial Port

BOP 4000 Break Out Panel

LAN LAN

Details of the Encore connection are presented below.
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Double−Y Cable

Please refer to Figure 2−23.

A Cat5 factory cable kit is available in two versions: If the SCB is the old style (071 0884 xx series), order kit 174 8216 xx.
If the SCB is the new style (071 1000 xx series), order kit 174 8217 xx. The factory cable must be used with a customer−sup-
plied adapter, wired as shown in Figure 2−21 on page 2−18. Note that  the cables in this kit are eight inches long. Further
instructions are provided with the cable kit.

The rack mount BOP 4000 Break Out Panel / cable kit is available for making Y connections to redundant CMs. For more
information, see page 2−8 and following.

Figure 2−23. Factory−supplied
Encore/Jupiter serial cables
and customer−supplied items

RJ45 female to 9−pin D male adapter. In-
ternal wiring is per Figure 2−21.
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For those who wish to prepare their own cable: if the SCB is the old style (071 0884 xx series), build the cable as shown in
Figure 2−24; if the SCB is the new style (071 1000 xx), build the cable as shown in Figure 2−25.
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Figure 2−24. Customer−supplied cable for
connecting redundant CM 4000s to old−style
redundant Encore SCBs (061 0884 xx series).
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Figure 2−25. Customer−supplied cable for
connecting redundant CM 4000s to new−style
redundant Encore SCBs (061 1000 xx series).
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Software Configuration (Redundant Systems)

Software configuration for redundant systems is much the same as that already described for non−redundant systems (page
2−19), except that two CM 4000s and two CM serial ports are configured.
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HORIZON CONNECTIONS

The CM 4000 can be connected to a Horizon matrix router through the General Purpose Interface with Terminal/Computer
Interface software (GPI−T/CI) (see Figure 2−26). The protocol for the GPI−T/CI RS−422 port must be set at: 38400 baud,
8 data bits, even parity, and 1 stop bit (refer to the Horizon GPI−T/CI Manual for configuration instructions).

Figure 2−26. Connection to Horizon matrix router.

See Figure 2−27 for a description of this cable
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Figure 2−27. Cable for connecting CM 4000 to Horizon matrix router.
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DATATEK D−2000/2166 CONNECTIONS

The CM 4000 can be connected to a Datatek D−2166 Buffer Control Module, which in turn is connected to a D−2000 Series
routing switcher (see page 2−24). The protocol setting is: 38400 baud, 8 data bits, even parity, 1 stop bit.

Although the CM 4000 is connected to one of the D−2166 Buffer Control Module ports labelled “RS−232,” the port must
be set with an internal jumper to operate according to RS−422. Refer to the manual supplied with the D−2166 for more infor-
mation.

Figure 2−28. Connection to Datatek D−2166 Buffer Control Module.

See Figure 2−29 for a description of this cable

Datatek protocol
“RS−232−C A” or

“RS−232−C B”  port
jumpered for RS−422 operation

to D−2000 series routing switcher

D−2167 Buffer Interface and
D−2166 Buffer Control Module
in DF−2115 Rack Frame

House time
code

(optional).
See pg.

2−64

CM 4000 System Controller

Serial Port

LAN

Figure 2−29. Cable for connecting CM 4000
to Datatek D−2166 Buffer Control Module.
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UTAH SCIENTIFIC PARTY LINE CONNECTION USING UDI−1B

The CM 4000 can be connected to a Utah Scientific Party Line through a UDI−1B Universal Data Interface (see Figure 2−30).
Some UDI−1B units are equipped with a 9−pin RS−422 port; others are equipped with a 25−pin RS−232 port. Either type can
be used.

The protocol for the UDI−1B  port must be set at: 9600 baud, 7 data bits, even parity, and 2 stop bits. The UDI−1B must be
equipped with software version 81.4 or later. The UDI−1B “AUX” rotary switch needs to be set to “E” for “PL−160 Mode”
and to enable all mode commands. Refer to the UDI−1B manual for detailed procedures.

Figure 2−30. Connection to Utah Scientific Party Line.

See Figure 2−31 for a description of this cable
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Figure 2−31. Cable for connecting CM 4000 to UDI−1B RS−422 port.
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Figure 2−32. Cables for connecting CM 4000 to UDI−1B RS−232 port.
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NEXUS AUDIO ROUTING SYSTEM

Nexus audio routers can be controlled using the hardware connections shown in Figure 2−33. The Nexus switcher requires
special PROMs for this application (please contact Grass Valley for more information).

Figure 2−33. Connection to Nexus audio router.

See Figure 2−34 or 2−35 for a description of this cable
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The Nexus router has two ports that can be used for connection to Jupiter: the “XCI” port and the “XCPU” port. Field reports
suggest that the XCI port be used if possible. The pinouts for both ports are shown below.

Figure 2−34. Cable for connecting CM 4000 to Nexus audio router XCI port.
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Figure 2−35. Cable for connecting CM 4000 to Nexus audio router XCPU port.
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Logical Level Mapping 

In these systems, the same physical level number is used on more than one logical level. For example, a switcher could have
video on level 1, left audio on level 2, and right audio also on level 2. In Figure 2−36, a 60 x 60 audio level is being used as
two 60 x 30 switchers, i.e., with half the outputs assigned to the left channel and the other half to the right channel.

This technique can sometimes help reduce overall switcher size, but requires special entries to the Switcher Description table
and the Switcher Outputs table. See Step 9(i) on page 5−41.

Figure 2−36. Logical level mapping (example).
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Data Matrix Switching

The Jupiter system can be used to control RS−232, RS−422, and RS−423 data switchers. In a typical application, a Venus data
matrix switcher can be used to route RS−422 machine control signals.

Older model Venus switchers equipped with DM 400 or DM 400A Data Matrix boards require crossover or Y−line cables.
Newer model Venus systems are equipped with the DM 400B Data Matrix boards; these boards have software−configurable
rear−panel pinout functions and do not require crossover or Y−line cables.§

Hardware Connections

For complete information regarding jumper settings and cabling, refer to the technical manual supplied with the data switcher.

Software Configuration

— For DM 400/400A Data Matrix boards, refer to Appendix L.

— For an overview of DM 400B configuration, see page 5−52. Entries are required on the Switcher Description
table (page 5−35), Switcher Input table (page 5−48), Switcher Output table (page 5−55), CP Input Set (page
5−62), and CP Output Set (page 5−78).

§Type and model of switcher card is shown on front edge of printed circuit board.



Hardware Installation

2−31CM 4000 Installation and Operating Manual

Connection to Multiple Crosspoint Bus Distribution Switchers

CONNECTION USING A SINGLE CM 4000

A single CM 4000 control board can be used to control more than one Crosspoint Bus switcher; however, each physical level
must have a unique number. When expanding a system in the field, this may require changing DIP switches or jumpers on
the hardware. See Figure 2−37.

Note: Figure 2−37 pictures a mixture of TVS and Venus routers. This is possible only if all switchers are configured
to operate on the same type (Super) Crosspoint Bus. For example, older TVS 2000 matrix cards are not capable
of operating on Super Crosspoint Bus, but a newer State machine PROM is available which permits Super Cross-
point Bus operations (each TVS 2000 board requires the newer State Machine PROM). Later versions of TVS
2000/3000 switchers were shipped with this PROM already installed; a DIP switch setting selects between Super
and Extended Crosspoint Bus.

Figure 2−37. Multiple switcher installation with single CM 4000.
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DEDICATED CM 4000 PER SWITCHER

By using separate CM 4000s, physical level numbers may be duplicated from one switcher to another. When expanding a
system in the field, this will eliminate the need to change DIP switches or jumpers on the hardware. See Figure 2−38.

Figure 2−38. Multiple switcher installation with dedicated CM 4000s.
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Connection to Multiple Distribution Switchers with Path Finding

Note: Data router pathfinding is not supported.

The path finding software option allows two or more Jupiter−controlled routing switchers to operate as a system, where one
switcher can access the other’s inputs through a number of tie lines. Tie lines can vary in number from one switcher to another,
and from one level to another.

Two wiring schemes can be used: sequential wiring, where tie lines are organized in blocks (as shown on page 2−34); and
non−sequential wiring (as shown on page 2−35). Sequential wiring requires entries to only one file server table (the “Path
finding Data Table,” shown on page 5−174). Non−sequential wiring requires use of an additional table (the “Non−Sequential
Path finding Data Table,” shown on page 5−185.)

SEQUENTIAL PATH FINDING (PATH FINDING USING SEQUENTIAL WIRING)

Connections can start with any input or output number, but thereafter must be sequential. Page 2−34 shows example connec-
tions for one level. Notice that the lowest number in an output group must be connected to the lowest number in the corre-
sponding input group, and so on.

Due to distance limitations of the CC−2010 Matrix cable, it may necessary to install a separate CM 4000 System Controller
for each switcher.

See page 5−174 for an overview of sequential path finding and software configuration requirements.

NON−SEQUENTIAL PATH FINDING (PATH FINDING USING NON−SEQUENTIAL WIRING)

In some cases, especially when adding tie lines to an existing system, wiring new lines out of sequence may be desirable. Page
2−35 shows example connections for one level.

Due to distance limitations of the CC−2010 Matrix cable, installing a separate CM 4000 System Controller for each switcher
may be necessary.

See page 5−174 for an overview of path finding and software configuration; then refer to page 5−185 for additional non−se-
quential path finding requirements.
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Figure 2−39. Sequential path finding connections (example).
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Figure 2−40. Non−sequential path finding connections (example).
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Installing File Server PC

Minimum hardware and software requirements have already been described (page 1−8). Follow the instructions supplied with
the file server for connection of monitor, keyboard, and mouse.

JUPITER LAN

Jupiter file server(s) are connected to the CM 4000 through an IP hub, switch, or media converter via the “Jupiter LAN.”

The Jupiter LAN is an IEEE 802.3 10/100BaseT network using a twisted pair cable with RJ−45 connectors (Cat 5E Enhanced
is recommended). Shielded cable is also recommended, maximum length 60 meters. Compliance with EEC, EMC, EN series,
UL− 1950, and CSA C22.2 No. 950−M89 standards requires use of a shielded cable.

Maximum length for unshielded cable is 100 meters.

Note: Other than IP devices such as hubs, connection of non−Jupiter equipment to the Jupiter LAN is not recom-
mended and will not be supported.

Jupiter File Server

Figure 2−41. PC−to−CM connections..
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PRINTER

A printer can be connected to the LPT1 port and used to print the contents of an entire Configuration Set in a 132−column
format; it can also be used to print the contents of individual tables (page 5−21).

SOFTWARE INSTALLATION

Procedures for installing the Jupiter software on the file server are found in the Field Engineering Bulletin supplied with the
software.

Installing “Remote” PC on LAN 

A second PC can be installed on the Jupiter LAN in addition to the PC used as the file server. This “remote” PC can be used
for certain Jupiter Network Suite (JNS) applications. For details concerning installation, see Appendix I. For information
about JNS see page 4−1.
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Installing Control Panels

CONNECTIONS T0 CM 4000

Figure 2−42. Control panel connections to CM 4000.
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For Jupiter LAN cable specifications, see page 2−36.
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SWITCHER CONTROL PANELS

CP 300 Series

Power supply requirements − A wall plug−in power supply is supplied with each 300 Series panel that will be used with
110 VAC 60 Hz power. Panels that are to be used in areas where 220VAC 50Hz power is the norm are not shipped with any
power supply; the user in these areas must provide a source of regulated 5 VDC power to each panel. The power requirement
is +5 VDC +/− 0.25 V at  600 mA. The power connector used on the 300 Series PC board is an RL11A (female) made by LZR
Electronics; Grass Valley part no. 30−005724−007.

Note: An optional PS 300 power adaptor kit provides all hardware needed to modify one CP 300 Series control
panel for direct connection to a power line. See Appendix Q.

DIP switch settings − A DIP switch, accessible through an opening in the rear panel, must be set with switch 8 OFF when
a 300 Series panel is used in a Jupiter system; the remaining seven switches are ignored. This sets the panel address to the
one stored in PROM (which is stamped on the rear panel).
 

CP 300 24 X 1 Single Bus Control Panel

Installation is shown on page 2−37.

CHG
VID

CHG
A1

CHG
A2

CHG
A3

CHG
A4

CHG
A5

0 1 2

Figure 2−43. CP 300 Control Panel (as supplied).

(etc.)

The CP 300 is a single bus control panel that can select one of 24 inputs. The push buttons illuminate to indicate status and
can be fitted by the user with transparent labels. The panel is shipped with input and level labels as shown in Figure 2−43—any
other labels must be created by the user (please see page 2−58 for more information about installing labels).

The bus to be controlled is entered in the “Output Set” assigned on the MPK Devices table (page 5−107). Also entered on
the MPK Device table is an Override Set for the panel; the Override Set (page 5−96) determines which button is as-
signed to which source. The left−hand button of the CP 300 (the “0” button in Figure 2−43) will select the first input listed
on the Override Set created and selected for this particular panel.

Six Level keys are provided on the right side of the panel for split (breakaway) switching and statusing.

For operating instructions, see page 6−1.
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CP 310 24 X 8 Eight Bus Control Panel

Installation is shown on page 2−37.

Figure 2−44. CP 310 Control Panel (as supplied).

0 1 2 (etc.)
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The CP 310 Control Panel is very similar to the CP 300 Control Panel, except that eight buttons on the left side of the panel
are used to control eight outputs. Refer to the CP 300 discussion (page 2−38) for installation instructions.

The buses to be controlled are listed in an “Output Set” (page 5−78); the name of the Output Set is entered on the MPK Devices
table (page 5−107).

For operating instructions, see page 6−2.
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CP 320 Push Button Control Panel

Installation of this panel is shown on page 2−37.

Figure 2−45. CP 320 Push Button Control Panel (as supplied).
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The CP 320 is a full−matrix, category/number control panel. The left-most mnemonic display shows switcher destination
(output being controlled), the center display shows the input category/number just selected, and the right indicates switcher
status (input now switched to the destination shown).

Sixteen buttons in the center are labeled with input/output categories; this allows the first button press to designate the cate-
gory and the second button press to designate the selection number. The factory−supplied categories (“VTR,” “CG,” etc.) can
be changed by installing new labels (see page 2−58) and creating a custom category set (see Step 5 on page 5−66.)

Two buttons are located on the far right, the top button for protecting an input and the bottom button for performing a TAKE
of the selected input/output. Buttons are also provided for changing the output to be controlled and for selection of specific
levels (split switching).

The CP 320 panel is configured using the MPK Devices table (page 5−107). For operating instructions, see page 6−3.

CP 328 Push Button Control Panel

Hardware installation and operation of the CP 328 is the same as the CP 320. Software configuration is slightly different due
to the eight−character display windows. See Step 10 on page 5−69.
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CP 330 Control Panel

Installation of this panel is shown on page 2−37.

Figure 2−46. CP−330 Control Panel (as supplied).
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The CP 330 can be configured to operate as a 48 x 1 panel, or, as a 24 x 2 panel with the top row of buttons assigned to one
output and the bottom row to another.

Installation is very similar to the CP 300 (page 2−38). However, for the 24 x 2 application, on the MPK Devices table, a “Y”
is entered in the Expansion Panel column, and, the entry in the Output Set column is the name of an actual Output Set. This
Output Set must show the names of the two destinations.

For operating instructions, see page 6−1. 

CP 330/6 48 x 6 Six Bus Control Panel

Installation of this panel is shown on page 2−37.

Figure 2−47. CP−330/6 Control Panel (as supplied).

0 1 2

3 4 5

0 1 2 (etc.)

The CP 330/6 Control Panel is very similar to the CP 300 Control Panel, except that six buttons on the right side of the panel
are used to control six outputs. Refer to the CP 300 discussion (page 2−38) for installation instructions.

The buses to be controlled are listed in an “Output Set” (page 5−78); the name of the Output Set is entered on the MPK Devices
table (page 5−107).

For operating instructions, see page 6−5.
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CP 3000 Switcher Control Panel and CP 3010 Expansion Panel

Installation of these panels is shown on page 2−37.

The basic control panel, referred to as the CP 3000, can be configured for single−bus operation (allowing selection of a source
for one destination), multi−bus operation (allowing selection of a source for several destinations), or full matrix operation
(selection of a source for any destination). This panel can be arranged to select one of 20 source categories (VTR, CAM, etc.)
and then, using a 10−key pad, a unit within the category. Crosspoint status is provided by the display window. Additional push
buttons provide breakaway (control of individual switcher levels such as left audio, time code, etc), chop, lock, protect, and
override switching. A password can be assigned to the panel if desired. 

The CP 3000 can also be operated in connection with an adjacent CP 3010 expansion panel (see Figure 2−49). For multi−bus
control the desired source can be selected on the CP 3000; the CP 3010 would then display the names of eight destinations,
beneath which are eight corresponding TAKE keys; one of these would be pressed to complete the switch. The page of eight
destinations can be scrolled to display up to 160 possible destinations. A blank panel is supplied when the CP 3000 is mounted
without a CP 3010.

Note: The original version of the CP 3000 panel can now be retrofitted in the field with re−legendable keys, using
the CP 3000RBK Relegendable Button Kit, part no. 44−046025−001.

The CP 3000/3010  panels are configured using the MPK Devices table (page 5−107).

For operating instructions, see page 6−7.
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CP 3020 Push Button Control Panel

Figure 2−50. CP 3020 Push Button Control Panel with example labels.

C1 C2 C3 C4 T1 T2 R1 R2 NTV1 V2 V3 V4 V5 SA SB E1 E2 E3 LOCK CHOPV6

Installation of this panel is shown on page 2−37.

The CP 3020 is a single−bus control panel that can select one of 20 inputs. The push buttons illuminate to indicate status and
can be fitted by the user with transparent labels. The panel is shipped with “Lock” and “Chop” labels and a general purpose
“0−99” label set—any other labels must be created by the user (please see page 2−58 for more information about installing
labels).

The logical name of the switcher bus (output) that is to be controlled is entered in the “OutSet” column on the MPK Devices
Table (page 5−107). Also entered on the MPK Device table is an Override Set for the panel; the Override Set (page 5−96)
determines which button is assigned to which source. The left−hand button of the CP 3020 (the “V1” button in Figure 2−50)
will select the first input listed on the Override Set created and selected for this particular panel.

For operating instructions, see page 6−26.

CP 3021 Push Button Expansion Panel

Figure 2−51. CP 3020 Push Button Control Panel with CP 3021 Push Button Expansion Panel with example labels.

LO1 LO2 LO3 LO4 81 82 41 42 DMM1 M2 M3 M4 M5 LR LS P1 P2 P3RR

C1 C2 C3 C4 T1 T2 R1 R2 NTV1 V2 V3 V4 V5 SA SB E1 E2 E3 LOCK CHOPV6

Up to four CP 3021 Push Button Expansion panels can be added to the CP 3020, allowing button−per−input selection of up
to 100 inputs. Each CP 3021 is supplied with a 12−inch (305 mm) ribbon cable with installed 37−pin connectors; the cables
loop through each expansion unit.

The left−hand button of the CP 3020 (the “V1” button in Figure 2−51) will select the first input listed on the Override Set
created and selected for this particular CP 3020. The left−hand button of the first CP 3021 on the ribbon wire bus (the “M1”
button in this example) will select the 21st input listed, etc.

Note: The “remote” connector of the CP 3020 must be connected to the “input” connector of the first CP 3021;
the “output” connector of that CP 3021 must be connected to the “input” connector of the next CP 3021, etc.
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CP 3800 Eight Character Control Panel 

Installation of this panel is shown on page 2−37.

Figure 2−52.
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The CP 3800 is a universal, eight−character mnemonic, switcher and machine control panel.

This control panel uses an eight−character “CP 3800” type CP Level Set (page 5−58), CP Input Set (page 5−62) and CP Output
Set (page 5−78). These sets, and others, are assigned to the panel using the MPK Devices table (page 5−107). and if used for
machine control, the Machine Control Devices table (page 5−135). It can also use custom CP Category Sets (page 5−102).

For operating instructions, see page 6−27.
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CP 3808 Control Panel

Figure 2−53. CP 3808.
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The CP 3808 control panel is a 16−category, full−matrix,* multiple level breakaway panel capable of locking and protecting
outputs. The panel features eight−character display capability and relegendable, lighted push buttons.

As an option, the CP 3808 can be operated in connection with an adjacent CP 3809 Expansion Panel (see page 2−48) or a
CP 3810 Expansion Panel (see page 2−54).

Hardware installation

Installation of this panel is shown on page 2−37.

If desired, the panel hardware can be tested, and window/button brightness adjusted, without being connected to the controller
board (CM 4000). For more information, see Diagnostics Mode on page 6−71.

Software configuration

The CP 3808 panel can display eight−character mnemonics for inputs and outputs. To accomplish this create a CP Level Set of
type “3800” (page 5−58), a CP Input Set of type “3808” (page 5−67), and a CP Output Set of type “3808” (page 5−82).  These
sets are among those assigned to each panel using the MPK Devices table (page 5−107).

Although the panel is capable of full−matrix operation, it can be restricted to control selected outputs, or even restricted to
control of a single output if desired. Such restrictions are made using the MPK Devices table (page 5−112).

Since the keycaps are relegendable, the CP 3808’s CP Input and Output Sets can use a custom CP Category set (page 5−102).

Before the panel can be used, these sets must be compiled, and the appropriate configuration set made active using the Control
Center (page 5−13).

Operation

For operating instructions, see page 6−64.

* Defined in Glossary Section
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CP 3824 Control Panel
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Figure 2−54. CP 3824.

The CP 3824 control panel is a locally−programmable, full−matrix,* multiple level breakaway panel capable of locking and
protecting outputs. The panel features eight−character display capability and relegendable, lighted push buttons. The 24 but-
ton−per−source keys on the left side of the panel are initially assigned to inputs from the file server, but some or all can be
re−assigned to new inputs at any time using only the panel itself. Sources can also be selected by scrolling up/down an LED
display of “Preset” mnemonics or by using the Category/Number keypad.

Hardware installation

Installation of this panel is shown on page 2−37.

For information about changing keycap labels, see page 2−58.

If desired, the panel hardware can be tested, and window/button brightness adjusted, without being connected to the controller
board (CM 4000). For more information, see Diagnostics Mode on page 6−87.

Software configuration

The panel can display eight−character mnemonics for inputs and outputs. This is accomplished by creating a CP Level Set of
type “3800” (page 5−58), a CP Input Set of type “3824” (page 5−67), and a CP Output Set of type “3824” (page 5−82). These
sets are among those assigned to each panel using the MPK Devices table (page 5−107). Also entered on the MPK Device table
is an Override Set for the panel (page 5−96); this set determines which of the 24 button−per−source buttons is assigned to
which source. The upper left−hand button of the CP 3824 (the “1” button in Figure 2−54) will select the first input listed on the
Override Set created and selected for this particular panel.

Although the panel is capable of full−matrix operation, it can be restricted to control selected outputs, or even restricted to
control of a single output if desired. Such restrictions are made using the MPK Devices table (page 5−112).

Since the keycaps are relegendable, the CP 3824’s CP Input and Output Sets can use a custom CP Category set (page 5−102).

Before the panel can be used, these sets must be compiled, and the appropriate configuration set made active using the Control
Center (page 5−13).

Operation

For operating instructions, see page 6−76.

* Defined in Glossary Section
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CP 3830 Control Panel

Figure 2−55. CP 3830.
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The CP 3830 Control Panel is a 12−category, full−matrix,* multiple−level* breakaway* panel which is capable of locking,*
protecting,* and chopping* outputs. The panel features eight−character display capability and relegendable, lighted push but-
tons.

As an option, the CP 3830 can be operated in connection with an adjacent CP 3809 Expansion Panel (see page 2−48) or a
CP 3810 Expansion Panel (see page 2−54).

Dual CP 3830 panels can be configured so that one of the panels is always used for destination selection (see page 5−126).
Dual output mode is also possible with two panels side by side.

Hardware installation

Installation of this panel is shown on page 2−37.

If desired, the panel hardware can be tested, and window/button brightness adjusted, without being connected to the controller
board (CM 4000). For more information, see Diagnostics Mode on page 6−87.

Software configuration

The panel can display eight−character mnemonics for inputs and outputs. To accomplish this, create a CP Level Set of type
“3800” (page 5−58), a CP Input Set of type “3830” (page 5−67), and a CP Output Set of type “3830” (page 5−82). These sets
are among those assigned to each panel using the MPK Devices table (page 5−107).

Although the panel is capable of full−matrix operation, it can be restricted to control of selected outputs, or even restricted
to control a single output if desired. Such restrictions are made using the MPK Devices table (page 5−112).

Since the keycaps are relegendable, the CP 3830’s CP Input and Output Sets can use a custom CP Category set (page 5−102).

Before the panel can be used, these sets must be compiled, and the appropriate configuration set made active using the Control
Center (page 5−13).

Operation

For operating instructions, see page 6−88.

* Defined in Glossary Section
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CP 3809 Expansion Panel

Up to five optional CP 3809 panels can be associated with a CP 3808 or CP 3830 (but not CP 3830P), providing direct switch-
ing and continuous status for up to 40 outputs.

Figure 2−56 illustrates a CP 3808 with a CP 3809 array for control of 24 outputs.
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Figure 2−56. CP 3808/E (top) with CP 3809/2 Dual Expansion Panel (below).
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Hardware installation

Installation of this panel is shown on page 2−37. Note that each CP 3809 Expansion panel requires a separate MPK connec-
tion.

If desired, the panel hardware can be tested, and window/button brightness adjusted, without being connected to the controller
board (CM 4000). For more information, see Diagnostics Mode on page 6−125.

Software configuration

Each CP 3809 Expansion panel requires a separate entry on the MPK Devices table. See “Out Panel” on page 5−108.

The MPK Devices table entry for the main panel (CP 3808 or CP 3830) must have a check mark in the “Expansion” box. The
MPK Devices table entry for the CP 3809(s) must not have a check mark. See “Expansion” on page 5−109.

Note: The MPK Devices table entry for the CP 3809 must identify the associated CP 3808 or CP 3830 in the Out
Panel column. See page 5−111.

The CP 3809 Expansion Panel keys are assigned to outputs using the CP Output table (page 5−78). Buttons that are left un-
assigned can be assigned dynamically by the operator (page 6−124).

Operation

For operating instructions, see page 6−124.
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CP 3832 Control Panel
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Figure 2−57. CP 3832.

The CP 3832 is a multiple−level* breakaway* panel which is capable of locking,* and protecting* outputs. The panel features
eight−character display capability and relegendable, lighted push buttons.

The panel can also be configured as a type “CP 3832L,” in which the right−hand group of six buttons are used for level selec-
tion and the panel operates in “sticky levels”* mode. In this case, the “Level” button shown in Figure 2−57 is used to access
the first level in the panel’s Level Set (typically video), the “Menu” button is used for the second level (e.g., left audio), etc.

Both the CP 3832 and the CP 3832L can be configured as a 32 x 1 single bus panel (Figure 2−58), as a 16 x 16 “balanced
split” panel (Figure 2−59), or as some variation of an “unbalanced split” panel (Figure 2−60).

Figure 2−58. Single−bus
configuration.

32
sources

Figure 2−59. “Balanced
split” configuration.

16
sources

16
destinations

Figure 2−60. Example of “unbal-
anced split” configuration (22 x
10).

22
sources

10
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Unbalanced split panels can be configured to control from 1 to 15 outputs, with keys not used for outputs available to control
inputs. For example, if 10 buttons are assigned to outputs then 22 buttons are available for inputs.

Control of additional inputs/outputs is possible using adjacent CP 3832 or CP 3864 expansion panels (page 2−53); the CP
3832 can be also be operated in connection with an adjacent CP 3810 Expansion Panel (see page 2−54).

Note: The CP 3832 cannot be used with an expansion panel if the panel is configured in an unbalanced split
configuration or as a CP 3832L.

* Defined in Glossary Section
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Hardware Installation

Installation of this panel is shown on page 2−37.

If desired, the panel hardware can be tested, and window/button brightness adjusted, without being connected to the controller
board (such as a CM 4000). For more information, see Diagnostics Mode on page 6−112.

Software Configuration

The panel uses an eight−character CP Level Set of type “3800” (page 5−58).

MPK table entries will depend on the application (see page 5−107).

Sources are defined in a CP Input Set of type “cp3832” (page 5−62). Destinations are defined in a CP Output Set of type
“cp3832” (page 5−78).

Before the panel can be used, these sets must be compiled, and the appropriate configuration set made active using the Control
Center (page 5−13).

For CP 3832 operating instructions, see page 6−100.

For CP 3832L operating instructions, see page 6−117.
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CP 3864 Control Panel

VTR1 VTR2 VTR3 VTR4

VTR5 VTR6 VTR7 VTR8

CAM1 CAM2 CAM3 CAM4

CAM5 CAM6 CAM7 CAM8

BLACK BARS TONE CG−1SILENCE CG−2 CG−3 CG−4

EBS1 EBS2 TEST1 TEST2 FDL1 FDL2 FDL3 FDL4

MON1 MON2 MON3 MON4

MON8MON6MON6MON5

STU1 STU2 STU3 STU4

EDIT1 EDIT2 EDIT3 EDIT4

PST PGM AIR KEY1

KEY2 BACK
UP

BY
PASS XMIT

VTR1 VTR2 VTR3 VTR4

VTR5 VTR6 VTR7 VTR8

Level Menu Clear

ChopLock/
Prot

Pre−
set

Take

CURRENT

PRESET

DESTINATION

Figure 2−61. CP 3864.

VTR−041

VTR−041

MONITOR5

The CP 3864 is a multiple−level* breakaway* panel which is capable of locking,* protecting,* and chopping* outputs. The
panel features eight−character display capability and relegendable, lighted push buttons.

The panel can also be configured as a type “CP 3864L,” in which the upper right−hand group of six buttons are used for level
selection and the panel operates in “sticky levels”* mode. In this case, the “Level” button shown in Figure 2−61 is used to
access the first level in the panel’s Level Set (typically video), the “Menu” button is used for the second level (e.g., left audio),
etc. The Take button is used as a Protect key.

The CP 3864 Control Panel can be configured as a 64 x 1 single bus (Figure 2−62), as a 32 x 32 “balanced split” panel (Figure
2−63), or as some variation of an “unbalanced split” panel (Figure 2−64).

Figure 2−62. Single−bus
configuration.

64
sources

Figure 2−63. “Balanced split”
configuration.

32
sources

32
destinations

Figure 2−64. Example of “un-
balanced split” configuration
(54 x 10) .

54
sources

10
destinations

* Defined in Glossary Section
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Unbalanced split panels can be configured to control from 1 to 31 outputs, with keys not used for outputs available to control
inputs. For example, if 10 buttons are assigned to outputs then 54 buttons are available for inputs.

Except for unbalanced split and CP 3864L configurations, control of additional inputs/outputs is possible using adjacent CP
3864 or CP 3832 panels (page 2−53); as another alternative, the CP 3864 can be operated in connection with an adjacent CP
3810 Expansion Panel (see page 2−54).

Hardware Installation

Installation of this panel is shown on page 2−37.

If desired, the panel hardware can be tested, and window/button brightness adjusted, without being connected to the controller
board (such as a CM 4000). For more information, see Diagnostics Mode on page 6−112.

Software Configuration

The panel uses an eight−character CP Level Set of type “3800” (page 5−58).

MPK table entries will depend on the application (see page 5−107).

Sources are defined in a CP Input Set of type “cp3832” (page 5−62). Destinations are defined in a CP Output Set of type
“cp3832” (page 5−78).

Before the panel can be used, these sets must be compiled, and the appropriate configuration set made active using the Control
Center (page 5−13).

For CP 3864 operating instructions, see page 6−26.

For CP 3864L operating instructions, see page 6−117.
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Source/Destination Expansion 

The CP 3832 and CP 3864 can be combined to increase the number of sources and destinations to a maximum of 128 x 128.
Examples are shown in Figure 2−65.

64
sources

Figure 2−65.

32
destinations

128
sources

CP 3864

CP 3832

128
sources

128
destinations

CP 3864

CP 3864

CP 3832

CP 3832

CP 3864

CP 3864

CP 3864

48
sources

16
destinations

CP 3832

CP 3832
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CP 3810 Panel

The optional CP 3810 panel can be associated with a CP 3832, CP 3864, CP 3808, or CP 3830, providing control of up to
80 outputs. The CP 3810 can also be assigned to one output, providing breakaway (split) switching and/or multi−level status.

Figure 2−66 illustrates a CP 3810 with a CP 3832 panel.

VTR1 VTR2 VTR3 VTR4

VTR5 VTR6 VTR7 VTR8

CAM1 CAM2 CAM3 CAM4

CAM5 CAM6 CAM7 CAM8

BLACK BARS TONE CG−1SILENCE CG−2 CG−3 CG−4

EBS1 EBS2 TEST1 TEST2 FDL1 FDL2 FDL3 FDL4

Level Menu Clear

Prot/
Lock

Pre−
set

Take

CURRENT

PRESET

VTR−001

PLAY/
STOP

PLAY/
STOP

PLAY/
STOP

PLAY/
STOP

PLAY/
STOP

PLAY/
STOP

PLAY/
STOP

PLAY/
STOP

Take/
Set

Take/
Set

Take/
Set

Take/
Set

Take/
Set

Take/
Set

Take/
Set

Take/
Set Dest

Figure 2−66. CP 3832 (top) with CP 3810 Expansion Panel (below).

VTR−001 PG1

The CP 3810 can be operated in several modes:

— For multi−bus control the destination can be selected on the CP 3810 and the desired source can be selected on
the main panel (CP 3832, CP 3864, CP 3808, or CP 3830). The CP 3810 can display the names of eight destina-
tions. The “page” of eight destinations can be scrolled to display up to 80 possible destinations.

— For single−destination applications, the panel can be configured as a “CP 3810L” and operated with a main
panel or as a stand−alone unit:

� When used with a main panel, the desired destination can be selected on the main panel; the CP 3810
will display the status of eight levels. The “page” of eight levels can be scrolled to display additional
levels. A breakaway switch can be set up and executed with a single Take command.

� When used as a stand−alone status panel, the desired destination is permanently entered on the MPK
table (see Software Configuration below). The CP 3810 will display the status of eight levels. The
“page” of eight levels can be scrolled to display additional levels.

— The CP 3810 can also be used as a limited−function machine control panel, providing Play and Stop com-
mands for VTRs.

— Alternatively, it can be configured as a “CP 3810S,” meaning that the selected outputs will remain selected
until explicitly changed by the operator.

Hardware Installation

Installation of this panel is shown on page 2−37. Note that each CP 3810 panel requires a separate MPK connection.

If desired, the panel hardware can be tested, and window/button brightness adjusted, without being connected to the controller
board (CM 4000). For more information, see Diagnostics Mode on page 6−130.

Software Configuration

Each CP 3810 panel requires a separate entry on the MPK Devices table. See page 5−107.
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For multi−bus control, the CP 3810 Expansion Panel keys are assigned to outputs using the CP Output table (page 5−78).

When used as a machine control panel, the CP 3810 will require entry on the Machine Control table (page 5−135).

Operation

For operating instructions, see page 6−126.

JEP 100 Jupiter / Encore Control Panel

Please refer to the JEP 100 installation and operating manual, part no. 071 8376 xx.
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INSTALLING MACHINE CONTROL PANELS

MC 3000 Machine Control Panel and CP 3010 Expansion Panel

Installation of these panels is shown on page 2−37.

The MC 3000 machine control panel includes a series of push buttons for motion control (PLAY, STOP, etc.). A variable speed
knob, with a color−coded direction/speed indicator, is also included.

The machine to be operated can be selected using the adjacent CP 3010 expansion panel (Figure 2−68), which can display
the names of eight machines over a row of selection buttons. Additional pages of eight machines can be called up for display
in the window as required. The method by which machines are assigned to the CP 3010 is described in detail later in this man-
ual (see Assigning Machines to Control Panels on page 5−141). The CP 3010 can also be used as a limited−function machine
control panel, providing Start and Stop commands for VTRs.

The panels must be entered on the Machine Control Devices table (page 5−135) and the MPK Devices table (page 5−107).
For operating instructions, please see page 6−132.

Figure 2−67. MC 3000
machine control panel.
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Figure 2−68. CP 3010
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MC 3010 Machine Control Panel

The MC 3010/2 version of this panel is shown in Figure 2−69; installation is shown on page 2−37.

The MC 3010 is used to control four (MC 3010/1 version) or eight (MC 3010/2 version) tape machines. The display window
shows the name of the machine presently linked to the button group immediately below. Lighted, re−legendable push buttons
are provided for motion control and status.

A special feature of the panel is the GANG START key, which allows a command to be sent to multiple machines simultane-
ously.

The method by which machines are assigned to the MC 3010 is described in detail later in this manual (see Assigning Ma-
chines to Control Panels on page 5−141).

The panel must be entered on the Machine Control Devices table (page 5−135) and the MPK Devices table (page 5−107).
For operating instructions, please see page 6−135.

PLAYGANG
START

PLAYGANG
START

PLAYGANG
START

PLAYGANG
START

STOP
−−−−−−
SHIFT

READY
−−−−−−
REW

REC
−−−−−−

FFD

STOP
−−−−−−
SHIFT

READY
−−−−−−
REW

REC
−−−−−−

FFD

STOP
−−−−−−
SHIFT

READY
−−−−−−
REW

REC
−−−−−−

FFD

STOP
−−−−−−
SHIFT

READY
−−−−−−
REW

REC
−−−−−−

FFD

Figure 2−69. MC 3010/2 Dual 4−Machine Control Panel.

 VTR1     VTR2      VTR4
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PREPARING AND INSTALLING BUTTON LABELS

Control panels are supplied with general purpose labels already installed. A sheet with additional labels is also provided, and
with care, these labels can be substituted for those already installed.

Custom labels. Information and templates for creating custom labels can be found at www.thomsongrassvalley.com in the
Support/FAQ area (search for Answer ID “1425” or Keywords “lens chip”). Copies can then be made on overhead projector
transparency material. Most Jupiter panels use the “Frutiger” typeface.

CP 3020/1
MC 3020D/L
VC 3020

Button caps on these panels are removed using a small screwdriver (or a fingernail). Use the small slot between the clear cap
and the black portion of the button; the slot can be found along the top or bottom of the button housing.

Note: A good technique is to use a corner of the tip of the screwdriver and a fingernail in the same slot. Be
prepared for the cap to come off suddenly!

Replacing Button Bulbs

After removing the cap and diffuser, the bulb (which is an incandescent type) can be pulled straight out.

Important:  Use extreme care when removing bulbs so that they do not break in the socket. The recommended
tool is a piece of heat shrink or other plastic tubing that will fit snugly on the bulb.

The Grass Valley part numbers for the bulbs are:

Button size GV part no. Manufacturer Manufacturer part no.

0.7−inch 65−028985−005 Oshino Electric OL−685BPE
0.45−inch 65−028985−007 Siemens LY K380

When re−installing the cap, notice that the small slots used during removal must be on the top and bottom of the button or the
cap will not snap into place properly.

CP 300 Series Control Panels

Button caps for these panels are most easily removed by pulling them straight off with needle nose pliers. Using needle−nose
pliers will insure that only the transparent cap is removed. Do not pry off the entire button top assembly by using a screwdriver
or similar tool; this will not provide access to the label. The existing label is held in place with adhesive; scrape off the label and
replace it with the new one.

Figure 2−70.
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CP 3800 Series Control Panels

Button caps for these panels are most easily removed by pulling back the top edge with the finger tip (see Figure 2−71). For the
black-edged buttons on the right side of the CP 3824, use a technique similar to that described above for the CP 3020.

Figure 2−71. Removing CP 3800 series keycaps.

Testing Bulbs

CP/VC 3020

To test the bulbs without sending any commands to the switcher or machines, use the pair of buttons on the right side of the
main panel:

1. Press and hold the right−hand button of the pair, then press the left hand button of the pair.

Both buttons will flash, showing that the panel is in test mode.

2. Press any other button to test the bulb.

Bulbs on expansion panels can also be tested.

3. To exit the test mode, repeat step 1.

The panel will return to its previous condition.

MC 3010

For MC 3010 diagnostics, please see page 6−137.

CP 300 / 3800 Series Panels

For lamp test information, please refer to Section 4 and the description of diagnostics for the particular panel.
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CONNECTION TO THOMSON/PHILIPS DD SERIES (“DIAMOND”)

An example of hardware connections is shown in Figure 2−72.

• The “Diamond protocol” cable to one of the DD serial ports is required for display of routing switcher status on
the DD console. For cable pin−outs, see page 2−63.

• The “ASCII bus protocol” cable to the DD XBAR port is required if switch commands will be sent from the
DD to Jupiter; for example, when a Venus router is used to provide additional AUX outputs for the DD, or used
to provide Pre−Routing. For cable pin−outs, see Figure 2−73.

• If desired, an MPK control panel could be used for DD Pre−Routing. For cable pin−outs, see page 2−63.

“Diamond” and “ASCII” protocols are set on the Serial Protocol table (page 5−30); and the switcher is identified on the MPK
Devices table (page 5−123).

Installation of MPK panels was discussed on page 2−38.

Refer to the DD installation manual for information about the Diamond serial ports and operating instructions.

“Diamond protocol”

Serial port 1,
2, or 3

ASCII bus protocol

XBAR port

for Mnemonic Status to DD

for AUX extension switch
commands from Diamond

Figure 2−72. Connections to DD switcher (example).

MPK panel may be used as alternate method of send-
ing switch commands to Jupiter (CP−3000 shown).

MPK protocol

CM 4000 
System

Controller

Serial
Ports

House sync required for
vertical interval switching.

LAN

See discussion on page 2−60 for in-
formation concerning these cables.

Figure 2−73. Cable for connecting CM
4000 to Grass Valley DD XBAR Port.
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Connection to VTRs and Other Machines

CONNECTION TO SONY AND SONY−COMPATIBLE VTRS

VTRs are connected to the LAN through a CM 4000 System Controller board. The protocol is set at the file server, as described
later in this manual.

Serial (Sony) bus 1

Figure 2−74. Connection to Sony VTRs.

BVH−2000     BVW−10
BVH−2500     BVW−40

BVU−800
BCB−35/60/65/70/75

DCR−10/18/20/28/34/35
PCB−2600/2650/2800

1See Sony Installation Notes,
page 2−61.

Serial
Ports

CM 4000 System Controller

Sync ref. See
pg. 2−64

LAN

Sony Installation Notes

Only one Sony VTR can be connected per port.

Late model Sony machines use a remote control protocol referred to as Sony serial, and these can be connected directly to
individual ports of a CM 4000 board. Sony serial machines include the BVH−2000, BVH−2500, BVU−800, BVW−10, and
BVW−40.

Other VTRs

Some VTRs not described above use the Sony Serial protocol. Please contact Grass Valley for additional information.
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REMOTE CONTROL VIA MODEM

Serial (MPK) bus op-
erating at 2400 baud

Jupiter control panel

Telephone line ModemModem

Figure 2−75. Modem control installation.

RS−422/232
converter

RS−422/232
converter

CM 4000 System Controller

The Jupiter system can be controlled through a modem connection using:

• A CP 3000 control panel equipped with a 1200/2400 baud PROM (FCS−3306/1/2, part no.
45−043114−01A/B). These products are described in separate documents, part no. 04-883306-001 (1200 baud
version) and 04-883306-002 (2400 baud version).

• An MPK control panel that allows baud rate selection on the front panel  (e.g., CP 3800A, CP 3830, CP 3808,
CP 3832, CP 3864 etc.). These products are described later in this manual.

The modems used in such a system should be connected to the Jupiter hardware through RS−232/422 converters. See Figures
2−75 and 2−76. The only modem supported for this application is the Motorola V.3229, which is available from Black Box
Corp. or NetLink Technology, Inc. Two RS−232/422 Converters are recommended: 1), the Black Box IC107A RS−232 >
RS−422 Converter, and 2) the Integrity Instruments 422−25I with external power supply. For instructions that apply specifi-
cally to these third−party items, please refer to Grass Valley Field Engineering Bulletin 04-047604-081.

Figure 2−76. Generalized modem wiring.
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Jupiter Configuration

Using the Serial Protocol table, change to the appropriate baud rate for the port that is connected to the modem. Only one
control panel can be defined on a port that is connected to a modem. For more information, see page 5−30.
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Installing CM 4000 VGA Status Display

Please refer to Appendix A for installation instructions.

Serial Data Cables

The RS−422 cables used to connect CM 4000 controllers, VTRs, and control panels may be known by various names depend-
ing on the devices to which they are connected. Thus a particular serial bus might be called the “Sony bus,” the “MPK bus,”
etc. In spite of the different terminology, each of these buses consist of a 4−conductor (plus ground) cable.

Maximum length per bus is 1220 meters (4003 ft).

The rear panel serial data cable connectors on the CM 4000 and MPK control panels are 9−pin D, female. The CP and MC
connectors are arranged for loop−through wiring. No termination is required. While these connectors are ESbus compatible,
it should be noted that the Grass Valley serial data cables use only 5 of the 9 pins described in the ESbus specification (Appen-
dix F).

The following ready−made cables, with installed 9−pin D male connectors, are available from Grass Valley (VDE* cables
include ferrite cores):

1 meter (3.3 ft)    8 meters (26.2 ft)
2 meters (6.6 ft) 16 meters (52.5 ft)
4 meters (13.1 ft) 32 meters (105 ft)

For ordering information, see page 1−22.

For those who wish to prepare their own cables, the pin−outs are shown in Figure 2−77. The cable itself should be Belden
8723 or equivalent. Details concerning ferrite cores are given in Figure 2−78.
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Figure 2−77. Serial data cable wiring. Reference: “Assembly, BCS−3000 Serial Data Cable,” Grass Valley drawing no.

01−041600−TAB.
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VDE EMI/RFI Modifications to Serial Data Cables

User−supplied serial data cables for VDE installations require a ferrite core over each end of the cable, adjacent to the connec-
tor.

Figure 2−78. Serial data cable VDE modifications.

Type 43 material
0.250 inch (6.35 mm) inside diameter

0.95 inch (24.13 mm) length (or longer)

Type 43 material sources

Fair−Rite, part no. 2643480002

Fair−Rite Products Corp., P.O. Box J, Commercial
Row, Wallkill, NY 12589, USA; Tel. (914) 895−2055.

Chomerics, part no. 83−10−A636−1000

Chomerics Inc., 77 Dragon Ct., Woburn, MA 01888
USA; Tel. (617) 935−4850.

Sync Reference Cables

A video reference (sync) signal should be connected to each Jupiter controller board (including the CM 4000 System Control-
ler).

This signal may be color black or composite sync with an amplitude between 1 V P−P and 4 V P−P.

The CM 4000 System Controller must have a sync reference in order for a Grass Valley Crosspoint Bus router to switch during
the house vertical interval. Crosspoint Bus routers are listed on page 1−11.

Time Code Connections

Time code must be connected to the CM 4000 for deterministic switching (AccuSwitch application). For more information,
see Appendix G.

A time code connection to the CM 4000 also provides an accurate date and time stamp for JNS Logger messages (page 12−1).

If desired, the CM 4000 clock and the file server clock can be synchronized by referencing them to the same time source, such
as a time code input (preferred) or a Network Time Protocol server. See page G−11 in Appendix G.
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Connection to Saturn Master Control Switcher

The Jupiter control system can be used as part of a Saturn Master Control Switcher installation, as shown in Figure 2−80. §

Jupiter and Saturn software programs are presently supplied on a multi−disk set, and running the “Install” program loads both
Jupiter and Saturn code.

Saturn software is accessed using the “Saturn” pull down menu.  See Figure 2−79.

Figure 2−79.  Jupiter/Saturn
Configuration menu.

Before attempting to connect and configure the Saturn Master Control Switcher, the Jupiter Facility Control System should
first be installed and checked out.

For Saturn installation instructions, including hardware connections and entries to Jupiter configuration tables, please refer
to the Saturn Master Control Switcher Installation and Operation Manual,  Grass Valley part no. 04−046654−002.

The Saturn Tally system, which operates only with the Saturn internal matrix option, is described in the Saturn installation/
operating manual. For Jupiter  Tally  applications, where signals are followed through routers or production switchers, refer
to page 2−67 of this manual.

For Under Monitor Display  installation instructions, see page 2−81.

§ Some of the functions described in this section may be extra−cost options. For more information, see page 1−27.
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Figure 2−80. Example of Saturn MCS with Crosspoint Bus router and Jupiter control
system. For Saturn instructions, see Saturn Master Control Switcher Installation and
Operating Manual.
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MI 3040 Tally Installation

Sync ref.
See pg.

2−64

MPK bus

MI 3040
General Purpose/Tally Interface

Serial data cable (see page 2−63)

Figure  2−81. MPK connections to MI 3040.

To tally lights, switchers, etc.
(see discussion)

CM 4000 
System

Controller

Serial
Ports

LAN

TALLY SYSTEMS 

Grass Valley offers the following software packages for operating tally systems:

• Jupiter Tally . The Jupiter Tally system can follow a source, such as a camera or VTR, through as many as five
switchers and turn on the tally light next to the source when it is switched to the “Air” destination. Switchers
that are on−air can also be tallied. Multiple sources will be tallied simultaneously during keys, special effects,
etc.†

• Saturn Tally. “Saturn Tally” supports tally in entry level stand−alone applications where one channel of Saturn
is installed and switching is performed by an internal matrix. Saturn Tally will tally up to 40 sources, switched
on its own internal matrix. It will tally all sources on all levels that are on air, including audio/video inserts. See
page 2−69. Also refer to “Saturn Tally” in the Saturn Installation and Operating Manual.

Note: Only the Saturn Tally application will tally sources that are wired directly to a Saturn internal 
matrix.

• Andromeda − logical signal processing system developed by the Grass Valley Systems group in Weiterstadt,
Germany. Functions include evaluation of GPIs, tally light control, evaluation of contact closure failure indica-
tions from devices such as master control switchers and video servers, and automatic, emergency switching.
For more information, please refer to the Andromeda User Manual or contact Grass Valley.

The MI 3040 General Purpose / Tally Interface can be used either to monitor the status of switching equipment, or to provide
a voltage source for tally lamps, or both.

Certain third−party tally systems can also be used with Jupiter. See the “Key Features” table beginning on page 1−27.

† In certain systems, special configuration techniques will allow Jupiter to tally outputs and operate multi−level (air+pre-
view+iso) tally systems. For more information, see Grass Valley technical paper “Advanced Tally Techniques for Studios
with Jupiter Control and DD-35 Series Production Switchers.”
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MI 3040 HARDWARE OVERVIEW

Relay Outputs 

The MI 3040 provides 40 electrically isolated output connections for operating tally lights, using solid−state switches which
are suitable for low−voltage (<100 V), low−current (<300 milliamps) applications.

Note 1: The Jupiter Tally system can only operate tally lights for sources that are connected directly to the Jupiter−
controlled router as inputs. If a source is instead connected to a production switcher, or to a non−Saturn, non−MCS
2000 master control switcher, then the tally light for that source must be operated by that switcher’s tally relay
system—not by the MI 3040.

Note 2: When the master control switcher feeds the transmitter indirectly (by re−entry through the routing
switcher), a relay number must be entered on system configuration tables (as described in detail later) for a tally
light assigned to the master control switcher. Relay numbers must also be entered on system tables for tally lights
mounted next to production switchers. However, physical installation of these lights is optional. Whether these
lights are installed or not, the sources upstream of the switcher(s) will still be tallied.

Status Inputs (Opto−isolators) 

40 opto−isolated inputs are provided on the MI 3040 to receive tally data from production switchers and/or non−Saturn, non−
MCS master control switchers, allowing the Jupiter system to determine what source has been selected by such switchers.
This information is used along with Jupiter−controlled router status data to illuminate the appropriate tally light(s).

MPK Bus Connections

The MI 3040 connects directly to a CM 4000 serial port using MPK protocol (Figure 2−81). Multiple MI 3040s can be in-
stalled as needed. Since information is shared among all units, tally lights can be operated by one MI 3040 based on switcher
data received at another.

For a Saturn stand−alone system, where no CM 4000 is available, the Saturn video processor (either digital or analog) is used
as the source of the MPK bus.

Current Sources

In many cases current sources will need to be found to operate the tally lamps and energize the opto−isolators. Although +5
V and ground utility connections are available on the back panel of the MI 3040, this supply may not be sufficient for the
particular installation. Before attempting these connections, please refer to the hardware overview starting on page 2−77.

Connecting production switchers and/or non−Saturn, non−MCS master control switchers to the MI 3040 opto−isolators will
require an understanding of the switcher’s tally relay hardware. Please refer to the installation manual supplied with the
switcher for more information.
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EXAMPLE OF SATURN TALLY SYSTEM

The following diagram shows an example of a Saturn Tally system. For detailed information, refer to “Saturn Tally” in the
Saturn Installation and Operating Manual.

Figure  2−82. Saturn Tally system.
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EXAMPLES OF JUPITER TALLY SYSTEMS 

The diagrams on the following pages show systems that can be controlled by the Jupiter Standard Tally application.

Connection to Systems with Saturn Master Control Switcher 

A Saturn (or MCS 2000) master control switcher can feed the transmitter directly (page 2−71) or indirectly by re−entering
the routing switcher (page 2−72). The main difference between these two systems is the tally light next to the master control
switcher.

Each tally light that is to be controlled by the Jupiter system requires one relay connection, as shown.

Systems can include one or more production switchers (page 2−73 and following). For each feed from the Jupiter−controlled
router to the production switcher(s), there must be a connection to one of the 40 opto−isolators of the MI 3040.

No connections from the Saturn master control switcher to the MI 3040 opto−isolators are needed; tally data is transmitted
through the MPK bus.

Connection to Systems with Non−Saturn, Non−MCS 2000 Master Control Switcher

The master control switcher can feed the transmitter directly (Figure 2−87) or indirectly by re−entering the routing switcher
(Figure 2−88). The main difference between these two systems is the tally light next to the master control switcher. For each
feed from the Jupiter−controlled router to the master control switcher, there must be a connection to one of the 40 opto−isola-
tors of the MI 3040. Each tally light that is to be controlled by the Jupiter system requires one relay connection, as shown.

Systems can also include one or more production switchers. For each feed from the Jupiter−controlled router to the production
switcher(s), there must be a connection to one of the 40 opto−isolators of the MI 3040.

SOFTWARE CONFIGURATION

The MI 3040 must be established as an MPK device for tally use, after which it is referred to as a “MI 3040/T” (page 5−115).
The Tally Relay and Tally Dependency tables must also be filled in, as described starting on page 5−152.

When used as a connection point for an MPK bus, the Saturn video processor must be entered on the Serial Protocol table
(page 5−30).

SLIMLINE UMD TALLY

The Grass Valley SlimLine series UMDs include self−powered tally LEDs. For more information, see page 2−81.
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Figure  2−83. Tally system with Jupiter−controlled router, Saturn master control, and direct feed to transmitter.
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Figure  2−84. Tally system with Saturn master control, Jupiter−controlled
router, and indirect feed to transmitter.
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Figure  2−85. Multi−switcher tally system with production switcher, Jupiter−controlled
router, Saturn master control, and direct feed to transmitter.
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Figure  2−86. Multi−switcher tally system with production switcher, Jupiter−controlled
router, Saturn master control, and indirect feed to transmitter.
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Figure  2−87. Multi−switcher tally system with production switcher, Jupiter−controlled
router, non−Saturn/MCS 2000 master control, and direct feed to transmitter.
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Figure  2−88. Multi−switcher tally system with production switcher, Jupiter−controlled
router, non−Saturn non−MCS 2000 master control, and indirect feed to transmitter.

Transmitter

Video and audio

Jupiter Control lines

40 opto−iso-
lators. See
Fig. 2−91.

 Tally light

One connection per tally light.
100 V, 300 mA max.

Sources

Equal number
of connections

Equal number
of connections

Non−Saturn non−
MCS master control

switcher

Switcher
tally relays

+5 V utility
connection

Jupiter−controlled 
router

INDIRECT

Production
switcher

Switcher
tally relays

See Note 1 on pg. 2−68

See Note 1 on pg. 2−68



Hardware Installation

2−77CM 4000 Installation and Operating Manual

MI/MC 3040 Hardware Overview

Reset
Gen.

Osc.
3.6864MHz

RESET

68HC705

PORT A
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40
Optical
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Relay
Interface

LCA
MI−3040R

Optical status
interface

LCA
MI−3040S

Figure 2−89. MI/MC 3040 interface block diagram.

Data/Address Bus

Control

The MI/MC 3040 interface provides 40 switch closures, monitors 40 isolated status inputs, and interfaces with a CM 4000
using MPK protocol.

Optoelectronic Relays  

(Reference: Fig. 2−90.) The relay selected for this design is an optically−coupled solid−state relay (PVD1352 by International
Rectifier) capable of switching from 0 to 100 volts (AC or DC) at up to 300 mA. Each relay may be configured by slide switch
for normally−open or normally−closed operation.

Relay Control

Each relay drive signal passes through a two−input exclusive−OR gate. The second input to each gate is tied to a DIP switch
to ground and pull−up. When a switch is in the OPEN or OFF position, the corresponding relay is considered normally open;
a high level on the relay drive line (inverted to a low level) will consequently close the relay. Conversely, when a switch is
in the CLOSED or ON position, the corresponding relay is considered normally closed; a high level on the relay control line
will cause this relay to open.

Optical Couplers  

(Reference: Fig. 2−91.) The optical coupler inputs respond to a differential voltage between the two input pins. The optical
couplers selected for this design are a bipolar type (PC314 by Sharp, for example) to eliminate the need for external steering
diodes. The signal leg contains a series current−limiting resistor selected to provide between 1.75 and 13.6 milliamps of LED
drive current at voltages of 5 to 28 volts (AC or DC).
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Utility Connections

+5 V and ground utility connections are provided on the back panel. There are two +5 V connectors, each of which is equipped
with a PCB−mounted 1 amp fuse. The fuse is designed to reset itself automatically.

to external
device

PVA1352

See Figure 2−92.
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Figure 2−90. MI/MC 3040 optoelectronic relay circuit (example). For discussion, see page 2−77.

2

U16

from external
device

Figure 2−91. MI/MC−3040 optical coupler status circuit (example). For discussion, see page 2−77.
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Figure 2−92. MI/MC 3040 normally open/closed relay DIP switches.

 1  1 2 3 4 5 6 7 8  

 0   −−−−−OPEN−−−−−

S1−1 24
S1−2 25
S1−3 26
S1−4 27
S1−5 28
S1−6 29
S1−7 30
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Hardware Installation

2−80 CM 4000 Installation and Operating Manual

Figure 2−93. MI/MC 3040 back panel.
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Under Monitor Displays

Figure 2−94. SlimLine Under Monitor Status Displays
(Standard screw mount models shown).

UMD 19 DD

Tally indicators

UMD 19 SD

UMD 19 UD

UMD 9 SD

UMD 12 SD

UMD 14 SD

Using Under Monitor Displays, the Jupiter system can display the name of a source (camera, VTR, etc.) when it is switched
through a Jupiter−controlled router to a particular monitor. In multi−switcher applications, the system can follow a source
through as many as five switchers, including production switchers and Saturn master control switchers. Also available is a
fixed mode of operation, during which the desired source name is displayed permanently.

The Grass Valley SlimLine UMD SD/DD/UD displays shown above can be configured with some character positions used
as “tally lights”; these lights can be configured to illuminate when the source shown is switched to a particular destination
(e.g., on−air). The SlimLine displays are available in 9−, 12−, 14−, and 19−inch−wide versions.

Each type is also available in a space−saving plate−
mount (“OB”) version for installation in front of a
monitor, i.e., in front of the monitor’s controls, not
the screen (see Figure 2−95). The mounting plate
slides under the monitor and a hinge allows the dis-
play to swing down when the monitor controls re-
quire adjustment. For more information, refer to the
equipment dimensions on page 1−15 and to the
SlimLine Under Monitor Displays Technical
Manual.

Figure 2−95. OB version
of UMD 19 SD.

Installation of the SlimLine Controller and UMDs is shown below. Up to 16 various UMD models can be mixed or matched
per SlimLine Controller. Multiple SlimLine Controllers can be daisy chained on the MPK bus if desired; in which case the
associated rear−panel switch is set to “0” (non−terminate) instead of “1” (terminate MPK bus).
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Note 1: When controlled by Jupiter or Saturn, SlimLine units display green characters, red tally indicators, and
one tally level only. With the Universal Display, only the triple display mode is supported (i.e., 3 segments of 8
characters each, plus tally indicators).

Note 2: Because the Cat 5 Ethernet cable connecting the controller to the UMDs carries power, the maximum rec-
ommended length is 15 m (50 ft). This is a standard (pin−for−pin) Ethernet cable, not a crossover cable.

Note 3: The RP 1/2/3 and RP 1/2/3 C series UMDs (which are no longer available) are installed and configured
similarly to the SlimLine series. The main difference is that the RP 1/2/3 units are daisy−chained directly to a CM
4000 serial port.

Note 4: For information about TSL UMDs, see Appendix S.

Note 5: For information about Grass Valley 8964 OMD On Screen Displays, see Appendix T.
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CONNECTION TO SYSTEMS WITH JUPITER−CONTROLLED ROUTER ONLY

SlimLine UMDs are connected to the Jupiter CM 4000 through a SlimLine Controller, which has RJ45 ports for Cat 5 Ethernet
cable connection to 16 UMDs. Power is provided to the UMDs through the Cat 5 cables. See Figure 2−96.

Figure  2−96. SlimLine UMD
Status Display installation.

Up to 16 UMDs per SlimLine controller

MPK bus

Serial data cable (see page 2−63)

Serial
Port

CM 4000 System Controller

Sync ref. See
pg. 2−64

Cat 5 cable 
(see Note 2 on page 2−82)

SlimLine UMD Controller

MPK bus loop to additional SlimLine Controllers

AC
power

LAN

Software Configuration

Under monitor status displays must be identified as MPK devices. See page 5−116.

If SlimLine UMD tally light  operation is needed, additional configuration will be required:

• For the Jupiter Standard Tally application, there must be an MPK table entry for an “MI 3040/T” whether it is
physically present or not (see page 5−117). Entries to the Tally Relay and Tally Dependency tables will also be
needed (see pages 5−152 and 5−158).
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CONNECTION TO SYSTEMS WITH SATURN MASTER CONTROL SWITCHER

A Saturn application is shown in Figure 2−97. No additional connections to the master control switcher itself are required,
since all status data is transmitted on the LAN (page 2−65).

PRESET PROGRAM AIR

CM 4000 

SlimLine UMD Controller

MPK bus

Figure 2−97. Example of status display system for Saturn master control switcher.

Serial data cable (see page 2−63)

Serial
Port

Sync ref. See
pg. 2−64

Cat 5 cable 
(see Note 2 on page 2−82)

MPK bus loop to additional SlimLine Controllers

AC
power

LAN

Software configuration

Two methods are available for configuring UMDs with Saturn systems:

• “Saturn control” − in most cases this will be the preferred method because 1) it involves fewer tables, 2) it will
provide status of inputs connected to the Saturn Internal Matrix Option, and 3) it is designed to integrate with
the “Monitor Follow” function of Saturn. For more information, refer to the “Saturn UMD” discussion in the
Saturn Installation and Operating Manual.

• “Jupiter control” − the original method for configuring master control UMDs, largely replaced by the “Saturn
control” method—especially because Jupiter control cannot be used to status inputs connected to the Saturn
Internal Matrix Option. However, the Jupiter control method may still be useful in special circumstances, as
described below.
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CONNECTION TO SYSTEMS WITH SATURN MASTER CONTROL AND PRODUCTION SWITCHER

Using the “Jupiter control” method, UMDs can be used to display the names of  inputs that pass through a production switcher
as well as the Saturn. See Figure 2−98.

MI 3040
General Purpose/
Tally Interface

Figure 2−98. Use of MI 3040 with
UMDs and production switcher.
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SlimLine Controllers

AC
power
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Since production switchers do not use the Jupiter LAN, an MI 3040 General Purpose / Tally Interface must be used to obtain
switcher status. For each feed from the Jupiter−controlled router to the switcher(s), there must be a connection from a switcher
tally relay to one of the 40 opto−isolators of the MI 3040. This allows the system to determine what source has been selected
by such switchers. This information is used along with routing switcher status data to display the appropriate mnemonic.

The MI 3040 connects directly to a CM 4000 serial port using MPK protocol. Since information is shared among all units,
status displays can be operated by one CM 4000 based on MI 3040 data received at another.

Connecting production switchers to the MI 3040 opto−isolators will require an understanding of the switcher’s tally relay
hardware. Please refer to the installation manual supplied with the production switcher for more information. (The MI 3040
hardware is discussed on page 2−77.)

Note 1: “Jupiter control” can only operate status displays for sources that are connected directly to the Jupiter−con-
trolled router as inputs (i.e., sources that go through the router to reach the production switcher). The system cannot
track sources that are wired only to a production switcher.

Note 2: “Jupiter control” cannot be used to status inputs connected to the Saturn Internal Matrix Option. “Saturn
control” must be used for this purpose.

Software Configuration

Under monitor status displays must be identified as MPK devices. See page 5−116.

In systems which include production switchers, entries to special CP Output Set tables and entries to the Tally Relay Descrip-
tion and Dependency tables will be required  (see page 5−119).

If SlimLine UMD tally light  operation is needed, additional configuration will be required:

• For the Jupiter Standard Tally application, there must be an MPK table entry for an “MI 3040/T” whether it is
physically present or not (see page 5−117). Entries to the Tally Relay and Tally Dependency tables will also be
needed (see pages 5−152 and 5−158).
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Connection to Automation and Other Systems

Note: The following refers to all automation−to−CM 4000 systems, including those with AccuSwitch. The
AccuSwitch application itself is described in Appendix G.

The CM 4000 will support multiple connections to an automation system (e.g., “channel A control” of an automation system
could be connected to Serial Port 1 of the CM and “channel B control” connected to Serial Port 2).

CM 4000s can be installed as a redundant pair where each monitors the other. If a fault is detected in the [active] master unit,
control will be switched to the other device automatically. For more information, see page 2−8.

Connection to Devices Using “ESswitch” Proposed ESbus Routing Switcher Dialect

“ESswitch” protocol is set on the Serial Protocol table (page 5−30); and the control computer is identified on the MPK Devices
table (page 5−107). A technical description of the proposed dialect is available; please contact Grass Valley for more informa-
tion.

Figure 2−99. Example of Automation installation.
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Connection to Devices using Jupiter ASCII Computer Interface Protocol

ASCII bus

Serial port

Control computer

Figure 2−100.

Serial
Port

CM 4000 System
Controller Sync ref. See

pg. 2−64

See pages 2−89 and
2−90 for examples of
this cable

LAN

These systems are similar to that shown on page 2−87. “ASCII” protocol is set on the Serial Protocol table (page 5−30); and
the control computer is identified on the MPK Devices table (page 5−107). A technical description of the Jupiter ASCII com-
puter interface protocol is presented in Appendix N.

This method is also used for connection to an Image Video TSI−100 tally system.
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Figure 2−101. Cable for connect-
ing CM 4000 to MSL 4000 IFS 4.
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Figure 2−102. Cable for connecting CM 4000 to AT−type computer..
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Encore Control of Jupiter 

The Encore System Controller Board (SCB) can send switching commands to a Jupiter control system (which can in turn send
the commands to a Crosspoint Bus router such as Venus). This application uses the “ESswitch” Proposed ESbus Routing
Switcher Dialect.

Hardware connections are the same as those used when Jupiter controls an Encore system. See page 2−17 and following.

“ESswitch” protocol is set on the Serial Protocol table (page 5−30); and the Encore SCB is identified as a Serial device on
the MPK Devices table (page 5−123). In the case of redundant VM / redundant SCB systems, two VM ports are defined on
the Serial Protocol table and two SCBs are defined on the MPK Devices table.

A technical description of the proposed ESswitch dialect is available; please contact Grass Valley for more information.
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Section 3 − Software Installation

If the file server was purchased from Grass Valley, the software will have been installed at the factory. In this case, for quick
system startup you may wish to refer to the Jupiter Getting Started Guide, part no. 04-045707-003. This booklet provides
an abbreviated version of the configuration instructions in this manual.

If the Jupiter software is being upgraded from a previous version, you must follow the special upgrade instructions in the
appropriate Grass Valley Field Engineering Bulletin. Failure to do so could result in loss of user data. For more information,
please contact Grass Valley Technical Support (see page ii in the front of this manual).

If the software is being installed for the first time, follow the procedure in the Field Engineering Bulletin.
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Section 4 − Jupiter Network Suite Control Console

The JNS Control Console is the application used to launch the various Jupiter Network Suite (JNS) programs. It is also  used
to launch the Jupiter Configurator (table editor).

The Jupiter Network Suite is a collection of several programs designed as a replacement and enhancement to the Jupiter Net-
work Interface Application (JNIA) software. JNS programs include: 

� Software Control Panel Suite (GUI control panel)

� Board Status

� Control Center§

� CP IO Set Editor†

� Force Unlock§

� JNS Configuration

� Logger§ and LogViewer§

� Physical Control§

� Physical Diagnostic Utility†

� Physical Remapping Utility†

� Router Control Utility

� Router Save/Restore

Installation

Software must be installed as described in Field Engineering Bulletin supplied with the software.

Caution: You must have administrator privileges in order to load Jupiter software, launch Jupiter applications,
and configure the system. And, the same login should be used for all tasks performed on the Jupiter file server,
including uninstalling software.

Note for XP systems: The welcome screen may not always show an Administrator icon. Press Ctrl−Alt−Del twice,
and then type “Administrator” as the username in the dialog box.

At the end of the installation process, the JNS programs can be activated using the JNS Control Console application.

Launching the Control Console

The JNS Control Console is located at Start > Programs > Jupiter Network Suite > JNS Console. When the program is
launched, the window shown in Figure 4−1 will appear.

§ This application replaces a similar program used in connection with the Jupiter Network Interface Application (JNIA).
† This application cannot be run on a “Remote” PC (a Remote PC is shown on page 2−36).
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Figure 4−1.

The JNS Control Console must be “connected,” i.e., directed to examine/control a particular computer. In this example, there
is only one computer—the “File Server.” Click on the computer, then Connect. A menu similar to that shown in Figure 4−2
will appear.

Note 1: When starting the Jupiter software for the first time, you may need to confirm that the file “JNS Console.i-
ni” should be created.

Note 2: when starting Jupiter for the first time, you may see the following message:

This condition is normal at this stage of installation; click “OK.” Creation and selection of sets is described in the
next section of this manual.
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Figure 4−2.

The “connection” step will automatically launch certain JNS “servers” (programs) on the File Server PC. Running programs
are indicated by the term “Local.” These background programs provide data needed by other software: specifically, the JNS
Applications, Tools, and Utilities. These three program groups, which are shown across the top of the window, consist of the
following programs:

JNS Applications Group

 Page

� Control Center 9−1

� CP IO Set Editor† 10−1

� LogViewer 12−1

� Logger 12−1

� Router Control Utility 17−1

� Saturn Monitor Follow & Preview ‡

� Software Control Panel Suite 
(GUI control panel) 7−1

JNS Tools Group

� Configuration editor (“Configurator”) 5−1

� Board Status 8−1

� Force Unlock 11−1

† Not supported by AccuSwitch.
‡ Not supported by CM 4000.
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� Party Line Download †

� Physical Control 14−1

� Physical Remapping Utility 16−1

� Router Save/Restore 18−1

JNS Utilities Group

� Physical Diagnostic Utility 15−1

Click on the appropriate group button, then the program button. For information about individual programs, refer to the page
number shown.

When the Jupiter system is set up initially, the “Jupiter Configurator” must be used next. This is described in Section 5 of this
manual.

† Not supported by CM 4000.
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Section 5 − Configurator

Following hardware installation, all connections to the Jupiter system including those for control, video, audio, data, and tally
must be identified and described in a “Configuration Set” consisting of a collection of user−defined tables. The configuration
editor (“Configurator”), the editing program used to create and edit these tables, is designed to eliminate manual entry of re-
petitive information and operate in a familiar, “Windows−like” environment. Editing features include search, error detection
and on−screen help, column/row copy/paste, and column/row auto−fill with incremental numbers.

Installation of the Configurator is described in the Field Engineering Bulletin provided with the software.

Quick Start tip : If your Jupiter equipment was purchased from Grass Valley as a “turnkey”
system, you may wish to refer to the Jupiter Getting Started Guide, part no. 04−045707−003.
This booklet provides an abbreviated version of the information in this section.

Starting the Configurator 

Caution: You must have administrator privileges in order to load Jupiter software, launch Jupiter applications,
and configure the system. And, the same login should be used for all tasks performed on the Jupiter file server,
including uninstalling software.

Note: (Windows XP systems) When logging on as the Administrator, you may notice that the welcome screen does
not always show an Administrator icon. Press Ctrl−Alt−Del twice, and then type “Administrator” as the username
in the dialog box to log on as the Administrator.

1. Start Windows.

2. Go to “Start > Programs > Jupiter Network Suite.”

3. Use the JNS Console to start the Jupiter Network Suite (JNS) tool “Configuration Editor” (as described in Section 4).

4. The “File > Open” command is used to select an existing configuration set (or “File > New” used to create a new set);
the full path and name of the set will appear in the window’s title bar. Thereafter when Configurator is started the last
used set will be opened automatically.

Quick Start tip : If you are an experienced Jupiter user, and wish to check the routing switcher
as quickly as possible, see Using the Numeric Set on page 5−11.
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5. To access Jupiter tables, use the “Jupiter” pull−down menu. For example, if you select the Network Description table
the display will be similar to the following (Figure 5−1).

Figure 5−1.

Jupiter Configurator menu
with Network Description
table open.

If a password entry menu appears, it means that a Jupiter password (other than the factory default of “999999”) has been
set. Enter the authorized password and click on “OK.”

The password system is discussed in detail starting on page 5−22.

6. The configuration set should now be edited as appropriate and made active (downloaded) as described beginning on
page 5−8. The pages immediately following provide general information about the Configurator.

Closing the Configurator

To close (quit) the Configurator, select “File > Exit” or click on the Close Box (X) in the upper right−hand corner of the win-
dow.

Other than for convenience, there is no need to leave the Configurator loaded after compiling. However, the JNS application
should be left running and the download connection to the CM 4000 System Controller should be left in place, in case the
a controller board requests a fresh download of data from the file server.
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Configurator Editing Guidelines

AUTOMATIC TABLE ENTRY

This function is designed to expedite the data entry process and eliminate errors due to differences in spelling and entry of
inappropriate data.

In cases where a controller board or device must be entered on more than one table, Configurator will automatically copy (or
offer as a selectable item) the data entered on the “initial entry” table to all “secondary” tables (including Saturn tables). Enter-
ing information in the same order as the tables appear in the pull−down menu will therefore eliminate most repeat entries. For
example, when a CM 4000 is entered on the Network Description table, the name will be added automatically to the Serial
Protocol table.

Note 1: You cannot enter data on secondary tables first. For example, you must enter a new VM on the Network
Description table. Again, data should be entered in the same order as the tables appear in the pull−down menu.

When certain items are deleted, the editor will automatically delete, when appropriate, the corresponding entries on other
tables. For example, when the name of an input is deleted from the Switcher Input table, the input will be deleted automatically
from the other corresponding tables. The same is true for an output deleted from the Switcher Output table. For instance, if the
VTR12 row on the Switcher Input table is deleted, the corresponding row on the CP Input Set table, i.e., the row defining the
category/number keys and mnemonic, will be deleted as well.

ENTRY/EDIT WITHIN A JUPITER TABLE

• Use the mouse, cursor keys, or TAB to move to the desired field. To accept the change and advance to the next
field, press TAB.

• When a field requires a selection to be made from a fixed list, clicking anywhere in the field will cause a drop−
down arrow to appear. Click on the arrow to show the available choices (or press ALT+DOWN). Click on the
desired choice. (You can also enter the first letter in the list item name; enter the letter again to move to the next
item that starts with that letter, then press RETURN.)

Note 2: In some cases you will need to press “Apply” to update the selections in a drop down list.

• To advance to the next row, press ENTER.

Note 3: New entries should be made at the bottom of tables whenever possible to avoid disrupting system
operation. If entries are made to the middle of tables you must be prepared to clear battery−protected memory
(Pmem) in the VM 3000 and re−establish switcher status and machine links. Clearing Pmem is described in
Appendix B.

• Press “Apply” to save the changes in memory (they are not saved to disk until you select File > Save). If you
attempt to edit another table before Applying your changes, a pop up message will appear asking you to confirm
or abandon the changes before editing a new table. After Applying all changes, the set can be Saved using the
“File > Save” command. The message “Exporting...” will appear.

• In some cases spaces are not allowed. If so the editor will not allow them to be entered.
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When creating a name for a Jupiter set, table, control panel, or other device, it’s a good practice to use letters
and numbers only. If you want to use punctuation or special characters, check the list on page 5−7 before
creating a name.

• To jump to the bottom of a table, press CTRL+DOWN; to jump to the top, press CTRL+UP.

• To scroll to the bottom of a long table, press and hold PAGE DOWN. You can also “drag” the scroll box, or
click and hold on the scroll arrows.

• To copy rows and add them to the bottom of the table, drag−select the row number boxes of the source rows (the
rows selected must form a single rectangle). Use “Edit” and “Copy.” Go to the bottom of the page. Press the
INSERT key. Then use “Edit” and “Paste.”

• To copy rows and insert them in the middle of a table, see “Reordering” below.

• You can exit without writing  even after changes have been Applied and the table closed by selecting “File >
Exit.” and answering “No” to the “Save?” question.

• Error detection and explanation − fields that contain insufficient or inappropriate information are marked in
red. Moving the cursor over the field will cause a Help window to appear.

• Auto Complete − the editor will suggest the remaining letters of a word that has been used before. To accept the
auto completed entry, press TAB; otherwise, continue typing the new entry.

REORDERING JUPITER TABLES

Important: It is possible to reorder Jupiter tables, but this can be very disruptive if not done carefully. The order
of entries in certain tables is significant because row numbers are used as cross−references to other tables. If data
is moved from one row to another, these relationships may be broken and system operation will be unpredictable.
When adding new items to tables, add them at the end if possible. If you wish to reorder table data then you must
be prepared to clear battery−protected memory (Pmem) in the system controller and re−establish switcher status
and machine links. Clearing Pmem is described in Appendix B.

• To insert a new row in the middle of the table, click on the row number box above the row where the new row is
to appear. Notice that row selection is a toggle function. Then go to the “Edit” pull−down menu and select “In-
sert Row.” (Or, just press the INSERT key.)

• To delete an entire row, click on the row number box and use “Edit” and “Delete.” (Or press ALT+DEL.)

• To re−order a table manually, drag−select the row number boxes of the source rows (the rows selected must
form a single rectangle). Make a note of how many rows you have selected. Use “Edit” and “Cut.” Select the
row number box above where you want to paste. Make room for  the source block by pressing the INSERT key
once for each source row. Then use “Edit” and “Paste.”

• To copy rows from one Jupiter table to another, drag−select the row number boxes of the source rows (the rows
selected must form a single rectangle). Make a note of how many rows you have selected. Use “Edit” and
“Copy.” Go to the destination table. Select the row number box above where you want to paste. Press the IN-
SERT key once for each row to be pasted. Then use “Edit” and “Paste.” (If you use this procedure without in-
serting blank rows, the existing rows will be overwritten.)
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FIND / FILL / INCREMENT

“Edit > Find” − searches for a text string in all open tables.

“Edit > Fill”  −  this is a copy/paste function for use with tables containing repetitive material. Select the row or column with the
desired text and then “Edit > Fill Right” or “Edit > Fill Down” to paste the information.

“Edit > Increment” function − similar to “Edit > Fill” except that incrementing numbers are automatically created in columns
to the right or rows below as desired. For example, on the Switcher Input table you could enter “IN 1” in the top left field, then
select the desired fields (the whole column in this example) and “Edit > Increment Down.” This will fill the rest of the column
with “IN 2,” “IN 3,” etc. to the bottom of the table. It is also possible to mix categories (prefixes) within a column and still
automate the process. For example, “VTR 1” could be entered in the top left field, the following 10 rows selected and “Edit >
Increment Down” applied; this would produce 10 rows labelled VTR 1 through “VTR 10.” “CAM 1” could then be entered in
the Name field on row 11, additional rows selected, “Edit > Increment Down” applied, etc.

COPYING AND PASTING A BLOCK

Before changing an existing Jupiter table, be sure to read “Important” on page 5−4.

• To copy a block, drag−select the block of the source fields (the fields selected must form a single rectangle).
Use “Edit” and “Copy.” See Figure 5−2.

       Figure 5−2.

Input Set — KXYZ−INP

Category Entry Mnemonic Logical

CAM 1 C1 CAM11

2 CAM 2 C2 CAM2

3 CAM 3 C3 CAM3

Input

Next, select the top left field of the destination area. In this case, the paste will overwrite the existing text.

Figure 5−3.

Input Set — KXYZ−INP

Category Entry Mnemonic Logical

CAM 1 C1 CAM11

2 CAM 2 C2 CAM2

3 CAM 3 C3 CAM3

Input

Then use “Edit” and “Paste.” the result is shown in Figure 5−4.

        Figure 5−4.

Input Set — KXYZ−INP

Category Entry Mnemonic Logical

CAM 1 CAM11

2 CAM 2 CAM2

3 CAM 3 CAM3

CAM1

CAM2

CAM3

Input
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Keyboard Shortcuts

To select an entire column, click the name of the column. Click anywhere outside the column to un−select.

To select an entire row, click the number of the row. Click anywhere outside the row to un−select.

COPY AND PASTE ROWS BETWEEN THE WINDOWS CLIPBOARD AND JUPITER

Before copying from a Windows program to Jupiter, be sure to read “Important” on page 5−4.

You can use Cut, Copy, and Paste to exchange information between Jupiter and other Windows programs such as Microsoft
Word and Microsoft Excel. For example, suppose you want to create a Jupiter CP Input Set using Microsoft Word or another
Windows text editor. The document might look like this:

VTR � 1 � VT01 � VT01
VTR � 2 � VT02 � VT02
VTR � 3 � VT03 � VT03
VTR � 4 � VT04 � VT04
VTR � 5 � VT05 � VT05
VTR � 6 � VT06 � VT06
VTR � 7 � VT07 � VT07
VTR � 8 � VT08 � VT08
VTR � 9 � VT09 � VT09 Figure 5−5. Text as entered using word processor.

The text must be “tab−delimited” (as indicated by the arrows). Spaces must not be used between columns. In the case of a
Microsoft Excel or other Windows spreadsheet document, each field would be entered in a separate cell.

You can drag−select this text, make a note of how many rows you have selected, and use “Edit” and “Copy” in the Word win-
dow. Then select the Jupiter CP Input Set window and select the row number box above where you want to paste. If you want
to insert new rows, press the INSERT key once for each row to be pasted. Then use “Edit” and “Paste.” The result is shown
in Figure 5−6.

Figure 5−6. Resulting Jupiter table.

4

Input Set — KXYZ−INP

Category Entry Mnemonic Logical

5

6

VTR 4 VT04 VT04

VTR 1 VT01 VT011

2

VTR 5 VT05 VT05

VTR 6 VT06 VT06

VTR 2 VT02 VT02

VTR 7 VT07 VT07

VTR 8 VT08 VT08

VTR 9 VT09 VT09

7

8

9

3 VTR 3 VT03 VT03

Input

The same technique can be used to copy from Jupiter and paste into another Windows program.



Configurator

5−7CM 4000 Installation and Operating Manual

Jupiter Naming Rules

When creating a name for a Jupiter set, table, control panel, or other device, the following rules should be observed:

• Eight character maximum.

• The following characters are OK :

Letters A through Z

Numbers 0 through 9

Underscore _
Number sign #
Hyphen −
Caret ^
Dollar sign $
Exclamation point !
Percent sign %
Ampersand &
Braces { }
At sign @
Single quote mark ‘
Apostrophe ’
Right parenthesis  )

• Do not use:

Space
Comma ,
Colon :
Semicolon ;
Forward or  back slash / \
Asterisk *
Period .
Left parenthesis (
Plus +
Equal =
Less or Greater than < >
Brackets [ ]
Question mark ?
Double quotes ”
Vertical bar (pipe) |

• Do not create a filename that is identical to another file (or subdirectory) in the same directory.
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Configuration Set Management

The top of the Configurator menu (page 5−9) shows the name of the selected set. This is the system configuration directory
that is currently selected for editing. 

After a set is edited, it should be saved and then compiled. If compiling is successful, the set name will appear on the Jupiter
Network Suite Control Center “Application” menu; the set can then be selected for downloading, during which a copy is
sent to the system hardware. Another copy always remains in the server, ready for automatic, on−demand download to the
hardware.

The Jupiter can have any number of configuration sets, each of which contains the file and subset types shown on page 5−12.
(The files in quotation marks are example names.)

Any one of the configuration sets can be selected for use by the system. This allows the entire system to be reconfigured from
the file server with only a brief interruption to normal operations.

Modifying and Downloading a System Configuration Set

Quick Start tip:  Program the system in small steps and compile often!

As described earlier, a compiled and/or active configuration set cannot be edited directly. And, since creating a new configura-
tion set from scratch is a very time−consuming process, you will probably want to make changes by making a copy of the
uncompiled (source) version of the set, editing it, and then switching the new set on−line. While any number of file manage-
ment schemes can be used to accomplish this, the following procedure is suggested:

� Make a copy of the most recent, known−good source set. Name the copy “CONFIG01.”

� Edit “CONFIG01.” Save the set.

� Compile and Download “CONFIG01.”

� When the next change is needed, select and copy source set CONFIG01. Name the copy “CONFIG02.”

� Edit “CONFIG02.” Save. Compile and download.

� Repeat above steps as needed.

� Eventually you will want to start deleting the older sets.

By numbering the sets, there will never be any doubt about which is the latest version. Also, it will be easy to return to “known
good” sets. This suggestion is detailed in the steps below.
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Source
set

selected
for editing

Compiled set(s)

Source sets

“Activate”
(Download)

CM 4000
Compile

Select for
editing

Save

Network Description

1
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CM1
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0080CE010000
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Copy of
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process

Open Configuration Set
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VGA−DEMO

Configuration sets
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OK Cancel

NUM−128

CONFIG02

Figure 5−7. Configuration set editing and downloading.

Redundant
Address



Configurator

5−10 CM 4000 Installation and Operating Manual

COPYING A CONFIGURATION SET FOR EDITING

Make a copy of the latest known−good set as follows:

1. On the “File” portion of the Jupiter Configuration menu (page 5−2), click on “Open.” This will bring up a menu similar
to that shown in Figure 5−8.

This menu will list all existing system configuration sets.

The NUMERIC sets are factory−supplied sets provided for quick start and diagnostic purposes. For more information,
see page 5−11. The list may also contain a test set used at the factory.

Open Configuration Set

NUM−64
NUMERIC
NUM−LE
VGA−DEMO

Configuration sets

CONFIG01

C:\PROGRA~1\Thomson\J

OK Cancel

NUM−128

Figure 5−8.  Select Edit Set menu.

2. Click on the desired set name and “OK.” Wait for the set to load. Close the loading progress window.

3. Select “File > Save As.”

4. Enter a new name for the set (up to eight characters).

When creating a name for a Jupiter set, table, control panel, or other device, it’s a good practice to use letters and numbers
only. If you want to use punctuation or special characters, check the list on page 5−7 before creating a name.

In keeping with the suggestion described earlier, you may wish to name the copy “CONFIG01.”

5. Click on the “OK” button. When the copy is finished, the copy will be the active set.
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MAKING THE DESIRED MODIFICATIONS TO THE SET

Editing procedures for specific modifications are described later in this manual, starting with the Network Description table
on page 5−27. From the Network Description table, you should move on to the Serial Protocol table, then the Switcher De-
scription table, and so on through the remaining Jupiter tables. See page 5−12.

Note: As previously explained, you cannot enter data on “secondary” tables first. For example, you must enter a
new CM 4000 on the Network Description table. In general, data should be entered in the same order as the tables
appear in the pull−down menu. For more information, see “Automatic Table Entry” on page 5−3.

Not all tables will apply to every system. For example, some are for machine control, others are for backward compatibility
with Philips/BTS Party Line equipment, etc. Please refer to the description of each table for more information.

USING THE “NUMERIC” SETS FOR QUICK SWITCHER CHECKOUT

The factory−supplied numeric configuration sets can be used to set up and operate the routing switcher in the
minimum possible time. The “NUMERIC” set provides for a switcher with up to 256 inputs, 256 outputs, and
four levels; the “NUM−64” set provides for 64 inputs and outputs; and the “NUM−128” set provides for 128
inputs/outputs.

The numeric sets are complete and ready to download, except for entry of at least one CM 4000 Control Chassis
address, entry of the actual switcher Physical Levels and Driver types, and one switcher control panel address.

Use the “File > Open” menu to select one of the Numeric sets and make a copy (as described on page 5−10.)

Select “Jupiter > Network Description” table and change the CM 4000 address(es) to match those in your sys-
tem (see page 5−27). The actual switcher Physical Levels and Driver types are entered on the Switcher Descrip-
tion table (page 5−35). The control panel address must be entered on the MPK Devices Description table (page
5−107).

The set can then be compiled and activated as described on page 5−13.

Inputs and outputs are selected numerically, using the TEST key on a CP 3000 control panel to enter a leading
zero for selections zero through 99. The VTR key is used to enter a “1,” and so on. For complete CP 3000 operat-
ing instructions, see page 6−7.

Quick Start Tip
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Password Table

c:\Program Files\Thomson\JUPITER\Config

Additional
configuration
sets

Configuration set
“CONFIG01”

——Network Description
——Serial  Protocol

——Switcher Description
——Switcher Input
——Switcher Output

——CP Level Sets
——“KXYZ−LEV”
——

——CP Input Sets
——“KXYZ−INP”
——

——CP Output Sets
——“KXYZ−OUT”
——“MC−OUT”
——“SHOP”
——“DELAY−OUT”
——etc.

——CP Override Sets
——“KXYZ−OVE”
——

——CP Sequence Sets
——“KXYZ−SEQ”

——CP Category Sets

——MPK Devices

——Machines
——Machine Control
——Delegation Groups

——Status Display Header
——VGA Status Display

——Tally

——Sequential Path Finding
——Non Seq Path Finding

——Exclusion
——Y Line

——Time  Standard
——Video Reference
——CM VGA Options †

Configuration set
“CONFIG02”

Figure 5−9.

——Network Description
——Serial  Protocol

——Switcher Description
——Switcher Input
——Switcher Output

——CP Level Sets
——“KXYZ−LEV”
——

——CP Input Sets
——“KXYZ−INP”
——

——CP Output Sets
——“KXYZ−OUT”
——“MC−OUT”
——“SHOP”
——“DELAY−OUT”
——etc.

——CP Override Sets
——“KXYZ−OVE”
——

——CP Sequence Sets
——“KXYZ−SEQ”

——CP Category Sets

——MPK Devices

——Machines
——Machine Control
——Delegation Groups

——Status Display Header
——VGA Status Display

——Tally

——Sequential Path Finding
——Non Seq Path Finding

——Exclusion
——Y Line

——Time  Standard
——Video Reference
——CM VGA Options †

† This function is optional. See Appendix H.
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VALIDATING, COMPILING, AND ACTIVATING (DOWNLOADING) A CONFIGURATION SET

1. After you have finished editing, select the “Tools > Validate All Tables” pull−down menu on the main menu menu (page
5−2).

If a validation error is reported, move the cursor to the red−colored area of the table to view the reason for the error.
Correct the error and run the validator again.

2. Select the “Tools > Compile” pull−down menu on the main menu menu (page 5−2). When the compiler is finished,
the number of compiler errors (if any) will be reported.

If a compiler error is reported, the error must be corrected and the set re−compiled. To print the error messages, click
on the “Print” command box.

Don’t worry about an error corrupting the active set—even if the active set has the same name as the one you’re working
on. A new set must compile without errors and be explicitly selected for downloading by the Control Center software
before it can go online.

3. Click on “Close.”

4. Use the JNS Console to start the Jupiter Network Suite (JNS) application “Control Center” (as described in Section 4.)
This will open a window similar to that shown in Figure 5−10.

A background program called “Bootp Server” will also be started automatically.

5. Click on the new set for the Active set. Check that the “Select and Reboot” radio button is selected.

Figure 5−10.

6. To initiate the download, click on “Activate.”
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Caution: Once the activate/reboot command has been issued, do not interrupt the process until the reboot is
complete. Interruptions such as sending a new command, turning off power, or disconnecting cables will
have unpredictable consequences. With a CM 4000, such consequences can include corruption of data stored
in flash memory and on the CM hard drive.

After a few seconds, the LEDs on the controller boards will turn red momentarily and the message “Device not con-
nected” or “Startup” will appear on the system control panels. When the download is complete, the LEDs should be
green and the panels returned to their previous status display. Depending on several factors such as the number of boards,
configuration size, need to update the *.sys file, LAN transmission rate, LAN traffic, etc., a complete set change can
take several seconds or multiple minutes.

Download status can also be determined using the Control Center “Board Status” tab.

For more information about Control Center functions, including the “Reboot” and “Restore Backup” buttons, see page
9−1.

Note: special procedures are available for CM 4000 systems to minimize system downtime during set activa-
tion. See “Download Now / Reboot Later” on page 5−15.

7. All control panels should now be operational. For operating instructions, see Section 6. (For Software Control Panel
operation, see Section 7.)
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DOWNLOAD NOW / REBOOT LATER (“PENDING REBOOT”)

Please refer to Figure 5−11.

In order to minimize system downtime due to changes in configuration and application code and to provide the operator the
ability to coordinate the time that the system is unavailable, modifications were made to Windows and the CM 4000 embedded
code resulting in a different configuration set and code activation procedure compared to previous Jupiter releases.

With the CM 4000, it is possible to download a configuration set and a copy of the application code without actually placing
them in operation; during this “Pending Reboot” state the CM continues to operate without interruption using the previously
executing application code and configuration. Only when the board is rebooted will the new set and application code be placed
in use.

Note: A reboot will occur when the operator executes any operation from the Control Center that will cause a re-
boot or a “Pmem Clear” to be sent to the processor, or by manually rebooting, or clearing Pmem on the processor
from the shell prompt, or by pressing the reset button.

The purpose of this technique is to provide the operator better control of system downtime. The download process, which
may be rather lengthy in large systems, does not interfere with normal operations. This allows the Reboot step, which is much
shorter (but will  interrupt switching operations), to be scheduled at an appropriate time.

Source
set

selected
for editing

Compiled set(s)

Source sets

Compile

Select for
editing

Save

Set
selected

for
download

Select and
process

Application
(executable code)

FILE SERVER

CM 4000

Copy of
Application

(executable code)

Downloaded
Set

Executing
Application

Operating
set

Reboot

“Activate”
(Download)

Reboot

Control panels

Router

Figure 5−11.

“Activate”
(Download)
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Download now / Reboot later procedure

1. Go to “Control Center >  Configuration > On Activation > Select and Reboot.” Then select a set and click “Activate.”
See Figure 5−12.

Figure 5−12.

Note 1: With the CM, choosing “Select and Reboot” will not cause the CM to reboot. Reboot of the processor
should be accomplished through the use of the Reboot button on the Board Info/Control menu, as described
below.

Note 2: In order to download new application code, you must select a configuration set for Activation even if
it has the same name as the set shown as “Current.” This action causes the system to recalculate the checksum
of system files allowing the processor to determine the need to download/update files.

Note 3: If the configuration set selected for activation and the Current set have identical content, the com-
mand to Activate (download) the set will be deemed by the processor to be un−needed. If application code has
changed, the processor will download it as a result of these actions.

When a configuration set is activated, the CM 4000 running 7.0 software will download the configuration and the ap-
plication code as a background task. It is important to note that this newly activated configuration and code is not
placed in operation on the CM 4000 until a reboot of the processor is performed.

2. Go to the Board Info/Control tab and monitor the status of the CM 4000 processors.

The system will compare the configuration set just downloaded with the configuration set that is in operation; if they
are different the “Pending Reboot” message will appear in the “Configuration” column as shown in Figure 5−13. Like-
wise the system will compare the application code just downloaded with the application code that is in operation; if they
are different the “Pending Reboot” message will appear as shown in Figure 5−14.
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Figure 5−13.

CM 4000

Copy of
Application

(executable code)
Downloaded

Set

Executing
Application

Operating
set

Reboot Reboot
“CONFIGURATION

PENDING REBOOT”
is indicated when

these two sets do not
match

Figure 5−14.

CM 4000

Copy of
Application

(executable code)
Downloaded

Set

Executing
Application

Operating
set

Reboot Reboot

“CODE
PENDING

REBOOT” is
indicated when
these two sets
do not match

Note: Due to the size of the application, the operator may observe “Mismatch” in the Code column while the download
is in progress (this is illustrated on page 5−17). The operator should wait until the Code column indicates “Pending Re-
boot” before continuing.

3. Once the Configuration or Code is successfully downloaded, as indicated by “Pending Reboot,” the operator can, at a
convenient time, select the processors either individually or by clicking “Select All” and then initiate a reboot of the
processor by clicking “Reboot” (or “Clear PMEM”). The result is shown in Figure 5−15.
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Figure 5−15.

The “OK” message means that the set/code executing are the same as the set/code on the file server.

Important:  In systems with more than one controller board it is a good practice to complete the Pending
Reboot process as soon as practical.

Mismatch Indicator

Please refer to Figures 5−16 and 5−17.

Under certain conditions, it is possible for the set/code downloaded (or selected for download) to be different than the software
that is actually in operation. An example of this condition is “Pending Reboot” (already described), where a set and application
are downloaded for Reboot at a later time.

A similar situation may arise if there is a controller board changeover, a selective download, or a break in the network. The
“Mismatch” indicator will show when the set/code in the file server is different than the set/code that is executing in a CM
4000. It is normal for the “Mismatch” indicator to appear while files are being downloaded from the file server to a controller
board. The progress and state of the download can be observed by clicking on the “TFTP Status” tab in the Control Center.
Once the download is complete, the “Mismatch” indicator will change to “Pending Reboot.” If the “Mismatch” indicator ap-
pears (and remains on), and a file transfer is not in progress, it is suggested that steps be taken to reboot the controller.



Configurator

5−19CM 4000 Installation and Operating Manual

Set
selected

for
download

Application
(executable code)

FILE SERVER

CM 4000

Copy of
Application

(executable code)

Downloaded
set

Executing
Application

Operating
Set

Reboot

“Activate”
(Download)

Reboot

“Activate”
(Download)

Figure 5−16.

“CONFIGURATION
MISMATCH” is
indicated when

these two sets do
not match

“CODE MISMATCH” is
indicated when these two
applications do not match

Figure 5−17.
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Troubleshooting

ERROR CONDITIONS

— “00,” “01,” or “FF” remain indicated on the front panel LED display. Red Alarm light on controller board
remains On. The meaning of the various possible LED on/off combinations is shown in Appendix R.

— The “Device not connected” message fails to appear or clear. There may be a download fault in the CM 4000
serial control section. It may be possible to correct this by resetting the board manually. See Appendix B.

— A switcher control panel fails to indicate switcher status. There may be a download fault in the controller
board. It may be possible to correct this by resetting the board manually. See Appendix B.

— Other errors/conditions. The “TFTP Status” and “Board Info/Control” tabs in the Control Center window can
be used to check the system. For more information, see page 9−1.

— A Log Viewer is also available as a diagnostic tool. For more information, see Section 12.

PROGRAM CRASH RECOVERY

If a control panel locks up, normal operation can usually be restored by cycling the power to the panel or to the controller
board. For additional information concerning hardware reset, please refer to Appendix B.

DELETING JUPITER SOFTWARE

To uninstall the Jupiter software, follow the procedure given in the Field Engineering Bulletin supplied with the software.

Caution: You must have administrator privileges in order to load Jupiter software, launch Jupiter applications,
and configure the system. And, the same login should be used for all tasks performed on the Jupiter file server,
including uninstalling software.

RE−INSTALLING JUPITER SOFTWARE

Refer to the Field Engineering Bulletin supplied with the software.

ZIPPING A CONFIGURATION SET

As part of a troubleshooting procedure, you may want to send a particular configuration set to Grass Valley Technical Support
for analysis. The Zip tool can be used to assemble all directories and files within a set so that it can be sent as a single com-
pressed file.

To zip a set, click on the “Tools > Zip Configuration Edit Set” menu selection. You will be asked to select a configuration
set, then you will be asked for the location to store the file. The default location is “C:\Program Files\Thomson\Jupiter\Logda-
ta\”. You may wish to change this location (i.e., to a floppy). Once you select OK, the selected set will be zipped up.
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To unzip a set, click on “Tools > Unzip Configuration Edit Set”. You will be asked which file to unzip. Make sure that the
selected file is a valid zip file that was created by the method outlined above. Once you select a zip file and click OK, the set
will be unzipped. If the set already exists, you will be asked if you want to overwrite the set. If you select OK, the set will
be overwritten.

ZIPPING A CONFIGURATION SET WITH DIAGNOSTIC INFORMATION (“SUPPORT PACKAGE”)

To combine the active configuration set with the editor’s diagnostic information in a single zip file, go to “Tools > Create
Support Package.” This file can then be sent to the Technical Services department to help them troubleshoot any difficulties
you are having. The support package will include the version of the configuration set that is currently stored on your hard
disk (i.e., unsaved changes will not be included). If your configuration set is new and has never been saved, it cannot be in-
cluded.

Printing

Printer installation was discussed on page 2−36. If you want to print a single table, bring the table’s window to the top of the
desktop. Then select the “Print” command button on the bottom of the window.

Note: Printing of an entire set is not supported.

On−line Help

Two levels of Help are available for the Configurator: “What’s This” Help, whereby the name of a tool will appear when the
cursor remains stationary over the icon for that tool, and “Implicit” Help, where a brief explanation of a field’s purpose or
requirements will appear along the bottom of the window when the field is selected.

In addition, an Adobe Acrobat version of the manual you are now reading can be accessed by selecting the “Help” pull−down
menu. The Acrobat Reader must be installed to view the manual on−line.

Inadvertent Loss of Power

Following a power interruption, the Jupiter controller board(s) will reset itself and should be back in operation in a few sec-
onds. The controller board uses a combination of flash ROM and battery−protected RAM to maintain programs and user ta-
bles indefinitely.

Disconnecting File Server from LAN

The file server can be disconnected from the LAN without affecting control panel operation. However, if for some reason
a controller board requires re−downloading, it will be unable to complete this operation until the LAN is reconnected and the
JNS program is running properly.

Important:   If for test purposes you wish to disconnect the LAN and reset a controller board, you must wait  60
seconds before pressing the reset switch. If you press reset before 60 seconds, the controller board will hang and
require re−downloading from the server.
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Passwords

Quick Start tip : You may wish to skip the Password table when you first configure the
system. If password levels are needed they can be added later.

The Jupiter passwords are arranged in a hierarchy, with the “99” level password being the equivalent of a supervisor password.
Entry of a 99−level password on the main menu (page 5−2) will allow any system operation, including starting the Jupiter
software and creating or changing passwords. There must be at least one 99−level password in the system at all times. In Figure
5−18, Boss Bill might have a password  of “007007”  with a level of “99.”

In addition, a password level can be established for each control panel and each switcher output. Bill’s control panel has an
inherent  password level of 80 and the switcher output leading to VTR1 has a level of 60. This means that anyone using Bill’s
control panel would be able to select a source for VTR1. Notice that the panel could also be used to select a source for QC
but not for the Lobby monitor.

Figure 5−18. Jupiter password system.

Boss Bill

99

Bill’s control
panel

80

Operator
Dave

70

Dave’s control
panel

50

10

60

90

QC VTR1 LOBBY

—— D E S T I N A T I O N S ——

Password
Levels
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However, Bill can enter his own personal password into his panel (or anyone else’s) and temporarily raise the panel’s level
to “99.” A new source could then be switched to the Lobby:

99

80

90

LOBBY

ÇÇÇ
ÇÇÇ
ÇÇÇ

50

ÇÇÇ
ÇÇÇ
ÇÇÇ
ÇÇÇ
ÇÇÇ
ÇÇÇ

Boss Bill Bill’s control
panel

Dave’s control
panel

Figure 5−19. Raising the level of a panel.

Furthermore, the level of a panel can be raised just long enough to make one switch (or until someone logs out of the panel).
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When the level of a panel is raised only temporarily, then re−entry of a password will be required for special commands such
as  protect* and lock,* and for front−panel definition of overrides.* It may also be required for executing an Input Sequence.*

For example, Operator Dave can protect the feed to VTR1 (Figure 5−20). No other panel, regardless of password level, could
then be used to change the source: †

Figure 5−20. Protecting an output.

ÇÇ
ÇÇ
ÇÇ

99

80

70

60

VTR1

50

PROTECT

Boss Bill Bill’s control
panel

Operator
Dave

Dave’s control
panel

A more rigorous form of protection is lock, where the output must be deliberately unlocked before changing the source for
a particular destination (Figure 5−21). Only the panel used to lock the output could unlock the output.†

Figure 5−21. Locking an output.

ÇÇ
ÇÇ
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99
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* Terms marked with an asterisk are found in the Glossary.
† Except by using supervisory “force unprotect/unlock.” See page 5−26.
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Systems are shipped with a password level of 00 for all panels and outputs; therefore any password can initially be used to
access all control panel functions.

As shown in Figure 5−9, there is only one table of passwords, and this table is used no matter what configuration set is active
or selected for editing. However, the password levels for individual control panels and outputs are stored with individual con-
figuration sets.

CHANGING PASSWORDS

1. On the main menu (page 5−2), select “Jupiter” (or ALT+j) to bring up the configuration set table list (Figure 5−22).

As explained above, it doesn’t matter which configuration set is selected for editing, since the password table applies
to all sets.

Password

Network Description
Serial Protocol

Switcher Description
Switcher Input
Switcher Output

Control Panel Sets F8
MPK Devices

Machines
Machine Control
Delegation Groups

Status Display Header
VGA Status Display

Tally

Sequential Path Finding
Non−Sequential Path Finding

Exclusion
Y Line

Time Standard†

Video Reference†

CM VGA Options§

CP Level Set
CP Input Set
CP Output Set
CP Override Set
CP Sequence Set
CP Category Set

Figure 5−22. Configuration set table list.

† See Appendix G.
§ See Appendix H.

2. Select “Password” (or press “p”). This will display the password table:

1

Password Table

Password

999999

Level

99 Figure 5−23.

3. Select the password you want to change.

Guidelines for using the editor are found on page 5−3.

4. Type in the revised password. The password must consist of six numbers.
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 5. Use TAB (or click) to select the Level field. Type in the revised password level (if any). This must be a number from
00 to 99.

In this example, pressing Enter at this point will create a row for another password. (If left blank, the new row will be
deleted automatically when the table is saved.)

6. When editing is complete, select “OK.” To save the changes, select “File > Save.”

SETTING PASSWORD LEVELS FOR CONTROL PANELS

Please see page 5−113.

SETTING PASSWORD LEVELS FOR SWITCHER OUTPUTS

Please see page 5−57.

FORCE UNPROTECT/UNLOCK

Force unprotect/unlock is available as a file server utility (page 11−1) and with the VGA Status Display (page 6−140).
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Network Description

This table must be used when the following are first installed on the LAN:

• CM 4000 System Controller

• Saturn Master Control Switcher†

• Software Control Panel Suite‡

0080CE010100

Redundant

2

Network Description

Board Name

CM1 0080CE010101SB

Address

3

1

Type Address

Figure 5−24. Network description (example).

Password 5−22

Network Description
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

Each board is given a user−specified name up to eight characters in length. The system is told which type it is, and the Ethernet
address, in hexadecimal, as shown on the back of the controller chassis. The Ethernet address was furnished by Xerox Corp.
and is unique world−wide. If the board is redundant, the address of the second unit is entered.

Important:  Row numbers on Jupiter tables are used as the “logical” numbers for devices. Changing the row num-
ber of an existing device (by inserting/deleting a new controller board in the middle of the table, for example) will
disrupt control of the system, requiring controller boards to be memory−cleared and reset (see “Clearing Bat-
tery−Protected Memory” in Appendix B). One way to avoid this interruption is to add new devices at the end of
tables.

Important:  Adding a redundant controller board to an existing table will also affect the system as described im-
mediately above.

† Saturn configuration instructions are described in the Saturn Installation and Operating manual.
‡ Applies only when Software Control Panel is used for machine control. For more information, see Section 7.
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AUTOMATIC TABLE ENTRY

Because entries on this table are needed on other tables, the Configurator will automatically copy (or offer as a selectable item)
the data entered on this “initial entry” table to all “secondary” tables (including Saturn tables). For example, when a CM 4000
is entered, the name chosen will be added automatically to the Serial Protocol table. For more information about automatic
table entry, see page 5−3.

ENTERING DESCRIPTIONS OF CONTROLLER BOARDS

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5−10.

2. Click on “Jupiter > Network Description.” This will open a table similar to that shown on page 5−27.

3. Double−click on the first Board Name box.

Guidelines for using the editor are found on page 5−3.

4. Enter the desired name for the board, up to eight characters.
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5. Press TAB to advance to the board Type box. A pop−up menu will list the possible board types. Select a type based on
hardware and application:

Board Application
“Type”
Entry Notes

CM 4000
AccuSwitch processor AS

JupiterXPress (“Snowbird”) processor SB

Saturn AAP Analog audio processor AA

Saturn AVP Analog video processor AV

Saturn CP Control Panel CP

Saturn DAP Digital audio processor DA

Saturn DVP Digital video processor DV

Saturn HDVP High definition video HD

PC Software control panel suite PC

6. Select the Address box and enter the Ethernet hardware address for the board.

For the CM 4000 and other system controllers, the address is shown on the back panel.

Use the Backspace key to erase.

7. If the board is redundant, enter the address of the second unit.

Even though they have the same name, the two boards will have different addresses on this table.

A redundant CM 4000 installation is described on page 2−8.

8. To delete a board, click on the row number box and press DELETE.

9. To close the table, click OK.

10. Click on “File > Save” to save the table.

11. Select the next table for editing. When finished, validate, compile, and activate the configuration set. (See Validating,
Compiling and Activating the Configuration Set on page 5−13 if you need more information.)
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Serial Protocol

The Serial Protocol table must be used when a CM 4000 System Controller is first connected to VTRs, control panels, and
other serial control devices. This includes “remote” (third party) switchers.†

This table is also used when a Saturn video processor serves as a connection point for an MPK bus, and/or when a PC acts
as a Software Control Panel.‡

2

3

Serial Protocol

1 CM1 MPK

Board (CM 1)
Protocol 1/2 -

MPK

(CM 2)
Protocol 3/4 -

MPK

(CM 3)
Protocol 5/6 -

SNY

(CM 4)
Protocol 7/8 -

UND

(CM 5)
Protocol 9/10 -

UND

11/12 - (CM 6)
Protocol

UND

13/14 - (CM 7)
Protocol

UND

15/16 - (CM 8)
Protocol

38400

(CM 1)
Baud 1/2 -

(CM 2)
Baud 3/4 -

(CM 3)
Baud 5/6 -

(CM 4)
Baud 7/8 -

(CM 5)
Baud 9/10 -

(CM 6
Baud 11/12 -

(CM 7)
Baud 13/14 -

(CM 8)
Baud 15/16 -

38400 38400 38400 UND UND UND UND

Figure 5−25. Serial protocol table (example).

Password 5−22

Network Description 5−27
Serial Protocol

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

The CM 4000 has eight serial ports; each can be set individually.

The columns on the right side of the table show the baud rate setting for each port.

† Some of the functions described in this section may be extra−cost options or may be unavailable. For more information, see
page 1−27.

‡ Applies only when Software Control Panel is used for machine control. For more information, see Section 7.
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ENTERING PROTOCOL FOR CONTROLLER BOARD PORTS

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5−10.

2. Click on “Jupiter > Serial Protocol.” This will open a table similar to that shown on page 5−30. The Board names should
already be present (they were established using the Network Description table—see page 5−27).

3. Double−click on the appropriate protocol box. A pull−down menu will list the possible protocol types. Click on the
desired type. To accept the entry, double−click again.

Guidelines for using the editor are found on page 5−3.

4. Continue the process for the baud rate fields. 

Baud rates will be selected automatically for some protocols. The possible selections are as follows (NA = not available,
Opt = optional, Std = default):

Figure 5−26. Serial protocol selections.

Device type Protocol 1200 2400 4800 9600 19200 38400 115000

GVG200† 200 NA NA Opt Opt Opt Std NA

Ampex† AMP −− −− −− −− −− −− −−

ASCII ASC Opt Opt Opt Std Opt Opt Note 1

DEC† DEC −− −− −− −− −− −− −−

DD (Diamond)† DIM NA NA Opt Opt Opt Std NA

Datatek DTK NA NA NA NA NA Std NA

Dune† DUN −− −− −− −− −− −− −−

ESbus† ES −− −− −− −− −− −− −−
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Device type Protocol 1200 2400 4800 9600 19200 38400 115000

ES Control ESC NA NA NA NA NA Std NA

ES−Control Panel ESCP Opt Opt Opt Opt Opt Opt Std

ESW−Physical ESP Opt Opt Opt Opt Opt Std NA

ES Switch ESW Opt Opt Opt Opt Opt Std Note 1

GVG Horizon HRZ NA NA NA NA NA Std NA

GVG Native Protocol GNP Opt Opt Opt Std Opt Opt Opt

MPK MPK Note 3 Note 3 NA NA NA Std NA

Nexus NXS NA NA NA NA NA Std NA

Party Line† PL −− −− −− −− −− −− −−

RKX† RKX −− −− −− −− −− −− −−

Sony† SNY NA NA NA NA NA Std NA

TCS 1† TCS −− −− −− −− −− −− −−

TCS 2† TC2 −− −− −− −− −− −− −−

Triton TRI NA NA NA NA Std NA NA

TSL−UMD TSL NA NA NA NA Std NA NA

Utah UDI−1B U96 NA NA NA Std NA NA NA

VT_ VT_ Opt Opt Opt Opt Std Opt NA

Note 1: 115K available only with CM 4000.
Note 2: Protocol for automation systems varies. Refer to additional protocol notes below and 

documentation supplied with automation system.
Note 3: Requires special PROMs or control panel settings. See “MPK” notes on page 5−33. 
†Depending on equipment, some of the functions described in this section may not be available. For more
information, see page 1−27.

Additional Protocol Notes

ASC (ASCII) refers to switcher control using Jupiter ASCII protocol commands originating from an external computer
(e.g, an automation system).  When used with Diamond production switchers (as described on page 2−60), the baud rate
must match the hardware setting on the DD production switcher XBAR port (normally 38400). A technical description
of the Jupiter ASCII computer interface protocol is presented in Appendix N.

DTK (Datatek D−2000/2166), HRZ (GVG Horizon), NXS (Nexus), and U96 (9600 baud connection to Utah UDI−1)
all refer to CM 4000 boards controlling one or more of these “remote” (third party) routers. When selected, this entry
will apply to CM odd−numbered ports only. (Hardware installation of these switchers is discussed starting on page 2−11.)

DEC is a custom protocol.

DIM (Diamond) is the protocol used to return mnemonic information to a DD Series production switcher serial port.
The baud rate must match the Diamond hardware setting (normally 38400) (See page 2−60).
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ES (ESbus) is for controlling a EBU/SMPTE ESbus−compatible VTR.

ESC (ESbus control) is for controlling a “remote” (third−party) routing switcher using the proposed ESbus routing
switcher dialect.)

ESCP (ES−Control Panel) is for a JEP−100 Jupiter / Control Panel operating in Serial mode. For more information, refer
to the JEP−100 manual, part no. 071 8376 xx.

ESW (ESswitch) This is a simplified version of the ESbus Tributary protocol. This protocol allows a Grass Valley
Crosspoint Bus router‡ to be controlled by an Encore control system, automation system, or third−party computer.

ESP (ESbus Physical) is a protocol used for “physical” switching where the control system selects physical inputs and
physical outputs on logical levels. (Note: This is not the same as File Server controlled physical switching, as described
on page 14−1.) For a description of this protocol, please contact Grass Valley.

GNP (Grass Valley Native Protocol) is used for Jupiter control of a Grass Valley SMS 7000 or Encore control system
(which is in turn connected to a routing switcher).

MPK  is the “Message per Keystroke” protocol used for all MPK devices, such as CP−3000 series control panels. (For
a complete list of MPK devices, see Dev Type on page 5−108.)

Operating a control panel at any baud rate other than 38400 will limit the number of panels per port to one.

For use with a modem, the CP 3000 panel can be equipped with either a 1200 baud PROM or a 2400 baud PROM;
other panels allow the baud rate to be set at the front panel. For more information, refer to page 2−62.

SNY (Sony) is for the Sony machine control protocol.

TSL−UMD (TSL) is for Television Systems Ltd. under monitor displays. For more information, see Appendix S.

TRI (Triton) routing switcher protocol. Hardware installation of these switchers is discussed on page 2−13.

VT_ is a custom protocol.

5. After saving your changes, compile and activate the configuration set. (See Compiling and Activating the Configuration
Set on page 5−13 if you need more information.)

‡ “Crosspoint Bus routers” are listed on page 1−11.
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SATURN VIDEO PROCESSOR − ENTRY FOR MPK PORT

The Saturn Master Control Switcher video processor (either digital or analog) can be used as an alternate connection point
for an MPK bus. (In Saturn stand−alone systems, it would be the only MPK port available.) Typical uses for the MPK bus
include:

• Connection to an MI 3040 General Purpose / Tally Interface (see page 2−66 for a system illustration).

• Connection to the Saturn console’s Select button group. In multi−channel Saturn systems, this would allow
selection of the channel to be be controlled. Please refer to the Saturn Installation Manual for more information.

An example entry is shown in Figure 5−27. The name of the video processor comes from the Network Description table. To
define the processor’s port, select “MPK” and “38400” for the first port pair. All other ports can be left undefined.

2

Serial Protocol

1 AVP MPK

Board (CM 1)
Protocol 1/2 -

UND

(CM 2)
Protocol 3/4 -

UND

(CM 3)
Protocol 5/6 -

UND

(CM 4)
Protocol 7/8 -

UND

(CM 5)
Protocol 9/10 -

UND

11/12 - (CM 6)
Protocol

UND

13/14 - (CM 7)
Protocol

UND

15/16 - (CM 8)
Protocol

38400

(CM 1)
Baud 1/2 -

(CM 2)
Baud 3/4 -

(CM 3)
Baud 5/6 -

(CM 4)
Baud 7/8 -

(CM 5)
Baud 9/10 -

(CM 6
Baud 11/12 -

(CM 7)
Baud 13/14 -

(CM 8)
Baud 15/16 -

Figure 5−27.
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Switcher Description

Logical level 
number Logical level 

name

Physical level 
number

1

Switcher Description

MAINROUT CM1 64 64 1 Binary None

2 MAINROUT CM1 64 64 2 Binary Left

3 MAINROUT CM1 64 64 6 Binary Right

4 MAINROUT CM1 64 64 3 Binary None

VIDEO

LEFT

RIGHT

TC

5 MAINROUT CM1 65 65 16 DM400B EnforceDATA

6

Switcher VI RV Board #In #Out PLvL Follow Level Driver 3 LI 3 LO Option AudioLevel
DM 400

MC Off Time

Figure 5−28.  Switcher Description table (example).

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

This table must be used when the CM 4000† is first connected to a distribution switcher.§

Each logical level number of the switcher is given a user−specified name up to eight characters in length, and the system is
provided with detailed information about each level.

§ Some of the functions described in this section may be extra−cost options. For more information, see page 1−27.
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ENTERING SWITCHER LEVELS DESCRIPTIONS

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5−10.

2. Click on “Jupiter > Switcher Description.” This will open a table similar to that shown on page 5−28.

3. Switcher Level      Enter a switcher and level name.

Guidelines for using the editor are found on page 5−3.

Important:   Row numbers on Jupiter tables are used as the “logical” numbers for levels. Changing the row number
of a level (by inserting/deleting a new level in the middle of the table, for example) will disrupt control of the
system, requiring controller boards to be memory−cleared and reset (see “Clearing Battery−Protected Memory”
in Appendix B). One way to avoid this interruption is to add new levels at the end of tables. Adding new levels
in the middle of the table will also clear all entries in the Switcher Input and Output tables.

Normally one switcher is named, using up to eight characters.

The level name (also called “logical level name”) can also be up to eight characters. All of the following information
entered on this menu will apply to this level. Conventional names are “VIDEO,” “LEFT,” “RED,” “GREEN,”etc.

For a Venus “ES 401”§ digital audio switcher with two−level stereo mode hardware settings, there must be an entry for
the Left level and another for the Right level; this will allow special stereo mode switching such as Mix and Reverse.
If the ES 401 switcher’s hardware is set for one−level stereo mode, or for one−level mono mode, or if a Venus “ES 400”
digital audio switcher is being configured, only one entry is needed. For information about setting the Venus hardware,
refer to the Venus Installation manual.

If there is more than one Grass Valley Crosspoint Bus router‡ type in the system (such as a Venus plus a Trinix), there
are two possible approaches to configuration. The additional switcher can be entered as a named level (or levels) within
the main router; however, this will require a unique hardware setting on each level to avoid conflicts (see diagram on
page 2−31). Another solution would be to drive the Venus with one CM 4000 and the Trinix with another; this would
allow level settings to remain independent (see diagram on page 2−32).

4. VI      Select vertical interval switching Yes or No for this level. Normally checked for the video level and unchecked
for all others.

If the CM 4000 is supplied with house reference sync, checking VI will cause switches on this level to start in the house
vertical interval. In other words, the level selected on this menu will start switching first; other levels will follow as soon
as possible. Priority is normally given to video since audio switches outside of vertical interval are not as noticeable.

§ In this manual, “ES 401 switcher” refers to the AES11 synchronous/asynchronous version of the digital audio switcher
matrix board and its associated components; “ES 400 switcher” refers to the original asynchronous (non−reclocking) ver-
sion of the digital audio switcher matrix board and associated components.

‡ “Crosspoint Bus routers” are listed on page 1−11.
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This method of enforcing vertical interval switching applies only to Grass Valley switchers operating on the Crosspoint
Bus port of the CM. For “remote serial control” applications, including Triton , VI should be unchecked on all levels.

5. RV      Reverse switching. This item applies only to certain data switchers. For video, audio, and time code switchers,
leave unchecked.

This box is checked for older model RS−232/422/423 data switchers equipped with DM 400/400A§ Data Matrix boards.
Configuration of DM 400/400A Data Matrix boards is described in Appendix L.

Newer model data switchers equipped with DM 400B§ Data Matrix boards use only one level, and the “RV” box is left
unchecked (even though “reverse” switching is still taking place).

6. MC      Select machine control assignment follow Yes or No for this level. Normally checked for video level and un-
checked for all others. One (only) level can be checked.

As explained in detail elsewhere in this manual, the usual procedure is for the machine assignment system to follow the
distribution switcher; that is, if a certain VTR is selected for a certain destination, then the associated machine control
panel will automatically assume control of that VTR. (See Assigning Machines to Control Panels on page 5−141 for more
information.) This menu item determines which level will be used as the reference in making the machine assignment.

7. Board      Select the name of the CM 4000 controlling this level.

The source of these names is the Network Description table (page 5−27).

Each logical level can be controlled by a separate CM 4000.

Redundant CM boards, if any, are ignored on this table. Recall that redundant CM boards have the same logical name.

Using a single CM, one or more Grass Valley Crosspoint Bus routers can be connected to the Crosspoint Bus port.

Triton routers, or certain non−Crosspoint Bus routers, can be connected to a CM 4000 serial port.

§ Type and model of switcher card is shown on front edge of printed circuit board.
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8. #In #Out      Enter the number of inputs and outputs for this logical level.

For Venus video switchers, the maximum for one logical level is 1024 in and out.

For Venus audio switchers, where the left and right channels are assigned to different levels, the maximum number of
inputs is 512 per level; the maximum number of outputs is 1024 per level. For example, these values would apply to
a Venus analog audio switcher configured for stereo operation (the usual case) and to a Venus ES 401 digital audio
switcher configured for two−level stereo operation.

For Venus analog audio switchers configured for mono operation, ES 400 digital audio switchers, or ES 401 digital audio
switchers operated in 1−level stereo mode or mono mode, the maximum number of inputs and outputs is 1024.

Special entries are required if Output Monitoring is being used (see Appendix O).

For Venus DM 400B Data Matrix switchers, the entry for “#In” and “#Out” should be set to the actual number of inputs
plus 1 to allow an extra number for the “SAFE” input. For example, if the switcher is 64  x 64, both entries should be
“65.” (A DM 400B matrix is always square.) The maximum is 192 in and out.

Mars switchers, which use octal architecture, will require special entries. When the binary driver is used (as described
in Step 11 below), then the “#In/#Out” entries are as follows:

Switcher size No. of inputs (as entered on table) No. of outputs (as entered on table)

24 x 8 64 16

For the maximum number of inputs/outputs for remote (third party) switchers, refer to the manual supplied with the
switcher. 

9. PLvL      Enter the physical (hardware) level number.

This is the level address determined by hardware switches on the switcher itself. These are normally set at the factory
and rarely changed in the field. Refer to the following list and the hardware manual supplied with the switcher for more
information.

A physical level number can range from 1 to 999; however, the maximum number of logical levels is still 96. This num-
ber may be reduced according to the number of outputs being controlled. For more information, see page 1−16.

a. Trinix  digital video routers are usually factory set to operate as physical level 7. 
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b. Apex digital audio routers are usually factory set to operate in “two−level stereo” mode, which permits special
stereo mode switching such as mix and reverse. The left level is normally set on the rear panel as level 32. The
Right stereo channel is automatically given the same number plus 4. This setting requires configuration of two
physical levels, typically Level 32 and Level 36. For more information about these hardware settings, refer to the
Apex manual.

c. For Venus switchers, the backplane level select jumpers are usually factory set as follows:

Name of level Physical level no. Notes

Analog video 1
Serial digital video (standard definition) 7
Serial digital video (high definition) 9

Analog audio left (A1) 2
Analog audio right (A2) 6
Analog audio A3 8
Analog audio A4 12
AES digital audio 32 Applies to all versions and modes of digital 

audio switchers.
AES digital audio (right) 36 Applies only to right channel of ES 401 

digital audio switchers operated in two−level
stereo mode.

Time code (mono) 3
Data transmit 16
Data receive 16
Data (reserved) 20

These level numbers should be confirmed by checking the documentation package supplied with the switcher.

Analog audio stereo level numbers: Selection of mono/stereo mode is determined by a backplane
jumper. With this jumper in the Stereo position, the physical level number set by the Level jumper is
automatically applied to the Left stereo channel (in this example, Left audio would be physical level
“2.”); and, the Right stereo channel is automatically given the same number plus 4 the Right stereo
channel is automatically given the same number plus 4 (in this example Right audio would be physical
level “6”). Furthermore, stereo operation places restrictions on the physical level numbers that can be
used; specifically, the “L4” level jumper cannot be installed. For more information, please refer to the
“Backplane Jumpers” section of the Venus Installation Manual.

ES 401 digital audio switcher level numbers: Selection of one− or two−level mode is determined by
hardware jumpers and switches: (1) If the “Mono” backplane jumper is On, the ES 401 will operate as a
one−level mono 64 x 64. (2) With this jumper off, dip switch settings on the Matrix and Output boards
will determine whether the switcher is operated as one−level stereo or two−level stereo.

The default setting is Mono jumper OFF, two−level stereo, which permits special stereo mode switch-
ing such as mix and reverse. This setting requires configuration of two levels, such as Level 32 and Lev-
el 36 as shown above. Again, the right channel always has the number of the left channel plus 4. For
more information about these hardware settings, refer to the Venus manual.
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Note: If non−factory default numbers are used, the following rules should be kept in mind: 1) For analog
audio left levels, and for digital audio levels, the binary form of the physical level number cannot have the 4s
bit set to 1; e.g., decimal ”2” (binary 00000010) can be used for analog audio left but decimal ”4” (binary
00000100) cannot. This means that the following decimal numbers cannot be used: 4 through 7, 12 through
15, 20 through 23, 28 through 31, 36 through 39, 44 through 47, 52 through 55, 60 through 63, etc. 2) The
analog audio right level number must be the left number + 4.

d. Concerto switchers are configured much the same as Venus. For more information, refer to Grass Valley Field
Engineering Bulletin 075−0722−00, “Jupiter Crosspoint Bus Control of Concerto Flexframe Routing Matrix.”

e. Triton switchers, when controlled by Jupiter, use a level scheme different than that described in the Triton manual.
In Jupiter applications, split switching requires each level to be assigned a different number.

Entries in the PLvL column consist of three digits. The first digit serves only to differentiate the table entry from
all other physical levels connected to the CM; the second two digits are derived from the “Router Address” DIP
switch [setting on the rear panel. In a typical video/audio/time code application, the first digit could be “1,” while
the last two digits would be the Router Address for the chassis. For example:

Triton chassis DIP switch setting PLvL entry

Video 0010 (decimal 02) 102
Left and right audio 0000 (decimal 00) 100
Time code 1111 (decimal 15) 115

Note that split switching is possible, but only between chassis; e.g., it is possible to split Audio Left/Right from
Video, but not possible to split Audio Left away from Audio Right.

As a convention, it is suggested that all Triton chassis connected on the same MIDI bus use the same first digit.
Thus if there were a second “group” of Triton switchers connected on another MIDI bus (and per Jupiter require-
ments connected to a second CM), they might have “2” as the first digit in the PLvL entry. For example:

Triton chassis Connected to DIP switch setting PLvL entry

News Video CM2 0010 (decimal 02) 102
News Left and right audio CM2 0000 (decimal 00) 100
News Time code CM2 1111 (decimal 15) 115

Aux Video CM5 0010 (decimal 02) 202
Aux Left and right audio CM5 0011 (decimal 03) 203

In RGB or YUV applications where all three signals must always switch together, the Router Address switches
should be set to the same value on each chassis. However, the Switcher Description table has only one row cover-
ing all three chassis. For example:

Triton chassis DIP switch setting PLvL entry

Red 0000 (decimal 00) 100
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In this example, the Green and Blue chassis would also have their Router Address switches set to “0000.”

f. Conventional TVS/TAS square matrix switchers. For these switchers the hardware switches are usually set as
follows:

Name of level Physical level no.

Video 1
Left audio 2
Right audio 8
Time code 4

TVS/TAS data matrix forward/reverse level numbers: two levels must be described on the table—a forward level
and a reverse level; for TVS/TAS data matrix switchers the levels have different physical level numbers.

g. RKX switchers††. The physical level number can range from 0 to 99. Not supported by Jupiter XPress.

h. Multiple switchers. 

An example of a multiple switcher installation is shown on page 2−31.

As discussed in Step 3 above, more than one switcher can be operated by a single CM board; however, this will
require a unique hardware setting on each level to avoid conflicts. For example, you could enter a switcher “MAIN-
ROUT” with levels 1, 2, and 6; and switcher “NEWSROUT” with levels 3, 4, and 5.

Alternatively, by dedicating a separate CM board to each switcher, the same physical level numbers can be used
on different switchers if desired. (See diagram on page 2−32.)

i. Logical level mapping (two logical levels on one physical level).

An example of logical level mapping is shown on page 2−29.

In these systems, the same physical level number can be used on more than one logical level (i.e., on more than
one row of the Switcher Levels table). For example, you could enter a switcher “MainRout” with Left Audio on
level 2, and with Right Audio also on level 2. This technique can sometimes help reduce overall switcher size, but
it requires special entries to this table and to the Switcher Outputs table as follows:

— the Switcher Levels table must always show the total number of outputs for the entire physical level. For the
example system shown on page 2−29, the matrix entry would be “60 x 60” for the Left logical level, even
though the level is being used as a 60 x 30. The same applies to the Right logical level; the table entry would be
“60 x 60.”

— the Switcher Outputs table (page 5−55) must indicate the differing physical output numbers used on each
level. For example, output “VT01” might use physical output “20” for video and left audio and physical out-
put “21” for right audio.

††When an RKX and a Grass Valley Crosspoint Bus switcher are entered on this table, an offset of 100 can be used to avoid
having the same level numbers for both switchers. See also footnote marked with “†” on next page.
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j. Datatek D−2000/2166†. The physical level number can range from 0 to 6. 

k. ESbus switchers§. The physical level number can range from 0 to 254 (but is limited to 96 by the CM 4000).

l. Nexus†. The physical level number is 0. 

m. Utah Scientific† switchers. The physical level number can range from 0 to 3. 

Notice that protocol can be assigned on a level−by−level basis.

On the CM crosspoint bus, this would allow a combination of TVS protocol on some levels and Binary protocol on oth-
ers. This would be the case in a system which combines a Venus with a TVS/TAS−2000, for example.

10. Follow Level      Enter name of switcher and logical level that this level is to follow permanently. For video/audio
switchers these boxes are usually left blank, thus allowing for split (breakaway) switching.

For switchers where split switching is not desirable (such as RGB switchers), this entry can be used to force one level
to follow another; for example, “Red” could be entered in the Follow Name box on the menus for the Green and Blue
levels. (This entry is not needed for Triton RGB/YUV applications.)

Note: Jupiter does not support follow level switching when switch requests are issued from the JNS Physical
Control application.

† When a switcher of this type and a Grass Valley Crosspoint Bus switcher are entered on this table, an offset of 100 can be
used to avoid having the same level numbers for both switchers. Thus a hardware level setting of “0” on the Alpha Image
switcher could be entered on this table as “100”; or, a hardware Level setting of “1” on the Datatek switcher could be en-
tered on this table as “101.” This eliminates the need to re−set existing level settings on the hardware.

§ When a switcher of this type and a Grass Valley Crosspoint Bus switcher are entered on this table, an offset of 400 can be
used to avoid having the same level numbers for both switchers. See also preceding footnote. 
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11. Driver      Select distribution switcher protocol (“Driver”).

    Figure 5−29. Switcher protocol selections.

Switcher Driver

Apex Binary

Concerto (controlled via Crosspoint Bus) Binary

Concerto Data (controlled via Crosspoint Bus) DM400B

Grass Valley Series 7000 (controlled via SMS 7000) GVG Native Protocol

Grass Valley Encore−controlled router GVG Native Protocol

Mars Binary

RKX† RKX

SDR 400 Binary

Trinix Binary

Triton Triton

TVS/TAS 1000 TVS Prot

TVS/TAS 2000/2001 TVS Prot

TVS/TAS 3000 TVS Prot

Binary Confirm All (test) Bin Confirm all

TVS/TAS Confirm All (test) TVS Confirm all

Venus Binary

Venus Data DM 400/400A Binary

Venus Data DM 400B DM400B

Datatek D−2166/2000 Datatek

ESbus switcher ES Bus

Nexus NXS

Sony Sony

Utah Scientific Party Line (UDI−1B) Utah_96

†Not supported by Jupiter XPress application.

12. 3 LI 3 LO      These entries apply only to three−stage switchers (not supported by CM 4000). For conventional square
matrix switchers, leave blank.

13. Option      This item applies only to data switchers (see page 5−45). For video, audio, and time code switchers, leave
blank.

14. Audio      In the “Audio” column, for Venus and Apex switchers, select “Left” for the left audio level, “Right” for
the right, and “Normal” for others. This will allow special CP 3000, CP 3800, and JEP 100 audio switching modes such
as mixing stereo signals into a mono output, duplicating a mono signal on both channels of a stereo output, and reversing
channels.
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For Triton  switchers, select an “A” for each audio chassis. Triton data switchers with rear−panel DIP switch 7 DOWN
(“controlled as audio”) also require an “A” entry. For Triton video switchers, or for Triton data routers with switch 7
UP (“controlled as video”), leave the column blank.

15. DM 400 Off Time      This item applies only to data switchers (see page 5−47). For video, audio, and time code
switchers, leave blank.

16. After saving your changes, validate, compile, and activate the configuration set. (See page 5−13 if you need more in-
formation.)
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Option   POINT−TO−POINT DATA SWITCHING OPTIONS

(“Normal/Advise/Enforce”)

Normally, a distribution switcher allows an input to be sent to more than one output. For example, the video in Figure 5−30
could be switched to two destinations at the same time.

Figure 5−30.

Video

In a data switcher, it may be desirable to restrict operation to “point−to−point” switching. For example, this would insure that
the transmit data from an editor could be switched to only one VCR at a time, as shown in Figure 5−31.

Figure 5−31.

Editor

VCR 1

VCR 2

Data

Controller level
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When “Enforce”  is turned on, and an attempt is made to switch control to a new device, then the device presently being con-
trolled will be switched automatically to a “safe” (non−existent) input (Figure 5−32).

Figure 5−32.

Editor

VCR 1

VCR 2

“Safe input”

Controller level

The control device would then be switched to the new destination (Figure 5−33).

Figure 5−33.

Editor

VCR 1

VCR 2

“Safe input”

Controller level

— For Venus DM 400/400A data routers, the Safe Input is defined as the first input listed on the Switcher Input
table (page 5−52), which is the same as “logical input 1.” The physical input number of the Safe Input
should always be “192;” this insures that the router will tri−state (i.e., the destination will be connected to a
high−impedance source).

— For DM 400B data routers, the Safe Input is defined as whatever input is named “SAFE” on the Switcher
Input table (page 5−52); the physical input number should always be one (1) beyond the last input number
(e.g., if the inputs are numbered 000−063, then the Safe Input would be 064). In these systems selecting the
Safe Input will cause the destination to be switched “off.”

When “Advise”  is turned on and an attempt is made to switch control to a new device, the switch will not occur. The system
will display the following message on the control panel:

Input currently in use by <output number>

The operator can then switch the “safe input” to the device presently being controlled. This will avoid having the control de-
vice connected to two machines at the same time.

When “Normal”  is turned on and an attempt is made to switch control to a new device, the switch will occur immediately.
There will be no notification of conflict or extra switch to a safe input.
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DM 400 Off Time   DATA SWITCHING − OFF TIME BETWEEN SWITCHES 

Number of frames switcher will dwell on Safe input when switching between controlled devices

When a switch occurs from one VTR control cable to another where the VTRs are of different types, the switch can occur
so rapidly that the editing system may not know that a new type of VTR has been connected. This can result in editing
inaccuracies since the editing system may be using ballistics for the wrong type of VTR. See Figure 5−34.

Figure 5−34.

Editor

VTR 1

VTR 2

Data Switcher

“Safe input”

To avoid this problem, the data switcher can be set to switch to a Safe input, wait for a specified minimum number of frames,
and then switch to the new device. This will cause the editing system to send a request to the new VTR to identify itself and
get the correct ballistics.

The wait period is set in the “DM 400 Off Time” column of the Switcher Description table. A setting of approximately 3/4
second is recommended (20 frames). The maximum value is 99 frames.

The delay will only occur when a data switcher is switching real devices, and only when Enforce (see page 5−46) is turned
on.

The DM 400A data switcher requires a two−row entry on the Switcher Description table; in this case the DM 400 Off Time
entry is made on the Reverse switcher row (the row with the letter “R” in the RV column).

For an overview of data switching, see page 2−30.
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Switcher Input

The switcher input table must be used to assign a logical name to each physical input.

If there is more than one switcher in the system, a table must be defined for each. Figure 5−35 shows a table for switcher
“MAINROUT.”

1

Name

BARS

RIGHTVIDEO

2 TONE

3 TC

4 VT01

5 VT02

6

7

8

BLK

VT03

VT04

LEFT TC

000

001

002

003

004

VT05 005

000P

001

002

003

004

005

000P

001

002

003

004

005

000P

001

002

003

004

005

064P

Switcher Input − MAINROUT

064I

000I 000I 000I

000I

000I060I 060I

Figure 5−35. Switcher input table (example).

Logical Input

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

“BARS,” “TONE,” and “VT01” are logical names for various inputs. Each name, which can be up to eight characters long,
corresponds to a switcher physical input number for each level of the switcher. This number is normally attached at the
factory to each connector on the back of the switcher; however, it should be understood that the real source of this number
is the hardware device address, which is usually set with an internal DIP switch or jumper. (For more information, refer to
the manual supplied with the particular switcher.)
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Note: an input name is not entered directly at switcher control panels; rather, it is linked to a category and entry
number through the CP Input Sets table. The category and entry number are then entered at the control panel to
make the switch. The status mnemonic that appears on control panels is also determined by the CP Input Sets table.
For more information, see page 5−62.

Important:  Mars physical input numbers, when controlled by a Jupiter system, are not continuous. For example,
physical input numbers 8 through 15 are skipped. For more information, refer to the Mars manual in the Cross-
point/Jupiter control section.

Note: Some switchers (such as Apex, late−model Trinix, Concerto and Triton ) use “1” as the first connector num-
ber. In this case, the physical input number for this connector, as entered on the table, is “0.” Connector “2” is physi-
cal input number “1,” etc.

In Figure 5−35, there are four levels: video, left audio, right audio, and time code. The table shows that the input named
“VT01” is wired to connector 001 on all four levels. Similarly, the input name BARS is associated with connector 000 on
all four levels.

If there is no entry for a particular level, no switch will occur on that level. On this table, when input “TC” is requested from
a control panel, only the time code level will switch.

An automatic split (breakaway) can also be arranged. In this example, a request for the input named “TONE” will obtain input
064 on the video level but input 000 on the other levels. Split switching is described in more detail below.

In Venus DM 400B data switching applications, the switcher input table is used to assign a logical name to each physical
port connected to a “tributary” device. For more information, see page 5−52.
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SPLIT SWITCHING

Split (or breakaway) switching is the selection of one input on one level and another input on another level. An example would
be the selection of color bars on the video level and test tone on the audio levels. Split switches can be manual, where the
operator addresses individual levels and makes each switch separately; or, automatic, where a single category / entry number
will cause the split to occur.

An automatic split can be arranged in either of two ways:

— The switcher can be wired so that the split sources arrive on parallel inputs, as shown in Figure 5−36. On the
video level, color bars are wired in as input 0. However, on the audio levels, test tone is wired in as input 0 and a
time code generator is wired in as input 0 on the time code level. The Switcher Inputs table (Figure 5−35) is
then arranged so that the input named “BARS” will switch to input 0 on all levels. This technique might be
referred to as a “hard−wired split.”

       Figure 5−36. Inputs to four−level switcher, showing a “hard−wired split.”

0

Video

BARS

1 2 3 4

Left audio

TONE TONE

Right audio Time code

0 1 2 3 4 0 1 2 3 4 0 1 2 3 4

TIME CODE
GEN

— A more flexible approach is to modify the Switcher Input table so that a single input name will address differ-
ent physical inputs from one level to another. For example, the switcher could be wired as shown in Figure
5−37, where black burst is input 64 on the video level, test tone is input 0 on the audio levels, and a time code
generator is input 0 on the time code level. The Switcher Input table is arranged so that the input named
“TONE” will switch to those inputs.

       Figure 5−37. Software−controlled split.

62

Video

BLACK

63 65 66 0

Left audio

TONE

1 2 3 464 0

Right audio

TONE

1 2 3 4 0

Time code

1 2 3 4

TIME CODE
GEN

Statusing for split switches is determined by the “I” and “P” suffixes on the Switcher Inputs table, as described in Primary
and Indirect Status Instructions on page 5−64.
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ENTERING OR EDITING INPUT NAMES AND NUMBERS

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5−10.

2. Click on “Jupiter” and “Switcher Input.” This will open a list of all existing Switcher Input tables (or open the table if
there is only one).

3. Click on the desired switcher input table name and “OK.” This will bring up a table similar to that shown on page 5−48.

If the table is based on the factory−supplied “Numeric” set, the table illustrates the reason for the name “numeric”—the
“Name” column shows all the inputs with numbers instead of names.

4. Enter/edit the desired logical name and physical input numbers for the inputs.

Guidelines for using the editor are found on page 5−3.

Important:   Row numbers on Jupiter tables are used as the “logical” numbers for sources. Changing the row num-
ber of an existing source (by inserting/deleting a new input in the middle of the table, for example) will disrupt
control of the system, requiring controller boards to be memory−cleared and reset (see “Clearing Battery−Pro-
tected Memory” in Appendix B). One way to avoid this interruption is to add new inputs at the end of tables.

5. After saving your changes, validate, compile, and activate the configuration set. (See page 5−13.)
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DATA SWITCHING APPLICATIONS

In Venus DM 400B data switching applications, the switcher input table is used to assign a logical name to each physical port
connected to a “tributary” device. See Figures 5−38 and 5−39.

Note: Configuration of DM 400/400A Data Matrix boards is described in Appendix L.

Port 00

DM 400B Data
Matrix

Controller

Editor selected
as switcher

OUTPUT
Port 01

Tributary

Tributary

Port 02

VTR 1 selected
as switcher 
INPUT

VTR 2 selected
as switcher 
INPUT

Figure 5−38. Example of DM 400B system.

For a discussion
of the “Safe” input,

see page 5−46.

See Note 1.

1

VT01

2

VT02

3

SAFE

001

002 002

Switcher Input − MAINROUT

002

001 001 001 001

064

002 002

EDIT1 000 000 000 000 000

4

Figure 5−39. Switcher Input table
for system shown in Figure 5−38.

Name RIGHTVIDEO LEFT TC DATALogical Input

Similarly, the switcher output table is used to assign a logical name to each physical port connected to a “controller” device.
See Figure 5−40.

Note 1: All port numbers that reside in the Switcher Output table must also have an entry in the Switcher Input
table (This is done to avoid possible Status display problems and is checked by the PC compiler).

Figure 5−40. Switcher Output table for system shown in Figure 5−38.

1

Switcher Output − MAINROUT

EDIT1 −

2 −

Name Security S−T
Pass
word RIGHTLEFT TC

000 000 000

DATA

000

VIDEO

000

Logical Output
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Controller / Tributary Reassignment

Some VTRs can themselves act as controllers or tributaries. With the DM 400B the associated ports can be configured as both
inputs and outputs; this allows their pinouts to adjust automatically depending on which VTR is selected as the output (con-
troller) and which is selected as the input (tributary). In Figure 5−41, VTR 1 is the controlling device; accordingly it is selected
as a switcher output in order to configure the switcher port correctly. The tributary VTR 2 is selected as a switcher input.

Port 01

Controller
pinout

Tributary
pinout

Tributary
pinout

Controller
pinout

Port 02

DM 400B Data
Matrix

VTR 2 selected
as switcher 
INPUT

VTR 1 selected
as switcher 
OUTPUT

Figure 5−41.

In Figure 5−42, the roles are reversed. VTR 2 is the master and VTR 1 is the slave. The switcher ports are configured properly
by selecting VTR 2 as an output and VTR 1 as an input.

Port 01

Tributary
pinout

Controller
pinout

Port 02

DM 400B Data
Matrix

Controller
pinout

Tributary
pinout

VTR 2 selected
as switcher 
OUTPUT

VTR 1 selected
as switcher 
INPUT

Figure 5−42.

Examples of  Switcher Input and Switcher Output tables for this reassignment application are shown in Figure 5−43.
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Figure 5−43. Switcher Input and Output
tables for application shown on page 5−53.

1

Name

VT01

RIGHTVIDEO

2

VT023

SAFE

LEFT TC

001

002 002

Switcher Input − MAINROUT

001 001 001 001

DATA

064

002 002

1

Switcher Output − MAINROUT

Name

VT01

Security S−T

−

VIDEO

001

LEFT

001

RIGHT

001

TC

001

2 VT02 − 002 002 002 002

Pass
DATA

001

002

Word

002

Logical Input

Logical Output

CP Input and Output Sets and Control Panel Operation

The input and output names in the previous tables must be assigned to Category/Entry selections using a CP Input Set (page
5−62) and CP Output Set (page 5−78). For example, if a CP−3000−type panel is to be used, the “C” (for “controller”) category
button could be used to select the controller (output) and the VCR category button could be used to select the VCRs .



ConfiguratorSwitcher Output Table

5−55CM 4000 Installation and Operating Manual

Switcher Output

The Switcher Output table performs much the same function as the switcher input table (described on page 5−48) except that
it applies to outputs.

1

Switcher Output − MAINROUT

Name

MAT MON

Security S−T

−

VIDEO

000

2 MC QC − 001

3 PATCH 1 − 002

4 PATCH 2 − 003

Pass

5 SHOP − 004

6 VC 2P 1 − 005

7 VC 2P 2 − 006

8 VC 2P 3 − 007

word LEFT

000

001

002

003

004

005

006

007

RIGHT

000

001

002

003

004

005

006

007

TC

000

001

002

003

004

005

006

007

9 VC 2P 4 − 008

6 VC  2S − 009

7 VT 01 − 010

8 VT 02 − 011

008

009

010

011

008

009

010

011

008

009

010

011

Figure 5−44. Switcher output table (example).

Logical Output

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

Logical Output
Name

     The table is used to give each physical output a logical name up to eight characters in length. If
more than one switcher is in the system, a table must be defined for each. Figure 5−44 shows a table for
switcher “MAINROUT.”

Unlike the Switcher Inputs table, the outputs table has several provisions for security:

Security      A Security Board can be identified for an output by entering the name of a controller board (such as
“CM1”); only controls connected to that board could be used to switch the output. The name must be one of
those already entered on the Network Description table (page 5−27).
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S−T      A Security Board Type can be entered. Only controls connected to a control board of that type could then
be used to switch the output. A dash (“−”) entry means “none.” The board types that can be selected are “VM”
and “SI.”

Note: In systems with CM 4000/Jupiter XPress, this field should be left blank (since Jupiter XPress
cannot be used in a system that includes VM/SI controllers).

Pass
word      A password level can be entered for the output. This is described in detail below.

In Venus DM 400B data switching applications, the switcher output table is used to assign a logical name to each physical
port connected to a “controller” device. For more information, see page 5−52.

ENTERING OR EDITING OUTPUT NAMES AND NUMBERS

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5−10.

2. Click on “Jupiter” and “Switcher Input.” This will open a list of all existing Switcher Output tables (or open the table
if there is only one).

3. Click on the desired switcher input table name and “Edit.” Selecting the switcher name will bring up a table similar to
that shown on page 5−55.

4. Enter/edit the desired logical name and physical output numbers for this output. Guidelines for using the editor are found
on page 5−3. For information about password levels, please see page 5−57.

Important:  Mars physical output numbers, when controlled by a Jupiter system, are not continuous. For
example, physical output numbers 8 through 15 are skipped. For more information, refer to the Cross-
point/Jupiter control section in the Mars manual.

Important:  When adding new items to tables, add them at the end if possible. Changing row numbers on
the Switcher Output table will cause panels to control different outputs than those to which they had been
assigned.

Important:   Row numbers on Jupiter tables are used as the “logical” numbers for destinations. Changing
the row number of a destination (by inserting/deleting a new output in the middle of the table, for example)
will disrupt control of the system, requiring controller boards to be memory−cleared and reset (see “Clear-
ing Battery−Protected Memory” in Appendix B). One way to avoid this interruption is to add new outputs
at the end of tables.

Note 1: Some switchers (such as Apex, late−model Trinix, Concerto, and Triton ) use “1” as the first connec-
tor number. In this case, the physical output number for this connector, as entered on the table, is “0.” Connec-
tor “2” is physical output number “1,” etc.
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5. To close the table, click OK.

6. Click on “File > Save” to save the table.

7. Select the next table for editing. When finished, validate, compile and activate the configuration set. (See page 5−13.)

SETTING PASSWORD LEVELS FOR SWITCHER OUTPUTS

In addition to individual Jupiter passwords assigned to each user, individual switcher outputs can be given a password level.
This can be used to  provide varying levels of protection from one switcher output to another.

Note 2: Output passwords are not honored by automation protocol handling.

 To change the password level for a switcher output:

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5−10.

2. Click on “Jupiter > Switcher output.” This will open a list of all existing Switcher Output tables (or open the table if
only one table exists).

3. Click on the desired Switcher Output table name and “OK.” This will open a table similar to that shown on page 5−55.

In this example, the password level column is blank, meaning that all outputs have a password level of zero. Therefore
all passwords presently assigned will allow changing the signal being sent to any output.

4. Double−click on the password box you want to change.

5. Enter the desired password level for this output.

Entering a level of “50” would mean that only passwords having levels of 50 or more could be used to enable selection
of an input for this output.

Guidelines for using the editor are found on page 5−3.

6. To close the table, click OK.

7. Click on “File > Save” to save the table.

8. After saving your changes, validate, compile, and activate the configuration set.
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CP Level Set

1

CP Level Set — KXYZ−LVL

Mnemonic Level Break Switch

2

3

VID VIDEO (MAINROUT)

LEFT LEFT (MAINROUT)

RGHT RIGHT (MAINROUT)

4 TC TC (MAINROUT)

Figure 5−45.

Figure 5−46.

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

The CP Level Set table is used to assign levels to control panels. In most cases, control panels are allowed to control all levels,
but creating multiple CP Level Sets allows restricting control to certain levels. Level Sets are assigned to individual control
panels on the MPK Devices table (page 5−107).

Selecting “Control Panel Sets” on the configuration set table list (Figure 5−22 on page 5−25) will open a dialog similar to
that shown in Figure 5−45. This dialog can be used to create, open, copy, and delete Control Panel sets. A example of a com-
pleted CP Level Set table is shown in Figure 5−46.

When creating a name for a Jupiter set, it’s a good practice to use letters and numbers only. If you want to use punctuation
or special characters, check the list on page 5−7 before creating a name.

When creating a new set, you will asked for the set type: “CP 3000” (for four−character display panels), or “CP−3800” series
(for most eight−character display panels).
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Note 1: For CP 328 panels, under monitor displays, DD production switchers, or external computer control, use
set type “CP 3000.” This is true even when the device can display more than four characters.

Mnemonic      The Mnemonic column of this table is the source for the ID of each level that will appear on control panels
during input selection.

Level     The Level column determines the order in which the switcher levels will appear in the control panel
status display. Video is normally listed first. In the example shown in Figure 5−45, the order from left to right will be video,
left audio, right audio, and time code. The first level entered will also be the level statused where display space is limited;
e.g., video will be the level statused on the CP 3000 expansion panel. 

Note 2: For DD switcher applications, the video level feeding the DD must be entered in the first row; other entries
are not used.

The source for the switcher Level names is the Switcher Description table (page 5−35).

Break     Using the Break column, breakaway switching can be disabled on a level by level basis. Since the CP Level Set
can be assigned to individual control panels on the MPK Devices table (page 5−107), this can be used to restrict breakaway
switching to specific panels.

Switch      Using the Switch column, all switching can be disabled on a level by level basis; and, by  CP Level Set  assignment,
on an individual control panel basis. Status will continue to be shown for the level.
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A Note Concerning Level Numbering and External Control Computers Using ASCII Protocol

ASCII protocol switching instructions include specification of output, input, and level; with level indicated by a number from
1 to 7. These level numbers correspond to the order in which levels are listed on the CP Level Set table. In the example table
shown in Figure 5−46, the ASCII level numbers would apply to the switcher levels as follows:

Level number used Example level shown on 
with ASCII protocol  CP Level Set table (Fig.5−45 )

1 VIDEO
2 LEFT
3 RIGHT
4 T/C

Do not confuse these ASCII level numbers with the logical and physical level numbers of the switcher, which may be differ-
ent. (The level names on this table are translated to logical and physical level numbers on the Switcher Description table, as
shown on page 5−35.)

For more information about ASCII protocol, see page 2−88.
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CP Input Set

Figure 5−47. CP Input Set (example showing new Auto Mnemonic column).

1

Input Set — KXYZ−INP

Category Entry Mnemonic Logical

2

3

Test 1 BARS BARS

VTR 1 VT01 VT014

5

Test 2 TONE TONE

Test 3 CODE TC

VTR 2 VT02 VT02

VTR 3 VT03 VT03

VTR 4 VT04 VT04

VTR 5 VT05 VT05

MISC 8 ESS ESS

6

7

8

n

Auto
Mnem Input

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

The CP Input Sets are used to link particular category / entry numbers, and mnemonics, to switcher input names. CP Input
Sets are also used to assign an input to each source button on CP 3832 and CP 3864 Control Panels.

• Categories are classes of inputs/outputs. The factory default category sets (as shown on pages 5−68 and 5−69) can
be used; or, custom category sets can be created.† Example: “TEST” as the category for all test signals. The cate-
gory is always followed by:

• An entry number. This defines the unit within the category. To continue the above example, after pressing “TEST,”
the operator presses the “1” key to switch to the color bar input. Note that the entry number is not the same as the
switcher input/output number.

• A mnemonic is an abbreviation, usually with a maximum length of eight characters, for a particular switcher input
or output.  This is the abbreviation that appears in the status windows of the control panels. Example: “VT01” as a
display mnemonic for switcher input 001.

† If you want to create a custom category set, skip to CP Category Set (page 5−101) and then return to this subsection.
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In the example shown in Figure 5−48, selecting VTR/1 on a control panel will call for the input named “VT01.” The system
will look on the Switcher Inputs table for this input name and switch to the indicated inputs; in this case, input 001 for all four
levels. The mnemonic “VT01” will be used in the control panel status windows to report the switch.

Figure 5−48. Selection of Category/Entry “VTR/1” will
switch to input 001 on all four levels.

1

Input Set — KXYZ−INP

Category Entry Mnemonic Input

2

3

Test 1 BARS BARS

VTR 1 VT01 VT014

5

Test 2 TONE TONE

Test 3 TC TC

VTR 2 VT02 VT02

VTR 3 VT03 VT03

VTR 4 VT04 VT04

VTR 5 VT05 VT05

MISC 8 ESS ESS

6

7

8

n

1

Name

BARS

RIGHTVIDEO

2 TONE

3 TC

4 VT01

5 VT02

6

7

8

VT03

VT04

LEFT

000

001

002

003

004

VT05 005

000P

001

002

003

004

005

000P

001

002

003

004

005

000

000P

001

002

003

004

005

Switcher Input − MainRout

064I I

000I 000I 000I

TCLogical Input

Logical

The Input Sets are assigned to specific control panels on the MPK devices table (page 5−107).

Although each control panel can be assigned a different CP Input Set if desired, the same set is usually assigned to all panels.
Different Output Sets, on the other hand, are often used to control access to outputs on a panel−by−panel basis as described
on page 5−78.

In Venus DM 400B data switching applications, a CP Input Set is used to assign a category/number and mnemonic to each
“tributary” (such as a VTR). For more information, see page 5−52.
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PRIMARY (P) AND INDIRECT (I) STATUS INSTRUCTIONS (“SPLIT MNEMONICS”)

While the Switcher Inputs table has provision for only one mnemonic per input name (page 5−47), split switching requires
a different mnemonic for each device selected.

For example, the top portion of Figure 5−49 shows a four−level switcher with a black burst generator connected to input 64
of the video level, a test tone generator connected to input 0 of the audio levels, and a time code generator connected to input
0 of the time code level.

All of these devices are assigned to the single input name “TONE” on the Switcher Inputs table (as shown at [1] ).

The input named TONE is in turn assigned to the command “TEST 2”  (this link is shown by the dotted line [2] ). Without
further instructions, the mnemonic for all levels would be “TONE” [3]. However, you might prefer to have “BLK” as a mne-
monic for video and “TC” as a mnemonic for the time code level.

To get the mnemonic “TC” on the time code level, an “I” (Indirect) suffix is entered back on the Switcher Inputs table at [4].
This tells the system to search that level for the “P” (Primary) suffix for that input. This is found at [5]. This Primary entry
is associated with the input named “TC”[6], which in turn is linked to the mnemonic “TC” [7].

A similar technique is used to get the mnemonic “BLK” on the video level.

Note: There can be only one Primary entry per input number within one level of the Switcher Inputs table. How-
ever, within that level, any number of Indirect entries can point to the Primary entry.
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66

Switcher Input
Name VIDEO LEFT RIGHT TC

1 BARS 000 000I 000I 000I
2 TONE 064I 000P 000P 000I
3 TC 000P
4 VT01 001 001 001 001
5 VT02 002 002 002 002
6 VT03 003 003 003 003
7 VT04 004 004 004 004
8 VT05 005 005 005 005

BLK 064P 060I 060I

Switcher Input − MainRout

1 Test 1 BARS BARS
2 Test 2 TONE TONE
3 Test 3 TC TC
4 VTR 1 VT01 VT01
5 VTR 2 VT02 VT02
6 VTR 3 VT03 VT03
7 VTR 4 VT04 VT04
8 VTR 5 VT05 VT05

TEST 4 BLK BLK

Input Set — KXYZ−INP

Auto Logical
Category Entry Mnem Mnemonic   Input

62

Video

BLACK

63 65 0

Left
audio

TONE

1 2 3 464 0

Right
audio

TONE

1 2 3 4 0

Time
code

1 2 3 4

TIME CODE
GEN

Figure 5−49. Primary and indirect status instructions (see notes on page 5−64).

[1]

[2]

[3]

[4]

[5]

[6]

[7]
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ENTERING OR EDITING A CP INPUT SET

(Includes procedure for assigning category/numbers or mnemonics)

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

For more information, please see Modifying and Downloading a System Configuration Set on page 5−8.

2. Click on “Jupiter,” “Control Panel Sets,” and “CP Input Set.” This will open a list of all existing CP Input Sets.

 Figure 5−50.  Select CP Input Set menu.

3. If you want to create a new set, click on “New,” and go to Step 4. Or, if you want to edit an existing set, click on the
name of the Input Set; then click “Open Table” and skip to Step 7.

You can also double−click on the name of an existing set to open the table.

If you want to copy an existing CP Input Set for use with a different panel type, you can probably save a lot of time by
following the procedure described on page 5−77.

4. If you are creating a new set, you will be asked to name the set.

Guidelines for using the editor are found on page 5−3.

Important:  Do not use the same name for different CP sets. Also, do not name a CP set with a name used
by the system for a Device Type. Device Type names are entered on the MPK Devices table (page 5−107).
Device Type names are shown on page 5−108.

5. If you want to assign this CP Input Set to a custom CP Category set (for a panel with re−legendable keycaps), enter the
custom CP Category set name. (If you wish to create a custom category set, skip to page 5−101 and then return to this
subsection.)
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If you want to use a factory default category set (as shown on pages 5−68 and 5−69) leave the Category Set as “Default.”

If you wish to associate an existing Input Set with a different category set than the one originally assigned, see page 5−105.

6.  Click on one of the CP types:

CP320
CP328
CP2002B
CP3000
CP3008†

CP3310
CP3800
CP3808
CP3824
CP3830
CP3832
EMEM
MC3020L†

SATRN†

SERIAL
UMD3A

Figure 5−51. 

• If CP 2002, CP 3000, or CP 3800 is selected, clicking on “Apply” and “Open Table” will open a blank ver-
sion of the table shown in Figure 5−52. These are 20−category panels. Go to Step 9.

• If CP 320, CP 328, or CP 3808 is selected, clicking “Apply” and “Open Table” will open a blank version of
the table shown in Figure 5−52. These are 16−category panels. Go to Step 10.

• If  CP 3824 is selected, clicking on “Apply” and “Open Table” will open a blank version of the table shown in
Figure 5−52. This is a 15−category panel. Go to Step 10.

• For CP 3830 panels, select type “CP 3830.” Clicking on “Apply” and “Open Table” will open a blank version
of the table shown in Figure 5−52. This is a 12−category panel. Go to Step 10.

• For RP 1/2/3, RP 1/2/3 C, and  SlimLine UMD status displays, select type UMD3A.

• For Diamond DD applications, both “E−MEM” and “serial” tables will probably be required. Clicking on
“Apply” and “Open Table” will open a blank version of the table shown in Figure 5−52. For the E−MEM
table, skip to Step 11. For the serial table, skip to Step 12.

• For Thomson Broadcast Automation or other external computer applications, a type “serial” table will be
required. Click on “Apply” and “Open Table” to open a blank version of the CP table without a “Mnemonic”
column. Skip to Step 13.

† Not supported by Jupiter XPress application..
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• For CP 3832 or CP 3864 control panels (including type “L”), a type “cp3832” table will be required. Click on
“Apply” and “Open Table” to open a blank version of the CP table. Then skip to Step 14.

7. If you click on an existing Input Set, this will call up a table similar to that shown in Figure 5−52.

Figure 5−52. Input Set menu (example).

1

Input Set — KXYZ−INP

Category Entry Mnemonic Input

2

3

Test 1 BARS BARS

VTR 1 VT01 VT014

5

Test 2 TONE TONE

Test 3 CODE TC

VTR 2 VT02 VT02

VTR 3 VT03 VT03

VTR 4 VT04 VT04

VTR 5 VT05 VT05

MISC 8 ESS ESS

6

7

8

n

Auto
Mnem

Logical

8. If you are:

— Adding a new entry, click on the row number above where you want the new entry to appear. Click the “Edit”
pull−down menu. Click on “Insert” and make the addition. Then go to Step 9 through 13 below as appropriate.

Important:   Row numbers on Jupiter tables are used as the “logical” numbers for destinations. Changing
the row number of a destination (by inserting/deleting a new output in the middle of the table, for example)
will disrupt control of the system, requiring controller boards to be memory−cleared and reset (see “Clear-
ing Battery−Protected Memory” in Appendix B). One way to avoid this interruption is to add new outputs
at the end of tables.

— Editing an existing entry, click on the item you want to change. Then go to Step 9 through 13 below as
appropriate.

9. CP 2002, CP 3000, CP 3800

a. Select the desired Category from the pull−down menu. Then press TAB.

The 20−category factory default set used for CP 2002, CP 3000, and CP 3800 panels is as follows:

VTR CG NET SAT A
VCR CAM REM EJ** B
FILM PTCH STU FS C
AUX TEST MISC SS D **EMER on CP 3800
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b. Specify the desired Entry  (unit) number. This can be done by clicking on the desired “Entry” field and typing in
the number. Press ENTER.

Guidelines for using the editor are found on page 5−3.

Note: For an input that is heavily used, an entry number of zero can be specified to help speed up control
panel operation. For example, by assigning color bars as “Test 0,” the mnemonic for color bars will ap-
pear immediately on the control panels whenever “Test” is selected; the operator can then complete the
switch by pressing Take. However, for this to work properly the zero entry must appear in this table
before all other entries for that category; for example, “Test 0” must appear before “Test 1,” “Test 2,”
etc.

c. Select the Input  name.

The source for the input names is the Switcher Input table (page 5−48).

d. Check the Auto Mnemonic box or enter the desired Mnemonic.

The Auto Mnemonic function can be used to enter a control panel mnemonic automatically based on the Name
given to the input. In cases where the input Name is more than four characters long, the mnemonic will be truncated
to the first four characters.

If an input Name is changed on the Switcher Input table and Auto Mnemonic is enabled, the mnemonic will change
to the new name automatically.

Note: if you use the Auto Mnemonic feature, it will not work if you go back to a version of the Jupiter
editor prior to 6.2.1.

CP 3000 panel mnemonics are limited to four characters.

When finished, skip to Step 15.

10. CP 320, CP 328, CP 3824, CP 3830

a. Enter the desired Category. This can be done by double−clicking on the appropriate field in the Category column;
this will open a pull−down menu of categories. Click on a category and press ENTER.

The 16−category factory default set used for the CP 3808 panel is as follows:

Default sets may vary —
confirm by creating a new set!

VTR CAM SAT EJ
VCR NET REM FILM
Studio MISC AUX FS
CGEN TEST PTCH STILL

The 16−category factory default set used for CP 320 and CP 328 panels is as follows:

VTR CG NET VCR
CAM AUX EJ SS
REM FILM PTCH STU
TEST SAT FS MISC
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The 15−category factory default set used for CP 3824 panel is as follows:

VTR CG NET VCR CAM
AUX SS REM FILM PTCH
STU TEST SAT FS MISC

The 12−category factory default set used for the CP 3830 panels:

VTR GFX Studio
ENG REM NET
EC POST Xmsn
AUX TEST NUM

Guidelines for using the editor are found on page 5−3.

b. Specify the desired Entry  (unit) number. This can be done by double−clicking on the desired “Entry” field and
typing in the number. Press ENTER.

Note: For an input that is heavily used, an entry number of zero can be used to help speed up control
panel operation. For more information, see the note in Step 9 (b) above.

c. Enter the desired Mnemonic.

A CP 320 panel can display four−character mnemonics; the CP 328, CP 3808, CP 3824, and CP 3830 can display
eight−characters.

d. Enter the Input  name.

The input name will be a name already entered on the Switcher Input table (page 5−48).

When finished, go to Step 15.
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11. DD (“Diamond”) − E−MEM

For DD applications, both E−MEM and Serial tables will probably be required. The dual entries are necessary because
of the two hardware connections, as previously described (page 2−60).

For the E−MEM table, you will need entries similar to that shown in Figure 5−53.

� Data in this field is not used, but an entry must
be made to satisfy the Jupiter compiler. Each
number in this column must be unique.

Figure 5−53. Input Set menu (example).

1

Input Set — DIA−INP

Category Entry Mnemonic Input

2

3
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6

7

8

n

�

�

�

�

�

�

�

�

�

Logical

a. For Category, the word “dflt” is used for all entries.

There are no category choices since the DD identifies inputs and outputs by number only.

b. Enter an Entry  number. This can be done by double−clicking on the desired “Entry” field and typing the number.
Press ENTER.

Note: Data in this field is not used, but an entry must be made to satisfy the Jupiter compiler. Each num-
ber in this column must be unique.

c. Enter the desired Mnemonic for the first router input that will be available to the DD.

This is the source of the mnemonics that will appear on the DD. The DD can display four−character mnemonics.

d. Select the Input  name of the first router input that will be available to the DD. The source of these names is the
Switcher Input table (page 5−48).

When a switch is made, Jupiter will search this table for the name of the new input. The corresponding mnemonic
will then be sent to the DD.

e. Enter the next Entry number, Mnemonic, and Input name, until you have entered all the inputs that you want avail-
able to the Diamond.

When finished, skip to Steps 15 and 16. Then return to Step 2 and following and build the DD serial table.
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12. DD (“Diamond”) − serial

For the Serial table, you will need entries similar to those shown in Figure 5−54.

Figure 5−54. Diamond Serial Input Set menu.

1

Input Set — ASC−INP

2 1

2

Entry

BARS

TONE

Input

3

3

TC

4

5 4

56

6

VT03

7

78 VT05

VT01

VT02

VT04

48 47 ESS

0

Logical

There are no category choices, since the DD identifies inputs and outputs by number only.

a. Specify the desired Entry  (unit) number. This can be done by double−clicking on the desired “Entry” field and
typing the number. Press ENTER.

Each Entry number corresponds to a button on the DD Aux Bus. The buttons are numbered 0−47.

b. Select the name of the router Input that you want assigned to the first button on the DD Aux bus. The source of
these names is the Switcher Input table (page 5−48).

c. Enter the next Entry number and Input name, up to the maximum of 48 rows.

When finished, skip to Step 15.

13. Thomson Broadcast Automation / External Computer

If you are entering a set for serial control device, a menu similar to that shown in Figure 5−55 will appear.

Figure 5−55. Serial Input Set menu.

1

Input Set — PC−INP

2

1
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Entry
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CAM2

Input

3 3 VTR1
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The purpose of the table is to establish a unique “Entry” number for each switcher “Input” name. In Figure 5−55, Entry
number “1” is associated with Input name “CAM1.” The Entry number is the number that the serial control device must
send to Jupiter. When the Entry number arrives, the software checks this table to find the associated Input name; then
the Switcher Inputs table (page 5−48) is checked to find the corresponding physical input number.
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Note:  For Thomson Broadcast Automation systems, it is suggested that you print out this Input Set; you
will need this information when setting up the Automation Switcher Initialization menu. The input names
entered on the Jupiter Input Set table must be in the same order as they are on the Automation table. Any
changes made to one table must also be made to the other.

When finished, skip to Step 15.
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14. CP 3832 / CP 3864

If you are entering a set for CP 3832 or CP 3864 (including type “L”), a menu similar to that shown in Figure 5−56
will appear. The purpose of the table is to assign a button position (row number) to each switcher “Input” name. In Figure
5−56, button position “1” will be used to select input “CAM1.” Note that destination buttons are defined on a CP Output
Set (page 5−78). Exact table entries will depend on the panel and the application, as shown in the following examples.

For Category, the word “default” is used for all entries.

Input button 1

CP 3832

Input button 32

Figure 5−56. Entries for CP 3832 configured as single−
bus panel.

1

CP Input Set − 3832−IN

default

2 default

1

2

Category Entry

CAM1

CAM2

Input

32 default 32 VTR12

CAM1

CAM2

Mnemonic

VTR12

†

†

†

Logical

Input button 1

CP 3832

Input button 16

IN
OUT

Figure 5−57. Entries for CP 3832 configured as “bal-
anced split” panel. Balanced number of input/output
buttons is determined by output assignments made on
the CP Output Set. For details, see page 5−90.

Category

1

CP Input Set − 3832−IN

default

2 default

1

2

Entry

CAM1

CAM2

Input

16 default 16 VTR12

CAM1

CAM2

Mnemonic

VTR12

†

†

†

Logical

Input button 1

CP 3832

Input button 30

IN

OUT

Figure 5−58. Entries for CP 3832 configured as 30 x 2
“unbalanced split” panel. Total number of input buttons
vs. total number of output buttons is determined by num-
ber of output assignments made on the CP Output Set.
For details, see page 5−90.

Category

1

CP Input Set − 3832−IN

default

2 default

1

2

Entry

CAM1

CAM2

Input

30 default 30 VTR12

CAM1

CAM2

Mnemonic

VTR12

†

†

†

Logical

† Data not used, but entry must be present to satisfy compiler. Each number in this column must be unique.
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Input button 1

Input button 64 Figure 5−59. Entries for CP 3864 operated as single−
bus panel.

1

CP Input Set − 3832−IN

default

2 default

1

2

Category Entry

CAM1

CAM2

Input

64 default 64 VTR12

CAM1

CAM2

Mnemonic

VTR12†

†

†

Logical

Input button 1

Input button 32

IN

OUT

Figure 5−60. Entries for CP 3864 configured as 32 x 32
“balanced split” panel. Balanced number of input/output
buttons is determined by output assignments made on the
CP Output Set. For details, see page 5−90.

Category

1

CP Input Set − 3832−IN

default

2 default

1

2

Entry

CAM1

CAM2

Input

32 default 32 VTR12

CAM1

CAM2

Mnemonic

VTR12

†

†

†

Logical

Input button 1

Input button 54

IN

OUT

Figure 5−61. Entries for CP 3864 configured as 54 x 10
“unbalanced split” panel. Total number of input buttons
vs. total number of output buttons is determined by num-
ber of output assignments made on the CP Output Set.
For details, see page 5−90.

Category

1

CP Input Set − 3832−IN

default

2 default

1

2

Entry

CAM1

CAM2

Input

54 default 54 VTR12

CAM1

CAM2

Mnemonic

VTR12

†

†

†

Logical
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Figure 5−62. Entries for CP 3832 (configured as balanced split panel) with 2nd CP 3832 used as source expansion panel.

16 default 16 VTR12VTR12

17 default 17 VTR13VTR13

48 default 48 VCR12VCR12†

†

†

CP 3832 (configured as
balanced split panel)

Input button 1

Input button
17

Input button 16§Input button 48§

CP 3832

IN

OUT

default

default1

CP Input Set − 3832−IN

2

1

2

Category Entry

CAM1

CAM2

Input

CAM1

CAM2

Mnemonic

†

†

Logical

15. To close the table, click OK.

16. Click on “File > Save” to save the table.

The change will apply to all control panels that use the same Input Set. For the system shown on page 5−107, it would
affect all panels in the system since all of them use “KXYZ−INP” as the Input Set.

17. Select the next table for editing. When finished, validate, compile, and activate the configuration set. (See page 5−13
if you need more information.)

§ When two or more CP 3832 panels are used, button assignments are also determined by order of MPK table entries. See
page 5−128.

† Data not used, but entry must be present  to satisfy compiler. Each number in this column must be unique.
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Copying a CP Input or Output Set for Use with a Different Panel Type

After you have created a CP Input or Output Set for one panel type, you may want to copy it for use with a different panel.
For example, you may have a set for CP 3000 panels, and want to use it with a CP 320. You will need to re−enter some of
the category/number selections (because of the difference in the number of possible categories), but you can save time by
copying the set in order to use the same mnemonics and input names.

1. On the main menu, click on “Jupiter” and  “Control Panel Sets.” Then select  “Input” (or “Output”).  A menu similar
to Figure 5−63 will appear.

Figure 5−63.

2. Click on the name of the set you want to copy. Click on “Copy.”

3. Enter a name for the copy.

4. Select the desired CP Type.

5. If you want to use a factory default category set (as shown on pages 5−68 and 5−69), leave the Category Set Name box
as “Default.” If you want to use a custom category set, click on the Category Set Name box and enter the name of the
new Category Set. For more information about custom category sets, see page 5−101.

6. Click on “Apply.”

7. Open the new CP Input Set table and make the necessary changes, if any. (In this example, you would need to enter
different category/number selections because only 16 categories are available on the CP 320).

Note: If you convert a CP Input Set for use with a serial control device (such as an external computer), make
sure there is a unique number for every row in the “Entry”column. See Step 11 on page 5−71.
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CP Output Set

1

Output Set — MC−OUT

Category

STU

Entry

1

Mnemnonic

QC

Output

QC

Level Set Button

2

3

VTR 1 VT01 VT01

VTR 2 VT02 VT02

1

Output Set — NEWS−OUT

EJ 1 NEW1 NEW1

2

3

EJ 2 NEW2 NEW2

EJ 3 NEW3 NEW3

4 VTR 3 VT03 VT03

5

6

VTR 4 VT04 VT04

VTR 5 VT05 VT05

Figure 5−64. CP Output Sets (example showing new Auto Mnemonic column).

Auto
Mnem

Category Entry Mnemnonic Level Set ButtonAuto
Mnem

Logical

Output
Logical

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

OVERVIEW

Category Entry Mnemnonic Output     Links category/entry numbers and mnemonics to switcher outputs.

The Output Sets are assigned to specific control panels on the MPK devices table (page 5−107).

Important:  Do not give an Output Set the same name as an output. Use of an extension such as “OUT” is recom-
mended to help avoid potential conflicts.

Since each control panel can be assigned a different CP Output Set if desired, these sets are usually used to control access
to outputs on a panel−by−panel basis:
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— You may want a control panel in the master control room to have access to all possible outputs. This panel
might be assigned to Output Set “MC−OUT,” which includes a category/number entry for all destinations.

— However, you may want a control panel in a particular department to have access to only a selected number of
outputs. This panel would be assigned to an Output Set (such as “NEWS−OUT”) which has only those outputs
listed.

Note: If you want the panel to be restricted to a single output, you could instead use the technique al-
ready described, whereby the name of the output, rather than the name of an Output Set, is entered on the
MPK Devices table. For more information, please see page 5−112.

In Venus DM 400B data switching applications, a CP Output Set is used to assign a category/number and mnemonic to each
“controller” (such as an editor). For more information, see page 5−52.

Level Set      For assigning a CP Level Set to individual outputs (multiple switcher installations)

The Level Set column is used when there are multiple switchers in the system and you want the control panels to control and
status more than one switcher. See page 5−94.

Button      For assigning expansion panel buttons to individual outputs

CP 3000/3010 − Outputs are normally assigned to the CP 3010 TAKE button dynamically by the operator (see page 6−24).
However, by entering an expansion button number from 1 to 160 (8 buttons x 20 pages) in the Button column and appropriate
row of the CP Output table (which is in turn assigned to the CP−3000 panel on the MPK devices table—page 5−107), the output
will be assigned permanently to the desired button. Such assignments cannot be changed using the panel itself.

Note:  If an output is permanently assigned to a CP 3010 button, but that output is later removed from the CP Output
table, and the new set downloaded, the CP 3010 will continue to display the name of the output until the output
is manually deleted. This is done by selecting an output that is not defined and pressing the appropriate TAKE key
on the expansion panel.

CP 3800 − When in Multiple Destination mode, CP 3800 outputs can be assigned to the soft keys dynamically by the operator
(see page 6−34). However, by entering a soft key button number from 1 to 80 (8 buttons x 10 pages) in the “Button” column
and appropriate row of the CP Output table (which is in turn assigned to this panel on the MPK devices table—page 5−107),
the output will be assigned permanently to the desired button. Such assignments cannot be changed using the panel itself.

CP 3809 − By entering a CP 3809 expansion panel button number from 1 to 40 (8 buttons x 5 panels max) in the Button column
and appropriate row of the CP Output table, the output will be assigned permanently to the desired button. Note that this CP
Output table must be assigned to the main panel (CP 3808 or CP 3830) on the MPK devices table—page 5−107. (Dynamic
assignment of outputs, using the front panel, is described on page 6−124. )

CP 3810 − By entering a CP 3810 expansion panel button number from 1 to 80 (8 buttons x 10 display “pages” max.) in the
Button column and appropriate row of the CP Output table, the output will be assigned permanently to the desired button.
Note that this CP Output table must be assigned to the main panel (such as a CP 3832 or CP 3864) on the MPK devices table.
See page 5−110.

CP 3832/3864 − although the CP 3832/3864 can be used to expand sources and destinations for another CP 3832/3864, these
panels do not use the “Button” column. Buttons are assigned to outputs by row number. See page 5−90.
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Copying a CP Output Set for Use with a Different Panel Type

After you have created a CP Output Set for one panel type, you may want to copy it for use with a different panel. For example,
you may have a set for CP 3000 panels, and want to use it with a CP 310. You will need to re−enter the category/number selec-
tions (because of the difference in the number of possible categories), but you can save time by copying the set in order to
use the same mnemonics and output names.

As another example, you may have a set for CP 320 panels (which can display four−character mnemonics) and want to use
it with a CP 328 (which can display eight−character mnemonics). You will need to re−enter the mnemonics, but you can save
time by copying the set in order to use the same category/numbers and output names.

The procedure is similar to that already described for a CP Input Set (see page 5−77).
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ENTERING OR EDITING A CP OUTPUT SET

(Includes procedure for assigning category/numbers or mnemonics)

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

For more information, please see Modifying and Downloading a System Configuration Set on page 5−8.

2. Click on “Jupiter > Control Panel Sets,” then “Output.” This will open a list of all existing CP Output Sets.

Figure 5−65.  Select CP Input Set menu.

3. If you want to create a new set, click on “New” and go to Step 4. Or, if you want to edit an existing set, click on the name
of the Output Set, then click “Open Table” and skip to Step 7.

You can also double−click on the name of an existing set to open the table.

If you want to copy an existing CP Output Set for use with a different panel type, you can probably save a lot of time
by following the procedure described on page 5−77.

4. If you are creating a new set, you will be asked to name the set.

Note: When creating a name for a Jupiter set, table, control panel, or other device, it’s a good practice to use
letters and numbers only. If you want to use punctuation or special characters, check the list on page 5−7
before creating a name.

Important:  Do not use the same name for different CP sets. Also, do not name a CP set with a name used
by the system for a Device Type. Device Type names are entered on the MPK Devices table (page 5−107).
Device Type names are shown on page 5−108.

5. If you want to assign this CP Output Set to a custom CP Category set (for a panel with re−legendable keycaps), enter
the custom CP Category set name. (If you wish to create a custom category set, skip to page 5−101 and then return to
this subsection.)
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If you want to use a factory default category set (as shown on pages 5−84 and 5−85), leave the Category Set as “Default.”

If you wish to associate an existing Output Set with a different category set than the one originally assigned, see page
5−105.

6. Click on one of the CP types:

CP310
CP320
CP328
CP2002B
CP3000
CP3008†

CP3310
CP3800
CP3808
CP3824
CP3830
CP3832
EMEM
MC3020D†

MC3020L†

SATRN†

SERIAL
UMD3A

Create Output Set

Figure 5−66. .

• If CP 2002, CP 3000, or CP 3800 is selected, clicking on “Apply” and “Open Table” will open up a blank
version of the table shown in Figure 5−67. These are 20−category panels. Press the INSERT button to start
building the table. Then skip to Step 9.

• CP 3809 and CP 3810 expansion panels do not have a separate CP Output Set. They use the Output Set as-
signed to the main panel associated with them.

• If CP 320, CP 328, or CP 3808 is selected, clicking “Apply” and “Open Table” will open a blank version of
the table shown in Figure 5−67 . These are 16−category panels. Press the INSERT button to start building the
table. Then skip to Step 10.

• If CP 3824 is selected, clicking “Apply” and “Open Table” will open a blank version of the table shown in
Figure 5−67 . This is a 15−category panel. Press the INSERT button to start building the table. Then skip to
Step 10.

• For CP 3830 panels, select type “CP3830.” Clicking on “Apply” and “Open Table” will open a blank version
of the table shown in Figure 5−67. These are 12−category panels. Press the INSERT button to start building
the table. Then skip to Step 10.

• If CP 310 is selected, clicking on “Apply” and “Open Table” will open a blank version of the table shown in
Figure 5−67. This panel does not use categories or mnemonics, but the table is used to assign the panel’s eight
outputs. Press the INSERT button to start building the table. Then skip to Step 11.

† Not supported by Jupiter XPress.
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• For CP 330/6 panels, select type “CP310.” This panel does not use categories or mnemonics, but the table is
used to assign the panel’s six outputs. Press the INSERT button to start building the table. Then skip to Step
11.

• For CP 330 panels operated in dual bus mode, select type “CP3000.” This panel does not use categories or
mnemonics, but the table is used to assign the panel’s two outputs. Press the INSERT button to start building
the table. Then skip to Step 12.

• For SlimLine (and RP 1/2/3) UMD  status displays select type UMD3A.

• For DD switcher applications, both E−MEM  and Serial tables will probably be required. Clicking on “Ap-
ply” and “Open Table” will open a blank version of the table shown in Figure 5−67. For the E−MEM table,
skip to Step 13. For the serial table, skip to Step 14.

• For Thomson Broadcast Automation or other external computer applications, a type “Serial” table will
be required. Click on “Edit” to bring up a blank version of the CP table without a “Mnemonic” column. Press
the INSERT button to start building the table. Then skip to Step 15.

• For CP 3832/3864 panels controlling more than one output, or CP 3810L control panels, a type “CP3832”
table will be required. Click on “Edit” to bring up a blank version of the CP table. Press the INSERT button to
start building the table. Then skip to Step 16.

7. Clicking on an existing Output Set will open a table similar to that shown in Figure 5−67.

Figure 5−67. Output
Set table (example).

1

Output Set — MC−OUT

Category

STU

Entry

1

Mnemnonic

QC

Output

QC

Level Set Button

2

3

VTR 1 VT01 VT01

VTR 2 VT02 VT02

4 VTR 3 VT03 VT03

5

6

VTR 4 VT04 VT04

VTR 5 VT05 VT05

Auto
Mnem

Logical

8. If you are:

— adding a new entry, click on the row number above where you want the new entry to appear. Click the “Edit”
pull−down menu. Click on “Insert” and make the addition. Then go to Steps 9 through 15 below as appropri-
ate.

Important:   Row numbers on Jupiter tables are used as the “logical” numbers for destinations. Changing
the row number of a destination (by inserting/deleting a new output in the middle of the table, for example)
will disrupt control of the system, requiring controller boards to be memory−cleared and reset (see “Clear-
ing Battery−Protected Memory” in Appendix B). One way to avoid this interruption is to add new outputs
at the end of tables.

— editing an existing entry, double−click on the item you want to change. Then go to Steps 9 through 15 below as
appropriate.
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9. CP 2002, CP 3000, CP 3800

a. Select the desired Category from the pull−down menu.

The 20−category factory default set used for CP 2002, CP 3000, and CP 3800 panels is as follows:

VTR CG NET SAT A
VCR CAM REM EJ** B
FILM PTCH STU FS C
AUX TEST MISC SS D **EMER on CP 3800

b. Specify the desired Entry  (unit) number. This can be done by double−clicking on the desired “Entry” field and
typing in the number. Press TAB.

Guidelines for using the editor are found on page 5−3.

c. Select an Output  name from the pull−down menu.

The source for these names is the Switcher Output table (page 5−55).

d. Check the Auto Mnemonic box or enter the desired Mnemonic.

The Auto Mnemonic function can be used to enter a control panel mnemonic automatically based on the Name
given to the output. In cases where the output Name is more than four characters long, the mnemonic will be trun-
cated to the first four characters.

If an Output Name is changed on the Switcher Output table and Auto Mnemonic is enabled, the mnemonic will
change to the new name automatically.

Note: if you use the Auto Mnemonic feature, it will not work if you go back to a version of the Jupiter
editor prior to 6.2.1.

Remember that a CP 3000 panel can display four−character mnemonics, while the CP 3800 can display eight−char-
acter mnemonics.

e. Optionally, select a Level Set name.

The Level Set column should be used when multiple switchers are in the system and you want the control panels
to control and status more than one switcher. See page 5−95.

The source of these names is the CP Level Set tables (page 5−58).

f. Optionally, enter a Button number. This is used to assign Expansion Panel buttons to individual outputs:

CP 3010 Expansion Panel −  Outputs are normally assigned to the CP 3010 TAKE button dynamically, by the
operator (see page 6−24). However, by entering an expansion button number from 1 to 160 (8 buttons x 20 pages)
in the Button column, the output will be assigned permanently to the desired button. Such assignments cannot be
changed using the panel itself.
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Note: If an output is permanently assigned to a CP 3010 button, but that output is later removed from the
CP Output table and the new set downloaded, the CP 3010 will continue to display the name of the out-
put until the output is manually deleted. This is done by selecting an output that is not defined and press-
ing the appropriate TAKE key on the expansion panel.

CP 3800 − When in Multiple Destination mode, CP 3800 outputs can be assigned to the soft keys dynamically,
by the operator (see page 6−34). However, by entering a soft key button number from 1 to 80 (8 buttons x 10 pages)
in the “Button” column the output will be assigned permanently to the desired button. Such assignments cannot
be changed using the panel itself.

CP 3810 Expansion Panel −  By entering an expansion button number from 1 to 80 (8 buttons x 10 pages) in the
Button column, the output will be assigned permanently to the desired button.

When finished, skip to Step 17.

10. CP 320, CP 328, CP 3808, CP 3830

a. Enter the desired Category. This can be done by double−clicking on the appropriate field in the Category column;
this will open a pull−down menu of categories. Click on a category and press ENTER.

The 16−category factory default set used for the CP 3808 panel is as follows:

Default sets may vary —
confirm by creating a new set!

VTR CAM SAT EJ
VCR NET REM FILM
Studio MISC AUX FS
CGEN TEST PTCH STILL

The 16−category factory default set used for CP 320 and CP 328 panels is as follows:

VTR CG NET VCR
CAM AUX EJ SS
REM FILM PTCH STU
TEST SAT FS MISC

The 15−category factory default set used for CP 3824 panel is as follows:

VTR CG NET VCR CAM
AUX SS REM FILM PTCH
STU TEST SAT FS MISC

The 12−category factory default set used for the CP 3830 panel is as follows:

VTR GFX Studio
ENG REM NET
EC POST Xmsn
AUX TEST NUM

Guidelines for using the editor are found on page 5−3.
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b. Specify the desired Entry  (unit) number. This can be done by double−clicking on the desired “Entry” field and
typing the number. Press ENTER.

c. Select the Output  name.

The source of these names is the Switcher Output table (page 5−55).

d. Check the Auto Mnemonic box or enter the desired Mnemonic.

The Auto Mnemonic function can be used to enter a control panel mnemonic automatically based on the Name
given to the output. In cases where the output Name is more than four characters long, the mnemonic will be trun-
cated to the first four characters.

If an Output Name is changed on the Switcher Output table and Auto Mnemonic is enabled, the mnemonic will
change to the new name automatically.

Note: if you use the Auto Mnemonic feature, it will not work if you go back to a version of the Jupiter
editor prior to 6.2.1.

A CP 320 panel can display four−character mnemonics; the CP 328, CP 3808, and CP 3830 can display eight−char-
acters.

e. Optionally, enter the Level Set name.

The Level Set column should be used when multiple switchers are in the system and you want the control panels
to control and status more than one switcher. See page 5−95.

f. Optionally, enter a Button number.

By entering a CP 3809 Expansion Panel button number from 1 to 40 (8 buttons x 5 panels max) in the Button
column and appropriate row of the CP Output table, the output will be assigned permanently to the desired button.
Note that this CP Output table must be assigned to the main panel (CP 3808 or CP 3830) on the MPK Devices
table—page 5−107. (Dynamic assignment of outputs, using the front panel, is described on page 6−124.)

When finished, go to Step 17.

11. CP 310 24 x 8 Eight−Bus Control Panel and CP 330/6 48 x 6 Six Bus Control Panel

For these multi−bus control panels, a special CP Output Set is used to identify the outputs that will be controlled by the
panel. This set is assigned to the specific control panel with the MPK devices table. In this case, there must still be an
entry in each field of the CP Output Set table, even though the only data that will be used is in the Output column. The
category name “dflt” is used throughout, but selection numbers and at least one character for a mnemonic will have to
be entered on each of the eight (or six) rows in order to satisfy the system compiler.

When finished, skip to Step 17.

12. CP 330 operating in dual bus mode

For the dual−bus CP 330 control panel, a special CP Output Set is used to identify the two outputs that will be controlled
by the panel. This set is assigned to the specific CP 330 with the MPK Devices table. The only data that will be used
is in the Output column; however, category names, selection numbers, and at least one character for a mnemonic will
have to be entered on both rows in order to satisfy the system compiler.
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When finished, skip to Step 17.

13. DD (“Diamond”) − E−MEM

For DD applications, both E−MEM and Serial tables will probably be required. The dual entries are necessary because
of the two hardware connections, as previously described (page 2−60).

For the  E−MEM table, you will need entries similar to that shown in Figure 5−68.

1

Output Set — DIA−OUT

dflt 1 DD01

2

3

dflt 2 DD02

dflt 3 DD03

4 dflt 4 DD04

5

6

dflt 5 DD05

dflt 6 DD06

128 dflt 128 DD128

Figure 5−68. Output Set table
(example).

Category Entry Mnemnonic Output Level Set Button
Logical

a. For Category, the word “dflt” is used for all entries.

b. Specify the desired Entry  number. This can be done by double−clicking on the desired “Entry” field and typing
the number. Press ENTER.

Note: These Entry numbers must match the numbers assigned to the buttons on the DD M/E Bus, using
the DD “Install > Ident Input >  Ident Xbar” menu. Each DD button that is fed from the router should
be assigned an Entry number from 1 to 128. Refer to the DD installation manual for information about
the DD serial ports and operating instructions.

c. Enter the name of the first router Output  wired to the DD. The source of these names is the Switcher Output table
(page 5−55).

d. Enter the next Entry number and Output name, up to the maximum of 128 rows.

When finished, skip to Steps 17 and 18.  Then return to Step 2 and build the DD serial table.
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14. DD (“Diamond”) − serial

For the Serial table, you will need entries similar to those shown in Figure 5−69.

Figure 5−69. Serial Input Set menu.

1

Output Set − ASC−OUT

2 2

3

Entry

DD01

DD02

Output

3

4

DD03

4

5 5

66 DD06

DD04

DD05

1

Logical

a. Specify the desired Entry  (unit) number.

Note: These Entry numbers must match the numbers assigned to the six buttons of the DD Delegation
Bus, using the DD “Install > Extern Aux > Config” menu. As a convention, these buttons are assigned
Entry numbers from 1 to 6. This will allow the DD operator to control up to six router outputs (these
router outputs are wired into the DD as inputs). Refer to the DD installation manual for information
about the DD serial ports and operating instructions.

b. Enter the name of the first router Output that is wired to the DD. The source of these names is the Switcher Output
table (page 5−55).

c. Enter the next Entry number and Output name, up to the maximum of 128 rows.

When finished, skip to Step 17.
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15. Thomson Broadcast Automation / External Computer

If you are entering a set for a serial control device, you will need a table similar to that shown in Figure 5−70.

Figure 5−70. Serial Output Set table.

1

Output Set − ALAM−OUT

2 2

3

Entry

QC

VT01

Output

3

4

VT02

4

5 5

66 VTO5

VT03

VT04

1

7 7

88 VTO7

VT06

nn VTnn

Logical

The purpose of the table is to establish a unique “Entry” number for each switcher “Output” name. In Figure 5−70, Entry
number “1” is associated with Output name “QC.” The Entry number is the number that the serial control device must
send to Jupiter. When the Entry number arrives, the software checks this table to find the associated Output name; then
the Switcher Outputs table (page 5−55) is checked to find the corresponding physical Output number.

Note: For Thomson Broadcast Automation systems, it is suggested that you print out this Output Set; you
will need this information when setting up the Automation Switcher Initialization menu. The Output names
entered on the Jupiter Output Set table must be in the same order as they are on the Automation table. Any
changes made to one table must also be made to the other.

When finished, skip to Step 17.
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16. CP 3832 / CP 3864 / CP 3810

Note: For CP 3832/64 panels, this table is only needed when more than one output is to be controlled.

If you are entering a set for CP 3832 or CP 3864, a menu similar to that shown in Figure 5−71 will appear. The purpose
of the table is to assign a button position (row number) to each switcher “Output” name. Exact table entries will depend
on the panel and the application, as shown in the following examples. Note that source buttons are defined on a CP Input
Set (page 5−74). 

For Category, the word “default” is used for all entries.

� Split mode. Split mode operation is determined by the checkmark in the Expansion box in the MPK table
(page 5−109). In this application, some buttons are used for inputs and some for outputs. If the number of in-
puts and outputs is the same, the split is “balanced” and the panel can be used with expansion panels. See
Figures 5−71 and 5−72.

1

Output Set — 3832−OUT

default 1 MONITOR1 MON1

2 default 2 MONITOR2 MON2

16 default 16 VTR−4 VTR4

Output button 1

CP−3832

Output button 16

IN

OUT

†

†

†

Figure 5−71. Entries for CP 3832
configured as “balanced split” panel.

Category Entry Mnemnonic Output Lev Set ButtonLogical

Output button 1

CP−3864

Output button 32

IN

OUT

Figure 5−72. Entries for CP 3864
configured as “balanced split” panel.

1

Output Set — 3832−OUT

default 1 MONITOR1 MON1

2 default 2 MONITOR2 MON2

32 default 32 VTR−12 VT12†

†

†

Category Entry Mnemnonic Output Lev Set Button
Logical

† Data not used, but entry must be present  to satisfy compiler. Each number in this column must be unique.
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A split panel can also be configured with a different number of inputs and outputs (“unbalanced split”), but such
panels cannot be expanded. In this application, the number of outputs can be from 1 to 15 (CP 3832) or 1 to 31
(CP 3864). Buttons not assigned to outputs are available for inputs. For example, if two buttons are used for out-
puts, then 30 buttons will be available for inputs on a CP 3832 panel. See Figures 5−73 and 5−74.

Output
button 1

CP−3832

Output
button 2

IN

OUT

†

†

Figure 5−73. Entries for CP 3832 configured as 30 x 2 “unbalanced split” panel.

1

Output Set — 3832−OUT

default 1 MONITOR1 MON1

2 default 2 MONITOR2 MON2

Category Entry Mnemnonic Output Lev Set Button
Logical

Output
button 1

CP−3864

Output
button 10

IN

OUT

†

†

†

Figure 5−74. Entries for CP 3864 configured as 54 x 10 “unbalanced split” panel.

1

Output Set — 3832−OUT

default 1 MONITOR1 MON1

2 default 2 MONITOR2 MON2

10 default 10 VTR−12 VT12

Category Entry Mnemnonic Output Lev Set Button
Logical
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� Expansion mode. Unless the panel is operated in “unbalanced split” mode, control of additional outputs is
possible using adjacent CP 3832 or CP 3864 panels. See Figure 5−75.

1

Output Set — 3832−OUT

default 1 MONITOR1 MON1

2 default 2 MONITOR2 MON2

64 default 64 VTR−12 VT12

96 default 96 AUX−12 AX12

65 default 65 VTR−13 VT13†

†

†

†

†

CP 3864

Output button 1

Output button 65§

Output button 64

Output button 96§

CP 3832

CP 3832IN

OUT

Figure 5−75. Entries for CP 3864 used for destinations and CP 3832 used as
destination expansion panel.

Category Entry Mnemnonic Output Lev Set Button
Logical

§ When two or more CP 3832/3864 panels are used, button assignments are also determined by order of MPK table entries.
See page 5−128.

† Data not used, but entry must be present  to satisfy compiler. Each number in this column must be unique.
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The CP 3832/64 can be also be operated in connection with an adjacent CP 3810 Expansion Panel. See Figure
5−76.

CP 3832
(Main panel)

CP 3810

1

Output Set — 3832−OUT

1 MONITOR1 MON1 1

2 2 MONITOR2 MON2 2

8 8 VTR−4 VTR4 8

9 9 VTR−5 VTR5 9

PAGE
1

PAGE
2

16 16 VTR−12 VTR12 16

Up to
page 10

†

†

†

†

†

default

default

default

default

default

Figure 5−76. Entries for CP
3810  used as multi−destination
panel. Set is assigned to main
panel on MPK Devices table.

Entry Mnemnonic Output Lev Set ButtonCategory
Logical

17. To close the table, click on “OK.”

18. Click on “File > Save” to save the set.

The change will apply to all control panels that use the same Output Set. For the system shown on page 5−107, it would
affect all panels in the system since all of them use “KXYZ−OUT” as the Output Set.

19. Validate, compile, and activate the new configuration set. For more information, refer to page 5−13.

† Data not used, but entry must be present  to satisfy compiler. Each number in this column must be unique.
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Multiple Switcher Installations

Please refer to Figure 5−77 for the following discussion.

When more than one switcher is in the system, and you want to operate the switchers from one control panel, there must be

a separate CP Level Set for each switcher ( [1] and [2] ). This is because the CP Level Set is used to determine how status
will be shown on the panel; specifically, the first entry on the CP Level Set will be the level that is statused. In this example,
video will be statused.

The CP Output Set is used to assign an individual output to a CP Level Set for the appropriate switcher [4]. In this example,
all outputs of the  “NewsRout”switcher would be assigned to the CP Level Set named “2000−LEV.”

Similarly, all outputs of the “MainRout” switcher could be assigned to a CP Level Set on an output−by−output basis, but in
this example the Lev Set entry is blank. With no entry, the system will refer back to the MPK Devices table to locate the default
CP Level Set—in this case, “KXYZ−LEV” [3]. Thus the “KXYZ−LEV” table will be used to establish  “MainRout” status
[2].
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Figure 5−77. CP Output Set and CP Level Set requirements for multiple switcher installations. See page 5−94 for discussion.

VT01

 Cam9 Cam1
 VT20 VT01

CAM1

CP 3000/E
“STUCP”

VT20

CAM9

TVS/TAS 2000
“NEWSROUT”

Venus
“MAINROUT”

  MPK Device
Devices   Type Exp Pw Mode Board Port Address In Set In Panel Out Set Out Panel Lev Set Over Set Seq Set

1 STUCP CP−3000 L CM1 8 00000014 KXYZ−INP KXYZ−OUT KXYZ−LEV KXYZ−OVE

MPK Devices

Level Set — KXYZ−LEV

1 VID VIDEO (MAINROUT)
2 LEFT LEFT (MAINROUT)
3 RGHT RIGHT (MAINROUT)

Mnemonic Level Break Switch

Output Set — KXYZ−OUT

1 VTR 1 VT01 VT01 [BLANK]
2 VTR 2 VT02 VT02 [BLANK]

VCR 20 VT20 VT20 2000−LEV
VCR 21 VT21 VT21 2000−LEV

 Auto Logical
Category Entry Mnem Mnemonic Output Level Set Button

Level Set — 2000−LEV

1 VID VIDEO (NEWSROUT)
2 LEFT LEFT (NEWSROUT)
3 RGHT RIGHT (NEWSROUT)

Mnemonic Level Break Switch

Status

Output

CM 4000

CM 4000

CM 4000

 1  2

 3

 4
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CP Override Set

The override function, which allows single−keystroke selection of a source, is used for a quick or emergency switch to an
often−used input. For example, the black burst generator could be defined as the first “override” source for the system, corre-
sponding to the first soft key position on a CP 3000 or CP 3800 panel. When in a hurry to find black burst, the operator can
then press BLK, TAKE (instead of, for instance, TEST, 1, TAKE).

Override sets are also used to assign an input to each button on CP 300, CP 310, CP 330, and CP 3020 Push Button Control
Panels, and to the button−per−source keys on CP 3824 panels.

The overrides can be permanently assigned with the file server (as described immediately below), and, if desired, temporarily
edited at CP 3000 control panels (as described on page 6−21). Overrides can also be temporarily edited at CP 3800 panels
(as described on page 6−54) and CP 3824 panels (page 6−85).

The order in which the overrides are listed on this table will be the order in which they appear on the panels.

Figure 5−78. CP override set (example).

1

CP Override Set — KXYZ−OVE

Override

BLK

Input

BLK

Edit Levels

YYYY

2

3

4

5

6

BARS BARS YYYY

TONE TONE YYYY

SLNC SLNC YYYY

Usr1 BLK YYYY

Usr2 BLK YYYY

...

...

...

...

...

...

Logical

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1
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DEFINING OVERRIDES

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

For more information, please see Modifying and Downloading a System Configuration Set on page 5−8.

2. Click on “Jupiter > Control Panel Sets,” then “CP Override set.” This will display a list of all existing CP Override sets.

Select Override Set

Figure 5−79. Override edit set menu (example).

The menu lists all override sets in the configuration set presently selected for editing.

3. If you want to create a new set, click on “New,” and go to Step 4.  Or, if you want to edit an existing set, click on the
name of the Output Set; then click “Apply” and “Open Table” and skip to Step 6.

4. If you are creating a new set, you will be asked for a set name.

Note: Do not use the same name for different CP sets. Also, do not name a CP set with a name used by the
system for a Device Type. Device Type names are shown on page 5−108.

5. Click on one of the CP types. Select “CP3000” for all panels except the CP 3800, and CP 3824. Clicking on “Apply”
and “Open Table” will bring up a blank version of the table shown in Figure 5−78. Skip to Step 7.

Because they can display eight−character mnemonics, the CP 3800 and CP 3824 all use type “CP3800” override sets.

6. If you click on an existing Input Set, this will open a table similar to that shown in Figure 5−78.

7. If the panel being configured is a CP 3000, CP 3800, or CP 3824, click on the “Override” field and create a name for
the first override button. This is the name that will appear in the panel’s display window during override mode. For all
other panels, no entry in the “Override” column is required.
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Guidelines for using the editor are found on page 5−3.

8. In the “Input” column, select the name of the switcher input for the first override button.

The source of these names is the Switcher Input table (page 5−48).

Although the CP 3824 has only 24 button−per−input keys, up to 360 inputs can be assigned on this table, i.e., 15 groups
(“pages”) of 24 inputs each. Each page of 24 sources would then be accessed with the Page key.

For CP 330 panels configured for dual bus control (24 x 2), the first 24 rows on this table will apply to the top row of
24 buttons and the next 24 rows to the bottom row of buttons.

9. If you want to allow the override to be changed from the CP 3000, CP 3800, or CP 3824 front panel, check the box in
the “Edit” column.

Note: Front−panel editing does not change the name of the override as established by the Override Set table.
This could result in a situation where the operator selects CAM1 but gets VTR5. For overrides that will be
allowed to be edited from the front panel, it’s a good practice to enter generic names such as “Usr1” or
“Ovr1.”

10. Select the Levels that you want to switch by double−clicking in the appropriate Levels field; this will open a secondary
dialog box showing the names of existing switcher levels (as shown in the Switcher Description table [page 5−35]).
Toggle the desired levels on or off and click OK.

11. To close the Override Set table, click OK.

12. Click on “File > Save” to save the table.

The change will apply to all control panels that use the same override set. For the system shown on page 5−89, it would
affect all CP 3000 panels in the system since all of them use “KXYZ−OVR” as the override set.

13. After saving your changes, compile and activate the configuration set. (See page 5−13 if you need more information.)



ConfiguratorCP Sequence Set

5−99CM 4000 Installation and Operating Manual

CP Sequence Set

A sequence is a switch of one or more sources to one or more destinations.

The CP 3000 panel can accommodate a maximum of 25 events (switches) in one sequence.

There is no specific limit to the number of sequences, but due to memory restrictions a limit of 16 is recommended.

Figure 5−80. CP sequence set (example).

1

Sequence Set − KXYZ−SEQ

Sequence

SEQ1

Input

VT01

Levels

YYYY

2

3

4

SEQ1 VC01 YYYY

SEQ1 VC02 YYYY

SEQ2 CAM1 YNNN

Output

PRDA

PRDB

PRDC

MON1

...

...

...

...

Logical Logical

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

In Figure 5−80, the first three rows show the switching events in “Seq1.” In this example, selecting “SEQ1” will cause three
VTRs to be switched into inputs A, B, and C of a production switcher. All four levels (video, audio left, audio right, and time
code) will be switched. The switches will take place in the vertical interval at maximum system speed.

Sequences are stored as sequence sets;  these sets can be made available to some or all control panels.  For the system shown
on page 5−89 (on the MPK Devices menu), the set in this example would be available to all CP 3000 Switcher Control Panels
in the system since all of them use “KXYZ−SEQ” as the sequence set. Sequences can include outputs not otherwise available
to a panel (i.e., when the outputs are not entered on the CP Output Set assigned to the panel).

When operating the CP 3000, sequences are accessed through the Menu and F keys, as described on page 6−17.

Note 1: Data matrixes can be part of sequences when used in conjunction with the “DM 400 Off Time” feature
(DM 400 Off Time is described on page 5−47). There should not be more than 25 DM 400 safe off time switches
per sequence. Safe off time in sequences must be used with care as specifying too short of a safe off time may result
in the switch occurring too soon; this could result in switches occurring out of sequence.
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Note 2: Great care needs to be used to ensure that the switches defined in CP Sequence Sets involving Data Routers
do not conflict.  Verify that each sequence uses all defined data router inputs and outputs just once, including the
implied reverse switches.  Failure to do this will result in unintended switches, and possibly switching a single
input to multiple outputs at the same time.

DEFINING SEQUENCES

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

For more information, please see Modifying and Downloading a System Configuration Set on page 5−8.

2. Click on “Jupiter > Control Panel Sets” then “CP Sequence Set.” This will open a list of all existing CP Sequence sets.

3. Click on “New.”

4. Enter the desired name for the set, up to eight characters, and select a CP type. Then click on “Apply” and “Open Table.”
An example of the resulting menu is shown in Figure 5−80.

Important:   Do not use the same name for different CP sets. Also, do not name a CP set with a name used
by the system for a Device Type. Device Type names are shown on page 5−108.

5. Add (or edit) sequences as desired.

Enter a name for the first sequence.

Select the first input name (source for these names is the Switcher Input table, page 5−48). Select the first output name.
The source for these names is the Switcher Output table (page 5−55).

Guidelines for using the editor are found on page 5−3.

The Levels column is edited by double−clicking in the field and toggling the desired levels on or off in a secondary dialog
box.

6. After saving your changes, validate, compile, and activate the configuration set.
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CP Category Set

1

Category Set − 3200-CAT

VTR

2

3

19

Font

Net

Aud

Mnemonic

Figure 5−81. CP category set
(example).
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Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

The CP Category Set table allows the category names to be customized. (Categories are classes of inputs/outputs, such as
“VTR” and “CAM.”) This table is the source of the name that appears in the display window when a category key is pressed.

A custom category set can be used with the CP 320, CP 3000, CP 3800, CP 3808, CP 3824, and CP 3830 panels, all of which
have re−legendable keycaps.

Note: The original CP 3000 switcher control panels have factory default categories engraved on the keys; however,
these panels can be retrofitted in the field using the CP 3000RBK Relegendable Button Kit, part no.
44−046025−001.

A CP Category Set is normally assigned to a CP Input Set and to a CP Output Set when those sets are first created. However,
this assignment can be changed later if desired (see page 5−105).

The CP Input and Output Sets are in turn assigned to specific control panels on the MPK Devices table (page 5−89).

When creating a new CP Category set, the menu shown in Figure 5−82 will appear.
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CP310 OUT
CP320 IN
CP320 OUT
CP328 IN
CP328 OUT
CP2002B IN
CP2002B OUT
CP3000 IN
CP3000 OUT
CP3008 IN†

CP3008 OUT†
CP3310 IN
CP3310 OUT
CP3800 IN
CP3800 OUT
CP3808 IN
CP3808 OUT
CP3824 IN
CP3824 OUT
CP3830 IN
CP3830 OUT
CP 3832 IN
CP3832 OUT
EMEM IN
EMEM OUT
SATRN IN
SATRN OUT†

SERIALIN
SERIALOUT
UMD3AIN
UMD3AOUT

Figure 5−82. CP category set create menu.

This menu is used to enter the name of the set and select the set type. 

When finished, a blank version of the table shown in Figure 5−81 will appear.

Guidelines for using the editor are found on page 5−3.

Each CP 3000, or CP 3800 Category Set can contain up to 20 category mnemonics; if less than 20 categories are entered,
the remaining category keys will be inoperative.

† Not supported by Jupiter XPress application.
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The table entries correspond to the CP 3000 and CP 3800 category keys as follows:

VTR

1

CG

2

NET

3

SAT

EJVCR

4

CAM

5

REM

6

FILM

7

PTCH

8

STU

9

FS

AUX TEST

0

MISC SS

A

B

C

D

Original CP
3000 engraved

keys

CP 3000/3800 key positions
showing number of corresponding

row on Category Set table

1 2 3 4 5

6 7 8 9

11 12 13 14 15

16 17 18 19 20

10

Figure 5−83. CP 3000/3800 key positions.

Each CP 320 and CP 3808 Category Set can contain up to 16 category mnemonics; if less than 16 categories are entered,
the remaining category keys will be inoperative.

The table entries correspond to the CP 320 category keys as follows:

VTR
1

CG
2

NET
3

VCR
4

CAM
5 AUX

REM
6

FILM
7

PTCH
8

STU
9

TEST
0

EJ SS

MISCFSSAT

1 2 3 4 5 6 7 8

9 10 11 12 13 14 15 16
Figure 5−84. CP 320 key positions.
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The table entries correspond to the CP 3808 category keys as follows:

VTR
1

CAM
2

SAT
3

VCR
4

NET
5 FILMREM

6

Stu
7

MISC
8

AUX
9

TEST
0

EJ

STILLCGEN

FS

PTCH

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16
Figure 5−85. CP 3808 key positions.

Each CP 3824 Category Set can contain up to 15 category mnemonics; if less than 15 categories are entered, the remaining
category keys will be inoperative. The table entries correspond to the CP 3824 category keys as follows:

VTR
1

CG
2

NET
3

CAM
5

AUX
6

SS
7

FILM
9

PTCH
0

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

VCR
4

REM
8

STU TEST FS MISCSAT Figure 5−86. CP 3824 key positions.

Each CP 3830 Category Set can contain up to 12 category mnemonics; if less than 12 categories are entered, the remaining
category keys will be inoperative. The table entries correspond to the CP 3830 category keys as follows:

VTR
1

GFX
2

Stu
3

ENG
4

REM
5

NET
6

EC
7

POST
8

Xmsn
9

TEST
0AUX

1 2 3

4 5 6

7 8 9

10 11

NUM

12
Figure 5−87. CP 3830 key positions.
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Changing the Category Set Associated with an Input or Output Set

A custom Category Set can be created at any time. The following procedure is used to assign a new Category Set to an existing
CP Input Set or CP Output Set.

1. On the main menu, click on “Jupiter” and “Control Panel Sets.” Then select  “Input” or “Output,” as desired. A menu
similar to Figure 5−88 will appear.

Figure 5−88. CP set dialog (example).

2. Select the name of the existing set of interest.

3. Click on the Category Set name box, and enter the name of the new Category Set.

If you want to return to the factory default category set, leave the Category Set name as “Default.”

4. Click on “OK.”
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MPK Devices

Figure 5−89. MPK Devices table (example).

STUMC MC−3000 6 00000016

STUCP CP−3000 6 00000014 KXYZ−OVE KXYZ−SEQ

1

MPK Devices

MPK
Type Expansion Pass Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 CM1 KXYZ−INP KXYZ−OUT KXYZ−LEV

Devices word In Panel Out Panel

ENGCP CP−3000 6 00000013 KXYZ−OVE KXYZ−SEQ3 CM1 KXYZ−INP KXYZ−OUT KXYZ−LEV

MC CP−3000 2 00000000 KXYZ−OVE KXYZ−SEQ4 CM1 KXYZ−INP MC−OUT KXYZ−LEV

SHOP CP−3000 2 00000002 KXYZ−OVE KXYZ−SEQ5 CM1 KXYZ−INP SHOP KXYZ−LEV

DELAY CP−3000 2 00000003 KXYZ−OVE KXYZ−SEQ6 CM1 KXYZ−INP DELAY−OUT KXYZ−LEV

TAPECP CP−3000 6 00000008 KXYZ−OVE KXYZ−SEQ7 CM1 KXYZ−INP TAPE−OUT KXYZ−LEV

TAPEMC MC−3000 6 000000168 CM1

CONF CP−3000 3 00000006 KXYZ−OVE KXYZ−SEQ9 CM1 KXYZ−INP CON1 KXYZ−LEV

PROD CP−3020 6 0000001210 CM1 3020−OVEVT01 KXYZ−LEV

TMC03010 MC−3010 6 0000002911 CM1

EDIT CP−320 5 0000003712 CM1 KXYZ−INP EDIT−OUT KXYZ−LEV

Hexadecimal

                                 

Device

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

This table must be used to define all MPK devices in the system. These include control panels and status displays. It is also
used when a PC is used as a Software Control Panel.§

§ Applies only when the Software Control Panel is used for machine control. For more information, see Section 7.
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Important : Row numbers on Jupiter tables are used as the “logical” numbers for devices. Changing the row number of an
existing device (by inserting/deleting a new control panel in the middle of the table, for example) will disrupt control of the
system, requiring controller boards to be memory−cleared and reset (see “Clearing Battery−Protected Memory in Appendix
B). One way to avoid this interruption is to add new devices at the end of tables.

MPK
Devices This column is used to create a name, up to eight characters in length, for each MPK device in the

system. Machine control panels (such as MC 3000, MC 3010, CP 3000 with “Exp” (expansion), CP 3800, and
CP 3810) listed here will automatically appear as a selection on the Machine Control table (page 5−139).

Type Device types (shown on a pull down menu) are limited to the following:

CP 300
CP 300/S
CP 310
CP 310/S
CP 320
CP 320/S
CP 328
CP 328/S
CP 330
CP 330/6
CP 330/S
CP 2002B
CP 2002D
CP 3000
CP 3008†

CP 3020†

CP 3021†

CP  3030†

CP 3310/5†

CP 3310/8†

CP 3320†

CP 3300/X†

CP 3800
CP 3808
CP 3809

CP 3810 (p. 5−131)
CP 3810L (p. 5−131)
CP 3810S†

CP 3824
CP 3830
CP 3830P†

CP 3832
CP 3832L
CP 3832P†

CP 3832S†

CP 3864
CP 3864L
CP 3864P†

Diamond (p. 5−123)
ES−LAN
FCS 3276†

FCS 3277†

FCS 3296†

FCS 3360†

FCS 3363†

GVG 200†

JNS−UMD
MANAGER§
MC 3000
MC 3010

MC 3020D†

MC 3020L†

MC 3040/2†

MC 3040/4†

MC 3040/8†

MCS TALY†

MESS UMD
3040 LOCK†

3040 SLCT†

MI 3040/T
MI 3040/2†

MI 3040/4†

MI 3040/8†

MI 3040IO†

SD 3x†

Serial (p. 5−123)
TSL−UMD
WPE*
UMD3A
VC 3020 (p. 5−114)
VCP 3000† (p. 5−114)
VMC 3000† (p. 5−114)

Selecting a control panel with an “/S” suffix will cause the panel to operate with “sticky levels.”*

Selecting a CP 3810L device type will cause the panel to operate in single bus mode. For more information,
see page 5−131 and following.

Selecting a CP 3810S device type will cause the panel to operate in “sticky output” mode.

* Defined in Glossary section.
† Not supported by JupiterXPress application.
§ Custom.
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Selecting a CP 3832L or CP 3864L device type will cause the right−hand group of six buttons to function as
level selection buttons.

ES−LAN applies to the JEP−100 Jupiter / Encore Control Panel. For more information, refer to the JEP−100
manual, part no. 071 8376 xx.

Expansion As a general rule, the Expansion box is checked when the panel is used with an expansion panel;
for example, when a CP 3000 is used with a CP 3010. For special uses of this column, see the notes below.

For each MC 3010, there is only one entry whether it is a 4 machine panel (MC 3010/1) or a dual 4 machine
panel (MC 3010/2). The right−hand panel of an MC 3010/2 is not treated as an expansion panel; therefore, the
Expansion box is not checked.

The CP 3800 panel can be defined for Multiple Destination Mode operation (front−panel selectable to Single
Destination mode); or, defined for Single Destination Mode only operation. For front−panel selectable, Mul-
tiple or Single Destination Mode operation, the Expansion box is checked. For Single Destination Mode only
operation, the box is not checked.

When CP 3808 or CP 3830 control panels are associated with a CP 3809 Expansion Panel(s), the CP
3808/3830 Expansion box is checked. The CP 3809 entry is unchecked. 

When a CP 3832 or CP 3864 control panel (including type L ) is to be operated as a “split” panel, with some of
the buttons used for inputs and some for outputs, the Expansion box is checked. For all other applications, the
box is not checked (even when the panel is used in association with another panel to expand the number of
inputs or outputs, the box entry is still unchecked). The split mode cannot be combined with the continuous
Preset mode described above.

For CP 3810 Expansion Panel(s), the Expansion box is always unchecked.

When a CP 330 is defined with the Expansion box checked and an Output Set with two or more outputs
defined, the CP 330 will operate as a 24 X 2 panel with the top row of buttons assigned to one output and the
bottom row to another. The first two outputs defined in the Output Set will be the two output buses it will
control.

Pass
word This table has provisions for entry of password levels (described in detail on page 5−113).

Board Name of controller board connected to this device. The source of these names is the Network Descrip-
tion table (page 5−27).

Port Number of controller board port connected to this device. The port must support the necessary protocol
for this device (as configured on the Serial Protocol table, page 5−30).

Address Address (hex). Unique serial data bus ID used to select and service this device. Must be entered in
hexadecimal. (Not to be confused with LAN address entered on Network Description table shown on page
5−27).
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With the exception of the CP 3800 Series panels, RP 1/2/3, RP 1/2/3 C, and SlimLine Under Monitor Dis-
plays, device addresses such as “00000018” are determined at time of manufacture and cannot be changed by
the user. To display the address of a control panel, please see Display Control Panel ID on page 6−21.

Input Sets
Name of CP Input Set to be assigned to this device. The usual practice is to have one CP Input Set,

containing the names of all inputs, apply to all panels. However, special CP Input Sets could be created which
list only selected inputs; such a set could be used to prevent certain panels from selecting specific inputs.
Creation of CP Input Sets was described on page 5−62.

If panel “A” does not have access to a certain input, but that input has been selected by panel “B” for the output
presently being statused by panel A, then panel A has no way of reporting the mnemonic of the input. Under
these conditions, panel A will show asterisks (****) for status.

For each CP 3832 or CP 3864 (including type L ) operated as a:

— Single−bus control panel, select the name of the CP Input Set that will be used to assign sources to the control
panel’s input buttons.

— “Split” panel, with some of the buttons used as inputs and some as outputs, select the name of the CP Input Set
that will be used to assign sources to the control panel’s input buttons.

— Main source panel (controlling the inputs at a multi−panel control station) select the name of the CP Input Set
that will be used to assign inputs to the buttons at this control station. See page 5−127 for more information
about CP 3832/64 multi−panel control stations.

In Panel This column is used only for expansion panel configuration when that panel will be used for addi-
tional inputs.

For each CP 3832 or CP 3864 operated as an expansion input panel (used in association with a main source
panel), select the MPK Devices name of the associated main panel in this column. See page 5−127 for more
information about CP 3832/64 multi−panel control stations.

Note 1: In some cases you will need to press “Apply” to update the selections in drop down lists.

Out Set CP Output Set name. Creation of CP Output Sets was described on page 5−78.

If the entry is an actual CP Output Set, then the control panel will be able to control all the outputs listed in that
Set. Depending on the contents of the set, this would allow for full−matrix or multi−bus control.

For many single−output panels, this field can be used to enter the name of a single switcher output to be con-
trolled (see Note 2 below for exceptions). The source of the output names is the Switcher Output table (page
5−55).

Note 2: For a CP 300, CP 310, CP 320,or single−bus CP 330 (including “/S” type) control panels, for a
CP 3020 panel, and for a single−bus CP 3830, enter the name of the output set that contains the name of
the output to be controlled.
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For each dual−bus CP 330, enter the name of the output set that will be used to assign the two destinations.

For each CP 328 (including “/S” type) or CP 330/6, enter the name of the output set that will be used to assign
the destinations.

For each CP 3809 Expansion Panel, the “Out Set” column must be blank.

For CP 3810 / 3810S / 3810L Expansion Panel entries, see page 5−131 and following.

For each CP 3832 or CP 3864 operated as a:

— Single−bus control panel, enter the name of the output that the panel is to control.

— “Split” panel, with some of the buttons used as inputs and some buttons used as outputs, enter the name of the
CP Output Set that will be used to assign destinations to the control panel’s output buttons.

— Main panel with a CP 3810 Expansion Panel, see page 5−131 and following for details.

Out Panel
This column is used only for expansion panel configuration, when that panel will be used for addi-

tional outputs.

For each CP 3832 or CP 3864 operated as an expansion output panel (in association with a source panel),
select the MPK Device name of the associated main source panel in this column. See page 5−127.

For each CP 3809 Expansion Panel, select the name of the associated CP 3808 or CP 3830 main source
panel.

For each CP 3810 Expansion Panel associated with a main source panel (CP 3832, CP 3864, CP 3808, or CP
3830), select the name of the main panel. See page 5−131 for an example.

For each CP 3830 Dedicated Output Panel, select the name of the associated CP 3830 main source panel
(see page 5−126).

Note: In some cases you will need to press “Apply” to update the selections in drop down lists.

Level Set
Select the CP Level Set name. Creation of CP Level Sets was described on page 5−58.

For each CP 3809  Expansion Panel, the Level Set column must be blank.

Override Set Select the CP Override set name. In addition to defining CP 3000 overrides, CP Override
Sets are also used to assign input buttons on CP 300/310/330 and CP 3020 Push Button Control Panels. Crea-
tion of CP Override sets was described on page 5−96.

Sequence set Select the CP Sequence set name. Creation of CP Sequence Sets was described on page
5−99.
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SETTING UP A SWITCHER CONTROL PANEL FOR FULL−MATRIX, MULTI−BUS, OR 
SINGLE−BUS CONTROL

The output(s) that can be controlled by a control panel will depend on the CP Output Set entry for that panel on the MPK
Devices menu:

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5−10.

2. Click on “Jupiter > MPK devices.” This will open a table similar to that shown on page 5−107, which is a list of all control
panels in the system. The column of interest is labelled “Out Set.”

3. Click on the Output Set field you want to change.

4. In most cases, you’ll want to enter the name of the desired CP Output Set (for full/multi−bus operation), or select the
name of a single switcher output (for single bus operation).

Creation of Output Sets was described on page 5−78. The source of the output names is the Switcher Output table (page
5−55).

You may wish to review the “Out Set” discussion on page 5−110 for special entries required for some control panel ap-
plications.

5. After saving your changes, validate, compile and activate the configuration set. (See page 5−13 if you need more in-
formation.)
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SETTING PASSWORD LEVELS FOR CONTROL PANELS

In addition to individual Jupiter passwords assigned to each user, individual control panels can be given a password level.
This can be used to provide varying levels of protection from one control panel to another.

 To change the password level for a control panel:

1. On the top of the Jupiter Configurator window (page 5−2), check to see whether the configuration set you want to
change is selected for editing.

In most cases, you will want to modify the set that is currently active; if so, you may want to copy the active set and
select the copy for editing. For more information, please see Copying a Configuration Set for Editing on page 5−10.

2. Click on “Jupiter > MPK Devices.” This will open a menu similar to that shown on page 5−107, which is a list of all control
panels in the system.

In this example, the Password level column is blank, meaning that all control panels have a password level of zero.
Therefore all passwords presently assigned will enable any panel.

3. Click on the Password field for the control panel you want to change.

4. Enter the desired password level for this panel.

Entering “50” would allow the panel to switch outputs having a security level of 50 or less.

Guidelines for using the editor are found on page 5−3.

5. After saving your changes, validate, compile and activate the configuration set.
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VGA STATUS DISPLAY CONTROL PANEL ENTRIES

Use of control panels with the VGA Status Display requires entries to the MPK Devices table. The following example applies
to the VGA system shown on page A−1.

VC VC−3020 1 00000020

VCP VCP−3000 1 00000021 KXYZ−OVE

VMC VMC−3000 1 00000022

1

MPK Devices

MPK
Expansion

Pass
Board

V

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 V KXYZ−INP KXYZ−OUT KXYZ−LEV

3

4

Devices word In Panel Out Panel

V

Figure 5−90. MPK device table entries for system shown on page A−1.

Device
Type

Force Unprotect / Force Unlock Password

The VGA control panels can be configured to force unlock and force unprotect switcher outputs. This will normally require
use of a password with a level of 90 or above. If you wish to enable force unlock/unprotect on a permanent basis, you should
enter a password level of 90 or above for the VGA panels on the MPK Devices table.

VC VC−3020

VCP VCP−3000 90

VMC VMC−3000

KXYZ−INP

1 00000020

1 00000021

1 00000022V

KXYZ−OUT

1

MPK Devices

MPK
Expansion

Pass
Board

V

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 V KXYZ−LEV

3

4

Devices word In Panel Out Panel

KXYZ−OVE

Figure 5−91. Force unprotect/unlock password entries.

Device
Type

Displaying Time Code on an MC 3000 Associated with a VGA Status Display

The entries shown above will allow the MC 3000 to control any machine pointed to by the VGA cursor. However, while the
MC 3000 is under VGA cursor control no time code will be displayed in the MC 3000 display window. This function will
require entries to the Machine Control table, as shown on page 5−148.
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MI 3040 GENERAL PURPOSE / TALLY INTERFACE ENTRIES

Tally Interface Applications

When an MI 3040 is configured as an “MI 3040/T,” that is, configured to control tally lights (as shown on page 2−67 and
following), an entry similar to that shown as row 1 in Figure 5−92 will be required. If there is more than one MI 3040, an entry
with a unique Device Name will be required for each. This entry is the source of the Device Name for the MI 3040 and this
same name must be selected on the Tally Dependency table (page 5−158).

If the tally system is being used in connection with a Saturn Master Control Switcher or a MCS 2000 Master Control Switcher,
an additional entry will be required to allow the Jupiter system to gather tally information from the MCS. This entry will be
similar to row 2 in Figure 5−92. The Device Name (“MCS_TLY” in this example) must also be selected on the Tally Depend-
ency table (page 5−158). If more than one master control switcher is in the system, there must be an entry for each—for exam-
ple, with Device Names such as “MCS_TLY1,” “MCS_TLY2,” etc. For Saturn, the “Board” is always the name of the video
processor; the MPK “Port” is always “1” (this is true even if the MPK port is not physically connected to the MI−3040). For
an MCS 2000, the “Board” is the name of the device that is the source of the TCS 2 bus, i.e., the device that is connected to
the Machine Control port of the EC 2000 Control Electronics.

Figure 5−92. Entry for MI 3040 used for tally.

TALLY1

MCS_TLY

MI−3040/T

MCS_TALY

SI1

DVP−1

5

1

000000261

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2

Devices word In Panel Out Panel
Device
Type

External Control of Saturn Master Control Switcher (“MI 3040IO” application)

Using the MI 3040 General Purpose / Tally Interface, an external device can transmit commands to, and receive status from,
a Saturn Master Control Switcher. In this application, the MI 3040 is configured in software as an “MI 3040IO.” For more
information, refer to “MI 3040IO” in the Saturn Installation and Operating manual.
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UNDER MONITOR DISPLAY ENTRIES

Hardware installation was discussed on page 2−81. Software configuration varies according to the switching equipment used.

SYSTEMS WITH JUPITER−CONTROLLED DISTRIBUTION SWITCHER ONLY

SlimLine Applications

The system shown in Figure 5−93 corresponds to the MPK table shown in Figure 5−94.

Video

Control lines

Routing
switcher

Output names

M/E 3

M/E 2

M/E 1

SlimLine
“UMDSD1”

SlimLine
“UMDDD1A”

CM 4000 “CM1”

SlimLine UMD Controller

SlimLine
“UMDDD1B”

Figure 5−93. Example of SlimLine installation.

MPK bus

MPK Devices

1

MPK
Expansion

Pass
Board Port Address

2

3

4

UMDSD1 CM1 4 00000031UMD3A

UMDDD1A CM1 4 00000032UMD3A

UMDDD1B CM1 4 00000132UMD3A

MI3040T CM1 1 11111111MI3040/T

Devices word Level Set

KXYZ−LEV

KXYZ−LEV

KXYZ−LEV

Sequence SetOut Panel Override SetIn Panel Output Sets

M/E 1

M/E 2

M/E 3

Input Sets

UMD−INP

UMD−INP

UMD−INP

Figure 5−94. Entries for system shown in Figure 5−93.

Device
Type
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Device Type “UMD3A” is used for all displays in the SlimLine series.

Note: No entries are needed for the SlimLine Controller chassis even though it is on an MPK bus.

The address of SlimLine UMDs is set with front−panel buttons. For Dual Display (DD) models, the address of the first (left−
hand) display is set manually; the address of the second display is automatically set to the same number plus 100 hex. For
triple displays (i.e., using the Universal Display), the address of the first display is set manually; the address of the second
display is automatically set to the same number plus 100 hex; and the address of the third display is automatically set to the
same number plus 200 hex. For example, if the first display is set to “AA,” then the address of the second display is “1AA”
and the address of the third display is “2AA.” For more information, refer to the SlimLine Under Monitor Displays Technical
Manual.

Note: Do not use address 00000011.

The “Input Set” specified should be of type “UMD3A” and include all inputs and mnemonics that will be used on the status
display. Each “Output Set” is not an actual Output Set, but is rather the name of the router output feeding the monitor next
to the particular status display. The status display will follow the first level listed in the Level Set, e.g., if Video is the first
level listed, then the mnemonic of the video input feeding the monitor will be shown.

Tally light operation. For SlimLine tally light operation, the MPK table must include an “MI 3040/T” entry (even if no actual
MI 3040 hardware is in the system):

— If there is no MI 3040/T connected to the CM controlling the UMDs, you must define an imaginary MI 3040T
and assign it to the CM controlling the UMDs. Entries for “Port” and “Address” are not used but must be pres-
ent to satisfy the compiler. See row 4 of Figure 5−94. The purpose of this entry is to launch a tally process
within the CM.

— If an MI 3040/T does exist, and is connected to the CM controlling the UMDs, use the actual CM Board name,
Port, and Address.

Tally light operation will also require entries to the Tally Relay and Tally Dependency tables (see pages 5−152 and 5−158).

RP 1/2/3  and RP 1/2/3 C Applications

Configuration of the older model RP 1/2/3 displays is similar to the SlimLine units except that address(es) are set using rear−
panel switches. There is no equivalent to the SlimLine Controller in RP 1/2/3 systems; the UMDs are instead connected in
loop−through fashion directly to the CM 4000.
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SYSTEMS WITH SATURN MASTER CONTROL SWITCHER

Two methods are available for configuring UMDs with Saturn systems:

• “Saturn control” − in most cases this will be the preferred method because 1) it involves fewer tables, 2) it will
provide status for inputs connected to the Saturn Internal Matrix Option, and 3) it is designed to integrate with
the “Monitor Follow” function of Saturn. For more information, refer to the “Saturn UMD” discussion in the
Saturn Installation and Operating Manual.

• “Jupiter control” − the original method for configuring master control UMDs, largely replaced by the “Saturn
control” method—especially because Jupiter control cannot be used to status inputs connected to the Saturn
Internal Matrix Option. However, the Jupiter control method may still be useful in special circumstances, as
described below.
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SYSTEMS WITH SATURN MASTER CONTROL AND PRODUCTION SWITCHER

If UMD status from a production switcher upstream of Saturn is needed, the “Jupiter control” method must be used. “Jupiter
control” of UMDs is based on the software used for tally light control. See page 5−120 for an example system of this type.

Note : “Jupiter control” cannot be used to status inputs connected to the Saturn Internal Matrix Option.

Each UMD must named on the MPK Devices table (page 5−121).

The address of SlimLine displays is set using front−panel switches. For more information, see page 5−117.

Special Output Set tables of type “UMD3a” must be created to name all router outputs that can be selected for the Preset,
Program, and Air busses.

The MI 3040 used to collect status information from the production switcher must be named on the MPK Devices table.

An “MCS_TLY” entry is required to allow the Jupiter system to gather status information from the Saturn. This entry will
be similar to row 5 of the MPK Devices table on page 5−121.

Note : The device called “MCS_TLY” exists only in software tables. Saturn systems require a “Board” entry that
points to the Video Processing Unit; the “Port” number is always “1.” For MCS 2000 systems, the “Board” entry
points to the controller connected to the MCS−2000; the “Port” number is always “7.”

If there is more than one master control switcher in the system, there must be an entry for each—for example, with the Device
Names “MCS_TLY1,” “MCS_TLY2,” etc.

The Output sets, Tally Relay, and Tally Dependency tables are created as shown. Note that these entries allow for operation
of a tally light connected to Relay 3 on the MI 3040 (if desired).

For information about activating UMD built−in tally lights, see “Tally Light Operation” on page 5−117.
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MI 3040/T
“TALLY1”

Relays
Video

Jupiter Control lines

Jupiter−
controlled
router

Production switcher

20 1 3 4

Output names

MCS−A

MCS−B

MCSK1

MCSK1

MCSBP

PROD1

PROD2

20 1 3 4

Opto−isolators

Equal number of connections

Switcher tally
relays

PRESET PROGRAM AIR

Optional tally light.

PRD

Input name
A B K1 K2 BP

Preset Program On air

Saturn
 master control switcher

Figure 5−95. Example of UMD application with Saturn
master control switcher and production switcher. Equipment
shown here corresponds to tables on page 5−121.

“SD−PRST” “SD−PRGM” “SD− AIR”

CM 4000 
“CM1”

SlimLine UMD
Controller

MPK bus
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Figure 5−96. Tables for system shown on page 5−120.

1

Output Set — Program

Category

MISC

Entry

1

Mnemnonic

X

Output

MCS−A

2 MISC 0 X MCS−B These rows must be in
reverse  order of the rows
in the Preset Output Set

† Data in this field is not used, but an entry must be
selected to satisfy the Jupiter compiler.

x Data in this field is not used, but at least one charac-
ter must be entered to satisfy the compiler.

Saturn application MCS−2000 application

DVP−1

SD−PRST UMD3A 4 00000032 PRESET

SD−PRGM UMD3A 4 00000033 PROGRAM

SD−AIR UMD3A 4 00000034 ONAIR

MCS_TLY MCS_TALY

1

MPK Devices

MPK
Type Expansion

Pass
Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 CM1 KXYZ−INP KXYZ−LEV

3

5

CM1

Devices word In Panel Out Panel

KXYZ−INP KXYZ−LEV

KXYZ−LEVKXYZ−INP

1 CM1 7

1

Output Set — Preset

Category

MISC

Entry

0

Mnemnonic

X

Output

MCS−B

Lev Set Button

2 MISC 1 X MCS−A

ButtonLev Set

1

Category

MISC

Entry

1

Mnemnonic

X

Output

MCS−A

Lev Set Button

2

3

MISC 0 X MCS−B

VTR 3 X MCSBP

Output Set — On air

TALLY1 MI−3040/T 000000284 5SI1

MCS−A

MCS−B

6 MCSBP

TALLY1 0 PROD1 TALLY1 /3

TALLY1 1 PROD2 TALLY1 /3

1

Tally Dependency

Tally Device

MCS_TLY

Opto

0

Output Tally

2

3

MCS_TLY 1

MCS_TLY

4

5

3 PRD1

Tally Relay

Tally Device

TALLY1

Relay Logical Input

Logical

Logical

Logical

Logical

Device

†

†

†

†

†

†

†
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PERMANENT DISPLAY OF MNEMONIC

Front Panel Configuration

Using the front−panel buttons, SlimLine and RP 1/2/3 series UMDs can be configured to display a mnemonic permanently.
For more information, refer to the applicable UMD manual.

Jupiter Configuration

To cause the Jupiter system to display a mnemonic on a permanent basis, the MPK Devices table can be used to assign an
Input Set to the status display containing only one input name and mnemonic. See Figure 5−97.

UMDSD1 4 00000032 NET−INP NETMON KXYZ−LEVUMD3A1

MPK Devices

MPK Expansion Pass Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out PanelDevice
Type

Figure 5−97.

1

Input Set — NET−INP

Category Entry Mnemonic Logical

2

Net 1 NET NETIN

Auto
Mnem Input

The Output Set entry is not used in this application; however, the name of an actual Output Set (or Output) must be entered
to satisfy the compiler.

On the Input Set table, the Input field must be the name of an actual input.
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EXTERNAL CONTROL DEVICE ENTRIES

Note: Even though they are not shown on the Serial Protocol table as MPK devices, “ESswitch,” ASCII, DD, and
GVG200 control devices require entries to the MPK Devices table.

ENCORE CONTROL OF JUPITER 

Encore installation was discussed on page 2−91. Serial port configuration was discussed on page 5−30 and following.

PC−OUTENCORE SERIAL CM1 1 PC−INP KXYZ−LEV1

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out Panel

Figure 5−98. Entry for Encore control system.

Device
Type

The Input, Output, and Level Sets named on this table should include all inputs, outputs, and levels that will be controlled
by the Encore.

The Input (page 5−62) and Output (page 5−78) sets must be created specifically for use by “serial” devices.

The Level Set must be created as a type “CP−3000” (see page 5−58.) For an important note about level numbering and external
computer control, see page 5−60.

DD SERIES SWITCHERS

Hardware installation was discussed on page 2−60; serial port configuration was discussed on page 5−30. Figure 5−99 shows
an example table for the system on page 2−60.

DIA−MNEM DIAMOND CM1 4 DIA−INP DIA−OUT

DIA−ASCI SERIAL CM1 ASC−INP ASC−OUT

1

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 6 KXYZ−LEV

Devices word In Panel Out Panel

KXYZ−LEV

Figure 5−99. Entry for system shown on page 2−60.

Device
Type

The dual entries are necessary because of the two hardware connections.

No “Address” entry is required.

The Input, Output, and Level Sets named on this table should include all inputs, outputs, and levels that will be controlled
by the Diamond switcher. As a precaution, you may wish to restrict control to selected outputs.

For device Type “Diamond,” the Input and Output Sets must be created specifically for use by E−MEM devices. The Input
Set is the source of the mnemonics that will appear on the Diamond console. The Output Set contains a cross−reference be-
tween each router output wired to the DD switcher and a number that the DD will use to refer to that output.
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Notice that device Type “Serial” is used for the “ASCII” protocol connection. For device Type “Serial,” the Input and Output
Sets must be created specifically for use by “serial” devices: the Input Set describes which router inputs can be selected by
the DD (and a number that the DD will use to refer to that input); the Output Set describes which router outputs are wired
to the DD (and a number that the DD will use to refer to that output).

For details concerning CP Input Sets, see page 5−62.

For details concerning CP Output Sets, see page 5−78.

For details concerning CP Level Sets, see page 5−58.
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AUTOMATION CONTROL

Automation control can be implemented with the JupiterXPress application or with the AccuSwitch application. Note that
only one of these applications can be operated in a CM 4000 at one time.

JupiterXPress

Automation control of the JupiterXPress application can be via Jupiter ESswitch protocol (ESW) or the Jupiter ASCII Inter-
face protocol. In either case device type “Serial” is selected on this table.

1

MPK Devices

MPK

AUTOMATN SERIAL

Expansion Pass

CM1

Port

1

AddressDevices word

AUTOIN AUTOOUT AUTOLEV

Figure G−1.

Board Input Sets Output Sets Level Set Overide Set Sequence SetIn Panel Out PanelType

2 AUTOMATN SERIAL CM1 2 AUTOIN AUTOOUT AUTOLEV

3 AUTOMATN SERIAL CM1 3 AUTOIN AUTOOUT AUTOLEV

4 AUTOMATN SERIAL CM1 4 AUTOIN AUTOOUT AUTOLEV

5 AUTOMATN SERIAL CM1 5 AUTOIN AUTOOUT AUTOLEV

6 AUTOMATN SERIAL CM1 6 AUTOIN AUTOOUT AUTOLEV

The Address field should be left blank.

The Input, Output, and Level sets named on this table should include all inputs, outputs, and levels that will be controlled
by the external control computer. As a precaution, you may wish to restrict computer control to selected outputs.

The Input and Output sets must be created specifically for use by “serial” devices. The Level Set must be created as a type
“CP−3000.” For more information about these sets see page 5−58.

Accuswitch

For a discussion of applicable MPK table entries, see Appendix G.
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CP 3830 DUAL CONFIGURATION

Dedicated Output Panel

Dual CP 3830 panels can be configured so that the second panel is always used for output selection. The output panel’s buttons
will glow amber.

MPK bus

CP 3830
“CP3830IN”

CP 3830
“CP3830OU”

Dedicated
output panel

Figure 5−100.CM 4000 
“CM1”

CP3830IN CP−3830 2 00000042

CP3830OU CP−3830 2 00000043

1

MPK Devices

MPK
Expansion

Pass
Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 CM1

KXYZ−INP

KXYZ−OUT KXYZ−LEV

Devices word In Panel Out Panel

KXYZ−LEVKXYZ−OUT

Figure 5−101. Entry for system shown in Figure 5−100.

CP3830IN

Device
Type

CP3830IN

Do the following to connect two CP 3830 panels together with one being an input panel and the other being an output panel:

1. The Expansion box must be unchecked for both the input and output CP 3830.

2. The Output Set should be the same for both panels. The compiler requires the LEV SET field to be defined.

The CP 3830 input panel can be independent of the output CP 3830. The output CP 3830 can still change the output
for the input CP 3830 by selecting the new output name and doing a TAKE.

3. The CP 3830 that is defined as the output panel must have the name of the associated CP 3830 selected in the “In Panel”
field (e.g., CP−3830IN).
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CP 3832 / 3864 MULTI−PANEL APPLICATIONS

Except for unbalanced split§ and type “L”configurations, CP 3832 and CP 3864 panels can be combined to increase the num-
ber of sources and destinations to a maximum of 128 x 128.

SINGLE−BUS APPLICATION

128 X 1 control station

MPK bus

Main
CP 3864

“CP3864A”

Input button 1

Expansion
CP 3864

“CP3864B”

Input button 65

Figure 5−102.

CM 4000 
“CM1”

CP3864A CP−3864 2 00000043 3832−IN MON−1

CP3864B CP−3864 2 00000044

1

MPK Devices

MPK
Expansion

Pass
Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 CM1

KXYZ−LEV

Devices word In Panel Out Panel

Note: Assignment of specific CP sets to a panel
identifies it as the “main” panel, i.e., the panel with
input button number 1.

Figure 5−103. Entry for system shown in Figure 5−102.

CP3864A

Device
Type

In this example, two CP 3864s are being operated as a 128 x 1 control station.

The top CP 3864 has been selected as the “main” panel; therefore it will be assigned to specific CP sets. Enter the name of
the CP Input Set that will be used to assign inputs to all the buttons at this control station (for more information about CP Input
Sets, see page 5−62). In the “Output Sets” column, enter the name of the output to be controlled. The main panel will always
have the lowest−numbered input buttons.

Any panel used to expand the number of inputs (the bottom CP 3864 in this example) will use the “In Panel” column to select
the MPK Device name of the main panel. It would use the CP sets assigned to the main panel. The first expansion panel listed
in this table will have the button numbers immediately following those of the main panel; in this example panel “CP3864B”
will have button numbers 65−128.

MPK Device table entries for other CP 3832/64 applications was discussed on page 5−109 and following.

§ For an overview of CP 3832 / 3864 configurations, see page 2−49.
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X−Y APPLICATION (WITH BALANCED SPLIT PANEL)

48 X 16 control station

Hardware installation was discussed on page 2−49. Figure 5−105 shows an example MPK Devices table for the system in
Figure 5−104.

MPK bus

Input button 17 Expansion CP−3832
“CP3832IN”

Main CP−3832
“CP3832S”

48
sources

16
destinations

Input button 1

Figure 5−104.
CM 4000 
“CM1”

CP3832IN CP−3832 2 00000043

CP3832S CP−3832 2 00000044 3832−IN 3832−OUT

1

MPK Devices

MPK
Expansion

Pass
Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 CM1 KXYZ−LEV

Devices word In Panel Out Panel

Note: Assignment of specific CP sets to a panel
identifies it as the “main” panel; i.e., the panel with
input button number 1.

Figure 5−105. Entry for system shown in Figure 5−104.

CP3832S

Device
Type

In this example, the top CP 3832 is being operated as a source expansion panel. In the MPK table, use the “In Panel” column
to select the MPK Device name of the main panel (the bottom CP 3832 in this example). Any additional source panels would
also refer to the “CP−3832S” in their In  Panel column; they would use the CP sets assigned to the main panel.

The bottom CP 3832 is being operated in split mode, so the “Expansion” box is checked. The CP 3832 is considered to be
the main panel because it is being used in split mode; therefore it will be assigned to specific CP sets. Enter the name of the
CP Input and CP Output Sets that will be used to assign inputs and outputs to all the buttons at this control station. The main
panel will always have the lowest−numbered input buttons.

If additional panels are added to provide more destinations, they would refer to the “CP−3832S” in their Out Panel column.
They would use the CP sets assigned to the main panel. The first expansion panel listed in this table will have the button num-
bers immediately following those of the main panel; the next expansion panel listed will have the next higher set of button
numbers, etc.

The button numbers shown in Figure 5−104 correspond to the row numbers of the CP Input and Output Sets. See page 5−62
(CP Input Sets) and page 5−78 (CP Output Sets). MPK Device table entries for other CP 3832/64 applications was discussed
on page 5−109 and following.
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X−Y APPLICATION (NO SPLIT PANEL)

64 X 32 control station

MPK bus
CM 4000 
“CM1”

Destination Panel
“CP3832”

64
sources

32
destinations

Source (Main) Panel
“CP3864”

Figure 5−106.

CP3864 CP−3864 2 00000043 3832−IN 3832−OUT

CP3832 CP−3832 2 00000044

1

MPK Devices

MPK
Expansion

Pass
Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 CM1

KXYZ−LEV

Devices word In Panel Out Panel

Note: Assignment of specific CP sets to a panel
identifies it as the “main” panel.

Figure 5−107. Entry for system shown in Figure 5−106.

CP3864

Device
Type

In this example, the CP 3864 is being operated as a source and “main” panel and the CP 3832 is being operated as a destination
panel.

The top CP 3864 is considered to be the “main” panel because it controls the inputs; therefore it will be assigned to specific
CP sets. Enter the name of the CP Input and CP Output Sets that will be used to assign inputs and outputs to all the buttons
at this control station. See page 5−62 (CP Input Sets) and page 5−78 (CP Output Sets).

Any additional source panels would refer to the main panel (the CP 3864 in this example) in their In Panel column. They
would use the CP sets assigned to the main panel. The first input expansion panel listed in this table will have the button num-
bers immediately following those of the main panel; the next input expansion panel listed will have the next higher set of
button numbers, etc.

For the CP 3832 in this example, use the Out Panel column to select the MPK Device name of the main panel. If additional
panels are added to provide more destinations, they would also refer to the main panel (the CP 3864) in their Out Panel col-
umn; they would use the CP sets assigned to the main panel. The first output panel listed in this table will have the lowest−num-
bered set of buttons; the next output panel listed will have the next higher set of button numbers, etc.

MPK Device table entries for other CP 3832/64 applications was discussed on page 5−109 and following.
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X−Y APPLICATION (NO SPLIT PANEL)

128 X 128 control station

MPK bus

CP 3864
“P3864Y1”

128
sources

128
destinations

CP 3864
“P3864X2”

CP 3864
“P3864Y2”

Main Panel
CP 3864

“P3864X1”

Input button 1

Input button 65

Output button 1

Output button 65

Figure 5−108.

CM 4000 “CM1”

P3864X1 CP−3864 00000043 3832−IN 3832−OUT

P3864X2 CP−3864 00000044

P3864Y1 CP−3864 00000045

P3864Y2 CP−3864 00000046

1

MPK Devices

MPK
Expansion

Pass
Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 CM1

KXYZ−LEV

3 CM1

4 CM1 2

Devices word In Panel Out Panel

2

2

2

Note: Assignment of specific CP sets to a panel identifies it as the “main” panel,
i.e., the panel with input button number 1. Beyond the main panel, button
numbering depends on the order in which panels are entered on this table.

Figure 5−109. Entry for system
shown in Figure 5−108.

P3864X1

P3864X1

P3864X1

Device
Type

In this example, the top two CP 3864s are being operated as source panels and the bottom two as destination panels.

The “main” panel is always an input panel. In this example, the top CP 3864 has been selected as the main panel and will
therefore be assigned to specific CP sets. Enter the name of the CP Input and CP Output Sets that will be used to assign inputs
and outputs to all the buttons at this control station. See page 5−62 (CP Input Sets) and page 5−78 (CP Output Sets).

Any additional source panels (CP 3864 “P3864X2” in this example) would refer to the main panel (the top CP 3864) in their
In  Panel column. They would use the CP sets assigned to the main panel. The first input expansion panel listed in this table
will have the button numbers immediately following those of the main panel; the next input expansion panel listed will have
the next higher set of button numbers, etc.

All destination panels use the Out Panel column to select the MPK Device name of the main panel; they would use the CP
sets assigned to the main panel. The first output panel listed in this table will have the lowest−numbered set of buttons; the
next output panel listed will have the next higher set of button numbers, etc. MPK Device table entries for other CP 3832/64
applications was discussed on page 5−109 and following.
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CP 3810 APPLICATIONS 

The optional CP 3810 panel can be associated with a CP 3832, CP 3864, CP 3808, or CP 3830, providing control of up to
80 output buses. The CP 3810 can also be assigned to one output, providing breakaway (split) switching and/or multi−level
status.

Multi−Bus Control

In the example shown in Figure 5−110, a CP 3832 is being used to select 32 inputs while the CP 3810 is used to select 80
outputs.

MPK bus

CP 3832
“CP3832”

CP 3810
“CP3810”

32
sources

80 destinations
(8 windows X 10 pages)

Figure 5−110.

CM 4000 “CM1”

CP3832 CP−3832 2 00000043 3832−IN 3832−OUT

CP3810 CP−3810 2 00000044

1

MPK Devices

MPK
Expansion

Pass
Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 CM1

KXYZ−LEV

Devices word In Panel Out Panel

Figure 5−111. Entry for system shown in Figure 5−108.

CP3832

Device
Type

Notice that the Expansion boxes for both panels are unchecked.

Main panel entries — In this example, a CP 3832 is the “main” panel and is therefore assigned specific CP sets. In the “Input
Set” column, enter the name of the CP Input Set that will be used to assign inputs to the main panel (for more information
about CP Input Sets, see page 5−62). In the “Output Set” column, enter the name of the CP Output Set that will be used to
assign outputs to the CP 3810 (for more information about CP Output Sets, see page 5−78).

Note: Even when associated with a CP 3810, the main panel is still configured independently and can be operated
independently. In this example, the CP 3832 will operate as a single−bus control panel (because Expansion  = No).
The CP 3832 will be assigned to the first output listed in CP Output Set “3832−OUT.”

CP 3810 entries — In the “In Panel” column, enter the name of the main panel. CP 3810S (“sticky outputs”) entries are similar
to the CP 3810, except the Device Type is “CP−3810S.”

For operating instructions, see page 6−126.
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Single Bus Control (“CP 3810L”)

In the example shown in Figure 5−112, a CP 3832 is used to select inputs and a CP 3810 is used to control the individual levels
of one output. The CP 3810 can thus be used for breakaway switching.

The corresponding MPK table entries are shown in Figure 5−113.

MPK bus

CP 3832
“CP3832”

CP 3810
“CP3810”

32
sources

Levels for 1
destination

Figure 5−112.

CM 4000 “CM1”

CP3832 CP−3832 2 00000043 3832−IN VT01

CP3810 CP−3810L 2 00000044 CP3832

1

MPK Devices

MPK
Expansion

Pass
Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 CM1 KXYZ−LEV

Devices word In Panel Out Panel

KXYZ−LEV
†

Figure 5−113. Entry for system shown in Figure 5−112.

Device
Type

Notice that the Expansion boxes for both panels are unchecked.

Main panel entries — In this example, a CP 3832 is the “main” panel and is therefore assigned specific CP sets. In the “Input
Set” column, enter the name of the CP Input Set that will be used to assign inputs to the main panel (for more information
about CP Input Sets, see page 5−62). In the “Output Set” column, enter the name of the output that will be controlled.

Note: Even when associated with a CP 3810, the Main panel is still configured independently and can be operated
independently. In this example, the CP 3832 will operate as a single−bus control panel (because Expansion = No).

For the CP 3810, select Device Type “CP−3810L.” Enter the name of the Main panel in the Input Set column.

For operating instructions, see page 6−126.

† Data not used, but entry must be present to satisfy compiler.
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X−Y Application

In the example shown in Figure 5−114, a CP 3864 is used to select inputs, a CP 3832 is used to select outputs, and a CP 3810
is used to control/status the individual levels of the output selected by the CP 3832. The CP 3810 can thus be used for break-
away switching.

CP 3832
“CP3832”

CP 3810
“CP3810”

32
destinations

64
sources

STATUS
of individual levels

CP 3864
“CP3864”

MPK bus Figure 5−114.

CM 4000 “CM1”

CP3832 CP−3832 2 00000044

CP3810 CP−3810L 2 00000045

CP3864 CP−3864 2 00000043 3832−IN 3832−OUT1

MPK Devices

MPK
Expansion

Pass
Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 CM1

KXYZ−LEV

3 CM1 KXYZ−LEV

Devices word In Panel Out Panel

†

Figure 5−115. Entry for system shown in Figure 5−108.

CP3864

CP3864

Device
Type

Notice that the Expansion boxes for all panels are unchecked.

Main panel entries — In this example, a CP 3864 is used to select inputs and is therefore the “main” panel. As such, it is as-
signed specific CP sets, as follows: In the “Input Set” column, enter the name of the CP Input Set that will be used to assign
inputs to the main panel (for more information about CP Input Sets, see page 5−62). In the “Output Set” column, enter the
name of the CP Output Set that will be used to assign Outputs to the destination panel CP 3832 (for more information about
CP Output Sets, see page 5−78).

Destination panel entries — In the Out Panel column, select the name of the main panel.

CP 3810 entries — Select “CP 3810L” as the device type. In the In Panel column, select the name of the main panel.

For operating instructions, see page 6−126.

† Data not used, but entry must be present to satisfy compiler.
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Single Bus Status Only (Stand−alone) (“CP−3810L”)

In this mode, the panel is configured to status a single output. No other panel is associated with the panel. and there is no
switcher control. An example entry is shown in Figure 5−117.

MPK bus

CP 3810
“CP3810”Levels for 1

destination

Figure 5−116.

CM 4000 “CM1”

CP3810 CP−3810L 2 00000044 3832−IN VT01 KXYZ−LEV1

MPK Devices

MPK
Expansion

Pass
Board

CM1

Port Address Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out Panel

Figure 5−117.

Device
Type

Select “CP−3810L” as the device Type. In the Output Set column, enter the name of the output to be statused.

For operating instructions, see page 6−126.
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Machines

1

Machines

2

VT01 Sony Mch CM1 1

VT05 Sony Mch CM1 7

Figure 5−118. Machines table for system shown on page 5−137.

Name Type Board Port AddressMachine Device

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

This table is the source for information about machines using Sony serial protocol. Data entered here is automatically made
available on the Machine Control table.§

Important: Row numbers on Jupiter tables are used as the “logical” numbers for devices. Changing the row num-
ber of an existing device (by inserting/deleting a device in the middle of the table, for example) will disrupt con-
trol of the machine, requiring linkages to be reestablished. One way to avoid this interruption is to add new de-
vices at the end of tables.

Name This column lists the device names of all serial control machines in the system. 

This is the source for machine names that appear on the control panels. Although this field will accept eight
characters, you may wish to limit machine names to four since that is the maximum that can be displayed on
the MC 3000’s expansion panel.

§ Some of the functions described in this section may be extra−cost options. For more information, see page 1−27.
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Type Device types (shown on a pull−down menu) are limited to the following:

� Sony machine serial protocol

� Ampex machine serial protocol†

Board Select the name of controller board connected to this machine. The source of these names is the Net-
work Description table (page 5−27).

Port Number of controller board port connected to this machine. The port must support the necessary proto-
col for this machine (as configured on the Serial Protocol table, page 5−30).

Address  (hex) Unique serial data bus ID used to select and service this machine, entered in hexadecimal.
(Not to be confused with LAN address entered on Network Description table shown on page 5−27.)

VTR addresses

— not required for Sony “serial” VTRs (as listed on page 2−61).

† Not supported by Jupiter XPress application.
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Sony Mach “VT01”
Address: none

CP with EXP. “TAPECP”
Address: 00000008 hex

MC with EXP. “TAPEMC”
Address: 00000016 hex

MPK protocol

Sony protocol

Figure 5−119. VTRs as listed in Machines table on page 5−135.
(Machine control panels are listed in MPK table on page 5−107.)

Sony Mach “VT05”
Address: none

CM 4000 “CM1”

Sony protocol
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Machine Control

Figure 5−120. 

1

Machine Control

Device Name Device Type Delegation In/Out Associated

2

TAPEMC MC−3000E Out PRDA

3

Mnemonic

TAPEMC

VT01 Sony Mch In VT01

VC01 Sony Mch In VC01

VC02 Sony Mch In VC02

4

Group Name

VT01

VC01

VC02

TAPEMC MC−3000E Out PRDBTAPEMC5

TAPEMC MC−3000E Out PRDCTAPEMC6

TMC3010 MC−3010 Out PRDXTMC30107

Preroll

2

2

2

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

This table is used to associate machines, machine controls, and router inputs/outputs in order to provide automatic machine
assignment functionality (“control follows video”).§ It is also used when a PC is used as a Software Control Panel.† 

Important:  Row numbers on Jupiter tables are used as the “logical” numbers for devices. Changing the row num-
ber of an existing device (by inserting/deleting a device in the middle of the table, for example) will disrupt con-
trol of the machine, requiring linkages to be reestablished. One way to avoid this interruption is to add new de-
vices at the end of tables.

§ Some of the functions described in this section may be extra−cost options. For more information, see page 1−27.
† Applies only when the Software Control Panel is used for machine control. For more information, see Section 7.
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Device Name Device Type     These columns repeat the descriptions of all machines (as entered on
the Machines table, page 5−135) and machine control panels (as entered on the MPK Devices table, page
5−107).

Mnemonic
Use of this column varies according to the device type. 

For machines, this entry will appear on the panel controlling the machine:

� For a serial control machine, the Mnemonic is always the same as the Device Name.

For control panels, the Mnemonic column is used only as a comment field.

Delegation
Group

  This entry can be used to permanently assign a machine to a specific group of control panels. For
more information, see page 5−149.

Associated
Name

In/Out
  These entries are required for the machine assignment system to function, whereby

machine control “follows” the routing switcher.

For machines, the entry in the In/Out column is always “In.” The Associated Name will be selected from a list
of all router inputs (source = Switcher Input table, page 5−48). For a discussion of Associated Name entries,
please see Assigning Machines to Control Panels starting on page 5−141.

For a CP 3000E, CP 3800, or CP 3810, the entry in the In/Out column is “Out.” The Associated Name col-
umn is left blank.

For a complete description of MC 3000 and MC 3010 entries, please see Assigning Machines to Control
Panels starting on page 5−141.

Preroll Number of seconds needed by this machine to come up to speed following a Play command. Most
machines will lock up in one second or less; two seconds is often used as a preroll value to provide a safety
margin. This value is used by the MC 3000 Machine Control Panel.

The MC 3000 uses this setting during Mark/Search operations. When SET MARK is pressed, the present
time code is stored; when SEARCH MARK is pressed, the machine will move the tape to that point minus the
preroll value. If there is no entry to the Machine Control Devices table, a two−second preroll will be used
automatically.

For more information, see page 6−132 and Appendix E.

SATURN MASTER CONTROL SWITCHER

Saturn machine control configuration instructions are described in the Saturn Installation and Operating manual. 
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ASSIGNING (LINKING) MACHINES TO CONTROL PANELS

The Jupiter system has an automatic machine assignment function, whereby control of a VTR is linked to a remote panel based
on the VTR being switched to a destination associated with that panel. In other words, machine control follows the routing
switcher.

Note 1: The GUI machine control panel, if installed in the system, bypasses the machine linkage process described
below.

Note 2: As described on page 5−147, it is possible to link machines to control panels even if those machines do not
pass through the routing switcher. However, this will still require an understanding of the “follow−the−switcher”
technique described below.

Note 3: As a further variation, the “follow switcher” scheme can be bypassed entirely, with machines assigned by
default to specific control panels on a semi−permanent basis. See page 5−146.

Summary of linkage system setup:

• The switcher inputs, outputs, category names/numbers, etc. must already be established.

• Each machine must be connected to a CM 4000 System Controller and the protocol for the bus leading to the
machine established. See page 5−142 for an example system.

• All machine control panels are described. In most cases, this is done using the MPK Devices table.

• The device names of all VTRs must be established on the Machine table (page 5−135).

• The Machine Control table is then used to associate machines and control panels to the router:

— The table must show the names of the routing switcher outputs which are wired to the destination (a pro-
duction switcher, in this example) that is associated with a particular machine control panel.

— The table must include the routing switcher input  names associated with each VTR.

The linkage setup procedure is described in detail on the following pages.
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Figure 5−121. Example of machine control linkage. Equipment shown here corresponds to table shown in Figure 5−122.

VT01 VC01 VC02

PRDC

PRDB

PRDA

Production switcher 1

A B C D

“VT01”

“VC01”

“VC02”

Routing
Switcher

“TAPEMC”

MC−3000

CP−3000

VC01VT01

Button groups

video and audio

control lines

software links

Input names

Output names

VC02

MC−3010

“TMC−3010”

Production switcher 2

X Y Z

PRDX

31 2 6

Serial Ports

CM 4000 System Controller “CM1”
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EXAMPLE OF MACHINE CONTROL TABLES SETUP

1

Machine Control

Device Name Device Type Delegation In/Out Associated

2

TAPEMC MC−3000E Out PRDA

3

Mnemonic

TAPEMC

VT01 Sony Mch In VT01

VC01 Sony Mch In VC01

VC02 Sony Mch In VC02

4

Group Name

VT01

VC01

VC02

1

Machines

2

VT01 Sony Mch CM1 1 2

VC01 Sony Mch CM1 2 2

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 TMC3010 MC−3010 CM1 6 00000029

Devices word In Panel Out Panel

1 TAPEMC MC−3000E CM1 6 00000016

3 VC02 Sony Mch CM1 3 2

TAPEMC MC−3000E Out PRDBTAPEMC5

TAPEMC MC−3000E Out PRDCTAPEMC6

TMC3010 MC−3010 Out PRDXTMC30107 Figure 5−122.

Device
Type

Name Type Board Port Address Preroll
Machine Device

The Machine Control table shown in Figure 5−122 corresponds to the system shown in Figure 5−121. The applicable entries
in the MPK Devices and Machines tables are shown for reference.

The “Associated Name” is the name of the routing switcher input or output to be associated with this particular device.

The first three rows show the names of the machines in the system and the associated routing switcher input names.

The next three rows (4, 5, and 6) relate to the SELECT buttons on the MC 3000 expansion panel; the order of entry on this
table will be the same as the order of buttons on the panel. In this example, we want the first SELECT button to be assigned
to whatever VTR is feeding routing switcher output “PRDA;” this is the output that feeds input A of the production switcher.
Associated names are also entered for the following two SELECT buttons: “PRDB” and “PRDC.”

The next row (7) is similar to the entries just described, but pertains to the MC 3010 Dual 4 Machine Control panel. Again,
the order of entry on this table will be the same as the order of button groups on the panel.

Given this table, Figure 5−121 shows what will happen when the indicated routing switcher crosspoints are closed. For exam-
ple, the VTR “VT01” is shown switched to input A of the production switcher; that is, routing switcher input VT01 has been
switched to output PRDA. The system will locate these two input/output names in the Machine Control table and find that
control of VT01 must be assigned to the first SELECT button on the MC 3000 expansion panel. The device name and status
for VT01 will be sent to the status displays indicating that control of the machine is now linked to this panel. (A detailed view
of the MC 3000 expansion panel displays is shown in Figure 5−123.)
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OPERATIONAL SEQUENCE FOR LINKAGE

Figure 5−123 shows a detailed view of the CP 3000 and MC 3000 control panels previously shown in Figure 5−121 and listed
in Figure 5−122.

The objective in this example is to use the CP 3000 switcher control panel to assign VTR “VT01” as the “A” input to the
control room’s production switcher, and thereby link the machine to the MC 3000 Machine Control Panel.

For this discussion, it is assumed that switcher output PrdA has already been assigned to the first TAKE key of the CP 3000
expansion panel (the output assignment procedure is described on page 6−24).

[1] SELECT source. The operator presses “VTR,” then “1” on the CP 3000.

[2] TAKE to destination. Operator selects production switcher input “A” as the destination by pressing the first TAKE key
on the expansion panel.

 This will cause two things to happen:

— The VTR will be switched into the production switcher as “input A”, and the CP 3000 expansion panel will
show the display mnemonic for the VTR (“VT01”) in the status window.

— The system will check the Machine Control table (Figure 5−122) to see what control panel is associated with
the production switcher. At this point the link is established: the device name of the VTR, which is  “VT01,”
appears over the first SELECT button on the expansion panel next to the MC 3000 machine control panel, and
the status of the machine appears as well.

[3] The START and STOP buttons (immediately below the device name) can now be used to operate VT01. Or:

[4] Press SELECT key to assign control of the VT01 to MC 3000 panel to the left.

The full status of VTR VT01, including time code, will appear in the MC 3000 display window.

[5] CONTROL all functions of  VT01 using MC 3000.

If a different VTR is switched to production switcher input A, control of the new VTR will be brought to the MC 3000 machine
control panel at the same time. In other words, no matter what VTR is selected as input “A,” a control command entered on
the first button group of the expansion panel will be sent to the correct VTR.

It should be noted that this is the only way to gain control of a machine: it must be done by first selecting the machine with
the switcher. This is true even if the machine does not actually pass through the switcher, as described on page 5−147.
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CP−3000 Switcher control

Expansion panelMC−3000 Machine control

Expansion panel

SELECT source

TAKE to
destination

CONTROL all functions of machine
selected by expansion panel

Production switcher

A B C

A B C

VT01
PrdA

VC01
PrdB

Identifies machines selected as
sources for production switcher

A B C

START and
STOP machine

SELECT machine
to be controlled by
MC−3000. Note
asterisk next to
machine name

Machine control linkage
follows routing switcher

VC02
PrdC

STOP
VC01

STOP
VC02

Switcher input name

Switcher output nam

Status
Machine name

STOP

VT01

CAT=VTR  SELECT=VT01
VT01 VT01 VT01 VT01

 00:54:49:11 T1
 VT01       STOP MAN

Figure 5−123. Example of automatic machine linkage sequence. Please see page 5−144 for discussion.

[1]

[2]

[3][4]

[5]
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DEFAULT (SEMI−PERMANENT) LINKAGE

Using the file server, machines can be linked directly to a specific control panel on a semi−permanent basis. An example sys-
tem is shown in Figure 5−124. In this arrangement, only the file server can re−assign control of a machine to another panel.
In other words, the normal linkage function (where machine control follows the routing switcher) is bypassed. The entries
needed on the Machine Control table are shown in Figure 5−125.

“VT01”

“VC01”

“VC02”

“TAPEMC”

MC−3000

VC02VC01VT01

SELECT buttons
control lines

software links established
by file server

Figure 5−124. Default machine control linkage.

31 2 6

Serial Ports

CM 4000 System Controller “CM1”

Figure 5−125. Default linkage entries
for system shown in Figure 5−124.

1

Machine Control

Device Name Device Type Delegation In/Out Associated

2

TAPEMC MC−3000E Def VT01

3

Mnemonic

TAPEMC

VT01 Sony Mch In

VC01 Sony Mch In

VC02 Sony Mch In

4

Group Name

VT01

VC01

VC02

TAPEMC MC−3000E Def VC01TAPEMC5

TAPEMC MC−3000E Def VC02TAPEMC6
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LINKAGE FOR MACHINES THAT DO NOT ENTER THE ROUTING SWITCHER

In some cases, machines may be wired directly to one destination, or to several destinations through distribution amplifiers
only (see Figure 5−126). Although these machines do not pass through the routing switcher, it is still possible to use switcher
control panels to establish linkages. In order to do this, imaginary switcher input and output names must be used as pointers
on the Machine Control menu. These names, along with imaginary physical I/O numbers, must be entered on the Switcher
Input and Output tables (pages 5−48 and 5−55). Also, the physical I/O numbers must be within the size range set on the
Switcher Description menu (page 5−35).

Figure 5−126. Machine control linkage in system without routing switcher.

PRDC

PRDB

PRDA

Production switcher

A B C D

“VT01”

“VC01”

“VC02”

“TapeMC”

MC−3000

CP−3000

VC02VC01VT01

SELECT buttons

video and audio

control lines

software links

Imaginary routing
switcher input

names

Imaginary routing
switcher output

names

VC02

VC01

VT01

31 2 6

Serial Ports

CM 4000 System Controller “CM1”
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START/STOP MACHINE CONTROL USING EXPANSION PANELS

The CP 3010 expansion panel and the CP 3810 expansion panel can be used as a limited−function machine control panels,
providing Start and Stop commands for VTRs.

When the CP 3010 is used as an expansion panel for a CP 3000 control panel, Start/Stop machine control is provided by the

 and >  buttons. When the CP 3810 is used as an expansion panel, Start/Stop machine control is provided by the  PLAY/
STOP buttons. In both cases, machine control will require the following:

— The switcher level that is checked as the “MC” level on the Switcher Description table (page 5−35) must be the
same as the first level shown in the CP Level set (page 5−58) that is assigned to the CP 3000 (or to the main
panel paired with the CP 3810) on the MPK Devices table (page 5−107). For example, the Video level would be
checked as the “MC” level, “Video” would appear as the first level in the CP Level set, and this CP Level Set
would be assigned to the main panel on the MPK Devices table;

and:

— The machine control buttons on the expansion panel must be assigned to the desired VTR by a process similar
to that described beginning on page 5−141.

VGA / MC 3000 STATUS DISPLAY TABLE ENTRIES

Use of control panels with the VGA Status Display requires entries to the MPK Devices table, as described on page 5−114.

For an MC 3000 to display time code it would have to be linked to the machine exactly as any other MC 3000. This would
require the following:

• Use of an “optional entry”on the Machine Control table, such as that shown in Figure 5−127. The Associated
Name could be the name of the switcher output connected to a nearby monitor.

• The switcher control panel would be used to switch video from the machine to the Associated output (the
nearby monitor, in this example). This would establish the link. Full status from the machine, including time
code, would then appear in the MC 3000 display window.

1

Machine Control

Device Name Device Type Delegation In/Out AssociatedMnemonic

VMC VMC−3000 Out VGMon

Group Name

VMC

Optional entry

Figure 5−127.

SATURN MASTER CONTROL SWITCHER

Saturn machine control configuration instructions are described in the Saturn Installation and Operating manual.
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Delegation Groups

1

Delegation Group

Name

STU

2 ENG

3 TAPE

4

Figure 5−128. Delegation groups menu (example).

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

The Delegation Groups menu, in conjunction with the Machine Control menu, can be used to restrict control of machines
to a particular panel or group of panels. The Delegation Groups menu is used to establish group names.

PERMANENT DELEGATION

To assign a machine to a particular control panel on a permanent basis, use the Machine Control menu to enter the group name
of the panel in the “Delegation Group” column for the machine.

2

Machine Control

Device Name Device Type Delegation In/Out Associated

3

4

Mnemonic

VT01 Sony Mch STU In VT01

VC01 Sony Mch STU In VC01

VC02 Sony Mch STU In VC02

Group Name

VT01

VC01

VC02

STUMC MC−3000 STU InSTUMC1

Figure 5−129.

In this example (Figure 5−129), all three Sony machines have been permanently assigned to the “STU” MC 3000.

Important:  The delegation system requires all control panels to be assigned to a group. Any control panel not
assigned to a group will continue to have access to all machines, even if those machines have been assigned to a
group.
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Status Display Headers

Thomson            WXYZ TELEVISION FACILITY CONTROL SYSTEM              PAGE: 00
May 10, 1999                   SWITCHER STATUS                          12:34:56
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
OUTPUT      VIDEO     LEFT     RIGHT    TC
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
PRDA        VT01      VT01     VT01     VT01
PRDB        VC01      VC01     VC01
PRDC        VTR1      VTR1     VTR1
PRDD        CAM1      ANN1     ANN1
VTR1        VTR2      VTR2     VTR2
VTR2        SAT1      SAT1     SAT1     SAT1
VTR3        CON2      CON2     CON2
VTR4        TST4      TST4     TST4
STUA        BARS      TONE     TONE
STUB        CAM1      CAM1     CAM1
STUC        STUA      STUA     STUA
CON1        VTR5      VTR5     VTR5     VTR5
CON2        CG02      CRT2     CRT2
CON3        CAM3      VC09     VC09
SAT1        CONA      CONA     CONA
SAT2        NET       NET      NET
SAT3        ENG2      ENG2     ENG2
SAT4        TSTB      TSTB     TSTB VGA Status Display

1

Header

WXYZ TELEVISION FACILITY CONTROL SYSTEM

Figure 5−130. Status display headers table (example).

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 
VGA Status Display 5−151

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

This table is the source of the header that appears centered at the top of the VGA Status Display pages. Up to 60 characters
can be entered. Only the entry on Row 1 is used.

For more information about the VGA Status Display, see Appendix A.

Note: This table was originally designed for use during configuration of the VG 3000 Video Display / Status Gen-
erator, which is no longer available (the functionality of the VG 3000 has been replaced by the VGA output of the
VM 3000 and CM 4000). For more information about the VG 3000 Video Display / Status Generator, please con-
tact Grass Valley.
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VGA Status Display Table

1

VGA Status Display Table

Board

CM1

Page File Name

VGA01

Video Mode

VC8

2

Figure 5−131. VGA Status Display table (example).

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display

Tally 5−152

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

This table is used when a VGA status display is installed.

Board is the name of the CM 4000 providing the VGA output. This must be the same as the name already entered on the
Network Devices table.

Page File Name is the source of the name of the file that will be created when the “Tools > Generate VGA Files” command
is run.

Note: The “Generate VGA Files” command is designed for use during initial installation only—it always uses the
original factory default settings when building the Page Description file. If you decide to modify your VGA dis-
play with custom formatting, do not  re−run the Generate VGA Files command. If you do, your modifications will
be overwritten.

Video Mode allows selection of color or black and white. When “Color 80” is selected the table will display “VC8;” when
“B/W 80” is selected the display will be “VB8.”

For details concerning VGA hardware installation and software configuration, please refer to Appendix A.
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Tally

RELAY DESCRIPTION

Figure 5−132. Tally Relay description table.

1

Tally Relay

Tally Device

TALLY1

Relay

0

Logical Input

VT01

2

3

TALLY1 1 VC02

TALLY1 2 VC01

4

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

An overview of Jupiter tally and a discussion of hardware installation can be found on page 2−67.

Note: The Jupiter Tally software package described here cannot tally sources that are wired directly to a Saturn
internal matrix. If the Saturn is equipped with an internal matrix, the Saturn Tally system is available (but cannot
be connected to the Jupiter Tally system). Please refer to the Saturn installation/operating manual for additional
information.

The Relay Description table must be used when an MI 3040 has been configured to operate as a “MI 3040/T,” i.e., for operation
with tally lamps. The Tally Dependency table must also be used (page 5−158 ).

The table has a one−row entry for each of the tally lights in the system. The entry shows the name and relay number of the
MI 3040 connected to each light; the source of this name is the MPK Devices table (page 5−115). Each relay is associated with
the name of a routing switcher input, so that whenever that input is switched to air the relay will close. The source of the
switcher input names is the Switcher Input table (page 5−48).

§ Some of the functions described in this section may be extra−cost options. For more information, see page 1−27.
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Figure 5−133 shows a tally system with a Jupiter−controlled routing switcher, a Saturn (or non−Saturn) master control
switcher, and a direct feed to the transmitter. The corresponding Tally Relay Descriptions table is also shown. Notice that the
table remains the same whether or not a Saturn master control switcher is used.

Figure 5−134 shows a system with a Jupiter−controlled routing switcher, Saturn (or non−Saturn) master control, and a produc-
tion switcher. The master control switcher is connected directly to the transmitter. The corresponding Tally Relay Descrip-
tions table is also shown. Notice that the table remains the same whether or not a Saturn master control switcher is used.

Figure 5−135 shows a system in which the master control switcher is connected to the transmitter indirectly, i.e., by re−entry
through the routing switcher. Again, the figure includes the corresponding Tally Relay Descriptions table. In this case, a tally
light for the master control switcher must be identified in the table (but not necessarily installed, as described previously).

The table is also used for systems with SlimLine (and RP 1/2/3) Status Displays, when an MI 3040 is being used to trace inputs
back through a production switcher. See page 5−121.

Figure 5−136 shows a system with SlimLine Status Displays when the front panel tally lights are used. The Tally Relay De-
scription table must include a one−row entry for each tally light pair. The source for the “Name” is the MPK Devices table
(page 5−94); the “Relay” entry is always “1” and the “Switcher Input” number is an existing switcher input name as defined
on the Switcher Input table (page 5−48). The “Switcher Input” entry is not actually used, but to satisfy the compiler a name
must be entered which is unique within this table.

In all cases, the Tally Dependency table must also be completed, as described on page 5−158.
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MPK bus

MI−3040/T
“TALLY1”

Relays
Video and audio

Jupiter control lines

Routing
switcher

 Tally light

Master control switcher

VC02 VT01VC01

20 1

Input names

Tally Device Relay Logical Input

1 TALLY1 0 VT01
2 TALLY1 1 VC02
3 TALLY1 2 VC01

Tally Relay

Transmitter

ÏÏÏÏÏÏÏÏÏÏ

ÏÏ
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Figure 5−133. Tally system with Jupiter−controlled
router, Saturn (on non−Saturn) master control, and di-
rect feed to transmitter. Equipment shown corresponds to
table at left.
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MPK bus

MI−3040/T
“TALLY1”

Relays
Video and audio

Jupiter control lines

Routing
switcher

Production switcher

 Tally light

Master control switcher

VC02 VT01PRD VC01

20 1 3

Input names

Tally Device Relay Logical Input

1 TALLY1 0 VT01
2 TALLY1 1 VC02
3 TALLY1 2 VC01
4 TALLY1 3 PRD

Tally Relay

Transmitter

Ï
Ï
ÏÏ
ÏÏ
Ï
Ï
Ï
Ï

ÏÏÏ
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Figure 5−134. Tally system with Jupiter−controlled router, Saturn
(or non−Saturn) master control, production switcher, and direct
feed to transmitter. Equipment shown corresponds to table at left.
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MPK bus

MI−3040/T
“TALLY1”

Relays

Transmitter

Video and audio

Jupiter control lines

Routing
switcher

Production switcher

 Tally light

Master control switcher

VC02 VT01PRD MCSVC01

20 1 3 4

Input names

Tally Device Relay Logical Input

1 TALLY1 0 VT01
2 TALLY1 1 VC02
3 TALLY1 2 VC01
4 TALLY1 3 PRD
5 TALLY1 4 MCS

Tally Relay

Ï
Ï
ÏÏ
ÏÏ
Ï
Ï
Ï
Ï

ÏÏÏ

Ï
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Ï
Ï
Ï
Ï
Ï
Ï
Ï
ÏÏÏÏÏÏÏ
ÏÏ
Ï
Ï
Ï
Ï
Ï
Ï
ÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏ
Ï
ÏÏÏÏÏ
ÏÏ
ÏÏÏÏÏÏ

ÏÏÏÏÏÏÏ

ÏÏÏÏÏÏ

ÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏ

ÏÏÏÏÏÏÏÏÏÏ

ÏÏÏÏÏÏÏ

ÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏÏ ÏÏ
ÏÏ
Ï
Ï
ÏÏÏÏÏÏÏÏÏÏÏÏÏ
Ï
ÏÏÏÏÏ

Ï

Figure 5−135. Tally system with Jupiter−controlled router, Saturn
(or non−Saturn) master control, production switcher, and indirect
feed to transmitter. Equipment shown corresponds to table at left.
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MPK bus

MI−3040/T
“TALLY1”

Relays

Transmitter

Video and audio

Jupiter control lines

Routing
switcher

Production switcher

 Tally light

Master control switcher

VC02 VT01PRD MCSVC01

20 1 3 4

Input names

Tally Device Relay Logical Input

1 TALLY1 0 VT01
2 TALLY1 1 VC02
3 TALLY1 2 VC01
4 TALLY1 3 PRD
5 TALLY1 4 MCS
6 UMDSD1 1 111
7 UMDDD1A 1 222
8 UMDDD1B 1 333

Tally Relay
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M/E 3

M/E 2

M/E 1

“UMDSD1”
“UMDDD1A”

Figure 5−136. SlimLine tally system with Jupiter−controlled router,
Saturn (or non−Saturn) master control, production switcher, and indirect
feed to transmitter. Equipment shown corresponds to table at left.

CM 4000 “CM1”

“UMDDD1B”

SlimLine Controller
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TALLY DEPENDENCY

Figure 5−137. Tally Dependency table (example).

1

Tally Dependency

Tally Device

MCS_TLY

Opto

0

Logical Output

MAIN−A

Tally

2

3

MCS_TLY 1 MAIN−B

MCS_TLY 2 KEYINS1

4

5

MCS_TLY 3 KEYINS2

MCS_TLY 4 MIXINS1

6 MCS_TLY 5 MIXINS2

7 MCS_TLY 6 BYPASS

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 

Path Finding 5−174

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

OVERVIEW

This table must be used when an MI 3040 has been configured to operate as a “MI 3040/T,” i.e., for operation with tally lamps.
The Tally Relay table must also be used (page 5−152).

Note 1: The Jupiter Tally system described in this manual cannot tally sources that are wired directly to a Saturn
internal matrix. If the Saturn is equipped with an internal matrix, the Saturn Tally system is available (but cannot
be connected to the Jupiter tally system). Please refer to the Saturn Installation and Operating Manual for addi-
tional information.

Note 2: The Tally Dependency table is also used for systems with under monitor status displays, when input mne-
monics must be tracked back through a master control or production switcher. See page 5−96.

The table has two basic purposes: first, to establish the identity of the main output of the system (the output being fed by the
tallied source); and second, to allow the Jupiter system to track sources through switchers other than the routing switcher.

Whatever source is feeding the main output (usually a transmitter) is tallied. When the main output is fed directly from the
routing switcher, it is referred to as an unqualified output; a sample entry is shown in Figure 5−138.

Figure 5−138. Entry used when main output is fed by router.

1

Tally Dependency

Tally Device Opto Logical Output

XMIT

Tally

2
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If the main output is fed from a switcher other than the router (such as a master control switcher), then the main output is not
identified as such. Instead, the names of all possible routing switcher outputs that could be selected for the main output are
listed (“Output” column in Figure 5−139). In this case, the master control switcher must tell the Jupiter system which routing
switcher output has been selected; this is done by energizing the appropriate opto−isolator (“Name/Opto” columns).

Figure 5−139. Entry used when main output is fed by
switcher other than router.

1

Tally Dependency

Tally Device

MCS_TLY

Opto

0

Logical Output

MAIN−A

Tally

2 MCS_TLY 1 MAIN−B

3 MCS_TLY 2 KEYINS1

4 MCS_TLY 3 KEYINS2

5 MCS_TLY 4 MIXINS1

6 MCS_TLY 5 MIXINS2

7 MCS_TLY 6 BYPASS

There may be additional switching layers other than the router (such as a production switcher). In this case, the system must
be able to determine (a) whether the switcher is on the air, and if it is, (b) which routing switcher output has been selected.
An entry to the “Tally” column (Figure 5−140) will identify the tally light associated with the switcher; if the light is on, then
the switcher is on the air. If it is on the air, the opto−isolators will be checked to find out which router output has been selected.

Figure 5−140. Additional switcher entries.

1

Tally Dependency

Tally Device

TALLY1

Opto

0

Logical Output

PROD1

Tally

TALLY1 /3

2 TALLY1 1 PROD2 TALLY1 /3

The source of the Tally column data (name of MI 3040 / relay number connected to each tally light) is the Tally Relay table
(page 5−152).

Entries for specific systems are shown below; this is followed by a detailed example of system operation.
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BASIC TALLY SYSTEM WITH SATURN MASTER CONTROL SWITCHER

Direct Connection to Transmitter

Please see Figure 5−142.

This table has only one type of entry: MCS_TLY.

Saturn (“MCS_TLY”) entries

These entries are used in systems equipped with a Saturn Master Control Switcher (or BTS MCS 2000). They allow
the Jupiter system to find out which of the sources feeding the master control switcher have been switched to the MCS
“On−air” output. There are always five entries for the MCS 2000, one for each of the five inputs from the routing
switcher. For the Saturn, there are seven entries.

The source of the Name used here is the MPK Devices table (for discussion, see page 5−115). As a convention, the name
“MCS_TLY” is used.

The Opto−isolator number entries must be assigned as follows:

Figure 5−141. Additional switcher entries.

MCS_TLY
Opto−isolator no.

Assigned to
MCS 2000 input

Assigned to
Saturn input

0 Input 1 BKGDA

1 Input 2 BKGDB

2 Key 1 KEY 1

3 Key 2 KEY 2

4 −−− MIX 1

5 −−− MIX 2

6 Bypass BYPASS

Note 1: The device called “MCS_TLY” and the “opto−isolators” associated with it exist only in software ta-
bles.

Note 2: There are no entries for MCS 2000 Mix 1 and Mix 2 (these are audio inputs). If the MCS 2000 is
mixing or keying, then both the mix source and the key source will be tallied by the Jupiter system.

The Switcher Outputs are the names of the five router outputs leading to the master control switcher. The source of
the switcher output names is the Switcher Output table (page 5−55).

The MCS_TLY entries do not include a dependency on a relay, since no tally light is associated with the master control
switcher. (There is no tally light because in this system the master control switcher is always on−air.) The last two col-
umns are therefore left blank.
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KEY 1 KEY 2BKGDA BKGDB BYPASS

Video
router

BUS INPUTS

000

MAIN−B001

KEYINS1002

KEYINS2003

BYPASS004

MIX 1 MIX 2MAIN A MAIN B BYPASS

Audio
router

BUS INPUTS

MAIN−A000

MAIN−B001

MIXINS1002

MIXINS2003

BYPASS004

L RL R L R L R L R

ISO1 ISO2

ISO 1005

ISO 2006

MAIN−A

Saturn audio processorSaturn video processor

Transmitter

Tally Device Opto Logical Output Tally

1 MCS_TLY 0 MAIN−A
2 MCS_TLY 1 MAIN−B
3 MCS_TLY 2 KEYINS1
4 MCS_TLY 3 KEYINS2
5 MCS_TLY 4 MIXINS1
6 MCS_TLY 5 MIXINS2
7 MCS_TLY 6 BYPASS

Tally Dependency

Physical
Output

Output
name

Figure 5−142. Example tally system with Jupiter−controlled
router (Venus), Saturn master control, and direct feed to
transmitter. Equipment shown corresponds to table at left.
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Indirect Connection to Transmitter

Please see Figure 5−143.

There are two types of entries on this table: an unqualified output entry and MCS_TLY entries.

Unqualified output

This is the name (“XMIT”) of the routing switcher output leading to the transmitter (or the name of the output leading
to the primary program line). All sources switched to this output will be tallied. The rest of the row remains blank. There
can be more than one unqualified output if desired.

Saturn (“MCS_TLY”) entries

Entries are similar to those already described (page 5−164) except for the last two columns. Since the master control
switcher is connected indirectly to the transmitter (by re−entry through the routing switcher), each entry must include
the Name of the MI 3040/T and the relay Number associated with the master control switcher’s tally light.
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Saturn audio processorSaturn video processor

Transmitter

Tally Device Opto Logical Output Tally

1 XMIT
2 MCS_TLY 0 MAIN−A TALLY1 /4
3 MCS_TLY 1 MAIN−B TALLY1 /4
4 MCS_TLY 2 KEYINS1 TALLY1 /4
5 MCS_TLY 3 KEYINS2 TALLY1 /4
6 MCS_TLY 4 MIXINS1 TALLY1 /4
7 MCS_TLY 5 MIXINS2 TALLY1 /4
8 MCS_TLY 6 BYPASS TALLY1 /4

Tally Dependency

XMIT007

XMIT007

MI−3040/T
“TALLY1”

Relays

20 1 3 4

Audio
router

Video
router

Physical
Output

Output
Name

Figure 5−143. Example tally system with Jupiter−controlled
router (Venus), Saturn master control, and indirect feed to
transmitter. Equipment shown corresponds to table at left.
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CONFIGURATION FOR SYSTEMS WITH SATURN MASTER CONTROL SWITCHER AND 
PRODUCTION SWITCHER

Direct Connection to Transmitter 

Please see Figure 5−145.

There are two types of entries on this table: MCS_TLY entries; and production switcher entries. There is no unqualified output
entry.

Saturn (“MCS_TLY”) entries

These entries are used in systems equipped with a Saturn Master Control Switcher (BTS MCS 2000). They allow the
Jupiter system to find out which of the sources feeding the master control switcher have been switched to the “On−air”
output. There are always five entries for the MCS 2000, one for each of the five inputs from the routing switcher. For
the Saturn, there are seven entries.

The source of the Name used here is the MPK Devices table (for discussion, see page 5−115). As a convention, the name
“MCS_TLY” is used.

The Opto−isolator number entries must be assigned as follows:

Figure 5−144.

MCS_TLY
Opto−isolator no.

Assigned to
MCS 2000 input

Assigned to
Saturn input

0 Input 1 BKGDA

1 Input 2 BKGDB

2 Key 1 KEY 1

3 Key 2 KEY 2

4 −−− MIX 1

5 −−− MIX 2

6 Bypass BYPASS

Note 1:  The device called “MCS_TLY” and the “opto−isolators” associated with it exist only in software
tables.

Note 2: There are no entries for MCS 2000 Mix 1 and Mix 2 (these are audio inputs). If the MCS 2000 is
mixing or keying, then both the mix source and the key source will be tallied by the Jupiter system.

The Switcher Outputs are the names of the five router outputs leading the master control switcher. The source of the
switcher output names is the Switcher Output table (page 5−55).

The MCS_TLY entries do not include a dependency on a relay, since no tally light is associated with the MCS. (There
is no tally light because in this system the MCS is always on−air.) The last two columns are therefore left blank.
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KEY 1 KEY 2BKGDA BKGDB BYPASS
BUS INPUTS

000

MAIN−B001

KEYINS1002

KEYINS2003

BYPASS004

MIX 1 MIX 2MAIN A MAIN B BYPASS

Audio
router

BUS INPUTS

MAIN−A000

MAIN−B001

MIXINS1002

MIXINS2003

BYPASS004

L RL R L R L R L R

ISO1 ISO2

ISO 1005

ISO 2006

MAIN−A

Saturn audio processorSaturn video processor

Transmitter

Tally Device Opto Logical Output Tally

1 MCS_TLY 0 MAIN−A
2 MCS_TLY 1 MAIN−B
3 MCS_TLY 2 KEYINS1
4 MCS_TLY 3 KEYINS2
5 MCS_TLY 4 MIXINS1
6 MCS_TLY 5 MIXINS2
7 MCS_TLY 6 BYPASS
8 TALLY1 0 PROD1 TALLY1 /3
9 TALLY1 1 PROD2 TALLY1 /3

Tally Dependency

Production switcher

Switcher tally
relays

MI−3040/T
“TALLY1”

Relays

20 1 3

20 1 3 4

Opto−isolators

PROD1007

PROD2008

PROD1007

PROD2008

Video
router

 Tally light

Physical
Output

Output
Name

Figure 5−145. Example tally system with Jupiter−controlled router
(Venus), Saturn master control, production switcher, and direct feed
to transmitter. Equipment shown corresponds to table at left.
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Production Switcher Entries

These entries will allow the Jupiter system to find out which of the sources feeding the production switcher have been
switched to the switcher’s Program output. The number of entries will be the same as the number of inputs from the
routing switcher.

The Name is that of the MI 3040/T connected to the production switcher’s tally outputs. The source of this name is the
MPK Devices table (page 5−115). As a convention, a name such as “TALLY1” is used.

The Opto−isolator number entries are based on the corresponding router output names. In this example, when the pro-
duction switcher has switched “PROD1” to its program output, it will report this by energizing opto−isolator number
0 on “TALLY1.”

Note: Entry of the correct opto−isolator numbers will require an understanding of the production switcher’s
tally connections. Please refer to the installation manual supplied with the production switcher for more in-
formation.

The Switcher Outputs are the names of the router outputs leading the production switcher. The source of these output
names is the Switcher Output table (page 5−55).

In the Tally  column, select the name of the MI 3040/T / relay number associated with the production switcher’s tally
light. The source of the Tally column data is the Tally Relay table (page 5−152).
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Indirect Connection to Transmitter

Please see Figure 5−146.

There are three types of entries on this table: an unqualified output entry; MCS_TLY entries; and production switcher entries.

Unqualified Output

This is the name (“XMIT”) of the routing switcher output leading to the transmitter (or the name of the output leading
to the primary program line). All sources switched to this output will be tallied. The rest of the row remains blank. There
can be more than one unqualified output if desired.

Saturn (“MCS_TLY”) Entries

Similar to those already described (page 5−164), except for the last column. Since the master control switcher is con-
nected indirectly to the transmitter (by re−entry through the routing switcher), each entry must include the name  of the
MI 3040/T and the relay number associated with the master control switcher’s tally light.

Production Switcher Entries

Similar to those already described (page 5−166).
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Tally Device Opto Logical Output Tally

1 XMIT
2 MCS_TLY 0 MAIN−A TALLY1 /4
3 MCS_TLY 1 MAIN−B TALLY1 /4
4 MCS_TLY 2 KEYINS1 TALLY1 /4
5 MCS_TLY 3 KEYINS2 TALLY1 /4
6 MCS_TLY 4 MIXINS1 TALLY1 /4
7 MCS_TLY 5 MIXINS2 TALLY1 /4
8 MCS_TLY 6 BYPASS TALLY1 /4
9 TALLY1 0 PROD1 TALLY1 /3
10 TALLY1 1 PROD2 TALLY1 /3

Tally Dependency

Physical
Output

Output
Name

Figure 5−146. Example tally system with Jupiter−controlled router
(Venus), Saturn master control, production switcher, and indirect
feed to transmitter. Equipment shown corresponds to table at left.
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CONFIGURATION FOR SYSTEMS WITH NON−SATURN MASTER CONTROL SWITCHER

Figure 5−147. Tally dependencies table for systems with
non−Saturn master control switcher (Figure 5−148).

1

Tally Dependency

Tally Device Opto Logical Output

XMIT

Tally

2 TALLY1 2 MCS1 TALLY1 /4

3 TALLY1 3 MCS2 TALLY1 /4

4 TALLY1 4 MCS3 TALLY1 /4

5 TALLY1 5 MCS4 TALLY1 /4

6 TALLY1 6 MCS5 TALLY1 /4

7 TALLY1 0 PROD1 TALLY1 /3

8 TALLY1 1 PROD2 TALLY1 /3

The Tally Dependency table shown above (Figure 5−147) corresponds to the system shown in Figure 5−148.

This table is similar to that already described, except that it shows the required connections from the non−Saturn master con-
trol switcher to the MI 3040/T opto−isolators.

Note: in this discussion, “non−Saturn” also means “non−MCS 2000.”
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MI 3040/T
“TALLY1”

Relays

Transmitter

Video and audio

Jupiter Control lines

Routing
switcher

Production switcher

 Tally light

Non−Saturn
master control

switcher

20 1 3 4

Output names

XMIT

MCS1

MCS2

MCS3

MCS4

MCS5

PROD1

PROD2

20 1 3 4

Opto−isolators

5 6

Switcher tally
relays

Switcher tally relays

Figure 5−148. Example of tally system with non−Saturn
master control switcher. Equipment shown here corre-
sponds to table shown in Figure 5−147.
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EXAMPLE OF TALLY SYSTEM OPERATION

MI−3040/T
“TALLY1”

Relays

Transmitter

Video

Jupiter Control lines

Routing
switcher

Production switcher

 Tally light “on”

Master control switcher

VC02 VT01PRD MCSVC01

20 1 3 4

XMIT

MCSM1

MCSM2

MCSK1

MCSK2

MCSBP

PROD1

PROD2

0 1

Opto−isolators

Crosspoint “on”

Switcher tally
relays

Figure 5−149. Example of tally system operation.
Equipment shown here corresponds to tables and
discussion on next page.
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Figure 5−150. Tables for system shown in Figure 5−149.

Tally Device Opto Logical Output Tally

1 XMIT
2 MCS_TLY 0 MCSM1 TALLY1 /4
3 MCS_TLY 1 MCSM2 TALLY1 /4
4 MCS_TLY 2 MCSK1 TALLY1 /4
5 MCS_TLY 3 MCSK2 TALLY1 /4
6 MCS_TLY 6 MCSBP TALLY1 /4
7 TALLY1 0 PROD1 TALLY1 /3
8 TALLY1 1 PROD2 TALLY1 /3

Tally Dependency

Tally Device Relay Logical Input

1 TALLY1 0 VT01
2 TALLY1 1 VC02
3 TALLY1 2 VC01
4 TALLY1 3 PRD
5 TALLY1 4 MCS

Tally Relay

�

�
�

�

�

�

�

�

The following discussion refers to Figures 5−149 and 5−150 above. All references to “inputs” and “outputs” are from the
routing switcher point of view. Only video is shown in this example.

� The system finds unqualified output “XMIT” on Tally Dependency table. All sources switched to this output
will be tallied. The system checks the routing switcher status tables and finds that input “MCS” (the master
control switcher) is switched to output “XMIT.”

� The system locates “MCS” on Tally Relay Descriptions table, according to which relay no. 4 of MI 3040
“TALLY1” should be turned on. This turns on the tally light next to the MCS.

� Tally 1, relay 4  is located on the Tally Dependency table. There are five entries, one for each possible source
for the MCS. Each depends (is conditional) on relay 4 to be closed in order to point back to a tally light.

� The system checks the MCS (“MCS_TLY”) to determine which source has been selected; in this case it is
output “MCSM1.” The system looks at the routing switcher status table and finds that input “PRD” (the pro-
duction switcher) is switched to output “MCSM1.”

� The system locates “PRD” on the Tally Relay Descriptions table, according to which relay 3 of Tally 1 should
be turned on. This relay turns on the tally light next to the production switcher.

� Tally 1, relay 3 is located on the Tally Dependency table. There are two entries, one for each possible router
output to the production switcher.

� The system now checks opto−isolators 0 and 1 of Tally 1 to determine which source has been selected by the
production switcher. Opto−isolator 0 is energized, meaning that output “PROD1” is selected. (In other words,
relay 3 is ANDed with opto 0.) The system looks at the routing switcher status table and finds that input
“VT01” is switched to output “PROD1.”

� The system locates “VT01” on the Tally Relay Descriptions table, according to which relay 0 should be turned
on. This turns on the tally light next to the VTR.
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Sequential Path Finding

Figure 5−151. Path finding data table (example).

1

Sequential Path Finding

Source Switcher/Level

VIDEO (NEWSROUT)

Physical

10

Destination Switcher/Level Physical

43

Count

5

2 LEFT (NEWSROUT) 10 43 5

3 RIGHT (NEWSROUT 10 43 5

4 TC (NEWSROUT) 10 43 5

5 VIDEO (MAINROUT) 61 20 3

6 LEFT (MAINROUT) 61 20 3

7 RIGHT (MAINROUT) 61 20 3

8 TC (MAINROUT) 61 20 3

Output Input

VIDEO (MAINROUT)

LEFT (MAINROUT)

RIGHT (MAINROUT)

TC (MAINROUT)

VIDEO (NEWSROUT)

LEFT (NEWSROUT)

RIGHT (NEWSROUT

TC (NEWSROUT)

Path Finding
Group Name

VNEWMAIN

LNEWMAIN

RNEWMAIN

TNEWMAIN

VMAINNEW

LMAINNEW

RMAINNEW

TMAINNEW

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

The path finding§ software option allows two or more Venus, Trinix, or later routing switchers to operate as a system, where
one switcher can access the other’s inputs through a number of tie lines. For example, Figure 5−152 shows a facility with a
large, central distribution switcher and a smaller switcher normally used only within the news department. By placing both
switchers under control of the Jupiter system, and by adding tie lines, the main router can access the news department’s inputs.
In this example, VT21 can be switched to output 55 of switcher “MAINROUT” with one command: the system will first
switch VT21 to one of the tie lines leading from “NEWSROUT” to “MAINROUT,” then it will switch that tie line signal to
output 55 of “MAINROUT.”

Path finding is not the same as three−stage switching. Path finding involves discrete switchers connected by a small number
of tie lines, the number of which strictly limits the inputs available at the downstream switcher.

§ Some of the functions described in this section may be extra−cost options. For more information, see page 1−27.
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If all tie lines are busy and an attempt is made to switch to an additional upstream source, the control panel will indicate
“Blocked.” In order to release a tie line, a downstream output using a tie line must be switched to a local input. In this example,
“MainRout” output 55 could be switched to VT16, or some other source known to be a local input (such as black burst). In
some cases, it might be necessary to switch more than one downstream output to a local source, since the tie line could be
feeding more than one destination. Since it may be difficult to determine the overall usage of a given tie line, the operator
should switch away from the upstream switcher source when it is no longer needed.†

Following hardware installation (discussed on page 2−33), path finding requires entries to the Path Finding Data table and
selection of Group Names numbers on the Switcher Input tables (Figure 5−151).

Note 1: If the tie lines are wired non−sequentially, please refer also to Non−sequential Path Finding on page 5−185.

PATH FINDING DATA TABLE

This table, shown in Figure 5−151, describes the tie lines between the two switchers. The first four rows show the lines from
“NEWSROUT” to “MAINROUT,” and the next four rows show the lines leading back to “NEWSROUT.” In this case, there
are tie lines for all four levels of both switchers. The columns are arranged in “from—to” order.

Row 1 describes lines from Input Switcher “NEWSROUT,” Video level, starting with Physical Output 10. The lines go to
Output Switcher “MAINROUT,” Video level, starting with Physical Input 43. Since there are five lines, and connections must
be consecutive, outputs 10 through 14 of “NEWSROUT” are connected to inputs 43 through 47 of “MAINROUT.”

Note 2: When a switcher input or output is used with a tie line (such as Physical Output 10 in the above example)
and entered in the Path Finding Data table, that input or output must not appear in the Switcher Input or Output
tables.

† With Jupiter version 4.0, the VGA Status Display can be made to display tie line status. See Appendix A.
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SWITCHER INPUT TABLES

Referring to Figure 5−153 and the Switcher Input table for “NEWSROUT,” the entries for VT21 and VT22 follow the normal
pattern. However, there are also entries for VT15 and VT16—machines that are normally sources for “MAINROUT.” In the
following columns, there are Group Name selections such as “VNEWMAIN,” “LNEWMAIN,” etc. If there is a request for
VT15 to be switched to a “NEWSROUT” output, then the system is referred to Groups VMAINNEW through TMAINNEW
on the Path Finding Data table. The VMAINNEW entry, for example, shows that for video there are three tie lines available
to make this switch. Assuming that one of these lines is available, the switch will be completed.

Note: All sources identified as available through path finding must also appear on the Switcher Input table for the
“home switcher.” In the example just given, VT15 appears on both tables.

17 18 19 20 21 22 23 24 25

6
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10

11

12

13

14

38 39 40 41 42 43 44 45 46 47 48 55

56

57

58

59

60

61

62

63

64

Distribution
switcher

“NEWSROUT”

Distribution
switcher 

“MAINROUT”

65

VT16

VT15

VT22

VT21

Figure 5−152. Example of sequential path finding connec-
tions between video levels of two switchers. For correspond-
ing tables, see Figure 5−153.

In this example, this group of tie
lines is named “VNEWMAIN” (vid-
eo, NEWSROUT to MAINROUT).
Other naming schemes could use
“GROUP1,” or,  more elaborate
names like “V5N10M43,” meaning
“Video, 5 News lines starting at
output 10 to Main router starting
at input 43,” etc.)

In this example, this group of tie
lines is named “VMAINNEW.”
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Logical Input
Name VIDEO LEFT RIGHT TC

30 VT21 023 023 023 023
31 VT22 024 024 024 024

45 VT15 VMAINNEW LMAINNEW RMAINNEW TMAINNEW
46 VT16 VMAINNEW LMAINNEW RMAINNEW TMAINNEW

Switcher Input − NEWSROUT

Switcher Input
Name VIDEO LEFT RIGHT TC

23 VT15 038 038 038 038
24 VT16 039 039 039 039

45 VT21 VNEWMAIN LNEWMAIN RNEWMAIN TNEWMAIN
46 VT22 VNEWMAIN LNEWMAIN RNEWMAIN TNEWMAIN

Switcher Input − MAINROUT

Path Finding Physical Physical
Group Name Source Switcher/Level Output Destination Switcher/Level Input Count

1 VNEWMAIN VIDEO (NEWSROUT) 10 VIDEO (MAINROUT) 43 5
2 LNEWMAIN LEFT (NEWSROUT) 10 LEFT (MAINROUT) 43 5
3 RNEWMAIN RIGHT (NEWSROUT) 10 RIGHT (MAINROUT) 43 5
4 TNEWMAIN TC (NEWSROUT) 10 TC (MAINROUT) 43 5
5 VMAINNEW VIDEO (MAINROUT) 61 NEWSROUTVIDEO 20 3
6 LMAINNEW LEFT (MAINROUT) 61 NEWSROUTLEFT 20 3
7 RMAINNEW RIGHT (MAINROUT) 61 NEWSROUTRIGHT 20 3
8 TMAINNEW TC (MAINROUT) 61 NEWSROUTTC 20 3

Sequential Path Finding

Tie lines from 
“NEWSROUT”
to 
“MAINROUT”

Tie lines from 
“MAINROUT”
to 
“NEWSROUT”

Starting
with

number

Starting
with

number

Group
names

Group
names

Figure 5−153. Sequential Path finding and Switcher inputs
tables for system shown in Figure 5−152.
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PATH FINDING FOR THREE OR MORE SWITCHERS

Connecting three switchers for path finding purposes possible, with five as the recommended maximum. This is illustrated
in Figure 5−154. Notice that no tie lines directly connect switcher “A” and switcher “C.”

In the corresponding Path Finding Data table, there would be descriptions of the tie lines from “A” to “B,” from “B” to “A,”
from “B” to “C,” and from “C” to “B.”

Note: There may be situations where wiring would allow manual selection of alternate routes. In Figure 5−154,
this would be the case if video lines also existed between switcher “A” and switcher “C. ” However, the Jupiter
path finding software cannot take advantage of such alternate routes; in other words, it does not “switch around
busy areas.” Only one possible route between each pair of switchers can be described on the Path Finding Data
table when the system is configured.

There would also be Group entries in the Switcher Input tables of all three switchers:

— For the switcher “A” table, the names of sources available through path finding would all be referenced to the
tie lines from switcher “B” to “A.” This would include the sources wired directly to switcher “C.”

— For the switcher “B” table, the names of sources available through path finding would be referenced to the tie
lines from switcher “A” to “B,” or, from “C” to “B,” as appropriate.

— For the switcher “C” table, the names of sources available through path finding would all be referenced to the
tie lines from switcher “B” to “C.” This would include the sources wired directly to switcher “A.”

In general, path finding entries are needed only for switchers that are immediately adjacent. The system will use this informa-
tion to find paths involving one or more intermediate switchers.
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Distribution 
switcher “A”

Distribution 
switcher “B”

Distribution
switcher “C”

Tie lines

Video

Figure 5−154. Example of path
finding connections between
video levels of three switchers.
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PATH FINDING BETWEEN ANALOG AND DIGITAL EQUIPMENT

Automatic Conversion of Separate Analog Signals to Combined Digital Signals

The pathfinding table can be used with customer−supplied ADCs and DACs to provide automatic conversion between analog
equipment and digital equipment (such as VTRs). See Figure 5−155.

ANALOG
EQUIPMENT

ANALOG
ROUTER

DIGITAL
ROUTER

A TO D 
CONVERTER

D TO A
CONVERTER

DIGITAL
EQUIPMENT

DIGITAL ENVIRONMENTANALOG ENVIRONMENT

L

R

L

R

Figure 5−155.

For example, this technique can be used for conversion of analog audio signals, which are carried on two levels of an analog
routing switcher, to a single digital audio (AES) signal. The same concept can be applied in an embedded audio environment,
where a single digital video stream can be split into an analog video signal and up to four analog audio signals.

It is possible to arrange a system so that the conversion will take place whenever the operator selects a particular source and
switches it to a particular destination. For example, in the system shown in Figure 5−156, whenever the operator selects VTR1
as the source for VTR2, the analog audio signals will always pass through an A to D converter; when VTR2 is the source for
VTR1, the digital signal will pass through a D to A converter.
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0 1

16
17“MAINROUT

LEFT”

A TO D
CONVERTER

D TO A
CONVERTER

18 19

26
27“MAINROUT

AES”

“VTR1”
(ANALOG)

6
7

“MAINROUT
RIGHT”

4 5

“VTR2”
(DIGITAL)

TIE LINE GROUP 1

TIE LINE GROUP 3

TIE LINE GROUP 4

TIE LINE GROUP 2

Figure 5−156. Example of automatic conver-
sion system (video connections not shown). For
corresponding table entries, see Figure 5−157.

This system will require four tie lines, with a dedicated A to D converter connected to the first pair and a dedicated D to A
converter connected to the second pair. Each pair is “locked” together, meaning that selection of one result in selection of both.

The corresponding table entries are shown in Figure 5−157.

There are three rules governing this technique:

1. The pathfinding groups to be locked together MUST have identical digital Switcher Names, digital Level Names, and
digital Physical Input/Output entries. These groups must be on consecutive rows of the table. Please refer to Groups 1
and 2, as well as Groups 3 and 4, in the Pathfinding Data table.

2. In the Switcher Description table, the “MAINROUT LEFT” level and “MAINROUT RIGHT” level must be controlled
by the same VM 3000 / CM 4000. The “MAINROUT AES” level may be controlled by another VM 3000 / CM 4000.

3. Any levels “sourced” by, in this case, the MAINROUT LEFT and RIGHT levels may not break away. This must be
established by unchecking the “Breakaway” box in the CP Level Set.
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Logical Input
Name LEFT RIGHT AES

30 VTR1 001 005 GROUP1
31 VTR2 GROUP4 GROUP3 019

Switcher Input − MAINROUT

Sequential Path Finding

Group
name

“Locked” tie lines
through A to D
converter

“Locked” tie lines
through D to A
converter

DM 400
Switcher Level VI RV MC Board #In #Out PLvl Follow Level Driver 3 LI 3 LO Option Audio Off Time

1 MAINROUT LEFT CM1 64 64 2 Binary Left
2 MAINROUT RIGHT CM1 64 64 6 Binary Right
3 MAINROUT AES CM1 64 64 32 Binary None

Switcher Description

Group
names

      Logical Output Pass
Name Security S−T Word LEFT RIGHT AES

1 VTR1 017 007
2 VTR2 026

Switcher Output − MAINROUT

Figure 5−157. Table entries for
system shown in Figure 5−156
(video entries not shown).

Path Finding Physical Physical
Group Name Source Switcher/Level Output Destination Switcher/Level Input Count

1 GROUP1 LEFT (MAINROUT) 16 AES (MAINROUT) 18 1
2 GROUP2 RIGHT (MAINROUT)   6 AES (MAINROUT) 18 1
3 GROUP3 AES (MAINROUT) 27 LEFT (MAINROUT)   0 1
4 GROUP4 AES (MAINROUT) 27 RIGHT (MAINROUT)   4 1
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Non−Sequential Path Finding

Figure 5−158. Non−Sequential Path Finding data table (example).

1

Non−Sequential Path Finding

Path Finding

GROUP1

Line

3

Physical

83

Physical

87

2 GROUP1 4 84 88

3 GROUP2 3 83 87

4 GROUP2 4 84 88

5 GROUP3 3 83 87

6 GROUP3 4 84 88

7 GROUP4 3 83 87

8 GROUP4 4 84 88

9 GROUP5 2 82 20

10 GROUP6 2 82 20

11 GROUP7 2 82 20

12 GROUP8 2 82 20

Number Output InputGroup Name

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding

Exclusion 5−188
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

The path finding software option has already been described in detail, starting on page 5−174.

The Non−Sequential Path Finding table must be used if the tie lines joining the switchers are not wired sequentially, i.e., not
wired as blocks. Basically, the table is designed to enter “exceptions” to the Sequential table. For example, a new tie line that
falls outside the original sequence can be defined on the Non−sequential table; the only change then needed on the Sequential
table would be to increment the “Count” number for the group by 1. (Alternatively, you may prefer to use the Non−sequential
table to define all tie lines individually.)

An example system is shown on page 5−186, with corresponding tables shown on page 5−187. Notice that the Path Finding Data
table, and the Switcher Input tables, must still be used as described in the previous section.
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Note: Line
numbers start

at zero!

20 26 27

83

84

888745 46

61

62

Distribution
switcher

“NEWSROUT”

Distribution switcher 
“MAINROUT”

13

14

15

44

82

33 34

VT22

VT21

1 2

VT16

VT15

GROUP1
Non−sequential

tie lines

GROUP1
Sequential tie

lines
Line 0

Line 1

Line 2

Line 3

Line 4

GROUP5
tie lines

Note: Line
numbers start

at zero!

Figure 5−159. Example of non−sequen-
tial path finding connections between
video levels of two switchers. For corre-
sponding tables, see Figure 5−160.
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Sequential Path Finding

Tie lines from
“NewsRout” to
“MAINROUT”

Tie lines from
“MainRout” to
“NEWSROUT”

See note 1

Path Finding Line Physical Physical
Group Name Number Output Input

Non−Sequential Pathfinding

1 GROUP1 3 83 87
2 GROUP1 4 84 88
3 GROUP2 3 83 87
4 GROUP2 4 84 88
5 GROUP3 3 83 87
6 GROUP3 4 84 88
7 GROUP4 3 83 87
8 GROUP4 4 84 88
9 GROUP5 2 82 20
10 GROUP6 2 82 20
11 GROUP7 2 82 20
11 GROUP8 2 82 20

Note 1: You may wish to define each and every tie line on the Non−sequential table; however, it will
still be necessary to enter some number in the Physical Output and Physical Input columns to satisfy
the compiler.

GROUP1
Non−sequential

tie lines

Logical Input
Name VIDEO LEFT RIGHT TC

30 VT21 033 033 033 033
31 VT22 034 034 034 034

45 VT15 GROUP5 GROUP6 GROUP7 GROUP8
46 VT16 GROUP5 GROUP6 GROUP7 GROUP8

Switcher Input − NewsRout

Logical Input
Name VIDEO LEFT RIGHT TC

23 VT15 001 001 001 001
24 VT16 002 002 002 002

45 VT21 GROUP1 GROUP2 GROUP3 GROUP4
46 VT22 GROUP1 GROUP2 GROUP3 GROUP4

Switcher Input − MainRout

Group
nAME

See note 1

See note 2

Note 2: in this example, the same input/output numbers are used for
the tie lines on each level; however, different inputs/outputs can be
used, and entered on this table, if desired.

Path Finding Physical Physical
Group Name Source Switcher/Level Output Destination Switcher/Level Input Count

1 GROUP1 VIDEO (NEWSROUT) 13 VIDEO (MAINROUT) 44 5
2 GROUP2 LEFT (NEWSROUT) 13 LEFT (MAINROUT) 44 5
3 GROUP3 RIGHT (NEWSROUT) 13 VIDEO (MAINROUT) 44 5
4 GROUP4 TC (NEWSROUT) 13 TC (MAINROUT) 44 5
5 GROUP5 VIDEO (MAINROUT) 61 VIDEO (NEWSROUT) 26 3
6 GROUP6 LEFT (MAINROUT) 61 LEFT (NEWSROUT) 26 3
7 GROUP7 RIGHT (MAINROUT) 61 RIGHT (NEWSROUT) 26 3
6 GROUP8 TC (MAINROUT) 61 TC (NEWSROUT) 26 3

Figure 5−160. Path Finding and Switcher Inputs tables for system shown in Figure 5−159.
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Exclusion

Figure 5−161.  Exclusion data table (example).

1

Exclusion

Logical Input

MULTBRST

Logical Output

XMIT

2 SINESQ XMIT

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding

Exclusion 
Y Line 5−189

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

This table can be used to prevent a particular input from being switched to a given output.

Note: No exclusions are allowed on data levels.
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Y Line Table (DM 400/400A)

Figure 5−162. Y Line table (example).

1

Y Line Table

Level

REV (DATA)

2

FOR (DATA)

Input

VR2−S

Output

VR2−M

VR2−M VR2−S3

REV (DATA)

4

FOR (DATA)

VR1−S VR1−M

VR1−M VR1−S

Logical Logical

Password 5−22

Network Description 5−27
Serial Protocol 5−30

Switcher Description 5−35
Switcher Input 5−48
Switcher Output 5−55

Control Panel Sets
Level set 5−58
Input set 5−62
Output set 5−78
Override set 5−96
Sequence set 5−99
Category set 5−101

MPK Devices 5−107

Machines 5−135
Machine Control 5−139
Delegation Groups 5−149

Status Display Header 5−150
VGA Status Display 5−151

Tally 5−152

Path Finding

Exclusion 5−188
Y Line

Time Standard G−11
Video Reference G−14
CM VGA Options H−1

The Y Line table is used only with Venus data routers equipped with DM 400 or DM 400A Data Matrix boards in applications
where a VTR can be used as a controller (master) on some occasions and as a tributary (slave) on others.

Note: This table is not used with newer model Venus systems equipped with the DM 400B Data Matrix boards;
these boards have software−configurable rear−panel pinout functions and do not require Y−line cables.

Configuration of this table is described at the conclusion of Appendix L, “Special configuration requirements: Venus DM
400/400A data matrix switching.”
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Time Standard table

Video Reference Table

These tables are used only for configuration of a CM 4000 System Controller running AccuSwitch software. CM
4000/AccuSwitch installation is described in Appendix G.

CM VGA Options

This table is discussed in Appendix H.
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Section 6 − Control Panel Operation

CP 300 24 x 1 Single Bus Control Panel

Each input button of the CP 300 is assigned to a specific source (and the entire panel assigned to a single destination) during
the installation procedure described on page 2−38.

Audio−follow−video switching - When one of the 24 input buttons is pressed, a TAKE* command is issued to all levels of
the switcher matrix. A status* signal is then returned to the control panel; this confirms the action by lighting the input button
that was pressed. See Figure 6−1.

CHG
VID

CHG
A1

CHG
A2

CHG
A3

CHG
A4

CHG
A5

1

Select desired input;
button will light when switch

is made.

Figure 6−1. CP 300 audio−
follow video switching.

Split switching − When the operator desires to take only specific switcher levels, those levels are defined by first pressing
one or more of the six breakaway buttons. The TAKE command to the switcher will be executed when an input button is
pressed. The switcher will confirm the action by lighting the selected input button. (See Figure 6−2.) If the panel has been
configured for sticky levels (as described on page 5−108), the selected level buttons will remain lit after TAKE has been
pressed.

Split statusing − To status a specific level of a previous breakaway level switch, select the level to be statused; one of the
input buttons will illuminate to indicate the source for that level. If more than one level status button has been toggled on (like
A1 and A2), only the lowest level (A1) will be statused.

Figure 6−2. CP 300 Split (breakaway) switching.

1. Select level(s)
to be switched.

2. Select desired input;
button will light when switch
is made.

* Defined in Glossary Section
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“Protect/lock” output indicator (button flash) − If the output has been protected* or locked* the active input button will
flash; this indicates that the input cannot be changed.

Note: CP 300, CP 310, and CP 330−type panels cannot be used to turn off protect or lock mode—this can only
be done with the same panel that was originally used to protect the output.

For additional protect/lock information  − see page 6−12.

CP-310 24 x 8 Eight Bus Control Panel

Each input button of the CP 310 is assigned to a specific source (and the output buttons assigned to eight destinations) during
the installation procedure described on page 2−38.

Audio−follow−video operation - Access to eight switcher outputs is provided by the buttons on the left side of the panel.

 After output selection, the input is selected from the bank of 24 buttons in the center of the panel.

Figure 6−3. CP 310 audio−follow video operation.

Select output, then input

Split switching - See Split Switching on page 6−1.

Split statusing − See Split Statusing on page 6−1.

“Protect/lock” output indicator (button flash) − If an output has been protected* or locked* the output button will flash;
this indicates that the input cannot be changed.

Note: CP 300, CP 310, and CP 330−type panels cannot be used to turn off protect or lock mode—this can only
be done with the same panel that was originally used to protect the output.

For additional protect/lock information  − see page 6−12.
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CP 320 Push Button Control Panel

Figure 6−4. CP 320 Push Button Control Panel (as supplied).

CHG
OUT

CHG
VID

CHG
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CHG
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CHG
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CHG
A4

CHG
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DESTINATION SELECTION STATUS

CAM1VTR2 VTR1

VTR
1

CG
2

NET
3

VCR
4

CAM
5 AUX

REM
6

FILM
7

PTCH
8

STU
9

TEST
0

EJ SS

MISCFSSAT TAKE

PROT

Installation of this panel is shown on page 2−37. For a general description, see page 2−40.

The control panel uses a category/number method for both input and output selection. The operator presses the keypad to
select the category, i.e., VTR, CAM, etc. The number selection then designates the individual entry within the category, i.e.,
VTR1, VTR2, CAM1, CAM2, etc. The Selection window displays the entry as each button is selected. Numbers may contain
one or two digits.

To change the output selection, press CHG OUT, then press a category button for the desired category, and a number button
for the output number within that category. The control panel output will be changed only when the TAKE button is pressed.
A TAKE will not be made, but the switcher controller and output display will change and the new output will be displayed
in the Destination window.

Note: If the current selection is not a valid mnemonic, the selection window will display a number to show that
a TAKE cannot be made.

Breakaway Level Switching - Inputs are selected as described above. The desired level push buttons are then pressed to
initiate switching only on those levels. The TAKE button is then pressed. If the panel has been configured for sticky levels
(as described on page 5−108), the selected levels will remain in effect after TAKE has been pressed; i.e., when the next input
is entered the appropriate level buttons will come back on.

Video Splits - Combinations of the Breakaway Level buttons and the Category/Number buttons can be used to create a video
split. The input and output selections are made as described above.
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Before the TAKE push button is pressed, the desired Breakaway Level push buttons are pressed to designate the levels to be
switched.

Another input selection is then made using the category/number push buttons. The desired Breakaway Level push buttons
are again selected corresponding to the levels to be added to the switcher TAKE command.

The TAKE button is then pressed, causing the switcher to perform the split, using the two designated inputs from the desired
levels.

Protecting the current switcher output - To protect the current output of the switcher, the PROTECT push button is pressed.
The PROTECT lamp will remain on to indicate the protect mode.

The protected status will also be displayed by other control panels presently controlling the protected output; if the other panel
is a CP 320 the PROTECT button will blink.

Only the control panel that originated the protected status can remove it (the originating panel can be recognized by the steady
illumination of the PROTECT lamp). To remove the protected status, press the lighted PROTECT push button. The button
light will go out to show the protected status has been removed.

For additional protect/lock information  − see page 6−12.

CP 328 Push Button Control Panel

Operation of this panel is the same as the CP 320. The only difference between the panels is that the CP 328 has eight−character
display windows while the CP 320 has four−character display windows.

CP 330 Control Panel

The CP 330 can be configured to operate as a 48 x 1 panel, or, as a 24 x 2 panel with the top row of buttons assigned to one
output and the bottom row to another. Operation is much the same as a CP 300, as described on page 6−1.

Figure 6−5. CP 330.

(For installation and configuration instructions, please see page 2−38.)
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CP 330/6 48 x 6 Six Bus Control Panel

Figure 6−6. CP 330/6 Operation.

0 1 2

3 4 5

Select output...

...then input.

Each input button of the CP 330/6 is assigned to a specific source (and the output buttons assigned to six destinations) during
the installation procedure described on page 2−41.

Audio−follow−video operation - Access to six switcher outputs is provided by the buttons on the right side of the panel.

After output selection, the input is selected from the bank of 48 buttons on the left side of the panel. This completes the switch.
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CP 300 Series Diagnostics

Control panels can be tested without affecting switcher operations.

CP 300/310/330

To enter the diagnostic mode, press and hold CHG VID and then press CHG A5: the CHG VID and CHG A1 lights will come
on; CHG VID will enable the Button/Lamp Test and CHG A1 will start the Lamp Self−Test.

Button/Lamp Test

This test is used to check the proper operation of control panel push buttons. Whenever a button is pressed, that button’s lamp
should come on. To exit, press any button twice.

Lamp Self−Test

Lamps should come on sequentially, remain on, and then go off. This mode will continue until a button is pressed.

CP 330/6

To enter the diagnostic mode, press and hold the output 0 button and then press output 5: the output 0 and output 1 lights will
come on; output 0 will enable the Button/Lamp Test and output 1 will start the Lamp Self−Test.

CP 320/328

Press and hold CHG VID and then press CHG A5. This will cause the panel to display its device name as defined in the MPK
Devices table. To exit, press PROT, or

— Press TAKE to display the panel ID. To exit, press PROT, or

— Press TAKE a second time to enter the diagnostic mode menu. Pressing the CHG OUT button will scroll
through the different diagnostic tests:

Display (LED) test

To start, press TAKE. To exit, press any button.

Keyboard test

To start, press TAKE. Then press every button, checking for duplications. To exit, press any button
twice.

Lamp test

To start, press TAKE. All lamps should light sequentially. To exit, press any button.
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CP 3000 Switcher Control Panel

Note: For a general discussion of the CP 3000, please see page 2−42; for a short tutorial on basic operations only,
see Appendix J.

The top row of the display shows output status for four levels. Using the CLEAR key, the bottom row can be toggled between
the first page of input override selections and the name of the current output (see Figure 6−7). Input overrides permit single
button input selection, eliminating the need to use the category and selection entry keypad for commonly used inputs.

To change the output is being controlled by the panel, please see Display/change Output on page 6−20.

Figure 6−7. Push CLR to toggle display.

VTR

1

CG

2

NET

3

SAT

EJVCR

4
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REM

6

FILM

7

PTCH

8
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9
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AUX TEST

0

MISC SS
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TAKECHOPLOCKPROT

F4F3F2F1

MORECLRMENULEV

 VTR1 VT1L VT1R VT1T
 BLK  BARS TONE SLNC

 VTR1 VT1L VT1R VT1T
 CURRENT OUTPUT=VTR2

Overrides

Status

Output

Status

OVERRIDE INPUT SELECTION

Override input selections are made by pressing a Function button below the desired mnemonic. The operator can see other
possible selections by pressing MORE. After the operator makes an override selection, the mnemonic and the levels defined
for the selected input are displayed in the prompt window. The operator then presses TAKE to send the command to the
switcher. The operator can exit the entry mode by pressing CLEAR and the panel returns to the mode it was in before the
override was selected.

If entry of a password is requested, please see Passwords on page 6−22.

For information about programming overrides, see page 6−21.
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CATEGORY AND NUMBER INPUT SELECTION

The user selects a switcher input by first pressing the desired input category keypad push button. The display menu line will
be cleared and the category name will appear (see Figure 6−8).
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TAKECHOPLOCKPROT

F4F3F2F1

MORECLRMENULEV

Figure 6−8. Display after category has been selected.

CAT=VTR  SELECT=????

The operator then enters the selection number for the desired input; the display will show the primary mnemonic for the input
after the word “Select.” Additional detail is given on the bottom row, which shows the input mnemonics for the sources
selected on up to four levels. See Figure 6−9. (The appearance and position of each level’s status information is determined
by the CP Level set assigned to the panel).
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F4F3F2F1

MORECLRMENULEV

Figure 6−9. Number has been selected. Ready for TAKE to be pressed.

CAT=VTR  SELECT=VTR1
VTR1 VT1L VT1R VT1T

Note: If the category entry is ignored, or if the bottom display row stays blank after the selection number is entered,
the category / selection number may not be defined in the CP Input Set (page 5−62) assigned to the panel on the
MPK Devices table (page 5−107).

When TAKE is pressed the command is sent to the switcher matrix. If the TAKE command was successful, the top display
row will be updated to reflect the new input status.

If entry of a password is requested, please see Passwords on page 6−22.
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PROTECT OUTPUT

The protect function prevents an output from being switched by other system control panels. For example, if a VTR is record-
ing a program or if the output is feeding a program line, care must be taken to insure that the signal is not switched or disrupted.

To Protect an Output 

The operator presses PROTECT. The system will request verification. (See Figure 6−10.) Press TAKE.

If entry of a password is requested, please see Passwords on page 6−22.
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Figure 6−10.

 VTR1 VT1L VT1R VT1T
PROTECT − PRESS TAKE

A blinking “P” will appear in the first character position on the display status line to alert all operators that the output is pro-
tected. If another panel attempts to make a switch, the display will indicate the name of the panel that protected the output.

Figure 6−11.

PVTR1 VT1L VT1R VT1T
 BLK  BARS VTR1 VTR2

Protect symbol
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To Unprotect an Output

The panel that protected an output is used to unprotect the output.

To unprotect the output, press PROTECT. The protect prompt will appear (See Figure 6−10.) Press TAKE.

If entry of a password is requested, please see Passwords on page 6−22.

The P symbol in the display status line will be removed. The output is now available for control by any panel in the system.

For additional protect/lock information  − see page 6−12.
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LOCK OUTPUT

The Lock function prevents an output from being switched, including being switched by the panel which set the lock. The
output is unlocked by the same panel before a switch can be made.

To Lock an Output

The operator presses the LOCK push button. The system will request verification (see Figure 6−12). Press TAKE.

If entry of a password is requested, please see Passwords on page 6−22.
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Figure 6−12.

 VTR1 VT1L VT1R VT1T
   LOCK − PRESS TAKE

A blinking “L”  will appear in the first character position on the display status line to alert all operators that the output is locked.
If another panel attempts to make a switch, the display will indicate the name of the panel that locked the output.

Figure 6−13.

LVTR1 VT1L VT1R VT1T
 BLK  BARS VTR1 VTR2

Lock symbol

To Unlock an Output

The panel that locked an output is used to unlock the output.

To unlock the output, press LOCK. The display menu line will be cleared and the LOCK prompt will appear (See Figure
6−12). Press TAKE.
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If entry of a password is requested, please see Passwords on page 6−22.

The L symbol in the display status line will be removed. The output is now available for control by any panel in the system.

Protect − On Jupiter control panels with a PROTECT button: after a given source has been switched to
a given destination, and PROTECT is pressed, the source for that destination can then be changed only
at the panel which protected the output.

Lock − On Jupiter control panels equipped with a LOCK button (except MC 3020L): after a given source
has been switched to a given destination, and LOCK is pressed, the source for that destination can then
be changed only at the panel which set the lock; and only after LOCK is pressed again.

Note 1:  If another panel was used to protect/lock the output, the name of the panel will be shown (on panels
equipped with alphanumeric displays). The panel names and corresponding device addresses can be found
on the MPK Devices table (Figure 5−89); to determine the device address (ID) of a particular panel, please
see page 6−21. A panel name such as “Poll 1−075” refers to a party line control panel, in this example,
a panel with a polling address of 075 (hex) connected to the first PL 3000 listed in the Network Devices
table.

Note 2:  An output can be force unprotected/unlocked from a panel equipped with LOCK/PROTECT
buttons if the panel’s password level is 90 or higher. This allows the panel to override the lock or protect
status of another control panel, including Master Control. Care must be exercised when using this func-
tion.

— To permanently change a panel’s password level using the file server, see Setting Password Levels for
Control Panels on page 5−113. This procedure will require downloading a revised set to the controller
board.

— To change a panel’s password level to “99” at the panel itself, see Raising Password Level To Maxi-
mum on page 6−22.

Note 3: A “force unprotect/unlock” function is also available using (1) JNS Force Unlock application
(page 11−1); (2) the Router Save/Restore utility (page 18−1); and (3) with the optional VG 3000 Video
Display/Status Generator (page 6−140).

Note 4: A panel can only protect/lock levels that are assigned to the panel with the CP Level set (page
5−58).

Note 5: An unlock command will unprotect an output but an unprotect command will not unlock an output.

Additional Protect/Lock Information 
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CHOP INPUTS

Chop is a special switching function which automatically alternates inputs to a switcher output. This mode is useful in system
test modes and for comparison of switcher inputs.

The matrix chops between the currently selected input and the new chop input. This new input is selected via the normal input
selection process, except CHOP is pressed instead of TAKE.

The matrix will then rapidly alternate between the two switcher inputs.

If entry of a password is requested, please see Passwords on page 6−22.

Chop will terminate automatically after approximately two minutes. To terminate the chop manually, select an input and press
TAKE.

Figure 6−14.

 CHOP CHOP CHOP CHOP
 BLK  BARS TONE SLNC
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9

FS

AUX TEST

0

MISC SS

A

B

C

D

TAKECHOPLOCKPROT

F4F3F2F1

MORECLRMENULEV

Pathfinding sources cannot be chopped.

Serially−controlled (”Remote switcher”) levels cannot be chopped.

On a single CM 4000 the total number of outputs/levels in chop mode cannot exceed 10 at one time.

Additional Chop Information
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LEVELS SELECTION (SPLIT SWITCHING)

Normally, a request for a given input will be issued to all levels defined for that input name in the Switcher Input table (page
5−48). However, in some cases it may be desirable to prevent certain levels from switching.

De−selecting Switcher Levels

After selecting category and number, the bottom row will display the input mnemonic for each level as selected, i.e., non−
blanked. See Figure 6−15.
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Figure 6−15. Number has been selected. Ready for LEVEL to be pressed.

CAT=VTR  SELCT=VTR1
VTR1 VT1L VT1R VT1T

If before pressing TAKE, the LEVEL button is pressed, the operator can toggle off the unwanted levels by pressing the corre-
sponding Function key. Additional levels (if any) can be displayed by pressing MORE. See Figure 6−16.

VTR

1

CG

2

NET

3

SAT

EJVCR

4

CAM

5

REM

6

FILM

7

PTCH

8

STU

9

FS

AUX TEST

0

MISC SS

A

B

C

D

TAKECHOPLOCKPROT

F4F3F2F1

MORECLRMENULEV

Figure 6−16. LEVEL has been pressed, and all levels except video have been toggled off.

VID
VTR1

After the appropriate levels have been de−selected, TAKE is pressed and the switcher command sent.

If entry of a password is requested, please see Passwords on page 6−22.
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Switching Different Inputs with a Single TAKE Command

By using the procedure just described, a completely different input can be selected from one level to another before pressing
TAKE.

1. Select an input without pressing TAKE.

2. Press LEVEL.

a. If you want to de−select a level, press the appropriate function key now.

3. Select another input.

4. Press LEVEL, then press the Function key for the level(s) you want to receive this input.

5. Repeat as needed for other levels.

a. If you de−selected a level (in Step 2a. above), you must press the appropriate function key again to blank the entry.

6. Press TAKE.

An Alternate Method of Split Switching

When only one level is to be switched, you may find it convenient to use the following method:

1. Press LEVEL.

2. Use the desired Function key to toggle the level ON.

3. Select an input.

4. Press TAKE.

If entry of a password is requested, please see Passwords on page 6−22.

MENU SELECTIONS

The operator uses MENU and MORE to display the desired menu selection. (See Figure 6−17.) The corresponding Function
key is used to select the desired operation.
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Figure 6−17. Menu selections.

 VTR1 VT1L VT1R VT1T
 STAT SEQ  AUD  OUT

 VTR1 VT1L VT1R VT1T
 DIAG DEF  PWD  LOG  

Page 1

Page 2

 VTR1 VT1L VT1R VT1T
 ID  Page 3

STAT — DISPLAY OUTPUT STATUS

Selecting STATUS permits the operator to review the current status of all levels of the output controlled by the panel.

The operator presses MENU and then the STATUS soft−key. The display prompt line is cleared and the output status prompt
appears. (See Figure 6−18.)

Normally the display status line will display the first four defined output levels. To view the status of other levels associated
with the control panel output, press MORE.

Figure 6−18.

 VTR1 VT1L VT1R VT1T
  *OUTPUT  STATUS*

The operator presses CLEAR or TAKE to exit the status display mode. The display status line returns to the first group of
levels status and the display prompt line returns to the mode it was in when the output status mode was selected.
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SEQ — SELECT INPUT SEQUENCES

Special input selection sequences or macros may be defined via the Sequence Set table (Figure 5−80). On the CP 3000
Switcher Control Panel, the SEQUENCE soft−key allows the operator to access these pre−defined sequences.

The operator presses MENU and then the SEQ soft−key to display the first page of sequence names. The operator then presses
the soft−key corresponding to the desired sequence and TAKE.

If entry of a password is requested, please see Passwords on page 6−22.
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AUD — AUDIO MODES

When the Jupiter system is used to control a Venus switcher, the CP 3000 panel can be used for special audio switching modes
such as sending a mono signal to both channels of a stereo output, mixing stereo signals into a mono output, and reversing
channels. This function requires proper entries to the “Audio” column of the Switcher Description table (see page 5−35).

1. Select an output (as described on page 6−20). Press TAKE.

2. Select an input (as described on page 6−8). Press TAKE.

3. Press MENU and then the AUD soft−key.

The display will show the audio pairs in the system. A typical example, based on the table entries shown on page 5−58,
is as follows:

Figure 6−19.

LEFT
RGHT

F4F3F2F1

4. Select the soft−key for the desired audio pair.

In this example, “F1” would be pressed because there is only one audio pair (level 2 “LEFT” and level 3 “RGHT.”) The
available audio modes will now appear on the bottom row of the display (Figure 6−20).

If the system has more than four audio pairs, use the MORE button to scroll to the next group of pairs.

Figure 6−20.

LEFT RGHT MODE:
NORM LEFT RIGHT MIX

5. Select the desired mode. Selections are as follows:
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Left signal on Left channel

Right signal on Right channel

“NORM”    =

“LEFT”    = Left signal on Left channel

Right signal on Right channel

Right signal on Left channel

“RGHT”    =

Left + Right signals on Left channel

Left + Right signals on Right channel

“MIX”    =

Right signal on Left channel

Left signal on Right channel
“REV”    =

Figure 6−21.

Left signal on Right channel

The “REV” mode is on the second page (accessible using the MORE key).

6. Press TAKE . This will complete the special switching operation and exit the audio mode. A flashing letter “A” will
appear on the normal status/override display:

Figure 6−22.

 VTR1 VT1L VT1R VT1T
ABLK  BARS VTR1 VTR2

Audio caution
symbol

This flashing symbol is a caution that the top row of the display does not show true status. In this example, “VT1R”
is indicated as the source for the right audio channel, but in fact VT1L is the source. This can be determined by pressing
MENU, AUD, and the soft−key for the desired level to bring up the following display:

Figure 6−23.

LEFT RGHT MODE: LEFT
NORM LEFT RIGHT MIX

This display shows true status. The left input channel is switched to both the left and right output channels.
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OUT — DISPLAY/CHANGE OUTPUT

The OUTPUT menu selection displays the current logical matrix output to which the control panel is assigned.

The operator presses MENU and then the OUTPUT soft−key. The display prompt line is cleared and the current control panel
logical output is displayed. (see Figure 6−24.) The display remains until the operator presses CLEAR or TAKE.

Figure 6−24.

 VTR1 VT1L VT1R VT1T
 PANEL OUTPUT = VTR2

By selecting a category and number before CLEAR or TAKE is pressed, a new output selection is entered in the output display.
When TAKE is pressed, the control panel will be assigned to control the new output bus.

Note:  If the panel cannot be changed to the desired output, it may have been limited to certain outputs by the CP
Output Set used on the MPK Devices table. See page 5−112.

DIAG — CONTROL PANEL DIAGNOSTICS

Special control diagnostics can be defined by the system controller and executed at the control panel. The operator interaction
and panel displays will be determined by the actual diagnostic selected.

The operator presses the MENU mode selection push button, then the MORE key to display the control panel DIAGnostics
selection. The operator presses the DIAGnostics soft−key and the first group of options is displayed. The operator presses
the soft−key for the desired selection and then follows the instructions on the control panel display.

Upon completion of the selected diagnostic, the control panel returns to the DIAGnostic selection menu. The operator may
then select another diagnostic or press the CLEAR key until the panel returns to the default control panel mode.

Display Self−Test

The display self−test mode is used to check the proper operation of the vacuum fluorescent (VF) character display. When the
test mode is started, a pattern of all position display characters will be written to each character position.

The display self−test will continue until the operator presses the CLEAR or TAKE push buttons. The panel will then return
to the DIAGnostic selection menu. Pressing the CLEAR push button again, will return the panel to mode it was in before the
diagnostic menu was selected.

Keypad Self−Test

The keypad self−test mode is used to check the proper operation of control panel push buttons. When the test mode is started,
the display will show the definition of each control panel push button as it is pressed. This display will show the button name/
address and the currently defined panel function name.

The keypad self−test mode will continue until the operator presses the CLEAR or TAKE push buttons twice.
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DEF — RE−DEFINE INPUT OVERRIDES

The control panel overrides permit a quick selection of switcher inputs and level selections. The overrides must first be
defined on the Override Set table (Figure 5−78). For each definition, there is a choice of allowing or not allowing the override
to be edited from the front panel.

Important: Front−panel editing of overrides is temporary. Download or loss of power to the SC−3000 Serial Con-
trol Interface will cause the overrides to revert to the definitions in the Override Set table.

The operator edits the override by first selecting a switcher input via the category and selection keypad. If level selection is
required, use the LEVEL menu selection mode. In other words, input selection must be complete but TAKE is not pressed.

The operator then presses MENU and MORE to display the DEFINE override soft−key. This displays the first page of existing
override names. The operator then selects the override to be edited by pressing the corresponding function key. The MORE
push button is pressed if the desired override name is on another page.

Note:  Only existing overrides can be edited. The override cannot be entered on an empty display position.

If entry of a password is requested, please see Passwords on page 6−22.

Important: This procedure does not change the name of the override as established by the Override Set table. This
could result in a situation where the operator selects CAM1 but gets VTR5. For overrides that will be allowed to
be to be edited from the front panel, it is a good practice to use generic names such as “Usr1” or “Ovr1”on the
Override Set table.

ID — DISPLAY CONTROL PANEL DEVICE ADDRESS

The panel ID menu selection displays the system address used to select and service this control panel. The ID is determined
at time of panel manufacture and cannot be changed by the operator.

The operator presses MENU, MORE (twice),  and then the ID soft−key. The display prompt line is cleared and the current
control panel identification is displayed. (See Figure 6−25.) The display remains until the operator presses CLEAR or TAKE.

Figure 6−25.

VTR1 VT1L VT1R VT1T
PANEL ID = 0000100A
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PASSWORDS

Note: For a general description of the Jupiter password system, including creation of passwords, please see page
5−22.

Single−Event Password Entry

If a password is requested during entry of a command, the output about to be affected has a password level higher than that
of the panel. After entry of a higher−level six−digit password, the command can be completed by pressing TAKE; however,
the panel will then revert to its previous password level.

Note: If entry of a password is requested, and a valid password is entered, but the system responds with “invalid”
or “illegal password,” it will probably be necessary to use the long−term password entry procedure described
below to raise the password level of the panel.

Long−Term Password Entry (PWD — Login)

The PWD function permits the operator to log on to the control panel, thus raising the password level of the panel to the same
level as the operator’s password—and this level will remain in effect until the operator uses the Logout procedure described
below.

Press MENU, MORE, and PWD. The display prompt line is cleared and the enter password prompt appears. (See Figure
6−26.) Enter your six−digit password (as entered on the Password Table) via the keypad and press TAKE. You have three tries
to enter a valid password.

Figure 6−26.

 VTR1 VT1L VT1R VT1T
 PASSWORD = ?????? Enter password prompt display

Raising Password Level to Maximum (for Force Unprotect/Unlock)

The password level of a panel can be raised temporarily to 99 (the maximum possible) directly at the panel. This avoids using
the file server and downloading a modified set to the controller board.

The operator presses MENU, MORE, and PWD. The display prompt line is cleared and the enter password prompt appears.
(See Figure 6−26.) The operator then enters the six−digit Jupiter password and presses TAKE. (The Jupiter password, which
is factory set at 999999, is discussed in more detail on page 5−22.) With a password level of 90 or higher, the panel’s PRO-
TECT and LOCK keys can be used to force unprotect/unlock any output.

To restore the panel to its normal password level, see LOG immediately below.
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LOG — Logout (CP 3000 Panel Only)

If the Enter New Password or Raising Password Level functions just described have been used and you later wish to log out
to prevent unauthorized operation, press MENU, MORE, and LOG. The panel will revert to the password level defined on
the MPK Devices menu (page 5−107).
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CP 3010 Expansion Panel Operation

The CP 3010 can be used as a companion to the CP 3000 Switcher Control Panel (described immediately below) or to the
MC 3000 Machine Control Panel (see page 6−131).

CP 3010 AS COMPANION TO CP 3000 SWITCHER CONTROL PANEL

For multi−bus control the desired source can be selected on the CP 3000; the CP 3010 would then display the names of up
to eight destinations, beneath which are the corresponding TAKE keys; one of these would be pressed to complete the switch.
20 pages of eight destinations each can be scrolled to display up to 160 possible destinations. To return to page 1, press the
UP and DOWN arrows at the same time.
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Figure 6−27. CP 3010 Expansion panel.
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Dynamic Assignment of Outputs to the TAKE Keys

The process of assigning outputs to the expansion panel is the same as assigning the output to be controlled by the CP 3000,
except that TAKE is pressed on the expansion panel rather than on the CP 3000:

1. On the CP 3000, press MENU, then OUT. Then select the category and number of an output.

2. On the expansion panel, scroll to the desired page and press the appropriate TAKE key.

Deleting an Output on TAKE Key

To delete an output that has been dynamically assigned to the expansion panel, use the CP 3000 to select an output that is not
defined and press the appropriate TAKE key on the expansion panel.
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Permanent Assignment of Outputs to the TAKE Keys

Outputs can also be assigned permanently, as described on page 5−79.

Note: If an output is permanently assigned to a CP 3010 button, but that output is later removed from the CP Output
table, and the new set downloaded, the CP 3010 will continue to display the name of the output until the output
is manually deleted. To do this, select an output that is not defined and press the appropriate TAKE key on the
expansion panel.

Machine Control

When the CP 3010 is used as an expansion panel for a CP 3000 control panel, Start/Stop machine control can be provided

by the  and >  buttons.

Configuration for machine control applications and the method by which machines are assigned to the panel are discussed
on page 5−148.
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CP 3020 Push Button Control Panel operation

Installation of this panel is shown on page 2−37. See also page 2−43.

The CP 3020 is a single bus control panel that can select one of 20 inputs using the button−per−input technique. The number
of inputs can be increased by means of the CP 3021 Expansion Panel.

Figure 6−28. CP 3020 Push Button Control panel (top) with CP 3021 Push Button Expansion panel.

82 41 42 DM

C1 C2 C3 C4 T1 T2 R1 R2 NTV1 V2 V3 V4 V5 SA SB E1 E2 E3 LOCK CHOP

LO1 LO2 LO3 LO4 81M1 M2 M3 M4 M5 LR LS P1 P2 P3

V6

RR

LOCK MODE

The LOCK button can be pressed at any time to lock* the output controlled by the panel; the button will illuminate to show
that the lock is in effect. Press LOCK again to unlock.

If the LOCK button is flashing, the output has been locked by another panel. The panel used to lock the output must also be
used to unlock the output. For additional protect/lock information  − see page 6−12.

CHOP MODE

To chop* between two inputs, select the first input, then press CHOP, then the second input. The CHOP button will illuminate
to show that the output is in chop mode. To terminate the chop, select another input. For additional chop information − see
page 6−13.

BUTTON/LAMP TEST

See page 2−59.

*see Glossary
§ A complete copy of this manual is also available on the Technical Publications Library CD−ROM supplied with the manu-

al you are now reading.
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CP 3800A Eight Character Control Panel

Figure 6−29.
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OVERVIEW

The CP 3800A is a universal, eight−character mnemonic, switcher and machine control panel. Display and operating modes
include:

• Preset Display
• Status Display
• Multilevel Status Display
• Multilevel Preset Display
• Destination Display
• Multiple destination Status Display
• Panel ID Display
• Password Level Display
• Lock Display
• Protect Display
• Audio Mode Display
• Category/Number Source Selection

• Category/Number Destination 
Selection

• Take Source
• FlipFlop Take
• Take Destination
• Chop Source
• Lock
• Protect
• Level Breakaway
• Sticky Level Breakaway
• Define/Assign Multiple Ganged 

Destinations (Dub Switching)

• Audio Modes all levels
• Audio Modes individual levels
• Sticky Audio Modes individual levels
• Override Source Selection
• Override Destination Selection
• Define/Assign Overrides
• Initiate Sequences
• Define Sequences
• Tie Line Display
• Play a source
• Stop a source

When operated in the “multiple destination mode,” the CP 3800A can be used to control from 1 to 80 destinations, with the
names of eight of those destinations (and the status for each) on display simultaneously. In the “single destination mode,” one
destination is selected for control, and the display window shows the status for each level of that destination (video, left audio,
right audio, etc.).

The push buttons are capable of both green and red back lighting, with green generally used to show a selected function and
red to indicate an operational mode in progress. Relegendable buttons are used to allow user−defined categories.

Note: This control panel uses an eight−character “CP 3800” type CP Level set (page 5−58), CP Input set (page
5−62) and CP Output set (page 5−78). The panel is also defined in the MPK Devices table (page 5−107), and if
used for machine control, the Machine Control Devices table (page 5−135). It can also use custom CP Category
sets (page 5−101).
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DISPLAY

In general, the top row of the display is used to show status or operational modes, error messages, page numbers and instruc-
tions. The bottom row shows selection items corresponding to the row of soft keys under the display (i.e. levels, destinations,
etc.).
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Camera_1 Camera_2 Studio_a Clr_Bars VTR_02 NetworkA NetworkABlack

F1 F2 F3 F4 F5 F6 F7 F8

Figure 6−30.

1

SOFT KEY GROUP

Eight soft keys are arranged across the bottom of the display to correspond with the display space above each button. These
buttons are dynamically reassigned depending upon the mode selected in the Menu Mode Group (Figure 6−32) and upon the
defined CP sets for the panel. Destination selections and menu selections illuminate in green.† Pending level, audio, or config-
uration selections illuminate in red as described in the appropriate sections below.
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UNDO

TAKE

Figure 6−31.

MENU / CONTROL GROUP

The up/down buttons (Figure 6−31) provide scrolling control over all defined menu pages. They will not scroll to any unde-
fined pages except in the case of adding destination assignments and defining overrides and sequences; in this case, they will
allow access to one blank page beyond any page that currently has assignments. Up to 20 pages are allowed. A single digit
in the upper left denotes the page number (1−9, 0 for page 10).

The UNDO button returns the panel and any affected outputs to the state it was in prior to the last TAKE. Successive selection
of this button will allow toggling between two selections (allows undoing an undo). The undo function will also undo Over-
rides.

† In this discussion, “illuminate in green” refers to high (bright) green. “Low” green is always on.
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Note: The “undo−undo” (toggle) function will not re−establish “special stereo switches” for Venus (mix, reverse,
etc.)

The TAKE button executes any change(s) which has(have) been selected. When any action has been selected that requires
a TAKE to be completed, this button will illuminate in red to indicate that it is “armed.”
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Figure 6−32.

MENU MODE GROUP

The menu mode group determines the operational mode of the panel. If no buttons are illuminated, the panel is in “multiple
destination” state, allowing source assignments to any of the destinations shown on the menu. The additional operational
modes are:

• MENU mode − used to access less frequently needed functions, run diagnostics, and to configure the panel. For
details, see page 6−45.

• AUDIO mode − used for Venus special stereo switching. For details, see page 6−43.

• SEQ − Displays available sequence names for selection and enable definition of new sequences. See page 6−57.

• OVERRIDES − Displays available override names for selection and enables definition of new overrides. See
page 6−53.

• LEVEL − selects levels for a breakaway level Take. See page 6−41.

• DEST − function varies according to panel configuration. If panel has been configured for selectable multiple/
single destination mode, DEST is used to switch between modes and to change output soft key assignment. In
single destination mode, DEST is used to select output for control. These modes are described below under
“Operation.”

When any mode is selected, it will illuminate green to indicate that new mode. If a definition is in progress (i.e. defining a
sequence) the mode will illuminate in red to indicate a process in progress.
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ÎÎÎ
ÎÎÎ

ÎÎÎ
ÎÎÎ

CLEARPROT/
LOCK

Figure 6−33.

PANEL CONTROL GROUP

The bottom two buttons below the Mode group select protection or locking (PROT/LOCK) and clear category/number selec-
tions and/or cancel ongoing definitions (CLEAR). Protect/lock mode is described on page 6−61.

The CLEAR button will clear any category/number selection if one is in progress. If none is in progress the CLEAR button
will return the panel to either single or multiple destination operational mode in increments of embedded menus or operations
− each button press will escape back one operational level.
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Figure 6−34.

CATEGORY AND NUMBER GROUP

Twenty buttons in a 4 high by 5 wide array form a traditional category and number group.

As an example, if the panel is configured to use category prompting, during source assignment all valid categories will illumi-
nate in green. Once a category has been selected, all valid numbers will illuminate in red. Once a category and one digit have
been selected, only remaining valid numbers will remain lit.

OPERATION

This panel can be system defined (at the file server) for:

— Multiple Destination Mode operation, front−panel selectable to Single Destination mode; or,

— Single Destination Mode only operation.

For front−panel selectable, Multiple or Single Destination Mode operation, a “Y” is placed in the Expansion column of the
MPK devices table (see “Expansion” on page 5−109). For Single Destination Mode only operation, an “N” is entered.
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MULTIPLE DESTINATION MODE

This mode, sometimes referred to as “multi−bus” or “full−matrix control” mode, is in effect when none of the “mode” buttons
are illuminated. This mode displays the top level status for eight destinations.

Note: If no destinations are defined for the panel, upon powering up the panel will go into the “adding destination
assignment” mode as explained on page 6−34. Follow the steps outlined to define at least one destination to one
button.

The first line contains the status of those eight destinations (defined name in the CP Input set for the selected source) plus
a page number in the upper left hand corner. The second line of the display will show up to eight destinations.

Figure 6−35. Example Multiple Destination Display Page − Home
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From this page you can:

• Scroll to other pages

• Select destination(s) and make a source change

• Add or change a destination assignment

• Erase a destination assignment

You can also change Protect/Lock status, level selections, and audio modes once a destination(s) has been selected. Those
operations are described in the appropriate separate sections in this document.

Scrolling to Other Pages

Scrolling to other pages is achieved with the Up/Down Arrows in the Menu Control Group. A maximum of 20 pages are acces-
sible, each page numbered in the upper left.
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MULTIPLE DESTINATION MODE (CONT’D)

Selecting Destination(s) and Making a Switch

1. Select the destination soft key(s).

Select the soft key under the desired destination (first scrolling to a different page if required). That soft key will illumi-
nate green, and if Category Prompting is enabled, valid categories in the Category/Number Group will also illuminate
green.

Category/number selections will be ignored until a soft key has been selected. Reselecting an illuminated soft key button
will toggle it off and cancel the operation. Selecting another soft key will add destinations to be changed to the same
source; up to all 80 destinations may be simultaneously selected. Selecting CLEAR will cancel all illuminated destina-
tion soft keys and return the panel to multiple destination home state. If the panel has not been configured for prompting
(page 6−51), operation will be identical, except the category and number keys will not illuminate.

2. Select the source category/number.

Initiate a source selection by selecting the desired category from the illuminated choices; selection of an invalid category
will have no effect. If a destination has not yet been selected, you will have the opportunity to select one now. Upon
selection of one of the illuminated Category buttons, all valid numbers will illuminate in red; the display will change
to entry mode. Appropriate updates to the display will occur as in the CP 3000 entry process, with the additional display
of the “Number =” selection as shown below. The selected destination soft key(s) will also change to red to indicate a
selection in process.

                            Destination = PRODCTN4

         Category = Vid_Tape     Number = ???         New Source =  ????????

Figure 6−36. Example Single Destination Assignment Display Page − Category Selected.

As valid numbers are entered, the display will update appropriately as defined in the sets. Selection of an invalid number
(not illuminated) will have no effect. If the panel has not been configured for prompting, operation will be identical,
except the category and number keys will not illuminate.

Examples of numeric entries are shown below:

                            Destination = PRODCTN4

         Category = Vid_Tape     Number = 1           New Source =  VTR_0001

Figure 6−37. Example Single Destination Assignment Display Page − Category & Digit Selected.

Once a category and one digit have been selected, only remaining valid numbers will remain lit.
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MULTIPLE DESTINATION MODE (CONT’D)

                            Destination = PRODCTN4

         Category = Vid_Tape     Number = 12          New Source =  VTR_0012

Figure 6−38. Example Single Destination Assignment Display Page − Category & Two Digits Selected.

If multiple destinations have been selected, the top line will display as many as possible (up to 6) and then indicate addi-
tional destinations with ellipses (...).

  Destination = PRODCTN1, PRODCTN2, PRODCTN3, PRODCTN4, ENGINRNG, EXTFEED9

         Category = Vid_Tape     Number = 12          New Source =  VTR_0012

Figure 6−39. Example 6 Multiple Destination Assignment Display Page − Category & Two Digits Selected.

  Destination = PRODCTN1, PRODCTN2, PRODCTN3, PRODCTN4, ENGINRNG, EXTFEED9,...

         Category = Vid_Tape     Number = 12          New Source =  VTR_0012

Figure 6−40. Example Over 6 Multiple Destination Assignment Display Page − Category & Two Digits Selected.

3. Press TAKE.

The source assignment operation may be completed using the TAKE button any time a valid selection has been made.
This will be indicated by the presence of a source name in the display after the display of “New Source =” and the fact
that the TAKE button will be illuminated.

Selection of the CLEAR button at any time during the category/number process will place the panel back in “ready for
category” mode. A second selection of clear will cancel the operation and revert to home state.

At any time after destinations have been selected and prior to selecting TAKE, levels and audio modes may also be se-
lected as described in the appropriate section below.

Note:  If Sticky Outputs (page 6−50) are selected, destination soft key selections will remain selected until
changed or cleared. To clear these selections, press the CLEAR key before selecting a destination.
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MULTIPLE DESTINATION MODE (CONT’D)

Adding or Changing a Destination Soft Key Assignment

A destination may be added to any unused location in the display. One additional page will be available when adding destina-
tion assignments.

Changing a destination that has already been defined on the panel is also possible.

Note:  Destinations that have been defined in the panel’s CP Output set (page 5−79) cannot be changed. If an illegal
attempt to change a destination is made, the display will provide the following warning:

Existing Destination STUDIO_A Is System Defined And Can Not Be Changed

     Category = Vid_Tape     Number = ???         New Source =  ????????

Figure 6−41. Example Destination Assignment In Process − Defined Destination Warning.

Adding or changing a destination is achieved by the following sequence:

1. Press the DEST button twice.

The button will blink red. The displayed change menu will appear:

1   Changing Destination − Use Up/Down Buttons and Soft Key to Select Position

  VTR_0123  VTR_0124  VTR_0125  VTR_0126  STUDIO_A  STUDIO_B  STUDIO_C  ENGINRNG

Figure 6−42. Example Destination Assignment − Change Menu.

All user defined locations will illuminate in green.

2. Select the soft key under the desired destination location.

3. Select the Category and Number for the destination.

The selected soft key will change to red. The display will update to indicate that a destination assignment is in process,
Category and number keypad entry, CLEAR, TAKE and display function as already described:

                                Assign Destination

         Category = STUDIO       Number = 3       New Destination =  STUDIO_C

Figure 6−43. Example Destination Assignment In Process − Category & Two Digits Selected.

4. Press TAKE.
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MULTIPLE DESTINATION MODE (CONT’D)

When assigning a destination to a soft key position for the first time, selecting the TAKE button will complete the assign-
ment and clear all illuminated buttons.  The panel will remain on the current page, with the page number displayed in
the upper left corner.

5. If changing an existing assignment, press TAKE again.

To change an eligible destination, one additional TAKE after the following warning display will be required to complete
the operation:

Overwrite Existing Destination: STUDIO_A? Select TAKE to Execute, CLEAR to Cancel

         Category = STUDIO       Number = 3       New Destination =  STUDIO_C

Figure 6−44. Example Destination Assignment In Process − Confirming replacing a destination.

Erasing a Destination

Destinations may be erased if no longer needed from the multiple destination home mode with the following sequence as in
changing a destination.

1. Select the DEST button twice; it will blink red.

The display will update to indicate that a destination assignment is in process.

2. Select the soft key under the desired destination location to be erased; all user defined destinations will illuminate in
green. The selected soft key will change to red.

3. Select CLEAR.

If CLEAR is selected before any keypad operation has been initiated, that soft key destination will be marked for erasure
and the user will see the following display:

1 ERASE Existing Destination: STUDIO_A? Select TAKE to Execute, CLEAR to Cancel

  VTR_0123  VTR_0124  VTR_0125  VTR_0126  STUDIO_A  STUDIO_B  STUDIO_C  ENGINRNG

Figure 6−45. Example Destination Erasure In Process − Selected destination blinking.

4. Select TAKE.

This will complete the clear for the selected destination, returning the panel to multiple destination home state. Selecting
CLEAR a second time will cancel the operation, also returning the panel to multiple destination home state. Reselecting
the blinking DEST button will cancel the operation and return the panel to the multiple destination home state.
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MULTIPLE DESTINATION MODE (CONT’D)

Entering Single Destination Mode

This mode displays multi−level status for a single destination.

1. Press the DEST button.

The DEST button will illuminate in green.

2. Select the destination to be controlled:

— If the desired destination has already been assigned to a soft key, select the key.

— If the desired destination has not been assigned to a soft key, press DEST again. Button should now be flash-
ing red. Select a soft key that is lit high green (i.e., one that is front−panel assignable). Select a category and
number; press TAKE. (If the button has already been assigned you will need to press TAKE again.) Then go
back to Step 1.

The DEST button will remain illuminated in green to indicate single destination mode.

3. For operating instructions while in the single destination mode, refer to page 6−37.

4. To return to Multiple Destination mode, press the green DEST button a second time.
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SINGLE DESTINATION MODE  (“SINGLE−BUS CONTROL”)

This mode displays multi−level status for a single destination. The DEST button remains illuminated in high green.

As explained previously, this panel can be system defined at the file server for Multiple/Single Destination Mode operation,
or Single Destination Mode only operation. For front−panel selectable, Multiple or Single Destination Mode operation, a “Y”
is placed in the Expansion column of the MPK devices table. For Single Destination Mode only operation, an “N” is entered.

— If the panel is system−defined for Single Destination Mode only operation, the “DEST” button is always illu-
minated in high green (cannot be turned off by the operator).

— If the panel is system−defined for Multiple/Single Destination Mode, selection of Single Destination Mode is
described on page 6−36.

1               Destination = PRODCTN4     Source = VTR_0001

  VTR01VID  VTR01AL   VTR01AR   VTR01A3   VTR01A4   VTR01TC   VTR01CTL  VTR01DIG

Figure 6−46. Example Single Destination Mode Display Page − Home State.

As shown in the above example, the first line of Single Destination home state shows the destination mnemonic, the source
mnemonic, and the page number. The second line shows status for that destination.

Page numbers here are only provided if more than eight levels exist. Levels are shown on the second line as defined for the
destination.

When in this mode, source assignments can be made at any time, so if the panel supports prompting (page 6−51), valid catego-
ries are also illuminated in green.

From this page you can:

• Scroll to other pages to view additional levels (if applicable)

• Select a new destination

• Make a source change

A user can also change a Protect/Lock status, level selections and audio modes. Those operations are described in the ap-
propriate separate sections in this document.
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DEST

SINGLE DESTINATION MODE (CONT’D)

Scrolling to Other Pages

Scrolling to other pages is achieved with the Up/Down Arrows in the Menu Control Group. Only pages containing levels will
be accessible. The presence of page numbers in the upper left corner indicate that more than eight levels have been defined
for the selected destination.

Selecting a Destination

Note: This procedure varies according to system definition.

1. Press DEST.

— If the button changes to red, the panel is system−defined for Single Destination mode. The available destina-
tion category buttons will illuminate in green. Go to Step 2.

— If the button lamp goes to low green, the panel is system−defined for selectable Multiple/Single Destination
mode. Go to Step 1a.

a. Press DEST again.

— If the desired destination has already been assigned to a soft key, select the key. This completes the proce-
dure.

— If the desired destination has not been assigned to a soft key, press DEST again (3rd time). Button should
now be flashing red. Select a soft key position (front−panel assignable positions are indicated by high
green). Go to Step 2.

                         Current Destination = PRODCTN4

         Category = ?????        Number = ???      New Destination = ????????

Figure 6−47. Example Destination Assignment Display Page − No Selections made.
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DEST

SINGLE DESTINATION MODE (CONT’D)

2. Select a category.

After a valid category has been selected, the display will reflect the choice and if prompting is enabled, the valid number
buttons will illuminate in red in the category/number group.

                         Current Destination = PRODCTN4

         Category = Vid_Tape     Number = ???      New Destination = ????????

Figure 6−48. Example Destination Assignment Display Page − Category  Selected.

3. Select a number.

Numbers may be selected as indicated by valid red illumination.

                         Current Destination = PRODCTN4

         Category = Vid_Tape     Number = 1        New Destination = VTR_0001

Figure 6−49. Example Destination Assignment Display Page − Category & One Digits Selected.

                         Current Destination = PRODCTN4

         Category = Vid_Tape     Number = 12       New Destination = VTR_0012

Figure 6−50. Example Destination Assignment Display Page − Category & Two Digits Selected.

4. Press TAKE. (A second TAKE will be needed to overwrite an old assignment.)

The destination selection operation may be completed using the TAKE button any time a valid selection has been made.
This will be indicated by the presence of a source name in the display after the display of “New Destination =” and the
fact that the TAKE button will be illuminated.

If the panel leaves the Single Destination mode (DEST button goes off), re−enter the mode by pressing DEST again and
selecting a destination to be controlled.

Pressing CLEAR at any time during the entry process will return the panel to the Destination Assignment No Selections
Made Mode. Selection of CLEAR at that state or reselecting the red DEST button at any time will cancel the operation
and return the panel to Single Destination Mode Home State.
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SINGLE DESTINATION MODE (CONT’D)

Making a Switch

1. Select a category.

To select a new source, the user enters Source Assignment Mode by selecting any of the green illuminated Category
buttons. The display will update as shown below and if prompting is enabled (page 6−51), the available source number
buttons will illuminate in red.

               Destination = PRODCTN4     Current Source = VTR_0001

         Category = Vid_Tape     Number = ???         New Source =  ????????

Figure 6−51. Example Single Destination Source Assignment Display Page − Category Selected.

2. Select a number.

Numbers may be selected as indicated by valid red illumination

               Destination = PRODCTN4     Current Source = VTR_0001

         Category = Vid_Tape     Number = 1           New Source =  VTR_0001

Figure 6−52. Example Single Destination Source Assignment Display Page − Category & One Digit Selected.

               Destination = PRODCTN4     Current Source = VTR_0001

         Category = Vid_Tape     Number = 12          New Source =  VTR_0012

Figure 6−53. Example Single Destination Source Assignment Display Page − Category & Two Digits Selected.

3. Press TAKE.

The source assignment operation may be completed using the TAKE button any time a valid selection has been made.
This will be indicated by the presence of a source name in the display after the display of “New Source =” and the fact
that the TAKE button will be illuminated.

Pressing CLEAR at any time during the entry process will return the panel to the Destination Assignment No Selections
Made Mode. Selection of CLEAR at that state or reselecting the red DEST button at any time will cancel the operation
and return the panel to Single Destination Mode Home State.

At any time prior to selecting TAKE, levels and audio modes may also be selected as described in the appropriate section
below.
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LEVEL SELECTION MODE (“SPLIT” OR “BREAKAWAY” SWITCHING)

This mode is in effect when the “LEVEL” button is illuminated.

Level selection mode can be entered at any time. This mode is accessed either by directly selecting the LEVEL button or by
selecting any level soft key when in single destination mode. This mode is indicated by the illumination of the LEVEL button:
green if all levels are selected, red if any subset of levels are selected. The display will also reflect this mode as shown below:

1  VIDEO     LEFT     RIGHT     TIMECODE  DATATX    DATARX    AES_LEFT  AESRIGHT

  VTR01VID  VTR01AL   VTR01AR   VTR01A3   VTR01A4   VTR01TC   VTR01CTL  VTR01DIG

Figure 6−54. Example Level Selection Mode Display Page.

From single destination mode, pressing any soft key will present this display. The behavior of the button (turning “on” or
“off”) will depend upon the panel type. If defined with Sticky Levels in the panel Configuration menu (page 6−50), the button
will change from its previous state while other buttons remain as they had been selected. Otherwise, the button will light in
red and all other levels will be deselected. Additional levels can also be selected from this state. Pages can be scrolled if need
be to access additional levels.

Entering Level Selection mode from multiple destination mode or when LEVEL is selected starts with all soft keys “off”
unless the panel was defined with sticky levels. In that case, entering Level Selection mode displays last selected levels by
illuminating the appropriate soft keys.

As many levels may exist (up to 64), it may be desirable for the operator to start this selection from all levels “on” rather than
all levels “off.” Double punching the LEVEL button will place the panel in that state (i.e. level selection mode with all levels
turned on). Note that all levels will switch when level soft keys are either all on or all off.

If accessed from single destination mode, the levels display line (line 2) does not change. If accessed from multiple destination
mode, all valid levels for all destinations selected will be displayed. The operator may select levels which have no impact
for some selected destinations; the level soft key will blink red when this condition occurs. When a take will only impact that
selected level where it is valid, in addition to blinking the soft key, the display will temporarily show the following message
until the next selection or time−out:

1     Level Selection Mode − LEVEL SELECTED NOT VALID FOR ALL DESTINATIONS

  VTR01VID  VTR01AL   VTR01AR   VTR01A3   VTR01A4   VTR01TC   VTR01CTL  VTR01DIG

Figure 6−55. Example Level Selection Mode Display Page − Valid Level Warning Display.

Note that this can even occur in the middle of a category/number operation. If no additional operations are needed, TAKE
can also be selected at this time (if illuminated) to complete any pending operation.

Any selected level soft keys remain illuminated in red when returning to single destination mode.
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LEVEL SELECTION MODE (CONT’D)

The soft keys return to their selected destination states illuminated in green when returning to the multiple destination mode.
The LEVEL button blinks in red to indicate that breakaway levels have been selected. It can be reselected at any time to ex-
amine the state of the level soft keys.

Making a Split Switch—Multiple Destination Mode (“DEST” Button OFF)

1. Use a soft key to select a destination.

2. —Press LEVEL and select level(s) to be switched. (Lamp ON = selected).

−or−

— Press LEVEL twice and de−select level(s).

3. Select the source category/number.

( 4. Optional: Repeat Steps (2) and (3) above if another level and source need to be switched with a single TAKE. )

5. Press TAKE.

6. To confirm the split, press DEST and select the destination. This will display status for all levels.

Making a Split Switch—Single Destination Mode (“DEST” Button ON)

1. —Select level(s) to be switched. (Lamp ON = selected).

−or−

— Press LEVEL twice and de−select level(s).

2. Select the source category/number.

( 3. Optional: Repeat the above steps if another level and source need to be switched with a single TAKE. )

4. Press TAKE.
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AUDIO CONTROL MODE (VENUS SPECIAL STEREO SWITCHING)

This mode is in effect when the “AUDIO” button is illuminated.

Note: Audio Control mode can only be used if an appropriately configured Venus switcher is connected. (For more
information see “Audio” on page 5−43.)

This mode is accessed by directly selecting the AUDIO button. If no such levels have been defined, the button will have no
effect. This mode is indicated by the illumination of the AUDIO button: green if only normal audio mode(s) selected, red if
any audio level(s) is set to other than normal. The display will also reflect this mode as shown below:

1            Left      Right     X−left    X−right

             Norm−L    Norm−R    Norm−L    Norm−R

Figure 6−56. Example Audio Selection Mode Display Page − Normal Modes Only.

In this mode, any appropriately defined stereo levels appear in the top line in the same position they appear in Level display.
The panel will automatically display the first page with defined audio levels. The bottom line shows what audio mode is se-
lected.

Selecting the soft key under any level will consecutively cycle through valid audio modes. For a left channel these would be:
Revrs−R, Mix, and back to Norm−L. For a right channel these would be Revrs−L, Mix, and back to Norm−R. In the following
example, three of the four levels have been changed from normal and those respective soft keys will be illuminated in red:

1            Left      Right     X−left    X−right

             Revrs−R   Norm−R    Mix       Revrs−L

Figure 6−57. Example Audio Selection Mode Display Page − Various Modes Selected.

Deselecting the AUDIO button returns the panel to exactly whatever state it was in prior to entry into this mode. Note that
this can even occur in the middle of a category/number operation. If no additional operations are needed, TAKE can also be
selected at this time (if illuminated) to complete any pending operation.

The soft keys return to their previous states when returning to the previous mode. The AUDIO button blinks in red to indicate
that special audio mode will be in effect for the next take. In multiple destination mode, special Audio Mode status will also
be shown for each destination displayed in the 1st character position with a blinking “A.” When in single destination mode
or Levels mode of multi−destination mode, the 1st character position of each level will also reflect special audio status of that
level with the blinking “M” for Mix, or “R” for Reverse. The AUDIO button can be reselected at any time to examine the
state of the audio levels.

The state of the Audio modes depend upon the panel type. If defined in the panel configuration menu with sticky audio, the
audio mode selections will remain in effect across any number of takes, if not, audio modes reset after each take.
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AUDIO

AUDIO CONTROL MODE (CONT’D)

To Perform a Special Stereo Switch:

1. Select a destination and a source.
2. Press AUDIO. 
3(a). Toggle the Left channel soft key to the desired mode:

� NORM L − Use left audio for this channel

LEFT LEFT (Left signal on Left channel)

� MIX − Mix left and right on left channel

LEFT

RIGHT

LEFT (Left + Right signals on Left channel)

� REVERSE R − Cross right channel signal over to left channel

RIGHT

LEFT (Right signal on Left channel)

3(b). Toggle the Right channel soft key to the desired mode:

� NORM R − Use right audio for this channel

RIGHT RIGHT (Right signal on Right channel)

� MIX − Mix left and right on left channel

LEFT

RIGHT RIGHT (Left + Right signals on Right channel)

� REVERSE L − Cross left channel signal over to right channel

LEFT

RIGHT  (Left signal on Right channel)

4. Press TAKE.
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MENU MODE 

This mode is in effect when the “MENU” button is illuminated.

Menu mode is used to access less frequently needed functions, run diagnostics, and to configure the panel. Select the MENU
button to enter this mode. That button will illuminate in green and the panel will present the following display:

                       Menu Page − Select Desired Soft Key

VTR CNTL          DIAGNOSTIC           CHOP             CONFIG         PASSWORD

Figure 6−58. Top Level Menu Page.

From this menu any of the five choices presented may be selected on the appropriate green illuminated soft keys.

VTR Control

When this soft key is selected, the panel goes into one of two modes, depending upon whether it was in single or multi destina-
tion mode prior to the selection of the menu button. The MENU button will change to red and remain illuminated.

If no machine control has been defined for the panel, “VTR CNTL” will not be selectable and the following will be displayed:

                     Machine Control NOT Defined For This Panel

VTR CNTL          DIAGNOSTIC           CHOP             CONFIG         PASSWORD

Figure 6−59.

Single Destination VTR Control

When the CP 3800A has been configured for machine control (using the Machine Control table, page 5−139) and if a valid
controlled VTR source has been switched to the destination, the panel will present the following menu display:

              Destination = VTR_0001        Source = VTR_0002

 PLAY      STOP      READY     CUE       MARK      REWIND    F FWD     RECORD

Figure 6−60. Example Single Destination Machine Control Page.

From this page, any of the displayed machine control functions can be selected. “Record” is selected by pressing both the
PLAY and RECORD soft keys. All other commands are accessed by single button selections.
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MENU

MENU MODE (CONT’D)

If a source is selected which does not support machine control the display will indicate as follows:

 Destination = PRODCTN4 NO MACHINE CONTROL DEFINED for <Bars    >

 PLAY      STOP      READY     CUE       MARK      REWIND    F FWD     RECORD

Figure 6−61. Example Single Destination Machine Control Page − No Machine defined warning.

If the destination supports machine control but the machine does not respond, the display will indicate that with the following
display:

 Destination = PRODCTN4     Source = VTR_0002     MACHINE IS OFF LINE

 PLAY      STOP      READY     CUE       MARK      REWIND    F FWD     RECORD

Figure 6−62. Example Single Destination Machine Control Page − Not on Line Warning.

To leave this mode, the user selects the red illuminated MENU button and will return to normal single destination operation
mode.

Multiple destination VTR Control

If VTR control is selected from the menu page, and menus entered from multi−destination mode, the Menu button will illumi-
nate in red and the panel will display as follows:

1 VTR_0123  VTR_0124  VTR_0125  VTR_0126  Test1    Bars       VTR_0333  VTR_0456

  STOPPLAY  PLAYSTOP  OFF LINE  SHUTTLE                       NO TAPE   STOPPLAY

Figure 6−63. Example Multiple Destination Machine Control Page.

Machines which are stopped will report “STOPPLAY” with “ STOP” blinking.  Machines which are playing will report
“PLAY STOP” with “PLAY ” blinking. Sources that are not responding will show the words OFF LINE and sources that are
not interfaced will show no status. If the device is in some other mode such as shuttling, the display will so indicate but no
control is offered. Wherever PLAY / STOP appears, the associated soft key will illuminate in green. Each successive selection
of this button will toggle the play/stop condition of the device.

To leave this mode, select the red illuminated MENU button and the panel will return to normal multiple destination operation
mode.

Scrolling to Other Pages

Scrolling to other pages is achieved with the Up/Down Arrows in the Menu Control Group. Presence of page numbers indicate
that more than eight outputs have been defined for the panel.
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Diagnostics

Upon selection of the Diagnostics soft key of the menu page, the panel will enter the firmware diagnostics mode and the fol-
lowing display will be shown:

DIAGNOSE LED TEST    MENU

   MENU

Figure 6−64. Menu Diagnostics Select Page.

Press the up and down arrows to scroll to the desired selection. Press TAKE to execute the desired selection.

To exit the diagnostics mode press CLEAR at any time. (It may be necessary to press CLEAR twice.)

Info

Info displays the panel’s Application (PROM) version. Pressing UP will advance to the Xilinx FPGA* version, the security
flag setting, the Variant version, and the PCB (hardware) version. Press CLEAR to exit.

Baud Rate

When selected, this option displays the current baud rate for the panel. Press DOWN to decrease the baud rate, UP to increase.
Available baud rates are: 38400, 19200, 9600, 4800, 2400, and 1200. Pressing TAKE will program the changed setting;
CLEAR will cancel.

If the message “Remove MPK conn” appears, the MPK cable must be disconnected before the change can be made.

The baud rate must agree with the setting for the CM 4000 port used by the panel (see Serial Protocol on page 5−30).

Panel ID

When selected, this option displays the current MPK hexadecimal address for this panel and permits entry of a new address
(the MPK cable must be disconnected before making a change). Use the UP and DOWN arrows to select the desired number
(0−9) or letter (A−F) and press TAKE to advance to the next position. (You can also use the numeric key pad and the ABCD
keys to enter numbers 0 through D.)

The address must agree with the setting for the panel on the MPK Devices table (see page 5−107).

Pressing TAKE will program the newly entered address; CLEAR will cancel.

* Defined in Glossary section
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MPK Test

This diagnostic, which requires the panel to be disconnected from the MPK data cable, is used for factory testing of the MPK
port.

Pressing any key will exit the test and return the panel to the Diagnostics menu.

Illumination adjustment

This option allows the user to change the “Low” and “Medium” levels of green button illumination, the “Low” and “Medium”
levels of red button illumination, and the level of LED (display character) illumination. The “High” button levels are not ad-
justable.

The “Low” green level is used for normal button lighting. “High” green and “high” red are also used, but these are not adjust-
able.

The brightness of the LED display characters can also be adjusted.

For each setting, use the UP and DOWN buttons to change to the desired brightness and press TAKE. Press CLEAR to exit.

Burn In

This test rotates through the button lamp and Display tests continually. Press CLEAR to cancel.

Keyboard test

This diagnostic displays the number of each button as it is pressed. Pressing the TAKE key will change the lamp color. Press-
ing CLEAR twice exits.

Display test

This test cycles through and displays all legal characters. The test will stop after one cycle. Pressing CLEAR exits.

LED test

This test cycles through the button lamps (LEDs) and illuminates them in green and then red. The test will stop after one cycle.
Pressing CLEAR during this test will cancel this test and return the panel to the beginning of the current diagnostic. Pressing
CLEAR again will return the panel to the Home mode.
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Chop

This menu selection allows chopping alternatively between the previously selected source and a new source. Upon selection
of the CHOP soft key, the MENU button will illuminate in red and the following display will be shown:

               Enter Input to CHOP and Press TAKE to Complete

Category = Vid_Tape     Number = ??           New Source =  ????????

Figure 6−65. Menu Diagnostics Select Page.

The user may then set up any kind of basic or complex source selection per normal operation, with the exception of audio
modes. Irrelevant keys will be ignored at this time; i.e. MENU, DEST, SEQ, OVERRIDES, AUDIO, PROT/LOCK.

When the desired source selection is complete, press the TAKE button and the CHOP will begin. The panel will return to home
mode and the MENU lamp will extinguish.

Chop mode is indicated by a flashing letter “c” in the status display. In single destination mode, the “c” will appear on each
level that is in chop mode.

For additional chop information − see page 6−13.
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Config

Upon selection of the Configuration soft key of the Menu page, the MENU button will illuminate in red and the following
display will be shown:

               Menu Configuration Page − Select Desired Soft Key

  Output                  Level                Audio                Prompting

Figure 6−66. Menu Configuration Select Page.

Pressing the red MENU button again, or CLEAR, will exit the configuration mode.

Sticky Outputs

On selection of the Output soft key in the configuration menu, the following display will appear:

                    Sticky Output Mode: ON

Press TAKE to turn Sticky Outputs   OFF  − Clear to Exit

Figure 6−67. Menu Configuration − Sticky Outputs Page.

Pressing TAKE will cause the sticky output mode to toggle. CLEAR will return the panel to the previous page.

Sticky Levels

On selection of the Level soft key in the configuration menu, the following display will appear:

                    Sticky Level Mode: OFF

Press TAKE to turn Sticky Levels   ON   − Clear to Exit

Figure 6−68. Menu Configuration − Sticky Levels Page.

Pressing TAKE will cause the sticky level mode to toggle. CLEAR will return to the previous page.

Sticky Audio

On selection of the Audio soft key in the configuration menu, the following display will appear:
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                    Sticky Audio Mode: OFF

Press TAKE to turn Sticky Audio   ON  − Clear to Exit

Figure 6−69. Menu Configuration − Sticky Audio Page.

Pressing TAKE will cause the sticky audio mode to toggle. CLEAR will return to the previous page.

Category Prompting

On selection of the Prompting soft key in the configuration menu, the following display will appear:

                    Category Prompting Mode: ON

Press TAKE to turn Category Prompting   OFF  − Clear to Exit

Figure 6−70. Menu Configuration − Category Prompting Page.

Pressing TAKE will cause the category prompting mode to toggle. CLEAR will return to the previous page.

Password Levels

Upon selection of the Password soft key of the menu page, the MENU button will illuminate in red and the following display
will be shown:

       Panel Security Level = 66  Enter New Password Then Select Take

                   PASSWORD = ??????              LOG OUT

Figure 6−71. Panel Password Security Page.

If category prompting is enabled, the number pad will illuminate in green. Enter a six−digit password. When six digits have
been typed, the TAKE button will illuminate in red to indicate that TAKE should be pressed. If an invalid password is entered
and Taken the display will briefly show “INVALID PASSWORD” and clear to accept another number.

The words LOG OUT will be displayed only if the panel is currently set to higher than its defined level. Selecting the soft
key under the LOG OUT legend will prompt the user to confirm with the TAKE button:

             Panel Security Level = 98  Confirm LOG OUT To

             Panel Security Level = 66  By Pressing TAKE

Figure 6−72. Panel Password Security Page − Password typed in.

Completion of a “raise password level” operation, or log out, or selecting the red illuminated MENU button will return the
panel to whichever operation mode it was in prior to selection of MENU.
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Password Level Request During TAKE

If the user requests a TAKE that requires a higher level password than the panel is currently set to, the user will also be pres-
ented with the password security page below. Entry of a valid password and TAKE will execute the take that one time only:

       Panel Security Level = 66   Enter New Password Then Select TAKE

                              PASSWORD = ??????      (FOR THIS TAKE ONLY)

Figure 6−73. One Time Only Password  Security Page.
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This mode is in effect when the “OVERRIDES” button is illuminated.

Up to 10 pages of Overrides (80 total) may be defined. The up/down arrow keys may be used to access all pages containing
defined overrides. Overrides may be defined using the file server in the CP Override set assigned to the panel (page 5−96),
or, interactively by the user as described below.

Override mode may be selected from either the single or multiple destination home state by pressing the OVERRIDE button,
which will then illuminate in green. No keypad operations may be in progress. Any selected levels or audio modes are sus-
pended as overrides contain their own level and audio definitions. Selected audio and levels are restored when the user leaves
this mode by turning off the OVERRIDE button. The following display will indicate override select mode and show all de-
fined override buttons:

1                            Destination = PRODCTN4

  ALLBLACK  ALL_BARS  SET_UP_A  SET_UP_B  OVERRD05  OVERRD06  OVERRD07  OVERRD08

Figure 6−74. Example Override Selection Mode Menu.

User defined overrides using special audio modes will indicate this with a blinking ‘A’ to the left of the override name.

If no system (file server) or user overrides are defined for the panel, the following message will be displayed:

1        No Overrides Defined, Select OVERRIDE key to define, CLEAR to exit

 

Figure 6−75.

Executing Overrides

All defined soft keys will illuminate in red to indicate that they are armed and ready to take an override. Selection of any so
illuminated soft key will cause the override to be immediately selected at the previously selected destination(s). No subse-
quent TAKE operation is required. In multiple destination mode, the output may be selected before or after pressing the
OVERRIDE button.

The top destination line functions in the same manner as defined in the multi destination mode section; it can show up to six
destinations; for over 6, the display indicates multiple destinations with ellipses (...).

An override may be applied to a destination that does not match the levels defined for that override. When this situation occurs,
the user will be warned with either of the two messages shown on the top line (as appropriate):
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1    Some Override Levels Not Valid For Destination − Partial Take Occurred

  ALLBLACK  ALL_BARS  SET_UP_A  SET_UP_B  OVERRD05  OVERRD06  OVERRD07  OVERRD08

Figure 6−76. Example Override Mode Warning Display.

1       All Override Levels Not Valid For Destination − No Take Occurred

  ALLBLACK  ALL_BARS  SET_UP_A  SET_UP_B  OVERRD05  OVERRD06  OVERRD07  OVERRD08

Figure 6−77. Example Override Mode Warning Display.

Defining Overrides

Users may define overrides to any unused accessible location. Overrides defined from the Jupiter file server CANNOT be
changed as they do not contain audio modes. User defined overrides do contain audio modes.

Overrides are automatically named by their position. For example, creating an override for the 2nd button of the third page
will create an override named “OVERRD18.” User defined overrides may also be erased if no longer needed or to make room
for new definitions.

Entering Define Mode

The panel is placed in Define Override mode by selecting a destination and double punching the OVERRIDE button. It will
illuminate in red to indicate this mode. The display will indicate this mode and prompt for a button assignment (valid soft
key locations will illuminate in green). A blank page will be provided after the last page of overrides.

1    Defining Override − Use Up/Down Buttons And Soft Key To Select Position

  ALLBLACK  ALL_BARS  SET_UP_A  SET_UP_B  OVERRD05  OVERRD06  OVERRD07  OVERRD08

Figure 6−78. Example Home Defining Override Menu.

Creating the override definition

When the user has selected an appropriate location, that soft key will illuminate in red and the display will indicate the selec-
tion and that it is ready to record the override:

3   Defining Override <OVERRD21> − Select TAKE to Define − 2ND TAKE to Finish

  TST_OR17  TST_OR18          OVERRD20  −DEFINE−

Figure 6−79. Example Override Definition Menu − Page 3, Fifth Button Position Selected.

When this menu appears the user may deselect the red soft key or select CLEAR to return to the Home Defining Override
menu or may deselect the red OVERRIDE button to exit Defining mode.
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To create the definition, the operator selects TAKE. The panel displays it is ready to define an override and the OVERRIDE
button blinks in red to indicate that a definition is in progress.

Defining Override <OVERRD21> − Press TAKE to Complete

Category = Vid_Tape     Number = 12          New Source =  VTR_0012

Figure 6−80. Example Override Definition Menu − Source Selection.

The user may then execute any kind of basic or complex source selection per normal operation. Destination changes/selec-
tions cannot be made as part of the Override definition. All irrelevant keys are ignored during definition; i.e. MENU, PROT/
LOCK, SEQ, DEST. When the selection is completed with the TAKE button, the menu will return to Define Override Mode
as shown (OVERRIDE button stops blinking, remains red):

3    Defining Override − Completed − Select TAKE To Confirm Or CLEAR To Cancel

  TST_OR17  TST_OR18          OVERRD20  OVERRD21

Figure 6−81. Example Override Definition Menu − Page 3, Fifth Button Position Defined.

From this menu the operator can confirm the definition by pressing TAKE or can select CLEAR to return to the Home Defin-
ing Override menu to try again. Pressing TAKE will also return the panel to Override Selection mode; an additional press
of the OVERRIDE button is required for each completed definition.

Note that the switch is not performed during definition. To execute the defined switch, the operator must select the override
from the menu.

Important:  Because user defined overrides have a large memory requirement, overrides should be defined from
the file server whenever possible. This applies especially to overrides with eight−character names.

Override Definitions may also be aborted at any time by selecting the OVERRIDE button when it is blinking red. A brief
message will appear on the top line stating “OVERRIDE DEFINITION ABORTED” and the panel will return to the Override
selection menu and the OVERRIDE button will illuminate in green.

Viewing Override Definitions

The user can view override definitions by placing the panel in the Define Override mode as defined above. The user then
selects an existing override. The following display will be shown:

1    Definition of Override <OVERRD05>

  VidTape1  VidTape1  VidTape1 MCart−01  MCart−01    Silence   Silence   Silence

Figure 6−82. Example Viewing Override Definition.

Page numbers are included if more than eight levels are defined for an override. Special audio modes are indicated with a
blinking ‘R’ for Reverse and ‘M’ for Mix. To exit this mode, the user will press either the red OVERRIDE or red CLEAR
buttons. This will return the operator to the Define Override Mode.
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Erasing An Override

Overrides may be erased if no longer needed or to make room for new definitions from the Define Overrides Home mode.
Enter define mode by double punching the OVERRIDE button (see above for menu display). Selecting CLEAR at this point
allows erasing user defined overrides. The display will indicate this mode and prompt for a button assignment (valid soft key
locations will illuminate in green):

1    Erasing Override − Use Up/Down Buttons And Soft Key To Select Position

  ALLBLACK  ALL_BARS  SET_UP_A  SET_UP_B  OVERRD05  OVERRD06  OVERRD07  OVERRD08

Figure 6−83. Example Erasing Override Menu.

The user may scroll pages as appropriate and select the desired button position to be erased. Upon selection of a valid position
the user will be prompted for confirmation while the selected override name blinks.

1    Erasing Override − Select TAKE To Confirm Or CLEAR To Cancel

  ALLBLACK  ALL_BARS  SET_UP_A  SET_UP_B OVERRD05   OVERRD06  OVERRD07  OVERRD08

Figure 6−84. Example Erasing Override Menu − Seventh Button Position Clear Confirmation.

From this menu the operator can confirm the desired clear operation by pressing TAKE or can select CLEAR to return to the
Home Defining Override menu to try again. Pressing TAKE will also return the panel to Override Selection mode; additional
presses of the OVERRIDE and CLEAR buttons are required for each completed clear.

As with Override Definitions, clears may also be aborted at any time by selecting the OVERRIDE button when it is red or
blinking red. A brief message will appear on the top line stating “OVERRIDE CLEAR ABORTED” and the panel will return
to the Override selection menu and the OVERRIDE button will illuminate in green.
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This mode is in effect when the “SEQ” button is illuminated.

Sequence mode may be selected from either single or multiple destination home state by selecting the SEQ button, which
will then illuminate in green. No keypad operations may be in progress. Any selected levels or audio modes are suspended
while in sequence mode as sequences contain their own level and audio definitions. Selected audio and levels are restored
when the user leaves this mode by turning off the SEQ button. The following display will indicate sequence select mode and
show all defined sequence buttons:

1               Select Sequence to Execute − CLEAR to Cancel
 

  BLACKSEQ  BARS_SEQ    SEQ_A    SEQ_B    USRSEQ05  USRSEQ06  USRSEQ07  USRSEQ08

Figure 6−85. Example Sequence Selection Mode Menu.

User defined sequences using special audio modes will indicate this with a blinking ‘A’ to the left of the sequence name.

If no system (file server) or user sequences are defined for the panel, the following message will be displayed:

1        No Sequences Defined, Select SEQ key to define, CLEAR to exit

 

Figure 6−86.

Executing Sequences

All defined soft keys will illuminate in red to indicate that they are armed and ready to take a sequence. Selection of any so
illuminated soft key will cause the sequence to be immediately executed to the defined destinations. No subsequent TAKE
operation is required.

Up to 10 pages of Sequences (80 total) may be defined. The up/down arrow keys may be used to access all pages containing
defined sequences. Sequences may be defined in the sequence set for the panel or interactively by the user as described below.

Defining Sequences

Users may define sequences to any unused accessible location.

Note: Sequences defined from the Jupiter file server CANNOT be changed as they do not contain audio modes.
User defined sequences do contain audio modes.

One additional page will be available when defining sequences. Sequences are automatically named by their position. For
example, creating an sequence for the 2nd button of the third page will create an sequence named “USRSEQ18.” User defined
sequences may also be erased if no longer needed or to make room for new definitions.
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Entering Define Mode

The panel is placed in Define Sequence mode by double punching the SEQUENCE button, which will then illuminate in red
to indicate this mode. The display will indicate this mode and prompt for a button assignment (valid soft key locations will
illuminate in green):

1    Defining Sequence − Use Up/Down Buttons and Soft Key to Select Position

  BLACKSEQ  BARS_SEQ    SEQ_A    SEQ_B    USRSEQ05  USRSEQ06  USRSEQ07  USRSEQ08

Figure 6−87. Example Home Defining Sequence Menu.

Creating the Sequence Definition

When the user has selected an appropriate location, that soft key will illuminate in red and the display will indicate the selec-
tion and that it is ready to record the sequence:

3  Defining Sequence <USRSEQ21> − Select TAKE to Define − Press SEQ to Finish

  TST_SQ17  TST_SQ18        USRSEQ20  −DEFINE−

Figure 6−88. Example Sequence Definition Menu − Page 3, Fifth Button Position Selected.

When this menu appears the user may deselect the red soft key or select CLEAR to return to the Home Defining Sequence
menu or may deselect the red SEQUENCE button to exit Defining mode.

To create the definition, the operator selects TAKE. The panel returns to single or multiple destination home mode (wherever
it was) and the Sequence button blinks in red to indicate that a definition is in progress.

In multiple destination mode the user is then prompted to select a sequence output and a source:

3                  Select Sequence Outputs, Then Select Source

  VTR_01   VTR_02   VTR_03   ENGNRING   STUDIO_A   STUDIO_D   MONITR45   MONITR46

Figure 6−89.
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In single destination mode the user is prompted to select a source:

3                  Destination = Studio A, Select Source

  VTR_01   VTR_02   VTR_03   ENGNRING   STUDIO_A   STUDIO_D   MONITR45   MONITR46

Figure 6−90.

The user may then set up any kind of basic or complex source selection per normal operation. Destination changes/selections
are also recorded as part of the Sequence definition. Audio mode selections are relevant to the specific switch being defined.
All irrelevant keys are ignored during definition; i.e. MENU, PROT/LOCK, OVERRIDE. When the operator has completed
all desired switches, the blinking SEQ button is selected to complete the definition; the menu will return to Define Sequence
Mode as shown (SEQ button stops blinking, remains red):

3    Defining Sequence − Completed − Select TAKE To Confirm Or CLEAR To Cancel

 TST_SQ17  TST_SQ18          USRSEQ20  USRSEQ21

Figure 6−91. Example Sequence Definition Menu − Page 3, Fifth Button Position Defined.

From this menu the definition can be confirmed by pressing TAKE, or CLEAR can be selected to return to the Home Defining
Sequence menu to try again. Pressing TAKE will also return the panel to Sequence Selection mode, an additional press of
the SEQ button is required for each completed definition.

Note that the switches are not performed during sequence definition. To execute the defined sequence, the operator must select
it from the menu.

Important:  Since user defined sequences have a large memory requirement, they should be defined from the file
server whenever possible. This applies especially to sequences with eight−character names.

Sequence Definitions may also be aborted at any time by selecting the SEQ button when it is blinking red. A brief message
will appear on the top line stating “SEQUENCE DEFINITION ABORTED” and the panel will return to the Sequence selec-
tion menu and the SEQ button will illuminate in green.

If the user enters too many switches and fills the sequence, the following prompt will appear:

1    Sequence <USRSEQ21> Full.  Press TAKE to Finish or CLEAR to Cancel

 TST_SQ17  TST_SQ18          USRSEQ20  −DEFINE−

Figure 6−92. Example Sequence Definition Menu − Too many entries.

Pressing the TAKE button completes the sequence at the current switch. Pressing CLEAR cancels the sequence entry.
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Viewing Sequence Definitions

To view sequence definitions, place the panel in the Define Sequence mode as defined above. Then select an existing se-
quence. The following display will be shown:

1    Definition of <TST_SQ17>, Entry:01,  Destination=PROCTN1,  Source=Test−17

  TST_SQ17  TST_SQ17  TST_SQ17  TST_SQ17  TST_SQ17  TST_SQ17  TST_SQ17  TST_SQ17

Figure 6−93. Example Viewing Sequence Definition − Sequence Entry 1.

Page numbers are included if more than eight levels are defined for a sequence. Special audio modes are indicated with a
blinking ‘R’ for Reverse and ‘M’ for Mix. If more than one entry exists, the TAKE button will turn red, allowing the user
to display the next entry. To exit this mode, the user will press either the red SEQUENCE or CLEAR buttons. This will return
the operator to the Define Sequence Mode. The CLEAR button turns red when the last sequence entry is reached.

Erasing a Sequence

Sequences may be erased if no longer needed or to make room for new definitions from the Define Sequences Home mode.
Enter define mode by pressing the SEQ button (see above for menu display). Selecting CLEAR at this point allows erasing
user defined sequences. The display will indicate this mode and prompt for a button assignment (valid soft key locations will
illuminate in green):

1    Erasing Sequence − Use Up/Down Buttons And Soft Key To Select Position

  BLACKSEQ   BARSSEQ   SEQ_A     SEQ_B    USRSEQ05  USRSEQ06  USRSEQ07  USRSEQ08

Figure 6−94. Example Erasing Sequence Menu.

The user may scroll pages as appropriate and select the desired button position to be erased. Upon selection of a valid position
the user will be prompted for confirmation while the selected sequence name blinks on the display.

1     Erasing Sequence − Select TAKE To Confirm Or CLEAR To Cancel

  BLACKSEQ   BARSSEQ   SEQ_A     SEQ_B    USRSEQ05  USRSEQ06  USRSEQ07  USRSEQ08

Figure 6−95. Example Erasing Sequence Menu − Seventh Button Position Clear Confirmation.

From this menu the operator can confirm the desired clear operation by pressing TAKE or select CLEAR to return to the Home
Defining Sequence menu to try again. Pressing TAKE will also return the panel to Sequence Selection mode; an additional
press of the SEQ and CLEAR buttons are required for each completed clear.

As with Sequence Definitions, clears may also be aborted at any time by selecting the SEQ button when it is red or blinking
red. A brief message will appear on the top line stating “SEQUENCE CLEAR ABORTED” and the panel will return to the
Sequence selection menu and the SEQ button will illuminate in green.
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The bottom two buttons below the Mode group select protection or locking (PROT/LOCK) and clear category/number selec-
tions and/or cancel ongoing definitions (CLEAR).

Protection is accessed by selecting the PROT/LOCK button once, illuminating green to indicate this condition. Locking is
accessed by selection twice (double punch). The PROT/LOCK button will illuminate red. If the panel is in single destination
mode, protection/locking is applied to the current destination. If in multiple destination mode, the user may select a destina-
tion(s) beforehand or afterwards from the soft keys; the lamp in the PROT/LOCK button will blink if a destination is still
needed. A third press will cancel the mode. Protect/Lock status will also be shown on the destination status display in the 1st
character position with a blinking “P” or “L” as appropriate. As soon as a valid destination and Protect/Lock mode is selected,
the TAKE button will illuminate in red. Protect/Lock functions take effect upon selection of the TAKE button and may be
incorporated into more complex takes as described below.

If the panel’s password level is 90 or above, the unlock or unprotect operation will be “Force Unlock.” The control panel will
override locks or protects from other panels. If the PROT/LOCK operation cannot be completed, an error message will be
displayed, including the name of the panel that locked or protected the output, if applicable. Switches that cannot be completed
due to locks and protects will also display an appropriate error message.

Locking or protecting a single destination in either multiple destination or single destination mode will result in the prompts
below. In multiple destination mode, the bottom line will display the current page of destination names and the selected des-
tination buttons will be illuminated. In single destination mode, the bottom line will display the status of the output.

Figure 6−96. Example Lock Single Destination Prompt.

1     LOCK Destination PRDCTN4 ?   Select TAKE to Execute, CLEAR to Cancel

  VTR_0123  VTR_0124  VTR_0125  VTR_0126  STUDIO_A  STUDIO_B  STUDIO_C  PRDCTN4

Figure 6−97. Example Protect Single Destination Prompt.

1    PROTECT Destination PRDCTN4 ?   Select TAKE to Execute, CLEAR to Cancel

  VTR_0123  VTR_0124  VTR_0125  VTR_0126  STUDIO_A  STUDIO_B  STUDIO_C  PRDCTN4

Locking or protecting multiple destinations will result in the following prompts:

Figure 6−98. Example Lock Multiple Destinations Prompt.

1 LOCK Destinations?   Select TAKE to Execute, CLEAR to Cancel

  VTR_0123  VTR_0124  VTR_0125  VTR_0126  STUDIO_A  STUDIO_B  STUDIO_C  PRDCTN4
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Figure 6−99. Example Protect Multiple Destinations Prompt.

1    PROTECT Destinations?   Select TAKE to Execute, CLEAR to Cancel

  VTR_0123  VTR_0124  VTR_0125  VTR_0126  STUDIO_A  STUDIO_B  STUDIO_C  PRDCTN4

The bottom line will display the current page of destination names and the selected destination buttons will be illuminated.

If the output is already locked or protected, the displays will have an “un” added to the messages for unlock and unprotect.
Pressing the TAKE button will unlock or unprotect the output.

For additional protect/lock information  − see page 6−12.
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TIE LINE STATUS AND OPERATION

All destinations employing tie lines will be so indicated with a blinking “T” in the destination status display in the 1st character
position. When in single destination mode, the 1st character position of each level will also reflect tie line status with the blink-
ing “T.”

Tie Lines Used Up Warning

Any time a Take is attempted that requires a tie line connection but none are available, the following display will appear show-
ing the name of the destination, its current source, and the attempted source:

1          NO TIE LINES LEFT TO SWITCH PRODCTN4 to OuterSpc

  VTR_0123  VTR_0124  VTR_0125  VTR_0126  STUDIO_A  STUDIO_B  ENGINRNG  PRDCTN4

Figure 6−100. Example Tie Lines Used Up Warning Message − Multi Destination Mode.

This display will remain for an undetermined timeout or until the CLEAR button is selected, which ever comes first. If the
take is to multiple destinations via multiple destination mode or a sequence, as much of the operation requested as is possible
will be performed. If multiple tie line requests were not fulfilled, multiple warnings will stack up and be displayed consecu-
tively.

As required, this tie line warning will appear during normal takes, overrides and sequences. When this condition occurs, all
levels of switching for the particular take will occur for those levels which can (those that do not require tie lines or still have
tie lines available). Sequences will execute all other takes that can be completed.

ERROR MESSAGES

For an explanation of CP 3800A series error messages (such as “10xx” or “3200” or “80xx”) please refer to Appendix R.
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CP 3808 Control Panel
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Figure 6−101.

COLORBAR

VTR−01−V

VTR−01−L

VTR−01−R

VTR−01−T

(For installation and configuration instructions, please see page 2−45.)

The CP 3808 control panel is a 16−category,* full−matrix,* multi level breakaway* panel capable of locking* and protecting*
outputs. The panel features eight−character display capability and relegendable, lighted push buttons. The panel includes four
dedicated level* display windows and breakaway buttons.

All push buttons are capable of both green and red back lighting, with green generally used to show a selected function and
red to indicate an operational mode in progress.

As an option, the CP 3808 can be operated in connection with an adjacent CP 3809 Expansion Panel (see page 6−124) or a
CP 3810 Expansion Panel (see page 6−126).

The panel has two basic modes of operation: Home mode, and Source Entry mode.

Home Mode

In Home mode, the level displays (the four displays on the left side of the panel) indicate status* of the first four levels of
the switcher (i.e., the first four levels listed on the CP Level set table assigned to this panel). To provide “flip−flop” switching,
the Preset window shows the previously selected source switched to the panel’s controlled output.

Source Entry Mode

Whenever the operator starts to enter a new source on the category/number keypad, the Preset window switches to a prompt-
ing mode. The level displays show the names of the first four levels; the four level buttons can now be used for breakaway
switching.

Detailed operating instructions follow.

* Defined in Glossary Section
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DESTINATION (OUTPUT) SELECTION
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Figure 6−102.

STUDIO−A

Press once to show current destination in Preset window.

VTR−01−V

VTR−01−L

VTR−01−R

VTR−01−T

To select a destination:

1. Press the MENU button once.

The Preset window will display the present destination.

Note:  If the MENU button does not blink, the destination cannot be changed—probably because the panel has
been limited to a certain output by the CP Output set used on the MPK Devices table. See page 5−112.

2. Select a new destination by

— pressing a category (e.g., “VTR”) and unit number combination, or by

— using the UP and DOWN arrows to scroll through all available destinations, or by

— pressing a category key and using UP/DOWN to scroll through the available units in that category; or by

— selecting a destination on the CP 3809 Expansion Panel (if so equipped—see Figure 6−104).

If the output has been locked* by another panel, the TAKE button will blink red. To continue, the output must be un-
locked (by the panel used to set the lock).

For additional protect/lock information  − see page 6−12.

3. When the desired destination is displayed in the Preset window, press the TAKE button to select it.

To verify the new output, press MENU again. To return to Home mode, press CLEAR.
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SOURCE SELECTION
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Figure 6−103.

VTR−01

Video

Left

Right

T/C

To select a source (input):

— press a category (e.g., “VTR”) and unit number combination, or

— use the UP and DOWN arrows to scroll through all sources, or

— press a category key and use UP/DOWN to scroll through the possible units in that category...

...then press TAKE.

On a valid entry, the defined eight character mnemonic will be displayed in the Preset window and all applicable level
lamps will light in green. The level displays (the four left windows) will show the status for each of the first four levels
defined in the CP Level set assigned to the panel.

Note: The Preset window will return to the previously selected source. This permits flip−flop switching.

If entry of a password is requested, please see Passwords on page 6−75.

Operation with Expansion Panels
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Figure 6−104. CP 3808 with CP 3809 Expansion Panel.

Before pressing TAKE, use the expansion panel to select the destination(s). The selected output button will illuminate in
“high” green to show it will be affected by the switch. These buttons can be toggled on/off before pressing TAKE.

Note:  The output currently being controlled by the CP 3808 will not be affected.

(To assign Expansion Panel buttons to outputs, see pages 5−79 and 6−124 (CP 3809) or 5−79 and 6−126 (CP 3810).
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LEVEL BREAKAWAYS (SPLIT SWITCHING)
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Figure 6−105.
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VTR−041

Breakaways can be accomplished either by selecting the levels to switch, and then selecting a source; or by selecting a source
and then deselecting unwanted levels.

Breakaways can be disabled on the CP Level Set table by setting the Break Flag for each level to ‘N.’ (See page 5−58.)

Level Preset Method

1. Press the button corresponding to the desired level.

The level mnemonic appears in the level window and the button will illuminate in “high” green. (To adjust button bright-
ness, see page 6−71.) The level may be toggled off by selecting it again. To move beyond the first four levels, use the
UP and DOWN arrow keys.

Pressing CLEAR will cancel the operation.

2. Select a source.

Note: If the level window goes blank, the source may not exist on that level (e.g., audio from a camera).

3. Press TAKE.

The source will switch only on the preset levels, while the non−selected levels will remain at the previously selected
source.

The level windows will indicate status of the first four levels of the switcher; the Preset window will return to the pre-
viously selected source. This permits flip−flop switching.
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Level Deselect Method

1. Select a source.

The available level mnemonics appear in the Level windows; applicable level buttons will illuminate in “high” green.

2. Deselect levels by pressing the appropriate level button.

The button lamp will change to “low” green, and the corresponding level window will be blanked. To move beyond the
first four levels, use the UP and DOWN arrow keys. Pressing CLEAR will cancel the operation.

3. Press TAKE.

The selected levels will switch to the new source. The deselected levels will remain at the previously selected source.

The level displays will indicate status of the first four levels of the switcher; the Preset window will return to the pre-
viously selected source. This permits flip−flop switching.

Multi−Source, One−Take Splits

The CP 3808 will allow operators to perform complex split switches using multiple sources on levels not defined for all
sources, similar to a salvo switch to a single destination. For example, assume the user has defined Camera−1 with Video and
TimeCode only levels. However, he or she desires CD−1 for audio. To perform this switch in one take:

1. Select all levels to be switched.

In this example, the operator would press the buttons corresponding to Video, Left, Right, and TimeCode. The buttons
will light in “high” green, indicating they are selected.

2. Select the first source.

In this example, Camera−1 would be selected.

3. Deselect the levels that apply to the second source.

In this example, Left and Right.

4. Select the second source.

In this example, CD−1 This source will automatically be assigned to the remaining levels, Left and Right audio.

5. Press TAKE.

MENU FUNCTIONS

Destination Mode — Press MENU Once

In this mode (already described on page 6−65) the destination is shown in the Preset window. If the panel is equipped with
a CP 3809 Expansion, the outputs controlled by that panel will be indicated.
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To return to Home mode, press CLEAR.

Status Mode — Press MENU Twice

This mode allows the UP and DOWN buttons to select and status levels beyond the first four. The mode is indicated by the
message “1 STATUS” in the Preset window. The “1” refers to “page 1,” that is, the first page of four levels being displayed.

To return to Home mode (in which UP and DOWN are used for source selection) press CLEAR.

Audio Status Mode— Press MENU Three Times

Note 1: Audio status mode can only be used if an appropriately configured Venus switcher is connected.

This mode is accessed by pressing MENU three times; the MENU button will light in red and the Preset window will display
the message “1 AUDIO.” The level windows show the audio mode for each audio channel. In Figure 6−106, both audio chan-
nels are set to “Normal.”
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Figure 6−106.

NORMAL

NORMAL

1 AUDIO

Other possibilities are:

� MIX − Left and right channels are mixed on this channel.

� REVERSE − Signal is from opposite channel.

To move beyond the first four levels, use the UP and DOWN arrow keys.

Note 2: You cannot change settings in Audio Status mode; this must be done using Audio Switching mode. See
page 6−74.

Locking or Unlocking an Output—Press MENU Four Times

Locking an output prevents that output from being switched by any panel in the system, including the initiating panel.

To lock an output:

1. Press and release MENU until “LOCK?” appears.
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2. Press LOCK.

This has the effect of locking only those levels this control panel can control (as defined on the CP Level set assigned
to the panel). The TAKE button will illuminate steady red, indicating the output has been locked by this panel.

If another panel selects this output for control, that panel’s LOCK button will blink. If the other panel attempts to switch
this output, a “LOCKED” message will appear, along with the name of the locking panel.

If the other panel has no LOCK button, that panel’s TAKE button will blink.

To unlock the output:

1. Press and release MENU until “UNLOCK?” appears.

2. Press UNLOCK.

The TAKE button lamp will return to green.

If the output will not unlock, it has been locked by another panel. The display will indicate “Locked” and show the name
of locking panel.

An output may be forced unlocked, no matter which panel locked it, if the password level of the unlocking panel is level 90
or greater. The password level is defined in the MPK Devices table entry (page 5−107). This operation is useful for a master
panel capable of switching any source to any destination. The operator would be required to force unlock the output prior
to changing its source selection.

For additional protect/lock information  − see page 6−12.

Protecting or Unprotecting an Output—Press MENU Four Times

Protecting an output prevents that output from being switched by other panels in the system. The protecting panel may still
change the outputs.

To protect an output:

1. Press and release MENU until “PROTECT?” appears.

2. Press PROTECT.

This has the effect of protecting only those levels this control panel can control (as defined on the CP Level set assigned
to the panel). The TAKE button will flash green, indicating the output has been protected by this panel.

If another panel selects this output for control, that panel’s PROT button will blink. If the other panel attempts to switch
this output, a “PROTECT” message will appear, along with the name of the protecting panel.

If the other panel has no LOCK button, that panel’s TAKE button will blink.
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To unprotect the output:

1. Press and release MENU until “UNPROT?” appears.

2. Press UNPROT.

The TAKE button will return to green.

If the output cannot be unprotected, it has been protected by another panel. The display will indicate “Protect” and show
the name of protecting panel.

An output may be force unprotected, no matter which panel protected it, if the password level of the unprotecting panel is
level 90 or greater. The password level is defined on the MPK Device table (page 5−107). This operation is useful for a master
panel capable of switching any source to any destination. The operator would be required to force unprotect the output prior
to changing its source selection.

For additional protect/lock information  − see page 6−12.

Panel ID (Address) Mode—Press MENU Five Times

This option displays the current MPK address for this panel.

Diagnostics Mode — Press MENU Six Times

Note:  CP 3808/3809/3824/3830 diagnostics are internal to the control panel and will operate with or without the
panel connected to a controller board via the MPK cable.

1. Press and release MENU until “DIAGNOSE” appears.

2. Use the UP and DOWN buttons to select the desired diagnostic.

3. Press TAKE. Instructions for each diagnostic are given below.

To exit the diagnostics mode press CLEAR at any time. (It may be necessary to press CLEAR twice.)

LED Test

This test cycles through the button lamps (LEDs) and illuminates them in green and then red. The test will stop after one cycle.
Pressing CLEAR during this test will cancel this test and return the panel to the beginning of the current diagnostic. Pressing
CLEAR again will return the panel to the Home mode.

Info

Info displays the panel’s Application (PROM) version, Xilinx FPGA* version. Variant version (not implemented), and PCB
(hardware) version. Press CLEAR to exit.
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Baud Rate

When selected, this option displays the current baud rate for the panel. Press DOWN to decrease the baud rate, UP to increase.
Available baud rates are: 38400, 19200, 9600, 4800, 2400, and 1200. Pressing TAKE will program the changed setting;
CLEAR will cancel.

The baud rate must agree with the setting for the CM 4000 port used by the panel (see Serial Protocol on page 5−30).

Panel ID

When selected, this option displays the current MPK address for this panel and permits entry of a new address. Since the ad-
dress is hexadecimal, the numeric key pad is used for numbers 0 through 9; on the CP 3808 the six remaining category keys
are used for numbers A through F (see Figure 6−107).

Figure 6−107. Buttons used for hex
address entry.

DIAGNOSE

Panel ID

0057A32E

2 3

4 5

7 8 9

0

6

1

EF

A

B

C

D

On the CP 3830, the six level keys are used for numbers A through F.

On the CP 3809, the top window shows the current address and the bottom window shows the new address as it is entered.
Starting with the first digit of the new address, use the UP and DOWN buttons to change the value, press TAKE, change the
next value, etc.

Pressing TAKE will program the newly entered address; CLEAR will cancel.

The address must agree with the setting for the panel on the MPK Devices table (see page 5−107).

MPK Test

This diagnostic requires the panel be disconnected from the MPK data cable.

This test allows the factory to test the MPK connection on the control panel.

Illumination Adjustment

This option allows the user to change the “low” and “medium” levels of green button illumination, the “low” and “medium”
levels of red button illumination, and the level of LED (display character) illumination. The “high” button levels are not ad-
justable.

* Defined in Glossary section
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The “low” green level is used for normal button lighting. “High” green and “high” red are also used, but these are not adjust-
able.

Note: The amber color, which is presently used only for a CP 3830 dedicated output panel, is created by combining
low green and low red.

For each setting, use the UP and DOWN buttons to change to the desired brightness and press TAKE. Press CLEAR to exit.

Burn In

This test rotates through the button lamp and Display tests continually. Press CLEAR to cancel.

Key test

This diagnostic displays the number of each button as it is pressed. Pressing the CHOP key will change the lamp color. Press-
ing CLEAR twice exits.

Display test

This test cycles through and displays all legal characters. The test will stop after one cycle. Pressing CLEAR exits. (On the
CP 3809, press the lower right button to exit.)
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AUDIO SWITCHING MODE (VENUS SPECIAL STEREO SWITCHING)

The CP 3808 has the capability of controlling Venus Audio Modes, which are Normal, Mix, and Reverse. These changes are
made to individual levels prior to completing a switch by pressing the TAKE button.

Note: Audio switching mode can only be used if an appropriately configured Venus switcher is connected.

To perform a special stereo switch:

1. Select a source.

2. Press MENU.

The MENU button will light in red and the Preset window will display the message “1 AUDIO.” The level windows
show the audio mode for each audio channel. In Figure 6−108, both audio channels are set to “Normal.”

2 3

4 5

7 8 9

0

6

1
VTR CAM SAT

VCR NET REM

TEST PTCHCGEN

Stu MISC AUX

EJ

FILM

FS

STILLTake

Clear

Menu

CP 3808

PRESET

Figure 6−108.

NORMAL

NORMAL

1 AUDIO

3. Toggle the Left channel soft key to the desired mode:

� NORMAL − Use left audio for this channel

LEFT LEFT (Left signal on Left channel)

� MIX − Mix left and right on this channel

LEFT

RIGHT

LEFT (Left + Right signals on Left channel)

� REVERSE − Cross opposite channel signal over to this channel

RIGHT

LEFT (Right signal on Left channel)

4. Toggle the Right channel soft key to the desired mode:
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� NORMAL − Use right audio for this channel

RIGHT RIGHT (Right signal on Right channel)

� MIX − Mix left and right on this channel

LEFT

RIGHT RIGHT (Left + Right signals on Right channel)

� REVERSE − Cross opposite channel signal over to this channel

LEFT

RIGHT  (Left signal on Right channel)

5. Press TAKE.

PASSWORDS

Note: For a general description of the Jupiter password system, please see page 5−22.

If entry of a password (“PASS = ”) is requested, the output about to be affected has a password level higher than that of the
panel. (Some panels may display their password level as entered on the MPK Devices table, e.g., “PASS = 48”.)

After entry of an appropriate−level six−digit password, the command can be completed by pressing TAKE; however, the panel
will then revert to its previous password level.

CP 3810 Expansion Panel Operation

See page 6−126.
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CP 3824 Control Panel

(For installation and configuration instructions, please see page 2−46.)

The CP 3824 control panel is a locally−programmable, full−matrix,* multiple level breakaway panel capable of locking* and
protecting* outputs. The panel features eight−character display capability and relegendable, lighted push buttons. The 24 but-
ton−per−source keys on the left side of the panel are initially assigned to inputs from the file server but some or all can be
re−assigned to new inputs at any time using only the panel itself. Sources can also be selected by scrolling up/down an LED
display of “Preset” mnemonics or by using the Category/Number keypad. The Current display window shows the source
switched to the panel’s controlled output. The Preset window shows the new source as it is being entered from the category
and keypad push buttons; after TAKE is pressed, the previous source is shown in the Preset window. This allows “flip−flop-
ping” the sources, or switching between the current and preset sources by simply pressing the TAKE button (see page 6−78).

DESTINATION SELECTION

Figure 6−109.
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Category/Number keys

To select a destination:

1. Press the MENU button once.

The Preset window will display the present destination.

2. Select a new destination by

— pressing a category (e.g., “VTR”) and unit number combination, or by

— using the UP and DOWN arrows to scroll through all destinations, or by

— pressing a category key and using UP/DOWN to scroll through the available units in that category.

3. When the desired destination is displayed in the Preset window, press the TAKE button to select it.

The Current window will return to the input mnemonic; the Preset window will go blank.

Note: if the panel cannot be changed to the desired output, it may have been limited to certain outputs by the
CP Output set used on the MPK Devices table. See page 5−112.

* Defined in Glossary Section
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SOURCE SELECTION

Figure 6−110.
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Button−per−source keys (programmable overrides) Category/
Number keys

To select an input:

— press one of the 24 button−per−source (Override) keys on the left side of the panel, or

— press a category (e.g., “VTR”) and unit number combination, then press TAKE, or

— use the UP and DOWN arrows to scroll through all sources, then press TAKE, or

— press a category key and use UP/DOWN to scroll through the possible category entries, then press TAKE. 

On a valid entry, the defined eight character mnemonic will be displayed in the Preset window.

When using the UP/DOWN arrows, scrolling past the end of the list will wrap around to the other end.

The newly selected source will be shown in the Current window. If an Override button was used to select the source (or if
an Override button corresponds to the selected source) the button will illuminate “high” green. However, the button will not
illuminate if the first level assigned to the panel on the Override set table has been set to “No” switching. Nor will it illuminate
unless all levels assigned to the button are switched.

If entry of a password is requested, please see Passwords on page 6−75.

Selecting a Source with PRESET On

With PRESET on, you can select an Override key(s) and check the source name(s) before pressing TAKE. The name of the
selected input will be previewed in the Preset window. 

Scrolling Through Override Pages

Although the CP 3824 has only 24 Override keys, up to 360 inputs can be assigned, i.e., 15 groups (“pages”) of 24 inputs each.
To scroll to other pages, press PAGE, then UP or DOWN, TAKE. Pressing both UP and DOWN simultaneously will reset
to page 1.

The Override keys can be programmed using the panel itself (see page 6−85) or from the file server (see page 5−96).



Control Panel Operation CP 3824

6−78 CM 4000 Installation and Operating Manual

Flip−flop Operation

The present source is shown in the Current window, while the previous source is shown in the Preset window. This allows
“flip−flopping” the sources, or switching between the current and preset sources by simply pressing the TAKE button.

As an example, if you wish to change the source from BARS to VTR−002, first select the VTR category. The Preset

display updates as follows, prompting with the first unit in the VTR category:

Figure 6−111.VTR−001

COLORBAR
CURRENT

PRESET

The user will then press the �2" key. The Preset display will update:

Figure 6−112.VTR−002

COLORBAR
CURRENT

PRESET

To complete the selection, press the red TAKE button to switch source VTR−002 to the panel’s defined output. The

Preset window and the Current window will be swapped as shown, indicating that the previous source can be rese-

lected.

Figure 6−113.

VTR−002

COLORBAR
CURRENT

PRESET
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LOCKING OR UNLOCKING AN OUTPUT

Locking an output prevents that output from being switched by any panel in the system, including the initiating panel.

To lock an output:

1. Press the LOCK button.

This has the effect of locking only those levels this control panel can control (as defined on the CP Level set assigned
to the panel). The button will blink, indicating the output has been locked by this panel.

If another panel selects this output for control, that panel’s LOCK button will blink. If the other panel attempts to switch
this output, a “LOCKED” message will appear, along with the name of the locking panel.

If the other panel has no LOCK button, that panel’s TAKE button will blink.

To unlock the output:

1. Press the LOCK button again.

The LOCK button lamp will stop blinking.

If the output will not unlock, it has been locked by another panel. The display will indicate “Locked” and show the name
of locking panel.

An output may be forced unlocked, no matter which panel locked it, if the password level of the unlocking panel is level 90
or greater. The password level is defined in the MPK Devices table entry (page 5−107). This operation is useful for a master
panel capable of switching any source to any destination. The operator would be required to force unlock the output prior
to changing its source selection.

For additional protect/lock information  − see page 6−12.

PROTECTING OR UNPROTECTING AN OUTPUT

Protecting an output prevents that output from being switched by other panels in the system. The protecting panel may still
change the outputs.

To protect an output:

1. Press the PROT button.

This has the effect of protecting only those levels this control panel can control (as defined on the CP Level set assigned
to the panel). The button will blink, indicating the output has been protected by this panel.

If another panel selects this output for control, that panel’s PROT button will blink. If the other panel attempts to switch
this output, a “PROTECT” message will appear, along with the name of the protecting panel.
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If the other panel has no LOCK button, that panel’s TAKE button will blink.

To unprotect the output:

1. Press the PROT button again.

The PROT button will stop blinking.

If the output cannot be unprotected, it has been protected by another panel. The display will indicate “Protect” and show
the name of protecting panel.

An output may be force unprotected, no matter which panel protected it, if the password level of the unprotecting panel is
level 90 or greater. The password level is defined on the MPK Device table (page 5−107). This operation is useful for a master
panel capable of switching any source to any destination. The operator would be required to force unprotect the output prior
to changing its source selection.

For additional protect/lock information  − see page 6−12.

CHOP OUTPUTS

To chop* an output, you must use the Category/number keypad. Select the first source and press TAKE. Then select the second
source and press CHOP. The CHOP button will blink, with the message “IN CHOP” displayed in the Current window.

The chop operation will automatically stop after approximately two minutes. The chop will finish with the source in the Preset
window being switched to the destination. The chop may be manually terminated by performing another source selection and
pressing TAKE.

For additional chop information − see page 6−13.
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LEVEL BREAKAWAYS (SPLIT SWITCHING)

Breakaway Using Override Keys (PRESET Off)

2

Figure 6−114.

CURRENT

PRESET

LEVEL

MENU

CLEAR

PROT

PRE−
SET

TAKE

LOCK CHOP

PAGE

SEND

Press LEVEL

1 Press CLEAR

These six buttons now function as temporary
level select keys. Lighted buttons initially indicate
defined levels.

VIDEO

321

4 5 6
VTR 001

Name of selected Level
shown here

Status shown here

Toggle OFF levels you do not  wish to switch.
In this example, Level 1 is toggled OFF. Only
LEFT and RIGHT will switch.

VTR−002

VTR 002

3

Select desired Override input. This completes the switch.4

To check the switch, press LEVEL. Then press one of the six temporary level keys; status will be
shown in the Current window. Then press CLEAR.

If there are more than six levels, use the UP/DOWN keys to access the second set of six levels,
etc.

CURRENT

PRESET

CURRENT

PRESET

1 2 3 4

VTR
1

VTR
2

VTR
3

VTR
4

5 6 7 8

STU
1

STU
2

EDIT
1

EDIT
2

BLACK BARS TONE SILE
NCE

EBS
1

EBS
2

TEST
1

TEST
2



Control Panel Operation CP 3824

6−82 CM 4000 Installation and Operating Manual

Breakaway Using Category/Number Keys (PRESET Off)

3

Figure 6−115.
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Breakaway Switching − Multi−Level Take

This function allows setup of different sources on different levels with all levels switched using a single TAKE. For example,
you can select video from VTR1 and audio from VTR2 to switch to VTR3 with a single TAKE.

1. Select the first source using the Category/Number keys.

The Override keys cannot be used for this function.

2. Press LEVEL.

This activates the six “temporary level” buttons (the outlined buttons in Figure 6−116). Lighted buttons initially indicate
defined levels.

321

4 5 6CURRENT

PRESET

Figure 6−116.

Temporary Level buttons

3. Toggle OFF the level(s) you DON’T want to receive the source just selected.

4. Select the next source using the Category/Number keys.

This will automatically select the levels not selected for the first source.

5. Repeat Steps 3 and 4 to setup additional sources (if any).

6. When all sources have been selected and assigned to the desired levels, press TAKE.

Checking Status of Multiple Levels

There are two ways to check status on more than one level:

— Press LEVEL, then press one of the six “temporary level” keys. The name of the selected level will appear in
the Preset window; the status of the selected level with be shown in the Current window.

— Press PRESET, then press LEVEL repeatedly to step through the levels. The name of the selected level will
appear in the Preset window; the status of the selected level will be shown in the Current window. You can also
use UP/DOWN to step through the levels.

Breakaway Switching − Sticky Level(s)

This function allows breakaway operation during which the selected Levels remain selected after a TAKE. For example, you
may want to keep switching different video test signals to a destination but not switch audio tone. To turn on sticky mode:
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1. Press MENU three times.

The word “STICKY” appears in the Current window.

2. Use UP/DOWN to toggle the display to “ON?”

3. Press TAKE.

If more than six levels have been defined, UP/DOWN will increment through additional pages of levels. When multiple
pages of levels exist, the Preset display will prompt PG 1 (2, 3, etc.) next to the “ON,” and allow the user to select addi-
tional pages for toggling on or off the level.

This activates the six “temporary level” buttons (the outlined buttons in Figure 6−117). Lighted buttons initially indicate
defined levels.

LEFT

321

4 5 6
VTR 002

CURRENT

PRESET

Figure 6−117.

These six buttons function as temporary
level select keys in Sticky mode.

4. Toggle OFF the level(s) you don’t  want to switch.

5. Press TAKE.

Sticky mode is now active, as indicated by the blinking LEVEL button .

To make a switch when sticky levels are in effect, select the desired input. Only the sticky levels will switch.

To find out which levels are sticky, press MENU three times; then press TAKE. The appropriate temporary level keys will
illuminate.

To cancel sticky levels, press MENU three times, then use UP/DOWN to toggle the display to “STICKY NOW OFF.” Then
press CLEAR or TAKE.
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DEFINING OVERRIDES

The 24 Override keys on left side of the panel can be programmed from the front panel using the SEND key.

1. Press CLEAR.

This returns the panel to the “home state.”

2. Locate the desired override page and key position for the new input:

a. Press PAGE, then UP/DOWN to access additional pages.

The page number is shown in the Current window. Pressing UP and DOWN together returns to page 1.

The number of possible pages and positions depends on the CP Override set that has been assigned to this panel.
For example, if the CP Override set contains 25 entries, then one page of 24 buttons has been defined, and there
is one button defined for page 2. In this case, 2 pages of 24 positions each are available for definition from the front
panel.

b. Press TAKE.

This locks the panel to the selected page number.

c. Press PRESET.

d. Press the Override key you would like to use. Check the Preset window for the current assignment.

e. Repeat Steps a. through d. until you find a suitable location.

3. Press CLEAR.

4. Use the Category/Number keypad to select the new input.

The name of the new input is shown in the Preset window.

5. Press SEND.

The display will read “SEND TO BUTTON.”

6. Press the desired override button.

The input is now assigned to the button.
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Restoring Override Keys to Default Assignments (Default Select Mode)

Preset sources assigned to the 24 programmable buttons and their various pages are initially assigned in the Jupiter Configura-
tion Sets and downloaded to the CM 4000. These initial assignments are considered the “DEFAULT” assignments. Other
preset sources and combinations of levels can be assigned dynamically at the CP 3824 without downloading new configura-
tion sets.

To restore any or all of the “DEFAULT” source assignments:

1. Press the MENU button twice.

The panel displays “DEFAULT SELECT?”

2. Press the UP/DOWN buttons to toggle between “SELECT?” or “ALL?”.

The 15 category/number buttons are now used as “temporary page” keys. Each illuminated category/number button rep-
resents a page of 24 inputs. For example, if 25 inputs have been defined, then the first two buttons will illuminate. See
Figure 6−118.

321 4 5

6CURRENT

PRESET

Figure 6−118.

These 15 buttons function as temporary
page select keys in Restore Override mode.

7 8 9 10

1514131211

The SELECT CHOICE − With “SELECT” displayed in the lower display, pages with the original default assignments
still in effect are illuminated. Pages with reprogrammed buttons can be selected as desired (toggled on). Pressing TAKE
restores the selected pages to the default settings. The word DONE appears in the lower display after TAKE is pressed.

The ALL CHOICE − With “ALL” displayed in the lower display, all the temporary page buttons with defined inputs
illuminate. Pressing TAKE returns all the programmable buttons on all pages of 24 buttons to their “DEFAULT” source
assignments. The word “DONE” appears in the lower display after TAKE is pressed.
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MENU FUNCTIONS

Destination Mode — Press MENU Once

In this mode (already described on page 6−76) the destination is shown in the Preset window.

To return to Home mode, press CLEAR.

Default Select Mode — Press MENU Twice

This mode is used to return Override buttons to the inputs assigned by the file server. See page 6−86.

Sticky Mode — Press MENU Three Times

Allows breakaway operation during which the selected Levels remain selected after a TAKE. See page 6−83.

Panel Name — Press MENU Four Times

Panel ID (Address) Mode — Press MENU Five Times

This option displays the current MPK address for this panel in the Preset window.

Diagnostics Mode — Press MENU Six Times

For a description of the diagnostics and adjustments, please see the CP 3808 Diagnostic Mode on page 6−71, starting with
Step 2. Except as noted, this description applies to the CP 3824.
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CP 3830 Control Panel

Figure 6−119.
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(For installation and configuration instructions, please see page 2−47.)

The CP 3830 Control Panel is a 12−category,* full−matrix,* multi−level* breakaway* panel, capable of locking,* protect-
ing,* and chopping* outputs. The panel features eight−character display capability and relegendable, lighted push buttons.

The Current display window shows the source switched to the panel’s controlled output. The Preset window shows the new
source as it is being entered from the category and keypad push buttons; after TAKE is pressed, the previous source is shown
in the Preset window. This allows “flip−flopping” the sources, or switching between the current and preset sources by simply
pressing the TAKE button (see page 6−78).

The push buttons are capable of green, red, and amber back lighting, with green generally used to show a selected function
and red to indicate an operational mode in progress. The amber color is presently used only for a CP 3830 dedicated output
panel (see page 5−126).

As an option, the CP 3830 can be operated in connection with an adjacent CP 3809 Expansion Panel (see page 6−124) or a
CP 3810 Expansion Panel (see page 6−126).

Dual CP 3830 panels can be configured so that one of the panels is used as a dedicated output panel (see page 5−126). Dual
output mode is also possible with two panels side by side.

CP 3830P (CP 3830 with Automatic Preview)

The CP 3830 can also be configured to control two outputs, with the second output used for preview. In this mode, the panel
is referred to as a “CP 3830P.” Note: The CP 3830P cannot be operated with an expansion panel.

* Defined in Glossary Section
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DESTINATION SELECTION

Figure 6−120.
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To select a destination:

1. Press the MENU button once. The Preset window will display the present destination.

On a CP 3830P auto preview panel, the Preset window will display the Preset (preview) destination, and the Current
window will display the Current (program) destination.

2. Select a new destination by

— pressing a category (e.g., “VTR”) and unit number combination, or by

— using the UP and DOWN arrows to scroll through all destinations, or by

— pressing a category key and using UP/DOWN to scroll through available units in that category; or by

— selecting a destination on the CP 3809 Expansion Panel (if so equipped—see Figure 6−122), or by

— selecting a destination on the adjacent CP 3830 dual panel (if so equipped—see below).

3. When the desired destination is displayed in the Preset window, press the TAKE button to select it. The Current window
will return to the input mnemonic; the Preset window will go blank.

On a CP 3830P auto preview panel, press TAKE to change the Current (program) output; or press PRESET TAKE
(CHOP button) to change the Preset (preview) output. The Current window will then show the source feeding the pro-
gram output. The Preset window will show the source feeding the preview output.

Note: if the panel cannot be changed to the desired output, it may have been limited to certain outputs by the
CP Output set used on the MPK Devices table. See page 5−112.

CP 3830 Dual Configuration—Dedicated Output Panel

Dual CP 3830 panels can be configured so that the second panel is used for output selection. The output panel’s buttons will
glow amber. For configuration instructions, see page 5−126.
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SOURCE SELECTION

Figure 6−121.
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To select an input:

— press a category (e.g., “VTR”) and unit number combination, or

— use the UP and DOWN arrows to scroll through all sources, or

— press a category key and use UP/DOWN to scroll through the possible category entries.

...then press TAKE.

On a valid entry, the defined eight character mnemonic will be displayed in the Preset window and all applicable level
lamps will light in green.

When using the UP/DOWN arrows, scrolling past the end of the list will wrap around to the other end.

The newly selected source will be shown in the Current window.

If entry of a password is requested, please see Passwords on page 6−75.

On a CP 3830P auto preview panel, you can send the selected input to the Preset (preview) output by pressing the
PRESET TAKE (CHOP) button instead of the TAKE button. After previewing the source, press TAKE to switch the
source to the Current (program) output.

Operation with Expansion Panels

1
STU

2
STU

3
STU

4
STU

8
STU

7
STU

6
STU

5
STU

Figure 6−122. CP 3830 with CP 3809 Expansion Panel.
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Before pressing TAKE, use the expansion panel to select the destination(s). The selected output button will illuminate in
“High” green to show it will be affected by the switch. These buttons can be toggled on/off before pressing TAKE.
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Note: The output currently being controlled by the CP 3830 will not be affected.

(To assign Expansion Panel buttons to outputs, see pages 5−79 and 6−124 (CP 3809) or 5−79 and 6−126 (CP 3810).

Flip−flop Operation

The present source is shown in the Current window, while the previous source is shown in the Preset window. This allows
“flip−flopping” the sources, or switching between the current and preset sources by simply pressing the TAKE button.

As an example, if you wish to change the source from BARS to VTR−041, first select the VTR category. The Preset display
updates as follows, prompting you to enter up to four digits:

Figure 6−123.
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Then press �4" and �1." The Preset display will update:

Figure 6−124.
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To complete the selection, press the red TAKE button to switch source VTR−041 to the panel’s defined output. (On a

CP 3830P, press PRESET TAKE. then TAKE.) The Preset window and the Current window will be swapped as shown,

indicating to the operator the previous source can be reselected.

Figure 6−125.
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LOCKING OR UNLOCKING AN OUTPUT

Locking an output prevents that output from being switched by any panel in the system, including the initiating panel. In a
single destination panel, it essentially locks the panel from further operator action until unlocked.

Note: The CP 3830P Preset (preview) output cannot be locked or protected.

To lock an output:

1. Press the LOCK button.

This has the effect of locking only those levels this control panel can control (as defined on the CP Level set assigned
to the panel). The button will illuminate in “high” red, indicating the output has been locked by this panel.

If another CP 3830 panel selects this output for control, that panel’s LOCK button will blink red. If the other panel at-
tempts to switch this output, a “LOCKED” message will appear, along with the name of the locking panel.

If a CP 3808 panel selects this output for control, that panel’s TAKE button will blink red (the CP 3808 has no LOCK
button).

To unlock the output:

1. Press the LOCK button again.

The LOCK button lamp will switch to “low” green. If the output has been locked by another panel, the button will show
lock status by blinking red.

An output may be forced unlocked, no matter which panel locked it, if the password level of the unlocking panel is level 90
or greater. The password level is defined in the MPK Devices table entry (page 5−107). This operation is useful for a master
panel capable of switching any source to any destination. The operator would be required to force unlock the output prior
to changing its source selection.

For additional protect/lock information  − see page 6−12.

PROTECTING OR UNPROTECTING AN OUTPUT

Protecting an output prevents that output from being switched by other panels in the system. The protecting panel may still
change the outputs.

To protect an output:

1. Press the PROT button.

This has the effect of protecting only those levels this control panel can control (as defined on the CP Level set assigned
to the panel). The button will blink “high” green, indicating the output has been protected by this panel.
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If another CP 3830 panel selects this output for control, that panel’s PROT button will blink red. If the other panel at-
tempts to switch this output, a “PROTECT” message will appear, along with the name of the protecting panel.

If a CP 3808 panel selects this output for control, that panel’s TAKE button will blink red (the CP 3808 has no Protect
button).

To unprotect the output:

1. Press the PROT button again.

The PROT button switch to “low” green. If the output has been protected by another panel, the PROT button will show
protect status by blinking red.

An output may be force unprotected, no matter which panel protected it, if the password level of the unprotecting panel is
level 90 or greater. The password level is defined on the MPK Device table (page 5−107). This operation is useful for a master
panel capable of switching any source to any destination. The operator would be required to force unlock the output prior
to changing its source selection.

For additional protect/lock information  − see page 6−12.

CHOP OUTPUTS

To chop* an output, select the first source and press TAKE. Then select the second source and press CHOP. The CHOP button
will blink red, with the first source displayed in the Current window, and the second source displayed in the Preset window.

The chop operation will automatically stop after approximately three minutes. The chop will finish with the source in the
Preset window being switched to the destination. The chop may be manually terminated by performing another source selec-
tion and pressing TAKE.

For additional chop information − see page 6−13.
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LEVEL BREAKAWAYS (SPLIT SWITCHING)

Figure 6−126.
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Level buttons

Breakaways can be accomplished either by presetting the levels to switch, and then selecting a source, or by selecting a source
and then deselecting unwanted levels.

Breakaways can be disabled on the CP Level Set table by setting the Break Flag for each level to ‘N.’ (See page 5−58.)

Level Preset Method

1. Press the Level button corresponding to the desired level.

The level mnemonic appears in the Preset window and the button will illuminate in “high” green with the current status
of that level in the current window. The level may be toggled off by selecting it again. The current window will be blank
if there is no status for that level.

Pressing CLEAR will cancel the operation.

2. Select a source.

Note: If the level window goes blank, the source may not exist on that level (e.g., audio from a camera).

3. Press TAKE (or, on a CP 3830P, PRESET TAKE, TAKE).

The source will switch only on the preset levels, while the non−selected levels will remain at the previously selected
source.

The Current window will display the defined mnemonic for the first level.

To check the status of individual levels, see Status Mode on page 6−96.



Control Panel OperationCP 3830

6−95CM 4000 Installation and Operating Manual

Level Deselect Method

1. Select a source.

The source mnemonic appears in the Preset window; applicable level buttons will illuminate in “high” green.

2. Deselect levels by pressing the appropriate level button.

The button will switch to “low” green, and the Preset window will display the level name. Pressing CLEAR will cancel
the operation.

3. Press TAKE (or, on a CP 3830P, PRESET TAKE, TAKE).

The deselected levels will remain at the previously selected source, while the selected levels will switch to the newly
selected sources.

The Current window will display the defined mnemonic for the first level.

Multi−Source, One−take Splits

The CP 3830 will allow operators to perform complex split switches using multiple sources on levels not defined for all
sources, similar to a salvo switch to a single destination. For example, assume the user has defined Camera−1 with Video and
TimeCode only levels. However, he or she desires CD−1 for audio. To perform this switch in one take:

1. Select all levels to be switched.

In this example, the operator would press the buttons corresponding to Video, Left, Right, and TimeCode. The buttons
will light in “high” green, indicating they are selected.

2. Select the first source.

In this example, Camera−1 would be selected.

3. Deselect the levels that apply to the second source.

In this example, Left and Right.

4. Select the second source.

In this example, CD−1 This source will automatically be assigned to the remaining levels, Left and Right audio.

5. Press TAKE.
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MENU FUNCTIONS

Destination Mode — Press MENU Once

In this mode (already described on page 6−89) the destination is shown in the Preset window. (The CP 3830P will show two
destinations.) If the panel is equipped with a CP 3809 Expansion, the outputs controlled by that panel will be indicated.

To return to Home mode, press CLEAR.

Status Mode — Press MENU Twice

This mode allows the six level buttons to select and status each level.

To return to Home mode press CLEAR. (In Home mode, the six level buttons are used for splits and the UP and DOWN but-
tons are used for source selection)

Audio Mode — Press MENU Three Times

Note 1: Audio status mode can only be used if an appropriately configured Venus switcher is connected.

This mode is accessed by pressing MENU three times; the MENU button will light in red. The Current window will show
the audio mode for the audio channel shown in the Preset window. In Figure 6−127, the Left audio channel is set to “Normal.”

Figure 6−127.
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Other possibilities are:

� MIX − Left and right are mixed on this channel.
� REVERSE − Signal is from the opposite channel.

The six level keys can be used to check other levels.

Note 2: You cannot change settings in Audio Status mode; this must be done using Audio Switching mode. See
page 6−98.
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Panel ID (Address) Mode—Press MENU Four Times

This option displays the current MPK address for this panel in the Preset window.

Diagnostics Mode — Press MENU Five Times

For a description of the diagnostics and adjustments, please see the CP 3808 Diagnostic Mode on page 6−71, starting with
Step 2. Except as noted, this description applies to the CP 3830.
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AUDIO SWITCHING MODE (VENUS SPECIAL STEREO SWITCHING)

The CP 3830 has the capability of controlling Venus Audio Modes, which are Normal, Mix, and Reverse. These changes are
made to individual levels prior to completing a switch by pressing the TAKE button.

Note: Audio switching mode can only be used if an appropriately configured Venus switcher is connected. 

To Perform a Special Stereo Switch:

1. Select a source.

2. Press MENU.

The MENU button will light in red. The Current window will show the audio mode for the audio channel shown in the
Preset window. In Figure 6−128, the Left audio channel is set to “Normal.”

Figure 6−128.

LEFT

 NORMAL
2 3

4 5

7 8 9

0

6

1
VTR CG NET

VCR CAM SAT

TEST NUMAUX

FILM PATCH STU

Menu

Lock

Prot

Clear

Chop

TakeVIDEO LEFT RIGHT AES1 T/C

CURRENT

PRESET

CP 3830

Left channel level key - toggle to desired stereo mode

3. Toggle the Left channel level key (see Figure 6−128) to the desired mode:

� NORMAL − Use left audio for this channel

LEFT LEFT (Left signal on Left channel)

� MIX − Mix left and right on this channel

LEFT

RIGHT

LEFT (Left + Right signals on Left channel)

� REVERSE − Cross opposite channel signal over to this channel

RIGHT

LEFT (Right signal on Left channel)
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4. Toggle the Right channel soft key to the desired mode:

� NORMAL − Use right audio for this channel

RIGHT RIGHT (Right signal on Right channel)

� MIX − Mix left and right on this channel

LEFT

RIGHT RIGHT (Left + Right signals on Right channel)

� REVERSE − Cross opposite channel signal over to this channel

LEFT

RIGHT  (Left signal on Right channel)

5. Press TAKE.
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CP 3832 / 3864 Control Panels

The CP 3832 is a button−per−source control control panel configurable for single bus* (32 X 1) or “split” operation. In split
configurations some of the buttons control inputs and some control outputs. The panel includes buttons for TAKE, LOCK,*
and PROTECT.* For installation and configuration instructions, please see page 2−49.

VTR1 VTR2 VTR3 VTR4

VTR5 VTR6 VTR7 VTR8

CAM1 CAM2 CAM3 CAM4

CAM5 CAM6 CAM7 CAM8

BLACK BARS TONE CG−1SILE
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EBS1 EBS2 TEST1 TEST2 FDL1 FDL2 FDL3 FDL4

Level Menu Clear

Prot/
Lock

Pre−
set

Take

CURRENT

PRESET

VTR−041

VTR−041

Figure 6−129. CP-3832.

The similar CP 3864 is configurable for single bus (64 X 1) or “split” operation. The panel has all of the CP 3832 control
buttons, plus a CHOP button. A “Destination” window is also provided. For installation and configuration instructions, please
see page 2−51.
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Figure 6−130. CP-3864.

All push buttons are capable of green, amber, and red back lighting. On the left side of the panel, green indicates inputs and
amber indicates outputs. On the right side, green is generally used to show a selected function and red to indicate an operation-
al mode in progress.

In some applications, the panels will be grouped with additional CP 3832s or CP 3864s to provide control of up to a 128 X
128 router; or, operated in connection with an adjacent CP 3810 Expansion Panel (see page 6−126).

PASSWORDS

Note: For a general description of the Jupiter password system, please see page 5−22.

If entry of a password (“PASS =00”) is requested, the output about to be affected has a password level higher than that of the
panel. Enter the appropriate password, using the first 10 buttons of the CP 3832/64 to enter digits from 0 to 9 (as shown on
page 6−144).

After entry of a higher−level six−digit password, the command can be completed by pressing TAKE; however, the panel will
then revert to its previous password level.
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SINGLE−BUS OPERATION

32
sources
(green)

Figure 6−131. CP 3832.

64
sources
(green) Figure 6−132. CP 3864.

Each input button of the CP 3832 / 3864 can be assigned to a specific source using a CP Input set (page 5−74.) The name of
this set, and the name of the destination to be controlled, is entered on the MPK Devices table (page 5−110 and following).

To verify destination − for the CP 3832, press MENU. The destination will be shown in the Preset window. Then press
CLEAR. On the CP 3864, the destination is always shown in the “Destination” window.

Audio−follow−video switching - (PRESET off.) When one of the source buttons is pressed, a Take* command is issued to
all levels of the switcher matrix (pressing the TAKE key is not necessary). A status* signal is then returned to the control panel;
this confirms the action by lighting the input button that was pressed and displaying the name of the input in the “Current”
window.

To verify a source before switching (PRESET mode) − To examine the mnemonic of a source in the Preset window before
a Take, the PRESET button should be flashing red or green (press if needed). Select the desired source and check the mne-
monic in the Preset window. Then press TAKE.

Breakaway switching − single level Take − (PRESET Off, or, blinking green.) To switch only a specific switcher level, the
level is defined by first pressing the LEVEL button; the name of the first level will be displayed in the “Preset” window. To
advance to the next level, press LEVEL again. The TAKE command to the switcher will be executed when an input button
is pressed.

If the switch was made on level 1 (usually video) the new input will be displayed in the Current window. If the switch was
made on another level, use the LEVEL button to return to that level; the new input will be displayed in the Current window.
(To turn off the LEVEL button, press CLEAR.) Notice that only the button for the lowest level will illuminate.

Breakaway switching − multi−level Take − To switch different sources to different levels with a single Take command,  press
PRESET (so that the button is flashing red). Then press the LEVEL button. The name of the first level will be displayed in
the Preset window. Advance to the desired level by pressing LEVEL; then select an input for that level. Press LEVEL to select
another level; select the next input, etc. When all selections have been made, press TAKE.

The input for level 1 will be displayed in the Current window. To check the status of another level, use the LEVEL button
to return to that level; the new input will be displayed in the Current window. (To turn off the LEVEL button, press CLEAR.)
Notice that only the button for the lowest level will illuminate.

* Defined in Glossary Section



Control Panel Operation CP 3832 / 3864

6−102 CM 4000 Installation and Operating Manual

Breakaway Switching − Sticky* Level(s)

Blinking LEVEL button
indicates Sticky mode

Figure 6−133.

To “retain” certain levels (keep them selected after a Take), press PRESET (so that the button is flashing red). Then
press the LEVEL button. The name of the first level will be displayed in the Preset window. Advance to the desired
level by pressing LEVEL; then press PROT/LOCK. The message “Retain” will appear briefly in the Current win-
dow and the LEVEL button will blink green as an indication that sticky level switching is now in effect. Press LEV-
EL to select another level; PROT/LOCK again, etc. When all selections have been made, press CLEAR.

To make a switch when sticky levels are in effect (indicated by the blinking LEVEL button ), select the desired
input. Only the sticky levels will switch.

To find out which levels are sticky, press PRESET, then LEVEL. If the first level is sticky, the word “Retain” will
appear briefly in the Current window, if the level is not sticky, the message “No retain”will appear. Advance to
the next level by pressing LEVEL; when finished, press CLEAR.

To cancel sticky levels, press PRESET, then LEVEL. The name of the first level will be displayed in the Preset
window. Advance to the sticky (Retained) level by pressing LEVEL; then press PROT/LOCK to cancel stickiness.
Press LEVEL to select another level; then PROT/LOCK again, etc. When finished, press CLEAR.

Breakaway statusing − To status a specific level of a previous breakaway level switch, use LEVEL to select the level to be
statused; the name of the input will be shown in the Current window.

“Protect/lock” output indicator:

Blinking gr een − The output has been protected* by this panel. See Protecting or Unprotecting an Output
below.

Red − The output has been locked* by this panel. See Locking or Unlocking an Output below.

Blinking red − The output has been protected or locked by another panel. To find out if the output is pro-
tected, or locked, and by what panel, select an input button. Then go to that panel and refer to the appropriate
section below.
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CHOP (CP 3864 ONLY)

To chop* an output:

1. With PRESET off, select the first source.

 2. Press PRESET.

3. Select the second source, and press CHOP.

The CHOP button will blink red, with the first source displayed in the Current window, and the second source displayed in
the Preset window.

The chop operation will automatically stop after approximately three minutes. The chop will finish with the source in the
Current window remaining switched to the destination. The chop may be manually terminated by performing another source
selection.

For additional chop information − see page 6−13.

PROTECTING OR UNPROTECTING AN OUTPUT

Protecting an output prevents that output from being switched by other panels in the system. The protecting panel may still
change the outputs.

To protect an output:

1. Press the PROT/LOCK button.

The Preset display will ask “Lock?”

2. Press the PROT/LOCK button again.

The Preset display will ask “Protect?”

3. Press TAKE.

This has the effect of protecting only those levels this control panel can control (as defined on the CP Level set assigned
to the panel). The button will blink “high” green, indicating the output has been protected by this panel. If a CP 3810
expansion panel is associated with the CP 3832/3864 panel, the output button on the expansion panel will also blink
green.

If a CP 3832 or CP 3864 at another location selects this output for control, that panel’s PROT/LOCK button will blink
red. If a CP 3810 expansion panel is associated with the remote CP 3832/3864 panel, the output button on the expansion
panel will also blink red. If the remote panel attempts to switch this output, a “PROTECT” message will appear, along
with the name of the protecting panel.
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To unprotect the output:

1. Press the PROT/LOCK button again.

The Preset display will ask “Unprot?”

2. Press TAKE.

The PROT button will switch to “low” green.

If the TAKE command is ignored, the output has been protected by another panel. To find out the name of the panel,
select an input button.

An output may be force unprotected, regardless of the panel that protected it, if the password level of the unprotecting panel
is level 90 or greater. The password level is defined on the MPK Device table (page 5−107). This operation is useful for a
master panel capable of switching any source to any destination. The operator would be required to force unlock the output
prior to changing its source selection.

For additional protect/lock information  − see page 6−12.

LOCKING OR UNLOCKING AN OUTPUT

Locking an output prevents that output from being switched by any panel in the system, including the initiating panel. In a
single destination panel, it essentially locks the panel from further operator action until unlocked.

To lock an output:

1. Press the PROT/LOCK button.

The Preset display will ask “Lock?”

2. Press TAKE.

This has the effect of locking only those levels this control panel can control (as defined on the CP Level set assigned
to the panel). The button will illuminate in red, indicating the output has been locked by this panel. (To adjust button
brightness, see page 6−114.) If a CP 3810 expansion panel is associated with the CP 3832/3864 panel, the output button
on the expansion panel will also illuminate in red.

If a CP 3832 or  CP 3864 at another location selects this output for control, that panel’s PROT/LOCK button will blink
red. If a CP 3810 expansion panel is associated with the remote CP 3832/3864 panel, the output button on the expansion
panel will also blink red. If the remote panel attempts to switch this output, a “Locked” message will appear, along with
the name of the protecting panel.

To unlock the output:

1. Press the PROT/LOCK button again.
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The Preset display will ask “Unlock?”

2. Press TAKE.

The PROT/LOCK button lamp will switch to “low” green.

If the TAKE command is ignored, the output has been locked by another panel. To find out the name of the panel, select
an input button.

An output may be forced unlocked, no matter which panel locked it, if the password level of the unlocking panel is level 90
or greater. The password level is defined in the MPK Devices table entry (page 5−107). This operation is useful for a master
panel capable of switching any source to any destination. The operator would be required to force unlock the output prior
to changing its source selection.

For additional protect/lock information  − see page 6−12.
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SPLIT PANEL OPERATION

31 sources (green)

Figure 6−134. Examples of CP 3832 split configurations.

1 destination (amber)

16 sources (green)

16 destinations (amber)

16 sources (green)

63 sources (green)

1 destination (amber)

32 sources (green)

32 destinations (amber)

Figure 6−135. Examples of CP 3864 split configurations.

In split panel applications, the buttons illuminated in green have been configured to select inputs; the buttons illuminated in
amber have been configured to select outputs.

During the configuration process, EXP (expansion) is set to “Y” on the MPK Devices Table (page 5−109). The sources are
defined in a CP Input set of type “cp3832” (page 5−74); the destinations are defined in a CP Output set of type “cp3832” (page
5−90).

Audio−follow−video switching - (PRESET off.) Check to see that the desired output has been selected (amber button); if
not, select it now. When a source (green button) is pressed, a Take* command is issued to all levels of the switcher matrix.
(It is not necessary to press the TAKE key.) A status* signal is then returned to the control panel; this confirms the action by
lighting the input button that was pressed in “high” green and displaying the name of the input in the “Current” window.

Breakaway switching − single level Take − (PRESET off.) Check to see that the desired output has been selected; if not,
select it now. To switch only a specific switcher level, the level is defined by first pressing the LEVEL button; the name of
the first level will be displayed in the “Preset” window. To advance to the next level, press LEVEL again. The TAKE command
to the switcher will be executed when an input button is pressed.

If the switch was made on level 1 (usually video) the new input will be displayed in the Current window. If the switch was
made on another level, use the LEVEL button to return to that level; the new input will be displayed in the Current window.
(To turn off the LEVEL button, press CLEAR.) Notice that only the button for the lowest level will illuminate.

* Defined in Glossary Section
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Breakaway switching − multi−level Take − Check to see that the desired output has been selected on the bottom row; if not,
select it now. To switch different sources to different levels with a single Take command, turn PRESET on (the button will
flash red). Then press the LEVEL button. The name of the first level will be displayed in the Preset window. Advance to the
desired level by pressing LEVEL; then select an input for that level; the selection will be shown in the Current window. Press
LEVEL to select another level; select the next input, etc. When all selections have been made, press TAKE.

The input for level 1 will be displayed in the Current window. To check the status of another level, use the LEVEL button
to return to that level; the new input will be displayed in the Current window. (To turn off the LEVEL button, press CLEAR.)
Notice that only the button for the lowest level will illuminate.

Breakaway switching − sticky* level(s) − See page 6−102.

Split statusing − To status a specific level of a previous breakaway level switch, use LEVEL to select the level to be statused;
the name of the input will be shown in the Current window.

“Protect/lock” output indicator:

Blinking gr een − The output has been protected* by this panel. See Protecting or Unprotecting an Output on
page 6−103.

Red − The output has been locked* by this panel. See Locking or Unlocking an Output on page 6−104.

Blinking red − The output has been protected or locked by another panel. To find out if the output is pro-
tected, or locked, and by what panel, select an input button. Then go to that panel and refer to the section on
Protecting (page 6−103) or Locking (page 6−104), as appropriate.
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OPERATION AS A SOURCE OR DESTINATION EXPANSION PANEL

The CP 3832 / 3864 can be combined with other CP 3832s and CP 3864s to increase the number of sources and destinations
to a maximum of 128 x 128. Examples are shown in Figures 6−136, 6−137, and 6−138.

64 sources
(green)

Figure 6−136.

CP 3832 used as source
expansion panel

48 sources
(green)

16 destinations
(amber)

Figure 6−137.

CP 3832 used as source
expansion panel

CP 3864

Figure 6−138.

64 sources
(green)

32 destinations
(amber) CP 3832 used as

destination panel

Many configurations are possible, but in all cases the buttons illuminated in green control inputs; the buttons illuminated in
amber control outputs.



Control Panel OperationCP 3832 / 3864

6−109CM 4000 Installation and Operating Manual

Single−Bus Operation

For single−bus applications, such as illustrated in Figures 6−139 and 6−140, operation is very similar to that described on page
6−101. The main difference is that only the Main panel’s control buttons (“LEVEL,” “TAKE,” etc.) are normally used. On the
expansion panel(s), the control buttons are not illuminated and the word “Source” always appears in the Preset window.
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Figure 6−139. CP 3832s configured
as 64 x 1 control station.
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Figure 6−140. CP 3864s configured
as 128 x 1 control station.
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Source Expansion Operation (with “balanced Split” 16 x 16 Main Panel)

For expansion with balanced split§ main panel applications, such as illustrated in Figure 6−141, operation is very similar to
that described on page 6−106. The main difference is that only the Main panel’s control buttons (“LEVEL,” “TAKE,” etc.)
are normally used. On the expansion panel(s), the control buttons are not illuminated and the word “Source” always appears
in the Preset window.
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Figure 6−141. CP 3832s configured as 48 x 16 control station.
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§ For a discussion of balanced and unbalanced split configurations, see page 2−49.
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Destination Expansion Operation

For destination expansion applications, such as illustrated in Figure 6−142, operation is very similar to that described on page
6−106. Configuration will be slightly different (since neither panel in Figure 6−142 is being used in the “split” mode).

In terms of operation, only the Main panel’s control buttons (“LEVEL,” “TAKE,” etc.) are normally used. On the expansion
panel(s), the control buttons are not illuminated and the word “Destnatn” always appears in the Preset window.
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Figure 6−142. CP 3832 used as destination panel for 64 x 32 control station.
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MENU FUNCTIONS

Destination Mode — Press MENU Once

In this mode the destination is shown in the Preset window. If the panel is equipped with a CP 3810 Expansion, the outputs
controlled by that panel will be indicated.

To exit this mode, press CLEAR.

Audio Status Mode— Press MENU Twice

Note 1: Audio status mode can only be used if an appropriately configured Venus switcher is connected.

This mode is accessed by pressing MENU twice; the MENU button will light in red and the Preset window will display the
name of the first audio level. The Current window will show the audio mode for that level. In Figure 6−143, the Left audio
channel is set to “Normal.”

Level Menu Clear

Prot/
Lock

Pre−
set

Take

CURRENT

PRESET

NORMAL

LEFT

Figure 6−143.

Other possibilities are:

� MIX − Left and right channels are combined on this channel.

� REVERSE − Channels are swapped.

To move beyond the first audio level, use the LEVEL button.

Note 2: You cannot change settings in Audio Status mode; this must be done using Audio Switching mode. See
page 6−115.

Panel Name — Press MENU Three Times

This option displays the name of the panel as entered on the MPK Devices table.

Panel ID (Address) Mode — Press MENU Four Times

This option displays the current MPK address for this panel in the Preset window.

Diagnostics Mode — Press MENU Five Times

Note:  CP 3832/3864 diagnostics are internal to the control panel and will operate with or without the panel con-
nected to a controller board (such as a CM 4000) via the MPK cable.
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1. Press and release MENU until “DIAGNOSE” appears in the Current window.

2. Use the LEVEL button to select the desired diagnostic.

3. Press TAKE. Instructions for each diagnostic are given below.

To exit the diagnostics mode press CLEAR at any time. (It may be necessary to press CLEAR twice.)

LED Test

This test cycles through the button lamps (LEDs) and illuminates them in green and then red. The test will stop after one cycle.
Pressing CLEAR during this test will cancel this test and return the panel to the beginning of the current diagnostic. Pressing
CLEAR again will exit the Diagnostic mode.

Info

Info displays the panel’s Application (PROM) version , Xilinx FPGA* version, Variant version (not implemented), and PCB
(hardware) version. Press CLEAR to exit.

Baud Rate

When selected, this option displays the current baud rate for the panel. Press LEVEL to cycle through the baud rate settings.
Available baud rates are: 38400, 19200, 9600, 4800, 2400, and 1200. Pressing TAKE will program the changed setting;
CLEAR will cancel.

The baud rate must agree with the setting for the CM 4000 port used by the panel (see Serial Protocol on page 5−30).

Panel ID

This diagnostic requires the panel be disconnected from the MPK data cable.

When selected, this option displays the current MPK address for this panel and permits entry of a new address. Use the top
row of buttons to enter a hexadecimal address (see Figure 6−144).

0 1 3 3 4 5 6 7 8 9 A CB D E F Level Menu Clear

Prot/
Lock

Pre−
set

Take

CURRENT

PRESET

00000032

Figure 6−144. CP 3832 buttons used to enter hex address. CP 3864 buttons are similar.

The CP 3264 panel operates in a similar manner.

Pressing TAKE will program the newly entered address; CLEAR will cancel.

* Defined in Glossary section
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The address must agree with the setting for the panel on the MPK Devices table (see page 5−107).

MPK Test

This diagnostic requires the panel be disconnected from the MPK data cable.

This test allows the factory to test the MPK connection on the control panel.

Illumination Adjustment

This option allows the user to change the “Low” and “Medium” levels of green button illumination, the “Low” and “Medium”
levels of red button illumination, and the level of LED (display character) illumination. The “High” button levels are not ad-
justable.

The “Low” green level is used for normal button lighting. “High” green and “high” red are also used, but these are not adjust-
able.

Note: The amber color, which is used for output buttons, is created by combining Low green and Low red.

For each setting, use the LEVEL button to increase brightness and PRESET to decrease. Press TAKE to save the setting and
advance to the next color. Press CLEAR to exit.

Burn In

This test rotates through the button lamp and Display tests continually.  Press CLEAR to cancel.

Keyboard Test

This diagnostic displays the number of each button as it is pressed. Pressing the LEVEL key will change the lamp color. Press-
ing CLEAR twice exits.

Display Test

This test cycles through and displays all legal characters. The test will stop after one cycle. Pressing CLEAR exits. (On the
CP 3810, press the CLEAR button twice to exit.)
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AUDIO SWITCHING MODE (VENUS SPECIAL STEREO SWITCHING)

The CP 3832/64 has the capability of controlling Venus Audio Modes, which are Normal, Mix, and Reverse. These changes
are made to individual levels prior to completing a switch by pressing the TAKE button.

Note: Audio switching mode can only be used if an appropriately configured Venus switcher is connected.

To perform a special stereo switch:

1. Enter Preset mode by pressing PRESET. The button will flash red.

2. Select a source. The source mnemonic will appear in the Preset window.

3. Press MENU.

The MENU button will light in red and the Preset window will display the level mnemonic. The Current window will
show the audio mode for the left channel.

In Figure 6−145, the left audio channel is set to “Normal.”

Figure 6−145.

Level Menu Clear

Prot/
Lock

Pre−
set

Take

CURRENT

PRESET

NORMAL

LEFT

4. Toggle the left channel to the desired mode by pressing PRESET:

� NORMAL − Use left audio for this channel

LEFT LEFT (Left signal on Left channel)

� MIX − Mix left and right on this channel

LEFT

RIGHT

LEFT (Left + Right signals on Left channel)

� REVERSE − Cross opposite channel signal over to this channel

RIGHT

LEFT (Right signal on Left channel)
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5. Press the LEVEL button to move to the right channel. Toggle the right channel to the desired mode by pressing the
PRESET button.:

� NORMAL − Use right audio for this channel

RIGHT RIGHT (Right signal on Right channel)

� MIX − Mix left and right on this channel

LEFT

RIGHT RIGHT (Left + Right signals on Right channel)

� REVERSE − Cross opposite channel signal over to this channel

LEFT

RIGHT  (Left signal on Right channel)

6. Press TAKE.
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CP 3832L / 3864L Control Panels

The CP 3832L is a CP 3832 panel configured so that the right−hand group of six buttons function as level selection buttons.

The CP 3832L is a button−per−source control control panel configurable for single bus* (32 X 1) or “split” operation. In split
configurations some of the buttons control inputs and some control outputs. For installation and configuration instructions,
please see page 2−49.

VTR1 VTR2 VTR3 VTR4

VTR5 VTR6 VTR7 VTR8

CAM1 CAM2 CAM3 CAM4

CAM5 CAM6 CAM7 CAM8

BLACK BARS TONE CG−1SILE
NCE CG−2 CG−3 CG−4

EBS1 EBS2 TEST1 TEST2 FDL1 FDL2 FDL3 FDL4

Level
1

Level
2

Level
3

Level
5

Level
4

Level
6

CURRENT

PRESET

VTR−041

LEFT

Figure 6−146. CP-3832.

The CP 3864L is a CP 3864 panel configured so that the upper right−hand group of six buttons function as level selection
buttons and the adjacent lower button functions as a Protect key. (The Lock function is not available for this panel.)

The CP 3864L is configurable for single bus (64 X 1) or “split” operation. A “Destination” window is also provided. For
installation and configuration instructions, please see page 2−51.

VTR1 VTR2 VTR3 VTR4

VTR5 VTR6 VTR7 VTR8

CAM1 CAM2 CAM3 CAM4

CAM5 CAM6 CAM7 CAM8
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NCE CG−2 CG−3 CG−4

EBS1 EBS2 TEST1 TEST2 FDL1 FDL2 FDL3 FDL4

MON1 MON2 MON3 MON4

MON8MON6MON6MON5

STU1 STU2 STU3 STU4

EDIT1 EDIT2 EDIT3 EDIT4

PST PGM AIR KEY1

KEY2 BACK
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PASS XMIT

VTR1 VTR2 VTR3 VTR4
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DESTINATION

VTR−041
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Figure 6−147. CP-3864.
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Prot

PASSWORDS

The Password function is limited to the password level assigned to the panel on the MPK table. It isn’t possible to enter a
supervisory password to temporarily raise the password level of the panel.

Note: For a general description of the Jupiter password system, please see page 5−22.
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SINGLE−BUS OPERATION

32
sources
(green)

Figure 6−148. CP 3832L.

64
sources
(green) Figure 6−149. CP 3864L.

Each input button of the CP 3832L / 3864L can be assigned to a specific source using a CP Input set (page 5−74.) The name
of this set, and the name of the destination to be controlled, is entered on the MPK Devices table (page 5−110 and following).

To verify destination (CP 3864L only) − On the CP 3864, the destination is always shown in the “Destination” window.

Audio−follow−video switching − When one of the input buttons is pressed, a Take* command is issued to all levels of the
switcher matrix. A status* signal is then returned to the control panel; this confirms the action by lighting the selected input
button and displaying the name of the input in the Current window.

Split switching − When the operator desires to take only specific switcher levels, those levels are defined by first pressing
one or more of the six level breakaway buttons. The Take command to the switcher will be executed when an input button
is pressed. The switcher will confirm the action by lighting the selected input button. Since the panel always operates in
“sticky level” mode, the selected level buttons will remain lit after the input button has been pressed.

Split statusing − To status a specific level of a previous breakaway level switch, select the level to be statused; one of the
input buttons will illuminate and the Current window will indicate the source for that level. If more than one level status button
has been toggled on (like A1 and A2), only the lowest level (A1) will be statused.

* Defined in Glossary Section
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PROTECT/UNPROTECT FUNCTIONS

CP 3832L

A CP 3832L will indicate when another panel has protected (or locked) an output by flashing the last selected input button.
The CP 3832L cannot protect/unprotect (or lock/unlock) an output.

CP 3864L

Protecting an output prevents that output from being switched by other panels in the system. The protecting panel may still
change the output.

To protect an output with the CP 3864L:

1. Press the Protect button.

This has the effect of protecting only those levels this control panel can control (as defined on the CP Level set assigned
to the panel). The button will blink “high” green, indicating the output has been protected by this panel. In addition, the
associated input button will also blink green.

If another panel attempts to switch this output, a “Protected” indication will appear on that panel.

To unprotect the output:

1. Press the Protect button again.

The Protect button will switch to “low” green.

If the Protect command is ignored, the output has been protected by another panel. To find out the name of the panel,
select an input button.

An output may be force unprotected, regardless of the panel that protected it, if the password level of the unprotecting panel
is level 90 or greater. The password level is defined on the MPK Device table (page 5−107). This operation is useful for a
master panel capable of switching any source to any destination. The operator would be required to force unprotect the output
prior to changing its source selection.

If another panel has protected (or locked) the output, the CP 3864 Protect button will blink red. In addition, the last selected
input button on the CP 3864L will blink green.

The CP 3864 cannot lock or unlock an output.

For additional Protect information  − see page 6−12.
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SPLIT PANEL OPERATION

31 sources (green)

Figure 6−150. Examples of CP 3832L split configurations.

1 destination (amber)

16 sources (green)

16 destinations (amber)

16 sources (green)

63 sources (green)

1 destination (amber)

32 sources (green)

32 destinations (amber)

Figure 6−151. Examples of CP 3864L split configurations.

In split panel applications, the buttons illuminated in green have been configured to select inputs; the buttons illuminated in
amber have been configured to select outputs.

During the configuration process, EXP (expansion) is set to “Y” on the MPK Devices Table (page 5−109). The sources are
defined in a CP Input set of type “cp3832” (page 5−74); the destinations are defined in a CP Output set of type “cp3832” (page
5−90).

Audio−follow−video switching - Check to see that the desired output has been selected (amber button); if not, select it now.
When a source (green button) is pressed, a Take* command is issued to all levels of the switcher matrix. A status* signal is
then returned to the control panel; this confirms the action by lighting the input button that was pressed in “high” green and
displaying the name of the input in the “Current” window.

Breakaway switching − single level Take − Check to see that the desired output has been selected; if not, select it now. To
switch only a specific switcher level, the level is defined by first pressing the appropriate level button; the name of the first
level will be displayed in the “Preset” window. The Take command to the switcher will be executed when an input button
is pressed.

* Defined in Glossary Section
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Breakaway switching − multi−level Take − Check to see that the desired output has been selected on the bottom row; if not,
select it now. To switch different levels with a single command, press the first desired level button. The name of the first level
will be displayed in the Preset window. Press the next desired level button, etc. When all selections have been made, perform
the switch by pressing an input button.

Split statusing − To status a specific level, select the desired level button. The name of the input will be shown in the Current
window. Then toggle off the level button. To status another level, select another level button, toggle the button off, etc.

DIAGNOSTICS MODE

Although the CP 3832L and 3864L do not have “Menu,” “Level,” etc. buttons as such (because the buttons are used as level
selection keys), the “Diagnostic” functions are still available indirectly. To access these functions, the MPK cable on the rear
of the unit must first be disconnected. Then use the buttons as described below.

CURRENT

PRESET

Figure 6−152. CP 3832L buttons as used during Diagnostic Mode.

Level
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Level
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CURRENT

PRESET

DESTINATION

Figure 6−153. CP 3864L buttons as used during Diagnostic Mode.
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Prot

1. Press and release the “Level 2” button until “DIAGNOSE” appears in the Current window.

2. Use the “Level 1” button to select the desired diagnostic.

3. Press the “Level 6” button (CP 3832L) or the “Protect” button (CP 3864L). Instructions for each diagnostic are given
below.

To exit the diagnostics mode press “Level 3” at any time. (It may be necessary to press Level 3 twice.)

LED Test

This test cycles through the button lamps (LEDs) and illuminates them in green and then red. The test will stop after one cycle.
Pressing Level 3 during this test will cancel this test and return the panel to the beginning of the current diagnostic. Pressing
Level 3 again will exit the Diagnostic mode.

Info

Info displays the panel’s Application (PROM) version , Xilinx FPGA* version, Variant version (not implemented), and PCB
(hardware) version. Press Level 3 to exit.
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Baud Rate

When selected, this option displays the current baud rate for the panel. Press Level 1 to cycle through the baud rate settings.
Available baud rates are: 38400, 19200, 9600, 4800, 2400, and 1200. Pressing the “Level 6” button (CP 3832L) or the “Pro-
tect” button (CP 3864L) will program the changed setting; Level 3 will cancel.

The baud rate must agree with the setting for the CM 4000 port used by the panel (see Serial Protocol on page 5−30).

Panel ID

When selected, this option displays the current MPK address for this panel and permits entry of a new address. Use the top
row of buttons to enter a hexadecimal address (see Figure 6−144).

0 1 3 3 4 5 6 7 8 9 A CB D E F

CURRENT

PRESET

00000032

Figure 6−154. CP 3832 buttons used to enter hex address. CP 3864 buttons are similar.

Level
1

Level
2

Level
3

Level
5

Level
4

Level
6

The CP 3264 panel operates in a similar manner.

Pressing the “Level 6” button (CP 3832L) or the “Protect” button (CP 3864L) will program the newly entered address; Level
3 will cancel.

The address must agree with the setting for the panel on the MPK Devices table (see page 5−107).

MPK Test

This test allows the factory to test the MPK connection on the control panel.

Illumination Adjustment

This option allows the user to change the “Low” and “Medium” levels of green button illumination, the “Low” and “Medium”
levels of red button illumination, and the level of LED (display character) illumination. The “High” button levels are not ad-
justable.

The “Low” green level is used for normal button lighting. “High” green and “high” red are also used, but these are not adjust-
able.

Note: The amber color, which is used for output buttons, is created by combining Low green and Low red.

For each setting, use the Level 1 button to increase brightness and Level 4 to decrease. Press the “Level 6” button (CP 3832L)
or the “Protect” button (CP 3864L) to save the setting and advance to the next color. Press Level 3 to exit.

* Defined in Glossary section
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Burn In

This test rotates through the button lamp and Display tests continually. Press Level 3 to cancel.

Keyboard Test

This diagnostic displays the number of each button as it is pressed. Pressing the Level 1 key will change the lamp color. Press-
ing Level 3 twice exits.

Display Test

This test cycles through and displays all legal characters. The test will stop after one cycle. Pressing Level 3 exits.
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CP 3809 Expansion Panel Operation

The CP 3809 can be used as a companion to the CP 3808 Switcher Control Panel or to the CP 3830 Control Panel. Each button
on the CP 3809 panel represents a destination, with the display line above providing status. Up to five CP 3809 panels can
be associated with a CP 3808 or CP 3830, providing up to 40 outputs for control. Figure 6−155 illustrates a control panel array
for CP 3809 control of 16 outputs.

For multi−bus control the desired source can be selected on the CP 3808/3830; the CP 3809 would then be used to select the
destination(s). The selected output button will glow “high” green to show that it will be affected by the switch. To complete
the switch, the operator presses the TAKE button on the CP 3808/3830. (This action does not affect the output being controlled
by the CP 3808 or CP 3830.)
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4 5

7 8 9
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Figure 6−155. CP 3808/E (top) with CP 3809/1  Expansion Panel (below)
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Dynamic Assignment of Outputs to Expansion Panel Buttons

The process of assigning outputs to the expansion panel is the same as assigning the output to be controlled by the CP
3808/3830, except that the desired button is pressed on the expansion panel (rather than TAKE on the main panel):

1. On the CP 3808 or CP 3830, press MENU. Then select an output.

For details concerning this procedure, see page 6−65 (CP 3808). or page 6−76 (CP 3830).

2. On the expansion panel, press the appropriate destination key.

To check the new assignment, press MENU.

Note: Only the output button positions not defined in the CP Output Set may be changed. See page 5−79.
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Deleting an Output on TAKE Key

To delete an output that has been dynamically assigned to the expansion panel, use the CP 3808/3830 to select an output that
is not defined and press the appropriate button on the expansion panel.

Permanent Assignment of Outputs to the Expansion Panel 

Outputs can also be assigned permanently, using the CP Output Set. See page 5−79.

Since there are no output displays, Grass Valley recommends fixing these outputs in the CP Output Set and installing perma-
nent labels in the buttons.

Diagnostics Mode

On the CP 3809, diagnostics mode is entered by pressing and holding the first button while pressing the eighth button.

For a description of the diagnostics and adjustments, please see the CP 3830 Diagnostic Mode on page 6−87, starting with
Step 2. Except as noted, this description applies to the CP 3809.
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CP 3810 Expansion Panel Operation 

The CP 3810 panel can be associated with a CP 3832, CP 3864, CP 3808, or CP 3830 Main panel, providing control of up
to 80 outputs. The CP 3810 can be configured as a “CP 3810L,” allowing it to be assigned to one output; this provides break-
away (split) switching and/or multi−level status. Alternatively, it can be configured as a “CP 3810S,” meaning that the se-
lected outputs will remain selected until explicitly changed by the operator.

The CP 3810 can also be used as a limited−function machine control panel, providing Play and Stop commands for VTRs.

Figure 6−156 illustrates a CP 3810 with a CP 3832 panel.

Note: Even when associated with a CP 3810, the Main panel is still configured independently and can be operated
independently.
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Figure 6−156. CP 3832 with CP 3810 (bottom).

VTR−001 P=01

For a general description of the CP 3810, and hardware installation instructions, see page 2−54. For software configuration
instructions (MPK table), see page 5−131.

To assign CP 3810 buttons to outputs, see page 5−79.

Configuration for machine control applications and the method by which machines are assigned to the panel are discussed
on page 5−148.

MULTI−BUS CONTROL

When configured for multi−bus control, the status of eight buses will normally be seen in the CP 3810’s eight−character dis-
play windows. The “page” of status of eight destinations can be scrolled with the arrow buttons to display up to 80 possible
destinations; the current page number is shown in the window above the DEST button.

To verify destinations − For the CP 3810, press DEST; the destinations will be shown in the eight display windows. The
“page” of eight destinations can be scrolled with the arrow buttons to display up to 80 possible destinations. To return to status
mode, press DEST again. For the Main panel, press MENU, then CLEAR.
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Audio−follow−video Switching

PRESET OFF method. See Figure 6−157.

Figure 6−157. Switching with Preset OFF.

Select destination(s)

PRESET OFF

Select source

[1]

[2]
[3]

1. Check to see that PRESET is OFF.

2. Use the CP 3810 to select the destination(s).

The “page” of eight destinations can be scrolled with the arrow buttons to display up to 80 possible destinations. The
selected output button(s) will glow “high” green to show it will be affected by the switch.

3. Use the Main panel to select the source. This completes the switch.

When one of the source buttons is pressed, a Take command is issued to all levels of the switcher matrix. (Press the TAKE
key is not necessary.) A status signal is then returned to the control panel; this confirms the action by lighting the input
button that was pressed and displaying the name of the input in the “Current” window of the Main panel and the appropri-
ate windows on the CP 3810.

This action does not affect the output being controlled by the Main panel.

If the CP 3810 has been configured for “sticky output” operation (CP 3810S), selected outputs will remain selected until
the Take/Select button(s) are toggled off.

If entry of a password is requested on the Main panel (“PASS =00”), the output about to be affected has a password level
higher than that of the panel. For more information about passwords, refer to the operation instructions for the Main
panel.
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PRESET ON method. See Figure 6−158.

Figure 6−158. Switching with PRESET ON.

Select destination(s)

PRESET ON
Select source

Press TAKE

[1]
[2]

[3] [4]

1. Check to see that PRESET is ON.

2. Select a source using the Main panel.

3. Use the CP 3810 to select the destination(s).

The “page” of eight destinations can be scrolled with the arrow buttons to display up to 80 possible destinations. The
selected output button(s) will glow “high” green to show that it will be affected by the switch.

4. Press the TAKE key.

A status signal is then returned to the control panel; this confirms the action by lighting the input button that was pressed
and displaying the name of the input in the “Current” window of the Main panel and the appropriate windows on the
CP 3810.

If the CP 3810 has been configured for “sticky output” operation (CP 3810S), selected outputs will remain selected until
the Take/Select button(s) are toggled off.

If entry of a password is requested on the Main panel (“PASS =00”), the output about to be affected has a password level
higher than that of the panel. For more information about passwords, refer to the operation instructions for the Main
panel.
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SINGLE−BUS CONTROL

In the example shown in Figure 6−159, a CP 3832 is used to select inputs and a “CP 3810L” is used to control the individual
levels of one output. The CP 3810 can thus be used for breakaway switching.

To find out what output is being controlled by the CP 3810, use the “show destination” procedure for the Main panel. In the
example shown in Figure 6−159, the CP 3832 MENU button would be pressed.

Note: To verify that the CP 3810 has been configured as a “CP 3810L,” press the DEST button. This will display
level names if the panel has been configured as a CP 3810L.

Switching Procedure

PRESET OFF method. See Figure 6−159.

Figure 6−159. Switching with Preset OFF.
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(If no levels are
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PRESET ON method. See Figure 6−160.

Figure 6−160. Switching
with PRESET ON.
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X−Y Application

In the example shown in Figure 6−161, a CP 3864 is used to select inputs, a CP 3832 is used to select outputs, and a “CP 3810L”
is used for control/status the individual levels of the output selected by the CP 3832. The CP 3810 can thus be used for break-
away switching.

32
destinations

(amber)

64
sources
(green)

STATUS/CONTROL
of individual levels

Figure 6−161

Once a destination has been selected, the switching procedure is similar to that just described (page 6−129). The “page” of eight
levels can be scrolled with the arrow buttons to display additional levels.

SINGLE−BUS STATUS ONLY (STAND−ALONE)

In this mode, a “CP 3810L” is configured to status the output assigned on the MPK Devices table. No other panel is associated
with the panel and there is no switcher control.

STATUS
of individual levels

Figure 6−162

To verify levels, press DEST. The level names will be shown in the eight display windows.

DIAGNOSTICS MODE

On the CP 3810, diagnostics mode is entered by pressing and holding the first button on the left while pressing DEST. This
will display the Panel (Device) Name and the Panel ID (Address) from the MPK Devices table. To clear the ID and enter the
Diagnostic mode, press DEST again. Use the soft−keys labelled with the UP and DOWN arrows to to select the desired diag-
nostic; press the TAKE soft−key to start the diagnostic.

For a description of the diagnostics and adjustments, please see Diagnostic Mode on page 6−112.

JEP 100 Jupiter / Encore Control Panel

Please refer to the JEP 100 manual, part no. 071 8376 xx.
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MC 3000 Machine Control Panel and CP 3010 Expansion Panel

Figure 6−163. MC 3000
machine control panel
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Installation of these panels has already been described (page 2−37).

The MC 3000 machine control panel includes a series of push buttons for motion control (PLAY, STOP, etc.). A variable speed
knob, with a color−coded direction/speed indicator, is also included.

The machine to be operated can be selected using the adjacent CP 3010 expansion panel (Figure 6−164), which can display
the names of eight linked machines over a row of selection buttons. Additional pages of eight machines can be called up for
display in the window as required.

The method by which machines are linked (assigned) to the CP 3010 is described in detail elsewhere in this manual (see As-
signing Machines to Control Panels on page 5−141). Essentially, each TAKE/SELECT button is “associated” with a particu-
lar output of the routing switcher and switching a VTR to that output will cause the VTR to appear over the button. This “fol-
low−the−switcher” concept should be understood before operating either of these panels.

The CP 3010 can also be used as a limited−function machine control panel, providing Start and Stop commands for VTRs.
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MC 3000 CONTROL FUNCTIONS

Toggles the machine in and out of scanner ready mode.

Stops machine regardless of mode.

Playback mode. May or may not override current mode, depending on machine.

Slow motion playback. Speed is indicated in the display window.

May or may not override current mode, depending on machine. When first
pressed, speed will be 1/5 or +0.2 play speed. Typical speed range, using variable
speed knob,  is −1 to +3 times play speed.

Captures current time code.

The actual value will depend on the machine and interface used. For more infor-
mation, see Appendix E.

Go to time code point captured with Set Mark command, minus Preroll value set
on the Machine Control Devices table, and stop. For more information, see Pre-
roll  on page 5−140.

For more information, see Appendix E.

End record mode (same as ESbus Exit command). Normally used to terminate
an Insert edit, in which case machine drops out of record mode but keeps on play-
ing.

When machine is stopped, pressing RECORD OUT also serves to place machine
in Tape Monitor mode.

SET
MARK

VAR

PLAY

STOP

RDY

SRCH
MARK

REC
OUT

>

>
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When pressed at the same time as PLAY, starts record mode and illuminates Re-
cord LED. Same as ESbus Play and Enter.

When machine is stopped, pressing RECORD IN places machine in E−E Monitor
mode.

Select a recording mode. Depending on the machine, pressing the button will cy-
cle through the following, as indicated in the display window:

Off − Record inhibit. 

Manual − Pressing PLAY and RECORD IN will begin a recording, during which
no editing functions will be enabled. 

Assemble − Pressing PLAY and RECORD IN will begin an Assemble edit.

Insert − Pressing PLAY and RECORD IN will begin an Insert edit.

             Full−speed shuttle (rewind or fast forward); speed is shown in the display win-
dow. Speed can be reduced by variable speed knob; direction can be reversed if
desired.

           Press both buttons at once for Jog (frame advance). Direction and speed is deter-
mined by variable speed control. (This is supported for true ESbus controlled
VTRs only, e.g., DCR 500.)

Shuttle mode can be entered by turning the knob more than approx. 30 degrees.

         Press both buttons at once for Diagnostic mode. Diagnostics are similar to those
supplied with the MC 3010 (as described on page 6−137). To exit individual diag-
nostics, use the Fast Forward ( >> ) key. To exit diagnostic mode, press both Ready
and Fast Forward at the same time.

<< >>

<< >>

Shuttle knob

>>

or

and

and

REC
MODE

REC
IN

RDY

Using the MC 3000 to Access Sony Auto−Edit Mode

To mark the edit beginning point, press the SET MARK key. Use any method to reach the edit ending point on the tape. To
mark the end point and initiate the edit, press and hold REC IN, then press PLAY, then release both buttons. The VTR will
rewind to the edit begin point minus the set preroll time, go into Play mode, and at the edit beginning point (where you pressed
SET MARK) go into Record mode. It will stay in Record until the edit ending point (where you pressed REC IN + PLAY),
at which point the VTR will continue on for a few frames, then go into Variable Play, rewind to the edit ending point, then
stay in Variable Play with a velocity of 0.00.
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CP 3010 CONTROL FUNCTIONS

The method by which machines are linked (assigned) to the CP 3010 is described in detail elsewhere in this manual (see As-
signing Machines to Control Panels on page 5−141). Linkage is indicated by the name of the machine appearing in the display
window.

When a machine name appears in the window, pressing SEL enables Start/Stop
control (described below). It also enables control using the adjacent  MC 3000 Ma-
chine Control Panel (if any). The TAKE legend does not apply to machine control.

Starts machine shown in window.

Stops machine shown in window.

Scrolls window up to next page of machine names.

Scrolls window back one page.

>

TAKE
−−−−−−

SEL

∨

∧
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MC 3010 Machine Control Panel

Figure 6−165. MC 3010/2 Dual 4−Machine Control Panel

 VTR1      VTR2      VTR4

PLAYGANG
START

PLAYGANG
START

PLAYGANG
START

PLAYGANG
START

STOP
−−−−−−
SHIFT

READY
−−−−−−
REW

REC
−−−−−−

FFD

STOP
−−−−−−
SHIFT

READY
−−−−−−
REW

REC
−−−−−−

FFD

STOP
−−−−−−
SHIFT

READY
−−−−−−
REW

REC
−−−−−−

FFD

STOP
−−−−−−
SHIFT

READY
−−−−−−
REW

REC
−−−−−−

FFD

Installation of these panels has already been described (page 2−37).

The MC 3010 is used to control four (MC 3010/1 version) or eight (MC 3010/2 version) tape machines. The display window
shows the name of the machine presently linked to the button group immediately below. Lighted, re−legendable push buttons
are provided for motion control (PLAY, STOP, etc.). Machine commands and status indications are shown in Figure 6−166.

The method by which machines are linked (assigned) to the MC 3010 is described in detail elsewhere in this manual (see
Assigning Machines to Control Panels on page 5−141). Essentially, each button group is “associated” with a particular output
of the routing switcher and switching a VTR to that output will cause the VTR to appear over the button group. This “follow−
the−switcher”concept should be understood before operating the panel.

Gang Start

To send the same command to more than one machine, toggle on the GANG START key for each desired machine. Then press
the appropriate command key (RECORD, STOP, etc). All following commands will be sent to all marked machines until the
GANG START keys are toggled off.

Gang Start commands will be applied to marked machines on both left and right halves of a dual panel.
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Rewind

READY
−−−−−−
REW

STOP
−−−−−−
SHIFT

STOP
−−−−−−
SHIFT

Figure 6−166. MC 3010 Operation and status

STOP
−−−−−−
SHIFT

PLAY

PLAY

REC
−−−−−−

FFD

Record

Fast forward

Stop

Action desired

Play

PLAY

PLAY

REC
−−−−−−

FFD

REC
−−−−−−

FFD

READY
−−−−−−
REW

Ready

READY
−−−−−−
REW

Press System response (status)

press & hold

then press

press & hold

then press

press & hold then press

STOP
−−−−−−
SHIFT
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DIAGNOSTICS

The diagnostics mode allows several panel functions to be checked without sending any machine commands.

GANG
START

GANG
START

Figure 6−167. Keys used to enter diagnostic mode.

press & hold

then press

READY
−−−−−−
REW

READY
−−−−−−
REW

READY
−−−−−−
REW

 DISPLAY  KEYBOARD  LAMPS

Figure 6−168. Diagnostic menu. Press appropriate READY/REWIND key to select test.

Display The display test will cycle through the character set used in the display window and repeat.
To exit to the diagnostic menu (Figure 6−168), press any READY/REWIND key.

Keyboard The keyboard test will report the key number of each button pressed. To exit to the diagnostic
menu, press any READY/REWIND key twice.

Lamps After starting the lamp test, it will take about 10 seconds for the first MC 3010 key to light. To
exit to the diagnostic menu, press any READY/REWIND key.

To exit the diagnostic mode, repeat the step shown in Figure 6−167. (If in keyboard test (as indicated by a “Key =” message),
you must first press any READY/REWIND key twice.)
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VGA Status Display Operation

The VGA Status Display provides a supervisory, system−wide display of switcher, machine, or system status. The display
video is provided by the VGA output of a CM 4000. The display format is initially based on a set of factory default pages,
but can be customized as needed. (For more information about installation and configuration, see Appendix A.)

Basic controls for this display are located on the front panel of the CM 4000 (Figure 6−169).

Figure 6−169. VGA controls on CM 4000

DOWNUP NEXT SELECT

For easier operation, the CM 4000 can be connected to one CP 3020 control panel, which in this application is configured
as device type “VC 3020” (see Figure 6−170). To use the VGA to best advantage, it should also be connected to a CP 3000
Switcher Control Panel and an MC 3000 Machine Control Panel. The RGB display monitor and the controls just described
should be located as close together as possible, preferably in the same equipment rack.

Figure 6−170. VGA Status Display control panel arrangement.

CP 3020 control panel, showing suggested labels for VC 3020 application

CP 3000 MC 3000

NEXT
CURSOR
MODE

CHNG
MODE 0 91 2 3 4 5 6 7 8

Philips                WXYZ TELEVISION ROUTER/VTR STATUS                PAGE: 00
May 10, 1999                   SWITCHER STATUS                          12:34:56
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
OUTPUT      VIDEO     LEFT     RIGHT    TC
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
PrdA        VT01      VT01     VT01     VT01
PrdB        VC01      VC01     VC01
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1
PrdC        Cam1      Cam1     Cam1

The VGA display starts up on Page #0 as defined in the VGA Page Description File. Display pages 0−9 are selected with the
number buttons.

Note: Page decades are accessed using 9+UP ARROW or 0+DOWN ARROW. For example, for pages 10−19,
press “9,” then UP ARROW; the “0” button will light indicating page 10, and the number buttons will select pages
10−19. To return to pages 0−9, press “0,” then DOWN ARROW; the “9” button will light and the number buttons
will select pages 0−9.
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The following discussion is based on the factory default set of display pages.

SWITCHER OUTPUT STATUS PAGE

Thomson         WXYZ TELEVISION FACILITY CONTROL SYSTEM               PAGE: 01
May 10, 1999             MAIN Switcher Output Status                    12:34:56
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
OUTPUT      VIDEO     LEFT     RIGHT    TC
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
PrdA        VT01      VT01     VT01     VT01
PrdB        VC01      VC01     VC01
PrdC        Cam1      Cam1     Cam1

Figure 6−171. Switcher out-
put status page (example)

Levels

Outputs

Inputs

A switcher output status page (Figure 6−171) can provide a list of switcher outputs and the name of the input switched to each.
Separate columns for each level can be used to report split switches; these can be highlighted with a distinct color.

An alternating (flashing) display indicates that the output is locked or protected:

• The first flashing character shows “L” if the output is locked; “P” if the output is protected.

• If a single flashing character is shown next, it indicates a special control device (i.e., not an MPK panel) has set
the the lock or protect. “A” is for an ASCII protocol device (e.g., an automation computer); “S” is for an ES−
switch protocol device (ditto).

• The following characters show the name of the locking/protecting device. The name is taken from (or short-
ened from) that shown on the MPK Devices table.

NEXT is used to cycle through additional logical switchers (if any). UP and DOWN (or the arrow buttons on the CP 3020)
will step through additional pages of outputs; hold the key down to auto−repeat.

Cursor Mode − Selecting an Output for Control

To enter cursor mode, press SELECT on the CM 4000 (or CURSOR MODE on the CP 3020). This will cause
the name of the first output to appear in reverse video. The UP and DOWN buttons (or arrow buttons) will move
the cursor from one output to another. An output pointed to by the cursor is automatically selected as the output
to be controlled by the CP 3000 Switcher Control Panel associated with the CM 4000 providing the VGA display.

Note 1: If an output cannot be switched, it may be that the output or input requested is not included in the CP
Output Set assigned to the CP 3000. See page 5−114. This may also be the case if asterisks appear in place of
the normal status indication.
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Note 2: If the cursor mode in the switcher status display will not work, it may be that no CP 3000 was defined
for the VGA on the MPK Devices table (page 5−114).

Force Unprotect / Force Unlock

As a supervisory system, the VGA / CP 3000 can be configured such that it can unprotect or unlock any output
shown on the display.

— If the panel has been so configured on a permanent basis (as described on page 5−114), place the cursor on the
output and press PROTECT (or LOCK) and TAKE.

— If the panel has not been configured permanently, login to the panel using a 90 level or above  password. This
will allow use of the force unprotect/unlock command until logout.

For additional protect/lock information  − See page 6−12.

MACHINE & DELEGATION STATUS PAGE

Thomson             WXYZ TELEVISION FACILITY CONTROL SYSTEM            PAGE: 01
May 10, 1999              MACHINE & DELEGATION STATUS                  12:34:56
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
MACHINE    STATUS   LINKAGE    MCS     STU     ENG     TAPE
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
VT01       STOP     StuMC      StuMC
VT02
VT03
VT04
VT05
VT06
VT07
VT08
VT09
VC01       STOP     StuMC     ASSIGNED     
VC02       STOP               ASSIGNED
VC03
VC04
VC05

Figure 6−172. Machine  & delegation
status page (example).

Up to 32 
Delegation

groups

A machine and delegation status page (Figure 6−172) can provide a list of all VTRs and other machines listed on the Machine
Control Devices table (page 5−135). The UP and DOWN buttons (or arrow buttons on the CP 3020) will step through addi-
tional pages of machines. Hold the key down to auto−repeat.

Depending on the machine, TMC (Transport Motion Control) status is shown as follows:

     OFF     NOT REM     EJECT     STOP     STOP−RDY     PLAY     VAR PLAY     FAST F     REWIND     SHUTTLE +     SHUTTLE −

Note: Delegation Groups are not supported by Jupiter XPress.

CURSOR MODE − SELECTING A MACHINE FOR CONTROL

To enter cursor mode, press SELECT on the CM 4000 (or CURSOR MODE on the CP 3020). This will cause
the name of the first machine to appear in reverse video. When in cursor mode, the UP and DOWN buttons (or
arrow buttons) will move the cursor from one machine to another. A machine pointed to by the cursor is automati-
cally selected as the machine to be controlled by the adjacent MC 3000 Machine Control Panel (i.e., the MC 3000
connected to the CM 4000 providing the VGA display).
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Note that the MC 3000 can send control commands to any selected machine, even when the machine has not been
delegated (“assigned”) to any delegation group.

Important:  As a supervisory system, the VGA / MC 3000 can send control commands to any machine, even
to a machine linked to and being controlled by another panel. In this condition both panels will be able to
send commands. However, the VGA can take exclusive control by using CHANGE MODE as described
below.

Note: Since the VGA / MC 3000 cannot normally link itself to a machine, time code will not be shown in  the
MC 3000 window. Linkage and display of time code under these circumstances is discussed in a note on page
5−148.

Change Mode − Changing Delegation of a Machine

This function is available with the CP 3020 panel only.

While in Cursor Mode, the CHANGE MODE button can be used to “un−delegate” a machine. To do this, the
cursor is moved to the row showing the desired machine, then, using the RIGHT and LEFT keys, to a delega-
tion group column showing  the word “Assigned” or the showing the name of the panel now linked to the
machine. When CHANGE MODE is pressed, the delegation/link will be cut and the VG 3000/MC 3000 will
have exclusive control. If CHANGE MODE is pressed again, the machine will again be delegated to the
group shown at the top of the column; however, another associative switcher Take will have to occur to re−
establish the link.
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Section 7 − Software Control Panel Suite

The Software Control Panel Suite (“Graphical User Interface”) consists of seven routing switcher and machine control
applications plus a configuration application. Only one of the applications can be activated at a time.

Note 1: Activation of the Software Control Panel Suite requires a license floppy disk provided by Grass Valley. For
more information, please refer to the Field Engineering Bulletin supplied with the Jupiter software.

Note 2: Some of the panels may not be available, depending on which packages have been purchased. For more
information, see page 1−26.

The software operates on a PC using the Jupiter Network Suite (JNS) software, which provides the interface to the Jupiter
Control system through the Jupiter LAN. The Software Control Panels are designed for mouse or touchscreen opera-
tion.§ The panels can be run on the Jupiter file server, on one or more separate PCs on the Jupiter LAN, or on both.

The control panels obtain configuration set information from the Jupiter control system file server, allowing the user to
maintain a central configuration control point even with multiple control panel PCs operating on the LAN. The software
provides a means for licensing and operation of multiple copies of the control panel software on a single Jupiter system.

Software Installation

Software installation is described in the Field Engineering Bulletin supplied with the software.

Jupiter Table Entries

If the software panels are to be used for switcher control only, no Jupiter table entries are required. However, the panels
will require the use of existing CP Level, Input, and Output sets.

Note 3: These sets are not assigned to the suite using the MPK Devices table directly. Instead, they are as-
signed using the special “Panel Configuration” procedure found later in this section (page 7−7).

If the panels are to be used for machine control, a Configuration Set must be selected for editing and entries describing
the PC and the machine control panels must be made to the following tables:

� Network Description table

� Serial Protocol table

� MPK Devices table

§ For touchscreen operation, the PC and monitor must be supplied by Grass Valley.
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� Machine Control Devices table

These entries are described on the following pages. Guidelines for using the table editor are found on page 5−3.

For information about management of Configuration Sets, including compiling and activating sets, see page 5−8.

NETWORK DESCRIPTION TABLE

Network Description

RednBoard Name

PC1 PC

Address

1

Type

192.168.253.2

Figure 7−1.

Board Name Create a name for the PC that will display the Software Control Panels.

For Jupiter naming rules, see page 5−7.

Type Select board type “PC.”

Address Enter the IP address of the PC (e.g., “192.168.253.2”).

To find out the IP address, go to Start > Programs > Jupiter Network Suite > JNS Configuration.

In some cases, there may be two network cards installed—one for Jupiter and another for a facility LAN.
If you are not sure which address is correct for the Jupiter card, try looking at Network Neighborhood >
Properties (right click for Properties), then Protocols > TCP/IP Protocol > Properties > Adapter;  usually
the Jupiter card will be a 3Com. Click on 3Com to see the IP address of the card.
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SERIAL PROTOCOL TABLE

Serial Protocols

Proto 1/2Name

PC1 MPK1

3/4

UND

5/6

UND

7/8

UND

9/10

UND

11/12

UND

13/14

UND

15/16

UND

Baud 1/2

38.4

3/4

UND

5/6

UND

Figure 7−2.

Name Enter the name of t7he PC displaying the Software Control Panels. This must be the same as
that entered on the Network Description table (Figure 7−1).

Proto 1/2 Select “MPK” for ports 1/2. Leave the other ports undefined.

Baud 1/2 Select “38.4” for ports 1/2. Leave the other ports undefined.
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MPK DEVICES TABLE

MPK Devices

1

Dev Name Dev Type Exp PW Board Port Address Inp Set Out Set Lev Set Over Set Seq Set

2

PC1MC2 PC1 1 23232323MC−30003

PC1MC3 PC1 1 45454545MC−30004

PC1MC4 PC1 1 67676767MC−30005

PC1MC5 PC1 1 89898989MC−30006

PC1MC6 PC1 1 90909090MC−3000

N

N

N

N

N

3800 VM1 6 00C19E22CP−3800

PC1MC1 PC1 1 01010101MC−3000

N

N

3800INP 3800OUT 3800LEV

7

Figure 7−3.

Dev Name There must be an entry for at least one CP 3xxx control panel that is capable of machine con-
trol and that has Input, Output, and Level Sets assigned. (This is true even if no physical panel actually
exists.) A CP 3800 panel is shown in this example.

You must also create a name for each of the six Slaved Machine Control panels.

Dev Type For the slaved machine control panels, select “MC−3000.”

Exp For the software machine control panels the entry is always “N.”

Board For the slaved machine control panels, enter the name of the PC that will display the software
panels; this must agree with the PC’s Board Name entered on the Network Description table (page
7−2).

Port For the slaved machine control panels, there must be an entry in each of these fields to satisfy
the compiler.

Address For the slaved machine control panels, there must be a unique entry in each of these fields to
satisfy the compiler.

Inp Set Out Set Lev Set     These fields are the source for the set names that appear on the Panel Config-
uration screen (page 7−7). For the six Slaved Machine Control panel entries, these fields must be blank.
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MACHINE CONTROL TABLE

Machine Control

1

Dev Name

PC1MC1

Dev Type

MC−3000

Board

PC1

Port

1

Address

01010101

Group I/O Asoc Name Preroll

MC−3000 Out

2 PC1MC2 MC−3000 PC1 1 23232323MC−3000 Out

3 PC1MC3 MC−3000 PC1 1 45454545MC−3000 Out

4 PC1MC4 MC−3000 PC1 1 67676767MC−3000 Out

5 PC1MC5 MC−3000 PC1 1 89898989MC−3000 Out

6 PC1MC6 MC−3000 PC1 1 90909090MC−3000 Out

Figure 7−4.

Dev Name Enter the Device Name for each of the six Slaved Machine Control panels. These must agree
with the names entered on the MPK devices table.

Dev Type Select “MC−3000.”

Board Enter the Name of the PC that will display these panels. This must agree with the PC’s Board
Name entered on the Network Description table (page 7−1).

Port Address To satisfy the compiler, there must be a unique entry in these fields and this entry must
agree with the corresponding entry on the MPK table. In this example, “PC1MC1” has the Address
“01010101” on both tables.

I/O Select “Out.”

For information about management of Configuration Sets, including compiling and activating sets, see page 5−8.
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Main Screen

At the end of the installation process, the Software Panels program can be launched using the JNS Console, in the “JNS
Applications” program group. (For more information about the JNS Console, see Section 4.)

Note: If the application can’t find an active set, it will not start. Be sure you have selected a configuration set
(as described on page 5−10), and then compiled and activated the set (page 5−13).

Figure 7−5.

The Main Screen provides the ability to access each of the installed GUI applications. The GUI buttons on the screen
indicate that the application is configured and ready for use by changing the label text from shaded to black.
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Panel Configuration

When the “Configure” button is selected, a password screen will appear. When the system is first configured, the screen
will have a “New Password” box and a “Confirm Password” box.

— If a password is desired, enter up to eight alphanumeric characters (case sensitive) and re−enter to con-
firm. Then select “Apply.” The screen shown in Figure 7−6 will appear.

— If no password is desired, just select “Apply.” The screen shown in Figure 7−6 will appear.

Figure 7−6. Panel Configuration screen.

The Panel Configuration screen displays the CP
Input, Output and Level sets found on the active
MPK table. The selected sets will be used for all
software panels in the system.

After highlighting the desired sets, select
“Back” to activate the sets and return to the
Main Screen.

Although the Software Control Panels can use
sets originally created§ for any CP 3xx or CP
3xxx control panel, the ideal sets would be those
created for use with an existing CP 3800 panel.
Since such sets can include 20 categories and
eight−character mnemonics, they would allow
you to take full advantage of the Software Con-
trol Panel’s capabilities.†

Note: the CP Output set selected here must have a least one output assigned to one of the first 16 categories
in the set, otherwise no output can be selected for control. For example, if a type 3800 output set is selected,
it must have at least one output assigned to a category in the outlined group shown in Figure 7−7:

VTR CG NET SAT A
VCR CAM REM EMER B
FILM PTCH STU FS C
AUX TEST MISC SS D

Figure 7−7.

§ In this application, use of sets that were created for one panel type and later copied for use with another type should be
avoided.

† If no such sets exist, you may want to create eight−character Input/Output/Level sets of type CP 3800 and assign them to an
imaginary device of type CP−3800. For information about creating these sets, see CP Level sets (page 5−58), CP Input sets
(page 5−62) and CP Output sets (page 5−78). Keep in mind that an imaginary device entered on the MPK table must have
corresponding entries on the Serial Devices table!
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Operation

Following configuration, any one of the following panels can be selected:

• Slaved Machine Control − provides the ability to send the same command to up to six machines at once.

• Full Function − the Full Function screen provides the user with full−matrix switcher control features in-
cluding breakaway, presets, and setup memory.

• Full Function Machine Control − provides the user with full function control, including time code mark
and search, of one machine at a time.

• Dubs − provides the ability to switch the same source to multiple destinations with a single Take.

• Source / Destination − the Source/Destination panel provides full−matrix routing switcher control using
Category and Entry buttons.

• Salvo − the Salvo screen provides the ability to switch multiple source/destination combinations with a
single Take.

• X−Y Panel − similar to Source / Destination panel but with one set of category and entry buttons for the
source and another set for the destination.

Each of these panels is described in the following pages.

If you have a large system, it can take quite a while for the system to apply configuration data to a panel when you first
start it. If you are running remotely, the delay will be somewhat longer because the panel must load configuration
information from the file server. This delay can be made worse if you have a lot of applications running on the file server.
The Jupiter Configuration Editor in particular requires a large amount of processor time. If you are running GUI panels
either on the file server, or remotely, you should close the Jupiter Configuration Editor. In addition, you should close
down any unnecessary applications on the file server.

After a panel is started, select the Back button to return to the Main screen.

To switch between windows, press ALT+TAB. To return to the software panel, click anywhere within the panel display.

On some computers, you can display the Windows task bar on the bottom of the screen by pressing the Windows logo
key and TAB. (You can’t minimize the Software Control Panel screen.)

Paths Full / Protected / Locked / Excluded Messages

These messages will be shown for approximately four seconds if a switch fails for one of these reasons. This applies to the
Full Panel, X−Y Panel, Source Destination Panel and the Dubs Panel. “Paths Full” means that no Tie Lines are available;
“Protected” means the output is protected by another panel; “Locked” means the output is locked by another panel; “Ex-
cluded” means the switch is prohibited by an entry in the Exclusion table. All GUI Panels that are on the same output as
the GUI Panel that requested the switch will display these messages. For additional Protect/lock information see page
6−12.
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SLAVED MACHINE CONTROL PANEL

Figure 7−8.

The Slaved Machine Control panel provides the ability to control up to six machines from a single screen. The panel
includes a Gang button for slaving machines together.

Machine Assignment

To link to a machine, select the “Machine” window; a drop down list will show the machines entered on the Machine
Control table of the active configuration set (see page 5−135).

Note: The GUI machine control panels are linked (assigned) directly to individual machines using the Ma-
chine drop−down window. It is not necessary to use the “Associated Name” linkage method used for hardware
control panels such as the MC 3000 (that method, sometimes referred to as “control−follow−router,” is de-
scribed on page 5−141).

Select the desired machine. If linkage is established, the appropriate motion control button will turn yellow; if time code
is present it will be displayed as well.

If an attempt is made to take control of a machine that has a “default” (semi−permanent) link to a specific control panel,
the link will not occur; instead, a message will indicate the name of the controlling device. For more information about
default links, see page 5−146.
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Machine Control Buttons

Gang Allows a machine control command to be sent to more than one machine.

Stop Stops machine regardless of mode

Play Playback mode. May or may not override current mode, depending on machine.

Record Immediately begins recording

REW or FF Full speed shuttle (rewind or fast forward)

Ready Toggles the machine in and out of scanner ready mode

Time code display

The time code display window will display hours, minutes, seconds and frames. In some modes the frames are not dis-
played.
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FULL FUNCTION SWITCHER PANEL 

Multi−level Status
Multi−level Preset

Level 1 Preset
Level 1 Status

Figure 7−9.

This panel provides full matrix control with breakaway switching capability. Memories allow the user to Save/Recall
up to four sets of 12 Direct Take inputs per output.

To Status a Destination

1. Select the Destination button.

The Categories section will be rewritten to display the categories available to the operator, up to a maximum of 16.
The Function buttons will change from white to gray to indicate they are inactive.

2. Select the desired Category button.

The Entries section will be rewritten to display up to 15 destination buttons. Additional Destination buttons, if avail-
able are accessed by using the scroll buttons.

3. Select the desired Entry button.

The destination entry will be entered into the Destination display and the level 1 status will be shown in the Status
window. In addition, the status for each level will be shown in the “Levels” window with yellow lettering; the name
of each level will be shown on the buttons. If more than four levels exist a scroll button will appear.
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To Switch a Source

1. Select the Source button.

The Categories section will be rewritten to display all source categories available to the operator. The Function but-
tons will change from gray to white to indicate they are active.

2. Select the desired Source Category button.

The Source Entries section will be rewritten to display up to 15 source buttons. Additional Source buttons, if avail-
able, are accessed by using the scroll buttons.

3. Select the desired Source Entries button. The source entry (level 1) will be entered into the Preset display. In addi-
tion, the preset source for each level will appear in the “Levels” window with green lettering.

4. Select Take to execute the switch.

The Status display will change to the new source indicating the switch was made. The Preset display will change
to the previously selected source. Flip−flop switching between the old and new source is accomplished by pressing
the Take button again.

Paths Full / Protected / Locked / Excluded messages − see page 7−8.

Breakaway Switching (“Select” Method)

When only one level is to be switched, the following method is suggested:

— If the destination needs to be changed, select it at this time.

— The “Source” button lettering should be yellow (active). If not, select it.

— The Preset windows should be blank. If not, click the Clear All button. Then:

1. Select the desired Level button. A dark line will appear around the button.

2. Choose the desired source Category and Entry.

The name of the source will appear above the Level button just selected.

3. Click the Take button.

The name of the source will move to the multi−level status window.

Flip−flop switching between the old and new source is accomplished by pressing the Take button again.
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Breakaway Switching (“Deselect” Method)

When more than one level is to be switched, the following method is suggested:

— If the destination needs to be changed, select it at this time.

— The “Source” button lettering should be yellow (active). If not, select it.

1. Choose the first source Category and Entry.

The name of the source will appear above all the Level buttons.

2. Deselect the Level button(s) for the level(s) not receiving this source.

This will erase the name of the source above the Level buttons just deselected.

3. Choose the the next source Category and Entry.

4. Deselect the Level button(s) for the level(s) not receiving this source.

5. Repeat until all sources are selected.

6. Click the Take button.

The names of the new sources will move to the multi−level status window.

Flip−flop switching between the old and new sources is accomplished by pressing the Take button again.
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Audio Modes (Venus Special Stereo Switching) 

The Full Function Switcher Panel has the capability of controlling Venus Audio Modes, which are Normal, Mix, and
Reverse. These changes are made to individual levels prior to completing a switch by pressing the TAKE button.

Note: Audio switching mode can only be used if an appropriately configured Venus switcher is connected.

To perform a special stereo switch:

1. Select a source. The source mnemonic will appear in the Preset window.

2. Select the Audio Modes key. The button will turn red and the Levels subwindow will show the current audio mode
status.

Figure 7−10.

In Figure 7−10, the left audio channel is set to “Mix.”

3. Toggle the left channel to the desired mode by pressing the LEFT level key:

� NORMAL−use left audio for this channel

LEFT LEFT (Left signal on Left channel)

� MIX− Mix left and right on this channel
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LEFT

RIGHT

LEFT (Left + Right signals on Left channel)

� REVERSE− Cross opposite channel signal over to this channel

RIGHT

LEFT (Right signal on Left channel)

4. Toggle the right channel to the desired mode:

� NORMAL−use right audio for this channel

RIGHT RIGHT (Right signal on Right channel)

� MIX− Mix left and right on this channel

LEFT

RIGHT RIGHT (Left + Right signals on Right channel)

� REVERSE− Cross opposite channel signal over to this channel

LEFT

RIGHT  (Left signal on Right channel)

5. Press TAKE.

A letter “M” (mix) or “R” (reverse) will appear in the Levels Status display.

To clear the special mode, perform another switch (with the Audio Modes button off).
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Presets

Direct Take Preset Assignments

The Presets Function allows the user to save frequently−used sources in a 12−button Direct Take Presets window. Four
of these Direct Take setups may be saved.

1. If the Functions buttons are grayed out, select the Source button.

All buttons in the Functions section are toggle function, i.e. select to turn On and select again to turn Off.

2. Select the Presets button.

The Presets button label color will change from white to red and the Direct−Take Presets window will appear.

Figure 7−11.

3. Select the Load button.

The button label color will change from black to yellow indicating that sources may be assigned to the Direct Take
buttons. If the Unload function was active it will be deactivated, indicated by the label color changing from yellow
to black.

4. Select the desired Source Category button.

The Source Entries section will be rewritten to display the source buttons.



Software Control Panel Suite

7−17CM 4000 Installation and Operating Manual

5. Select the desired Source Entry button.

The source entry will be entered into the Preset display.

6. Select the desired Direct Take button.

The Source name will be written to the button.

7. Repeat the above steps as required.

A Direct Take button may be reassigned to a new source using the normal assignment procedure.

8. To make a Direct Take assignment permanent, follow the “Memory” procedure below.

Direct Take assignments that are not saved in Memory will be erased when you exit the Software Control Panel
application.

Breakaway Preset Assignments

To assign Breakaway Selections to Direct Take buttons, follow the “Breakaway Switching” procedure on page 7−12 ex-
cept for selecting Take at the end. Instead, select the Presets and Load buttons and then the desired Direct Take button
to assign the breakaway selection. The Direct Take button source label will be displayed as red characters indicating that
a breakaway switch is assigned to this button.

The breakaway setup may be checked on any Direct Take button by activating the Presets window, then the Levels win-
dow, and selecting the Check Preset button. The Check Preset button label color will change from black to yellow indicat-
ing the function is active. Select the Direct Take button of the source to be checked. The source names will be shown
on the Level buttons. The Check Preset button will change from yellow to black indicating the function is no longer ac-
tive.

Removing a Preset Assignment

To remove a source from a Direct Take button, select Unload in the Functions section. The button label color will change
from black to yellow indicating the function is active. If the Load function was active, it will be deactivated, indicated
by the label color changing from yellow to black.

Select the desired Direct Take button. The source name on this button will be cleared. The Unload button label color will
change from yellow to black indicating the function is no longer active.

Switching Using the Direct−Take Presets

Select the Presets button in the functions section. The button label color will change from white to yellow and the Direct
Takes section will be displayed. Select the desired Direct Take button. The switch will be immediate.

The Status display will change to the new source indicating the switch was made. The Preset display will change to the
previously selected source.
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Switching using the Categories/Source Entries section remains active.

Memory

The memory window allows the user to save or recall up to four sets of 12 Direct Take setups.

Saving a Direct Take Setup

Note: Saved presets for a given configuration set may not be valid with other configuration sets. For example, if
a preset calls for input ”VTR1” and “VTR1” does not appear in a set downloaded at a later time the preset will fail.

1. Follow the Direct Take Preset Assignments procedure above to set up the Direct−Take selections to be saved.

2. With the Direct−Take window open, select the Memory button.

The Memory button label color will change from white to red and the Memory window will appear.

Figure 7−12.

3. Select the desired Memory location (1, 2, 3, or 4).

The label will change from black to yellow.

4. Select Store.

The setup will be saved in the selected location. Also, a “Recall” and a “Clear” button will now appear.
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Recalling a Direct Take Setup

1. Select the destination by following the Status a Destination procedure above (page 7−11).

2. Select the Source button.

The Categories section will be rewritten to display all source categories available to the operator. The Function but-
tons label color will change from gray to white to indicate they are active.

3. Select Memory.

The Memory button label color will change from white to red and the Memory window will appear.

4. Select the desired Memory location (1, 2, 3, or 4) to recall the Direct Take setup.

The Memory button selected will change from black to yellow.

5. Select Recall.

The Memory button label will change from red to white and the Memory store window will be replaced with the
Direct Take display window which will contain the recalled Direct Take setup entries.

Memory Location Labeling

Note: This feature requires that the GUI PC includes a keyboard.

Select the Memory button, then select the label adjacent to the desired Memory 1, 2, 3, or 4 button. Use the computer
keyboard to enter an 8 character (minimum) user specified name. Select Store. Select Memory to close the display win-
dow.
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FULL FUNCTION MACHINE CONTROL 

Figure 7−13.

The Full Function Machine Control screen provides the user with control of one machine at a time. The screen includes
an eight−character display for selecting and displaying current machine linkage, twelve machine control buttons, a nu-
meric keypad for entering time code values, a time code readout, and a motion control knob with direction and speed
indicators.

Machine Assignment

To link to a machine, select the “Machine” window; a drop down list will show the machines entered on the Machine
Control table of the active configuration set (see page 5−135).

Note: The GUI machine control panels are linked (assigned) directly to individual machines using the Ma-
chine drop−down window. It is not necessary to use the “Associated Name” linkage method used for hardware
control panels such as the MC 3000 (that method, sometimes referred to as “control−follow−router,” is de-
scribed on page 5−141).

Select the desired machine. If linkage is established, the appropriate motion control button will turn yellow; if time code
is present it will be displayed as well.

If an attempt is made to take control of a machine that has a “default” (semi−permanent) link to a specific control panel,
the link will not occur; instead, a message will indicate the name of the controlling device. For more information about
default links, see page 5−146.
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Machine Control Buttons

Ready Toggles the machine in and out of scanner ready mode.

Stop Stops machine regardless of mode.

Play Playback mode. May or may not override current mode, depending on machine. Shuttle
knob remains centered.

Record Immediately begins recording.

Search Go to the time code point captured with Mark, minus the Preroll value set on the Ma-
chine Control Devices table.

REW or FF Full speed shuttle (rewind or fast forward). Control knob remains centered.

Go To Go to the time code entered using the keypad.

Mark Captures current time code if the system uses serial time code interface and time code is
being fed from machine.

Rec In Immediately begins recording.

Rec Out Exit Record mode (same as ESbus Exit command). Normally used to terminate an In-
sert edit, in which case the machine drops out of record mode but keeps on playing.

Mode (When enabled) Select a recording mode:

Off = record Inhibit.

Manual = pressing REC IN followed by PLAY will begin a recording, during
which no editing functions will be enabled.

Assemble = pressing PLAY and REC IN will begin an Assemble edit.

Insert = pressing PLAY and REC IN will begin an Insert edit.

Control Knob and Direction/speed Indicators

The control knob and and the direction/speed indicators are used for the Variable play, Rewind, and Fast Forward and
functions. The shuttle function is controlled by rotating the control knob. Stop by pressing the top center mark or the Stop
button.

Time Code Display

The time code display window will display hours, minutes, seconds and frames. In some modes, the frames are not dis-
played.

Manual Time Code Entry

The keypad is used to enter an eight−digit time code; the Go To button can then be used to move to that time.
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DUBS PANEL 

Figure 7−14.

The Dubs screen provides the ability to switch the same source to multiple destinations with a single Take.

To Status a Destination

1. Select the desired Destination button. The status of the current output will be shown in the Status window.

Additional Destination buttons, if available, are accessed by using the scroll buttons. The label of the selected but-
ton will change from black to yellow and the entry name will be written in the Destination display. The panel Status
display will always indicate the source status for the last activated destination button.
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Switching Multiple Destinations to the Same Input (Dub Switching)

1. Select the appropriate Destination buttons.

Additional Destination Entries buttons, if available, are accessed by using the scroll buttons. The label of the se-
lected buttons will change from black to yellow and the entry name of the last destination selected will be written
in the Destination display. The Status display will be rewritten to provide current source status.

To cancel a single output selection, select that button again.

To cancel all Destination Entries select Clear.

2. Select the desired Source Category button.

The Source Entries section will be rewritten to display up to 12 source buttons.

3. Select the desired Source Entry button.

The source entry will be entered into the Source Preset display.

4. Select Take to execute the switch.

The Status display will change to the new source indicating the switch was made. The Preset display will change
to the previously selected source. Flip−flop switching between the old and new source will be accomplished by
selecting the Take button again.

Paths Full / Protected / Locked / Excluded Messages − see page 7−8.

Using the Hold Button

When Hold is pressed, the button label will change from white to red indicating that the selections made in the Destination
Entries section cannot be inadvertently changed.

Select the Hold button again to toggle the function off. The Hold button label will change from red to white indicating
the Hold function has been disabled and the selections in the Destinations Entries section can be modified.
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SOURCE/DESTINATION PANEL

Figure 7−15.

The Source/Destination panel provides full−matrix routing switcher control using Category and Entry buttons.

To Status a Destination

1. Select the Destination button.

The Categories section will be rewritten to display all categories available to the operator.

2. Select the desired Category button.

The Entries section will be rewritten to display up to 24 destination buttons.  Additional Destination buttons, if
available, are accessed by using the scroll buttons.

3. Select the desired “Entries” button.

The destination entry will be entered into the Destination display and the Source display will be rewritten to provide
current status.

To Switch a Source

1. Select the desired Destination.
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For more information, see “To Status a Destination” above.

2. Select the Source button.

The Categories section will be rewritten to display all categories available to the operator.

3. Select the desired Source Category button.

The Source Entries section will be rewritten to display up to 24 source buttons.  Additional Source buttons, if avail-
able, are accessed by using the scroll buttons.

4. Select the desired “Source Entries” button.

The source entry will be entered into the Preset display.

5. Select Take to execute the switch.

The Status display will change to the new source indicating the switch was made.  The Preset display will change
to the previously selected source. Flip−flop switching between the old and new source is accomplished by pressing
the Take button again.

Paths Full / Protected / Locked / Excluded Messages − see page 7−8.
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SALVO PANEL

Figure 7−16.

The Salvo screen provides the ability to switch multiple source/destination combinations with a single Take.

Multiple Source/Destination Switching (Salvo)

1. The Salvo Setup function should be On (indicated by a red button label) and the Mem function should be Off (indi-
cated by a black button label).

2. Select the first desired Source Entry button.

Additional Source Entries buttons, if available, are accessed by using the scroll buttons. The label of the selected
button will change from black to yellow. Selection of a different source will deselect the previous source selection.

3. Select the desired “Destination Entries” buttons.

Each source/destination entry will be entered automatically in the Salvo list window in the lower center of the dis-
play.

Additional Destination Entries buttons, if available, are accessed by using the scroll buttons. The label of the se-
lected button will change from black to yellow. Additional destinations can be switched to the currently selected
source by selecting the desired Destination Entries buttons. The button label will change from black to yellow for
each selected destination. To remove a destination from the switch setup select that button again. This will deselect
that output and change the button label from yellow to black.
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4. Select the next desired Source Entry button, then Destination Entry buttons, etc.

5. Select Take to execute the switch.

Memory

The memory window allows the user to save or recall up to four sets of Salvo setups.

Note: Saved salvos for a given configuration set may not be valid with other configuration sets. For example, if
a preset calls for input ”VTR1” and “VTR1” does not appear in a set downloaded at a later time the preset will fail.

Saving a Salvo Setup

1. Follow the Multiple Source/Destination Switching (Salvo) procedure above to set up the salvo selections to be
saved.

2. Select the Memory button.

The Memory button label color will change from black to yellow and the Memory window will appear.

Figure 7−17.

3. Select an unassigned Memory location (1, 2, 3, or 4).

The label will change from black to yellow.
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4. Select Store.

The setup will be saved in the selected location.

Checking a Salvo Setup

1. Select Memory.

2. Select the desired Memory location (1, 2, 3, or 4).

3. Select Recall. 

Recalling and taking a Salvo Setup

1. Select Memory.

2. Select the desired Memory location (1, 2, 3, or 4).

3. Select Recall.

4. Select Take to execute the switch. 

Memory Location labeling

Note: This feature requires that the GUI PC includes a keyboard.

Select the Memory button, then select the label adjacent to the desired Memory 1, 2, 3, or 4 button. Use the keyboard
to enter an 8 character (minimum) user specified name. Select Memory to close the display window.
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X − Y PANEL 

Figure 7−18.

The X−Y Panel is similar to the Source/Destination panel but has one set of category and entry buttons for the source
and another set for the destination.

To Status a Destination

1. Select the desired Destination Category button.

The Destination Entries section will be rewritten to display up to 12 destination buttons. Additional Destination
buttons, if available, are accessed by using the scroll buttons. Status for the first level will be shown on the button.

If the button is selected, the destination will also appear in the Destination display and the Current Source display
will indicate current status.

To Switch a Source

1. Select the desired Destination Category and Entry.

2. Select the Source Category and Entry.

The selection will appear in the Source Preset display.
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3. Select Take to execute the switch.

The Current Source display will change to the new source indicating the switch was made. The Preset display will
change to the previously selected source. Flip−flop switching between the old and new source will be accomplished
by pressing the Take button again.

Paths Full / Protected / Locked / Excluded Messages − see page 7−8.
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Section 8 − Board Status

This application displays board status and information. It can be used to help make certain that all system controllers are using
compatible software and user−created configuration sets, and that enough free memory is available for the system to operate
properly.

Since most of this information also appears in the Control Center, this application will eventually be phased out.

Figure 8−1.

OPERATION

The first column lists board names in the order that they appear in the Network Description table.

The second column shows the name of the board’s operating system code file. This file is found in the jupiter\bin directory
and is downloaded to the board if the file changes or you clear the flash on the board.

The third column shows the Ethernet hardware address for the board.

The fourth column shows ticks, which is an approximate indication of the board’s up−time. There are approximately 60 ticks/
second in NTSC and approximately 50 ticks/second in PAL.

The fifth column shows board status. The field is green if the board is active and red if the board is inactive.

The fifth and sixth columns show the CRC for the board’s application and configuration files. If these match what the file
server has for the active set, the fields will be green. Otherwise, the fields are red—indicating the need for a fresh download
to all boards.

The “...MemAvail” fields show how much memory each board has for application, heap, configuration, and PMEM.
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The Version field shows what version of application code each board is running. This should indicate the same version for
all boards in the system. If not, a fresh download to all boards should be performed.

The example above (Figure 8−1) shows a set that has 5 PCs in the Network Description table. Board Status cannot show in-
formation for PCs.

Refresh

The Board Status application does not poll for board information. Click on the Refresh button to refresh the display.

Menus

File
Exit - close the application.

Options
Alarm Enabled - this enables or disables an audible alarm. If a board is inactive, or if its code or configuration
CRCs do not match the file server’s active set, the application will beep if the alarm is enabled.

Help
About - this displays the application’s about box with version information.
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Section 9 − Control Center

The JNS Control Center, which replaces the JNIA Control Center, has four tabs:

• The Board Status tab (page 9−1) shows a list of boards with status and up time.

• The TFTP* Status tab (page 9−2) shows the state of TFTP transfers to boards.

• The Board Info/Control tab (page 9−3) allows you to see board information and send commands to boards.

• The Configuration tab (page 9−6) allows you to select configurations and activate them.

BOARD STATUS

Figure 9−1.

The Board Status tab shows board status and up−time.

The first column lists the board names in the order that they appear in the Network Description table (note that PC boards
do not appear here).

The second column shows the board status. The fields will be green if the board is active. If boards are inactive, “Inactive”
will appear in the field and the field will be red. If a board is currently downloading, “LOADING...” will appear in the field,
and the field will be cyan.

The third column shows how long the boards have been up in days, hours, minutes and seconds.  For the up−time display to
be accurate you must have selected the correct Scan Rate option in the options menu (see below).

* See Glossary.
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TFTP STATUS

Figure 9−2.

This table shows TFTP status while the boards are in the process of downloading.

The first column shows the boards in the order that they appear in the Network Description table (again, PCs do not appear).

The second column shows the name of the file that the board is downloading. In the example above, you can see some boards
downloading their configuration files (.cfg), one board downloading code (.sys), and two boards have just finished download-
ing loader code (.ldr).

The third column shows the status of the transfer. On a busy system, you may occasionally see packet timeout counts.  This
indicates that the file server has missed responses from a board. This does not necessarily indicate a serious problem. Packet
timeouts frequently occur on very busy systems. When a transfer succeeds, the “Transfer succeeded. <n> packets timed out.”
message will be displayed and the field will be green. If the transfer fails, the field will turn red, and a description of the prob-
lem will appear in the field. This may be a temporary condition. The boards will usually attempt to start new transfers in this
case, and the field will turn green again as the new transfer starts. A very large number of timeouts or frequent transfer failures
could indicate problems with your network or configuration.

The fourth column shows what percentage of the file has been sent.
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BOARD INFO/CONTROL

Figure 9−3.

This application can be used to help make certain that all system controllers are using compatible software and user−created
configuration sets. It also allows you to send commands to the boards.

The first column of the table shows board names in the order that they appear in the Network Description table (PCs do not
appear).

The second column displays the current IP address of the board.

The third column indicates whether the board’s configuration set matches the active set on the file server. If the sets match,
“OK” appears in the field and the field is green. If they don’t match, the field is red and “MISMATCH” appears. This status
will usually appear if you activate a new set without rebooting. If the board is downloading or inactive, the field is cyan and
“?” appears.

Note: For information about “Pending Reboot” messages, see page 5−15.

The fourth column shows whether the board’s operating system code matches the code on the file server. Indicators are the
same as for the Configuration column.

Selecting Boards

You must select boards before you can send commands to them. To select individual boards, click anywhere in that board’s
row in the table. The selected board will appear in a darker gray in the Board column and the board’s IP address field will
turn blue. To de−select a board, click in the row again.
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To select all the boards, click on the Select All button. To de−select all boards click on the Unselect All button.

Reboot

This button sends a reboot command to the selected boards only. This differs from the Reboot button on the Configuration
tab, which sends reboots to all boards.

Note: Having different versions of software or configuration tables between boards can cause system instability.

Clear PMEM

This button clears PMEM on the selected boards.

Clear Flash

This clears flash memory on the selected boards and reboots them. The boards will immediately begin downloading all config-
uration and code.

Post Mortem

This starts the post−mortem debugger on the selected boards.

Start Board Override

Start Board Override is a troubleshooting tool intended for programmer use. When the Start Board Override button is selected,
and a board selected and booted, the basic operating system will launch but the Jupiter processes will not start. Boards in this
state will display a Probe message similar to “pmemOverrideStartBoard is set, not starting this board.” Using Probe, one can
enter “startBoardOverrideShow” from the shell to determine if the board will or will not start up on the next reboot. Once
troubleshooting is completed, one can either reboot the board (which will automatically “start” all processes), or use the Probe
command “startBoard” to resume normal board operation.

Probe connections are described in Appendix C.

Telnet

This opens telnet windows for the selected boards. For this command to work, you must have a “telnet.exe” application some-
where in your search path. The default TCP/IP Windows installation will do this for you. Note that if you have selected several
boards, the telnet windows may appear on top of each other. Simply move them to see the ones underneath.

Update Board Info

This requests updated board information from the boards. The control center does not poll for board information. It does at-
tempt to update board information when boards become active, but the display may occasionally show incorrect information.
If you suspect this, click on the Update Board Info button.
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MENU COMMANDS

Several commands are accessible through the control center’s menu:

File

Exit

This closes the application.

Options

Scan Rate

 You must select the correct scan rate for your system for board up−time to be displayed correctly:

NTSC - Select this if you use NTSC.
PAL - Select this if you use PAL.

Time Sync

This item does not apply to CM 4000 units (it is used by the VM 3000, which is described in a separate manu-
al).

For a discussion of time sources and synchronization for AccuSwitch applications, see Appendix G.

Help

About - Displays the Control Center’s About box with version information.
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CONFIGURATION

Figure 9−4.

The Configuration tab allows you to see a list of compiled sets and select a set for activation. It also allows you to restore a
previously activated set and reboot the boards.

Simple Set Activation

On the left side of the window, you will see a box that shows a list of compiled sets. To activate a set, click on the set name
in the list, make sure the Select and Reboot radio button is selected, and click on the Activate button. A status dialog will
appear while the set activation is occurring:

Figure 9−5.

Once set selection completes, the following dialog will appear:

Figure 9−6.

At this point, a reboot command will be sent to all the boards in the set, and the boards will reboot and download the new
set.

Caution: Once the activate/reboot command has been issued, do not interrupt the process until the reboot is com-
plete. Interruptions such as sending a new command, turning off power, or disconnecting cables will have unpre-
dictable consequences. With a CM 4400, such consequences can include corruption of data stored in flash memory
and on the CM hard drive.
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Though the “Configuration” tab gives no indication of activity during file transfers, other tabs (described above) can be used
to determine when it is safe to initiate some other command. Depending on a several factors such as the number of boards,
configuration size, need to update the *.sys file, LAN transmission rate, LAN traffic, etc., a complete set change can take
several seconds or multiple minutes.

Note: special procedures are available for CM 4400 / Jupiter Xpress (only) systems to minimize system downtime
during set activation. See page 5−15.

Activation Without a Reboot

Selecting the “Select Set Only” radio button will prevent the Control Center from sending a reboot to the boards after a set
activation. Keep in mind that the active set will not match what is on the board. If any boards reboot after this time, they will
download the new set, but they will not match other boards that have not rebooted. This can cause system instability. For this
reason, you should not usually leave the file server in this state. Reboot all boards as soon as possible.

Reboot

Clicking on the “Reboot” button sends a reboot command to all the boards. If the boards do not have the currently active set,
they will download the new set.

Note: special procedures are available for CM 4400 / Jupiter Xpress (only) systems to minimize system downtime
during set activation. See page 5−15.

Backup Set

Whenever you activate a set, the name of the new set appears in the Current Set box and the name of the old set appears in
the Backup Set box.

To restore a backup set, click on the Restore Backup button. The backup set will be made the active set. The name of this set
will now appear in the Current Set box, and the Backup Set: box will be cleared. Note that the Control Center does not “swap”
sets. That is, the set that was active before you clicked on Restore Backup does not become the backup set.

The “On Activation” radio buttons have the same effect for restoring backups as they do for activating sets. That is, if the
“Select and Reboot” radio button is selected when you restore a set, the backup set will be made active, and a reboot command
will be sent to the boards. Otherwise, the set will be activated but no reboot command will be sent.
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Section 10 − CP Input/Output Set Editor

The Control Panel Input/Output Set Editor (sometimes referred to as the “Active Editor”) allows special CP I/O Sets to be
created and downloaded to the system controllers without using the Jupiter Configurator or the Control Center (see Figure
10−1). Since the download is limited to these special sets, the download process occurs much more rapidly than it would other-
wise. Modifications such as assigning a new category/number to an input, or changing a mnemonic, can thus be made without
affecting on−air operation or taking the control system down. It is also possible to edit Category names.

Source
set

selected
for editing

Compiled set(s)

Source sets

“Activate”
(Download)

System controller
Compile

Select for
editing

Save

Copy of
Active Set

Select and
process

JUPITER CONFIGURATOR CONTROL CENTER APPLICATION

CP
INPUT/OUTPUT

SET EDITOR

Figure 10−1.

The user first selects an existing CP I/O Set from the active configuration set, then creates a copy for exclusive use by the
CP I/O Set Editor. The copy is then modified and activated (downloaded). The set (or sets) are sent to the controller board’s
PMEM, overriding the current input or output sets.

Note 1: Saturn control panels are not supported by the CP I/O Set Editor, nor are the following control panel input/
outset set types: cp3310, mc3020D, mc3020L, serial, and cpsatrn.

Note 2: The CP I/O Set Editor does not support remote PC operation.

Since the modified set information is kept in PMEM, it will be preserved in the event of a power loss. However, it will be
lost if PMEM is cleared.

Important: Sets modified with the CP I/O Set Editor will no longer match those in the original Jupiter Configura-
tion Set. This creates a situation where, for example, Selected Set “config01” seen by the Jupiter Configurator does
not match Current Set “config01” seen by the Control Center. A good practice is to reconcile these sets as soon
as possible by using the Jupiter Configuration Editor to modify the original CP I/O Sets. This will avoid the poten-
tial confusion of having two versions of the same set.



JNS CP I/O Set Editor

10−2 CM 4000 Installation and Operating Manual

The CP I/O Set Editor is launched using the JNS Console, in the “JNS Applications” program group. (For more information
about the JNS Console, see Section 4.)

Note: If the application can’t find an active set, it will not start. Be sure you have selected a configuration set (as
described on page 5−10), and then compiled and activated the set (page 5−13).

PASSWORDS

When the CP I/O Set Editor is started, the system presents a log in dialog:

Figure 10−2.

— If the CP I/O Set Editor has never been run before, you must create an administrator Name. If you want to
create a Password, enter the password (up to eight characters) and press OK. Or, if you don’t want a password
established, just select OK.

— If you are logged in as the administrator, and want to add a new user, go to “Options > Passwords.” You will see
a list of all users. Note that the first person in the list (the administrator) is always assigned a security level of
“4.” Only those with a security level of 4 can add new users. As administrator, you can also delete users and
re−assign passwords.

— If you need a password, or forget your password, contact the administrator. If you are the administrator and
have forgotten the administrator password, contact Grass Valley Technical Support for assistance. (Rebooting
or re−installing software will not restore the password system to its original state.) For more information about
passwords, see page 10−8.

After entering the appropriate password, the main window is displayed (Figure 10−3). On entry, no set selected, and the main
window is empty. The “Edit Set” child windows will not appear until sets are selected for editing, or new ones created.

Figure 10−3.

DROP−DOWN MENUS

File

Select Edit Set − Allows the user to open (edit), delete, copy, and create new CP I/O Set Editor sets (see page 10−3).
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Select Group − Allows CP I/O Set Editor sets to be grouped and activated (downloaded) (see page 10−5).

Activate Sets − Can be used to activate individual CP I/O Set Editor sets (see page 10−7).

Close/Save − These options are only available when an set is open. “Save” makes the modified set information available for
activation.

Print Log − Allows the user to specify a log file to print (see page 10−7).

Print Setup − Standard Windows dialog for printer selection, etc.

Log In − Following a Log Out, allows a user to log in and use the CP I/O Set Editor (see page 10−8).

Log Out − Logs the user out of the CP I/O Set Editor (see page 10−8).

Exit

View

This displays the Input and Output Set Usage table (see page 10−11).

Options

Passwords − This menu displays the password window and allows an operator to add or delete users (see page 10−8).

Compare Sets − Allows the user to compare two sets and print the results (see page 10−9).

Generate Log − Toggles the generation of log entries (on/off) when sets are activated. This can only be changed by users with
level 4 privilege.

Check for duplicates − This option is only available when an edit set is open. Selecting this menu option checks the currently
active set for duplicate entries.

Settings − Shows the current user and allows setting the activation timeout interval and the session privilege level.

SELECTING A SET FOR EDITING AND DOWNLOAD

“File > Select Edit Set” brings up a menu similar to the following:

Figure 10−4.
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This dialog lists the sets that have been created for use with the CP I/O Set Editor (when first opened, the list will be empty.)
From here, you can edit existing sets, delete and copy sets, and create new sets.

To create a new set, select New. The following dialog is displayed:

Figure 10−5.

This table shows the CP I/O Sets that are in use by the active (“Current”) Set. (The name of the Current Set is shown in the
Control Center menu; the names of the CP I/O sets are shown on the MPK Devices table). To create a new set for the CP I/O
Set Editor, select a set, enter a Name, and select Create. The program will create a copy of the selected input or output set,
and then display an edit window for that set.

EDITING SETS

To edit an existing CP I/O Set Editor set, select a row on the Select Set menu, and select Edit. An example of a CP input set
is shown in Figure 10−6.

Figure 10−6.
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The Edit Set window for output sets is similar, except that the Category/Entry numbers are grayed out (cannot be changed).
The Level Set and Button assignments are shown but cannot be changed.

On an Input set table, selecting the Category field displays a drop−down list of categories; Entry numbers are typed in. The
Mnemonic column contains simple edit fields. The Input/Output field is a combo box that lists all switcher inputs or outputs.
You can select an input or output or type one.

There are two additional fields per row that are not contained in the active set: Password Level and Comment. The Password
Level ranges from 1 through 4, 1 being the default. The Password Level prevents users with lower passwords from changing
entries that are protected with a higher password level. (Password Levels are assigned in the Options menu; for more informa-
tion see page 10−8.) The Password Level drop−down list contains the numbers 1 through the level of the current user.

On Input sets only, you can insert new rows using the Insert key or the Insert Row command from the Edit menu, or, delete
rows with the Delete key or the Delete command.

To save the set(s), select “File > Save.” (This does not download the sets.)

EDITING CATEGORY NAMES

To change the name of a category or add a new category, select a set for editing, then go to “Edit > Edit Categories.” After
making the change, select OK.

Note: After you have selected “OK,” be sure to save the set using “File > Save.” If you close the set without saving,
further editing will be confusing because two versions of the category name will exist in the system. To correct
this situation, you must return to “Edit > Edit Categories” and re−enter the old name of the category (as shown
in the window with the name of the set in the upper left corner), then click OK; then return to “Edit > Edit Catego-
ries” and make the desired change.

CREATING AND ACTIVATING A GROUP OF SETS (SELECT GROUP)

In most cases, you will want to create an input set and an output set and manage them as a unit. For example, during a particular
show or production project you may want to use special mnemonics for sources and destinations.

The Group function allows you to group input and output sets and name the group (after the name of the project, for example).
Thus the sets can edited and activated together.

“File > Select Group” displays a window similar to the following (when first opened, the list will be empty):

Figure 10−7.
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To create a new group, select the New button. The following dialog is displayed:

Figure 10−8.

Enter a new name and select OK. The group will be created and the Edit Group dialog will be displayed (Figure 10−9).

Figure 10−9.

The left column shows all the CP input and output sets. The right−hand column shows all the sets in this group. To add sets
to the group, select one or more entries from the left−hand column and click the >> button. To remove sets, click on one or
more set names in the right column and click the << button. To select multiple sets, use standard Windows keys − Shift−click
or Ctrl−click.

To edit the sets in the group, select a group in the Select Group dialog and click the Edit Sets button. An edit window will
appear for each set in the group (see “Editing Sets” above).

To immediately activate (download) all the sets in a group, select the Activate button in the Select Group dialog. During this
process, the following dialog is then displayed:

Figure 10−10.

This dialog displays the names of all boards in the active set, and the status of the transfer. The status will display as follows:
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READY − The board has received the new control panel set, or the board does not need the set. The set will only
be sent to boards that require it.

NO MEMORY − The board has reported back that there is insufficient memory to download the selected sets. The
board will not be downloaded at this time.

UNKNOWN − The board is not responding. If a board has not responded within 15 seconds, this will change to
INACTIVE.

The OK button is disabled until the process has completed.

It is also possible to activate sets individually, as described below.

ACTIVATING (DOWNLOADING) A SINGLE SET

To activate individual input or output sets, go to “File > Activate Sets.”

Figure 10−11.

Select one or more “Replacement Set” fields and select a set name. Click the Activate button. The system will ask for verifica-
tion. If you elect to proceed, the information will be sent to the controller boards and a Sending Status display will appear
(as described on page 10−6).

LOGGING

After the sets are activated two log files will be written to the Jupiter/AppData/IOEdit directory. The first contains the set
names and group names. The second log file contains the actual sets that have been sent. Both files will have a date and time
stamp, along with the name of the user who did the activation as a header field, and will be comma delimited (CSV) for export-
ing to other applications. The name of the file will be the same, with the extension describing the log file type. The file names
will be:

Lxxxxxxx.nam

Lxxxxxxx.set

where xxxxxxx is a seven digit sequential number starting at 0000000, going to 9999999. These log files can be printed from
the “File” menu.
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LOG IN/LOG OUT

Logging In

The user must log into the system to be able to edit and activate sets and groups. When the user selects the “Log In” option
from the File menu, he will be prompted with the following dialog:

Figure 10−12.

The user will be required to enter his or her log in name and password. The system password level will be set to the user’s
password level.

Passwords are up to eight characters in length and can be any alphanumeric character. This includes special DOS filename
characters such as ‘*’, ‘\’, etc. The user will be prompted to enter a new password twice for validation purposes.

Logging Out

When the user logs out of the system, no changes can be made. The login screen will be displayed.

Without being logged into the system, the user can view the input and output usage tables. If the application is running and
no changes or activations have occurred within the last 15 minutes, the operator will have the option to stay logged in or auto-
matically log out. This option will be available for only 30 seconds. If there is no operator intervention, the system will log
out the user and the login window above will be displayed.

OPTIONS MENU

Passwords

The user logged in must have a password level of 4 to use all options available in this window. Otherwise the options will
be grayed out, indicating they cannot be selected. Any user will be able to change their own password; all other operations
are password level dependent. On validation of password level, the password table will be displayed:
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Figure 10−13.

The window contains a list of users and their password levels. Actual passwords are not displayed in this window. Each pass-
word is assigned a level 1 through 4. This level determines the entries in the table that the operator has authority to change.
Level 4 is the highest and can change any entry. Level 3 can change levels 1, 2, and 3. Level 2 can change levels 1 and 2, while
level 1 passwords can only change level 1 entries.

A level 4 user can add, delete, or change entries in the password table by selecting the entry and then the Add, Delete, or
Change buttons. Adding or changing entries will bring up the following window:

Figure 10−14.

This dialog contains a 20 character (maximum) name, an eight character (maximum) password, and a single digit level. Levels
are entered using a drop−down box.

Compare Sets

This option provides a comparison utility between two sets. The sets must be of the same type; i.e. both input sets or both
output sets. The Compare Sets window shown provides the user with a complete list of sets.
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Figure 10−15.

Highlight the two sets for the comparison and press the Compare button to start the comparison. The following comparison
window will be displayed:

Figure 10−16.

The comparison list shown puts the two sets together for scrolling purposes. Various highlight shadings are used to distinguish
between items added, changed, or deleted. Care will be taken to display only the changes made. However, if the files are out
of synchronization, the resulting list could be misleading.

To print the comparison results, select the Print button. Otherwise, when done, press the Close button. The system will return
to the previous menu to allow additional set comparisons.
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INPUT AND OUTPUT SET USAGE TABLES

Input/Output Set Usage, from the View menu, shows where inputs are and outputs are being used.

Figure 10−17.

This window is displayed when the user se-
lects an input. It displays all the control panel
input sets where the input is used.

ADDITIONAL NOTES

1. The CP I/O Set Editor does not know when a PMEM Clear is done on a controller board. This means that if there were
any edit sets on the board before the PMEM clear the editor still thinks they are on the board; therefore when the editor
is running and the pull−down menu “File > Activate Sets” is used to bring up the Activate Sets dialog, the Current Sets
list will not reflect the changes made by the PMEM Clear. The PMEM Clear causes the board to revert to the original
sets. If you want to force the Current Sets list to display the original sets, delete the server file “CurSets.dat.” This file
is found in the directory “jupiter\AppData\IOEdit\SetName\” where SetName is the current set that has been selected
with the Control Center (this file doesn’t get created until you successfully activate a set). Note that edit sets may span
boards and a PMEM Clear on just one board may cause the system to be in a state where the Current Sets list cannot
reflect the system.

2. Cut and paste in edit sets do not behave the same as in most applications:

� When a row is selected, Cut will only cut from the Entry, Mnemonic, and Comment columns.

� Paste Row does not automatically create a new row. To create a new row, a blank row must first be Inserted
and remain selected; then the copied (or cut) row can be pasted into the new row’s position.

� Certain columns (Input, Output, PW level, and Category [for input sets]) have drop down lists of valid values
for the cells in these columns. You cannot paste invalid values into the cells in these columns.
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Section 11 − Force Unlock

Figure 11−1.

This application replaces the JNIA Force Unlock application. It allows you to unlock or unprotect any outputs that have been
locked or protected from anywhere in the system.

Display

The first column lists the name of any outputs that are locked or protected. The second column lists the panel that locked or
protected the output. Sometimes, the application is unable to determine which panel was used; in this case, the field may be
blank or may contain a number. Columns 2−n are for the levels defined in the Switcher Description table. Each column shows
whether a particular output and level are locked or protected.

Unlocking and Unprotecting

To unlock or unprotect an output, click anywhere in the first two columns. The entire row will be selected. To deselect a line,
simply click in the first two columns again. Click on the Force Unlock button, and the output will be unlocked or unprotected,
and the line will eventually be deleted from the display. (Note: If complete status for all levels of an output does not appear
you may need to repeat this step to unlock/unprotect all levels.)

To unlock an individual output/level, click on that cell in the table, then click on the Force Unlock button. The cell should
be cleared. The line will not be deleted from the table until all levels on that output have been unlocked or unprotected.

Menus

File
Exit - Close the application.

Help
About - Display the application’s about box with version information.
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Section 12 − Logger and Log Viewer

Figure 12−1.

The JNS Logger and Log Viewer are used to create, view, and print log files of Jupiter LAN activity. These files can be useful
for troubleshooting. The Log Viewer will display Jupiter LAN activity as it occurs and record errors detected by the Jupiter
Network Suite. To assure accuracy of the date/time stamp, connecting the CM 4000 to house time code is recommended (for
additional information about time code, see page G−11).

The functionality of the JNS Log Viewer is similar to that of the Jupiter Network Interface Application (JNIA) Log Viewer;
however, the user interface is very different. (Although the JNS Logger replaces the JNIA Log Viewer, the JNIA Log Viewer
is still available on Windows 95 platforms.)

Logger and Log Viewer require installation of the Jupiter Network Suite.

Note: The log file will be saved on whatever computer is executing the Log Server application. This computer can
be identified by going to “JNS Control Console > JNS Servers” and looking for the “Log” button. If the word “Lo-
cal” appears above the Log button, you are at the computer with the log file. 

Running the JNS Logger

Select “Start > Programs > Jupiter Network Suite > Logger.”
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Figure 12−2.

The Logger “Options” pull−down menu allows the operator to select which events to log.

Figure 12−3.

To begin logging, select “Start.”  The following dialog box will appear when logging is in progress:

Figure 12−4.

Note: This dialog will remain on the desktop until Stop is selected, but it does not appear in the Window Task Bar
on the bottom of the screen.

Running the JNS Log Viewer

The JNS Log Viewer can display Jupiter LAN activity as it happens, even if the JNS Logger has not been started. However,
the JNS Logger must be running in order to capture the events; i.e., have them saved to a file automatically.
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To run the Log Viewer, select “Start > Programs > Jupiter Network Suite > Log Viewer.”

Figure 12−5.

Dynamic Displays

When first started, the Log Viewer is in the Dynamic Data mode, i.e. all displays show Jupiter LAN activity as it happens.
Select “View” and select the desired Dynamic Displays.

Figure 12−6.

Dynamic Displays hold up to 256 lines of information.

Static Displays

To view Jupiter LAN activity that has been logged to a file, select “File” and then “Open” the desired log file.

Log files are created in the “logdata” subdirectory of where JNS was installed. By default, JNS is installed in C:\Program
Files\Thomson\Jupiter\Jupiter Network Suite and therefore log files would be found in C:\Program Files\Thomson\Jupi-
ter\Jupiter Network Suite\logdata.

After opening the file, select “View” and select the desired displays. Note that Dynamic Displays and Static Displays can
coexist. The caption of each window indicates if it is a Dynamic Display. If not a Dynamic Display, then the caption indicates
which log file the data pertains to. The JNS Log Viewer allows simultaneous displays of multiple log files.
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Figure 12−7.

Sort displays by clicking on the column heading.

To select Dynamic Displays after opening a log file, select “File > Dynamic Data” and then select the desired Dynamic Dis-
plays.

Date/Time Filter

Set the Date/Time Filter, (“View > Date/Time Filter”) in order to filter log data. The selected Static Display as well as new
Static Displays created after setting the filter will use the filter settings.

IMPORTANT NOTE for JNS Release 5.1.0 and later: The Date/Time Filter may not work properly when Windows
Regional Settings other than “English (United States)” are being used.

Print/Export

To Print or Export a display, select “File > Print” or “File > Export.”

Notes

Sometimes, some of the fields in a Log Viewer grid may be truncated. To see the entire field, select “View/Auto−adjust column
widths” from the menu. The columns will be automatically resized to fit the largest field in the column.

In some cases, the “All Events” table has an especially large Description field. If you are using a low−resolution screen (like
800x600), you may be unable to make the window large enough to see the entire field. However, you can cut and paste the
field or fields into another application (like notepad), where you can see the entire field. You can also export the table to a
CSV file, where it can be viewed with applications like Excel.
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Section 13 − Configuration Upload

OVERVIEW

Configuration Upload displays all CM 4000s on the LAN that are running Jupiter XPress, displays configuration information
about each CM 4000, and allows for the currently active configuration set and the previously active configuration set to be
uploaded from any of the CM 4000s.

Whenever a configuration set is successfully compiled, the set is zipped and placed in the Jupiter\Comp directory. When a
set is activated on a system that has one or more CM 4000s that are running Jupiter XPress, that zip file is downloaded along
with the compiled file.

When the Configuration Upload utility is used to upload the active or previous set, the zip file is sent to the Jupiter\logdata
directory on the Jupiter File Server. The Configuration Editor can then be used to unzip the set, edit the set, compile the set,
and/or activate the set.

STEP−BY−STEP INSTRUCTIONS

1. Run the Jupiter Network Suite.

2. From the JNS Console, select “Tools > CM−4000 Configuration Info and Set Upload.” (The Tools menu is only enabled
when the JNS Servers are disconnected.)

Figure 13−1.
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3. Information for each active CM−4000 on the PC’s subnet that is running Jupiter XPress is displayed. If all CM 4000s
are not listed, click on the Broadcast button. All running CM 4000s that are connected to the network should then be
displayed regardless of subnet.

Figure 13−2.
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Note: If you do not see any CM 4000s listed when the Multicast button is selected, you may need to set the Gateway
and Subnet Mask in the Jupiter Settings. Go to “Tools > Jupiter Settings.” Then fill in the Gateway and the Subnet
Mask:

Figure 13−3.

Figure 13−4.

After editing and saving your changes, you may need to reboot the CM 4000s in order to see them listed for the
multicast scope.
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4. Select one of the CM 4000s and click on the Upload Configuration Sets button. In a few seconds, the currently active
configuration set is uploaded as_active.zip and the previously active set is uploaded as_prev.zip. A message informs
the user when the sets have been uploaded.

Figure 13−5.

5. Use the Jupiter Configurator to unzip, open, edit, and compile the Current Set (_active.zip) or the Previous Set
(_prev.zip) just as you would any other set. You will probably want to use the Configurator’s File > Save as menu option
to give the set the desired name.
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Section 14 − Physical Control

Figure 14−1.

The JNS Physical Control is a replacement for the Jupiter Physical Control application. It allows the user to switch using
“physical” input and output numbers.

Logical levels are displayed on the left in the order that they appear in the Switcher Description table.

To perform a switch, first select a level from the list, then enter the physical output number in the Output field. At this point,
you can click on the Update Status button to check the current status of the selected output and level; the status will appear
in the Input field. Enter the new input in the Input field, then select Take. The Input field will clear and the Take should occur.
To verify, select the Update Status button.

Note: Jupiter does not support follow level switching (e.g., for RGB switchers) when switch requests are issued
from Physical Control.
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Section 15 − Physical Diagnostic Utility

FEATURES

This utility allows the user to see the physical inputs and outputs associated with a logical or physical control panel, input
mnemonic, output mnemonic, and level mnemonic. It also provides the user the opportunity to view outputs associated with
a logical or physical input.

This utility can be used in conjunction with the Physical Remapping Utility. The user must be logged into the network for
this utility to function.

Note: The Physical Diagnostic Utility does not support remote PC operation.

This is an MDI application. An MDI application has a window within which multiple MDI child windows, which are frame
windows themselves, can be opened, each containing a separate document (or a log file for this utility).

MENUS

File

New − Allows the user to create a new Diagnostic Log File.

Open −Allows the user to open an existing Log File.

Close − Closes the frame window that has the keyboard focus. If only one child frame window is open, this will close that
child window.

Save − Saves the log file that is open in the child frame window, which has the keyboard focus.

Save As − Saves the log file to a different filename.

Print − Prints the current log file.

Print Setup − Sets up the printer.

Recent Files − Lists the last four log files being created or opened.

Exit

View

Toolbar − Allows the user to display or hide the toolbar.
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Status Bar − Allows the user to display or hide the status bar.

Input Mapping − Provides the user with the input mapping table.

Input/Output Exception Table − Provides the user with the Input or Output Exception tables.

Options

Manual − Allows the user to update the log file manually.

Automatically − Allows the user to update the log file automatically.

Window

Cascade − Cascades all non−minimized MDI child windows.

Tile − Tiles all non−minimized MDI child windows.

Help

About PhyDiag

Displays the About dialog box.

FUNCTIONALITY

Figure 15−1 shows the main MDI frame window that the user sees when entering the application.

Figure 15−1.

File > New

Selecting this item brings up the following dialog:
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Figure 15−2.

Select a control panel (MPK device) by clicking on one row of the grid table. The row will be highlighted and the OK button
will be enabled. When OK is selected, the following dialog will be displayed:

Figure 15−3.

This dialog displays a filename that consists of the name of the control panel the user has chosen and the current time and
date. Select the Change button to change the filename. If OK is selected, a MDI child frame window containing a empty log
document will be displayed:
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Figure 15−4.

The title bar of this MDI child window shows the log file name, and the first two fields of the dialog show the control panel
the user has chosen. To display the associated physical information, select an output, input and level mnemonic. Once these
fields are filled in, select UPDATE to display the “Physical” table.

The Physical table displays the switcher, logical level name, physical inputs and outputs associated with the logical informa-
tion. The user may select to update the table and log manually or automatically by selecting the Manual/Automatic  toggle
in the Options menu. Note that multiple lines of information may be displayed for each event if the currently selected input/
output/level uses path−finding.

The contents of this scrolling display can be saved as a CSV (comma delimited) file by selecting the File > Save menu option.

Selecting By Output

When the “Output” field is selected from the “Level Set” table, the “Output Select” dialog is displayed:
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Figure 15−5.

The title bar of this window displays the Control Panel Output Set name as well as the logical control panel name.

The table displays the output set for the selected control panel. To select an output, click on any row in the table, and click
“OK.”  The output mnemonic is displayed in the output field of the Level Set table in the Physical Diagnostic child window.

Selecting By Level

When the “Level” field is selected from the “Level Set” table, the “Level Select” dialog box is displayed:

Figure 15−6.

The title bar of this window displays the Control Panel Level Set name as well as the logical control panel name.

The table displays the level set for the selected control panel. To select a logical level, click on any row in the table, then click
“OK.” The level mnemonic is displayed in the Level field of the Level Set table in the Physical Diagnostic child window.
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NOTE: If the selected output and level set have an input associated with it, then the input mnemonic will be displayed in the
input  field of the Level Set table. If no input is associated with the selected output and level, an INVALID red color mark
will be displayed in the input field of the Level Set table.

Physical Data Update

After selecting the panel mnemonics, the UPDATE button of the MDI child window will be enabled to allow the user to up-
date the physical information. All events will display in the window with a scroll bar, if necessary. If “path−finding” is in use,
there will be multiple lines of data for an event. The data will be written to a comma delimited CSV log file, as displayed in
the title bar of the child window. The log file will have the capability of being printed to the currently selected Windows printer.
The user may select to update the table and log manually or automatically by selecting the Manual/Automatic  toggle in the
Options menu.

File > Open

This menu allows the user to view and print an existing log file. The following Open dialog is displayed to allow the user
to choose an existing log file:

Figure 15−7.

After the user selects a file, a MDI child window as in File > New containing the information of all the events in the log file
will be displayed.

View Menu

The View menu contains Input Mapping , Input Exception Table, and Output Exception Table items.

INPUT MAPPING

Input Mapping allows the user to view the mapping of Logical Outputs; Physical Outputs can also be viewed by selecting
a logical switcher, logical level, and an input, as seen in the following window:
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Figure 15−8.

Inputs are selected either by physical number, or logical name. Once all the fields are filled in, the program will then display
a list of outputs the input is currently switched to. The information in this table can be printed to the currently selected Win-
dows printer.

EXCEPTION TABLES

The Input and Output Exception Tables display the current physical input and output remappings:

Figure 15−9.

These Input or Output exception tables are entered from the Physical Remapping Utility. They can be printed to the currently
selected Windows printer.
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Section 16 − Physical Remapping Utility

This application allows the user to change individual or ranges of physical inputs and outputs, mapping around failed cross-
points or entire crosspoint boards.

This utility can be used in conjunction with the Physical Diagnostics Utility. The user must be logged into the network for
this utility to function.

Note: The Physical Remapping Utility does not support remote PC operation or AccuSwitch applications.

Figure 16−1.

The window above is displayed when the application is started. Select either the Input or Output check button for different
I/O type mapping, then select a switcher and level (as defined in the Switcher Description Table). Select either the “Single
Port” or the “Whole Board” radio buttons depending on whether individual or ranges of pages are to be changed.

Menus

File

Select Exception Table − Allows creation of a new Input or Output Exception Table or reuse of an existing table.
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Save Log File − Saves the current log file under the existing name. If the file has not yet been named, the program will default
to the Save As option.

Save Log File As − Saves the current log file under a new name.

Page Setup − Sets up the page layout of the printer.

Print Log File − Prints the current log file.

Exit

System Definition

This menu allows selection, on a level by level basis, of the range sizes for the level, and the idle physical inputs and outputs
for the level. Range sizes are based on router type and the user is given the opportunity to select numbers from 1 to 64 from
a drop−down list.

View − display the Input or Output Exception tables.

Start Remapping by Entering Physical Numbers

Enter the old physical input or output then a new physical input or output. The old physical number is the original number
from the switcher input or output table. The user should get this old physical number information from the switcher input or
output table, not the Physical Diagnostic utility. However, the user may determine the original physical number by reading
the number from the Physical Diagnostic utility, and looking up the number in the Exception tables. The user may view the
Input or Output Exception table by clicking on the corresponding entry in the View menu (see below).

The user may type in physical numbers from the edit box. The Original Physical Input/Output edit box contains all the cur-
rently used physical numbers on the specified switcher and level.  The New Physical Input/Output combo box contains all
physical input and output numbers defined as “Idle” in the System Definition Menu for the specified switcher and level.
When entering a single number, the screen will update to show him the board range for that specific input or output. The area
will be grayed out, indicating it cannot be changed. After typing in the port number, the system will automatically validate
the number. If a wrong port number is entered (a number not in the range), the system will display a warning box:

Figure 16−2.

If the user elects to remap a range of numbers by pressing the “Whole Board” radio button, the number he or she enters could
be any of the physical numbers in the range. The system will use the number entered in the System Definition Menu for range
size per level to determine the actual range and insert the correct range in the window. The first window shows the system
if a single number is entered in a range. The second illustration shows a range being entered.
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Figure 16−3.

Figure 16−4.

Comment Field

A comment field in the main dialog box is available as a word−wrap box for the user to enter relevant comments regarding
the remap.
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Remapping

When Remap is selected, the system will check to make sure that the old physical number(s) are valid, then it will check to
make sure that the new physical number(s) are available by checking the Switcher Description, the Switcher Input or Output
tables, and the Input or Output Exception tables.

If the physical numbers are valid, the system will display the following confirmation dialog box:

Figure 16−5.

Select Proceed or Cancel. If you elect to proceed, the information will be saved in the Input or Output Exception tables. These
tables serve to map old physical inputs or outputs to new ones. The updated table will then be sent to the VM 3000 controller
boards. Changes are effective immediately. If you select cancel, the system returns to the remap window with no changes
made to the system or exception tables.

If the physical numbers are already mapped, the program will display a message indicating the inputs or outputs are currently
remapped:

Figure 16−6.

You have the option of remapping or keeping the current mapping.

The remap information, including the comment field, date, and time stamp, is written to an ASCII log file, comma delimited
CSV file for exporting to a program such as Microsoft Excel. This log file should be named and can be printed to the current
Windows printer.

Restoring

The Restore button removes a mapping from an Exception table and remaps the number to its original number from the
Switcher Input or Output table. This new table is then sent to the VM 3000 controller boards. Changes are effective immedi-
ately. The user is prompted for confirmation as above prior to any changes taking place.
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System Definition

From this menu you can select range sizes, idle inputs, and idle outputs on a level basis. The following dialog box will be
presented:

Figure 16−7.

The Switcher Name, Switcher Level, #In and #Out fields are read from the active set’s Switcher Description table and cannot
be modified.  The range is selected from a drop−down list.  Range numbers from one to the minimum of 64 and #In/Out are
valid.

Setting Idle Inputs/Outputs

To define the input groups available for remapping, or the idle inputs, first select the level; the grayed Idle Inputs/Outputs
button will be enabled. Press either the Idle Inputs or Idle Outputs button.

Figure 16−8.

The heading line shows the switcher and level names. Next, define the group by specifying a physical input number and a
count.  The system will perform error checking to make sure that each input is not part of another group. The system will not
check against the size boundaries for that level, as the user may desire to map one input at a time.  When OK  is selected, all
changes are written to a binary file for future use.
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Enter both the idle input and output selections at least once. The information entered into the tables will be stored by the system
and be displayed each time the application is used. Controls allow editing the tables as needed, but the information will remain
persistent.

Exception Tables

For efficiency and speed, remappings will be limited to a maximum of 64 inputs and 64 outputs. Display the current Input
or Output Exception table by selecting the Input  or Output Exception Table item from the View menu. The following dia-
logs will be displayed, based on selection.

Figure 16−9.

Information in this table can be printed to the currently selected Windows printer.

To restore old physical numbers and remove them from the table, select rows from the table, then selects the Restore button
to remove the selected mappings from the Exception table.  The user could also select the Restore All button to restore the
whole table. After confirmation from the user, the numbers are remapped to their original numbers from the Switcher Input
or Output table. This new table is then sent to the system controllers. Changes are effective immediately.
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Section 17 − Router Control Utility

Figure 17−1.

This application allows the user to do simple Takes using any control panel input, output and level set in their currently active
set.

Configuration

When you first open the Router Control Utility, you will see the Configure window. You must select an input, output, and
level set. These sets will be used when making switches.

Figure 17−2.

Click on one of each set and then click on OK. The Configure dialog will disappear and the Outputs, Inputs, and Levels lists
in the Router Control window will fill with entries from the selected control panel sets. You can return to the Configure dialog
by selecting the “Configure” command from the Options menu.
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Displaying Status

The table at the top of the window displays the status for the currently selected output. Initially, the grid is empty because
no output is selected. To display status for an output, select an output from the Outputs list. The name of the output appears
in the first column, and status is displayed for each level in the selected level set. If nothing is currently switched to the output
in any of the levels, “?” will appear. If the display will not fit across the window, a scroll bar will appear below the table. You
can also resize the window to see more levels.

Doing Takes

To do a Take, select one input, one output, and one or more levels. To deselect a level, click on it again. Click the Take button.
The status display should update accordingly.

Menus

File
Exit - Close the application.

Options
Configure − Display the Configuration dialog (see above).

Help
About - Display the application’s about box with version information.
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Section 18 − Router Save/Restore

Figure 18−1.

The Router Save/Restore application displays router status (setup) and allows the user to save and restore router status.

OPERATION

When the application is first run, it displays the status for the entire router. Outputs from the Switcher Output table are dis-
played in the first column, and level names from the Switcher Description table are displayed along the top row. Input status
is displayed in the white cells in the table. These input names come from the Switcher Input table. If an output is locked, the
cell will be red and an “L” will be displayed next to the input name; if an output is protected, the lettering in the cell will be
red and a “P” will be displayed; if the Take is unconfirmed, the cell will be yellow and and a “U” will be displayed. In the
example above, output 100 is locked and output 102 is protected.

Status is displayed dynamically. If you make switches, the Router/Save Restore display is updated immediately.

Saving Router Status

To save router status, click on the Save command in the File menu. A standard Windows File Dialog will appear. Select the
directory where you wish to save the file and enter the name. Click OK. The application will save the current router status
to the file. Router Save/Restore files have a .rsv extension by default.

Restoring Router Status

To restore a saved router status, click on “File > Restore.” A standard Windows File Dialog will appear. Locate the file you
wish to restore, select it, and click OK. The application will execute takes to restore the saved status.
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Note: Because restoration includes lock/protect status, it is possible for the Router Save/Restore application to
override and switch a locked or protected output. For example, if an output is not in a lock/protect condition at
the time of a save, but is later switched and locked/protected, it will be “force unlocked/unprotected” and switched
back to the saved input when status is restored.

Selecting Outputs and Levels

Router Save/Restore lets you restrict the outputs and levels that are displayed and saved. To do so, select the “Select Outputs
and Levels” command from the Options menu. The following dialog will be displayed:

Figure 18−2.

Select the outputs and levels that you want to display or save. You can click and drag to select contiguous entries. To unselect
an entry, click on it again. When you are done, click on OK. Only the selected outputs and levels will be displayed in the Router
Save/Restore window. If you save the status, only the displayed outputs and levels will be saved. Selecting outputs and levels
does not affect which outputs and levels are restored. The application always restores all outputs and levels that were saved
in any .rsv file.

Menus

File
Save - Save router status (see above).
Restore - Restore router status (see above).
Exit - Close the application.

Options
Select Outputs and Levels - see above.

Help
About - Display the application’s about box with version information.
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Appendix A

CM 4000 VGA Status Display

HARDWARE INSTALLATION

The CM 4000 provides a VGA output for system status display. Basic controls for this display are located on the front panel
(Figure A−1).

Figure A−1. VGA controls on CM 4000.

DOWNUP NEXT SELECT

The CM 4000 VGA Status Display can optionally be operated with the CP 3020, a 1 3/4−inch rack mount panel configured
as a device type “VC 3020.” (Figure A−2.) To use the VGA display to best advantage, it should also be connected to a dedi-
cated CP 3000 Switcher Control Panel (configured as a “VCP 3000”) and an MC 3000 Machine Control Panel (configured
as a “VMC 3000”). Grass Valley recommends that all panels be mounted immediately beneath the VGA monitor. These panels
can be on different MPK buses, but they must all be connected to the CM 4000 being used to drive the VGA display. See Figure
A−3.

Figure A−2. CP 3020 with suggested VC 3020 labelling.

NEXT
CURSOR
MODE

CHNG
MODE 0 91 2 3 4 5 6 7 8

Figure A−3. VGA Status Display installation.
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SUMMARY OF SOFTWARE CONFIGURATION PROCEDURE

Following hardware installation:

1. The optional control panels, if any, must be configured as MPK devices:

a. A CP 3020 used with the VGA is configured as type “VC 3020” (page 5−114).

b. A CP 3000 used with the VGA is a type “VCP−3000” (page 5−114). If the CP 3000 has an expansion panel, it must
be entered as a type “VCP3000E.”

c. An MC 3000 panel must be entered on the MPK Devices table (page 5−114) and given the device type of
“VMC−3000” or, if it has an expansion panel, as a type “VMC3000E.”

2. In order to display time code on an MC 3000 associated with a VGA status display, entries must also be made to the
Machine Control table, as shown on page 5−148.

3. Text for the centered header can be entered (if desired) using the Status Display Headers table (page 5−150).

4. The VGA Status Display Table should be filled out (see page 5−151).

This table establishes the name of the Page Description file; i.e., the name of the file that will be created when the “Tools
> Generate VGA Files” command is run.

5. The “Tools > Generate VGA Files” command is used to create the Page Description file.

Note 1: The “Generate VGA Files” command is designed for use during initial installation only—it always
uses the original factory default settings when building the Page Description file. If you decide to modify
your VGA display with custom formatting, do not  re−run the Generate VGA Files command. If you do, your
modifications will be overwritten.

The Generate VGA Files command will refer to the information in the current Edit set, then use the factory default for-
mats to build two files: the first file will use the name entered on the VGA Status Display Table plus the extension “.vga.”
The second file will be created identically to the first but will have the name “vga−desc.vga.” Both files will be written
to the \jupiter\config\ configname directory, where configname is the name of the currently selected edit set.

Note 2: Whenever you run the Generate VGA Files command, you will see the following message:

WARNING VGA files may be overwritten

This message is a reminder that the system is about to use the factory default settings when building the Page
Description file. (When first installing the VGA, this is OK.)

6. The Edit set must be compiled and downloaded in the normal manner. This completes the configuration process using
factory default formatting. Operating instructions are found on page 6−138.
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CUSTOM DISPLAY FORMATTING

This discussion assumes that the reader is familiar with ASCII file editing concepts and that the procedure described on page
A−2 has been used to create preliminary VGA display pages based on the factory default layouts.

The VGA status display output of the CM 4000 is designed to give a great deal of flexibility to the user in defining what kind
of system information will be displayed at a particular location on the VGA screen. The types of information, or “fields,” that
can be displayed are:

Switcher Output Status (any level)
Switcher Input Status (any level)
Machine Status (Play, Stop, Record, etc.)
Machine Delegation Status
Machine Linkage Status (Which control panel it’s currently linked to)
System Time and Date
System Control Board Status (Active, Inactive)
System Control Board Time Source (Time Code Reader, File Server, etc.)
System Control Board Messages (Also displayed by the logger)
Path Finding (Tie Line) Status (details about Tie Line displays are shown on page A−9)

The type and location of these fields are determined by a user−named text file called the “VGA Page Description File.” This
file is located in the \jupiter\config\configname directory, where configname is the name of the currently selected edit set. The
file is a standard DOS ASCII Text file with “.vga” as its file name extension. The VGA Page Description File can be edited
by the end−user in order to modify existing status pages or create new ones.

Note 1: Initially, there may be two, identical−content .vga files in this directory. Before beginning the customiza-
tion process, you should move any file named “vga−desc.vga” to another directory for safekeeping. (This file con-
tains display pages with the original factory default formatting.)

The following instructions explain how the display fields are positioned, defined, and colorized. After the VGA Page Descrip-
tion File is edited, the Edit set must be compiled and downloaded in the normal manner. Be sure to keep copies of known−good
VGA Page Description Files (.vga files) in another directory. Once the .vga  Page Description File has been customized,
the Generate VGA Files command should NOT be used.

Note 2: The character used to separate “fields” is a <TAB> character, so any text editor used must be able to gener-
ate “straight ASCII” and a <TAB> character (WordPad and Notepad work well). Do not use MS−DOS “EDIT”
or any other word processor that substitutes spaces for the <TAB> character—this will cause unwanted results on
the VGA display.

VGA Page Description File Definitions

Basic Rules:

1) All field definitions that are a capital letter define a system name that will be used by following status fields until re−de-
fined with another system name.

2) All field definitions that are a lower−case letter are a status field, and use previously−defined system names applicable
to the given type of status.
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3) Field attributes are a single digit number 0−9 immediately following the field definition.

4) The field separation character(s) is a <TAB> or <CR + LF>.

5) Switcher name is defined for every subsequent line until re−defined with another switcher name field.

6) Switcher Input and Output name are defined for the rest of the current line.

7) Level status is defined for the current column position until re−defined with another level status.

8) To assign a page−worth of data to a specific button number, use “P#4” to assign the page description data that follows
to page 4.

9) Continued Input Status uses the last defined switcher input and level from the previous line.

10) Machine Delegation is defined for the current column position until re−defined with another Machine Delegation.

11) All compiled numbers are in four−character ASCII form, NOT BINARY.

12) The Tie Line Group field will continue to the rest of the current line.

13) The number of pages for each CM 4000 VGA port is limited to 99.

Field Definitions

Field Type            Start Char Field Length    Definition Syntax
−−−−−−−−−−            −−−−−−−−−− −−−−−−−−−−−−    −−−−−−−−−−−−−−−−−
Switcher Name   S Not Displayed Sssssssss<TAB>
Output Name              O      8   Onoooooooo<TAB>
Level Status (Output) l     9 lnllllllll<TAB>
Input Name         I      8      Iniiiiiiii<TAB>
Level Status (Input) l Rest of line lnllllllll<TAB>
−Continued Input Status C Rest of line C<TAB>
Path Finding Status G Rest of line Gngggee<TAB>
System Time              i     8 in<TAB>
System Date        a      12 an<TAB>
Machine Name  M 8 Mnmmmmmmmm<TAB>
Machine TMC Status       m     8 mn<TAB>
Machine Delegation        d     9 dndddddddd<TAB>
Machine Linkage Status   k      8 kn<TAB>
Board Name  B 8         Bnbbbbbbbb<TAB>
Board Message            g    Rest of line gn<TAB>
Board Status     u      8 un<TAB>
Board Time Source        s     17 sn<TAB>
Screen Text         T    Variable Tn−−−−−−−−−−<TAB>
Current Page Number  p            2 pn<TAB>
Button Number P Not Displayed P#xx<TAB>
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Definition Syntax Key:     VGA Color  Color Code
−−−−−−−−−−−−−−−−−−−−−−     −−−−−−−−   −−−−−−−−−−
n          = Color Code     White          0
oooooooo   = 8 char System Output Name     Yellow         1
iiiiiiii   = 8 char System Input Name     Magenta        2
llllllll   = 8 char System Level Name     Red            3
ssssssss   = 8 char System Switcher Name     Cyan           4
pppp       = 4 digit Physical Output Number     Green          5
mmmmmmmm   = 8 char System Machine Control Device Name Blue           6
dddddddd   = 8 char Delegation Group Name     Dark White     7
bbbbbbbb   = 8 char System Board Name     Brown          8
−−−−−−−−   = User defined screen text (any length)     Dark Blue      9
xx         = 2 digit Button Number
ggg        = 3 digit group number (0−999)
ee         = 2 digit line number (0−99)
 

Box Drawing Characters (IBM Line Characters)
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

Character Converted to:
−−−−−−−− −−−−−−−−−−−−−
+ Corners of a box, or intersections of vertical and horizontal lines
− Horizontal Lines
| Vertical Lines

For example, a simple box, divided into four squares inside, would be defined like this:

+−−−−+−−−−+
|    |    |
|    |    |
|    |    |
+−−−−+−−−−+
|    |    |
|    |    |
|    |    |
+−−−−+−−−−+ 

As a quick demonstration of the VGA Page Description File syntax, to display the status of the switcher output “VTR1” of
the switcher name “DEFAULT,” on levels “VIDEO,” “LEFT,” and “RIGHT,” the formatting instructions would look like this
(assuming “<TAB>” is substituted with a real <TAB> character):

SDEFAULT
O0VTR1<TAB>T0  <TAB>l0VIDEO<TAB>T0  <TAB>l0LEFT<TAB>T0  <TAB>l0RIGHT<TAB>

The letters “S,” “O,” “T,” and “l” (small L) define the type of field of the following text. The number “0” after the letters “O,”
“T,” and “l” corresponds with the color the data will appear on the screen.
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Page Description Examples

These examples assume that the procedure described on page A−2 has been used to create preliminary VGA display pages
based on the factory default layouts, and that the .vga file now needs to be customized.

Switcher Output Status Page

P#00
SMAIN
T0Thomsonö          KXYZ TELEVISION FACILITY CONTROL SYSTEM                Page:   p0
a0    T1                  MAIN Switcher Output Status                   i0
T6−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
T0OUTPUT          T6|   T0VIDEO    LEFT     RIGHT    T/C
T6−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
O5PRDA      T6   |      l5video     l5left      l5right     l5t/c
O5PRDB      T6   |
O5PRDC      T6   |

O5019       T6   |

Thomson        KXYZ TELEVISION FACILITY CONTROL SYSTEM                PAGE: 00
May 10, 1999            MAIN Switcher Output Status                     12:34:56
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
OUTPUT      VIDEO     LEFT     RIGHT    TC
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
PrdA        VT01      VT01     VT01     VT01
PrdB        VC01      VC01     VC01
PrdC        Cam1      Cam1     Cam1

019

Figure A−4. Text file and resulting
status page (example)

Levels

Outputs

Inputs
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Switcher Input Status Page

Thomson        KXYZ TELEVISION FACILITY CONTROL SYSTEM                PAGE: 01
May 10, 1999            MAIN Switcher Input Status                      12:34:56
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
INPUT       SDV     
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
VTR5        VT01
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
STUA        VC01
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
PrdC        Cam1
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

Figure A−5. Text file and resulting
status page (example)

Levels

Inputs

Outputs

P#01
SMAIN
T0Thomsonö         KXYZ TELEVISION FACILITY CONTROL SYSTEM                 Page:  p0
a0    T1                 Switcher Input Status                          i0
T6−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
T0INPUT           T6|   T0SDV
T6−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
I0000       T6   |      l0SDV
T6           |    C
T6−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
I0001       T6   |
T6           |    C
T6−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
I0002       T6   |
T6           |    C
T6−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
I0003       T6   |
T6           |    C
T6−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
I0004       T6   |
T6           |    C
T6−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
I0005       T6   |
T6           |    C
T6−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
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Machine and Delegation Status Page

P#02
T0Thomsonö        KXYZ TELEVISION FACILITY CONTROL SYSTEM                  Page:   p0
a0    T1                Machine & Delegation Status                     i0
T6−−−−−−−−−+−−−−−−−−−+−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
T0Machine   T6|   T0 Status   T6|   T0 Linkage  T6|   T0Jupiter  Saturn
T6−−−−−−−−−+−−−−−−−−−+−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
M5VTR1      T6 |  m0    T6 |  k0   T6|   d5Jupiter      d5Saturn
M5VTR2      T6 |  m0    T6 |  k0   T6|
M5VTR3      T6 |  m0    T6 |  k0   T6|

Thomson        KXYZ TELEVISION FACILITY CONTROL SYSTEM                PAGE: 02
May 10, 1999           Machine & Delegation Status                      12:34:56
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
MACHINE    STATUS   LINKAGE   JUPITER  SATURN     
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
VTR1       PLAY               ASSIGNED ASSIGNED
VTR2       *OFF*
VTR3       *OFF*

Figure A−6. Text file and resulting
status page (example)

System Status Page

P#03
T0Thomsonö       KXYZ TELEVISION FACILITY CONTROL SYSTEM                   Page:   p0
a0    T1                     System Status                              i0
T6−−−−−−−−+−−−−−−−−+−−−−−−−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
T0BOARD     T6|   T0 STATUS   T6|   T0   TIME SOURCE        T6|   T0 MESSAGES
T6−−−−−−−−+−−−−−−−−+−−−−−−−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
B5CM−Board  T6|   u5  T6|     s5   T6|    g0

Thomson        KXYZ TELEVISION FACILITY CONTROL SYSTEM                PAGE: 03
May 10, 1999                 System Status                      12:34:56
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
BOARD     STATUS     TIME SOURCE     MESSAGES     
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
CM−board  ACTIVE   RTC set by server (m−red): This board is ACTIVE−auto

Figure A−7. Text file and resulting
status page (example)
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TIE LINE (PATH FINDING) PAGE

(For a general discussion of path finding, please see page 5−174.)

The VGA tie line display allows the user to determine which sources and destinations are using which tie lines. See Figure
A−8.

Group 1 line 0 DVE−1 > Keyer 1
line 1 VTR 2 > Monitor 1 Monitor 4
line 2 VTR 1 > G002 L03

Group 2 line 3 G002 L03 > Monitor 2

Figure A−8. Tie line display.

In path finding, there is a “Group” for each switcher level. The Group number for a given level corresponds to the actual row
number in the Pathfinding Description table (page 5−177).

The “line” number is the physical tie line in use.

The input (“DVE−1”) and output (“Keyer 1”) names are the logical names from the Switcher Input table (page 5−48) and
Switcher Output table (page 5−55).

Jupiter’s tie line management system can consist of multiple tie line usage. In other words, tie lines using other tie lines to
access a source. This state is indicated by displaying the group number and line number of the tie line instead of the input
or output number. In Figure A−8, Group 1 line 2 is carrying VTR 1; however this tie line is connected to Group 002 line 03,
which in turn is connected to Monitor 2.

If an output for a specific group/line has no tie line source connected to it, the source and destination fields will contain the
word “unused.”

The Next key will move the group/line destination field to show the next group of 1 or more destinations. A double arrow
(>>) will be displayed on a group/line row if the current row has no room to show other destinations that are switched to a
source. The message “No More” will be displayed if no more destinations for a group/line are available. The other keys are
not used.

The user must define the Tie Line display page (as described below), entering the desired tie line group numbers and line
numbers. The usual limit of 25 rows per page applies.
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Tie Line Status Display

Thomson        KXYZ TELEVISION FACILITY CONTROL SYSTEM                PAGE: 04
May 10, 1999          Path Finding Path1    −> Path2                    12:34:56
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
Group No.    Line No.  Source    Destination     
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
G#0 VIDEO    Line0     P2018   > P1017
             Line1     P2020   > P1018
             Line2     Unused  > Unused

Figure A−9. Text file and resulting
status page (example)

P#04
T0Thomsonö        KXYZ TELEVISION FACILITY CONTROL SYSTEM                  Page:   p0
a0    T1                VGA Tie Line Status Display                    i0
T6−−−−−−−−−−−−−+−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
T0Group No.       T6  | T0Line No.  T6 |  T0SOURCE     Destination
T6−−−−−−−−−−−−−+−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
T0G#0  VIDEO      T6|    T0Line0    T6  | G500000
T0          T6    |      T0Line1    T6  | G500001
T0          T6    |      T0Line2    T6  | G500002
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Appendix B

PROGRAM RESTART PROCEDURES

CM 4000  Reset

There are four ways to reset this controller:

A . Control Center Go to “Start > Programs > Jupiter Network Suite > JNS Applications > Control Center.” Then
select the “Configuration” tab and “Reboot.” This will reset all controllers in the system. Or, select
the “Board Info /Control” tab and toggle on the board you want to reset; then click “Reboot” (note
that having different versions of software or configuration tables between boards can cause sys-
tem instability). For more information about the Control Center, see page 9−1.

B . Press the front−panel Reset button

C . Cycle Power

D . Console port Use of the Console port  is described in Appendix C. 

During a reset, the CM will test itself and, depending on the result, may request a new download from the file server.

CLEARING PARAMETER MEMORY (PMEM)

CM 4000

If the reset procedure just described fails to solve the problem, clear the Pmem (parameter memory).

Note: When PMEM is cleared, all switcher status will be lost (but no switches will take place.) If a CM 4000 is
cleared the switcher status will not be restored until the switches are manually re−taken. In addition, machine con-
trol links (as described on page 5−141) will have to be re−established.

Proceed as follows:

Go to “Start > Programs > Jupiter Network Suite > JNS Applications > Control Center.” Then select the “Board Info /Control”
tab and toggle on the board you want to clear; then click “Clear PMEM.” After Pmem has been cleared the boards will be
reset automatically. For more information about the Control Center, see page 9−1.
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Appendix C

Console Port Connections and Protocol

Figure C−1. Location of Console connector.

Console
connector

CM 4000

Rxd

TxD

Signal Gnd

pin 2

pin 3

pin 5

Txd

Rxd

To controller board
Console connector

Logic ground

DB9P (male)

To computer/terminal

DB25P connector

pin 3

pin 2

pin 7

DB9S connector

pin 2

pin 3

pin 5

OR

Figure C−2. Console cable for all controller boards.

The Console connection is provided for test purposes. The protocol for this port is 9600 baud, 8 data bits, 1 stop bit, no parity.

All boards can be reset by momentarily shorting pin 7 to pin 5 on the Console port.
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Appendix D

Decimal−Hexadecimal−Binary−ASCII Conversion Chart

0 00 00000000 NUL
1 01 00000001 SOH
2 02 00000010 STX
3 03 00000011 ETX
4 04 00000100 EOT
5 05 00000101 ENQ
6 06 00000110 ACK
7 07 00000111 BEL
8 08 00001000 BS
9 09 00001001 HT

10 0A 00001010 LF
11 0B 00001011 VT
12 0C 00001100 FF
13 0D 00001101 CR
14 0E 00001110 SO
15 0F 00001111 SI
16 10 00010000 DLE
17 11 00010001 DC1
18 12 00010010 DC2
19 13 00010011 DC3
20 14 00010100 DC4
21 15 00010101 NAK
22 16 00010110 SYN
23 17 00010111 ETB
24 18 00011000 CAN
25 19 00011001 EM
26 1A 00011010 SUB
27 1B 00011011 ESC
28 1C 00011100 FS
29 1D 00011101 GS
30 1E 00011110 RS
31 1F 00011111 US

32 20 00100000 SP
33 21 00100001 !
34 22 00100010”
35 23 00100011 #
36 24 00100100 $
37 25 00100101 %
38 26 00100110 &
39 27 00100111 ’
40 28 00101000 (
41 29 00101001 )
42 2A 00101010 *
43 2B 00101011 +
44 2C 00101100 ,
45 2D 00101101 −
46 2E 00101110 .
47 2F 00101111 /
48 30 00110000 0
49 31 00110001 1
50 32 00110010 2
51 33 00110011 3
52 34 00110100 4
53 35 00110101 5
54 36 00110110 6
55 37 00110111 7
56 38 00111000 8
57 39 00111001 9
58 3A 00111010 :
59 3B 00111011 ;
60 3C 00111100 <
61 3D 00111101 =
62 3E 00111110 >
63 3F 00111111 ?

64 40 01000000 @
65 41 01000001 A
66 42 01000010 B
67 43 01000011 C
68 44 01000100 D
69 45 01000101 E
70 46 01000110 F
71 47 01000111 G
72 48 01001000 H
73 49 01001001 I
74 4A 01001010 J
75 4B 01001011 K
76 4C 01001100 L
77 4D 01001101 M
78 4E 01001110 N
79 4F 01001111 O
80 50 01010000 P
81 51 01010001 Q
82 52 01010010 R
83 53 01010011 S
84 54 01010100 T
85 55 01010101 U
86 56 01010110 V
87 57 01010111 W
88 58 01011000 X
89 59 01011001 Y
90 5A 01011010 Z
91 5B 01011011 [
92 5C 01011100 \
93 5D 01011101 ]
94 5E 01011110 ^
95 5F 01011111 _

96 60 01100000 ‘
97 61 01100001 a
98 62 01100010 b
99 63 01100011 c

100 64 01100100 d
101 65 01100101 e
102 66 01100110 f
103 67 01100111 g
104 68 01101000 h
105 69 01101001 i
106 6A 01101010 j
107 6B 01101011 k
108 6C 01101100 l
109 6D 01101101 m
110 6E 01101110 n
111 6F 01101111 o
112 70 01110000 p
113 71 01110001 q
114 72 01110010 r
115 73 01110011 s
116 74 01110100 t
117 75 01110101 u
118 76 01110110 v
119 77 01110111 w
120 78 01111000 x
121 79 01111001 y
122 7A 01111010 z
123 7B 01111011 {
124 7C 01111100 |
125 7D 01111101 }
126 7E 01111110 ~
127 7F 01111111 DEL
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Appendix E

Mark/Search Commands in Jupiter Control System

This appendix is to clarify the operation and implementation of these two commands when used with the MC 3000 control
panel.

MC 3000 CONTROL PANEL OPERATION

The operation of the MC 3000 control panel is generalized to support time code and non−time code oriented machines. This
insures that the operator interface is consistent. Descriptions are included for operation with time code and without.

MARK Command Pushbutton

If the operator presses the MARK  push button, the following operations are performed by the MC 3000 control panel driver:

1) The current time code value is captured by the MC 3000 driver. This value is stored locally and is used for the
Search command.

2) A ES−bus PRESET <time value> command is sent to the machine being controlled. This time value may be
used for future search commands.

SEARCH Command Pushbutton

If the operator presses the SEARCH push button, the following operations are performed by the MC 3000 control panel
driver:

1) The current machine PREROLL  time value is subtracted from the previously stored MARK  time value. The
preroll time value is found by interrogating the controlled machine and recovering the defined preroll time
value.

2) An ES−bus TARGET SEARCH <time value> command is sent to the machine being controlled. The machine
is placed in search mode and is moved to the time value included in the TARGET SEARCH command. Since the
time value sent to the machine incorporates the preroll time value, the machine will be moved to the PREROLL
location. The actual result of this command is determined by the operations of the controlled machine. In most
cases, the machine will cue to the previously marked location, this is usually less the PREROLL value.
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Appendix F

“ESbus” Specifications

MECHANICAL AND ELECTRICAL CHARACTERISTICS

Source: EBU tech. 3245−E, Remote−Control Systems for Television Equipment, December, 1984.

Figure F−1. Connector pin assignment.

FG
1

RC
6

RA
2

RB
7

TB
3

TA
8

TC
4

FG
9

SP
5

FG
1

TC
6

TA
2

TB
7

RB
3

RA
8

RC
4

FG
9

SP
5

Bus controller Tributary

FG Frame ground
TA Transmit “A”
TB Transmit “B”
TC Transmit−signal common
RA Receive “A”
RB Receive “B”
RC Receive−signal common
SP Spare

A < B ”MARK” state
A > B ”SPACE” state

G R

Generator

Balanced
Interconnecting

Cable Load

Receiver

R
t

+

−

1 = HI
0 = LO

1 = HI
0 = LO

B TB

A TA

C TC

RB B’

RA A’

RC C’

Cable
termination

Figure F−2. Balanced digi-
tal interface circuit.
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   ESbus command Hex    Sony command                 Hex

STOP 41 STOP 20 00

VAPL 42 VAR FWD 22 12 + speed

VAR REV 22 22 + speed

STPL 43 PLAY 22 01

VFST 45 JOG FWD 22 11 + speed

JOG REV 22 21 + speed

SHUT 46 SHUTTLE FWD 22 13 + speed

SHUTTLE REV 22 23 + speed

TSPO 47 PROG. SPEED + 21 38

PROG. SPEED − 21 39

REDS 48 STANDBY ON 20 05

STANDBY OFF 20 04

SRES 49 SERVO REF SEL 41 33

REMS 4A EDIT PRESET 41 30 + control bits

ENTY 4B EDIT PRESET 41 30 + control bits

(then) REC 20 02

EXIT 4C EDIT PRESET 41 30 + control bits

(then) PLAY 20 01

TASE 4E CUE UP W/DATA 24 31 + data

PRSE 4F CUE UP W/DATA 24 31 + data

TEES 67 TAPE/AUTO SEL 41 32

PRST (TTON) 60 46 TIMER−1 PRESET 44 00 + data

PRST (PTSV) 60 6D TIME CODE PRES 44 04 + data

ESbus VTR protocol to Sony VTR protocol conversion table
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Appendix G

CM 4000 AccuSwitch Installation and Configuration

The CM 4000 Control Module is presently available for use with the Jupiter XPress or AccuSwitch applications. Note that
only one of these applications can be downloaded and executed in a single CM 4000 at one time.

Note: Unlike systems with Jupiter XPress, systems with AccuSwitch can include other processor types (e.g.: VM
3000, SI 3000, Saturn processors).

The AccuSwitch product, when connected to and operated by a suitable automation system, allows deterministic switching
of a Grass Valley Crosspoint Bus router, with each switch guaranteed to occur one frame after receipt of the automation system
switch command; and, allows a sustained switching rate of up to 200 physical crosspoint switches per frame.

CM 4000/AccuSwitch supported functions

� Automation interface

� JNS reboot, JNS clearpmem, activating a configuration from the JNS Control Center, JNS Router Control, JNS
RouterSaveRestore

� Basic switching from JNS Control Panel Suite (GUI control panel)

CM 4000/AccuSwitch non−supported functions

� JNS functions except those listed above (for a list of JNS functions, see page 4−1)

� Hardware control panels

� MI 3040 General Purpose / Tally Interfaces

� VTRs and other production machines

� Third−party routers

� Pathfinding, remote (non−Crosspoint Bus) routers, distributed routing, 3−stage routers, follow switching

� VGA status display

The AccuSwitch product follows SMPTE time code and assumes that all switch commands received from the automation
system are to be executed within the next 24 hours. Therefore the automation system must send switching commands no more
than 24 hours in advance.

As an option, a second CM 4000 can be connected using the BOP 4000 Redundancy Cable Kit and Breakout Panel and oper-
ated as a backup unit. For more information, see page 2−8.

The preferred time source for the CM 4000 is house SMPTE time code. Various other devices can be configured as backup
sources, but priority is always given to the SMPTE time code input. (The CM will run without time code, but not frame accu-
rately.) For more information, see page G−12.

Grass Valley recommends using automation systems which have been tested with AccuSwitch software. Currently supported
systems are:
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� Thomson Broadcast Automation

� Harris (Louth) Automation

� Encoda Systems (formerly Columbine JDS/Enterprise Systems)

It is anticipated that additional automation systems will be qualified in the near future for control of the CM 4000 module.
For more information, please contact Grass Valley.

CM 4000/ACCUSWITCH HARDWARE INSTALLATION

Depending on the particular application, a media converter or hub may be needed to connect the Jupiter file server LAN card
to the CM 4000 or to a Jupiter VM/SI 3000. The CM 4000 has a 10/100baseT rear panel connector; the VM/SI 3000 has a
10base2 (BNC) rear panel connector.

Figure G−2. Example of Jupiter AccuSwitch installation.
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Note: VM/SI 3000 is not compatible
with Jupiter XPress application

Automation
System

Connection to Automation System

For cabling details, please refer to the drawings starting on page 2−89.
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Installing 10Base2 LAN Cables

In AccuSwitch applications, the CM 4000 can be on the same Jupiter LAN as VM/SI 3000 units and Saturn processors. The
10Base2 LAN used to connect VM/SI 3000 and Saturn units is the Ethernet thin cable type, also referred to as “thin net.” LAN
cabling guidelines are shown on pages G−4 and G−5. Please note the following additional restrictions:

• 50−ohm, RG−58 type coaxial cable and BNC connectors must be used for the LAN cabling. 75−ohm RG−59
cable cannot be used. Furthermore, cable crimpers designed for RG−59 cable may not do a good job with the
smaller RG−58 cable. Factory−made cable is available (see below).

• A thin cable LAN cannot be used outdoors between unconnected buildings. An Ethernet thick−cable segment,
connected to thin cable segments with repeaters, would be required for this purpose.

• Local building codes must be checked before LAN installation, especially with regard to grounding require-
ments and installation of cable in air return plenums. It is recommended that the LAN not be grounded; but if
grounding is required by local code it should be grounded on one end only.  Generally, the national electrical
codes restrict the use of LAN cabling in air ducts and plenums. If PVC−jacketed cable is permitted in such
spaces it typically must be run in metal conduit; FEP−jacketed cable is typically permitted without conduit.

• Due to possible speed loss, use of non−Jupiter equipment on the Jupiter LAN is not recommended and will not
be supported.

The following RG−58 thin net cables, with installed BNC connectors, are available from Grass Valley:

1 meter (3.3 ft)
2 meters (6.6 ft)
4 meters (13.1 ft)
8 meters (26.2 ft)

16 meters (52.5 ft)
32 meters (105 ft)

For ordering information, see page 1−22.

The jacket material for these cables is fluoropolymer (FEP).

A termination kit, consisting of a pair of 50−ohm terminators (without ground wire connections) is also available. The part
number is 44−039807−001.
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Figure G−3. Jupiter 10Base2 LAN
cable lengths
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Note 2: Hewlett−Packard recommends avoid-
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20 65.6
25 82

Note 3: Grass Valley recommends that each
cable segment be a multiple of 0.5 meter in
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Note 2).

Note 4: All BNC Tees must be equipped with
insulating covers. See page G−6.

See page G−3 for additional guidelines.
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Figure G−4.10Base2 LAN cable linearity.
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Figure G−5. ThinLAN insulating cover for tee connector.

Grass Valley part no:
05−042549−001.
Amphenol part no: 31−5271.
HP part no: 92227R.

Velcro
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ACCUSWITCH SOFTWARE INSTALLATION

Software Installation is described in the Field Engineering Bulletin supplied with the software package.

ACCUSWITCH SOFTWARE CONFIGURATION

For AccuSwitch applications, the CM 4000 must be configured using the Network Description, Serial Devices, Switcher De-
scription, and MPK tables as described below. There are also two new tables that apply specifically to the CM: Time Standard
and Video Reference.

1. Network Description table. This table must be used when the CM is first installed on the LAN. Each board is given a
user−specified name up to eight characters in length. For AccuSwitch applications, the board is identified as type “AS.”
The Ethernet address in hexadecimal is entered as shown on the front of the module.

0080CE010100

Redundant

2

Network Description

Board Name

CM1 0080CE010101AS

Address

3

1

Type Address

Figure G−6. Example Network Description table.

In a redundant CM system, the redundancy cable between the units is marked “Master” on one end; whichever CM is
connected to this end of the cable is always the master unit. The hardware address of the master is entered in the “Ad-
dress” column. The hardware address of the redundant (“slave”) unit is entered in the “Redundant Address” column.
For more information about redundant installations, see page 2−8.

2. Serial Devices table. This table is used when the automation system is connected to one of the CM serial ports. Enter
the name of the board, as previously entered on the Network table. Then select the protocol for the port(s) to be used.

2

Serial Protocol

1 CM1 ASC

Board (CM 1)
Protocol 1/2 -

ASC

(CM 2)
Protocol 3/4 -

ASC

(CM 3)
Protocol 5/6 -

ESW

(CM 4)
Protocol 7/8 -

ESW

(CM 5)
Protocol 9/10 -

ESW

11/12 - (CM 6)
Protocol

CET

13/14 - (CM 7)
Protocol

CET

15/16 - (CM 8)
Protocol

9600

(CM 1)
Baud 1/2 -

(CM 2)
Baud 3/4 -

(CM 3)
Baud 5/6 -

(CM 4)
Baud 7/8 -

(CM 5)
Baud 9/10 -

(CM 6
Baud 11/12 -

(CM 7)
Baud 13/14 -

(CM 8)
Baud 15/16 -

38400 115K 9600 19200 115K 4800 115K

Figure G−7. Example Serial Protocol
table.
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The CM serial protocol selections are:

� ESW (a.k.a. “Jupiter ESswitch protocol”). This is a simplified version of the ES Tributary protocol. It
is described in Grass Valley document “ESswitch Serial Routing Switcher Control Protocol, En-
hanced Version.” (The protocol description used as a reference should be dated June 2001 or later.)

� CET (ES Tributary) protocol, a.k.a. “CM_ESTR.” This is the full tributary ESBus automation proto-
col, compliant with SMPTE EG 29−1993, and all associated normative references. The protocol sup-
ports all standard bit rates from 300 to 115.2 kBPS. Flow control is an advantage with this protocol.

� ASC (ASCII) (a.k.a. “Jupiter ASCII Interface Protocol”). This protocol is described in Appendix N
(the protocol description used as a reference should be dated June 2001 or later). If this protocol is
used, the developer should read “A note concerning level numbering and external control computers
using ASCII protocol” on page 5−60.

If there is a redundant CM, it is not necessary to define it on this table.

Note 1: Grass Valley recommends that all eight ports be defined regardless of how many are actually
used. Even if there is no serial connection at all (e.g., in the case of an automation system connected via
LAN) all eight should still be defined in this version of the software.

Note 2: For every port defined in the Serial Protocol table there must also be an entry in the MPK De-
vices table, otherwise the CM 4000 will not boot.

3. Switcher Description table entries.

Each logical level number of the switcher is given a user−specified name up to eight characters in length, and the system
is provided with detailed information about each level. The name of the CM 4000 connected to the switcher is entered
in the “M Board” column.

At least one switcher level must be assigned to the CM 4000.

1

Switcher Description

MAINROUT CM1 64 64 1 Binary None

2 MAINROUT CM1 64 64 2 Binary Left

3 MAINROUT CM1 64 64 6 Binary Right

VIDEO

LEFT

RIGHT

Switcher VI RV Board #In #Out PLvL Follow Level Driver 3 LI 3 LO Option AudioLevel
DM 400

MC Off Time

Figure G−8. Example Switcher Description table.

The name of the CM 4000 (as per the Network Description table) is entered in the “M Board” column.

4. MPK table entries.

Control devices connected to the CM 4000 are entered on this table. (Although an automation system is not an actual
“MPK” device, it must still be entered on this table.)
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Note: For every port defined in the Serial Protocol table there must also be an entry in the MPK Devices table,
otherwise the CM 4000 will not boot.

a. Jupiter ESswitch protocol (ESW) and Jupiter ASCII Interface protocol entries.

1

MPK Devices

MPK

AUTOMATN SERIAL

Expansion Pass

CM1

Port

1

AddressDevices word

AUTOIN AUTOOUT AUTOLEV

Figure G−9.

Board Input Sets Output Sets Level Set Overide Set Sequence SetIn Panel Out PanelType

2 AUTOMATN SERIAL CM1 2 AUTOIN AUTOOUT AUTOLEV

3 AUTOMATN SERIAL CM1 3 AUTOIN AUTOOUT AUTOLEV

4 AUTOMATN SERIAL CM1 4 AUTOIN AUTOOUT AUTOLEV

5 AUTOMATN SERIAL CM1 5 AUTOIN AUTOOUT AUTOLEV

6 AUTOMATN SERIAL CM1 6 AUTOIN AUTOOUT AUTOLEV

The Address field should be left blank.

The Input, Output, and Level sets named on this table should include all inputs, outputs, and levels that will be
controlled by the external control computer. As a precaution, you may wish to restrict computer control to selected
outputs.

The Input and Output sets must be created specifically for use by “serial” devices. The Level Set must be created
as a type “CP−3000.” For more information about these sets see page 5−58.

b. SMPTE ES LAN protocol entries.

1

MPK Devices

MPK

cm−eslan ES−LAN

Expansion Pass

CM1

Port Address

1

Devices word

AUTOIN AUTOOUT AUTOLEV

Figure G−10.

Type Board Input Sets Output Sets Level Set Overide Set Sequence SetIn Panel Out Panel

The SMPTE ES LAN protocol defined here is compliant with SMPTE EG 30−1995 and all associated normative
references.

The Address field should contain the number “1.”

The Input, Output, and Level sets named on this table should include all inputs, outputs, and levels that will be
controlled by the external control computer. As a precaution, you may wish to restrict computer control to selected
outputs.

The Input and Output sets must be created specifically for use by “serial” devices.

The Level Set must be created as a type “CP−3000.”

c. SMPTE ES Tributary (CET / CM_ESTR) protocol entries.

As described in the SMPTE specification, ES−Tributary is an addressable serial protocol that allows several serial
devices to be individually controlled on a single serial connection of an automation control system. One applica-
tion might be to control multiple CM 4000 ports from a single serial connection to an automation system:
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CM 4000 Control Module

Automation computer

Figure G−11.

Because each device on the serial connection must have a unique address, entries are made in the MPK Devices
Table to associate the serial port numbers to the ES−Tributary address of the CM port. Also assigned in this table
are the input, output and level sets associated with router levels to be controlled on that port:

1

MPK Devices

MPK

AUTOMAT

Type

ES−TRIB

Expansion Pass Board

CM1

Port

7

Address

8280

Input Sets Output Sets Level Set Overide Set Sequence SetDevices word In Panel Out Panel

IN OUT LEV

2 AUTOMAT ES−TRIB CM1 8 8282 IN OUT LEV

Figure G−12.

Dev Name: This is the device name to be assigned to the controlling device on the port. It is an alpha−numeric
name up to 8 characters long.

Dev Type: This is set to ES−TRIB.

Board: Enter the board name of the CM 4000(s) being configured. This name must be identical to the name entered
into the Network Description Table.

Port: Enter the port number of the serial port that was configured for the ES−Tributary protocol.

Address:  For each port on a given serial line, a unique hex address must be assigned. The address must be an even
hex value between 8280 and 828E.

Input Set: Enter the name of the desired input set created in the CP Input Set Table. The set that is created must
be specifically for use by serial devices. The CP Input Set defines the inputs that can be controlled on this port.
This is a required entry.

Out Set: Enter the name of the desired output set created in the CP Output Set Table. The set that is created must
be specifically for use by serial devices. The CP Output Set defines the outputs that can be controlled on this port.
This is a required entry.

Lev Set: Enter the name of the desired level set created in the CP Output Set Table. The set that is created must
be specifically for use by serial devices. The CP Level Set defines the levels that can be controlled on this port.
This is a required entry.
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5. Time Standard table.

For deterministic switching, time information (hour:min:sec:frame) must be provided to the CM, the preferred time
source being house SMPTE time code. This table is used to identify one or more backup time sources for use if the time
code source fails. Each CM in the system must be described (except only one entry is required for a redundant pair).
Certain fields must be filled in for all systems; see description below.

NTP Host

1

Time Standard

Board

CM1

Address TCR Host AddressTCR Host Address TCR Host AddressRTC Host Address

Offset from GMT (+/−HH:MM)Time Zone Name

USA_East −05:00

Day (1−31)DST Start Month (MMM)

APR 1

Hour (HHAM/PM)

02AM

Day (1−31)

28

Hour (HHAM/PM)

02AM

DST End Month (MMM)

OCTFigure G−13.  Example Time Standard table.

Board − select the name of the CM 4000 board as entered on the Network Description table.

NTP Host  / Address − if a Network Time Protocol host computer will be used to supply time information (or used as
a backup source), create a host name (if one is desired). As a minimum, an IP address must be entered if an NTP host
will be used.

TCR Host  /  Address − if there is more than one CM in the system where one CM is connected to a time source and
acts as a “Time Code Reader” host for the other. If this is the case, enter the name of the host CM as found on the Network
Description table. Enter the IP address of the host CM (the IP address can be determined using the JNS Board Status
menu).

RTC Host  /  Address − if a Real Time Clock host computer will be used to supply time information, create the host
name and enter the IP address.

Time Zone Name − create a description of the local time zone (up to eight characters).

Offset from GMT − (entry required) Hours and minutes offset from Greenwich Mean Time (Coordinated Universal
Time or “UTC”).

Note: time zones west of Greenwich require a minus entry; time zones east of Greenwich require a plus entry. For
example, New York City would be −05:00.

DST Start Month  / Day  / Hour − (entry required) Daylight Savings start date and time.
DST End Month  / Day  / Hour − (entry required) Daylight Savings stop date and time.

Note: If you don’t wish to use Daylight Savings, enter the same month, date, and time for Start and Stop.

If there is more than one time source for the CM, the sources will be prioritized as follows:

1. SMPTE time code connected to CM
2. NTP 
3. Hardware clock on CM
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For example, if the SMPTE time code source were to fail the CM would attempt switch to the SNTP source; if
that source was not available then the CM hardware clock would be used, etc.

For a more technical discussion of CM time keeping, see page G−12.

6. Video Reference table.

Sync Standard

1

Video Reference
Sync Standard Sync StandardHorizontal Line

Figure G−14.  Example Video Reference table.

Sync Standard − choices are NTSC, PAL, 1080i 60Hz, 1080i 50Hz, and 1080i 59.94Hz.

Horizontal line  − this entry determines the switch point.

NTSC choices are 9.5, 10, 10.5, 11, 11.5, 12, 12.5, and 13. The SMPTE recommended setting is 10.5.

PAL choices are 5.5, 6, 6.5, 7, 7.5, 8, and 8.5. The recommended setting is 6.5.

ACCUSWITCH TIME MANAGEMENT

AccuSwitch tracks two time lines, SMPTE time code and an internal real−time clock (RTC).

Time code is used for short−term, frame−accurate switching. Since NTSC video signals run at 29.97 frames per second, drop−
frame time code accumulates an error of 2.2610 frames per day. This amounts to +75.442 milliseconds of drift every 24 hours,
a discrepancy larger than two seconds every month.

The real−time clock is used to accurately track time long term. This clock is synchronized with other sources based on the
entries in the Time Standard table.

If time code is present, the real−time clock’s hours, minutes, and seconds will be synchronized to it. If time code is not present,
the SMPTE time line will be synchronized with the real−time clock (i.e., the real−time clock is a backup time line). However,
AccuSwitch inhibits adjustments to the SMPTE time line when the system is under a load (i.e., the time line will only be ad-
justed when nothing is happening).

When a valid time code is not present, the real−time clock will use SNTP1 to synchronize with the specified sources in the
following order:

1) TCR (Time Code Reader) Host

2) NTP (Network Time Protocol) Host

3) RTC (Real−Time Clock) Host

1 Simple Network Time Protocol
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The idea is to synchronize first with another CM 4000 connected to a time code reader. This would keep the time within a
few milliseconds of time code.

If the TCR host does not respond, it will synchronize with a designated NTP server (some PC set up to perform that function).
If the house time code went bad, all CM 4000s could stay synchronized with a designated time server, which could itself be
synchronized to an accurate national standard.

Finally, if the first two hosts do not respond, a CM 4000 could be selected as the master and all CM 4000s synchronized to
it. While this would still allow time to drift it would force all CM 4000s to drift together.

In the final analysis, each time host is just an IP address and the CM 4000 will attempt to synchronize with each one in the
priority specified. Any valid IP address can be placed in each of the fields or each can be left empty (no synchronization).
Each facility is free to use this feature as it sees fit.

The “Time Zone Name” field is not used. It will accept any string eight characters or shorter.

The offset from GMT must be supplied so that the correct time is displayed. Time in the CM 4000 is always kept in UTC2

internally. When time is displayed, it is shifted according the offset for the local time zone.

For daylight savings time, enter the month, day, and hour to start and stop. Currently if you do not want to adjust for daylight
savings, you must enter the same month, day, and hour for start and stop times.

CM 4000 FRONT PANEL ERROR CODES
CM 4000 STARTUP AND SHUTDOWN CODES

Please refer to Appendix R.

2 Universal Time Coordinated, same as Greenwich Mean Time (GMT)
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Appendix H

JupiterXPress Configuration Swap Option

The Configuration Swap option allows JupiterXPress systems to swap between two similar configurations without a
Jupiter file server present.  Similar configurations means the same number of boards in the network description table,
number and type of control panels in the MPK description table, the same switcher description tables, and the same num-
ber of inputs and outputs in the switcher input and output tables.  In general, changes to the configuration that require
PMEM to be cleared should be avoided.  The Jupiter Configurator help and warning messages should be used as a guide.
Using the CM VGA Options table (Jupiter Configurator > Jupiter > CM VGA Options), Configuration Swapping, PMEM
Clear, Local Reboot, and Global Reboot can be made available to the System Command Page (CM VGA Options
screen).

� Configuration Swapping - when selected swaps between the current and previous configurations and then re-
boots, which activates the new configuration.

� PMEM Clear - clears PMEM in the whole system.

� Local Reboot - reboots only the board where it is selected.

� Global Reboot - reboots the whole system.

� User−Defined Options - currently not used.

After saving, compiling, and activating the new configuration, the System Command Page can be enabled by pressing
and holding the NEXT button, pressing and releasing the UP button, followed by releasing the NEXT button.  Configura-
tion information consisting of configuration name and a date time string (Xpress−1−Fri Mar 15 15:51:03 2003) from each
board in the system will then be displayed.  Commands are selected using the SELECT, UP, and DOWN buttons.  The
first SELECT button press will enter selection mode highlighting the first command, which is Exit.  The second SELECT
button press will activate that command.  Pressing the UP or DOWN buttons, once in selection mode, will highlight each
selected command.

Requirements for this feature are as follows.

� CM 4000(s) running JupiterXpress.

� Software key enabling configuration swapping.

� VGA running on at least one JupiterXpress board.

� CM VGA Options table configured with desired options.

� Two configurations downloaded to the JupiterXpress system with configuration swap options configured.

� All boards in both system configurations must be fully operational.

� The Jupiter file server should not be running any JNS applications.

CONFIGURATION SWAP PROCESS

When JupiterXPress is installed, the Software Key must contain the option for configuration swap. Two configurations with
minimal changes (control panel sets, mnemonic names) are downloaded to the JupiterXPress board.
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1. Using the configurations for the Jupiter XPress system, Xpress−1 and Xpress−2 for this document, verify that both
configurations have at least one Jupiter XPress board running VGA.  Using the Jupiter Configurator, go to Jupiter >
VGA Status Display:

Figure H−1.

2. Select the CM VGA Options (Jupiter > CM VGA Options) to include in each configuration.  All options should be
selected for this procedure.

Figure H−2.

3. Save, compile and download the first configuration (Xpress−1) to the system.

4. Once the system is rebooted and active again, verify the system is operating correctly.

5. While pressing and holding the NEXT button, press and release the UP button on a Jupiter XPress board configured
for VGA to enter the System Command Page.

6. Verify that the Current Configuration for each board is now Xpress−1.
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Thomson               Jupiter Configuration Set : Xpress−1              Page: 00
03/07/03                     System Command Page                        19:42:28
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
BOARD     | Current Configuration           |  Previous Configuration..
−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
CM−Board  |Xpress−1−Fri Mar 07 10:28:16 2003|Xpress−2−Fri Mar 07 09:35:16 2003
CM−Board-R|Xpress−1−Fri Mar 07 10:28:16 2003|Xpress−2−Fri Mar 07 09:35:16 2003
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
     Press <SELECT> then <UP> or <DOWN> to Highlight, <Select> to Choose
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
Exit   Swap Configuration   Clear PMEM   Reboot Local   Reboot Global
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

7. Press and release the SELECT button, which will highlight Exit.

8. Press and release the SELECT button a second time to Exit the System Command Page.

9. Modify, save, compile and download the second configuration (Xpress−2) to the system.

10. Once the system is rebooted and active again, verify the system is operating correctly.

11. Shut down all Jupiter/JNS applications on the Jupiter file server.

12. While pressing and holding the NEXT button, press and release the UP button on a Jupiter XPress board configured
for VGA to enter the System Command Page.

13. Verify that the Current Configuration for each board is now Xpress−2 and the Previous Configuration is now
Xpress−1.

Thomson               Jupiter Configuration Set : Xpress−2              Page: 00
03/07/03                     System Command Page                        20:02:18
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
BOARD     | Current Configuration           |  Previous Configuration..
−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
CM−Board  |Xpress−2−Fri Mar 07 09:35:16 2003|Xpress−1−Fri Mar 07 10:28:16 2003
CM−Board-R|Xpress−2−Fri Mar 07 09:35:16 2003|Xpress−1−Fri Mar 07 10:28:16 2003
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
      Press <SELECT> then <UP> or <DOWN> to Highlight, <Select> to Choose
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
Exit   Swap Configuration   Clear PMEM   Reboot Local   Reboot Global
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

14. Press and release the SELECT button, which will highlight Exit.

15. Press and release the UP button until PMEM Clear is highlighted.

16. Press and release the SELECT button which will activate a system wide PMEM Clear.

NOTE: Since the file server is not running Control Center, bootp requests from the Jupiter system will not be
acknowledged introducing a longer reboot time.

17. Once the system is rebooted and active again, verify the system is operating correctly.

18. While pressing and holding the NEXT button, press and release the UP button on a Jupiter Xpress board configured
for VGA to enter the System Command Page.

19. Verify that the Current Configuration for each board is now Xpress−2 and the Previous Configuration is now
Xpress−1.
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Thomson               Jupiter Configuration Set : Xpress−1              Page: 00
03/07/03                     System Command Page                        20:10:34
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
BOARD     | Current Configuration           |  Previous Configuration..
−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−+−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
CM−Board  |Xpress−1−Fri Mar 07 10:28:16 2003|Xpress−2−Fri Mar 07 09:35:16 2003
CM−Board-R|Xpress−1−Fri Mar 07 10:28:16 2003|Xpress−2−Fri Mar 07 09:35:16 2003
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
      Press <SELECT> then <UP> or <DOWN> to Highlight, <Select> to Choose
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−
Exit   Swap Configuration   Clear PMEM   Reboot Local   Reboot Global
−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

20. Press and release the SELECT button, which will highlight Exit.

21. Press and release the DOWN button until Swap Configuration is highlighted.

22. Press and release the SELECT button, which will Swap Configurations and reboot.

23. Once the system is rebooted and active again, verify the system is operating correctly.

24. While pressing and holding the NEXT button, press and release the UP button on a Jupiter Xpress board configured
for VGA to enter the System Command Page.

25. Verify that the Current Configuration for each board is now Xpress−1 and the Previous Configuration is now
Xpress−2.

26. Press and release the SELECT button, which will highlight Exit.

27. Press and release the SELECT button a second time to Exit the System Command Page.

Note:  If Swap Configurations is selected and all the Jupiter XPress boards in the system do not have the same
Current Configuration (Xpress−1 on all boards) and the same Previous Configuration (Xpress−2 on all
boards) then the configuration swap will be aborted.
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Appendix I

Jupiter Remote PC

OVERVIEW

“Remote” PC configurations allow a user to operate certain JNS applications/tools from a workstation other than the file serv-
er. For example, the Software Control Panel Suite (GUI) could be executed, displayed, and controlled at a Remote computer.

Remote applications/tools. JNS programs that can be operated at a Remote PC are:

� Board Status

� Control Center

� Force Unlock

� Logger and LogViewer

� Party Line Download

� Physical Control

� Router Control Utility

� Router Save/Restore

� Saturn Monitor Follow & Preview

� Software Control Panel Suite (GUI control panel)

Local−only applications. In contrast, the following programs cannot be operated at a Remote PC: Configuration Editor, CP
I/O Editor, Physical Remapping, and Physical Diagnostics. These programs execute in, and are accessible only at, the File
Server.

INSTALLATION

General considerations

• Do not run applications on your Jupiter network that might degrade system performance (e.g., an email applica-
tion).

• Do not assign Jupiter PCs to a domain, as this is not supported.

• Since Remote PCs require the same administrator login and password as the File Server, Remote operators by
definition have administrative privileges on the File Server.
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Hardware installation

As shown in Figure I−1, a Remote PC can be installed on the Jupiter network, or on a separate network (e.g., the facility/IT
LAN) connected through a second network interface card (NIC) in the File Server.

If you do connect the File Server to a second network, make sure the two networks are logically separated on separate subnets.
In other words, the devices on the Jupiter network will have IP addresses in one number series and the devices on the facility/IT
network will have IP addresses in another series. For example, the devices on the Jupiter network will typically have IP ad-
dresses in the 192.168.253.x series, while the devices on the facility/IT network might have IP addresses in a range such as
192.168.1.x. In these examples, the subnet mask would be 255.255.255.0 for both class C networks.

Jupiter File Server

Router

Remote PC Extended

Remote PC Extended

Facility LANJupiter LAN

Control Module

E
th

er
ne

t 1

E
th

er
ne

t 2

Figure I−1.

Control Panel

Control Module
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Software installation

Software installation is described in the Field Engineering Bulletin supplied with the software. The following is supplemental
information.

1. The Remote PC must have an appropriate IP address (for a Jupiter network, typically in the 192.168.253.x series). The
IP address must not conflict with existing equipment. Note that Jupiter does not support DHCP or domains.

2. Establish an administrator login for the Remote PC that is identical to that used on the existing File Server.

3. Using the administrator login, install Jupiter software using the procedure described in the Field Engineering Bulletin.

4. When you arrive at the menu shown below, select Remote.

Figure I−2.

5. Install Jupiter in the exact same path where JNS was installed on the File Server PC.  Example:  if Jupiter was installed
to “C:\program files\Thomson\Jupiter,” then the Remote PC needs to be directed to the same location (locally of course).

6. Select the local NIC card that will be used to connect to the Jupiter File Server.
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Configuration

1. At the Remote PC, use the same login as before and launch JNS.

2. Go to the existing File Server and verify that at least one of the “JNS servers” (applets) are “connected” (executing).
This is indicated by the green bar above the name of the applet.

The JNS server applets allow the various JNS applications (such as the JNS Control Center) to send and receive data
to and from the File Server and the system controllers.

3. Return to the Remote PC and select “Configure > Remote PC Extended.”

Figure I−3.

4. Enter the IP address of the File Server’s NIC that is on the same network as the Remote PC.

5. Select the Connect button. This will launch one or more of the JNS server applets in the Remote PC.

Note: If you are using Windows XP and receive a “DCOM” error, see “Connecting a Remote PC to a Windows
XP Server” on page I−5.

6. Some or all of the JNS “Remote Applications/Tools” shown on page I−1 can now be executed on the Remote PC as
desired. Executing JNS applications are indicated by the green bar above the name of the application.
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ADDITIONAL NETWORK CONFIGURATIONS

File server − backup PC

As a means of protecting the Jupiter system from File Server failure, a second PC can be installed on the Jupiter network using
the “File Server” option (which causes all software to be installed, including Local−Only Applications shown on page I−1).
A copy of the current Jupiter Configuration set should also be installed by the user and kept current. Following installation,
the PC is normally operated as a Remote unit. Should the main File Server fail, the Remote PC can be reconfigured using
“Configure > File Server” and thus placed on line as the new server.

Load sharing

In systems with a very large number of Remote PCs, system performance may sometimes be improved by distributing the
Jupiter applications among the PCs, thus reducing loading on the File Server. This is the purpose of the “Configuration >
Remote PC” option (as opposed to the “Extended” option). When this configuration is selected, some of the “server applets”
will execute in the Remote PC while others will execute in the File Server. (The JNS applications/tools/utilities will always
execute in the local PC.) However, it should be noted that newer, high−speed CPUs have largely eliminated the need for load
sharing.

CONNECTING A REMOTE PC TO A WINDOWS XP SERVER

If the File Server is running Windows XP and you would like to run remote clients that connect to the File Server, a Local
Security Policy setting may need to be changed. By default, Windows XP will prevent remote clients from connecting.

Open the Control Panel, select Performance and Maintenance, select Administrative Tools, select Local Security Policy,
double−click on Local Policies in the tree−view, and double−click on Security Options in the tree−view. Scroll down the list
of settings to find “Network access: Sharing and security model for local accounts.” Change the setting from “Guest only −
local users authenticate as Guest” to “Classic − local users authenticate as themselves.” You may need to reboot the File Server.
If you still get DCOM errors while connecting, the Administrative Tools /Event Viewer may provide helpful information.

Keep in mind that the username AND password on both the File Server and the Remote clients must be identical. To prevent
unauthorized access, Grass Valley recommends that you use a secure password.
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Appendix J

CP 3000 Control Panel Basic Operation

INPUT TO OUTPUT SWITCHING

The CP 3000† is a full−matrix control panel, designed to route any source to any destination. (However, access to certain
destinations may be limited by the system administrator.)

Looking at Figure J−1, we’ll break the panel up into a couple of groups. The first area is the display window. The top row
in the display window shows you the status of each level in the router for a particular destination.

Using the CLEAR key, the bottom row can be toggled between the first page of input override selections (as shown in  Figure
J−1) and the name of the current output  (Figure J−2).

To the right of the control panel is a keypad; this includes all the numbered and lettered buttons. Directly beneath the keypad
is a row of buttons that have designated functions.

Figure J−1. CP 3000 Switcher control panel with example Status/Override display.

Status for 4 levels

Overrides

VTR

1

CG

2

NET

3

SAT

EJVCR

4

CAM

5

REM

6

FILM

7

PTCH

8

STU

9

FS

AUX TEST

0

MISC SS

A

B

C

D

TAKECHOPLOCKPROT

F4F3F2F1

MORECLRMENULEV

 VTR1 VT1L VT1R VT1T
 BLK  BARS TONE SLNC

Figure J−2. Press CLEAR to toggle to Status/Output display

 VTR1 VT1L VT1R VT1T
 CURRENT OUT  = VTR1

† For complete CP 3000 operating instructions, see page 6−7.
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Figure J−3.
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Looking at Figure J−3, the display window shows the home menu. This includes, in the top row, the status of the video, audio
channel 1, audio channel 2, and timecode levels. In the bottom row, it displays the override selections. These overrides are
selected when you push the function button directly below it. This gives you a one button push in conjunction with the TAKE
button to call up whatever source is in the display column. For example, pressing F1 and then pressing the TAKE  button
would select black as the source to the destination the panel is controlling. Another way of selecting a source is to use the
keypad and then the TAKE  button. For example, pressing VTR  and then 1 and then the TAKE  button would select all levels
of VTR1 as the source.

Since this panel can access any destination (for example, an input to a VTR), you must select the destination that the panel
is controlling. This panel can only control one destination at a time. To select or change the panel’s destination, you press the
MENU  button. Once this button has been pressed, it will change the bottom row of the display (See Figure J−4).

F4F3F2F1

Figure J−4. Page 1 of menu display.

 VTR1 VT1L VT1R VT1T
 STAT SEQ  AUD  OUT

F1  = Status − display output status
F2  = Sequence − select input sequences
F3 = Audio − audio modes
F4 = Output − display/change output
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By depressing the MORE button, you will call up page 2 of the menu. The function buttons change to represent the following:

F4F3F2F1

Figure J−5. Page 2 of menu display.

 VTR1 VT1L VT1R VT1T
 DIAG DEF  PWD  LOG

F1  = Diagnostics − control panel diagnostics
F2  = Define − re−define input overrides
F3 = Passwords
F4 = Logout

By depressing the MORE button, you will call up page 3 of the menu:

F4F3F2F1

Figure J−6. Page 2 of menu display.

 VTR1 VT1L VT1R VT1T
 ID

F1  = ID − display control panel device address

By pressing the MORE button again, you will toggle back to page 1 of the menu.

For the present time, we want to go to page 1 and press the F4 button; this will allow us to change what destination the panel
is controlling. The bottom display row will now show PANEL OUTPUT = VTR2. (See Figure J−7.)

Figure J−7.

 VTR1 VT1L VT1R VT1T
 PANEL OUTPUT = VTR2

Now any selection made from the keypad area of the controller will change the panel’s destination. For example, with “PAN-
EL OUTPUT =” showing, pressing the VTR button, the 2 button, and the TAKE  button, you have now selected the panel
to control what feeds VTR2. Be aware, however, any time the bottom row of the display shows “PANEL OUT =”, anything
you press on the keypad and then press TAKE  will change the destination of the panel.
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Let’s try a simple switch. For example, let’s put VTR1 into VTR2. The first thing you would do when you walk up to a panel
is find out what destination the panel is controlling. To do this, you would look for the “CURRENT OUT = ” message; if you
don’t see it, press CLR until you do.

If you are happy with the output being controlled, we can now change the source feeding our machine. Going to the keypad,
press VTR , 1, and then the TAKE  button. You have now called up VTR1 into your machine. You will notice the top row in
the display window will show VTR1 for the video level and both audio levels.

Another way of calling up a source is to use the override buttons. The bottom row of the display window in the home menu
describes which override each function button represents. By pressing the F2 button and then the TAKE button, you will have
sent BARS into VTR2.

VTR
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NET
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EJVCR

4
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REM

6

FILM

7

PTCH
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TAKECHOPLOCKPROT

F4F3F2F1
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Figure J−8.

 VTR1 VT1L VT1R VT1T
   LOCK   PRESS TAKE

LVTR1 VT1L VT1R VT1T
 BLK  BARS VTR1 VTR2

Lock symbol

Figure J−9.
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LOCK

Now that we have routed something to a machine, we don’t want someone from another panel changing or accessing into
that machine. So how do we take care of this problem? From the home menu, if you press the LOCK button you will see the
display shown in Figure J−8; by pressing the TAKE  button, you will have locked out that destination so that no other source
can be switched into it from anyone else’s panel—or even your panel. You will notice that a flashing L will appear at the very
left hand top corner of the display.

If you wish to unlock it, you must go to the panel that locked it, call up the destination that is locked, and then press the LOCK
and then the TAKE  button from the home menu. To find out which panel has something locked, press the LOCK  and then
the TAKE  button. For a moment, the panel will display in the bottom row which panel has it locked out. For example, it will
read LOCKED BY MON1. This is telling you that the monitor 1 panel has locked out this destination. Remember that any
panel can lock out any destination. By locking out a destination, it must be unlocked before switching even from its own panel.

PROTECT

If you wish to switch from your own panel but protect the output from other panels, then you can use the PROT button. The
protect function is toggled on and off exactly like the lock function using the PROT button.

[Grass Valley would like to thank Mr. Howard Lukk for help in preparing this tutorial.]



CP 3000 Basic Operation

J−6 CM 4000 Installation and Operating Manual



K−1CM 4000 Installation and Operating Manual

Appendix K

Preparing and activating a replacement CM 4000

As discussed on page 2−8, CM 4000s can be installed as a redundant pair, so that failure of one unit will result in control being
taken by the second. A third unit can be kept in reserve and, in the event of a failure, have its address altered and be installed
to provide a quick replacement for the failed unit and restore system redundancy. See Figure K−1.

CC−2010 Matrix (Cross-
point bus) cables

House sync required for vertical
interval switching.

Routing
switcher

CM 4000
Redundancy
Cable

House time
code

Crosspoint
bus port

BOP 4000 Break
Out Panel

Hub

10/100baseT
Jupiter LAN

Replacement CM 4000

Figure K−1. A CM  can be kept in
reserve, ready to swap with a
failed unit.

CM 4000

CM 4000
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REPLACING A FAILED UNIT

A fault condition should be indicated by a “00,” “01,” or “FF” indication on the front panel LED display, or, in the case of
a failed power supply, no lamps illuminated. Control should have switched to the other CM by this point. Check that it has
by looking for the green Activate lamp. Then proceed as follows:

1. If necessary, switch control manually to the good unit by pressing the Activate button.

Figure K−2.
Activate
button

DOWN
RESET

ACTIVATE+3V
+5V
−5V

+12V
−12V

UP NEXT SELECT

2. De−power the faulty CM 4000.

3. Before installing the replacement unit, change its physical Ethernet address (MAC address) to match that of the failed
CM 4000:

Caution: Changing the physical address of the CM 4000 can have undesirable results if not done properly.  It
is very important to maintain strict control of the addresses of all units in and out of the system to avoid net-
work conflicts.

The physical Ethernet address is stored in a serial EEPROM chip.  The data in this chip is validated with two
checksums.  If either checksum is invalid, the Ethernet chip will fail to initialize and will not function.  Be-
cause of this, it is very important that during the EEPROM write procedure, the CM 4000 is not reset or power
interrupted until the write cycle is completed.

a. On the replacement CM, connect a terminal to the front console port and power up the unit.  It is stressed that this
procedure is done with the replacement CM 4000 out of the system where there can be no address conflict.

b. Stop the boot process at the ‘Press any key to stop auto−boot.’ prompt.

Press any key to stop auto−boot...
1

c. At the VxWorks boot prompt, enter ‘N’ and then press ‘enter’.

[VxWorks Boot]: N [ENTER]

d. Wait for the EEPROM memory to get read:

Reading EEPROM ..................................
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The current Ethernet address will be displayed:

Current Ethernet Address is: 00:40:53:12:34:56

The first 3 bytes of the Ethernet address are the manufacturer’s ID and cannot be changed. The fourth byte will
be shown with an option to change it:

00− 00
40− 40
53− 53
12− _

e. Modify the last 3 bytes to match those of the failed CM 4000.

Enter the new digits and press Enter to change Byte 4 or press Enter alone to keep the current byte.  In this example,
the 4th byte is changed to “21.”

12− 21 [ENTER]

Repeat the process for the remaining two bytes.  In this example, the 5th byte will be kept the same, and the 6th

byte changed to ”65”:

34− [ENTER]
56− 65 [ENTER]

f. The EEPROM will now be re−written.  During this time, do not reset the CM 4000 or allow the power to reset.

Writing EEPROM .....

When the write cycle is complete, the new current Ethernet address will be displayed with the vxWorks prompt:

New Ethernet Address is: 00:40:53:21:34:65
[VxWorks Boot]:

Make a note of this number  (e.g., by writing it on the CM back panel).

g. Remove power from the CM 4000.

4. Make sure that power has been removed from the faulty CM 4000, then disconnect it from the system while noting cable
positions.

5. Install, connect, and power up the replacement CM 4000.

The replacement CM 4000 will boot up automatically. The other CM 4000 should remain active throughout this opera-
tion.

6. Confirm that the system is still operating normally by using a Jupiter control panel.

Ensure that the status of all crosspoints on the switcher is reported on the panel.
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7. To verify that the replacement unit is ready for use:

a. Go to “JNS Applications > Control Center > Bootp” and check that the correct MAC address is being used for the
replacement CM. Also go to the “TFTP Status” tab and look for an indication that the “transfer succeeded” (“100%
complete”). If these indications are correct, proceed as follows:

b. Swap control to the replacement CM 4000 by pressing the Activate button.

c. Confirm system operation.

d. Assuming all is well leave the replacement CM 4000 in control of the system. The installation is now complete.

Should problems be experienced return control immediately to the opposite CM 4000. De−power the replacement CM 4000,
check all cabling, and reapply power. Should this fail to eliminate the fault, it may be necessary to download a new configura-
tion set; refer to “Validating, Compiling, and Activating (Downloading) a Configuration Set” on page 5−13.

If problems persist, contact Grass Valley Technical Support.
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Appendix L

Special Configuration Requirements: Venus DM 400/400A Data Matrix Switching

Note 1: The following discussion applies only to older model Venus switchers equipped with DM 400 or DM 400A
Data Matrix boards. Newer model Venus systems are equipped with the DM 400B Data Matrix boards; these
boards have software−configurable rear−panel pinout functions and do not require crossover or Y−line cables.§

The Jupiter system can be used to control RS−232, RS−422, and RS−423 data switchers.

DM 400/400A data switchers employ a “reverse” switching technique, where one level is used to switch data from a control-
ling device (such as an editor) to a controlled device (such as a VTR); a second level is used to return data to the controller.
The return path is switched automatically by the control system.

The following discussion applies specifically to a Venus DM 400/400A data matrix switchers in an RS−422 machine control
application; however, the same concepts generally apply to other Grass Valley Crosspoint Bus data switchers and protocols.
An important difference is that the Venus DM 400/400A data matrix switcher uses the same physical level number for both
the forward and reverse levels; whereas the TVS/TAS series data matrix switchers use different physical level numbers.

HARDWARE CONNECTIONS

For complete information regarding jumper settings and cabling, refer to the technical manual supplied with the switcher.
An example of an RS−422 Venus system is shown on page L−2.

Note 2: As shown on page L−2, the cable used to connect the control device (e.g., editor) to the DM 400/400A
switcher is a cross−over type cable.

Note 3: If you wish to use or build a cable for the editor that has the standard “straight−through” pin−outs, you may
elect to use this straight−through cable with a short crossover cable or connector. The short crossover cable/con-
nector could be attached permanently to the Venus rear panel.

§ Type and model of switcher card is shown on front edge of printed circuit board.
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Figure L−1. Example of  DM
400/400A Data switching
system.
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Figure L−2. Pinouts for system shown in Figure L−1 .
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SWITCHER DESCRIPTION TABLE

An example of a Switcher Description table for a DM 400/400A data matrix switcher is shown in Figure L−3. This table corre-
sponds to the system shown in Figures L−1 and L−2.

In this example, a special entry in the “Switcher” column (“DATA”) is used for the data router levels; this forces the Jupiter
software to create Switcher Input and Switcher Output tables that are separate from those used for other switcher levels (Fig-
ure L−6).

Note 1: A limitation in the present software requires that the entries in the “Switcher” column for the data router
levels must be the same as, or come alphabetically before, all other names used in the Switcher column. In Figure
L−3, this rule is satisfied because the letter “D” in “DATA” comes alphabetically before the letter “M” in “MAIN-
ROUT,” and before the letter “O” in “OLDROUT.” This does not mean that the entries must be in alphabetical
order within the table itself.

For DM 400/400A applications, the forward and reverse levels have the same physical level number (“16”). Reverse switch-
ing is enabled for the reverse level (“R”); and, the reverse level is made to follow the forward level (“DATA” and “FOR”).
The “Option” entry (normally “E”) is described starting on page 5−45.

Note 2: For DM 400/400A data switchers, the entry for “#In” must be “193.” This is true regardless of the actual
size of the switcher. †

The Switcher Description table is described in more detail starting on page 5−35.

Figure L−3.

Name chosen for data router must sort alphabetically before  names used
for other switchers (e.g., “D” comes in the alphabet before “M” and “O.”

1

Switcher Description

MAINROUT M1 64 64 1 Binary None

2 MAINROUT M1 64 64 2 Binary Left

3 MAINROUT M1 64 64 8 Binary Right

4 MAINROUT M1 32 32 4 Binary None

VIDEO

LEFT

RIGHT

TC

Switcher VI RV Board #In #Out PLvL Follow Level Driver 3 LI 3 LO Option AudioLevel
DM 400

MC Off Time

5 DATA M1 193 32 16 Binary EFOR

6 DATA M1 193 32 16 FOR (DATA) Binary EREV

7 OLDROUT M1 10 10 3 TVS ProtVIDEO

† This is because the “#In” must always be one greater than the largest number used in the CP Input table. The largest number
used in the CP Input table will always be “192” (for the “safe” input, as described on page 5−32).
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As an alternative scheme, it is possible to use the same entry in the “Switcher” column (for example, “MAINROUT”) for
all levels, including the data levels (Figure L−4). In this case, the Switcher Input and Switcher Output tables will have columns
for all switcher levels.

Figure L−4.Name chosen for data router must sort alphabetically before  names used
for other switchers (e.g., “M” comes in the alphabet before “O.”

1

Switcher Description

MAINROUT M1 64 64 1 Binary None

2 MAINROUT M1 64 64 2 Binary Left

3 MAINROUT M1 64 64 8 Binary Right

4 MAINROUT M1 32 32 4 Binary None

VIDEO

LEFT

RIGHT

TC

Switcher VI RV Board #In #Out PLvL Follow Level Driver 3 LI 3 LO Option AudioLevel
DM 400

MC Off Time

5 MAINROUT M1 193 32 16 Binary EFOR

6 MAINROUT M1 193 32 16 FOR (MAINROUT) Binary EREV

7 OLDROUT M1 10 10 3 TVS ProtVIDEO

Note: A limitation in the present software requires that the entries in the “Switcher” column for the data router
levels must be the same as or come alphabetically before all other names used in the Switcher column. In Figure
L−4 this rule is satisfied because the entry “MAINROUT” in rows 5 and 6 is the same as the entry in rows 1 through
4, and because the letter “M” in “MAINROUT” comes alphabetically before the letter “O” in “OLDROUT.” This
does not mean that the entries must be in alphabetical order within the table itself.

For a discussion of the ”DM 400 Off Time” entry, see page 5−47.

Figure L−5. Example
of  DM 400/400A Data
switching  system.
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selected

=
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“D−1”
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Suggested
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control panel use.

=“C−1”
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SWITCHER INPUT AND OUTPUT TABLES

Note: Since the software depends on logical numbers, which are actually row numbers on these tables, edit-
ing one of the the tables can easily break the logical connection between them. For example, if new inputs
are added to the top of the Switcher Input table, all following rows will be pushed down and assume new
row (logical) numbers. To minimize this difficulty, Grass Valley recommends that all NEW entries be made
at the end of the tables.

In a reverse switching scheme, a device feeding the “forward” level must use a logical input number on the forward level that
is the same as its logical output number on the “reverse” level. In other words, the row numbers must match. See Figures L−5
and L−6.

Figure L−6.

1 SAFE

FOR

2 EDITOR

3 VCR1D

4 VCR2D

REV

192

002

004

192

002

004

Switcher Input − DATA

003 003

Logical
input/output
numbers are
identical

Logical input “1” should be re-
served for use as the “safe input”
for point−to−point applications, as
described on page 5−45.

“Safe” is used in row 1 as a place
holder to maintain relative row
number positions.

Name
Logical Input

1 SAFE

FOR

2 EDITOR

3 VCR1D

4 VCR2D

REV

002

004

Switcher Output − DATA

003

Name
Logical Output

Conversely, a device feeding the “reverse” level must use a logical input number on the reverse level that is the same as its
logical output number on the forward level. See Figures L−5 and L−7.

Figure L−7.

1 SAFE

FOR

2 EDITOR

3 VCR1D

4 VCR2D

REV

192

002

004

192

002

004

Switcher Input − DATA

003 003

Logical
input/output
numbers are
identical

Logical input “1” should be re-
served for use as the “safe input”
for point−to−point applications, as
described on page 5−45.

“Safe” is used in row 1 as a place
holder to maintain relative row
number positions.

Name
Logical Input

1 SAFE

FOR

2 EDITOR

3 VCR1D

4 VCR2D

REV

002

004

Switcher Output − DATA

003

Name
Logical Output
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CP LEVEL SET

In data router applications, the reverse level should be entered on the CP Level Set(s), but should not be set to Switch, i.e.,
an “N” should be entered in the “Switch” column.

CP INPUT AND OUTPUT SETS

The input and output names in the previous tables must be assigned to Category/Entry selections. In the following examples,
intended for use with a CP 3000−type panel, the “C” (for “controller”) category button will be used to select the Editor and
the “D” (for “destination”) category button will be used to select the VCRs .

1

Input Set — KXYZ−INP

Category Entry Mnemonic Input

Test 1 BARS BARS

2

3

VTR 1 VT01 VT014

5

Test 2 TONE TONE

Test 3 TC TC

VTR 2 VT02 VT02

VTR 3 VT03 VT03

VTR 4 VT04 VT04

VTR 5 VT05 VT05

C 1 EDITOR EDITOR

6

7

8

n

Figure L−8.

Auto
Mnem

Figure L−9.

1

Output Set — KXYZ−OUT

EJ 1 NEW1 NEW1

2

3

EJ 2 NEW2 NEW2

EJ 3 NEW3 NEW3

Category Entry Mnemnonic Level Set ButtonAuto
Mnem Output

Logical

n

n

D 1 VCR1 VCR1D

D 2 VCR2 VCR2D

OPERATION

In this example, the operator would select a destination such as “B−1” (VCR 1); then a source such as “C−1” (the editor). When
TAKE is pressed the switch is made in the forward level; and, VCR 1 is automatically switched back to the editor in the reverse
level.
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POINT−TO−POINT DATA SWITCHING OPTIONS

(“Normal/Advise/Enforce”)

In most reverse data switching applications, one of the point−to−point Options (“Advise” or “Enforce”) should be selected
for the “controller level.” The controller level is defined as the level receiving data from the editor or other control device.
For more information, see page 5−45.
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Y LINE TABLE − VTR CONTROLLER/TRIBUTARY SELECTION

Note: These instructions assume that the installer has read “Data Matrix Installation” in Section 3 of the Venus
Routing Switcher System Technical Manual.

Some VTRs can act as controllers or tributaries. These can be connected with a “Y” cable to two Venus ports— one for use
when the VTR is a controller, the other when the VTR is used as a tributary (see Figure L−14). If the VTR is operated only as a
controller, or only as a tributary, then a “Y” cable will not be needed; the cable can instead be one of those shown on page L−4.

The following tables correspond to the system shown in Figure L−14. The basic rules for these tables have already been de-
scribed (starting on page L−3).

1 SAFE

FOR

2

VR1−M3

VR2−M

REV

192

003

001

003

Switcher Input − DATA

1

Switcher Output − DATA

SAFE

Security S−T

−

FOR

016

REV

2

VR1−M − 0013

VR2−M − 003

4

5

VR1−S − 000

VR2−S − 002

001

4

VR1−S

3

VR2−S 002

000

002

000

5

192

Figure L−10.

Figure L−11. Figure L−12.

Name
Logical Input

Name
Logical Input Pass

word

1

Switcher Description

2

Switcher VI RV Board #In #Out PLvL Follow Level Driver 3 LI 3 LO Option AudioLevel
DM 400

MC Off Time

DATA VM1 193 32 16 Binary EFOR

DATA VM1 193 32 16 FOR (DATA) Binary EREV

The Y Line table informs the system controller of a level, input, and output that have a Y line installed. Notice that each Y
line requires two entries, and that the “crossover” ports (the “M” ports) are listed as inputs on the forward level and outputs
on the reverse level:

Figure L−13.

Drop−down menu shows
“Switchers” and “Names” from

Switcher Description table
(Figure L−10). Select

appropriate data switcher.

Select the appropriate name from those
already entered on the Input (Figure
L−11) or Output (Figure L−12) table.

1

Y Line Table

Level

REV (DATA)

2

FOR (DATA)

Input

VR2−S

Output

VR2−M

VR2−M VR2−S3

REV (DATA)

4

FOR (DATA)

VR1−S VR1−M

VR1−M VR1−S

Logical Logical
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Rx

Tx

VR1
being used as Master

VR2
being used as Slave

Rx

Tx

Figure L−14.  Example of Sony Master/Slave VTR ap-
plication showing forward and reverse switcher levels.

“VR1−S”

Port 1

Port 2

Venus Data Matrix

Port 3

For pin−outs of these
cables see Figure L−2

on page L−2.

Controller

Tributary

Darker lines indicate
active signal paths

when VR 1 is
controlling VR 2.

Forward data
switcher level

“FOR”

Reverse data
switcher level

“REV”

Port 0

“VR1−M”

“VR2−S”

“VR2−M”

“VR1−S” is suggested as the name for VR 1
when used as a Slave. “VR1−M” is suggested
as the name for VR 1 when used as a Master.

“D−1”

“C−1”

“D−2”

“C−2”
Suggested

Category/Number for
control panel use.
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CP Input and Output Sets

The input and output names in the previous tables must be assigned to Category/Entry selections. In the following examples,
intended for use with a CP−3000−type panel, the “C” (for “controller”) category button will be used to select the master VCR
and the “D” (for “destination”) category button will be used to select the slave VCR.

Figure L−15.

1

Input Set — KXYZ−INP

C 1 VR1M VR1−M

2 C 2 VR2M VR2−M

Category Entry Mnemonic LogicalAuto
Mnem Input

1

Output Set — KXYZ −OUT

D 1 VR1S VR1−S

2 D 2 VR2S VR2−S

Category Entry Mnemnonic Level Set ButtonAuto
Mnem Output

Logical

Operation

In this example, the operator might select a slave VCR destination such as “D−2” (VR 2); then select a master VCR source
(i.e., a controller) such as “C−1” (VR 1). When TAKE is pressed, the VR 1 transmit (Tx) signal is switched through the cross-
over cable to VR2; and, the VR 2 Tx signal is automatically switched back to VR 1. VR 1 is therefore the master and VR 2
the slave. If the operator selected input “C−2” and output “D−1,” then VR 2 would be the master and VR 1 the slave.
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Appendix M

CP 3000/3010 Output Set Work Sheet
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Appendix N

Jupiter ASCII Communications Protocol

Revision E − November 10, 2005

Hardware connections for an external computer are shown on page 2−88.

Set−up in the Jupiter Control System File Server includes defining one or more ports as being ASCII in the Serial Proto-

col Table (page 5−30).

The control computer is identified on the MPK Devices table (page 5−123). You will need to define each port as being

type “Serial”, and give each port a CP Input set, CP Output Set and CP Level set. These sets will determine which levels,

inputs, and outputs are available to each ASCII port to control and status.

The ASCII Computer Interface is assigned to a system controller port and uses a simple ASCII data format defined be-

low. The serial protocol defaults to 9600 Baud, 8 Data Bits, No Parity, and 1 Stop Bit. Baud rates of 2400, 4800, 19.2K

and 38.4K are also user−configurable from the Jupiter Control System File Server. The control port uses XON (0x11) and

XOFF (0x13) to control command pacing if necessary.

All commands are in upper case ASCII. Space (0x20) characters are optional and will be ignored. Each command is fol-

lowed by a carriage return (0x0D). If a line feed (0x0A) is included it must follow the carriage return.

The controlling computer must take care to wait for a ZY or ZN response after each command before attempting to send

a subsequent command. Failure to do so will result in a ZN response, and possibly an XOFF condition. If switcher status

is received, wait for all levels to be statused before sending another command.

Here is a key to help you understand the following command descriptions:

OOO  −−−>          Router Switcher OUTPUT. This corresponds with the “Selection” number defined in this AS-

CII port’s CP Output Set. The range is from 000 to 999. (Previous releases had a range from

000 to 249.)

III  −−−−−−−>      Router Switcher INPUT. This corresponds with the “Selection” number defined in this ASCII

port’s CP Input Set. (Previous releases had a range from 000 to 249.)
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LLLLLLL −−−>   Router Switcher LEVELS. This corresponds with a logical position in this ASCII port’s CP

Level Set. The range is from 1 to 7. For example, 1 refers to the first entry in the CP Level

Set, and 5 refers to the fifth entry in that same set. If no levels are specified, then the take is

assumed to apply to all levels defined in that set. Level number entries are NOT position−de-

pendent.

ASCII General Purpose Commands

ZA Acknowledge This command is used to see if the ASCII interface exists

and is running. A response of ZA  is returned whenever a

ZA  is received.

ZZ Reset This command forces the ASCII controller to reset. This

causes the interface to cancel all previous ZP, ZV, and

ZW  commands. A ZX  response is returned to the external

computer upon command completion. This ZX  is also

returned whenever the interface is manually reset.

ZY Command Accepted This response is returned after the serial port has

(ACK) successfully parsed the command and in the case of a

switch command has successfully issued the TAKE to the

system and received a switch response back from the sys-

tem. This does NOT mean that the command was success-

fully executed. The remote computer should not issue a

new command until receiving a ZY  or ZN from the cur-

rent command. The amount of time for the response will

vary depending on system complexity and current system

activity. Also the number of switches involved in the com-

mand will affect the amount of time it takes to receive the

ZY  response. Multiple switches sent in one command

may result in ZR response(s) being returned before the

ZY  response.

ZN Command Rejected A ZN will be issued when a condition occurs where

(NAK) the current command cannot be executed. A ZN response

can be issued for several reasons such as an invalid com-
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mand, an invalid command format, or an invalid input,

output or level. Invalid inputs, outputs and levels are

logged to the system logger. Also if the system is busy a

ZN will be issued followed by XOFF. When it is again

ready for the next command a XON will be issued. Note

that after the XON, response(s) from the prior command

may be issued (e.g. ZR response(s)).

Router Switcher Control and Status Commands

ZSOOOIIILLLLLLL Switch Request This command causes the interface to issue a TAKE

Switch Request to the routing switcher control system and

affects a single routing switcher output. If no levels are

specified, then ALL defined levels are assumed.

Note: Passwords are not honored by automation protocol

handling.

A remote computer can send a command with multiple

Switch Requests (older releases do not have this capabili-

ty). A single command can be up to 180 characters long

which allows switching of from 12−22 outputs (depending

on the specified levels). An example of a multiple Switch

Request follows:

   ZS00000112ZS00100212ZS00200312<CR>

This example command would switch outputs 0, 1, and 2

on levels 1 and 2.

ZROOO Status Request This command requests current switcher status for a single

output. The response is in the format:

                   ZROOOIIILLLLLLL.

If the status for the output is “split”, multiple responses

will be returned.

ZWOOO Watch Output This command causes the interface to watch the specified

output for any changes and report such changes. A request

to watch output “999” is a request to watch all defined
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outputs in that port’s serial output set. All responses are in

the “ZR” format described above. When issued, this com-

mand also may result in an immediate ZR response for the

requested output(s). No ZR response(s) will be returned if

the requested output(s) do not have any inputs assigned to

them.

ZPOOO Lock Output This command LOCKS the specified output from being

changed by any system control device.

ZVOOO Protect Output This command PROTECTS the specified output from

being changed by any other system control device.

ZUOOO Unlock Output This command removes the LOCK or PROTECT from the

specified system output. If another system control device

or interface locked or protected this output, this command

will fail.

ZJOOO Report Lock Status This command will return a code based on which kind of

system control device or interface LOCKED or PRO-

TECTED the specified output. If the output is not locked

or protected, no response will be sent. The response codes

are as follows:

ZJ000 Jupiter Control Panel

ZJ001−004 Party Line Control Panel

ZJ999 THIS ASCII INTERFACE

Note: Lock status returned for the first level only in the

CP Level Set for this ASCII port.
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Appendix O

Venus Monitor Configuration

When used with a Jupiter control system, the Venus output monitoring hardware allows verification of switcher performance
without interrupting normal operations. A separate switching system is used to switch the Monitor Output to any output of
the switcher.

Using a control panel, the operator picks an output as usual—in this case, the Monitor Output. The operator then selects an
input, but this input is actually one of the switcher outputs.

QC 
STATION

CROSSPOINT
BUS

CONTROL SYSTEM

MPK BUS

Audio and video from
Monitor outputs

SWITCHER CONTROL
PANEL

Figure O−1. Venus monitoring overview.

HARDWARE INSTALLATION

The number of the Monitor Output, which is used during software configuration, is determined by factory−set jumpers on
the switcher motherboard. At the output card slots, the output number used is the output number for the output monitor. In
larger, multi rack systems, all output cards are set to the same output number. By convention, this number should be the next
output number range above the last real output in the system. On a 352 by 64 switcher system, the output numbers would be
from 0 to 63. The output monitor would then be 64.  In all cases, the monitor output number should be confirmed by checking
the documentation package supplied with the switcher.

Cabling

For details concerning external cable connections for output monitoring, please see the Installation Section of the Venus
Installation Manual, part number 04-044592-004.

VM/DC 400 Combiners

The Venus Installation Manual also describes installation of the VM 400 Analog Video Monitor Combiner and the DC 400
Digital Video Monitor Combiner.
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SOFTWARE CONFIGURATION

Figure O−2 is a block diagram of a Venus 64 x 64 switcher and its built−in 64 x 1 monitor switcher. In this example, the monitor
output (lower right corner) has been set with a jumper to the highest output number plus 1, or “64.” The crosspoint marked
“x” means that the monitor output has been switched to physical input 0 of the monitor switcher, which corresponds to physi-
cal output 0 of the Venus itself.

Various software tables must be used to establish the switcher as having 65 outputs; to assign a name and category/entry num-
ber to the monitor switcher output; and to assign a name and category/entry number to each monitor switcher input.

64 x 64 Venus switcher

2 30 41

5

0

1

2

3

4

6

7

5

0

1

2

3

4

6

7

“Out0”

“Out1”

“Mon”

A 0

A 1

“Out3” A 3

“Out2” A 2

Input
name

Physical
input

number

Category/
number

selection

“Out4” A 4

“Out5” A 5

“Out6” A 6

“Out7” A 7

63

63
63 “Ou63” A 6

64

Router inputs

Router
outputs

Monitor output

3

Misc 0

Internal 64 x 1 monitor
switcher

Figure O−2. Example of Venus monitoring system.

Output
name

Physical
output

number

Category/
number

selection

1. On the Switcher Description table, enter the Monitor Output Number (as shown in the documentation supplied with the
switcher) as the number of outputs for all levels. In this example, the number of outputs would be 65, even when some
of the levels have less than 64 outputs. See Figure O−3.

2. At the end of the Switcher Output table, create a name for the monitor output, and enter the corresponding physical out-
put number (Figure O−4). On an Output Set table, enter the output name and a Category/Entry number (Figure O−5).

3. At the end of the Switcher Input table, create names for the monitor inputs, and enter the corresponding physical input
numbers (Figure O−6). On an Input Set table, enter the input names and a Category/Entry number for each (Figure O−7).
Note the use of input names and mnemonics such as “OUT0;” these are to help the operator find the intended router
output for monitoring.
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Figure O−3.

DM 400
Switcher Level VI RV MC Board #In #Out PLvl Follow Level Driver 3 LI 3 LO Option Audio Off Time

1 MainRout VIDEO M1 64 65 1 Binary NONE
2 MainRout LEFT M1 32 65 2 Binary LEFT
3 MainRout RIGHT M1 32 65 6 Binary RIGHT
4 MainRout TC M1 16 65 3 Binary NONE

Switcher Description

Logical Output Pass
Name Security S−T Word VIDEO LEFT RIGHT TC

63 VT15 S 63 63 63 63
64 MON S 64 64 64 64

Switcher Output − MainRout

Figure O−4.

Output Set — QC−OUT

1 MISC 0 MON MON

Auto Logical
Category Entry Mnem Mnemonic Output Level Set Button

Figure O−5.

Logical Input
Name VIDEO LEFT RIGHT TC

63 VT15 063 063 063 063
64 OUT0 000 000 000 000
65 OUT1 001 001 001 001
66 OUT2 002 002 002 002
67 OUT3 003 003 003 003

127 OU63 063 063 063 063

Switcher Input − MainRout

Input Set —QC−INP

1 A 0 OUT0 OUT0
2 A 1 OUT1 OUT1
3 A 2 OUT2 OUT2

63 A 63 OU63 OU63

Auto Logical
Category Entry Mnem Mnemonic Input

Figure O−6.

Figure O−7.
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OPERATIONAL SEQUENCE FOR MONITORING

The following example assumes that the Venus has been set up as described above.

1. Using a control panel such as a CP 3000, select the monitor output of the switcher for control. In this example, the opera-
tor would select output “MISC 0.”

2. Select one of the switcher outputs to be monitored. In this example, the operator would select category “A,” then an entry
number from 0 to 63.



P−1CM 4000 Installation and Operating Manual

Appendix P

CE 3000 Matrix Control / PL 3000 Party Line Interface
SC 3000 Serial Control / VG 3000 Video Display / Status Generator

These controller boards, which were part of  the original BCS 3000 Control System, have been replaced by the VM/SI 3000
and CM 4000 Control Systems. As of Jupiter software release 7.1.0 they are no longer supported and should not be used in
systems with current software.
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Appendix Q

PS 300 110/220 VAC Power Adaptor Kit Installation Instructions

This kit (assembly part no. 44−046442−001) provides all hardware needed to modify one CP 300 Series control panel for
direct connection to a 110/220 VAC power line. The CP 300 Series includes the CP 300, CP 310, CP 320, CP 328, and CP
330.

The kit includes an add−on chassis (which mounts on the rear of the panel) and a detachable, 3−prong AC power cord. The
chassis measures approximately 12 in. wide x 5 in. deep x 1−3/4 in. high and includes a TE/PE grounding strap and fuse
holder.

MOUNTING PROCEDURE

1. Disconnect control panel, remove from rack.

2. Remove eight screws from rear of control panel as indicated in Figure Q−1.

Figure Q−1.

3. Open top cover of PS 300 add−on chassis.

4. Using the eight screws provided, attach top cover of add−on chassis to rear of control panel.

5. Insert DC plug and MPK 9−pin D connectors from add−on chassis into their respective connectors on the control
panel.  Secure the 9−pin D connectors with the screws provided (the ribbon wires will have a half−twist when
finished).

6. Slide lower half of add−on chassis into position. Secure with twelve #4 counter−sunk screws (three on the top, three
on the bottom, and three on each side).
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7. Test power supply by applying power and noting lamp test.

8. Test MPK connections by attaching to Jupiter system controller and verifying operation through each connector.

For more information about the MPK cables, please refer to page 2−63.
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Appendix R

Status and Error Codes

CB 3000 CROSSPOINT BUFFER AND INTERFACE 
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OUTPUT BUS FAULT 0−7

RED LEDS RED LEDS GREEN LEDS

OUTPUT DRIVRS A OR B ACTIVE

ON = A       OFF = B

FAILURE ALARMS 3 SWITCHES NOT
ACCESSIBLE THROUGH

FRONT PANEL

Figure R−1. CB−3000 front panel status window.

The window on the front of the chassis allows the fault indicators on the front of the CB−3000 card to be viewed. (See Figure
R−1) Beginning at the left side of the window, the first eight RED LEDs are DS1 through DS8, the Output Fault Memory
LEDs. These LEDs are normally off. If any of the LEDs are on, a fault has occurred at some time on the indicated crosspoint
bus output.

The next group of three RED LEDs are the INPUT_FAILURE, OUTPUT_FAILURE, and FAN_FAILURE LEDs,
respectively. These LEDs are normally off. An on condition indicates the fault described by the LED name.

Three local changeover switches on the front of the CB−3000 card are not accessible from the front panel. They are the local
equivalent to the front panel pushbuttons.

The eight GREEN LEDs at the right side of the display window are Output Configuration LEDs DS12 through DS19. They
indicate the A output drivers are active on their respective outputs, 0 through 7. These LEDs are normally ON, indicating
the default A position. Any LED that is OFF indicates that its respective output has switched to the B driver position.
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CM 4000 SYSTEM CONTROLLER BOARDS 

Startup and shutdown codes

Compiled: May 04 2001, 14:19:49
CVS tag: COMBO_6_1_0.

Startup Codes

Code Description

00 Advance to next code in sequence

01 Starting up the system

0B Initializing the bootp client

0C Initializing the control center client

10 Initializing the time keeper

20 Initializing the router status

28 Initializing the switch processor

30 Initializing the router switcher

40 Releasing application tasks to run

Shutdown Codes

Code Description

E0 Shutting down the system

E4 Suspending applications tasks

E8 Abdicating control to slave board

EC Shutting down serial ports

F0 Saving router status

F4 Closing the switch log

F8 Closing the event log

FF The system is stopped

Other Codes

Code Description

DE A critical disk error occurred

CM 4000 front panel error codes

Compiled: May 04 2001, 14:19:49
CVS tag: COMBO_6_1_0.

Message
Number

Short message / Detailed description

01 Logging configuration version is %s.
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This message is logged anytime the log file is changed. It identifies the version of the logging con-
figuration so that the log viewer knows how to read the files.

02 Logger Error.

This is a generic message for logger errors. These messages will typically only get logged to the con-
sole. This message is typically serious and warrants technical support.

03 Video SYNC input lost.

The board could no longer detect a valid video SYNC reference. Check to make sure that the SYNC
cable is properly connected to the board and that the SYNC source is still active. If SYNC is not re-
stored, frame−accurate operations will not be possible.

04 Time code input lost.

The board could no longer detect a valid time code signal. Check to make sure that the time code
cable is properly connected to the board and that the time code source is still active. Also insure that
video SYNC is connected to time code generator. If time code is not restored, frame accurate opera-
tions will not be possible.

05 Ethernet interface %s inactive for %d seconds.

The board could no longer detect activity on the ethernet interface. Check to make sure that the LAN
cable is properly connected to the board and that it is still connected to an active network. If the
LAN is not restored, it will not be possible for the board to communicate with the rest of the system,
resulting in loss of status or control from other LAN devices.

06 Unconfirmed and unasserted takes on xpt (crosspoint) bus.

The board attempted takes on the xpt bus, but the takes were unconfirmed and not asserted. This
usually indicates an open connection to the router or that the crosspoints were not valid for the
router. Check to make sure that the xpt bus cable is properly connected. If this does not fix the prob-
lem, double check the router’s configuration.

07 Video SYNC locked to %s.

The board has locked to a valid SYNC reference. When this occurs, SYNC is properly connected
and working. However, verify that the SYNC standard is correct for the system.

08 Time code acquired.

The board detected a valid time code signal. When this occurs, time code is properly connected and
working.

09 Unexpected jump in time code to %02x:%02x:%02x:%02x.

The time code input has jumped to a value that is not continuous with the current time line. This
may be expected if the input was just acquired or the time code generator was set to a new value.
Since the video time line was adjusted abruptly, some deferred events may be invalid. If this mes-
sage occurs without cause or the time code value is unreasonable, check the generator and its con-
nection to the system.

0A Ethernet interface %s appears active.

The board detected activity on the ethernet interface. When this occurs, the ethernet is properly con-
nected and working.

0B Unable to initialize udp socket.

The system was unable to initialize the ethernet connection. This is typically a critical error and will
result in lack of communication with other systems.

0C Output %d, level %d is locked.
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An attempt to switch the indicated output failed because it was locked.

0D Output %d, level %d is protected.

An attempt to switch the indicated output failed because it was protected.

0E Failed to change from configuration %s to %s.

The system failed to change the configuration. The system will continue to function, but with the old
configuration set. Check the new configuration set and try again.

0F SNTP client error %s for server %s

The application could not synchronize its internal POSIX clock with the remote server using the
Simple Network Time Protocol (SNTP). The time management software will attempt to perform
synchronization periodically to maintain the long term accuracy of its internal POSIX clock. Note
that the POSIX clock is not the same clock used by the system to manage frame−accurate operations.
That clock, known as Video Time, is genlocked to the video SYNC reference. The POSIX clock is
used as a reference for Video Time when the schedule permits an adjustment. No action needs to be
taken on this event, unless the remote SNTP server is the only source of trusted time and several
consecutive failed attempts have been logged. Check to make sure the SNTP server is available over
the network and its NTP service is running correctly.

10 Error %d getting status back from router.

The system failed to read status from the crosspoint bus. This is typically a critical error.

11 Mismatch in status count, %d received, %d expected.

The switch count received back from the router does not match the expected count. This typically
indicates a critical software error.

12 Could not take xptStatusSem semaphore!

The system failed to communicate with the crosspoint bus. This is typically a critical error.

13 %s: Actor never ran.

The command scheduler controls all commands, which are known as actors. This message indicates
that the actor did not execute. This may be because there was not enough time to allow it to run.
This should not effect other commands.

14 Reinitializing status because %s.

Router status has been reinitialized due to a request for a PMEM clear, an adjustment in the configu-
ration, or a change in the application.

15 Standby board, status will synchronize with the master.

The board is currently the slave board in a redundant pair. Status must be initialized by listening to
the crosspoint bus refresh takes.

16 Cannot access status file \”%s\”, error 0x%X: %s.

The current router status is kept in a directory on the hard drive. A file in this directory could not be
accessed. This may indicate a problem with the disk drive.

17 Cannot create status directory \”%s\”, error 0x%X: %s.

The current router status is kept in a directory on the hard drive. This directory could not be created,
which may indicate a problem with the disk drive.

18 Unable to initialize %s component.

The application was unable to initialize a component. This is usually a fatal error.
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19 Maximum number of status observers exceeded, only %d can be attached.

The system can only handle a limited number of observers and has reached maximum capacity.

1A Failed to notify switch requestor (named %s) of a status change.

The status that should have been returned to the switch requestor could not be scheduled. This im-
plies that the system is overloaded, but it should not happen on a properly balanced system.

1B Error %d sending switches to the router.

An error occurred sending the switch to the router hardware. This implies a hardware error.

1C Could not create \“%s\” task.

A task on the system was removed. This indicates an overloaded system.

1D SwitchListStore has exhausted its supply of RCDataLists.

The system has a limited number of switch lists. If this supply is exhausted, no more switches can be
performed.

1E The maximum number of switches was exceeded.

As the system processes a switch request it may add additional switches due to system configuration
(follow switches, etc.). The addition of these switches has exceeded the maximum number of
switches allowed in a single switch list.

1F ConfirmAll has been turned %s for VenusRouterDriver.

If confirmAll is turned on, all switches will be confirmed regardless of the response from the router
(even if no router is connected). This is typically used in development.

20 Cannot find file system: ‘%s’.

The indicated file system could not be found. This is typically a critical error. It may indicate a bad
disk drive.

21 Error %d trying to initialize the crosspoint driver.

The system could not initialize communications with the crosspoint driver. This is typically a critical
hardware problem.

22 An error was encountered while trying to resolve a path for the switch(es) received.

The switch(es) could not be completed due to an error in the path resolver.

23 POSIX clock adjusted by %d mS from %s

The system’s POSIX clock was adjusted to match a reference source. This type of adjustment occurs
periodically every 17 minutes. Typically, the clock is adjusted by a small value (less than 1 second).
If the adjustment is large (greater than 1 second), this message will be logged. This should not be a
problem if it occurs infrequently.

24 POSIX clock set to %d/%02d/%d %02d:%02d.

The system’s POSIX clock was set to the indicated time, which is is most likely the result of a manu-
al adjustment initiated through the call to setClock. Note that the Video time line was also recali-
brated as a result of this change and could have resulted in a loss of any deferred events already in
the time line.

25 Bootp failed: no response
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The system did not receive a response from the bootp server (JNS). This message is typically logged
because the JNS control center is not running. A network problem is also possible. The system will
continue to operate using the previous application software and configuration. This will give unde-
sirable results if the configuration or software has changed since the last reboot. If no changes have
occurred, this should not be a problem.

26 Bootp failed: no vendor extensions.

This message is logged when a bad bootp response is received. The bootp response must have ven-
dor specific information to be useful. There may be another bootp server on the network erroneously
configured to reply to this system.

27 Bootp failed: no Jupiter extensions

This message is logged when a bad bootp response is received. The bootp response must have ven-
dor specific information to be useful. There may be another bootp server on the network erroneously
configured to reply to this system.

28 Bootp succeeded from server %s

This message indicates that a good bootp response was received from the indicated server.

29 Using configuration from %s for Bootp.

A valid bootp response was not received. The indicated source is supplying the required information.

2A Using bootline and defaults for Bootp.

A valid bootp response was not received. The built−in defaults are supplying the required informa-
tion.

2B Activate command received−−updating code.

The “activate” command was received. This is used to change the configuration set without reboot.
However, the system will reboot if the new configuration set contains changes that requires it.

2C Reboot command received−−rebooting

The “reboot” command was received. This is used to reboot the system.

2D Clear Persistent Memory command received−−memory will reinitialize on reboot.

The “clear persistent memory” command was received. This is used to clear the router status on the
next reboot. This has no immediate effect and any subsequent changes to router status will also be
cleared on the next reboot.

2E Post Mortem command received. Critical errors will not cause a reboot.

The “post−mortem” command was received. This is used to tell the system to not reboot on a fatal
error. The system tasks will be suspended so further investigation can be performed.

2F Unsupported %s command received−−ignored.

The system received an unsupported command. The system may be out of sync with the control cen-
ter. The command is ignored.

30 Scheduling system reboot

Because the system is a high−performance system a requested reboot will be deferred till the system
completes its high−priority tasks. This typically takes only a few seconds.

31 Scheduling configuration swap

Because the system is a high−performance system a requested configuration change will be deferred
till the system completes its high−priority tasks. This typically takes only a few seconds.

32 Checking CRC of %s
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This is an informational message indicating that the CRC of the specified file is being checked. This
allows the system to ensure that no file corruption occurred.

33 %s is up to date

This is an informational message indicating the specified file is up to date and need not be reloaded
to the system.

34 %s saved as %s

This is an informational message indicating that the specified file was downloaded successfully and
renamed.

35 Downloading file %s

This is an informational message indicating that the specified file is being downloaded.

36 Cannot download file \“%s\” (Error number 0x%X: %s)

The file download failed. This is typically a critical error.

37 %s CRC failure, Computed=0x%04x Expected=0x%04x

The CRC on the downloaded file was not correct. This indicates a corrupted file.

38 Downloaded %s −− %d bytes in %ld mS

This is an informational message indicating that the specified file was downloaded (giving the byte
count and the time required to download it).

39 Configuration successfully loaded

This is an informational message indicating that the specified configuration was successfully loaded.

3A Could not create UDP socket errno = 0x%x

There may be a problem with the LAN hardware or external LAN connections. This is typically seri-
ous.

3B Could not shutdown UDP socket errno = 0x%x

A problem with the LAN hardware or external LAN connections may exist. This is typically serious.

3C Could not close UDP socket errno = 0x%x.

There may be a problem with the LAN hardware or external LAN connections. This is typically seri-
ous.

3D Logical UDP port 0x%x overlaps standard port at 0x%x.

Error trying to use a reboot or com port that is already in use via the Jupiter / BootP tasks. Check
Jupiter com and boot port numbers.

3E Could not bind UDP socket for port 0x%x errno = 0x%x.

There may be a problem with the LAN hardware or external LAN connections. This is typically seri-
ous.

3F Could not set option 0x%x on UDP port 0x%x errno = 0x%x.

There may be a problem with the LAN hardware or external LAN connections. This is typically seri-
ous.

40 Send failed for UDP port 0x%x errno = 0x%x ip = 0x%x

Unable to send a message to the UDP port at this ip address. The network may not be configured
correctly or not physically connected correctly. Verify the correct UDP port numbers and IP address-
es are being used.
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41 Receive failed for UDP port 0x%x errno=0x%x

There may be a problem with the LAN hardware or external LAN connections. This is typically seri-
ous.

42 Invalid UDP destination name ’%s’ on port 0x%x

There may be a problem with the LAN hardware or external LAN connections. This is typically seri-
ous.

43 Error setting non blocking for port 0x%x

There may be a problem with the LAN hardware or external LAN connections. This is typically seri-
ous.

44 Invalid logical multicast address 0x%04x

There may be a problem with the LAN hardware or external LAN connections. This is typically seri-
ous.

45 Could not create ’%s’ task

There may be a problem with the LAN hardware or external LAN connections. This is typically seri-
ous.

46 Could not create the virtual master array (step %d).

The virtual input master array (list of outputs that can be used as virtual inputs) was not created. The
system will not be able to perform virtual input switching. (Step indicates where the process failed)

47 The virtual input master table is corrupt (cause %d).

The virtual input master array is corrupt. The system will not be able to perform virtual input switch-
ing. (Cause indicates where the corruption occurred.)

48 Cannot find any levels configured for this board (%d).

There are no levels configured for this board. You must build a valid configuration and reboot.

49 Bad config request: %s (task %x)

An improper configuration request was made. This is a programming error and should be reported to
technical support.

4A Cannot load serial card for this board.

Unable to load files for the coldfire serial card. Either the boot loader or serial processor application
program failed to run on one or more serial processors. This indicates a failure of one of the serial
processors.

4B SerialTimeSync failed to set a serial processor time reference.

A synchronize time command is sent to each serial processor. If the processor fails to set its time this
event is logged. The processor may also fail to load protocols if the synchronize time command fails.
This indicates that the processor control channel is not responding.

4C One or more serial protocols did not start correctly.

One or more of the configured serial protocols failed to load on one or more of the connected serial
processors. This indicates a serial processor control channel failure or incorrect protocol module. A
probable cause is that the serial protocols tables define an invalid protocol for this board.

4D Serial processor watchdog expired on card %d.\nProcessor Restarted.

The indicated serial processor failed to reset the hardware watchdog timer indicating that a hang
condition existed on the processor. The processor was reset by hardware and its program will be re-
started.
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4E Error 0x %x scheduling actors for the router control device.

An error occurred when trying to schedule actors to the command scheduler. System may be over
loaded. This is typically a critical problem.

4F Configuration error for router control device %d.

An error occurred when trying to get the logical CP number for this device. The device was config-
ured in the protocols table but could not be found in the MPK devices table.

50 Error creating watch list for deferred events.

When a time−deferred switch is created, a watch list observer is created so that the event handler
will be notified when the event runs. This message indicates that the system was not able to create
the watch list observer. Possibly too many observers are being used.

51 Failed to allocate memory.

The system tried to allocate memory but failed. This is always a fatal error.

52 Failed to free memory.

The system tried to free memory but failed. This is always a fatal error.

53 Cannot open configuration file \“%s\” (Error number 0x%X: %s)

There was some problem opening the configuration file.

54 Cannot find configuration image \”%s\” (\”%s\”).

The configuration image was not found in the configuration file. The old configuration image will be
used (or the default if a valid one has not been loaded yet). This will typically give undesirable re-
sults.

55 Cannot swap to alternate configuration image \”%s\”, it is not valid.

A swap was attempted on the configuration image but the alternate image was invalid. The old
image will continue to be used. This may give undesirable results.

56 Cannot get the ethernet address for this board.

The ethernet address is needed to determine which configuration to load. If it cannot be determined
the board will not operate. This is always fatal.

57 Cannot find this board number (%u) in the configuration table.

Each board has a unique number. This number is used to determine which configuration parameters
are used. If the parameters for the board cannot be found, the old configuration will be used. This
will usually result in undesirable results.

58 Serial Processor: %s

Out of memory! When the serial card memory heap is completely exhausted, this message is logged
and the task allocating memory hangs.

59 Serial Processor: %s

Heap nearly exhausted! When the serial card memory heap is nearly exhausted, this warning mes-
sage is logged.

5A Serial Processor: %s

Heap Free error! When memory on the serial card is freed, the currentHeapUsed value is decrement-
ed by the size of the block being freed. If the current used value is negative, there is a problem with
the heap memory management and this error is logged.

5B Serial Processor: %s
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Message transfer during last frame failed to complete. Determinacy of incoming messages was lost.
When processing input messages and a message failed to be completely transferred in the previous
frame this message is logged. It represents a determinacy error. Increments a serial input channel
determinism error metric.

5C Serial Processor: %s

DPM access failure. The system was unable to write serial messages. This message is logged when
the system is processing input messages and is unable to allocate DPM memory for writing. Incre-
ments a serial input DPM access error metric.

5D Serial Processor: %s

Message transfer during last sync interval failed to complete. Determinacy of outgoing messages was
lost. When processing output messages, if a message failed to complete in the last frame this mes-
sage is logged. It represents an output determinacy error.

5E Serial Processor: %s

Message overflow. Outgoing message lost. While outputting serial messages to the frame processor
the serial card ran out of memory and was unable to copy any more messages.

5F Serial Processor: %s

Data overrun error. A separate thread is watching all the port metrics overrun error counts. When any
port’s overrun error count exceeds its previously logged count this event is logged.

60 Serial Processor: %s

Serial Card Flash Directory Initialized. When a new board is installed this event is expected. Any-
time after initial installation if this event occurs the flash file system directories have both been cor-
rupted and were re−initialized.

61 Serial Processor: %s

Primary directory was copied from the secondary directory. When the primary directory was
checked, it indicated a data corruption problem and was replaced by the secondary directory copy
because its contents checked ok.

62 Serial Processor: %s

The flash file system attempted to update the directory in memory, but the write to flash failed for
the primary directory copy 1 or secondary directory copy 2.

63 Serial Processor: %s

A separate thread is watching all the serial port metrics error counts. When any ports line, protocol,
or timeout error count exceeds zero or its previously logged value this event is logged.

64 Serial Processor: %s

When a message comes from a serial port protocol, it is transferred from the serial processor to the
frame processor to be processed by the system. The protocol expects to receive either a positive or
negative acknowledgement. If that response is not received within the specified timeout period, this
event is logged.

65 Serial Processor Undefined: %s

Undefined serial processor log event. See message string.

66 Cannot run unit test for %s with production code

You cannot run unit tests when the code is compiled for production.

67 Could not create unit test task for %s
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Failed to create the unit test task.

68 Could not create unit test cleanup task for %s

Failed to create the unit test cleanup task.

69 Unable to initialize the bootp information. Activate a valid configuration and start the bootp dae-
mon.

The application was unable to initialize the bootp information. The application could not determine
its IP address. Make sure a bootp server is running and a valid configuration is activated.

6A Unable to initialize the control center. Activate a valid configuration and start the bootp daemon.

The application was unable to initialize the bootp information. The application could not find a valid
configuration file. Make sure a bootp server is running and a valid configuration is activated.

6B Cannot find host name for %s in host table.

A host name was specified without an IP address. The host name was not found in the hostname
table. This time server will be inactive.

6C Cannot add host name for %s to the host table.

A host name was specified with an IP address. An attempt was made to add the host name to the
hostname table. This should not affect operations.

6D %d deferred events for %s:%02d reassigned for makeup.

A time line discontinuity has caused deferred events to be passed over for execution. Since these
events now exist in the past, the system will attempt to perform these events as the current schedule
permits. This is evidence of a serious problem with the system video time line. It may be caused by
an abrupt change to the time code input or a problem with video SYNC. Check to make sure these
are working and properly connected. If the time on the time code generator was adjusted, make sure
that these changes do not occur if deferred events are pending that may be swallowed by the adjust-
ment.

6E ERROR: %s (errno=0x%x, %s)

Some system error occurred. This is usually fatal.
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CP 3800 SERIES CONTROL PANELS

This software operates with Jupiter release 4.0 or later.

The following FATAL ERR codes can appear on the CP 38XX series of Control Panels. These are firmware errors that the
panel found while running. The following list will help explain these errors and possible actions to be taken.

10xx − Where xx is the unknown MPK message type received by the panel. The biggest cause of this error is a
wrong Control Panel type being defined for this panel in the MPK table. Check for correct Control
Panel type in the MPK table on the main File Server. If correct panel type is defined, call Grass Valley
Technical Support.

11xx − Where xx is the data that can NOT be written into the build in EEPROM. This could possibly be a
hardware failure. Call Technical Support.

3200 − Could NOT send an ACK in response to receiving a message, still had previous data in transmit buffer.
This could be a possible hardware failure. Call Technical Support.

3300 − Received MPK message that had a byte count too large. Possible cause, wrong panel type or
something wrong with MPK bus. Call Technical Support.

3400 − Received transmit buffer empty IRQ when there was no data that was sent. Possible hardware
problem. Call Technical Support.

3500 − Could NOT send a NAK in response to receiving a new message before processing last message. Call
Technical Support.

3600 − Could NOT send a NAK in response to receiving an illegal check sum on the last message. Call
Technical Support.

80xx − Where xx is the column number that is not on this panel display. The biggest cause of this error is a
wrong Control Panel type being defined for this panel in the MPK table. Check for correct Control
Panel type in the MPK table on the main File Server. If correct panel type is defined, call Technical
Support.

81xx − Where xx is the column group trying to blink on this panel type. The biggest cause of this error is a
wrong Control Panel type being defined for this panel in the MPK table. Check for correct Control
Panel type in the MPK table on the main File Server. If correct panel type is defined, call Technical
Support.

Most of these problems that say call Technical Support could be a hardware problem. The first thing that the customer needs
to do is check all MPK devices that are connected to the effected MPK bus for the possibility of having two or more devices
with the same device address. If no problems are found, disconnect the panel from the MPK bus. Turn the power off and
then back on again to reset the panel. Run all the tests in the diagnostic mode to check for possible control panel hardware
problems. A MPK loop back cable to connect the receive and transmit lines will need to be made to check the panels MPK
port. If any problems are found, call Technical Support to get the panel repaired. If no problems are found, check the MPK
bus for possible problems.
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Appendix S

TSL UMD Setup Guide

The TSL Under Monitor Display panels are manufactured by Television Systems Limited
(http://www.televisionsystems.ltd.uk),  and can be controlled via RS−422 serial connection with VM/SI 3000 control
boards running Jupiter 7.2 or newer software.

The TSL UMD panels have RS−422 serial data and 24 V power on the same connector, so custom−built cables will be
necessary to connect the TSL UMD panels with Jupiter.  Some TSL UMD panels use DB−15 connectors, and some use
RJ−45 connectors, so great care should be taken in their construction.  Also, the ground pins (“0V” in the TSL manuals) on
the TSL UMD connectors should be connected to the ground pins on the Jupiter VM/SI−3000 control boards to ensure
proper communications.  Please refer to the TSL UMD manual for the exact connector pinouts.

Figure S−1 is an illustration of a cable for a TSL “UMD−QD8” quad display panel (DB−15) and an “UMD−D8C” single
display panel (RJ−45), connected to a VM 3000 (DB−9).

There are some setup issues that need to be addressed.  The TSL UMD−QD8 panel needs to be set in “Error Mode 3” using
the recessed front panel switches.  Please refer to the TSL manual for more information on how to set that mode.  All panels
need to be set in “Mode 1” to communicate with Jupiter via the serial connection.
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The recessed front panel switches are also used to select a serial address for the TSL UMD panel.  The valid addresses are 0 –
125.  This address is entered in the Jupiter MPK Devices Table in the “Address” field.  If the TSL UMD has two displays,
then the left−hand display has the TSL serial address entered in the address field, and the right−hand display has that address
plus 100.  For example, in a two display TSL panel, with the address “5” chosen, the left−hand display is address
“00000005” in the MPK Devices Table, and the right−hand display is address “00000105”.  Please see the drawing below.

Figure S−2

Also, if there are more than two displays in a single TSL UMD chassis, the left−most two displays use the address that is set
by the front panel switches (again, please refer to the TSL manual for more information on how to set panel addresses).  The
right−most one or two displays use the next sequential address.  For instance, on the UMD−QD8 panel with four displays, if
the front panel switches are used to choose an address of “8”, then the left two displays are addresses “00000008” and
“00000108” in the Jupiter MPK Description Table, and the right two displays are addresses “00000009” and “00000109”.
Please see the drawing below.

Figure S−3

In all other respects, the TSL UMD panels behave exactly like the UMD3A UMD panels, including being able to be defined
as Saturn UMD panels, and controlling the tally lamps (Output Tally).

Recessed Front Panel SwitchesAddress “00000005” Address “00000105”

Recessed Front Panel SwitchesAddress “00000008” Address “00000108” Address “00000009” Address “00000109”
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Appendix T

Grass Valley 8964 OMD (On Monitor Display) module

The 4−channel GV 8964 OMD (or on−screen display) board, which is based on the 8964 ENC SDI to NTSC/PAL Encoder
Module, mounts in the 8900 TFN−V Module Frame. In this application, each of the four channels can insert an 8−character
status mnemonic into a digital video stream and display the result on the analog output. Figure T−1 shows the status
mnemonic “CAMERA 1” inserted into one of the OSD board’s four video channels.

Each module frame can contain 10 modules for a total of 40 outputs per frame.

Figure T−1. Example of OSD application. The device names shown correspond to those used in the Jupiter Configuration Procedure
discussion below .

CM 4000 running 
AccuSwitch
application

Digital video router
Crosspoint Bus

PS 1PS 2

LOCKLOCK

FAULT

IP Switch

“MNF1” 8900TFN−V Module Frame 
with 

“OSD1,” “OSD2,” ”OSD3,” and “OSD4” channels provided by 1 8964OMD OSD
Module

CAMERA 1

Digital

Analog

Jupiter
LAN

Each 8964 channel is associated with a particular Logical Output of the router. The source mnemonic is displayed as white
characters over a black background in the lower part of the screen.

The CM 4000 / AccuSwitch communicates to each Module Frame via the Jupiter LAN and a TCP connection.

The OSD also has the ability to display the current time on a separate line.
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JUPITER CONFIGURATION PROCEDURE

1. Network Description table: Each module frame requires a separate row on this table. The board Type is “MN”
(Modular Network board). In the Address field enter the IP address of the frame’s network card.

2. MPK Devices table and CP sets.

The MPK Devices table requires an entry for the module frame, and a separate entry for each video channel of each
OSD board.

Module frame entry

The module frame entry consists of an MPK Device name, a Device Type, and the names of three sets. See Figure
T−2.

Figure T−2. Module frame entry on MPK table (example).

MNF1 MNF MNF−IN MNF−OUT1

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2

Devices word In Panel Out Panel

MNF−LEV

Device
Type

The MPK Device name must be exactly the same as the Board Name for the module frame on the Network Description
table. The Device Type is “MNF” (Modular Network Frame). Of the three sets, only the Output set is used; the Input
Set and Level Sets are placeholders needed to satisfy the compiler.

Input Set. This placeholder set, type Serial, must be created with at least one Entry number and one Logical Input.
See Figure T−3.

Figure T−3. Placeholder Serial−type CP Input Set (example).

1

Input Set — MNF−IN

2

Entry

BARS

Input

0

Logical

Output Set. This set, type Serial, is used to assign a router output to each OSD channel.
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Figure T−4. Serial−type CP Input Set (example).

1

Output Set − MNF−Out

2 1

2

Entry

STU1

SVR1

Output

3

3

SVR2

4

5

6

VT01

0

Logical

The Entry number is used to identify an OSD board and channel number, which is then associated with a Logical
Output number of the router. For example: Entry “0” = module 0, channel 0; this channel will monitor the status of
router output “STU1.” “3” would be module 0, channel 3; it will monitor router output “VT01.” If there is another
module, then the next row would show Entry “4” for module 1, channel 0, etc.

Note: Module 0 is the module furthest from the power supply.

Level Set. This placeholder set, type CP 3000, must be created with at least one Level entry. See Figure T−5. The
entries are not used.

Figure T−5. Placeholder CP Level Set table (example).

1

CP Level Set — MNF−LEV

Mnemonic Level Break Switch

2

aaaa VIDEO

OSD Module channel entries

Each OSD channel also requires an entry on the MPK Devices table consisting of an MPK Device name, a Device
Type, and the names of three sets. See Figure T−6.

Figure T−6. MPK table (example).

MNF1 MNF MNF−IN MNF−OUT

OSD0 OSD OSD−IN OSD−OUT

1

MPK Devices

MPK
Expansion

Pass
Board Port Address Input Sets Output Sets Level Set Overide Set Sequence Set

2 OSD−LEV

Devices word In Panel Out Panel

MNF−LEV

Device
Type

3 OSD−LEV

4 OSD−LEV

5 OSD−LEV

OSD1 OSD OSD−IN OSD−OUT

OSD2 OSD OSD−IN OSD−OUT

OSD3 OSD OSD−IN OSD−OUT

A device name is created here for each OSD channel. The Device Type is “OSD.” Three CP sets must also be specified.
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Input Set. This set, type UMD3A, is the source of the mnemonics that will be inserted into the video. It must include
all router inputs that need to be available to the monitored output. See Figure T−7.

Figure T−7. UMD3A−type CP Input Set (example).

Input Set — OSD−IN

Category Entry Mnemonic Input

2

3

Test 1 BARS BARS

VTR 1 VT01 VT014

5

Test 2 TONE TONE

Test 3 CODE TC

VTR 2 VT02 VT02

CAM 1 CAMERA 1 CAM16

Auto
Mnem

Logical

Output Set. This set, type UMD3A, is only used to enable a clock display on a selected channel. If this is desired, enter
“@@Time@@” as the Mnemonic and select the router output.

Figure T−8. Clock−enable entry on CP Output Set (example).

1

Output Set — OSD−OUT

TEST 1 @@Time@@ STU1

2

Category Entry Mnemnonic Level Set ButtonAuto
Mnem Output

Logical

(The Category and Entry fields are not used, but they must have entries to satisfy the compiler.)

Level Set. This set, type CP 3800, determines which level will be statused. In the example shown in Figure T−9, the
video level will be statused. The Mnemonic field is not used (but must include text as a placeholder).

Figure T−9. CP Level Set table (example).

1

CP Level Set — OSD−LEV

Mnemonic Level Break Switch

2

aaaa VIDEO
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Glossary

10Base2 − a coax version of ETHERNET. Uses a 4.9 mm (0.19 inch) diameter, 50−ohm coaxial cable (RG−58) and
BNC connectors, but runs at the same speed (10Mb/s) as ETHERNET.  The Jupiter system uses this standard
between VM/SI controllers and Saturn. It is also used by the original BCS 3000 controllers.

10/100BaseT − an ETHERNET configuration that uses twisted pair wiring (typically Cat 5 UTP unshielded twisted
pair cable with RJ45 8−pin connectors) to transmit data up to 100 Mbps.

4000 series − (Saturn) these products are very similar to the Saturn 3000 and 3500 series products but have the
“crescent”  style front panel.

A board - ES−3000 used for Thomson Automation applications. Now obsolete.

AA board − analog audio processor for Saturn Master Control switcher.

AccuSwitch − control application for CM 4000. Provides interface between Grass Valley Crosspoint Bus routers
and certain automation systems, including Thomson Broadcast Automation.

AES − Audio Engineering Society. Internet address: http://www.aes.org.

AES3−1992 − AES Recommended Practice for Digital Audio Engineering −− Serial transmission format for two−
channel linearly represented digital audio data.

AES11 − AES Recommended Practice for digital audio engineering −− Synchronization of digital audio
equipment in studio operations.

AFV  − Audio−Follow−Video. Normal operation of a distribution switcher where selection of a video source
automatically selects audio from that source. Example: selection of VTR1 video automatically selects VTR1
Audio 1 and VTR1 Audio 2 as well.

Alamar  − manufacturer of broadcast automation systems. Acquired by Philips.

Ampex bus − see SERIAL BUS.

Andromeda − logical signal processing system developed by Systems group Griesheim. Functions include eval-
uation of GPIs, tally light control, evaluation of contact closure failure indications from devices such as master
control switchers and video servers, and automatic, emergency switching.

AV board − analog video processor for Saturn Master Control switcher.

BCS 3000 − Bosch Control System. Predecessor of Jupiter Facility Control System, originally developed by
Bosch Video Systems Division (now part of Grass Valley). Used Hewlett−Packard UNIX−based file server.
BCS−3000 controller boards included the CE 3000 Matrix Controller, the SC 3000 Serial Control Interface,
the PL 3000 Party Line Interface, and the VG 3000 Dual Video Display Status Generator. Most of the func-
tions of these controllers were combined in the VM 3000 Control Processor. Some facility control systems
built by BTS combined BCS controller boards with a Jupiter PC file server.
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binary super crosspoint bus - similar to super crosspoint bus, but the units digits are allowed to cover the range
of 0 to F, rather than 0−9 as in previous switcher systems. Generated only by the Jupiter, CE-2500,  and BCS 3000

control systems.

breakaway − independent operation of a switcher level. Same as “split.” Contrasts with normal AFV operation.
Example: selecting video from VTR1 but audio from Announce Booth 2.

BTS − Broadcast Television Systems. A joint venture of Bosch and Philips. Now part of Grass Valley.

bus − in distribution switching, a channel leading to an output or destination. Example: “controls 20 buses” means
being able to select sources for 20 destinations.

button−per−input/output control panel − buttons are dedicated to a particular source or destination.  As
opposed to CATEGORY/NUMBER control.

category/number selection method −  operator first picks category (example: VTR); then unit within category.

CE 3000 − Matrix Controller. Interface between LAN and CROSSPOINT BUS. Now obsolete.

chop − rapid, back−and−forth switching between two inputs.

CM 4000 − hardware platform developed as follow−on to VM 3000.

configuration set − a file server directory containing files that are downloaded to CONTROLLER BOARDS. These
files are used to establish network addresses, switcher input and output names, types of VTRs in system, etc.

controller board − (1) term used for the interface unit between Jupiter LAN and the RS−422 bus. Includes VM 3000
Control Processor, SI 3000 Control Processor, and VG 3000 Video Display/Status Generator. Also refers to
BCS 3000 boards: SC 3000 Serial Control Interface, CE 3000 Matrix Control, and PL 3000 PARTY LINE Inter-
face.  In ESBUS terminology, each of these boards functions as a coupler, gateway, and bus controller. (2) Con-
certo router controller module such as the CRS−MC−C2.

CP 3200 − a Jupiter GUI control panel associated with JNIA. Superceded by the JNS Software Control Panel Suite.

CP 3300 − an X−Y panel, developed by Philips BTS in Germany, with soft keys displaying configured names. The
hardware contains 2 lines of 20 characters and displays four character and eight character source and destina-
tion names.

CP 3310 − an X−Y panel similar to the CP 3300 that can display status for either five or eight outputs.

CP 3320 − a control panel developed by the Grass Valley Systems group in Germany.

CP board − control panel for Saturn Master Control switcher.

CPL − Control Point Language. Protocol used in SMS7000 Control System.

crosspoint − distribution switcher circuit where input signal can be connected to output bus. A 10 x 10 crosspoint
board has 100 crosspoints.
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Crosspoint Bus - Also called the matrix bus. A five−pair bus that carries switching and status commands between
the crosspoint (matrix) cards in the router and the control device. Used with all switchers developed at the Salt
Lake City design center, including Trinix and Venus.

The control device could be any one of a large number of devices, including a CE-300A Control Board (inter-
nal to Mars), a SC 400 Control Board (internal to Venus), a CE 3000 Matrix Controller (BCS 3000 control
system), a CE 2500 Control Electronics chassis, a VM 3000 Control Processor (Jupiter), or a CE 2200 (PARTY

LINE system).

The protocol for this bus has changed through the years to accommodate larger and larger switchers with
increasing numbers of levels, being identified as “standard,” “extended,” “super,” and “binary.” For example,
the binary protocol uses binary (rather than BCD) coding to increase maximum control size to 1024 x 1024 on
127 levels.

The “octal” protocol type is used only for Mars switchers.

For additional information, refer to the “Switcher Control Rulebook” appendix of the Party Line Control
Maintenance Manual, Grass Valley part no. 04−043473−010.

Crosspoint Bus router − distribution switcher using the Grass Valley CROSSPOINT BUS protocol. This includes
Trinix, Venus, TVS/TAS−1000/2000/2001/3000, GS−400, SDR−400, and Mars. Also includes Concerto
equipped with CRS−MC−C2 Controller Board.

DA board − digital audio processor for Saturn Master Control switcher.

DDE − Dynamic Data Exchange. A form of interprotocol communication that uses shared memory to exchange
data between applications.

delegation − use of a special control panel or supervisory display to restrict control of a specific VTR to a particu-
lar control panel or panels. The delegation process does not actually connect a control panel to a machine;
rather, it  allows the connection to be made using the normal machine linkage procedures. See also Linkage.

DHCP − Dynamic Host Configuration Protocol. Provides automatic TCP/IP configuration when a DHCP server is
present on the network.

Distributed routing  − sending a switch command through a CM 4000 running AccuSwitch, to a CM 4000 run-
ning JupiterXPress or a VM 3000 running JupiterPlus, and then to a router. Also called switch forwarding.

DVB−ASI - Digital Video Broadcasting − Asynchronous Serial Interface.

downloadable panel − term used with older systems (CE 2200/PARTY LINE technology). Downloadable panels have
the ability to change display mnemonics and/or category/number button assignments, from a central com-
puter. This is a standard feature with Jupiter.

DSP − digital signal processor.

Dune − ATM−based digital audio switcher built by LAWO. Discontinued in 2002.

DV board − digital video processor for Saturn Master Control switcher.
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DVS − (Philips) Digital Video Systems. Successor to BTS. Now part of Grass Valley.

EBU − European Broadcasting Union. Internet address: http://www.ebu.ch/.

ES 400 − A term used in Grass Valley technical publications to denote the original asynchronous (non−reclock-
ing) version of the Venus digital audio switcher matrix board and associated components.

ES 401 − A term used in Grass Valley technical publications to denote the new AES11 synchronous/asynchronous
version of the Venus digital audio switcher matrix board and its associated components.

ES 3000 ESnet Interface Circuit Card − Ethernet board used in PC compatible computers. No longer available.

ESbus − nickname for EBU/SMPTE RS−422 bus protocol for remote control of television production equipment
using a full−duplex four−wire, asynchronous serial, 38.4 kbits/s digital channel. Connectors are 9−pin D.  In-
corporates ANSI−SMPTE 207M and Recommended Practice 113. The Jupiter Serial bus is designed to be
compatible with ESbus; however, the serial data cable supplied by Grass Valley uses only 5 conductors. (In
Jupiter systems, “ESbus” usually refers to VTR control.)

ESbus Routing Switcher Protocol − used for control of a routing switcher with a third−party computer operat-
ing according to the proposed ESBUS routing switcher dialect. Also referred to as ESCONTROL protocol. Uses
logical input and output numbers to identify crosspoints.

ESbus Tributary protocol − (a.k.a. “ESTR” and “ES−trib”). Full tributary ESBus automation protocol, com-
pliant with SMPTE EG 29−1993, and all associated normative references. The protocol supports all standard
bit rates from 300 to 115.2 kBPS. Flow control is an advantage with this protocol.

EScontrol − control of a “remote” (serial control) routing switcher using proposed ESBUS ROUTING SWITCHER PRO-
TOCOL. Also referred to as “ESbus Router” protocol.

ESnet − nickname for EBU/SMPTE proposed protocol for remote control of television production equipment
based on THIN NET.

ESphysical − (a.k.a. “ESP”). Used for control of a routing switcher with a third−party computer operating ac-
cording to the proposed ESBUS ROUTING SWITCHER PROTOCOL. Uses physical input and output numbers to iden-
tify crosspoints.

ESswitch protocol − (a.k.a. “ESW”). Protocol used for Jupiter control of a routing switcher by a third−party com-
puter. It is described in Grass Valley document “ESswitch Serial Routing Switcher Control Protocol, En-
hanced Version.” This is a simplified version of the ESBUS ROUTING SWITCHER PROTOCOL. This protocol oper-
ates in a “pre−selected” mode, and no polling or flow control is implemented.

exclusion − lockout of selected inputs from selected outputs. Example: lockout of a test signal from bus leading to
transmitter.

extended party line − see PARTY LINE.

extended crosspoint bus − see CROSSPOINT BUS.

fabric board − DM−33100 matrix board used in Trinix router.
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file server − a computer dedicated to providing access to a hard disk on a LAN. In Jupiter systems, the PC that holds
the Jupiter installation with the active set.

follow switch − a switch made automatically on one level in response to a switch made by the operator on another
level. See also AFV, REVERSE SWITCHING.

force unprotect/unlock − a system management function that allows a new source to be selected for a protected
or locked destination. See LOCK, and PROTECT.

FPGA − Field Programmable Gate Array.

full−matrix control  − ability to select any source for any destination.

gateway − a device for connecting two dissimilar networks.

GUI −Graphical User Interface. In Jupiter systems, a “software” control panel that exists only as a CRT display.

hardware address −another name for the link level address, a unique identifier required for every device that
operates on a network (for example, 08000090acf6 [hex]). Compare with TCP/IP ADDRESS.

ICS − Integrated Control System. Original name of BCS 3000 and Jupiter Control Systems. “ICS” also refers to a
control system developed by Philips BTS Darmstadt.

indirect status instruction − see PRIMARY STATUS INSTRUCTION.

interface bus  − an ESBUS term for the channel that connects VTRs, control panels, bus controllers, etc.  Uses
9−pin D connectors (but Grass Valley version uses only 5−conductor cable). See SERIAL BUS.

JNIA  - Jupiter Network Interface Application. A program that supported operation of a Logger, Log Viewer,
Party Line Download software, Physical Control (Switching), CP 3200, and Force Unprotect/Unlock. Super-
ceded by JNS.

JNS - Jupiter Network Suite. A collection of many programs designed as a replacement and enhancement to the
JNIA software. Includes the Router Save/Restore Utility, Physical Diagnostic Utility, Physical Remapping
Utility (PRU) and the I/O Editor. The JNS also includes all the JNS SERVERs, Board Status Display, Router
Control Utility, JNS Logger, JNS Log Viewer, Force Unlock, Physical Control, and Party Line Download.

JNS Servers − JNS programs that provide data to Jupiter client programs in the same or other computers.

Jupiter  - compact, follow−on version of BCS 3000 CONTROL SYSTEM. A PC-type computer is used as the file server.

Jupiter XPress - Provides a limited set of Jupiter switching and machine control functions using the CM 4000 as
the interface between Grass Valley crosspoint bus routers and certain control devices.

Lawo AG − audio equipment manufacturer based in Rastatt, Germany. Supplied components for Dune Digital
Audio Switcher.

level − historically, a switcher matrix that carries one type of signal, as determined by  DIP switch settings on
crosspoint boards.  Example: level 1 for video, levels 2 and 4 for left and right audio, etc. However, in 3−stage
switching systems this switch−set level is referred to as the “physical” level; and large systems may require
more than one physical level to provide enough hardware for an entire “logical” level (such as video). The
Jupiter Physical Switching menu refers to a “logical level” that is actually the logical level number, this being
the row number on which the level is identified on the Switcher Level Descriptions table. The logical level
name also appears on this table.
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linkage − the Jupiter machine assignment function, whereby control of a VTR is passed to a remote panel. The
system can be configured so that linkage will occur automatically, based on the signal from the VTR being
switched to a destination associated with that panel; this function is sometimes described as “machine control
following the router.” Linkage can also be accomplished manually, using the MC−3020L Linkage panel. See
also DELEGATION.

Little Cloud − engineering project name for JUPITER XPRESS product.

lock − 1. on Jupiter control panels equipped with a LOCK button (except MC 3020L): after a given source has
been switched to a given destination, and LOCK is pressed, the source for that destination can then be changed
only at the panel which set the lock; and only after LOCK is pressed again. Note that a panel can only lock
LEVELS that are assigned to the panel during configuration.  See PROTECT, and FORCE UNPROTECT/UNLOCK. 2. on
the MC 3020L Linkage panel, the LOCK button is used to prevent any interruption in the assignment of a
machine to a control panel.

logical level mapping - in these systems, the same physical level number can be used on more than one logical
level. For example, you could have a switcher with Left Audio on level 2, and with Right Audio also on level 2.
This technique can sometimes help reduce overall switcher size, but it requires special entries to control sys-
tem tables.

logical level name − see LEVEL.

logical level number − see LEVEL.

logging − maintaining a disk file of Jupiter LAN activity, including switches, machine control commands, config-
uration set downloads, error messages, etc. Each file covers a twenty−four hour period.

LOS − Loss of Signal.

MADI   −  Multiplexed Audio Digital Interface. Interface bus used in Dune switchers.

matrix bus − see CROSSPOINT BUS.

M board − CE 3000 Matrix Controller. Now obsolete.

MDI  − Multiple Document Interface.

MIDI   −  Musical Instrument Digital Interface. Serial interface bus used in Triton switchers.

mnemonic − abbreviation, usually four characters long, for a particular input or output. Mnemonics appear in the
LED status windows of the control panels. However, the term is sometimes used to define an input or output in
the sense of a logical device name.

MPK   −  message−per−keystroke. Protocol developed by Grass Valley for control panels and devices connected
to the Jupiter Serial bus. Baud rate is variable, with 8 data bits, 1 start bit, 1 stop bit, and even parity; timeout is 6
characters (1.72 msec). See also  SERIAL BUS.

native protocol − GV Series 7000 Signal Management System Protocol via RS−232, RS−422, SLIP, or Ethernet.
In  Jupiter systems, used for control of a Grass Valley SMS 7000 or Encore control system (which is in turn
connected to a routing switcher).
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NetBEUI − NETBIOS Extended User Interface. Windows for Workgroups ships with the NetBEUI protocol to
interconnect computers running Windows for Workgroups, MS−DOS, Windows NT, and Microsoft LAN
Manager−compatible networks, in a local area network environment. NetBEUI is a small, efficient protocol
designed for use on a departmental LAN of 20 to 200 workstations. For enterprise−wide networks where a
routable protocol is required, TCP/IP or IPX should be used.

NetBIOS − Network Basic Input/Output System. An operating system interface for application programs used
on IBM personal computers that are attached to a LAN.

node − a device on a network, such as a controller board, control panel, file server, or VTR.

numeric mode − switcher selection method using input and output numbers only (as opposed to
category/number mode).

numeric set − a factory−supplied configuration set used to set up and operate the routing switcher in the mini-
mum possible time.

override − one−button selection of an input. Override button of a control panel is programmed to select a
particular input that is used heavily.

output monitoring  − feature of routing switcher which allows control system to verify switcher performance
without interrupting normal operations. A separate, internal switching system is used to switch the Monitor
Output to any output of the switcher.

party line  − proprietary network technology originally developed by TELEMATION, Inc. to control distribution
switchers. Uses unterminated 75−ohm coaxial cable from CE 2200 or PL 3000 looped through all control
panels. Not to be confused with 50−ohm THIN NET technology used in Jupiter. Two types are commonly in use:
the extended party line, which allows control of 250 inputs and 150 outputs; and the super party line, which
allows control of 250 inputs and 250 outputs.

path finding − a switching technique allowing two or more TVS/TAS−2000 or later routing switchers to operate
as a system, where each switcher can access the other’s inputs through a number of tie lines. Because the tie
lines are limited, the path will be blocked when all lines are busy. Not to be confused with THREE−STAGE

SWITCHING.

PCI − Peripheral Component Interconnect, a local computer bus standard developed by Intel Corporation. Most
PCs include a PCI bus in addition to a more general ISA expansion bus.

Philips Broadcast − successor to Philips Digital Video Systems (DVS). Now part of Grass Valley.

physical level − see LEVEL.

PL board − PL 3000 Party Line Interface. Now obsolete.

PMEM  − battery−protected memory.

polling − communication technique where central controller polls (addresses) each device on a party line in turn.
When so addressed, a particular device can then send or receive data without being interrupted.
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polling name − a unique address assigned to a switcher control panel. When transmitted by the polling and
control card, allows communication between that panel and the switcher matrix.

PPM − peak program meter.

protect − on Jupiter control panels with a PROTECT button: after a given source has been switched to a given
destination, and PROTECT is pressed, the source for that destination can then be changed only at the panel
which protected the output. Note that a panel can only protect LEVELS that are assigned to the panel during
configuration. See also LOCK, and FORCE UNPROTECT/UNLOCK.

primary status instruction − in Jupiter systems, a configuration technique used in the CP Input set for display of
SPLIT MNEMONICS. Indirect (“I”) entries are used to point to a primary (“P”) entry. The primary entry in turn
points to the desired mnemonic for that level.

RCL  − GV Router Control Language Protocol (Encore Control System Protocol via RS−232, RS−422, SLIP, or
Ethernet.)

refresh − continuous repetition of switching instructions and confirmation of crosspoint status.  Reports any
interruption of service — for example, if crosspoint board is removed.  When board is replaced, automatically
restores previous switch instructions.

repeater − a device for connecting two LAN segments.

remote PC −a PC on a Jupiter LAN in addition to the PC used as the file server. Can be used for auxiliary tasks such
as remote LOGGING.

remote switcher −a non−Grass Valley distribution switcher under Jupiter control.

retained level − see STICKY LEVEL.

reverse switching −reverse switching is used in RS−232/422/423 data switchers where one level is used to switch
data from a controlling device (such as an editor) to a controlled device (such as a VTR); a second level is used
to return data to the controller. The return path is switched automatically by the control system.

RS−422 − EIA standard which defines the electrical characteristics of balanced voltage digital interface circuits.
More rugged than the earlier RS−232 standard, which employs unbalanced voltages. This standard does not
specify a connector type. While the Jupiter VTR / control panel bus and CC 2010 matrix (crosspoint) bus are
both based on the RS−422 standard, the VTR / control panel bus uses 9−pin D connectors and the CC−2010
matrix bus uses 15−pin D connectors.

RS−422 bus − see SERIAL BUS.

S board − SC 3000 Serial Control Interface. Now obsolete.

salvo − single−command switching of source(s) to multiple destinations.

SCP − Software Control Panel.

segment − a portion of a LAN. In 10BASE2 systems, a segment is limited to 185 meters and 30 nodes. However,
segments can be joined by repeaters.
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sequencing − term used in connection with Jupiter for single−command switching of one or more sources to one
or more destinations. With a CP 3000 switcher control panel, each named sequence can contain up to 25
switching events.

serial bus − term used in connection with Jupiter for the interface bus that connects VTRs and control panels to a
controller board such as a VM 3000. Depending on how the bus is configured by software, may also be re-
ferred to as Sony bus, Ampex bus, ESBUS, MPK bus, RS−422 bus, etc.

server − 1. Hardware: a computer that provides shared services to other computers over a network; e.g., a file
server. 2. Software: a program that provides data to client programs in the same or other computers. In Jupiter
systems, a “JNS server” (software) is said to run on a “file server” (hardware).

set − see CONFIGURATION SET.

single−bus control panel − selects any source for 1 destination.

SMPTE − Society of Motion Picture and Television Engineers. URL: www.smpte.org.

SMPTE 259M−1997 − Television standard: “10−Bit 4:2:2 Component and 4fsc Composite Digital Signals −
Serial Digital Interface.”

SMPTE 269M−1999 − Television standard − “Fault Reporting in Television Systems.”

SMPTE 274M−1998 − Television standard: “1920 x 1080 Scanning and Analog and Parallel Digital Interfaces
for Multiple Picture Rates.”

SMPTE 292M−1998 − Television standard: “Bit−Serial Digital Interface for High−Definition Television Sys-
tems.”

SNMP − Simple Network Management Protocol.

Snowbird − engineering project name for JUPITER XPRESS product.

Sony bus − see SERIAL BUS.

SPD − signal presence detector.

SPDIF − Sony/Philips digital interface.

split − see BREAKAWAY.

status − in a distribution switcher, a display indicating what source is currently switched to a given destination.

sticky levels − control panel BREAKAWAY  operation during which the selected LEVELS remain selected after a Take.

Sundance − engineering project name for CM 4000/ACCUSWITCH.

super crosspoint bus − see CROSSPOINT BUS.
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super party line − see PARTY LINE.

switch forwarding − see DISTRIBUTED ROUTING.

TCS 1  −TELEMATION Control System. Predecessor to BCS 3000 and Jupiter. TCS 1 provides machine control only
(no switcher control).

TCS 2  − control panel protocol used with the MCS 2000 Master Control Switcher. Contains byte counts, check
sums, and error detection. Replaces the TCS CP interface but not the TCS MI interface. TCS2 can only be used
with the MCS 2000, which must be equipped with updated PROMs.

TeleMation − Salt Lake City manufacturer of CATV and broadcast equipment founded by Lyle Keys and
associates. Now part of Grass Valley.

three−stage switching − architecture used for very large switchers as a means of reducing crosspoints needed for
a given number of inputs/outputs. An array of relatively small matrixes is arranged in an input stage, an inter-
mediate stage, and an output stage. The path taken by a given signal through these stages is determined by
software and will vary according to which circuits are already in use. Unlike PATH FINDING between two dis-
crete switchers, three−stage switchers are carefully designed so that all inputs are always available at all out-
puts; i.e., the switcher cannot be blocked.

tie line − see PATH FINDING.

tributary  − term used in ESBUS documentation for an intelligent device (such as a VTR or control panel) con-
nected to an ESBUS.

TSL − Television Systems Ltd.

UMD  − Under monitor display.

VDE − Verband Deutscher Electrotechniker e.V. (Union of German Electrical Engineers). Professional organiza-
tion in Germany authorized to conduct product safety tests.

VITC − Vertical Interval Time Code, embedded in the vertical interval of the video signal.

VGA Status Display  − built−in switcher and machine control status display feature of the VM 3000. Can be
controlled by front−panel buttons or with optional VC 3020 panel.

VM 3000B − VM 3000 with minor electrical changes and “crescent”  style front panel. Functionally identical to
VM 3000.

WPE − serial device type designation used for SPQ 3A frequency response equalizer connection to VM 3000.

XPT − crosspoint.

X−Y selection method − full−matrix control of switcher, where source is described as (x) and destination is
described as (y).

Y line − in an editing environment, some VTRs can act as controllers or tributaries. These can be connected with a
“Y” cable to two switcher ports— one for use when the VTR is a controller, the other when the VTR is used as a
tributary. If the VTR is operated only as a controller, or only as a tributary, then a “Y” cable will not be needed.



Glossary−11CM 4000 Installation and Operating Manual

ZIF  − zero insertion force.

Zion − engineering project name for Jupiter “Configurator,” an enhanced, “Windows−like” editor introduced
with Jupiter 6.1.
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Index

Symbols
.rsv files, 18−1 

**** (as status display), 5−110 

Numbers

0/1−based numbering, 5−56 

00 / 01, front panel display, 2−7 

01−041600−TAB cable, 2−63 
10/100BaseT

defined, Glossary−1 
Jupiter LAN, 2−36 

100/400 offset method, 5−42 

10Base2, defined, Glossary−1 

110/220 VAC selection, 2−1 

220 VAC selection, 2−1 
3−stage. See Three−stage

4000 series, defined, Glossary−1 

802.3, 2−36 

8900 TFN−V Module Frame, T−1 

8964 ENC, T−1 

8964 OMD, T−1 

A
A (flashing), on VGA display, 6−139 

A (in CP−3000 display), 6−19 

A board, defined, Glossary−1 
A264S. See Alpha Image

AA board, defined, Glossary−1 

AC line selection, 2−1 

AC power adapter, Q−1 

AccuSwitch, G−1 
defined, Glossary−1 
hardware installation, 2−87 , G−2 
ordering information, 1−25 
software configuration, G−7 

Activating configuration set, 5−13 

Active I/O Set Editor, 10−1 

ADC, 5−181 

Add row, 5−4 
Address

CP−3808, 6−71 
CP−3824, 6−87 
CP−3830, 6−97 
CP−3832/3864, 6−112 
LAN devices

hardware, 5−27 , 8−1 
TCP/IP, 9−3 

Machine control device, 5−135 
MPK device, 5−107 

Display of ID, 6−21 , 6−47 , 6−72 

Administrator, 4−1 , 5−1 , 5−20 

Advise, 5−45 

AES, defined, Glossary−1 

AES11, defined, Glossary−1 

AES3−1992, defined, Glossary−1 

AFV, defined, Glossary−1 
Alamar. See Thomson Automation

Alarm, 2−7 
Board Status application, 8−2 

Ampex
Addressing, 5−135 
serial protocol table entry, 5−31 

Ampex bus, defined, Glossary−1 

Analog−digital conversion, 5−181 

Andromeda, 2−67 

ANSI, xxxi 

ANSI X3T11, xxxi 
Apex

and CB−3000, 2−6 
connection to CM, 2−3 
connector numbering, 5−56 
Switcher Description table entries, protocol, 5−43 
Switcher Description table entry, 5−39 , 5−43 

AS, entry on Network Description table, G−7 

ASC, entry on Serial Protocol table, 5−32 , G−8 
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ASCII
CM−4000/AccuSwitch application, G−8 
Routing switcher protocol

Command set, N−1 
Hardware connections, 2−88 
Level indication, 5−60 
load factor, 1−18 
Serial protocol table entry, 5−31 

Asoc name, 5−143 

Assemble edit, MC−3000, 6−133 
Assignable inputs. See Input Source Assignment

Assigning machines to control panels, 5−141 
Audio

CP−3000 stereo switching, 6−18 
CP−3800 stereo switching, 6−43 
CP−3808 stereo switching, 6−74 
CP−3830 stereo switching, 6−96 , 6−98 
CP−3832/64 stereo switching, 6−115 
GUI panel stereo switching, 7−14 

Auto−Edit mode, 6−133 
Automation

See also Thomson Automation
Output passwords ignored, 5−57 

AV board, defined, Glossary−1 
AVS−1B. See Utah Scientific

B
B&B Electronics, 2−13 
Backup, redundant CM. See CM redundant installation

Base load factor, 1−17 

Base multiplier, 1−21 
Baud rate

1200/2400 for MPK control panel, 5−33 
entry on Serial Protocol table, 5−31 

BCS−3000, defined, Glossary−1 
Belden

8723, 2−63 
9505, 2−4 

Binary
Mars protocol, 5−43 
SDR−400 protocol, 5−43 
super crosspoint bus, Glossary−2 
Venus protocol, 5−43 

Binary−hexadecimal−decimal chart, D−1 

Black Box, 2−25 , 2−62 , 2−90 

BNC Tee cover, G−6 

Board Info/Control, JNS Control Center, 9−3 

Board Override, 9−4 
Board Status

JNS application, 8−1 
JNS Control Center, 9−1 

Boot, CM, B−1 

BOP−4000, 2−8 

Break out panel, 2−8 
Breakaway

CP−3000, 6−14 
CP−3800, 6−41 
CP−3808, 6−67 
CP−3830, 6−81 , 6−94 
defined, Glossary−2 
Disabling, 5−59 
Switching, 5−50 

Bridge, G−4 
Broadcast Automation. See Thomson Automation
Bulbs

Replacing, 2−58 
Testing, 2−59 
testing. See Diagnostics

Bus, defined, Glossary−2 

Button labels, 2−58 

Button−per−input, defined, Glossary−2 

C
Carts. See Audio carts

CAT 5E, 2−36 

Categories, Changing factory names for, 5−101 , 10−5 
Category set

Changing, 5−105 
default, 5−68 , 5−69 , 5−84 , 5−85 

Category/number
defined, Glossary−2 
Linking to switcher input, 5−62 , 5−66 
Linking to switcher output, 5−78 , 5−81 

CB−2000, 2−6 

CB−3000, 1−2 , 2−3 , 2−6 , 2−87 , G−2 
LED error codes, R−1 

CC−2010 cable, 2−4 

CDRH, xxxiii 

CE−1003B, 1−11 
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CE−3000, P−1 
Defined, Glossary−2 

CENELEC, xxxiii 

CET, entry on Serial Protocol table, G−8 

CFR, xxxiii 

Characters, in set, table, & device names, 5−7 
Cheapernet. See Thin net

Chomerics, 2−7 , 2−64 
Chop

CP−3000 panel, 6−13 
CP−3020 panel, 6−26 
CP−3800, 6−49 
CP−3824 panel, 6−80 
CP−3830 panel, 6−93 
CP−3864, 6−103 
defined, Glossary−2 
limitations, 6−13 

Clear Flash, Board Info/Control menu, 9−4 

Clear PMEM, Board Info/Control menu, 9−4 

Clipboard, Windows, 5−6 

CM−4000, 1−3 
clearing battery−protected memory, B−1 
clock, 2−64 
Configuration Info and Set Upload, 13−1 
connecting to

multiple Crosspoint Bus routers, 2−31 
PC, 2−36 
remote (third party) switcher, 2−11 

connecting to router, 2−3 
Controls, indicators, connectors, 1−9 
defined, Glossary−2 
devices per bus, max, 1−17 
drawing, 1−10 
entry on Net Description table, 5−27 
Ethernet address, K−2 
front panel codes, G−13 
hardware installation, AccuSwitch, 2−87 , G−2 
LED error codes, R−2 
levels, max. no. of, 1−16 
MAC address, K−2 
Multiple

Switchers, 2−31 
Units/levels, 5−37 

Next key, 6−138 , A−1 
Pending reboot, 5−15 
Pin outs,  serial ports, 2−63 
Protocol table, 5−30 
redundant installation, 2−8 

kit, 2−10 

replacement CM, K−1 
software configuration, 5−29 

Reset, B−1 
software version, 8−2 
status check, 8−1 , 9−1 
VGA display controls, 6−138 , A−1 

CM_ESTR, G−8 

Columbine Systems, G−2 
Combiner. See VM−400 or DC−400

Compiling/activating configuration set, 5−13 
Computer, file server. See File server
Concerto

connection to CM, 2−3 
connector numbering, 5−56 
Switcher Description table entries, protocol, 5−43 

Configuration
CP−3800, 6−50 
Editor, 5−1 
JNS Control Center, 9−6 
Sets

Activating, 5−13 
Compiling, 5−13 
Copying and selecting for editing, 5−10 
defined, Glossary−2 
General description, 5−8 
Modifying and downloading, 5−8 
naming rules, 5−7 
Numeric, 5−11 

Configuration guide, 1−22 

Configuration Info & Set Upload, 13−1 

Configuration Swap, H−1 

Configurator, 5−1 

Confirm all, 5−43 

Connect, on JNS Control Console, 4−2 

Connector numbering, 5−56 

Contact information, ii 
Control

Center. See “Control Center” below
Panels

See also model no. (“CP−xxxx”)
baud rate, 5−33 
Custom mounting, 1−15 
I/O set editor, 10−1 
Installing, 2−37 
JNS Router Control Utility, 17−1 
naming rules, 5−7 
Operating, 6−1 
Power supply, 1−15 
Software Control Panel Suite. See Software Control

Panel Suite
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Control Center, 5−8 , 5−13 , 9−1 
clearing battery−protected memory, B−1 
CM 4000 reset, B−1 
VM/SI−3000 reset, B−1 

Control Console, 4−1 

Controller, VTR, DM 400B, 5−53 

Controller board, defined, Glossary−2 
Conversion

analog−digital, 5−181 
RS−232/422 converter. See RS−232/422 converter

Copying
Configuration sets, 5−10 
CP Input set, 5−77 
CP Output set, 5−80 

Cover for BNC tee, G−6 
CP

Category sets, 5−101 
Input sets, 5−62 

control panel types, 5−67 , 5−82 
Level sets, 5−58 
Output sets, 5−78 
Override sets, 5−96 
Sequence sets, 5−99 

CP board, defined, Glossary−2 

CP I/O Set Editor, 10−1 
password, 10−2 

CP−  300 Series
diagnostics, 6−6 
DIP switches, 2−38 
Installation, 2−38 
Installing button labels, 2−58 
load factor, 1−17 
rear panel connectors, 1−12 

CP− 300
AC power adapter, Q−1 
assigning keys to inputs, 5−96 
diagnostics, 6−6 
front panel drawing, 2−38 
installation, 2−38 
MPK table entry, 5−110 
Operation, 6−1 
sticky levels, 5−108 , 6−1 

CP− 3008, CP Category set type entry, 5−102 
CP− 310

AC power adapter, Q−1 
assigning keys to inputs, 5−96 
CP Category set type entry, 5−102 
CP output set entry, 5−82 , 5−86 
diagnostics, 6−6 
front panel drawing, 2−39 

installation, 2−39 
MPK table entry, 5−110 
Operation, 6−2 

CP− 310/6, CP output set entry, 5−83 
CP− 320

AC power adapter, Q−1 
categories, 5−69 , 5−85 
CP Category set type entry, 5−102 
CP Input set type entry, 5−67 
CP Output set table entry, 5−82 
custom category set, 5−101 
diagnostics, 6−6 
Front panel drawing, 2−40 
general description, 2−40 
installation, 2−40 
key positions (diagram), 5−103 
MPK table entry, 5−110 
Operation, 6−3 

CP− 328
AC power adapter, Q−1 
categories, 5−69 , 5−85 
CP Category set type entry, 5−102 
CP Input set type entry, 5−67 
CP Output set table entry, 5−82 
diagnostics, 6−6 
general description, 2−40 
installation, 2−40 
Level Set entry, 5−59 
MPK table entry, 5−111 
Operation, 6−4 

CP− 330
AC power adapter, Q−1 
assigning keys to inputs, 5−96 
diagnostics, 6−6 
dual bus mode, CP output set entry, 5−83 , 5−86 
entry on MPK table, 5−109 
front panel drawing, 2−41 
installation, 2−41 
MPK table entry, 5−110 
Operation, 6−4 
sticky levels, 6−3 

CP− 330/6
CP output set entry, 5−86 
diagnostics, 6−6 
installation, 2−41 
MPK table entry, 5−111 
Operation, 6−5 

CP−2002
CP Category type entry, 5−102 
general, 1−5 
Load factor, 1−18 
specifications, 1−12 

CP−2002B
CP Input set type entry, 5−67 
CP Output set table entry, 5−82 
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CP−3000
2400 baud operation, 2−62 
Audio switching modes, 6−18 
CHOP button, 6−13 
CP Category type entry, 5−102 
CP Input set type entry, 5−67 
CP Output set table entry, 5−82 
custom category set, 5−101 
custom mounting, 1−15 
defining

override keys, 5−96 
overrides (at panel), 6−21 
sequences, 5−99 

Diagnostics, 6−20 
Display ID, 6−21 
Entering mnemonic for switcher input, 5−62 
Expansion panel

entry on Machine Control table, 5−140 
Level statused, 5−59 

Front panel drawing, 2−42 
Full matrix control, 5−112 
General description, 2−42 
Input selection, 6−8 
Installation, 2−42 
key positions (diagram), 5−103 
LEV button, 6−14 
Level mnemonics, 5−59 
Levels order in status row, 5−59 
Linking category/no. to switcher inputs, 5−62 
Load factor, 1−17 
LOCK key, 6−11 
MENU key, 6−15 
modem connection, 2−62 
MPK Devices table entry, 5−107 
Multi bus control, 5−112 
operation, 6−7 

force unprotect/unlock, 6−12 
tutorial, J−1 

Output to control, changing, 6−20 
Override input selection, 6−7 
password, 6−22 
PROTECT key, 6−9 
re−legendable button kit, 5−101 
Rear panel connectors, 1−12 
Sequences (selecting), 6−17 
Single bus control, 5−112 
Status checking, 6−16 
stereo special switching, 6−18 

Switcher description table entry, 5−43 
tutorial, J−1 
Unlock, 6−11 
Unprotect, 6−10 
Work sheet for output set, M−1 

CP−3008
CP Input set type entry, 5−67 

CP Output set table entry, 5−82 
CP−3010

See also CP−3000 expansion panel or MC−3000 ex-
pansion panel

Front panel drawing, 6−131 
Load factor, 1−17 
MPK Devices table entry, 5−107 
With CP−3000

Front panel drawing, 2−42 
General description, 2−42 
Operation, 6−24 
Permanent output assignment, 5−79 , 5−84 

with MC−3000 machine control panel, operation,
6−131 

Work sheet for output set, M−1 
CP−3020

assigning keys to inputs, 5−96 
Chop button, 6−26 
Front panel drawing, 2−43 
General description, 2−43 
Installing button labels, 2−58 
Load factor, 1−17 
Lock button, 6−26 
MPK Devices table entry, 5−107 
Operation, 6−26 
Rear panel connectors, 1−12 
Selecting output for control, 5−112 

CP−3021
Front panel drawing, 2−43 
General description, 2−43 
Installation with CP−3020, 2−43 
Installing button labels, 2−58 
Load factor, 1−17 
Rear panel connectors, 1−12 

CP−3030, MPK devices table entry, 5−108 

CP−3300, defined, Glossary−2 
CP−3310

CP Category set type entry, 5−102 
CP Input set type entry, 5−67 
CP Output set table entry, 5−82 
defined, Glossary−2 

CP−3320, defined, Glossary−2 

CP−38 xx series, 64 level limitation, 1−17 
CP−3800

Audio control mode, 6−43 
baud rate set, 6−47 
breakaway switch, 6−41 
button lamps, brightness, 6−48 
chop, 6−49 
configuration, 6−50 
CP Category set type entry, 5−102 
CP Input set type entry, 5−67 
CP Output set table entry, 5−82 
CP Override table entry, 5−96 
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custom category set, 5−101 
diagnostics, 6−47 
display ID, 6−47 
entry on Machine Control Devices table, 5−140 
entry on MPK devices table, 5−108 
error codes, R−12 
front panel drawing, 2−44 
installation, 2−44 
Level button, 6−41 
level selection mode, 6−41 
Load factor, 1−17 
lock, 6−61 
machine control, 6−45 
Menu mode, 6−45 
modem connection, 2−62 
Multiple destination mode, 6−31 

changing output soft key, 6−34 
erasing an output, 6−35 
making a switch, 6−32 
permanent output assignment, 5−79 , 5−85 
switching to single destination mode, 6−37 

operation, 6−27 
override mode, 6−53 
overview, 6−27 
passwords, 6−51 
power requirements, 1−12 
prompting, 6−51 
protect, 6−61 
rear panel connectors, 1−12 
Sequence mode, 6−57 
Single destination mode, 6−37 

making a switch, 6−40 
selecting an output for control, 6−38 

split switch, 6−41 
stereo special switching, 6−43 

Switcher description table entry, 5−43 
sticky displays, 6−50 
tie line status, 6−63 
VTR control, 6−45 

CP−3808
audio switching modes, 6−74 
baud rate set, 6−72 
breakaway (split switch), 6−67 
button lamps, brightness, 6−72 
categories, 5−69 , 5−85 
CP Category set type entry, 5−102 
CP Input set type entry, 5−67 
CP Output set table entry, 5−82 
custom category set, 5−101 
diagnostics, 6−71 
display ID, 6−72 
displaying address (ID), 6−71 
error codes, R−12 
front panel drawing, 2−45 
input selection, 6−66 

installation, 2−45 
key positions (diagram), 5−104 
load factor, 1−17 
lock, 6−69 
MENU key, 6−68 
modem connection, 2−62 
operation, 6−64 

force unprotect/unlock, 6−70 , 6−71 
output to control, changing, 6−65 
password, 6−75 
power requirements, 1−13 
PROM version, 6−47 , 6−71 , 6−113 , 6−121 
protect, 6−70 
rear panel connectors, 1−13 
Status checking, 6−69 
stereo special switching, 6−74 
unlock, 6−69 
unprotect, 6−70 
with Expansion Panel, entry on MPK table, 5−109 

CP−3809
button assignment, 5−79 
diagnostics, 6−125 
entry on MPK Devices table, 5−109 , 5−111 
front panel drawing, 2−48 
installation, 2−48 
load factor, 1−17 
operation, 6−124 
power requirements, 1−13 
rear panel connectors, 1−13 
With CP−3808/3830, Permanent output assignment,

5−86 
CP−3810

assigning buttons to outputs, 5−79 , 5−85 
diagnostics, 6−130 
entry on Machine Control table, 5−140 
entry on MPK Devices table, 5−109 , 5−111 , 5−131 
front panel drawing, 2−54 
general description, 2−54 
hardware installation, 2−54 
load factor, 1−17 
operation, 6−126 
power requirements, 1−13 
rear panel connectors, 1−13 

CP−3810L, entry on MPK table, 5−108 , 5−132 
CP−3810S

entry on MPK table, 5−108 , 5−131 
operation, 6−126 

CP−3824
categories, 5−70 , 5−85 
category keys (diagram), 5−104 
CHOP button, 6−80 
CP Category set type entry, 5−102 
CP Input set type entry, 5−67 
CP Output set table entry, 5−82 
custom category set, 5−101 
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diagnostics, 6−87 
displaying address (ID), 6−87 
front panel drawing, 2−46 
installation, 2−46 
LEVEL button, blinking, 6−84 
load factor, 1−17 
LOCK key, 6−79 
MENU key, 6−87 
operation, 6−76 

force unprotect/unlock, 6−79 , 6−80 
overrides, 6−77 
power requirements, 1−13 
PROTECT key, 6−79 
rear panel connectors, 1−13 
sticky levels, 6−83 
unlock, 6−79 
unprotect, 6−79 

CP−3830
audio switching modes, 6−96 , 6−98 
baud rate set, 6−72 , 6−113 , 6−122 
button lamps, brightness, 6−72 
categories, 5−70 , 5−85 
CHOP button, 6−93 
CP Category set type entry, 5−102 
CP Input set type entry, 5−67 
CP Output set table entry, 5−82 
custom category set, 5−101 
diagnostics, 6−71 , 6−97 
display ID, 6−72 
displaying address (ID), 6−97 
dual / dedicated output, 5−111 , 5−126 , 6−89 
error codes, R−12 
front panel drawing, 2−47 
installation, 2−47 
key positions (diagram), 5−104 
load factor, 1−17 
LOCK key, 6−92 
MENU key, 6−96 
modem connection, 2−62 
operation, 6−88 

force unprotect/unlock, 6−92 , 6−93 
password, 6−75 
power requirements, 1−13 
PROTECT key, 6−92 
rear panel connectors, 1−13 
single bus control, entry on MPK table, 5−110 
Status checking, 6−96 
stereo special switching, 6−96 , 6−98 
unlock, 6−92 
unprotect, 6−92 
with Expansion Panel, entry on MPK table, 5−109 

CP−3830P, operation, 6−88 
CP−3832

assigning keys to inputs, 5−62 

audio switching modes, 6−115 
button lamps, brightness, 6−114 , 6−122 
CP Category set type entry, 5−102 
CP Input set type entry, 5−67 , 5−82 
diagnostics, 6−112 
displaying address (ID), 6−112 
entry on CP Input set table, 5−68 , 5−83 
entry on MPK table, 5−109 
front panel drawing, 2−49 
general description, 2−49 
hardware installation, 2−49 
LEVEL button, blinking, 6−102 
load factor, 1−17 
MENU key, 6−112 
modem connection, 2−62 
multi−panel applications, entry on MPK table, 5−127 
operation, 6−100 

force unprotect/unlock, 6−104 , 6−105 
Panel name, 6−112 
password, 6−100 
power requirements, 1−13 
PRESET button, blinking red, 6−101 
PROT/LOCK button, 6−103 , 6−104 
rear panel connectors, 1−13 
stereo special switching, 6−115 
sticky levels, 6−102 
unlock, 6−104 
unprotect, 6−103 
X−Y operation, entry on MPK table, 5−110 , 5−111 

CP−3832L
diagnostics, 6−121 
entry on CP Input set table, 5−68 
entry on MPK table, 5−109 
general description, 2−49 
hardware installation, 2−49 
operation, 6−117 
password, 6−117 
PROT/LOCK button, 6−119 

CP−3864
assigning keys to inputs, 5−62 
audio switching modes, 6−115 
baud rate set, 6−113 , 6−122 
button lamps, brightness, 6−114 , 6−122 
chop, 6−103 
diagnostics, 6−112 
displaying address (ID), 6−112 
entry on CP Input set table, 5−68 , 5−83 
entry on MPK table, 5−109 
front panel drawing, 2−51 
general description, 2−51 
hardware installation, 2−51 
LEVEL button, blinking, 6−102 
load factor, 1−17 
MENU key, 6−112 
modem connection, 2−62 
multi−panel applications, entry on MPK table, 5−127 
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operation, 6−100 
force unprotect/unlock, 6−104 , 6−105 

Panel name, 6−112 
password, 6−100 
power requirements, 1−13 
PRESET button, blinking red, 6−101 
PROT/LOCK button, 6−103 
rear panel connectors, 1−13 
stereo special switching, 6−115 
sticky levels, 6−102 
unlock, 6−104 
unprotect, 6−103 , 6−119 

CP−3864L
diagnostics, 6−121 
entry on CP Input set table, 5−68 
entry on MPK table, 5−109 
general description, 2−51 
hardware installation, 2−51 
operation, 6−117 

force unprotect/unlock, 6−119 
password, 6−117 
PROT/LOCK button, 6−119 

CPL, Glossary−2 

Crash (program), B−1 

CRC, 8−1 
Crosspoint

Bus
load factor, 1−18 
Transmission speed, 1−11 

defined, Glossary−2 

Crosspoint bus, defined, Glossary−3 

Crosspoint bus router, defined, Glossary−3 

CSA, xxxi 

CSA C22.2, 2−36 

Cut and Paste, Windows to Jupiter, 5−6 

D
D−2000/2166. See Datatek

D8C, S−1 

DA board, defined, Glossary−3 

DAC, 5−181 

Damage claim, 2−1 

Data bits, MPK, Glossary−6 

Data switcher, 2−30 

Datatek, D−2000/2166
Connecting to, 2−24 
Physical level no., 5−42 
protocol entry, 5−43 
serial protocol table entry, 5−31 

Daylight savings, G−11 

DC−400, O−1 

DCOM, I−4 , I−5 
DD Series. See Diamond

DD−5/10/20/30, 2−60 

DDE, defined, Glossary−3 

DEC, 5−32 

Decimal−hexadecimal−binary chart, D−1 

Default linkage, 5−146 
Delegate panel. See MC−3020D
Delegation

defined, Glossary−3 
Group, Establishing, 5−149 
Permanent, 5−149 

Delete row, 5−4 

Dependency, Standard tally, 5−158 

DEST (CP−3800 button), 6−29 , 6−34 , 6−35 , 6−36 ,

6−38 , 6−42 
Destination. See Output

Deterministic switching, 1−3 , 2−3 , G−1 

Device, name, rules, 5−7 

DHCP, I−3 
defined, Glossary−3 

Diagnostic, physical, 15−1 
Diagnostics

CP−300 series, 6−6 
CP−3000, 6−20 
CP−3800, 6−47 
CP−3808, 6−71 
CP−3809, 6−125 
CP−3810, 6−130 
CP−3824, 6−87 
CP−3830, 6−71 , 6−97 
CP−3832/3864, 6−112 
CP−3832L/3864L, 6−121 
MC−3000, 6−133 
MC−3010, 6−137 

Diamond
CP Input set, 5−67 
CP Level set, 5−59 
CP Output set, 5−83 
entry on MPK table, 5−123 
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Hardware connections, 2−60 
serial protocol table entry, 5−31 
tally and DD−35, 2−67 

Digital−analog conversion, 5−181 

DIM, 5−32 

Dimensions, 1−14 

DIP switches, CP−300 Series panels, 2−38 
Disable

Breakaway, 5−59 
Level, 5−59 

Display mnemonic, defined, Glossary−6 

Distributed routing, defined, Glossary−3 
Distribution switcher. See Switcher, distribution

DM 400 Off Time, Switcher Description table, 5−47 
DM−400/400A/400B. See Data switcher

Documents, related, xxv 

Domains, I−3 

Download, cable (CM to PC), 2−90 

Downloadable, defined, Glossary−3 

DSP, defined, Glossary−3 

DST, G−11 

DTK, 5−32 

Dubs panel (GUI), 7−22 
Dune

defined, Glossary−3 
entry on Serial Protocol table, 5−31 

DV board, defined, Glossary−3 

DVP−ASI, defined, Glossary−3 

E
E−E monitor mode, MC−3000, 6−133 
E−MEM. See Grass Valley

EBU, defined, Glossary−4 

Editing guidelines, 5−3 

EEC, 2−36 

EMC, 2−36 

EMI modifications, 2−7 , 2−64 

Emission notice, xxxi 

EN 55103, xxxii 

EN 60950, xxxi 

EN Series (Jupiter LAN), 2−36 

Encoda Systems, G−2 

Encoder (8964), T−1 
Encore

Encore control of Jupiter, 2−91 
Jupiter control of Encore, 2−17 
MPK Devices table entry, 5−123 
serial protocol table entry, 5−33 , Glossary−6 

Enforce, 5−45 

Enterprise Systems, G−2 

Error codes, R−1 
CB−3000, R−1 
CM−4000, R−2 
CP−3800 series panels, R−12 

ES, 5−33 

ES−3000, defined, Glossary−4 

ES−400, defined, Glossary−4 

ES−401, 5−36 
defined, Glossary−4 

ES−LAN, 5−109 
ESbus

defined, Glossary−4 
Max length, 1−11 
Max tributaries, 1−11 
Pin assignment, F−1 
Protocol to Sony protocol, F−2 
router, 5−32 
Routing switcher dialect

Control panel connections, 2−87 
Matrix−physical level no., 5−42 
serial protocol table entry, 5−33 

Transmission speed, 1−11 
tributary, 5−33 
VTR, interface, 5−31 

ESbus VTR Dialect, protocol guide, xxvi 

ESC, 5−33 

EScontrol, protocol guide, xxvi 

ESCP, 5−33 
ESnet

defined, Glossary−4 
Interface board. See ES−3000

ESP, 5−33 
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ESswitch, 5−32 
See also ESbus routing switcher dialect
load factor, 1−18 
protocol guide, xxvi 
Routing switcher protocol, Hardware connections,

2−87 , 2−91 

ESW, entry on Serial Protocol table, 5−33 , G−8 
Ethernet. See LAN

Excel, 5−6 

Exclusion, 5−188 
defined, Glossary−4 

Expansion panel
See also see model, e.g., CP−3010, CP−3809, etc.
With CP−3000

Front panel drawing, 2−42 
Operation, 6−24 

with MC−3000
illustration, 5−145 
operation, 6−131 

Extended crosspoint bus, defined, Glossary−3 

Extended party line, defined, Glossary−7 

Extended Remote PC, I−4 

F
Fabric board, Glossary−4 

Fair−Rite, 2−7 , 2−64 

FAQ, ii 

Fast forward, MC−3000, 6−133 

FCC, xxxi 

FCS−3306, 2−62 

Ferrite, 2−7 , 2−64 

FF, front panel display, 2−7 

Field Engineering Bulletin, 3−1 

File names, rules, 5−7 
File server

Clock, 2−64 
Configuration Editor, 5−1 
customer−supplied, 1−14 
defined, Glossary−5 
disconnecting LAN, 5−21 
Installation, 2−36 
Printer. See Printer
specifications, 1−14 

Fixed load factor, 1−18 

Follow switch, 5−42 
defined, Glossary−5 

Force unprotect/unlock, 6−12 
all outputs (JNS), 11−1 
CP−3808, operation, 6−70 , 6−71 
CP−3824, operation, 6−79 , 6−80 
CP−3830, operation, 6−92 , 6−93 
CP−3832/3864, operation, 6−104 , 6−105 
CP−3864L, operation, 6−119 
defined, Glossary−5 
Router Save/Restore application, 18−2 
VGA, operation, 6−140 
VGA Status Display, Software configuration, 5−114 

Forward switcher. See Data switcher

FPGA, defined, Glossary−5 

Frame advance, MC−3000, 6−133 

Frutiger, 2−58 
FS−3000. See File server

Full function machine control (GUI), 7−20 

Full function switcher panel (GUI), 7−11 

Full−matrix control, defined, Glossary−5 

G
Gateway, defined, Glossary−5 

Generate VGA Files, A−2 

Getting Started guide, xxv , 2−1 , 3−1 , 5−1 

GJ−IC455B, 2−25 , 2−90 

GMT, G−11 

GNP, 5−33 

GPI−T/CI, 2−23 
Grass Valley

E−MEM
CP Category set type entry, 5−102 
CP Input set type entry, 5−67 
CP Output set table entry, 5−82 

Model 200
MPK table entry, 5−123 
serial protocol table entry, 5−31 

Native Protocol, serial protocol table entry, 5−32 
Group delegation panel. See MC−302D

GUI, defined, Glossary−5 
GUI panels. See Software Control Panels
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H
Hardware, address, defined, Glossary−5 

Harris Automation, G−2 

HD 482 S1, xxxiii 

Hexadecimal−decimal−binary chart, D−1 
Horizon

General Purpose Interface, connnecting to, 2−23 
serial protocol table entry, 5−32 

Horizontal Line, G−12 
Hot key. See Shortcut key

HRZ, 5−32 

Hyphen, in set, table, & device names, 5−7 

I
I (entry on switcher input menu), 5−64 

I/O Set Editor, 10−1 
password, 10−2 

ICS, defined, Glossary−5 
ID

display on CP−3000, 6−21 
display on CP−3800, 6−47 
display on CP−3808, 6−72 
display on CP−3830, 6−72 

IEC, xxxiii 

IEC 825, xxxiii 

IEEE 802.3, 2−36 

Image Video, TSI−100, hardware connection, 2−88 

Imaginary switcher, 5−147 

Indirect status instruction, 5−64 
defined, Glossary−5 

Input currently in use... (error message), 5−46 
Inputs

Switcher
Entering # of, 5−51 
Entering mnemonics for, 5−62 , 5−66 
Entering name of, 5−51 

Switcher Input table, 5−48 

Inputs, Switcher, max no. of, 1−27 
Insert

edit, 6−133 

row, 5−4 

Installation, 2−1 
See also model number of product

Integrity Instruments, 2−62 

Interface bus, defined, Glossary−5 

IP address, network devices, 9−3 

ISO 9001, xxxiv 

J
JDS Systems, G−2 

JEP−100, 1−29 
entry on MPK devices table, 5−109 
entry on Serial Protocol table, 5−33 
manual, xxv 
stereo special switching, Switcher description table

entry, 5−43 

JNIA, defined, Glossary−5 
JNS

Applications, 4−3 
on Remote PC, 4−1 

Board Status, 8−1 
Control Center, 5−8 , 9−1 

Board Info/Control, 9−3 
Configuration, 9−6 

Control Console, 4−1 
CP I/O Set Editor, 10−1 
defined, Glossary−5 
Force Unlock/unprotect, 11−1 
Logger and Log Viewer, 12−1 
Physical Control, 14−1 
Physical Remapping, 16−1 
Router Control Utility, 17−1 
Router Save/Restore, 18−1 
Servers, defined, Glossary−5 
TFTP Status, 9−2 
Tools, 4−3 
Utilities, 4−4 

JNS Console.ini, 4−2 

Jog, MC−3000, 6−133 
Jupiter

defined, Glossary−5 
Network Interface Application. See JNIA
Network Suite. See JNS
XPress. See XPress

Jupiter XPress, defined, Glossary−5 
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K
KEMA certificate, xxxiv 

Key caps, 2−58 

L
L (flashing), on VGA display, 6−139 

L4 (Venus level jumper), 5−39 

Labels, preparing, 2−58 
Lamps

Replacing, 2−58 
Testing, 2−59 
testing. See Diagnostics

LAN
facility, I−2 
Jupiter

addresses

hardware, 5−27 , K−2 

TCP/IP, 9−3 

disconnecting file server, 5−21 
installation

10/100BaseT, 2−36 

10Base2, G−3 

specifications

10/100BaseT, 2−36 

10Base2, G−4 

use of non−Jupiter equip, 2−36 , G−3 

Laser compliance, xxxiii 
Lawo

See also Dune
defined, Glossary−5 

Leave alone, 5−45 

LED Error codes, CB−3000, R−1 

Lens chips, 2−58 

LEV key (CP−3000), 6−14 
Level

breakaway, CP−3830, 6−81 , 6−94 
button

CP−3824, 6−84 
CP−3832/3864, 6−102 

CP−3800 button, 6−41 

defined, Glossary−5 
Disabling breakaway to, 5−59 
Disabling switching on, 5−59 
Mapping, 2−29 , 5−41 
Max inputs/outputs, 5−38 
max. no. of, 1−16 , 1−27 
Physical. See Physical level
Switcher Description table, 5−35 

Limits, system, 1−17 
Linkage

Default, 5−146 
defined, Glossary−6 
Machines to control panels, 5−141 
Panel. See MC−3020L

Load, Factors, 1−17 

Local Security Policy, I−5 

Lock, 6−12 
See also Unlock
CP−3000 panel, 6−11 
CP−3020 panel, 6−26 
CP−3800, 6−61 
CP−3808, 6−69 
CP−3824, 6−79 
CP−3830, 6−92 
CP−3832, 6−104 
defined, Glossary−6 
GUI panel, 7−8 

Locked pathfinding, 5−182 

Log Viewer, JNS, 12−1 

Logger, JNS, 12−1 
date/time stamp, 12−1 

Logging, defined, Glossary−6 
Logical, Level

Mapping, 2−29 , 5−41 
Name, 5−35 
Number, 5−35 

Logical level mapping, defined. See level

Logical level name, defined, Glossary−5 

Logical level number, defined, Glossary−5 

Login, CP−3000 panel, 6−22 

Logout, CP−3000 panel, 6−23 

LOS, defined, Glossary−6 

Loss of power, 5−21 

Louth Automation, G−2 

LZR Electronics, 2−38 
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M
M, in GUI status display, 7−15 
M board. See CE−3000

MAC address, K−2 
Machine control

CP−3800, 6−45 
Devices table, 5−135 , 5−139 
full function (GUI), 7−20 
load factor, 1−18 
slaved (GUI), 7−9 

Machine Control table, 5−139 

Machines table, 5−135 

MADI, defined, Glossary−6 

Mains voltage selection, 2−1 

Manuals, related, xxv 

Mapping, Logical level, 2−29 , 5−41 

Mark, E−1 

Mark key, MC−3000, 6−132 
Mars

connecting to VM−3000, 1−11 
inputs/outputs table entry, 5−38 
protocol selection, 5−43 

Master control. See MCS−2000; Saturn
Matrix

Board. See Crosspoint board
Bus, defined, Glossary−6 
Cable, VDE modifications, 2−7 

Matrix Combiner. See 2x1 Matrix Combiner

MC, 5−37 
MC−200/900/2095/2098. See Alamar
MC−3000

custom mounting, 1−15 
Diagnostics, 6−133 
Front panel drawing, 6−131 
Load factor, 1−17 
MPK Devices table entry, 5−107 
operation, 6−131 
Rear panel connectors, 1−12 
Sony Auto−Edit, 6−133 

MC−3010
Diagnostics, 6−137 
Front panel drawing, 6−135 , 6−136 
Load factor, 1−17 
Operation, 6−135 
Rear panel connectors, 1−12 

MC−3020D
Button labels, 2−58 
CP output set entry, 5−82 

Rear panel connectors, 1−12 
MC−3020L

Button labels, 2−58 
CP input set type entry, 5−67 
CP output set entry, 5−82 
Rear panel connectors, 1−12 

MC−3040
back panel drawing, 2−80 
hardware overview, 2−77 
reset switch, 2−79 

MCS−2000, Machine control, Preroll key, 5−140 
MCS−3500. See Saturn

MCS_TLY, 5−160 , 5−164 
MCX 400. See 2x1 Matrix Combiner

MDI, 15−1 
defined, Glossary−6 

Memory
Clearing battery−protected, B−1 
clearing PMEM, B−1 

MENU
CP−3000 button, 6−15 
CP−3800 button, 6−45 
CP−3808 button, 6−68 
CP−3824 button, 6−87 
CP−3830 button, 6−96 
CP−3832/3864 button, 6−112 

MI 3040/T, 5−115 
MI−3040

Back panel drawing, 2−80 
GPI/O application (”MI−3040IO”), 5−115 
Hardware overview, 2−77 
in Saturn Tally systems, 2−69 
MPK table entries, 5−115 
Reset switch, 2−79 
Software configuration, MPK devices table, 5−115 
Tally, Hardware connections, 2−67 
tally configuration (Standard tally), 5−152 , 5−158 

MI−3040IO, 5−115 
Microsoft programs. See name of program

MIDI, defined, Glossary−6 
Mix

CP−3800, 6−44 
CP−3808, 6−69 , 6−74 
CP−3830, 6−96 , 6−98 
CP−3832/3864, 6−112 
CP−3832/64, 6−115 , 7−14 

Mnemonic, defined, Glossary−6 
Mnemonics

Length, max, 5−62 
Linking to switcher inputs, 5−62 , 5−66 
Linking to switcher outputs, 5−78 , 5−81 
Split, 5−64 
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Modem, connecting to control panel, 2−62 
Monitor combiner. See VM−400 or DC−400

Monitoring, Venus, O−1 
MPK

Bus
Baud rate, 5−33 
Cable, 2−63 
Installation, 2−37 
Max devices, 1−17 
Max length, 2−63 

defined, Glossary−6 
Devices, menu entry, 5−107 

Multimedia, Jupiter courses, xxv 
Multiple switcher installations

Hardware installation, 2−31 
Path finding, 2−33 
Statusing requirements, 5−79 
Switcher levels table entry, 5−41 

MVD. See Microvideo

N
Name, rules for set, table, & device names, 5−7 

Native Protocol, Serial protocol table entry, 5−33 

Native Protocol, defined, Glossary−6 

NetBEUI, defined, Glossary−7 

NetBIOS, defined, Glossary−7 

NetLink, 2−62 
Network, board. See LAN card

Network description menu, 5−27 
Network Suite. See JNS
Nexus

Physical level no., 5−42 
serial protocol table entry, 5−32 
switcher protocol, 5−43 

Nexus Star, Connecting to, 2−27 

No Active Set, 4−2 , 7−6 , 10−2 

Node, G−4 
defined, Glossary−7 

Non−sequential path finding
Hardware installation, 2−33 
Table entry, 5−185 

NORM−L/R (CP−3800 display), 6−44 
NORMAL

CP−3808 display, 6−74 
CP−3830 display, 6−98 

CP−3832/64 display, 6−115 , 7−14 
NT. See Windows NT

NTP, G−11 

NUM−64/128, 5−11 
Numeric

Mode, defined, Glossary−7 
Set, 5−11 

defined, Glossary−7 
NVT. See Novotronic

NXS, 5−32 
See also Nexus

O
Octal, Mars architecture, 5−38 

Off Time, Switcher Description table, 5−47 

Offset, 100/400 (switch. desc. table), 5−42 

Offset from GMT, G−11 

OMD, T−1 

On Monitor Display, T−1 

On Screen Display, T−1 

Online documentation, ii 
Option, Switcher Description table. See Data switcher

Options, overview, 1−27 

Opto−isolator, Standard tally, 5−158 

Optoelectronic relays & optical couplers (MI/MC−3040),
2−77 

Ordering information, 1−22 

OSD, T−1 

Oshino Electric, 2−58 
Output

changing on CP−3000, 6−20 
changing on CP−3808, 6−65 
monitoring (Venus), O−1 
Sets, 5−78 

Output monitoring, defined, Glossary−7 
Outputs

Deleting from expansion panel, 6−24 , 6−125 
Switcher, Entering mnemonics for, 5−81 
switcher

entering # of, 5−56 
entering name of, 5−56 
max no. of, 1−27 
password levels, 5−57 
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status checking, 6−16 , 6−69 , 6−96 
Switcher Output table, 5−55 

Override
Board, 9−4 
CP−3800, 6−53 
defined, Glossary−7 
Defining at CP−3000, 6−21 
Input selection, 6−7 
Sets, 5−96 

P
P (entry on switcher input menu), 5−64 

P (flashing), on VGA display, 6−139 
P board. See PL−3000

Page file name, 5−151 

Pan Name, CP−3832/3864, 6−112 

Paper, technical, 2−67 

Parenthesis, in set, table, & device names, 5−7 

Parity, MPK, Glossary−6 

Part numbers, 1−22 

Parts, spare, ii 

Party Line, serial protocol table entry, 5−32 , 5−43 
Party line

defined, Glossary−7 
Utah Scientific, connecting to, 2−25 

Party Line (UDI−1B), serial protocol table entry, 5−32 
PASS =

CP−3808/3830, 6−75 
CP−3832/3864, 6−100 
CP−3832L/3864L, 6−117 

Password
and automation, 5−57 
CP I/O Set Editor, 10−2 
CP−3000, 6−22 
CP−3808/3830, 6−75 
CP−3832/3864, 6−100 
CP−3832L/3864L, 6−117 
Jupiter

Changing, 5−25 
CP−3800, 6−51 
General description, 5−22 
levels

control panels, 5−113 

switcher outputs, 5−57 

Path finding
auto analog−digital conversion, 5−181 
defined, Glossary−7 
Hardware installation, 2−33 
locked groups, 5−182 
multimedia course, xxv 
Non−sequential table entry, 5−185 
Sequential table entry, 5−174 
Three or more switchers, 5−178 
VGA display, A−9 

Paths Full, message on GUI panel, 7−8 
PC

as file server. See File server
connecting to system controller, 2−36 
remote unit, I−1 

connecting to LAN, 2−36 
defined, Glossary−8 
JNS applications, 4−1 

PC−3000. See File server

PCI, defined, Glossary−7 

Pending reboot, 5−15 
Physical

diagnostic, 15−1 
Input number, 5−48 
level

Apex, 5−39 
Datatek switcher, 5−42 
defined, Glossary−5 
ESbus switcher, 5−42 
Nexus switcher, 5−42 
RKX switcher, 5−41 
Trinix, 5−38 
Triton, 5−40 
TVS/TAS, 5−41 
Utah Scientific, 5−42 
Venus, 5−39 

Physical Control, JNS, 14−1 

Physical Remapping Utility, 16−1 

PL−3000, P−1 

Play key, MC−3000, 6−132 
PMEM

clearing, B−1 
after modifying tables, 5−27 

defined, Glossary−7 

Point−to−point, Switching, 5−45 

Polling and polling names, defined, Glossary−7 

Pop−up menu, 5−3 

Post Mortem, 9−4 
Power

Line (voltage) selection, 2−1 
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Loss, 5−21 
Supply, control panels, 1−15 

Power adapter (AC), Q−1 

PowerPoint, Jupiter courses, xxv 

PPM, defined, Glossary−8 

Preroll, 5−140 , 6−132 , E−1 

Primary status instruction, 5−64 
defined, Glossary−8 

Printer
command on Compile window, 5−13 
commands on Options menu, 5−21 
hardware connection, 2−36 

Probe connector and cable, C−1 
Production switcher. See Switcher, production

Program restart, B−1 

Prompting, CP−3800, 6−51 

PROMs, 1200/2400 baud for MPK control panel, 5−33 

Protect, 6−12 
See also Unprotect
CP−3000, 6−9 
CP−3800, 6−61 
CP−3808, 6−70 
CP−3824, 6−79 
CP−3830, 6−92 
CP−3832/3864, 6−103 
CP−3832L, 6−119 
CP−3864L, 6−119 
defined, Glossary−8 
GUI panel, 7−8 

Protocol guides, xxvi 

PS−20, 2−38 

PS−300, Q−1 

Publications, related, xxv 

Punctuation, in set, table, & device names, 5−7 

Push button, 2−58 

Q
QD8, S−1 

Quick start manual, xxv , 2−1 , 3−1 , 5−1 

R
R, in GUI status display, 7−15 

Rack mounting, 2−1 

RCL, defined, Glossary−8 

Re−legendable button kit, 5−101 

Ready key, MC−3000 panel, 6−132 
Reboot

Board Info/Control menu, 9−4 
CM, B−1 
minimizing downtime with CM, 5−15 

Record
In key, MC−3000, 6−133 
Mode key, MC−3000, 6−133 
Out key, MC−3000, 6−132 

Redundant, CM 4000. See CM 4000 redundant installa-
tion

Refresh, defined, Glossary−8 

Regulatory notices, xxxi 

Relay descriptions (Standard tally), 5−152 

Relays (MI/MC−3040), 2−78 

Relegendable button kit, 5−101 

Remapping, 16−1 
Remote

PC. See PC remote unit
switcher, defined, Glossary−8 
switcher (non−Crosspoint Bus), load factor, 1−18 
switcher (third party), connecting to, 2−11 

Repeater, G−4 
defined, Glossary−8 

Reset, CM−4000, B−1 

Restart, Program, B−1 

Retained level, Glossary−8 
Retained levels. See Sticky levels

Returning merchandise, 2−1 

Reverse, CP−3832/3864, 6−112 
Reverse switcher

See also Data switcher
defined, Glossary−8 

Rewind, MC−3000, 6−133 

RFI modifications, 2−7 , 2−64 

RGB switcher, Level menu entry, 5−42 
RKX

Physical level no., 5−41 



CM 4000 Installation and Operating Manual Index−17

switcher protocol, 5−43 

RL11A, 2−38 
Router. See Switcher, distribution

Router Control Utility, 17−1 

Router Save/Restore utility, 18−1 

Row editing, 5−4 

RP 1/2/3 UMDs, 2−82 
RS−232/422 converter

control panel connection, 2−62 
Utah Scientific connection, 2−25 

RS−232/422/423, switching. See Data switcher
RS−422

Cable, Connection to system controller, 2−63 
defined, Glossary−8 

rsv files, 18−1 

RTC, G−11 

RV, 5−37 

S
S (flashing), on VGA display, 6−139 
S board. See SC−3000

S−T (on Swit. out menu), 5−56 

Safe input, 5−46 , 5−47 

Safe off time, Switcher Description table, 5−47 

Safe time, Switcher Description table, 5−47 
Safety

certification, xxxi 
terms and symbols, xxvii 

Salvo panel (GUI), 7−26 

Salvo, defined, Glossary−8 
SATRN

CP Category set, 5−102 
CP Input set, 5−67 
CP Output set, 5−82 

Saturn
connecting to Jupiter, 2−65 
CP I/O Set Editor, with, 10−1 
tally, 2−65 

Save/Restore utility, 18−1 

SB, entry on Net Description table, 5−29 

SC−3000, P−1 

Scan rate, 9−5 

SCP, defined, Glossary−8 

SDI to NTSC/PAL Encoder, T−1 
SDR−400

connecting to VM−3000, 1−11 
Protocol selection, 5−43 

Search
Mark, E−1 
mark key

MC−3000, 6−132 
MCS−2000, 5−140 

Security board, 5−55 

Segment, G−4 
defined, Glossary−8 

Select, key, CP−3010, 6−134 

Selected, set, 5−8 

Semi−permanent linkage, 5−146 

Sequence sets, 5−99 
Sequences

CP−3000, 6−17 
CP−3800, 6−57 

Sequencing, defined, Glossary−9 
Sequential path finding

Hardware installation, 2−33 
Table entry, 5−174 

Serial
Bus, defined, Glossary−9 
CP Category set type entry, 5−102 
CP input set type entry, 5−67 
CP output set type entry, 5−82 
Data cable, 2−63 

VDE modifications, 2−64 
machine control, load factor, 1−18 
MPK bus installation, 2−37 
protocol table, 5−30 

Server, defined, Glossary−9 

Service information, ii 

Set mark, E−1 

Set mark key, 5−140 
MC−3000, 6−132 

Sets. See Configuration sets

Setup, Router Save/Restore, 18−1 

Shuttle, MC−3000, 6−133 

SI−3000, manual, xxv 

Siemens, 2−58 

Single−bus, defined, Glossary−9 
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Slant, in set, table, & device names, 5−7 

Slashes, in set, table, & device names, 5−7 

Slaved machine control (GUI), 7−9 

SlimLine UMDs, 2−81 
See also Under Monitor Displays
and Jupiter software packages, 1−30 
dimensions, 1−15 
hardware installation, 2−81 
ordering information, 1−23 
software configuration, 5−116 
specifications, 1−13 

Slow motion play, MC−3000, 6−132 
SMPTE

259M−1997, defined, Glossary−9 
269M−1999, defined, Glossary−9 
274M−1998, defined, Glossary−9 
292M−1998, defined, Glossary−9 
EG 29−1993, G−8 
EG 30−1995, G−9 
ES LAN, G−9 
ES tributary, G−8 

SMS 7000
connecting to, 2−15 
serial protocol table entry, 5−33 , Glossary−6 

SNMP, defined, Glossary−9 

Snowbird, defined, Glossary−9 

SNY, 5−33 
Software

Configuration Editor, 5−1 
Installation, 3−1 
upgrade, 3−1 
version. See Version information

Software Control Panel Suite, 7−1 
dubs panel, 7−22 
full function machine control, 7−20 
full function switcher panel, 7−11 

audio switching modes, 7−14 
license floppy, 7−1 
salvo panel, 7−26 
slaved machine control, 7−9 
source/destination panel, 7−24 
X−Y panel, 7−29 

Sony
Auto−Edit mode, 6−133 
machine control bus, 2−61 

cable, 2−63 
serial protocol table entry, 5−32 

max VTRs per port, 1−18 
Protocol to ESbus protocol, F−2 
switcher protocol, 5−43 

Source/destination panel (GUI), 7−24 

Space, in set, table, & device names, 5−7 

Spaces, 5−3 

Spare parts, ii 

SPD, defined, Glossary−9 

SPDIF, defined, Glossary−9 

Specifications, 1−9 
Split

defined, Glossary−9 
Mnemonics, 5−64 
switching, 5−50 

and Level menu entry, 5−42 
CP−3000, 6−14 
CP−3800, 6−41 
CP−3808, 6−67 
CP−3830, 6−81 , 6−94 
CP−3832/3864, 6−101 

Spreadsheet, 5−6 
Star. See Nexus

Start bit, MPK, Glossary−6 

Start Board Override, 9−4 
Status

defined, Glossary−9 
display

under monitor. See SD−3x
VG−3000. See VG−3000
VGA, A−1 

See also VGA Status Display

header table, 5−150 

Multiple switcher installations, 5−79 
Stereo

CP−3000 switching modes, 6−18 
CP−3800 switching modes, 6−43 
CP−3808 switching modes, 6−74 
CP−3830 switching modes, 6−96 , 6−98 
CP−3832/3865 status, 6−112 
CP−3832/64 switching modes, 6−115 
GUI panel switching modes, 7−14 
Venus, Level jumper, 5−39 

Sticky display (CP−3800), 6−50 
Sticky levels

300 Series panels, 6−1 
CP−3824, 6−83 
CP−3832/3864, 6−102 
defined, Glossary−9 
entry on MPK devices table, 5−108 

Stop bit, MPK, Glossary−6 

Stop key, MC−3000, 6−132 
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Streamline. See Grass Valley
Super

Crosspoint bus, defined, Glossary−3 
Party line, defined, Glossary−7 

Support package, 5−21 

SW−4000, features, 1−25 

Swap, H−1 

Switch forwarding, defined, Glossary−10 

Switch rate, 1−18 

Switcher Description table, 5−35 

Switcher Input table, 5−48 

Switcher Output table, 5−55 

Switcher, data matrix, 2−30 
Switcher, distribution

100/400 offset, 5−42 
Alpha Image. See Alpha Image
Datatek. See Datatek
Disabling a level, 5−59 
ESbus

Physical level no., 5−42 
Serial Protocol table entry, 5−32 

Grass Valley. See Grass Valley
Inputs

Entering mnemonics for, 5−62 
Names, length of, 5−48 

Microvideo. See Microvideo
Multiple switcher installations

Status, 5−79 
Switcher levels table entry, 5−41 

Nexus. See Nexus
Novotronic. See Novotronic
NVISION. See NVISION
Output

Selecting on CP−3000, 6−20 
Selecting on CP−3808, 6−65 

outputs, password levels, 5−57 
physical, input number, 5−48 
Pro−bel. See Pro−bel
RKX. See RKX
serial connection, 2−11 
Status

Checking, 6−16 , 6−69 , 6−96 
Multiple switcher installations, 5−79 

Switcher Description table, 5−35 
Switcher Input table, 5−48 
Switcher Output table, 5−55 
switching by physical connector number, 14−1 
Triton, Connecting to, 2−13 
Utah Scientific. See Utah Scientific

Switcher, production. See specific model

Symbols, in set, table, & device names, 5−7 
Sync

Reference cable, 2−64 
Vertical interval, 5−36 

Sync Standard, G−12 

Syntax, naming rules for sets, tables, CPs, etc., 5−7 

System limits, CM loading, 1−17 

T
T/CI, 2−23 

Tab−delimited, 5−6 

Table names, rules for, 5−7 

TAKE key, Expansion panel, Deleting output from, 6−24 

Take/select key (CP−3010), Machine control, 6−134 

Tally, 2−67 
advanced (white paper), 2−67 
and DD−35, 2−67 
Example of operation, 5−172 
Hardware connections, 2−67 
multi−level (air+preview+iso)(red+yellow+green),

2−67 
multimedia course, xxv 
output, 2−67 
Saturn Tally, 2−67 
software configuration, 2−70 

MPK Devices table, 5−115 
Relay Description table, 5−152 
Tally Dependency table, 5−158 

Tape
Drives. See HP 9144A (1/4 in) or HP 6400/2000 (DAT)
Machines. See Audio carts or VTRs
monitor mode, MC−3000, 6−132 

TCP/IP. See IP address

TCR, G−11 

TCS−1, defined, Glossary−10 

TCS−1/2, Serial protocol table entry, 5−32 

TCS−2, defined, Glossary−10 

Technical paper, 2−67 

Tee cover, G−6 

Television Systems Limited, S−1 

Telnet, 9−4 
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Termination, LAN terminators
Installation, G−4 
Part number, G−3 

Test. See Diagnostics

TFTP, 9−2 
Thin net

See also LAN
Installation, G−3 

ThinLAN. See Thin net
Third party, routers

See also name of router manufacturer
entry on Switcher Description table, 5−42 

Thomson Automation, G−2 
CP Input set entry, 5−72 
CP Output set entry, 5−89 
Switcher Initialization menu, 5−73 , 5−89 

Three−stage switching, defined, Glossary−10 

Ticks, 8−1 

Tie line, 5−174 
defined, Glossary−10 
status on CP−3800, 6−63 
VGA display, A−9 

Time code, 2−64 
AccuSwitch, G−2 , G−11 
JNS Logger, 12−1 

Time Standard table, G−11 

Time sync, 9−5 

Time Zone Name, G−11 

Timeout, MPK, Glossary−6 
Tools

Generate VGA Files, A−2 
Zip/Unzip, 5−20 

TRI, 5−33 
Tributary

defined, Glossary−10 
ESbus. See ESbus tributary
VTR, DM 400B, 5−53 

Trinix
and CB−3000, 2−6 
connection to CM, 2−3 
connector numbering, 5−56 
Switcher Description table entries, protocol, 5−43 
Switcher Description table entry, 5−38 

Triton
connecting to CM−4000, 2−13 
connector numbering, 5−56 
front−panel controls, not statused by Jupiter, 2−14 
Serial Control Kit, 2−13 
Serial Protocol table entry, 5−32 

Switcher Description table entries
audio/video/data, 5−44 
level, 5−40 
protocol, 5−43 

Troubleshooting, 5−20 
Probe connections, C−1 
program restart, B−1 
zipping a configuration set, 5−20 

TSI−100. See Image Video

TSL, S−1 
defined, Glossary−10 

TSL−UMD, Serial Protocol table entry, 5−32 

TVS/TAS−1000, 1−11 

TVS/TAS−2000/3000, connecting to VM−3000, 1−11 

TVS/TAS−2001, 1−11 

Twisted pair, 2−5 , 2−63 

Type 43 material, 2−7 , 2−64 

U
U96, 5−32 

UDI−1B, 2−25 
serial protocol table entry, 5−32 

UL, xxxi 

UL−1950, 2−36 
UMD

See also Under Monitor Displays
Defined, Glossary−10 

UMD3A
CP Category set type entry, 5−102 
CP input set type entry, 5−67 
MPK table entry, 5−108 

Under Monitor Displays, 2−81 
bus loading, 1−17 
CP input set type entry, 5−67 
CP Level set type, 5−59 
CP output set entry, 5−83 
hardware installation, 2−81 
MPK table entries, 5−116 
permanent display, 5−122 
software configuration, 5−116 

Underscore, in set, table, & device names, 5−7 

Universal Data Interface, 2−25 
Unlock

CP−3000, 6−11 
CP−3808, 6−69 
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CP−3824, 6−79 
CP−3830, 6−92 
CP−3832/3864, 6−104 
force, 6−12 

all outputs (JNS), 11−1 
CP−3808, 6−70 , 6−71 
CP−3824, 6−79 , 6−80 
CP−3830, 6−92 , 6−93 
CP−3832/3864, 6−104 , 6−105 
CP−3864L, 6−119 
VGA, 6−140 

Unprotect
CP−3000, 6−10 
CP−3808, 6−70 
CP−3824, 6−79 
CP−3830, 6−92 
CP−3832/3864, 6−103 
CP−3864L, 6−119 
force, 6−12 

all outputs (JNS), 11−1 
CP−3808, 6−70 , 6−71 
CP−3824, 6−79 , 6−80 
CP−3830, 6−92 , 6−93 
CP−3832/3864, 6−104 , 6−105 
CP−3864L, 6−119 
VGA, 6−140 

Unqualified output (tally), 5−162 , 5−168 

Update Board Info, Board Info/Control menu, 9−4 

Upgrade, 3−1 

Upload, Configuration, 13−1 
Utah Scientific

Party Line (UDI−1B)
serial protocol table entry, 5−32 
switcher protocol, 5−43 

physical level no., 5−42 
UDI−1B Universal Data Interface, connecting to, 2−25 

Utah_12/96, Routing switcher dialect, Matrix−physical
level no., 5−42 

Utilities
Physical diagnostic, 15−1 
Physical Remapping, 16−1 

V
V board. See VG−3000

Vacuum fluorescent, 6−20 

Downloading , configuration set, 5−13 , K−4 

Validating configuration set, 5−13 , K−4 

Variable play key, MC−3000, 6−132 

VC−3020
bus loading, 1−17 
Button labels, 2−58 
Front panel, A−1 
Installation, A−1 
Rear panel connectors, 1−12 

VCP−3000, A−2 
VDE

Cable modifications, 2−7 , 2−64 
Defined, Glossary−10 

Ventilation space, 2−2 
Venus

connection to CM, 2−3 
output monitoring, O−1 
stereo

CP−3000 switching, 6−18 
CP−3800 switching, 6−43 
CP−3808 switching, 6−74 
CP−3830 switching, 6−98 
CP−3864 switching, 6−115 , 7−14 
Level jumper, 5−39 

Switcher Description table entry, 5−36 , 5−38 , 5−39 ,
5−43 

Version information, CM−4000, 8−2 

VG−3000, P−1 
Software configuration, Status Display Headers table,

5−150 
VGA Status Display

cable length, A−1 
General description, 1−7 
Generate Files command, A−2 
hardware installation, A−1 
operation, 6−138 

force unprotect/unlock, 6−140 
Software configuration, A−2 

Force unprotect/unlock, 5−114 
Machine control table, 5−148 
MPK devices table, 5−114 
Status Display Headers table, 5−150 
VGA Status Display table, 5−151 

tie line (path finding), A−9 
Video

display/generator. See VG−3000
Mode (VGA), 5−151 
monitor combiner. See VM−400 or DC−400

Video Reference table, 5−190 , G−12 

VITC, defined, Glossary−10 

VM− 400, O−1 

VM−3000, manual, xxv 

VM−3000B, defined, Glossary−10 
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VMC−3000, A−2 

Voltage (AC line) selection, 2−1 

VT_, serial protocol table entry, 5−33 
VTRs

Connecting to, 2−61 
controlling with, CP−3800, 6−45 
ESbus. See ESbus VTRs
Linking to control panels, 5−141 
Names, entering, 5−135 

W
WAN operation, 1−27 

Web site, ii 

White paper, 2−67 
Windows

cut and paste to Jupiter, 5−6 
XP

Administrator login, 4−1 
Remote PC, I−4 , I−5 

Word, 5−6 

Work sheet, CP−3000/3010 output set, M−1 

WPE, defined, Glossary−10 

X
X−Y panel (GUI), 7−29 

X−Y selection, defined, Glossary−10 

X3T11, xxxi 

XCI, 2−28 

XCPU, 2−28 
XP. See Windows XP

XPress, 1−3 , 2−3 
key features, 1−27 , 1−28 , 1−29 , 1−30 

XPT, defined, Glossary−10 

Y
Y line, L−8 

defined, Glossary−10 

Y line table, 5−189 

Z
ZIF, defined, Glossary−11 

Zip/Unzip, 5−20 
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To access documentation for Apex, Saturn, Trinix, Triton, Venus, and
related products, refer to the “Routing Products Documentation” CD−
ROM, part no. 071−8274−xx.

For other Grass Valley Router products, including 7500, Concerto, and
Encore, refer to the “Routing Products Documentation” CD−ROM,
part no. 071−8130−xx.

Internet: http://www.thomsongrassvalley.com/support
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